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Введение

В настоящее время существует множество графических редакторов и программ 
геометрического моделирования. Компания Autodesk – один из ведущих произ-
водителей систем автоматизированного проектирования и программного обес-
печения (ПО) для конструкторов, дизайнеров, архитекторов. Это крупнейший в 
мире поставщик ПО и услуг для промышленного и гражданского строительства, 
машиностроения, геоинформатики, цифровых средств передачи информации и 
беспроводной связи.

Система AutoCAD, разработанная этой компанией, является лидирующей 
среди платформ программного обеспечения систем автоматизированного проек-
тирования (САПР). Она предназначена для профессионалов, которым требуется 
воплощать свои творческие замыслы в реальные динамические проекты.

AutoCAD – программа с богатой и во многом уникальной историей. Впервые 
она увидела свет в 1982 году под именем MicroCAD. Первая версия AutoCAD 
ознаменовала начало настоящей революции в автоматизированном проектирова-
нии. Сегодня AutoCAD используют в своей работе миллионы проектировщиков 
во всем мире на процессорах в тысячи раз мощнее тех, которые были установлены 
на первых персональных компьютерах.

AutoCAD является постоянно развивающейся базовой средой проектирова-
ния. Каждая новая версия программы наследует все лучшее от предыдущих и на-
правлена на повышение производительности и эффективности работы пользова-
телей.

В версии AutoCAD 2016 компания Autodesk предлагает архитекторам, дизай-
нерам, инженерам и проектировщикам новый инструмент для еще более полного 
воплощения их идей в реальность.
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Требования.к.системе
AutoCAD может работать как в автономном режиме, так и в локальной сети.

Для эффективной работы 32-разрядной версии AutoCAD 2016 под управле-
нием операционной системы Windows необходимы следующие программные и 
аппаратные средства:

�� операционные системы: Windows® 8 Standard, Enterprise или Professional 
edition; Windows® 7 Enterprise, Ultimate, Professional, или Home Premium 
edition; Windows® XP Professional или Home edition (c пакетом обновле-
ний SP2 или более поздним);

�� процессор: Windows® XP – двухъядерный процессор Intel® Pentium® IV 
или AMD Athlon с тактовой частотой 1,6 ГГц или выше, с поддержкой тех-
нологии SSE2; Windows® 7 или Windows® 8 – двухъядерный процессор 
Intel® Pentium® IV или AMD Athlon с тактовой частотой не менее 3,0 ГГц, 
с поддержкой технологии SSE2;

�� браузер: Windows Internet Explorer® 7.0 или более поздний;
�� оперативная память: 2 Гбайт (рекомендуется 4 Гбайт);
�� монитор VGA с разрешением не менее 1024×768 и поддержкой режима 

True Color (рекомендуется 1600×1050);
�� жесткий диск: 6 Гбайт свободного места для установки;
�� привод компакт-дисков: DVD-ROM (для установки программы).

Для работы 64-разрядной версии AutoCAD 2016 необходимо:

�� операционные системы: все перечисленные для 32-разрядной версии 
AutoCAD 2016;

�� процессор: AMD Athlon 64, AMD Opteron™, Intel® Xeon® с поддержкой 
Intel® EM64T или Intel® Pentium® IV с поддержкой Intel® EM64T (все с 
технологией SSE2);

�� браузер: Windows Internet Explorer® 7.0 или более поздний;
�� оперативная память: 2 Гбайт (рекомендуется 4 Гбайт);
�� монитор VGA с разрешением не менее 1024×768 и поддержкой режима 

True Color (рекомендуется 1600×1050);
�� жесткий диск: 6 Гбайт свободного места для установки;
�� привод компакт-дисков: DVD-ROM (для установки программы).

Дополнительные требования к программным и аппаратным средствам, необхо-
димые для 3D-моделирования:

�� процессор: Pentium® IV или AMD Athlon c тактовой частотой 3 ГГц или 
выше; либо двухъядерный процессор Intel или AMD с тактовой частотой 
2 ГГц или выше;

�� дополнительно 6 Гбайт свободной памяти на жестком диске, необходимой 
для установки;
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�� видеоадаптер с экранным разрешением 1280×1024 с памятью не менее 
128 Мбайт, а также с поддержкой режима True Color, технологии Pixel 
Shader 3.0 или более поздней версии; графический адаптер класса рабочих 
станций с поддержкой Direct3D®.  

Запуск.AutoCAD
Запуск AutoCAD осуществляется следующими способами: 

�� на Панели задач выберите из меню Start → Programs → Autodesk → Auto-
CAD 2016;

�� на Рабочем столе Windows дважды щелкните на пиктограмме AutoCAD 2016.

При запуске AutoCAD предлагает создать новый неименованный рисунок. 
Можно либо начать создавать в нем объекты, либо загрузить с диска один из уже 
имеющихся файлов.

При открытии ранее подготовленного рисунка всем системным переменным 
присваиваются значения, которые они имели в ходе последнего сеанса работы с 
ним. Это происходит благодаря тому, что переменные сохраняются в файле вместе 
с рисунком.

Если же вы начинаете работу «с нуля», следует предварительно задать ряд 
установок. Обычно это делается автоматически с помощью Мастера подготовки 
Wizard Description. AutoCAD позволяет менять установки и в ходе сеанса, если 
возникает такая необходимость.

Вызов.справочной.системы
В любой момент работы с AutoCAD можно получить доступ к 
электронной документации по программе. Для этого необходимо 
выбрать в падающем меню пункт Help (рис. 1.1). Альтернативный 
вариант – нажать клавишу F1 на функциональной клавиатуре или 
ввести символ ? в командной строке.

Рис. 1.1. Падающее меню справочной системы

Вызов справочной системы
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Падающее меню Help содержит следующие пункты:

�� Help – загрузка справочной системы;
�� Download Offline Help – cкачать справочную систему для работы в режиме 

вне сети:
�� Additional Resources – дополнительные ресурсы:

•� Support Knowledge Base – база знаний службы поддержки: часто задавае-
мые вопросы, сведения о последних обновлениях продукта, информа-
ция о дискуссионных группах, специальные программы поддержки 
(требуется соединение с Интернетом);

•� Online Training Resources – ресурсы для интерактивного обучения: инфор-
мация об авторизованных учебных центрах Autodesk и прочих учебных 
центрах, сведения о сертификации, ссылки на дискуссионные группы, 
средства обучения (требуется соединение с Интернетом);

•� Online Developer Center – интерактивный центр разработчика: постоян-
но обновляющиеся ресурсы, содержащие ответы на вопросы, заданные 
пользователями, образцы приложений, электронную документацию 
(требуется соединение с Интернетом);

•� Developer Help – загрузка системы документации для разработчиков;
•� Autodesk User Group International – группы пользователей Autodesk во всем 

мире;
�� Send Feedback – обратная связь (требуется соединение с Интернетом);
�� Customer Involvement Program… – загрузка программы вовлечения пользо-

вателей Autodesk;
�� Desktop Analytics... – загрузка программы настольной аналитики;
�� About AutoCAD 2016 – загрузка информации о программе.

Открытие.рисунков
Программа AutoCAD по умолчанию записывает внутреннее представление ри-
сунка в файл с расширением DWG. Кроме рисунка, файл содержит ряд парамет-
ров, определяющих значения переключателей режимов шага привязки SNAP, сет-
ки GRID, ортогонального режима ORTHO; принятые единицы измерения и точность 
представления; границы рисунка; организацию слоев; форматы и логотипы; раз-
мерные и текстовые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирования Multiple Design 
Environment (MDE), которая допускает одновременное открытие нескольких 
чертежей. В одном сеансе работы можно открывать неограниченное количество 
рисунков, не жертвуя при этом производительностью. Среда MDE позволяет пе-
ретаскивать объекты, копировать их свойства, такие как цвет, слой, тип линии, из 
одного рисунка в другой. Она обеспечивает параллельную работу с несколькими 
рисунками, не прерывая выполнения текущей команды и не нарушая последова-
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тельности действий. Это существенно упрощает выполнение многих операций и 
повышает эффективность работы.

Открыть существующий рисунок можно с помощью команды OPEN, 
которая вызывается из падающего меню File → Open… (Ctrl+O) или щелч-
ком на пиктограмме Open… панели быстрого доступа.

После обращения к команде OPEN на экране AutoCAD появляется диалоговое 
окно выбора файла Select File (рис. 1.2). Здесь можно выбрать файл из списка или 
ввести его имя в поле File name:.

Рис. 1.2. Диалоговое окно выбора файла

При выделении в списке одного из файлов в области Preview появляется соот-
ветствующий образец рисунка. Нажатие кнопки Views выводит список, изменяя 
параметры которого, пользователь может выбрать форму представления файлов, 
предлагаемых для открытия: список, таблицу, образцы.

При нажатии стрелки справа от кнопки Open (в правом нижнем углу диалого-
вого окна) в списке устанавливается режим открытия файлов – Open (Открыть), 
Open Read-Only (Открыть для чтения), Partial Open (Открыть частично), Partial Open 
Read-Only (Открыть для чтения частично). Частичное открытие позволяет загру-
жать только те объекты рисунка, которые принадлежат определенным слоям или 
видовым экранам. Это оказывается полезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следует выбрать необходи-
мые файлы в диалоговом окне Select File, используя клавишу Shift или Ctrl.

Открытие рисунков
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Кроме того, рисунки можно открывать путем перетаскивания из Проводника 
Windows. Для этого один или несколько выделенных в дереве Проводника файлов 
следует перетащить с помощью мыши в любую часть окна AutoCAD, за исклю-
чением области рисунка, например на командную строку или в ту часть панелей 
инструментов, которая не занята кнопками. Если же перетащить один файл в об-
ласть рисования уже открытого рисунка, то произойдет вставка содержимого пе-
ретаскиваемого документа в текущий рисунок в качестве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени соответствующего 
файла в Проводнике Windows, что приведет к автоматическому запуску AutoCAD. 
Если же в системе уже ведется сеанс работы в AutoCAD, то рисунок откроется в 
нем.

В AutoCAD имеется специальное средство просмотра небольших фрагментов 
рисунков, открытия файлов рисунков и их поиска. Его можно использовать для 
поиска файлов в структуре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска файлов Find, показанного 
на рис. 1.3, необходимо в диалоговом окне Select File последовательно щелкнуть на 
кнопках Tools → Find….

Рис. 1.3. Диалоговое окно просмотра и поиска файлов
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На вкладке Name & Location диалогового окна Find указываются имя, расшире-
ние и область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам их создания, пользуясь 
вкладкой Date Modified диалогового окна Find (рис. 1.4). Здесь организуется поиск 
файлов, созданных или измененных в период между двумя указанными датами 
либо за определенное количество последних дней или месяцев. Имена найденных 
документов отображаются в нижней части диалогового окна.

Рис. 1.4. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей версии, открываются 
как любой документ версии 2016 и автоматически преобразуются в новый формат.

Создание.рисунков
При создании рисунка могут использоваться различные стандарты. Иногда они 
диктуются государственными и отраслевыми стандартами или нормами предприя-
тия, иногда – требованиями заказчика. Ключевой момент как для непосредствен-

Создание рисунков
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ных исполнителей, так и для руководителей групп, контролирующих ход выпол-
нения проекта, – это грамотная подготовка начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект. Он может включать в 
себя множество разделов: планы этажей, схемы сетей водоснабжения, канализа-
ции, отопления, вентиляции и т. п. Обычно каждый раздел проекта разрабатыва-
ется в отдельном подразделении, поэтому здесь остро встает проблема унифика-
ции. Наиболее грамотное ее решение – обеспечение всех исполнителей файлами 
шаблонов, настроенными на используемую систему единиц и содержащими стан-
дартные рамку, основную надпись, слои и типы линий.

Не менее важно, какие стили применяются для текстовых надписей, штрихова-
ния и нанесения размеров. Их также следует задавать заранее: это дает гарантию, 
что каждый проектировщик будет действовать без отклонения от оговоренных 
стандартов.

Следует ответственно подходить к выбору рабочего масштаба. Только четкое 
представление о том, как соотносятся единицы рисунка на экране и единицы чер-
тежа, выводимого на плоттер, позволяет правильно выбрать высоту текста для по-
яснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на последних стадиях проек-
тирования, грамотное планирование на предварительных этапах позволяет избе-
жать многих ошибок и избавить персонал от излишних операций редактирования. 
При создании проекта работа, как правило, ведется в пространстве модели (здесь 
объекты представляются в натуральную величину), а для компоновки чертежа 
выполняется переход в пространство листа, где ко всем графическим объектам, 
текстам, типам линий и размерам применяется необходимый масштабный коэф-
фициент.

Все начальные установки рисунка могут быть сохранены в шаблоне для по-
следующего использования в других документах. В качестве шаблона могут 
применяться как рисунки, поставляемые с AutoCAD, так и любые другие, в том 
числе созданные пользователем. Новый рисунок наследует всю информацию из 
используемого шаблона. Имеется также возможность запускать AutoCAD без 
шаблона.

Создать новый рисунок позволяет команда NEw, вызываемая из 
падаю щего меню File → New... (Ctrl+N) или щелчком на пиктограмме 
New панели быстрого доступа.

После запуска команды открывается диалоговое окно выбора шаблона Select 
tamplate (рис. 1.5) (в том случае, если значение системной переменной STARTUP 
установлено в 0).

Если значение системной переменной STARTUP установлено в 1, то после запу-
ска команды NEw выводится диалоговое окно создания нового рисунка Create New 
Drawing  (рис. 1.6), где производятся необходимые настройки параметров рабочей 
среды AutoCAD.
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Рис. 1.5. Диалоговое окно выбора шаблона

Рис. 1.6. Диалоговое окно создания нового рисунка

Создание рисунков
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При создании рисунка по простейшему шаблону используется пикто-
грамма Start from Scratch. В данном режиме устанавливается британ-
ская или метрическая система единиц. Значения многих системных 
переменных, принятые по умолчанию, зависят от того, какая из двух 

систем выбрана. Эти переменные управляют текстом, размерами, сеткой, ре-
жимами привязки, а также устанавливают действующие по умолчанию тип 
линий и файл образцов штриховки:

�� Imperial (feet and inches) – создается рисунок, использующий британскую 
систему единиц измерения (футы и дюймы), по шаблону acad.dwt. При 
этом область рисования, иначе называемая лимитами рисунка, устанавли-
вается равной 12×9 дюймов;

�� Metric – создается рисунок, где используется метрическая система единиц 
измерения (миллиметры), по шаблону acadiso.dwt. При этом устанавли-
вается область рисования 429×297 мм.

Чтобы создать рисунок с использованием шаблона, документа, уста-
новки которого используются как основа для нового рисунка, необхо-
димо в диалоговом окне Create New Drawing щелкнуть на пиктограмме 
Use a Template и в списке Select a Template: указать нужный шаблон, 
содержащий необходимые установки черчения (рис. 1.7). В списке 
перечисляются имена файлов шаблонов с расширением DWT, кото-
рые найдены по стандартному пути, заданному в диалоговом окне на-
строек Options. В шаблонах определяются различные параметры ри-
сунка, в том числе наборы специально созданных слоев, типов линий 
и видов;

Рис. 1.7. Выбор шаблона рисунка
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В AutoCAD имеется так называемый Мастер подготовки Wizard – служебное 
средство для создания нового рисунка. С помощью Мастера подготовки можно, 
взяв за основу текущий шаблон, модифицировать некоторые базовые установки. 
Например, пользователь может автоматически настраивать масштабные коэффи-
циенты для текста в зависимости от общих размеров рисунка. Если рисунки круп-
ные, выбирается большая высота символов, если мелкие – меньшая; таким об-
разом обеспечивается разборчивость текстовых надписей, когда рисунок отобра-
жается на экране целиком.

Для вызова Мастера подготовки необходимо в диалоговом окне Create 
New Drawing щелкнуть на пиктограмме Use a Wizard – откроется окно, 
показанное на рис. 1.8.

Рис. 1.8. Создание нового рисунка с помощью Мастера подготовки

Мастер быстрой подготовки QuickSetup (рис. 1.9) позволяет задать для ново-
го рисунка единицы измерения Units и область рисования Area. Поддерживаются 
следующие типы единиц для рисования и вычерчивания: десятичные – Decimal, 
инженерные – Engineering, архитектурные – Architectural, дробные – Fractional, на-
учные – Scientific.

Далее, указывая ширину Width и длину Length области рисования, пользователь 
тем самым задает граничные пределы рисунка, так называемые лимиты. Именно 
лимитами определяется размер чертежа, впоследствии выводимого на плоттер. 
После того как все параметры заданы, Мастер быстрой подготовки запускает се-
анс рисования в пространстве модели.

Создание рисунков
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Рис. 1.9. Диалоговое окно Мастера быстрой подготовки

Мастер детальной подготовки Advanced Setup (рис. 1.10) позволяет задать для 
нового рисунка тип линейных единиц измерения Units и способ измерения углов 
Angle, указать начало отсчета угла Angle Measure и направление измерения угла 
Angle Direction, определить границы области рисунка Area. В отличие от Мастера 
быстрой подготовки, который настраивает только пространство модели, Мастер 
детальной подготовки воздействует как на пространство модели, так и на про-
странство листа.

Рис. 1.10. Диалоговое окно Мастера детальной подготовки

Любая из установок, произведенных в начале рисования, в дальнейшем может 
быть изменена.
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Подробнее.о.шаблоне
Установленный набор параметров сеанса можно сделать доступным и для рисун-
ков, создаваемых впоследствии. Для этого следует сохранить документ как шаб-
лон. Шаблон обычно представляет собой рисунок, не содержащий никаких гра-
фических объектов и используемый только для хранения стандартных значений 
системных переменных.

Шаблоны (файлы с расширением DWT) – весьма удобное средство создания 
набора рисунков с однотипными настройками. Можно использовать как шабло-
ны, поставляемые с AutoCAD, так и созданные пользователем. Любой имеющийся 
рисунок можно сохранить в качестве шаблона. В этом случае значения всех пара-
метров настройки сохраняемого документа будут наследоваться всеми создавае-
мыми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше всего подготовить 
набор стандартных шаблонов, где представлены чаще всего используемые уста-
новки и базовые элементы:

�� тип и точность представления единиц;
�� лимиты рисунка;
�� настройки режимов шага привязки SNAP, сетки GRID и ортогонального ре-

жима ORTHO;
�� организация слоев;
�� основные надписи, рамки и логотипы;
�� размерные и текстовые стили;
�� типы и веса (толщины) линий.

Никакие изменения, вносимые в рисунок, созданный на основе шаблона, на 
сам шаблон не распространяются.

Определение.границ.рисунка
Команда Limits позволяет установить границы текущего рисунка в 
пространстве модели и в пространстве листа. Она вызывается из па-
дающего меню Format → Drawing Limits. 

Границы рисунка – это пара двухмерных точек в мировой системе координат: ко-
ординаты левого нижнего и правого верхнего углов, определяющие прямоуголь-
ную область. По оси Z границы не устанавливаются.

Запросы команды Limits:

Reset Model space limits: – переустановка лимитов пространства модели,
Specify lower left corner or [ON/OFF] <current>: – левый нижний угол,
Specify upper right corner <current>: – правый верхний угол,
где:

Определение границ рисунка
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�	ON – включается контроль соблюдения границ. При этом AutoCAD от-
вергает все попытки ввести точки с координатами, выходящими за гра-
ницы рисунка;

�	OFF – отключается контроль соблюдения границ рисунка;
�	<current> – используется текущее значение.

Если текущее значение границ рисунка вас устраивает, достаточно нажать 
клавишу Enter.

Лимиты должны полностью охватывать полномасштабную модель. Например, 
если ее размеры 100×200 мм, значения лимитов должны слегка превышать эти 
цифры.

В пространстве листа лимиты обычно задают равными формату листа бумаги. 
Следовательно, сетка (если она включена) покрывает при этом весь скомпоно-
ванный чертеж, включая графические объекты, размерные элементы, основную  
надпись и т. п. Например, если формат листа равен 210×297 мм, следует устано-
вить десятичный формат единиц и определить лимиты указанием точек 0,0 для 
левого нижнего угла прямоугольника и 210,297 – для правого верхнего угла.

Если в пространстве листа отображаются поля листа или подложен заданный 
формат, нельзя задать границы рисунка с помощью команды Limits. В этом слу-
чае лимиты вычисляются и устанавливаются в зависимости от размеров выбран-
ного листа. Включение и отключение отображения полей и разметки листа произ-
водятся на вкладке Display диалогового окна Options.

В пространстве модели лимиты могут быть заданы при создании нового рисун-
ка с помощью Мастера быстрой подготовки или Мастера детальной подготовки.

Выполните упражнение № 4 из раздела 1.

Определение.параметров.сетки
В отличие от ранних версий, где сетка представляла собой упорядоченную после-
довательность точек, в AutoCAD 2016 сетка GRID выглядит как тетрадный лист в 
клетку и покрывает всю область рисунка.

Использование сетки помогает выравнивать объекты и оценивать расстояние 
между ними. Сетку можно включать и отключать в ходе выполнения других ко-
манд. На печать она не выводится.

Включение сетки и определение ее частоты осуществляются на 
вкладке Snap and Grid диалогового окна режимов рисования Drafting 
Settings (рис. 1.11), которое загружается из падающего меню Tools → 
Drafting Settings... или при выборе пункта настройки Grid Settings... кон-
текстного меню, вызываемого щелчком правой кнопки мыши на 
кнопке  Display drawning grid в строке состояния.
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Сетка включается при установке флажка Grid On (F7) (системная переменная 
GRIDMODE).

�� В области Grid style определяется стиль сетки при двухмерном моделирова-
нии (системная переменная GRIDSTYLE):

•� 2D model space – задает точечный стиль сетки для двухмерного простран-
ства модели;

•� Block editor – определяет точечный стиль сетки для редактора блоков;
•� Sheet/layout – задает точечный стиль сетки для листа.

Рис. 1.11. Диалоговое окно определения параметров сетки и шага привязки

�� В области Grid spacing устанавливается частота горизонтальных и верти-
кальных делений сетки:

•� Grid X spacing: – шаг сетки по оси X (системная переменная GRIDUNIT);
•� Grid Y spacing: – шаг сетки по оси Y (системная переменная GRIDUNIT);
•� Major line every: – шаг основной линии (системная переменная GRIDMAJOR).

�� В области Grid behavior определяются свойства сетки (значение 0 систем-
ной переменной GRIDSTYLE): 

Определение параметров сетки
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•� Adaptive grid – настройка сетки (системная переменная GRIDDISPLAY);
•� Allow subdivision below grid spacing – разрешить разбиение имеющегося 

интервала сетки (системные переменные GRIDDISPLAY и GRIDMAJOR);
•� Display grid beyond Limits – показать сетку за лимитами (системная пере-

менная GRIDDISPLAY);
•� Follow Dynamic UCS – сетка отображается в плоскости XY динамической 

ПСК (системная переменная GRIDDISPLAY).

При работе с рисунком включать и отключать сетку следует щелчком 
на кнопке Display drawning grid в строке состояния или нажатием функ-
циональной клавиши F7.

После зуммирования рисунка для лучшего согласования с новым коэффици-
ентом экранного увеличения может потребоваться изменение частоты сетки.

Выполните упражнение № 5 из раздела 1.

Определение.шага.привязки
В режиме шаговой привязки SNAP курсор может находиться только в определен-
ных точках, согласно установленному значению шага, и при этом движется не 
плавно, а скачкообразно между узлами воображаемой сетки, как бы «прилипая» к 
ее узлам. Активность режима шаговой привязки SNAP можно определить визуаль-
но, по скачкообразному движению курсора на экране. Шаговая привязка обычно 
используется для точного указания точек с помощью мыши. Интервал привязки 
задается отдельно по осям X и Y. Включение и отключение режима шаговой при-
вязки могут производиться в ходе выполнения команды.

Шаг привязки не обязательно совпадает с частотой сетки. Сетку часто делают 
достаточно редкой, используя ее исключительно для наглядности, а шаг привязки 
устанавливают меньшим. Допустимо и обратное: установка шага привязки боль-
шего, по сравнению с сеткой.

Включение шаговой привязки SNAP и настройка ее параметров осу-
ществляются на вкладке Snap and Grid диалогового окна режимов ри-
сования Drafting Settings (см. рис. 1.11), которое загружается из падаю-
щего меню Tools → Drafting Settings... или при выборе пункта Snap 
Settings... из контекстного меню, вызываемого щелчком правой кноп-
ки мыши на кнопке  Snap Mode в строке состояния.

Шаговая привязка включается при установке флажка Snap On (F9) (системная 
переменная SNAPMODE).

�� В области Snap spacing задается шаг привязки по горизонтали и вертикали:
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•� Snap X spacing: – шаг привязки по оси X (системная переменная 
SNAPUNIT);

•� Snap Y spacing: – шаг привязки по оси Y (системная переменная 
SNAPUNIT);

•� Equal X and Y spacing – устанавливается равный шаг по осям X и Y.

�� В области Polar spacing определяется шаг полярной привязки (системная 
переменная POLARDIST).

�� В области Snap type устанавливаются стиль и тип шаговой привязки:

•� Grid snap – шаговый тип привязки (системная переменная SNAPTYPE);
•� Rectangular snap – стандартный режим ортогональной привязки (систем-

ная переменная SNAPSTYL);
•� Isometric snap – режим изометрической привязки (системная перемен-

ная SNAPSTYL);
•� PolarSnap – режим полярной привязки (системная переменная 

SNAPTYPE).

При работе с рисунком включать и отключать шаговую привязку сле-
дует щелчком на кнопке Snap Mode в строке состояния или нажатием 
функциональной клавиши F9.

Выполните упражнения № 6 из раздела 1 и L4 из раздела 2.

Совмещение.шаговой.привязки.
с.полярным.отслеживанием
При использовании полярного отслеживания можно установить такой режим ша-
говой привязки, в котором узлы располагаются только вдоль линий полярного 
отслеживания через заданные интервалы.

Для настройки шаговой привязки на совместную работу с полярным отслежи-
ванием необходимо выбрать из падающего меню Tools → Drafting Settings... и затем 
на вкладке Snap and Grid диалогового окна Drafting Settings в области Snap type от-
метить пункт полярной привязки PolarSnap – см. рис. 1.11. Далее в области Polar 
spacing в текстовом поле Polar distance: задать величину шага привязки.

Установка.изометрического.стиля.
сетки.и.шаговой.привязки
Изометрический стиль сетки и шаговой привязки помогает строить двухмерные 
рисунки, представляющие трехмерные объекты (например, куб). Аксонометрия 

Установка изометрического стиля сетки и шаговой привязки
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(в том числе и изометрия) – это не что иное, как средство изображения трехмер-
ных объектов на плоскости, то есть имитация объема, а не трехмерная модель. 
Поэтому изометрические рисунки нельзя рассматривать в перспективной про-
екции или под различными углами. Имитация трехмерности достигается здесь 
за счет расположения объектов по трем изометрическим осям. При нулевом угле 
поворота шаговой привязки направления изометрических осей следующие: 30, 
90 и 150°.

Узлы сетки и шаговой привязки можно ориентировать вдоль левой, правой 
или верхней изометрической плоскости (рис. 1.12); переключение между плос-
костями осуществляется нажатием функциональной клавиши F5 (или сочетания 
Ctrl+E):

�� левая: сетка и шаговая привязка ориентируются вдоль осей, направлен-
ных под углами 90 и 150°;

�� правая: сетка и шаговая привязка ориентируются вдоль осей, направлен-
ных под углами 90 и 30°;

�� верхняя: сетка и шаговая привязка ориентируются вдоль осей, направлен-
ных под углами 30 и 150°.

Рис. 1.12. Оси изометрической сетки 

При выборе изометрического стиля шаговая привязка, сетка и указатель мыши 
в виде перекрестья поворачиваются соответственно выбранным изометрическим 
осям. При определенных условиях в AutoCAD допускается указание только 
тех точек, которые лежат в одной из изометрических плоскостей. Например, 
когда включен ортогональный режим ORTHO, указываемые при рисовании точки 
располагаются в текущей изометрической плоскости. Таким образом, можно 
вначале нарисовать верхнюю плоскость модели, затем, переключившись на левую 
плоскость, построить одну из сторон модели, а после этого завершить построение, 
выбрав правую плоскость.

Для включения изометрии необходимо выбрать из падающего меню Tools →  
Drafting Settings... и далее на вкладке Snap and Grid диалогового окна Drafting Settings 
в области Snap type отметить пункт Isometric snap – см. рис. 1.11.
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Определение.формата.единиц
Размеры каждого из создаваемых в AutoCAD объектов задаются в условных еди-
ницах измерения. Соответствие единиц AutoCAD и единиц существующих мет-
рических систем устанавливается перед рисованием. Так, в одном рисунке едини-
ца может соответствовать одному миллиметру, в другом – одному дюйму и т. д. 
Заданные значения определяют интерпретацию вводимых координат и углов, а 
также вид отображаемых координат и размеров.

Тип и точность представления единиц назначают в диалоговом окне 
определения форматов единиц Drawing Units, показанном на рис. 1.13. 
Оно вызывается из падающего меню Format → Units.... 

Рис. 1.13. Диалоговое окно определения форматов единиц

�� В области Length устанавливаются формат Type: и точность Precision: ли-
нейных единиц измерения:

•� Architectural – архитектурные;

Определение формата единиц
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•� Decimal – десятичные;
•� Engineering – инженерные;
•� Fractional – дробные;
•� Scientific – научные.

  В техническом и архитектурном форматах значения чисел записываются 
в футах и дюймах; при этом предполагается, что условная единица состав-
ляет один дюйм.

�� В области Angle – формат Type: и точность Precision: угловых единиц. Пара-
метр Clockwise определяет отсчет по часовой стрелке. Для измерения угло-
вых величин предлагаются следующие форматы единиц:

•� Decimal Degrees – десятичные градусы;
•� Deg/Min/Sec – градусы/минуты/секунды;
•� Grads – грады;
•� Radians – радианы;
•� Surveyor’s Units – топографические единицы.

�� В области масштаба вставки Insertion scale в списке Units to scale inserted 
content: устанавливаются единицы измерения для вставленных в теку-
щий чертеж элементов – блоков и чертежей. В случае несовпадения еди-
ниц измерения элемент при вставке масштабируется. При этом масштаб 
вставки – это отношение единиц исходного блока и целевого чертежа. 
Если выбрана опция Unitsless, то блок будет вставлен без масштабирова-
ния. В списке предлагаются следующие единицы: безразмерный, дюймы, 
футы, мили, миллиметры, сантиметры, метры, километры, микродюймы, 
милы, ярды, ангстремы, нанометры, микроны, дециметры, декаметры, гек-
тометры, гигаметры, астрономические, световые годы, парсеки.

�� В области Sample Output отображается пример представления линейных и 
угловых величин.

�� В области Lighting в списке Units for specifying the intensity of lighting: осущест-
вляется управление единицами измерения интенсивности фотометричес-
ких источников света в текущем чертеже: международные, американские 
и общие.

Для указания нулевого угла и направления отсчета углов необходимо щелк-
нуть на кнопке Direction.... Появится диалоговое окно выбора направления Direction 
Control – рис. 1.14.

Нулевым называется направление, относительно которого AutoCAD измеряет 
углы. По умолчанию таковым считается направление вправо от исходной точки.

Направление отсчета задается при помощи параметров East – восток, North – 
север, West – запад, South – юг или Other – другое. При выборе последнего открыва-
ется доступ к настройке Angle:, с помощью которой задается угол путем указания 
двух точек в графической зоне экрана или в текстовом поле, куда вводится число-
вое значение угла.
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Рис. 1.14. Диалоговое окно выбора направления

Сохранение.рисунков
Команда сохранения рисунка QsAVE вызывается из падающего 
меню File → Save (Ctrl+S) или щелчком на пиктограмме Save панели 
быстрого доступа.

Команда QsAVE используется в тех случаях, когда уже существующий рису-
нок сохраняется без изменения его имени. Если рисунок новый и его имя не опре-
делено, то QsAVE действует так же, как команда sAVEAs.

Команды sAVE и sAVEAs предназначены для сохранения рисунка под дру-
гим именем. Команда sAVE может вызываться только из командной строки, а 
SAVEAS – из падающего меню File → Save As... (Ctrl+Shift+S). В обоих случаях имя 
документа задается в поле File name: диалогового окна Save Drawing As – рис. 1.15.

Предыдущей копии рисунка на диске присваивается расширение BAK вместо 
DWG. Все предыдущие BAK-файлы с данным именем удаляются. Обновленный 
рисунок записывается с расширением DWG. Если при указании имени файла ока-
зывается, что рисунок с таким названием уже существует, выдается предупреж-
дение и предоставляется возможность перезаписать файл или ввести другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в раскрывающемся 
списке Files of type: диалогового окна Save Drawing As необходимо выбрать пункт 
AutoCAD Drawing Template (*.dwt).

Чтобы обеспечить автоматическое сохранение рисунка через заданные интер-
валы времени, следует использовать системную переменную SAVETIME или вклад-
ку Open and Save диалогового окна Options. Оно вызывается из падающего меню 
Tools → Options.... В последнем случае необходимо поставить флажок автосохране-

Сохранение рисунков
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ния Automatic save в области File Safety Precautions и установить значение интервала 
в минутах между автосохранениями в поле Minutes between saves.

Рис. 1.15. Диалоговое окно сохранения рисунка

Получение.твердой.копии.рисунка
Распечатка чертежа – последний этап при работе с рисунком. Перед выводом 
рисунка на печать необходимо его скомпоновать, то есть определить, какие виды 
должны быть вычерчены. Работа над рисунком ведется на разных этапах либо в 
пространстве модели, либо в пространстве листа. Пространство модели предна-
значено для создания модели – изображения в реальном масштабе. Пространст во 
листа представляет собой аналог листа бумаги, на котором производятся созда-
ние и размещение видов перед выводом на печать.

Как в пространстве модели, так и в пространстве листа может быть один или 
несколько видовых экранов, на которых представлены различные виды модели. 
Компоновка чертежа, по сути дела, представляет собой процесс создания и разме-
щения таких экранов. По завершении компоновки чертеж выводится на принтер 
или плоттер.

Перед выводом рисунка на плоттер можно предварительно просмот-
реть, как он будет размещаться на листе бумаги. Для этого использу-
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ется команда предварительного просмотра PREViEw, вызываемая из падаю-
щего меню File → Plot Preview или щелчком на пиктограмме Plot Preview панели 
быстрого доступа. При этом автоматически включается изменение масштаба 
изображения в режиме реального времени для просмотра мелких деталей чер-
тежа. Для изменения режима масштаба изображения, вывода на плоттер, ис-
пользования панорамирования или выхода из предварительного просмотра 
используется контекстное меню (рис. 1.16), которое вызывается в ответ на на-
жатие правой кнопки мыши.

Рис. 1.16. Контекстное меню

Все установки вывода рисунка на плоттер осуществляются в диалого-
вом окне Plot – Model (рис. 1.17), Это окно загружается командой 
PLOt, вызываемой из падающего меню File → Plot... (Ctrl+P) или щелч-
ком на пиктограмме Plot… панели быстрого доступа.

В диалоговом окне Plot – Model делаются следующие назначения.

�� В области Page setup устанавливается набор параметров листа. Кнопкой 
Add… открывается диалоговое окно добавления набора параметров листа.

�� В области Printer/plotter определяется устройство вывода:

•� Name: – из списка доступных принтеров выбирается устройство для вы-
вода на печать;

•� кнопка Properties… – загружает редактор параметров плоттера, позволяю-
щий изменить текущую конфигурацию плоттера;

•� Plot to file – назначается печать в файл.

�� В области Paper size определяется формат из списка стандартных, разре-
шенных для применения на выбранном устройстве вывода.

�� В области Number of copies устанавливается количество экземпляров.
�� В области Plot area устанавливается печатаемая область:

•� Display – область, отображаемая на экране;
•� Limits – область, указанная в пределах лимитов;

Получение твердой копии рисунка
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•� Window – область, выбранная рамкой.

�� В области Plot offset (origin set to printable area) определяется смещение пе-
чатаемой области по осям X и Y, а также Center the plot – автоматическое 
определение смещений по X и Y при размещении чертежа в центре листа.

�� В области Plot scale определяются масштаб печати и веса линий:

•� Fit to paper – печатаемая область масштабируется для вписывания в ука-
занный формат листа;

•� Scale: – значение масштаба печати;
•� Scale lineweights – масштабирование веса линий.

�� В области Plot style table (pen assignments) определяется таблица стилей пе-
чати. Кнопка Edit… загружает диалоговое окно редактора таблиц стилей 
печати Plot style table Editor.

�� В области видовых экранов с тонированием Shaded viewport options опре-
деляются:

•� Shade plot – способ вывода видов на печать: как на экране, каркас из 
предыдущих версий, скрытие линий из предыдущих версий; концеп-
туальный, скрытие линий, реалистичный; тонированный, тонирован-
ный с кромками, оттенки серого, эскизный, каркас, просвечивание; с 
визуализацией, черновой, низкий, средний, высокий, презентационный;

•� Quality – задание качества печати тонированных и визуализированных 
видовых экранов: черновое, просмотр, нормальное, презентационное, 
максимальное, пользовательское;

•� DPI – задание разрешения (точек/дюйм) для печати тонированных и ви-
зуализированных видов.

�� В области Plot options определяются параметры печати:

•� Plot in background – печатать в фоновом режиме (системная переменная 
BACKGROUNDPLOT);

•� Plot object lineweights – печатать с учетом весов линий, назначенных объ-
ектам и слоям;

•� Plot transparency – печатать объекта с учетом его прозрачности;
•� Plot with plot styles – учитывать стили печати, применяемые к объектам 

и слоям;
•� Plot paperspace last – печатать объекты листа последними;
•� Hide paperspace objects – скрывать объекты листа;
•� Plot stamp on – включить режим нанесения штемпелей в определенном 

углу каждого чертежа или запись соответствующей информации в файл 
журнала. Кнопка Plot stamp Settings… загружает диалоговое окно штем-
пеля чертежа Plot stamp;

•� Save changes to layout – сохранение всех изменений параметров, внесен-
ных в текущем диалоговом окне.

�� В области Drawing orientation определяется ориентация чертежа:
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•� Portrait – книжная ориентация, то есть верх страницы соответствует ко-
роткой стороне листа;

•� Landscape – альбомная ориентация, то есть верх страницы соответствует 
длинной стороне листа;

•� Plot upside-down – поворот чертежа на 180°.

�� Кнопка Preview… загружает окно предварительного просмотра.
�� Кнопка Apply to Layout сохраняет настройки печати для текущего листа.

Рис. 1.17. Диалоговое окно вывода на печать пространства модели

Выход.из.AutoCAD
Для выхода из AutoCAD используется команда QUit, которая вызывается из па-
дающего меню File → Exit (Ctrl+Q).

Команда позволяет сохранить или проигнорировать сделанные в рисунке из-
менения и выйти из AutoCAD. Если все выполненные изменения сохранены, при 
выходе из программы не появится никаких дополнительных сообщений. В про-
тивном случае на экран будет выведено диалоговое окно AutoCAD (рис. 1.18), пред-
лагающее пользователю выбор: сохранить изменения, отказаться от них или про-
должить сеанс работы.

Выход из AutoCAD
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Рис. 1.18. Диалоговое окно сохранения изменений в рисунке

Если текущему рисунку не было присвоено имя и вы хотите его сохранить, от-
кроется диалоговое окно Save Drawing As – см. рис. 1.14.
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На рис. 2.1. показан рабочий стол AutoCAD для Windows. Интерфейс AutoCAD 
2016 выполнен в темных тонах.

Рис. 2.1. Рабочий стол AutoCAD

В рабочий стол включены:

1. Кнопка меню приложения – кнопка в верхнем левом углу программы;
2. Панель быстрого доступа Quick Access Toolbar – меню в левой верхней части 

окна;
3. Заголовок чертежа – надпись в верхней части окна по центру;
4. Инфоцентр – инструменты в верхней части окна справа;
5. Элементы управления окном AutoCAD – в верхней части окна справа;
6. Падающие меню Menu Browser – меню в верхней части окна;
7. Ленты – сгруппированные инструменты под падающими меню; 
8. Управление видами – вкладки слева, вверху;
9. Элементы управления окнами чертежа – справа вверху;

10. Видовой куб – в правом верхнем углу графического поля;
11. Панель навигации – справа на графическом поле;
12. Пиктограмма осей координат – слева внизу на графическом поле;
13. Строка состояния – строка внизу окна программы;
14. Окно командных строк – выше строки состояния;
15. Графическое поле, занимающее остальную часть рабочего стола.

При желании темную цветовую схему можно переключить на тради-
ционный светлый вариант интерфейса. Для этого необходимо вы-

1 2 3 4 56 78 910

1112 1314 15
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брать в падающем меню пункты Tools → Options..., затем в открывшемся диа-
логовом окне Options на вкладке Display в области Widow Elements в списке Color 
scheme: выбрать пункт Light (рис. 2.2).

Рис. 2.2. Рабочий стол AutoCAD Light

Кнопка.меню.приложения
Кнопка меню приложения располагается в верхнем левом углу программы 
(рис. 2.3) и служит для создания, открытия, публикаций чертежей, а также для 
поиска команд.

Раскрывающееся меню содержит следующие инструменты:

��  Recent Documents – отображение последних документов.

��  Open Documents – отображение открытых документов.

��  порядок отображения документов:

•� By Ordered List – по упорядоченному списку;
•� By Access Date – по дате обращения;
•� By Size – по размеру;
•� By Type – по типу.

��  форма отображения:

Кнопка меню приложения
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Рис. 2.3. Меню кнопки приложения

•� Small Icons – мелкие значки;
•� Large Icons – крупные значки;
•� Small Images – малые изображения;
•� Large Images – крупные изображения.

��  Create a new drawing – создание нового чертежа:
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•�  Drawing – создание нового чертежа на основе выбранного шаблона;

•� Sheet Set – создание файла данных подшивки для управления 
лис тами чертежа, путями к файлам и данными проекта;

��  Open a file – открытие чертежа:

•�  Drawing – открытие ранее созданного чертежа;

•� Sheet Set – открытие файла данных подшивки в Диспетчере под-
шивок;

•�  DGN – импорт данных из файла DGN в новый файл DWG;

��  Save – сохранение текущего чертежа;

��  Save a copy of the drawing – сохранение копии текущего чертежа:

•� Drawing – сохранение текущего чертежа в формате файлов DWG 
по умолчанию;

•� Drawing Tamplate – сохранение файла DWT шаблона чертежей, по 
которому будут создаваться новые чертежи;

•� Drawing Standards – сохранение файла стандартов чертежей DWS, 
по которому будет проверяться соответствие чертежей стандар-
там;

•� Other formats… – сохранение текущего чертежа в формате файлов 
DWG, DWT, DWS или DXF;

•� Save Layout as a Drawing – сохранение всех видимых объектов с 
текущего листа в пространстве модели нового чертежа;

•� DWG Convert – сохранение;

�� Export to a different format – экспорт текущего чертежа в другой фор-
мат:

•� DWF – экспорт текущего чертежа в формат DWF с возможностью 
переопределения набора параметров листа;

Кнопка меню приложения
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•� DWFx – экспорт текущего чертежа в формат DWFx с возможно-
стью переопределения набора параметров листа;

•� 3D DWF – экспорт текущего чертежа в формат DWF или DWFx 
трехмерной модели и его отображение в программе просмотра 
файлов DWF;

•� PDF – экспорт текущего чертежа в формат PDF с возможностью 
переопределения набора параметров листа;

•� DGN – экспорт текущего чертежа в формат DGN с созданием од-
ного или нескольких файлов;

•� FBX – экспорт текущего чертежа в формат FBX;

•� Other Formats – экспорт текущего чертежа в другой формат фай-
лов;

�� Share the drawing – предоставление доступа к чертежу с помощью 
службы:

•� Send to 3D Print Service – отправка в службу 3D печати объектов, 
являющихся телами и непроницаемыми сетями;

•� Archive – упаковка файлов текущей подшивки для хранения в ар-
хиве;

•� eTransmit – создание пакета из файлов чертежей и их взаимосвя-
зей;

•� Email – отправка текущего файла чертежа в виде вложения в со-
общение электронной почты;

�� Output the drawing to a plotter or other device – вывод текущего черте-
жа на устройство печати:

•� Plot – вывод текущего чертежа на плоттер, принтер или в файл;

•� Batch Plot – пакетная публикация нескольких листов или черте-
жей на плоттере, принтере или в файлы DWF, PDF;

•� Plot Preview – предварительный просмотр текущего чертежа в том 
виде, в котором он будет выведен на печать;
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•� View Plot and Publish Details – отображение подробной информации 
о выполненных задачах печати и публикации;

•� Page Setup – задание параметров компоновки листа, устройства 
печати, формата бумаги и других параметров для каждого нового 
листа;

•� Manage Plotters – вывод Диспетчера плоттеров, предназначенного 
для добавления или редактирования конфигурации плоттера;

•� Manage Plot Styles – вывод Диспетчера стилей печати, предназна-
ченного для редактирования таблицы стилей печати;

•� Edit Plot Style Tables – управление именованными стилями печати, 
присоединенными к текущему листу;

�� Tools to maintain the drawing – инструменты работы с текущим чер-
тежом:

•� Drawing Properties – отображение и установка свойств файла теку-
щего чертежа;

•� Units – задание формата отображения, а также точности коорди-
нат и углов;

•� Audit – проверка целостности чертежа и корректировка отдель-
ных ошибок;

•� Status – получение статистических данных о текущем чертеже, 
его режимах и границах;

•� Purge – удаление из текущего чертежа неиспользуемых имено-
ванных элементов, таких как блоки, слои и пр.;

•� Recover – восстановление поврежденного файла чертежа;

•� Open the Drawing Recovery Manager – загрузка Диспетчера восста-
новления чертежей после сбоя программы или системы;

�� Close the drawing – закрыть чертеж:

•� Current Drawing – закрыть текущий чертеж;

Кнопка меню приложения
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•� All Drawings – закрыть все открытые чертежи.

��  – открытие диалогового окна настройки рабочей среды Options.

��  – выход из программы.

Панель.быстрого.доступа
Панель быстрого доступа располагается в верхней левой части рабочего стола 
AutoCAD (рис. 2.4). 

Список команд, которые можно добавить на панель быстрого доступа, содер-
жится в списке, раскрывающемся при щелчке мышью на стрелке в правой части 
панели. 

Рис. 2.4. Панель быстрого доступа

Падающие.меню
Строка падающих меню устанавливается/скрывается в контекстном меню панели 
быстрого доступа выбором пункта Show Menu Bar/ Hide Menu Bar (см. рис. 2.4).

По умолчанию строка падающих меню содержит следующие пункты (рис. 2.5):
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Рис. 2.5. Строка падающих меню

�� File – команды работы с файлами: создание, открытие, сохранение, публи-
кация в Интернете, печать, экспорт файлов в другие форматы, а также дис-
петчеры параметров листов, плоттеров, стилей печати и пр.;

�� Edit – инструменты для редактирования частей графического поля, ин-
струменты для работы с буфером обмена и пр.;

�� View – управление экраном, зуммирование, панорамирование, установ-
ка трехмерной точки зрения, создание видовых экранов и именованных 
видов, установка визуальных стилей, тонирование, анимация траектории 
перемещения, установка необходимых панелей инструментов;

�� Insert – команды вставки блоков, внешних объектов, объектов других при-
ложений;

�� Format – команды работы со слоями и их инструментами; цветом, типами 
линий; управление стилями текста, размеров, мультилиний, таблиц; ви-
дом маркера точки, установки единиц измерения, границ чертежа;

�� Tools – управление рабочими пространствами; палитрами; установка по-
рядка прорисовки объектов и получение сведений о них; работа с блоками 
и их атрибутами; работа с языком AutoLISP; работа с пользовательской 
системой координат; настройка стандартов оформления; управление Мас-
терами (публикации в Интернете, установки плоттеров, создания таблиц 
стилей печати, цветозависимых стилей печати, компоновки листа, созда-
ния подшивки, импорта параметров печати); установка параметров черче-
ния и привязок с помощью диалоговых окон; и пр.;

�� Draw – команды двухмерного и трехмерного рисования;
�� Dimension – команды простановки размеров и управления параметрами 

размерных стилей;
�� Modify – команды редактирования элементов чертежа;
�� Parametric – команды параметризации зависимостей и доступа к Диспет-

черу параметров;
�� Window – многооконный режим работы с чертежами;
�� Help – вывод на экран системы гипертекстовых подсказок;
�� Express – быстрый доступ к часто используемым инструментам.

Строку падающих меню можно изменить путем добавления либо уда-
ления тех или иных пунктов. Для этого необходимо выбрать в падаю-
щем меню пункты Tools → Customize → Interface..., в появившемся диа-
логовом окне настройки интерфейса пользователя Customize User Inter-
face на вкладке Customize в области Customizatios in All CUI Files раскрыть 
пункт Menus (рис. 2.6). Далее установить указатель мыши на один из 
пунктов меню и, нажав правую кнопку мыши, вызвать контекстное 
меню, в котором выбрать соответствующий пункт для удаления имею-
щихся или создания новых падающих меню.

Падающие меню
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Рис. 2.6. Диалоговое окно адаптации меню

Ленты
В отличие от предыдущих версий, AutoCAD 2016 не предлагает классического ин-
терфейса. Все инструменты расположены на лентах (рис. 2.7). Содержимое лент 
зависит от выбранного рабочего пространства.

Рис. 2.7. Лента в рабочем пространстве для двухмерного моделирования
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Рабочие пространства включают ленты с наборами инструментов, инструмен-
тальные панели и палитры, сгруппированные и упорядоченные соответственно 
решаемой задаче. Элементы интерфейса, не являющиеся необходимыми для ре-
шения текущей задачи, скрываются, максимально освобождая область экрана, до-
ступную для работы.

В AutoCAD определены следующие рабочие пространства:

�� Drafting & Annotation – двухмерное моделирование (см. рис. 2.7);
�� 3D Basics – основные инструменты трехмерного моделирования (рис. 2.8);
�� 3D Modeling – трехмерное моделирование (рис. 2.9).

Рис. 2.8. Лента с основными инструментами трехмерного моделирования

Рис. 2.9. Лента в рабочем пространстве для трехмерного моделирования

Рабочее пространство устанавливается с помощью инструмента Workspaces, 
расположенного в строке состояния.

Помимо возможности установить рабочее пространство, инструмент Workspaces 
включает следующие пункты:

�� Save Current As… – открытие диалогового окна Save Workspace, позволяю-
щего сохранить текущее рабочее пространство;

�� Workspace Settings… – открытие диалогового окна Workspace Settings, позво-
ляющего настроить текущие параметры рабочего пространства для после-
дующего использования;

�� Customize… – открытие диалогового окна Customize User Interface, позволяю-
щего осуществить настройки интерфейса пользователя.

Строка.состояния
Строка состояния (рис. 2.10) расположена в нижней части рабочего стола.

Рис. 2.10. Строка состояния

Она содержит текущие координаты курсора – Coordinates, а также кнопки 
включения/выключения режимов черчения:

Model or Paper space – переключение из пространства модели в про-
странство листа;

Строка состояния
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Display drawing grid – включение и выключение отображения сетки;

Snap mode – включение и выключение шаговой привязки курсора;

Infer Constraints – включение и выключение подразумеваемых геомет-
рических зависимостей;

Dynamic Input – включение и выключение динамического ввода;

Restrict cursor orthogonally (Ortho Mode) – включение и выключение орто-
гонального режима;

Restrict cursor  to specified angles (Polar Tracking ) – включение и выключе-
ние режима полярного отслеживания;

Isometric Drafting – включение и выключение среды изометрического 
черчения;

Show snapping reference lines (Object Snap Tracking) – включение и выклю-
чение режима объектного отслеживания;

Snap  cursor to 2D reference points (2D Object Snap) – включение и выклю-
чение режимов объектной привязки;

Show/Hide Lineweight – включение и выключение режима отображения 
линий в соответствии с весами (толщинами);

Transparency – включение и выключение прозрачности;

Selection Cycling – включение и выключение циклического выбора;

Snap cursor to 3D reference points (3D Object Snap) – включение и выключе-
ние режимов трехмерной объектной привязки;

Snap UCS to active solids plane (Dynamics UCS) – включение и выключение 
динамической пользовательской системы координат;

Filters object selection – включение и выключение фильтров выбора объ-
екта;

Show gizmos – включение и выключение Gizmo;

Show annotation objects – At current scale (Annotation Visibility)  – включение 
видимости аннотаций: показываются аннотативные объекты для любо-
го масштаба;

Add scales to annotative objects when the annotation scale changes (AutoScale)  – 
автоматическое добавление масштабов к аннотативным объектам при 
изменении масштаба аннотаций;
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Annotation Scale of the current view – включение масштаба аннотаций;

Workspace Switching – выбор и установка рабочего пространства;

Annotation Monitor – включение и выключение аннотативного монитора;

Current drawing units – единицы измерения текущего чертежа;

Quick Properties – включение и выключение Панели 
быстрых свойств объектов;

Isolate Objects – изолирование объектов;

Hardware Acceleration – включение и выключение ап-
паратного ускорения;

Clean Screen – очистка экрана.

Customization – контекстное меню, предназначенное 
для отображения кнопок включения/выключения 
режимов черчения в строке состояния (рис. 2.11). 

Окно.командных.строк
Окно командных строк обычно расположено над строкой со-
стояния; оно служит для ввода команд и вывода подсказок 
и сообщений AutoCAD. Размеры окна, а следовательно, ко-
личество выводимых строк протокола можно изменять. При 
наличии в окне команд более одной строки перемещение по 
строкам осуществляется с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по ширине 
окну AutoCAD (рис. 2.12). 

Изменить высоту окна можно с помощью разделительной 
полосы, находящейся в его верхней части (если оно закрепле-
но внизу) или в нижней (если оно закреплено вверху). Чтобы 
изменить размер, следует захватить разделительную полосу с 
помощью мыши и «отбуксировать» ее до требуемой высоты.

Окно может быть как закрепленным, так и плавающим. 
Закрепление отменяется путем выбора рамки окна в любом 
месте и последующей буксировки за пределы зоны закрепле-
ния до тех пор, пока граница окна не примет вид широкой 

Рис. 2.11. Контекстное меню настройки строки состояния

Окно командных строк
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контурной линии. Если отпустить окно в этот момент, оно станет плавающим и 
приобретет размер, который имело до закрепления. Плавающее окно может быть 
перемещено в любую позицию экрана; при этом пользователю разрешено изме-
нять его ширину и высоту (рис. 2.13).

Рис. 2.12. Закрепленное окно командных строк

Рис. 2.13. Плавающее окно командных строк

Закрепляется окно команд путем «буксировки» к верхней или нижней зоне 
закрепления окна AutoCAD.

В окне командных строк можно прокручивать текст, выполнять его редактиро-
вание и повторно вводить команды. Для этого используются стандартные клави-
ши: ↑, ↓, ←, →, Insert, Delete, Home, End, Page Up, Page Down, Backspace.

При повторении ранее введенных команд удобно воспользоваться комбинаци-
ей клавиш Ctrl+C, чтобы копировать выделенный текст в буфер обмена, и Ctrl+V, 
чтобы вставить содержимое буфера в текстовое окно или окно команд.
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Щелчок правой кнопкой мыши в области окна командных строк или текстового 
окна AutoCAD вызывает контекстное меню, куда входят шесть последних исполь-
зованных команд, функции копирования выделенного текста или всего протокола 
команд, вставки текста, а также вызова диалогового окна настройки Options.

Текстовое.окно
Просмотреть большую часть протокола команд – так называемую историю ко-
манд (command history) – можно, переключившись в текстовое окно, показанное 
на рис. 2.14. Оно вызывается нажатием функциональной клавиши F2 или коман-
дой tEXtsCR, а также из падающего меню View → Display → Text Window F2.

Рис. 2.14. Текстовое окно

Текстовое окно подобно окну команд: в нем также можно вводить команды, 
наблюдать подсказки и сообщения, выдаваемые AutoCAD. Для перемещения по 
окну используются полоса прокрутки или клавиши ↑, ↓, ←, →, Page Up и пр.

Содержимое текстового окна предназначено только для чтения и не подлежит 
изменению. Но протокол команд можно копировать для последующей вставки в 
командную строку или текстовый редактор.

Контекстное.меню
Для выбора пунктов меню и пиктограмм на панели инструментов часто использу-
ется устройство указания – мышь. При работе с мышью нажатие левой кнопки в 
области рисования обычно используется для выбора и указания точки на экране; 
щелчок правой кнопкой мыши вызывает контекстное меню, которое обеспечивает 
быстрый доступ к командам. Форма и содержание меню зависят от положения 
указателя мыши и состояния задачи.

При щелчке правой кнопкой мыши в области рисования вызывается одно из 
шести контекстных меню:

Контекстное меню
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�� стандартное – вызывается при отсутствии выбранных объектов и актив-
ных команд. Содержит последнюю используемую команду, набор стан-
дартных функций, предназначенных для работы с буфером обмена, ко-
манды зуммирования, панорамирования, а также вызов диалогового окна 
настройки рабочей среды Options (рис. 2.15);

Рис. 2.15. Пример стандартного контекстного меню

�� команда – вызывается при выполнении какой-либо команды. Содержит 
набор ключей, отображаемых в командной строке и облегчающих выпол-
нение текущей команды с помощью мыши (рис. 2.16);

Рис. 2.16. Пример контекстного меню команды CIRCLE
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�� объектная привязка – вызывается при щелчке правой кнопкой мыши и 
одновременном нажатии клавиши Shift. Позволяет выбрать или настро-
ить режимы объектной привязки и включить координатный фильтр 
(рис. 2.17);

�� редактирование – вызывается при выбранном одном или нескольких объ-
ектах и отсутствии активных команд. Объединяет функции, предназна-
ченные для редактирования объектов. Набор функций может изменяться 
в зависимости от типа выбранного объекта (рис. 2.18);

           Рис. 2.18. Контекстное меню редактирования

�� ручки – вызывается при выделенной на объекте активной ручке. Содер-
жит функции, позволяющие проводить редактирование с помощью ручек 
(рис. 2.19);

�� OLE – вызывается при щелчке правой кнопкой мыши на вставленном в 
рисунок OLE-объекте. Объединяет функции, позволяющие редактиро-
вать OLE-объекты (рис. 2.20).

Рис. 2.17. Контекстное 
меню объектной привязки

Контекстное меню
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Рис. 2.19. Контекстное меню ручек

Рис. 2.20. Контекстное меню OLE
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Контекстные меню объектная привязка, ручки и OLE всегда включены, а пото-
му их можно вызывать в любой момент. Контекстные же меню стандартное, ре
дактирование и команда можно отключить. В этом случае щелчок правой кнопкой 
мыши будет соответствовать нажатию клавиши Enter. По умолчанию вызов этих 
трех контекстных меню включен.

Для других элементов окна AutoCAD, кроме области рисования, можно вы-
зывать следующие контекстные меню:

�� командная строка – вызывается щелчком правой кнопкой мыши на ко-
мандной строке или в окне команд. Служит для вызова функций, исполь-
зуемых при работе с командной строкой (рис. 2.21);

Рис. 2.21. Контекстное меню командной строки

�� диалоговое окно – вызывается щелчком правой кнопкой мыши на элементе 
диалогового окна. Доступно не для всех диалоговых окон и, как правило, 
связано либо с раскрывающимися списками, либо с полями для ввода зна-
чений и позволяет удалять, переименовывать отдельные пункты списка 
или работать с буфером обмена (рис. 2.22);

�� строка состояния – вызывается щелчком правой кнопкой мыши на обла-
сти строки состояния, где выводятся текущие координаты, либо на любой 
кнопке переключения режимов рисования или изменения настроек. Слу-
жит для переключения режимов рисования или изменения их настроек 
(рис. 2.23);

�� вкладки Model/Layout – вызывается щелчком правой кнопкой мыши на 
вкладке Model или одной из вкладок Layout. Используется для вызова окон 
печати и настройки параметров страницы, а также управления листами 
(рис. 2.24).

Контекстное меню
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Рис. 2.22. Пример контекстного меню диалогового окна

     

Рис. 2.24. Пример контекстного меню вкладки 
Model/Layout

Рис. 2.23. Пример контекстного 
меню строки состояния
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Инструментальные.палитры
Инструментальные палитры загружаются командой tOOLPALEttEs  
из падающего меню Tools → Palettes → Tool Palettes (Ctrl+3) либо щелч-
ком на пиктограмме Tool Palettes на ленте View в группе Palettes.

Инструментальные палитры представляют собой 
отдельные вкладки, объединенные в специальном окне 
Tool Palettes (рис. 2.25) и являются эффективным сред-
ством хранения и вставки, например, блоков и штри-
ховки, а также могут содержать инструменты, предо-
ставленные сторонними разработчиками.

В разных областях окна инструментальных палитр с 
помощью контекстных меню можно изменять следую-
щие настройки:

�� автоматически убирать палитры с экрана – 
окно инструментальных палитр может автома-
тически разворачиваться и сворачиваться при 
подведении указателя мыши к строке заголов-
ка окна и отведении от нее;

�� прозрачность – окно палитры инструментов де-
лается прозрачным и не скрывает находящие ся 
за ним объекты;

�� вид – изменяются стиль и размер отображае-
мых на палитре значков.

Окно инструментальных палитр при необходимо-
сти можно закрепить у правой или левой границы окна программы. Для того что-
бы избежать закрепления, при перемещении окна следует удерживать нажатой 
клавишу Ctrl.

На палитрах удобно размещать часто используемые блоки и штриховки. Для 
того чтобы вставить блок или штриховку из палитры в рисунок, необходимо «за-
хватить» элемент палитры с помощью мыши и перетащить его в графическую 
область. При перетаскивании блоков с палитры можно использовать объектную 
привязку, однако шаговая привязка в это время не действует. Некоторые свойства 
инструментов, включая масштаб, угол поворота и слой, могут устанавливаться от-
дельно для каждого из их.

При перетаскивании блока с инструментальной палитры на рисунок он автома-
тически масштабируется в зависимости от соотношения заданных единиц блока и 
единиц текущего рисунка. Например, если в качестве единиц измерения данного 
рисунка используются метры, а в качестве единиц измерения блока – сантиметры, 
то коэффициент пересчета составляет 1:100. Соответственно, при перетаскивании 
блока в рисунок его размеры меняются в пропорции 1:100.

Рис. 2.25. Инструмен-
тальная палитра

Инструментальные палитры
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Для изменения свойств инструментов, например масштаба блока и угла пово-
рота образца штриховки, необходимо щелкнуть правой кнопкой мыши на инстру-
менте, а затем выбрать из контекстного меню пункт свойств объекта Properties…. 
Далее в диалоговом окне свойств инструмента Tool Properties изменяются следую-
щие свойства (рис. 2.26):

�� название инструмента и пояснение к нему;
�� параметры вставки или образца – угол поворота, масштаб;
�� общие свойства – слой, цвет, тип линий и стиль печати.

Рис. 2.26. Диалоговое окно свойств инструментов палитры

Для добавления инструментов на палитру можно:

�� перетаскивать рисунки, блоки и штриховки из Центра управления на ин-
струментальную палитру. Если туда занесен целый рисунок, то при пере-
таскивании с палитры на графическую область он вставляется как блок;

�� перетаскивать на палитру элементы чертежа;



61

�� перемещать и копировать инструменты с одной палитры на другую при 
помощи команд контекстного меню Cut – Вырезать, Copy – Копировать и 
Paste – Вставить;

�� перетаскивать на палитру команды из области Command List: диалогового 
окна Customize User Interface.

Можно создать новую палитру. Чтобы она сразу оказалась заполнена инстру-
ментами, необходимо щелкнуть правой кнопкой мыши на папке, файле рисунка 
или блоке в Центре управления, а затем выбрать из контекстного меню пункт 
Create Tool Palette.

Порядок размещения инструментов на палитре изменяется в результате пере-
таскивания их с помощью мыши.

Если в нижнем углу палитры высвечивается значок замка, это значит, что фай-
лу инструментальной палитры присвоен атрибут только чтения Read only.

Настройки инструментальных палитр сохраняются в профиле AutoCAD. 
А экспортируются и импортируются палитры как файлы с расширением XTP.

Центр.управления.AutoCAD.
DesignCenter
В практической деятельности очень важно иметь возможность использовать соз-
данные ранее наработки: опыт показывает, что большинство проектно-конструк-
торских работ создается на базе новых сочетаний элементов, давно известных как 
по принципу функционирования, так и по исполнению. AutoCAD обеспечивает 
эффективное повторное использование имеющихся наработок путем их вставки в 
рисунки в виде блоков или внешних ссылок. Управлять блоками, внешними ссыл-
ками, растровыми изображениями и содержимым рисунков, находящихся в дру-
гих источниках (и даже подготовленных в других приложениях), позволяет Центр 
управления AutoCAD DesignCenter.

Кроме того, если в сеансе открыто несколько рисунков, Центр управления 
дает возможность упростить процесс создания таких элементов, как, например, 
описания одних и тех же слоев. Пользователь создает описание в одном рисунке, 
а затем просто копирует в остальные.

Центр управления DesignCenter предназначен для организации доступа к 
чертежам и их элементам и обеспечивает:

�� просмотр содержимого чертежей, на локальных и сетевых дисках, а также 
веб-страницах;

�� просмотр и вставку в текущий чертеж блоков, слоев, текстовых и размер-
ных стилей, типов линий, внешних ссылок, образцов штриховки и прочих 
элементов чертежей;

�� доступ к растровым изображениям и сторонним объектам, созданным в 
других приложениях;

Центр управления AutoCAD DesignCenter
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�� обновление описания блоков;
�� перетаскивание элементов чертежа на инструментальные палитры.

Центр управления AutoCAD загружается командой ADCENtER, либо 
из падающего меню Tools → Palettes → DesignCenter (Ctrl+2), либо щелч-
ком на пиктограмме DesignCenter на ленте View в группе Palettes 
(рис. 2.27).

Рис. 2.27. Центр управления DesignCenter

Центр управления имеет интуитивно понятный интерфейс и позволяет быстро 
находить, просматривать, вызывать и применять специфические компоненты, та-
кие как блоки, слои, типы линий и пр. Причем эти операции осуществляются из 
открытых или закрытых файлов AutoCAD независимо от того, где они находятся: 
на локальных или удаленных дисках. Достаточно просто выбрать нужные компо-
ненты и перетащить их в текущий рисунок.

Панель инструментов, расположенная вверху Центра управления DesignCenter, 
обеспечивает доступ к набору режимов и операций, а также осуществляет нави-
гацию внутри окна и просмотр информации в области структуры и содержимого. 
Область структуры находится слева, в ней отображаются источники содержимо-
го. Справа находится область содержимого, предназначенная для добавления эле-
ментов в чертеж или на инструментальную палитру. Область просмотра образца и 
пояснений к нему расположена справа внизу окна.

Центр управления включает следующие вкладки:

�� Folders – вкладка, отображающая дерево иерархической структуры папок. 
Если слева, в области структуры с помощью мыши выбрать элемент, то 
справа отобразится его содержимое;
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�� Open Drawings – вкладка, отображающая список чертежей, открытых в те-
кущий момент. Для того чтобы справа в области содержимого отобразить 
элементы, необходимо слева в области структуры выбрать файл чертежа, 
а затем из списка – одну из таблиц описаний;

�� History – вкладка, отображающая список последних файлов, открывав-
шихся с помощью Центра управления. При двойном нажатии в списке на 
файле чертежа открывается папка Folders с этим чертежом и его элемента-
ми в области содержимого.

Для добавления элементов из области содержимого в текущий чертеж вы-
бранный элемент достаточно перетащить в графическую область чертежа либо 
воспользоваться одним из вариантов, предлагаемых в контекстном меню. Также 
из области содержимого Центра управления можно перетащить чертежи, блоки и 
штриховки на текущую инструментальную палитру.

Просмотр.и.поиск.содержимого
Для просмотра элементов содержимого, находящихся в текущем источнике, слу-
жит зона содержимого, или палитра, – средство AutoCAD, предназначенное для 
просмотра содержимого открытых рисунков и других источников, а также образ-
цов и описаний перед вставкой идентифицируемых ими объектов в рисунок. Кро-
ме того, палитра может использоваться для поиска на диске файлов рисунков по 
их содержимому.

Просматривать открытые рисунки, журнал предыдущих рисунков, а также 
файлы и папки локального и сетевых дисков можно в зоне структуры, которая 
является хорошим помощником при перемещении по содержимому рисунка, но 
ее присутствие на экране необязательно для загрузки палитры.

На палитре отображаются крупные значки, а в зоне структуры показана струк-
тура Рабочего стола. Перемещаясь по структуре, можно выбирать источники и за-
гружать их содержимое в палитру.

Ниже приводятся способы размещения Центра управления AutoCAD на Ра-
бочем столе:

�� для изменения размеров окна следует захватить с помощью мыши его гра-
ницу, разделитель зон или ручку в правом нижнем углу и перетащить ее в 
нужное положение;

�� для освобождения окна нужно щелкнуть на его заголовке, перетащить 
окно за пределы зоны закрепления и отпустить кнопку мыши. Окно ста-
нет плавающим, и его можно будет перемещать в любое место экрана;

�� для закрепления окна нужно либо перетащить его в одну из зон закрепле-
ния (в левой или правой части окна AutoCAD), либо дважды щелкнуть 
мышью на заголовке плавающего окна. При перетаскивании окна никакие 
особые действия по закреплению не нужны – оно закрепляется само, до-
стигнув крайней части области рисования.

Просмотр и поиск содержимого
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В дополнение к поиску рисунков с нужными элементами вручную пу-
тем перемещения по структуре Центр управления AutoCAD обеспечи-
вает автоматический поиск рисунков, описаний блоков и слоев, а так-
же элементов сторонних приложений по именам. Для этого использу-
ется инструмент Search, при щелчке на котором открывается диалого-
вое окно Search – рис. 2.28.

Рис. 2.28. Диалоговое окно поиска

Здесь можно настроить поиск по различным критериям, в том числе по дате 
последнего изменения. Допускается также поиск по фрагментам текста, содержа-
щимся в текстовых описаниях блоков или в полях свойств рисунка. Например, 
если имя рисунка неизвестно, его можно найти по ключевому слову, заданному в 
свойствах. Если же пользователь желает отыскать созданный им блок, но не пом-
нит точно, как он был сохранен (в рисунке или в отдельном файле), следует задать 
в качестве критерия имя блока, а из списка Look for выбрать Drawings and Blocks. Вы-
бранный тип определяет вид вкладок диалогового окна. Далее необходимо ввести 
в поле In начальный участок поиска или нажать кнопку Browse... и выбрать его в 
структуре диска. Если поиск должен охватывать все уровни, подчиненные указан-
ному, требуется установить флажок для просматривания вложенных папок Search 
subfolders.
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Если в списке Look for выбран пункт Drawings, то в диалоговом окне Search по-
являются три вкладки, на которых можно задать различные критерии поиска:

�� Drawings – имя или текст для поиска, возможно, вместе с именем свойства. 
Разрешается задавать искомый текст и указывать, к чему он относится 
(к названию файла, имени автора и т. д.);

�� Date Modified – дата или диапазон дат создания или последнего измене-
ния искомого элемента содержимого. Может также задаваться в формате 
during the previous N month(s) – за последние N месяцев или during the previous 
N day(s) – за последние N дней. По умолчанию AutoCAD не ограничивает 
поиск по дате;

�� Advanced – дополнительные параметры поиска. Здесь можно, например, 
настроить поиск рисунков, содержащих некоторую текстовую строку 
(в именах блоков, именах или значениях атрибутов, а также в текстовых 
описаниях элементов). Кроме того, предусмотрено ограничение поиска по 
минимальному или максимальному размеру файла. При поиске допуска-
ется ввод как всей текстовой строки, так и отдельного ее фрагмента. Мож-
но также использовать глобальные символы (* и ?).

Если в списке Look for выбрано значение, отличное от Drawings, то в диалоговом 
окне Search появляется одна из нижеперечисленных вкладок:

�� Blocks – поиск блоков по именам;
�� Dimstyles – поиск размерных стилей по именам;
�� Drawings and Blocks – поиск рисунков и блоков по именам;
�� Hatch Pattern Files – поиск файлов образцов штриховки по именам;
�� Hatch Patterns – поиск образцов штриховки по именам;
�� Layers – поиск слоев по именам;
�� Layouts – поиск листов по именам;
�� Linetypes – поиск типов линий по именам;
�� Multileaderstyles – поиск стилей мультивыносок;
�� Tablestyles – поиск табличных стилей по именам;
�� Textstyles – поиск текстовых стилей по именам;
�� Xrefs – поиск внешних ссылок по именам.

Для запуска механизма поиска следует нажать кнопку Search Now. Записи о 
найденных элементах отображаются в диалоговом окне по мере их обнаружения. 
Для нового поиска с другими критериями нужно воспользоваться кнопкой New 
Search. После щелчка на ней список с результатами предыдущего поиска будет 
очищен.

Элемент содержимого, найденный во время поиска и занесенный в таблицу 
результатов, можно добавить в открытый рисунок. Результат поиска также можно 
загрузить непосредственно на палитру Центра управления.

Для смены источника содержимого зоны структуры необходимо в Центре 
управления AutoCAD открыть одну из следующих вкладок или выбрать их из 

Просмотр и поиск содержимого



Глава 2. Пользовательский интерфейс AutoCAD66

контекстного меню, щелкнув правой кнопкой мыши на свободной части палит-
ры:

�� Folders – перечень локальных и сетевых дисков;
�� Open Drawings – перечень рисунков, открытых в данный момент в AutoCAD;
�� History – перечень последних 20 элементов, открытых через Центр управ-

ления AutoCAD.

Центр управления AutoCAD предоставляет очень простой способ открытия 
файлов рисунков – пользователю достаточно всего лишь перетащить значок вы-
бранного файла в пустую часть области рисования. При этом следует быть внима-
тельным, так как перетаскивание значка не в пустую часть, а на открытый рисунок 
приведет к другому результату.

Для перетаскивания необходимо, чтобы хотя бы часть области рисования не 
была покрыта рисунками. Этого можно достичь, уменьшив размеры открытых 
окон или свернув их. Если при перетаскивании вывести указатель мыши за преде-
лы окна AutoCAD, он примет форму перечеркнутого круга – значит, оставлять 
рисунок в этом месте нельзя.

Таким образом, с помощью Центра управления AutoCAD можно:

�� просматривать различные источники содержимого рисунков, начиная с 
документов, открытых в текущем сеансе AutoCAD, и вплоть до библиотек 
обозначений на веб-страницах;

�� просматривать описания блоков, слоев и других элементов в любом файле 
рисунка, вставлять и копировать эти описания в текущий рисунок;

�� создавать ярлыки для часто используемых рисунков, папок и интернет-
страниц;

�� находить рисунки с нужным содержимым на локальном и сетевых дис-
ках. Так, например, можно разыскать рисунок, в котором имеется слой с 
заданным именем, либо файл, сохраненный до или после указанной даты. 
Найденный рисунок можно загрузить в Центр управления или перета-
щить непосредственно в текущий документ;

�� открывать рисунки путем перетаскивания DWG-файлов с палитры в об-
ласть рисования;

�� просматривать и вставлять растровые изображения путем перетаскива-
ния их файлов с палитры в область рисования;

�� управлять представлением элементов палитры (крупные или мелкие знач-
ки, список или таблица). Также предусмотрено отображение на палит ре 
образцов и текстовых описаний элементов рисунка.
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Пользователь имеет возможность изменять различные параметры рабочей среды 
AutoCAD, влияющие на конфигурацию интерфейса и условия рисования. Такие 
настройки называются профилем. Пользователи, входящие в систему под одним 
именем, могут загружать свои настройки из различных профилей. Целесообразно 
использование профилей для сохранения настроек, присущих разным проектам.

Процедура настройки рабочей среды AutoCAD осуществляется в диа-
логовом окне Options, которое вызывается из падающего меню Tools → 
Options... или из стандартного контекстного меню при условии, что нет 
выполняющихся команд или выбранных объектов. Диалоговое окно 
Options содержит 11 вкладок, описанных ниже.

Определение.доступа.к.файлам.
поддержки
На вкладке Files диалогового окна Options, показанной на рис. 3.1, задаются пути 
доступа к файлам поддержки, где хранятся шрифты для текста, файлы адаптации, 
подключаемые модули, шаблоны рисунков, чертежи для вставки, типы линий и 
образцы штриховок, используемые AutoCAD. Здесь перечисляются все пути до-
ступа к папкам, которые должны существовать в текущей структуре папок локаль-
ного и подключенных сетевых дисков.

В области Search paths, file names, and file locations: содержатся тематические за-
головки путей доступа к файлам и папкам поддержки:

�� Support File Search Path – путь доступа к вспомогательным файлам;
�� Working Support File Search Path – путь поиска рабочих вспомогательных 

файлов;
�� Trusted Location – путь надежного расположения;
�� Device Driver File Search Path – путь доступа к драйверам устройств;
�� Project Files Search Path – путь доступа к файлам проектов;
�� Customization Files – файлы адаптации;
�� Help and Miscellaneous File Names – имена файлов справочной системы и др.;
�� Text Editor, Dictionary, and Font File Names – имена файлов текстового редак-

тора, словаря и шрифтов;
�� Print File, Spooler, and Prolog Section Names – имена файла печати, программы 

фоновой печати и раздела пролога;
�� Printer Support File Path – путь к вспомогательным файлам печати;
�� Automatic Save File Location – папка для файла автосохранения;
�� Color Book Locations – папки для альбомов цветов;
�� Data Sources Location – положение источников данных;
�� Template Settings – параметры шаблонов;
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�� Tool Palettes File Locations – папки с файлами инструментальных палитр;
�� Authoring Palette File Locations – папки файлов палитры вариаций;
�� Log File Location – расположение файла журнала;
�� Action Recorder Settings – параметры рекордера операций;
�� Plot and Publish Log File Location – папка для файла журнала печати/публи-

кации;
�� Temporary Drawing File Location – папка для временных файлов;
�� Temporary External Reference File Location – папка для временных файлов 

внешних ссылок;
�� Texture Maps Search Path – папка для поиска текстур;
�� Web File Search Path – папка для поиска веб-файлов;
�� i-drop Associated File Location – папка для связанных файлов точек загрузки;
�� DGN Mapping Setups Location – папка параметров соответствия DGN.

Рис. 3.1. Вкладка определения доступа к файлам поддержки

Определение доступа к файлам поддержки



Глава 3. Настройка рабочей среды AutoCAD70

Настройка.параметров.рабочего.экрана
На вкладке Display диалогового окна Options, показанной на рис. 3.2, можно осу-
ществлять настройку параметров рабочего экрана AutoCAD.

Рис. 3.2. Вкладка настройки параметров рабочего экрана

�� В области элементов окна Window Elements настраиваются следующие па-
раметры:
•� Color scheme: – установка тона фоновой области инструментов (строки 

состояния, заголовка, ленты, рамки меню): Dark – темная; Light: – свет-
лая;

•� Display scroll bars in drawing window – включение/отключение полос про-
крутки в нижней и правой части графического поля;

•� Use large buttons for Toolbars – изменение размера пиктограмм инструмен-
тов с 16×16 на 32×32 пиксела;

•� Resize ribbon icons to standard sizes – изменение размера пиктограмм до 
стандартного (системная переменная RIBBONICONRESIZE);
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•� Show ToolTips – включение/отключение всплывающих подсказок при 
наведении указателя мыши на пиктограммы инструментов (системная 
переменная TOOLTIPS);

•� Show shortcut keys in ToolTips – включение/отключение комбинации кла-
виш в подсказках;

•� Show extended ToolTips – включение/отключение расширенных описаний 
в подсказках;

•� Number of seconds to delay – установка времени задержки между отобра-
жением основных и расширенных подсказок;

•� Show rollover ToolTips – управление ролловерами подсказок для выделен-
ных объектов (системная переменная ROLLOVERTIPS);

•� Display File Tabs – включение/отключение вкладок с именами открытых 
чертежей в левом верхнем углу области рисования;

•� кнопка Colors... – загрузка диалогового окна Drawing Window Colors, для 
изменения цвета элементов рабочего стола AutoCAD (рис. 3.3):
◊� список Context: – выбор объекта, в контексте которого будет изме-

нен цвет элемента: 2D model space – пространство двухмерной моде-
ли, Sheet/layout – лист, 3D parallel projection – трехмерная параллельная 
проекция, 3D perspective projection – трехмерная перспективная проек-
ция, Block editor – редактор блоков, Command line – командная строка, 
Plot preview – просмотр печати;

◊� список Interface element: – выбор элемента интерфейса, цвет которого 
необходимо установить. Для 2D model space и Sheet/layout – однород-
ный фон, перекрестье, вектор автоотслеживания, маркер автопривяз-
ки, подсказка при прочерчивании, фон подсказки, источники света, 
яркое пятно, спад освещенности, начальный предел, конечный пре-
дел, цвет обозначений камер, усеченная камера/плоскость усечения, 
плоскости подрезки камер, световая сетка, форма источника света, 
освещенность на расстоянии. Для 3D parallel projection – однородный 
фон, перекрестье, основные линии сетки, промежуточные линии сет-
ки, осевые линии сетки и далее, аналогично пространству двухмерной 
модели. Для 3D perspective projection – верх небесного фона, фоновый 
небесный горизонт, фоновое наземное начало, фоновый наземный 
горизонт, низ земного фона, фоновый земной горизонт и далее, ана-
логично трехмерной параллельной проекции. Для Block editor – одно-
родный фон, перекрестье, вектор автоотслеживания, маркер авто-
привязки, подсказка при прочерчивании, фон подсказки, источники 
света, яркое пятно, спад освещенности, начальный предел, конечный 
предел, световая сетка, форма источника света, освещенность на 
расстоянии. Для Command line – однородный фон и текст. Для Plot 
preview – однородный фон;

◊� список Color: – выбор оттенка из цветовой палитры;

Настройка параметров рабочего экрана
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◊� Tint for X, Y, Z – оттенок для осей;
◊� кнопка Restore current element – восстановление цвета по умолчанию 

для выбранного элемента интерфейса;
◊� кнопка Restore current context – восстановление цветов по умолчанию 

для всех элементов интерфейса, выбранного контекста;
◊� кнопка Restore all contexts – восстановление цветов по умолчанию для 

всех элементов интерфейса;
◊� кнопка Restore classic colors – восстановление классических цветовых 

настроек AutoCAD 2008 только для элементов интерфейса простран-
ства двухмерной модели;

◊� в области Preview: демонстрируется образец с текущими установками 
цвета;

Рис. 3.3. Диалоговое окно изменения цвета элементов рабочего стола AutoCAD
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•� кнопка Fonts... – загрузка диалогового окна Command Line Window Font для 
изменения шрифта текста командной строки (рис. 3.4). В этом диало-
говом окне устанавливаются: Font: – шрифт, Font Style: – начертание и 
Size: – размер. В области Sample Command Line Font показывается образец 
шрифта командной строки.

Рис. 3.4. Диалоговое окно изменения шрифтов

�� В области Layout elements назначаются следующие параметры простран-
ства листа:
•� Display Layout and Model tabs – управление отображением ярлыков вкла-

док Layout и Model в нижней части графического поля;
•� Display printable area – управление отображением границ печатаемой об-

ласти на листе чертежа, показанных штриховой линией;
•� Display paper background – управление отображением фона;
•� Display paper shadow – управление отображением тени вокруг границ 

лис та;
•� Show Page Setup Manager for new layouts – управление выводом Диспетчера 

параметров для новых листов;
•� Create viewport in new layouts – назначение автоматического создания ви-

дового экрана на новых листах.
�� В области экранного разрешения Display resolution определяются:
•� Arc and circle smoothness – управление плавностью отображения дуг, 

окружностей и эллипсов (диапазон значений от 1 до 20 000, команда 
ViEwREs);

•� Segments in a polyline curve – установка количества сегментов в дугах по-
лилиний (диапазон значений от –32 767 до –32 767, системная перемен-
ная SPLINESTGS);

•� Rendered object smoothness – управление плавностью отображения тони-
рованных объектов (диапазон значений от 0.01 до 10, системная пере-
менная FACETRES);

Настройка параметров рабочего экрана
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•� Contour lines per surface – установка числа образующих для изображения 
поверхностей (диапазон значений от 0 до 2047, системная переменная 
ISOLINES).

�� В области Display performance настраивается производительность отобра-
жения объектов:
•� Pan and zoom with raster & OLE – управление динамическим отображением 

в реальном времени растровых изображений и OLE-объектов (систем-
ная переменная RTDISPLAY);

•� Highlight raster image frame only – управление подсветкой растровых 
изобра жений при их выборе. При установке флажка подсвечиваются 
только границы растра (системная переменная IMAGEHLT);

•� Apply solid fill – управление заливкой плоских фигур и полилиний нену-
левой ширины. Настройка вступает в силу после регенерации чертежа 
(системная переменная FILLMODE);

•� Show text boundary frame only – управление отображением текста на экра-
не. При установке флажка отображаются только границы текстов. На-
стройка вступает в силу после регенерации чертежа (системная пере-
менная QTEXTMODE);

•� Draw true silhouettes for solids and surfaces – настройка отображения конту-
ра трехмерного объекта. При установке флажка вычерчиваются кромки 
силуэтов тел и поверхностей (системная переменная DISPSILH).

�� В области Crosshair size задается размер перекрестья в процентах от раз-
мера экрана (системная переменная CURSORSIZE);

�� В области Fade control устанавливается затенение:
•� Xref display – регулировка отображения внешних ссылок (системная пе-

ременная XDWGFADECTL);
•� In-place edit and annotative representations – регулировка интенсивности 

затенения объектов при редактировании вхождений (системная пере-
менная XFADECTL).

Выполните упражнения № 7 – 15 из раздела 1.

Настройка.параметров.открытия.
и.сохранения.файлов
Вкладка открытия и сохранения файлов Open and Save диалогового окна Options 
показана на рис. 3.5.

На ней осуществляется настройка следующих параметров.

�� В области File Save задаются параметры сохранения файлов:
•� список Save As: – установка формата файлов при их сохранении;
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Рис. 3.5. Вкладка настройки параметров открытия и сохранения файлов

•� Maintain visual fidelity for annotative objects – сохранение визуальной чет-
кости аннотативных объектов (системная переменная SAVEFIDELITY);

•� Maintain drawing size compatibility – сохранение совместимости размеров 
чертежа. Системная переменная LARGEOBJECTSUPPORT управляет ис-
пользованием предельных размеров для больших объектов и выводом 
предупреждений при сохранении чертежа;

•� кнопка Thumbnail Preview Setings… – загрузка одноименного диалогового 
окна (рис. 3.6), осуществляющего настройку образцов для просмотра:
◊� флажок Save a thumbnail preview image – создание образца для просмот-

ра (системная переменная RASTERPREVIEW);
◊� Use view when drawing last saved – использование последнего сохранен-

ного вида при формировании миниатюры чертежа;
◊� Use Home View – использование сохраненного вместе с чертежом ис-

ходного вида при формировании миниатюры чертежа;
◊� Set current View as Home – указание текущего вида чертежа в качестве 

исходного;

Настройка параметров открытия и сохранения файлов
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◊� Reset Home to default – восстановление исходного вида, принятого по 
умолчанию;

◊� Generate Sheet, Sheet View and Model View Thumbnails – обновление об-
разцов листов и видов листа/модели в Диспетчере подшивок (си-
стемная переменная UPDATETHUMBNAIL). Линейка указывает на об-
новление образцов при обращении к ним (системная переменная 
UPDATETHUMBNAIL): Perfomance – производительность, Accuracy – точ-
ность;

◊� Named views. Maximum size in pixels: – установка максимального размера 
в пикселях именованных видов.

Рис. 3.6. Диалоговое окно настройки образцов для просмотра

•� Incremental save percentage – определение процента для быстрых сохране-
ний, отражающего максимально допустимый объем устаревшей инфор-
мации, хранимой в файле при быстрых сохранениях (системная пере-
менная ISAVEPERSENT).
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�� В области File Safety Precautions определяются меры предосторожности при 
сохранении:
•� Automatic save – включение функции периодического автоматического 

сохранения файла. Расположение файлов для автосохранения задается 
системной переменной SAVEFILEPATH. Имя файла автосохранения хра-
нится в системной переменной SAVEFILE;

•� Minutes between saves – определение интервала между сохранениями в 
минутах (системная переменная SAVETIME);

•� Create backup copy with each save – обеспечение создания резервных копий 
(системная переменная ISAVEBAK);

•� Full-time CRC validation – осуществление постоянной проверки контроль-
ной суммы, являющееся механизмом проверки целостности данных;

•� Maintain a log file – запись содержимого текстового окна в файл журнала. 
Системная переменная LOGFILEMODE определяет папку для файла жур-
нала. Имя файла хранится в системной переменной LOGFILENAME;

•� File extension for temporary files – определение расширения для временных 
файлов. По умолчанию файлы имеют расширение AC$;

•� кнопка Security Options… – загрузка одноименного диалогового окна, 
предназначенного для определения параметров безопасности, в кото-
ром можно задать пароль для открытия текущего чертежа или цифро-
вую подпись;

•� Display digital signature information – отображение информации о цифровой 
подписи (системная переменная SIGVARN).

�� В области File Open определяются: Number of recently-used files – количе-
ство последних файлов, отображаемых в меню File для быстрого доступа 
(допус тимый диапазон значений от 0 до 9), и Display full path in title – ото-
бражение полного пути чертежа в строке заголовка.

�� В области меню приложения Application Menu определяется Number of 
recently-used files – количество последних файлов, отображаемых в меню 
быстрого доступа. Допустимый диапазон значений от 0 до 50.

�� В области External References (Xrefs) определяются следующие параметры 
внешних ссылок:
•� список Demand load Xrefs: – управление подгрузкой файлов внешних 

ссылок. Подгрузка увеличивает производительность системы путем до-
бавления в чертеж только частей, необходимых для регенерации теку-
щего чертежа (системная переменная XLOADCTL). Выбирается одно из 
значений: Disabled – запрещено, Enabled – разрешено, Enabled with copy – 
разрешено с копированием;

•� Retain changes to Xref layers – сохранение изменений слоев ссылок (си-
стемная переменная VISRETAIN);

•� Allow other users to Refedit current drawing – разрешение редактирования 
рисунка как ссылки (системная переменная XEDIT).

Настройка параметров открытия и сохранения файлов
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�� В области ObjectARX Applications определяются следующие параметры при-
ложений:
•� в списке подгрузки приложений Demand load ObjectARX apps: определя-

ются условия подгрузки приложения в зависимости от установленного 
режима: Disable load on demand – отключение подгрузки по запросу, Cus-
tom object detect – обнаружение сторонних объектов, Command invoke – 
вызов команды, Object detect and command invoke – обнаружение объектов 
и вызов команды (системная переменная DEMANDLOAD);

•� список Proxy images for custom objects: – управление отображением сто-
ронних объектов в чертеже, при выборе одного из режимов: Do not show 
proxy graphics – не показывать прокси-графику, Show proxy graphics – по-
казывать прокси-графику, Show proxy bounding box – показывать только 
рамку (системная переменная PROXYSHOW);

•� Show Proxy Information dialog box: – включение/отключение вывода 
предуп реждения при открытии чертежа, содержащего объекты сторон-
них приложений (системная переменная PROXYNOTICE).

Выполните упражнение № 16 из раздела 1.

Определение.параметров.вывода.
на.печать
Параметры печати задаются на вкладке Plot and Publish диалогового окна Options – 
рис. 3.7.

�� В области Default plot settings for new drawings настраиваются параметры пе-
чати для новых чертежей по умолчанию:
•� Use as default output device – устройство вывода по умолчанию;
•� Use last successful plot settings – установка печати в соответствии с на-

стройками последнего успешно использованного устройства;
•� кнопка Add or Configure Plotters… – добавление и настройка устройств с 

помощью Диспетчера плоттеров.
�� В области Plot to file настраивается печать в файл, то есть определяется рас-

положение файлов чертежей по умолчанию и задается папка, в которую 
должны записываться файлы чертежей при печати в файл.

�� В области Background processing options настраиваются параметры фоновой 
обработки установкой режима поддержки фонового вывода (системная 
переменная BACKGROUNDPLOT): Plotting – печать, Publishing – публикация.

�� В области Plot and publish log file назначается ведение журнала для печати и 
публикаций. Файл журнала содержит: код и имя задания, имена подшив-
ки и категории, дату и время начала и окончания, имя листа, полный путь 
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к файлу, имя выделенного листа, набор параметров листа и путь к набору, 
имя устройства и формата листа, окончательный статус. Осуществляются 
следующие назначения:
•� Automatically save plot and publish log – вести журнал автоматически;

◊� Save one continuous plot log – общий файл журнала для всех операций;
◊� Save one log per plot – отдельный файл журнала для каждой операции.

Рис. 3.7. Вкладка определения параметров вывода на печать

�� В области Auto publish назначается автопубликация:
•� Automatic Publish – автоматическая публикация в файлы DWF, DWFx 

или PDF. Настройка изменяется с помощью системных переменных 
AUTOMATICPUB и AUTOWFPUBLISH;

•� кнопка Automatic Publish Settings… – загрузка диалогового окна Auto 
Publish Options, предназначенного для адаптации настройки параметров 
автоматической публикации, включая время публикации и папку для 
хранения опубликованных файлов.

�� В области общих параметров печати General plot options определяется сле-
дующее:

Определение параметров вывода на печать
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•� Keep the layout paper size if possible – сохранение (если возможно) разме-
ров листа при смене устройства печати (значение 0 системной перемен-
ной PAPERUPDATE);

•� Use the plot device paper size – использование размеров листа из устрой-
ства при смене устройства печати (значение 1 системной переменной 
PAPERUPDATE);

•� список System printer spool alert: – установка режима предупреждения о 
буферизации и выбор способа регистрации ошибок системного прин-
тера, возникших в результате конфликта входного и выходного портов:
◊� Always alert (and log errors) – всегда регистрировать все ошибки;
◊� Alert first time only (and log errors) – в первый раз регистрировать все 

ошибки;
◊� Never alert (and log first error) – в журнале регистрировать только первую 

ошибку;
◊� Never alert (do not log errors) – никогда не регистрировать ошибки;

•� список OLE plot quality: – установка качества печати OLE-объектов (си-
стемная переменная OLEQUALITY):
◊� Monochrome (e.g. spreadsheet) – монохромное (например, таблица);
◊� Low graphics (e.g. color text !& pie charts) – простая графика (например, 

круговая диаграмма);
◊� High graphics (e.g. photograph) – сложная графика (например, фотогра-

фия);
◊� Automatically select – автоматический выбор;

•� Use OLE application when plotting OLE objects – назначение печати OLE-
объектов в приложениях, в которых они были созданы (системная пере-
менная OLESTARTUP);

•� Hide system printers – запрещение показа системных принтеров.

�� В области Specify plot offset relative to определяется отсчет смещения черте-
жа:
•� Printable area – относительно печатаемой области;
•� Edge of paper – относительно кромок листа бумаги.

�� Кнопка Plot Stamp Settings… загружает диалоговое окно Plot Stamp, позволяю-
щее настроить параметры штемпелей чертежей (рис. 3.8):
•� в области Plot stamp fields определяется информация о чертеже для штем-

пеля:
◊� Drawing name – имя и путь чертежа, предназначенного для экспорта;
◊� Layout name – включение имени листа в информацию о штемпеле чер-

тежа;
◊� Date and Time – включение в штемпель информации о дате и времени;
◊� Login name – имя пользователя (системная переменная LOGINNAME);
◊� Device name – включение в штемпель информации о текущем устрой-

стве печати;
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◊� Paper size – формат листа для текущего сконфигурированного устрой-
ства печати;

◊� Plot scale – включение в штемпель информации о масштабе выводи-
мого чертежа;

Рис. 3.8. Диалоговое окно штемпеля чертежа

•� в области Preview демонстрируется образец штемпеля;
•� в области User defined fields дополнительно задается текст, который мож-

но проставить на чертеже или занести в журнал при выводе чертежа на 
печать. Кнопка Add/Edit загружает диалоговое окно User Defined Fields, по-
зволяющее внести добавления и изменения в поля, задаваемые пользо-
вателем;

•� в области Plot stamp parameter file назначается местоположение файла па-
раметров штемпеля в файле с расширением PSS. Кнопки Load и Save As 
позволяют загрузить и сохранить файлы параметров штемпеля;

�� Кнопка Advanced загружает диалоговое окно Advanced Options (рис. 3.9), по-
зволяющее определить дополнительные параметры:
•� в области Location and offset задаются расположения и отступы: Location: – 

расположение штемпеля относительно положения чертежа на странице 
(внизу слева, вверху слева, вверху справа или внизу справа); Orientation: – 
поворот штемпеля относительно указанной страницы (вертикально или 
горизонтально); Stamp upside-down – штемпель чертежа поворачивается 
на 180°�по вертикали; X offset – отступ по X; Y offset – отступ по Y; Offset 
relative to printable area – отступ относительно угла области печати; Offset 
relative to paper border – отступ относительно угла границ листа;

Определение параметров вывода на печать
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•� в области Text properties назначаются свойства текста. Font: – шрифт; 
Height: – высота шрифта; Single line plot stamp – однострочный штемпель;

•� в области Plot stamp units определяются единицы для штемпеля (дюймы, 
миллиметры или пиксели);

•� в области Log file location определяется расположение файла журнала. 
Create a log file – вести журнал в файле; кнопка Browse… загружает диа-
логовое окно обзора файлов.

Рис. 3.9. Диалоговое окно дополнительных параметров

�� Кнопка Plot Style Table Settings… загружает одноименное диалоговое окно, 
позволяющее настроить таблицы стилей печати (рис. 3.10):
•� в области Default plot style behavior for new drawing определяются стили пе-

чати по умолчанию для новых чертежей:
◊� Use color dependent plot styles – использование цветозависимых стилей 

печати (значение 1 системной переменной);
◊� Use named plot styles – применение именованных стилей печати (зна-

чение 0 системной переменной PSTYLEPOLICY);
•� в области Current plot style table settings настраивается текущая таблица 

стилей печати:
◊� в списке Default plot style table – таблица стилей печати по умолчанию, 

представляющая собой файл CTB или STB;
◊� в списке Default plot style for layer 0: – стиль печати по умолчанию для 

слоя 0 (системная переменная DEFLPLSTYLE);
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◊� в списке Default plot style for objects: – стиль печати по умолчанию для 
объектов (системная переменная DEFLPLSTYLE);

•� кнопка Add or Edit Plot Style Tables… загружает Диспетчер стилей печати.

Рис. 3.10. Диалоговое окно параметров таблиц стилей печати

Настройка.системных.параметров
Для настройки системных параметров AutoCAD используется вкладка System 
диалогового окна Options – рис. 3.11.

�� В области Hardware Perfomance определяется производительность трехмер-
ной графики. Кнопка Graphics Perfomance загружает одноименное диало-
говое окно, позволяющее оптимизировать параметры аппаратного и про-
граммного обеспечения трехмерной графики.

�� В области Current Pointing Device выбирается текущее устройство указа-
ния, а также источник входных данных: Digitizer only – только дигитайзер, 
Digitizer and mouse – дигитайзер и мышь.

�� В области Touch Experience устанавливается сенсорный режим панели лен-
ты.

Настройка системных параметров
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Рис. 3.11. Вкладка настройки системных параметров

�� В области Layout Regen Options настраивается регенерация вкладок:
•� Regen when switching layouts – чертеж регенерируется каждый раз при 

переходе на другую вкладку;
•� Cache model tab and last layout – кэширование модели и последнего листа;
•� Cache model tab and all layouts – кэширование модели и всех листов, при этом 

чертеж регенерируется только в первом заходе на каждую из вкладок.
�� В области General Options назначаются общие параметры:
•� кнопка Hidden Messages Settings – загружает диалоговое окно параметров 

скрытых сообщений;
•� Display OLE Text Size Dialog – вывод диалогового окна размера текста OLE-

объектов;
•� Beep on error in user input – оповещение об ошибках пользовательского 

ввода при помощи звукового сигнала;
•� Allow long symbol names – разрешение на использование длинных имен. 

Имя объекта может содержать до 255 символов (системная переменная 
EXTNAMES).
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�� В области Help назначается доступ к справочной системе через онлайн-
контент.

�� В области InfoCenter настраиваются параметры всплывающих уведомле-
ний.

�� В области Security настраиваются параметры безопасности загружаемых 
файлов.

�� В области dbConnect Options устанавливаются параметры подключения к 
базам данных:
•� Store Links index in drawing file – сохранение индекса баз данных внутри 

файла чертежа;
•� Open tables in read-only mode – открытие таблицы баз данных в файле 

только для чтения.

Настройка.пользовательской.среды
На вкладке User Preferences диалогового окна Options можно настроить пользова-
тельскую среду рисования по своему усмотрению (рис. 3.12).

Рис. 3.12. Вкладка настройки пользовательской среды

Настройка пользовательской среды
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�� В области Windows Standard Behavior назначается соответствие стандартам 
Windows событий, происходящих при нажатии клавиш и щелчке правой 
кнопкой мыши:
•� Double click editing – редактирование по двойному нажатию левой кнопки 

мыши в области рисования (системная переменная DBLCLKEDIT);
•� Shortcut menus in drawing area – отображение контекстных меню в области 

рисования (системная переменная SHORTCUTMENU);
•� кнопка Right-click Customization… – загрузка одноименного диалогового 

окна, позволяющего выбрать действия, к которым приводит нажатие 
правой кнопки мыши (системная переменная SHORTCUTMENU) (рис. 3.13):
◊� Turn on time-sensitive right-click – учитывать длительность нажатия пра-

вой кнопки мыши: Quick click for ENTER – кратковременное нажатие 
эквивалентно нажатию клавиши Enter; Longer click to display Shortcut 
Menu – более продолжительное нажатие вызывает контекстное меню; 
Longer click duration: – продолжительность нажатия в миллисекундах;

◊� в области Default Mode настраивается обычный режим. Если нет вы-
бранных объектов и выполняющихся команд, то правая кнопка мыши 
выполняет: Repeat Last Command – повтор последней команды, Shortcut 
Menu – включение стандартного контекстного меню;

◊� в области Edit Mode настраивается режим редактирования. Если объ-
екты выбраны, но нет выполняющихся команд, то правая кнопка 
мыши выполняет: Repeat Last Command – повтор последней команды, 
Shortcut Menu – включение контекстного меню редактирования;

◊� в области Command Mode настраивается командный режим. Если вы-
полняется команда, то правая кнопка мыши производит: ENTER – от-
ключение контекстного меню и имитацию нажатия клавиши Enter, 
Shortcut Menu: always enabled – включение контекстного меню команд, 
Shortcut Menu: enabled when command options are present – контекстное 
меню команды, если команда в текущий момент имеет доступные 
ключи.

�� В области Insertion scale определяется масштаб вставки блоков и чертежей. 
Если единицы вставки не заданы, то используются:
•� Source content units: – единицы исходного чертежа (дюймы, футы, мили, 

миллиметры, сантиметры, метры, километры, микродюймы, милы, 
ярды, ангстремы, нанометры, микроны, дециметры, декаметры, гекто-
метры, гигаметры, астрономические единицы, световые годы, парсеки) 
(системная переменная INSUNINTSDEFSOURCE);

•� Target drawing units: – единицы целевого чертежа (дюймы, футы, мили, 
миллиметры, сантиметры, метры, километры, микродюймы, милы, 
ярды, ангстремы, нанометры, микроны, дециметры, декаметры, гекто-
метры, гигаметры, астрономические единицы, световые годы, парсеки) 
(системная переменная INSUNINTSDEFTARGET).
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Рис. 3.13. Диалоговое окно настройки правой кнопки мыши

�� В области гиперссылок Hyperlink назначается отображение курсора, под-
сказок и контекстного меню для гиперссылок.

�� В области Fields определяются параметры для полей:
•� флажок Display background of fields назначает отображение заднего пла-

на светло-серым фоном, не видимым при выводе на печать (системная 
переменная FIELDDISPLAY);

•� кнопка Field Update Settings… загружает одноименное диалоговое окно, 
позволяющее настроить условия автоматического обновления полей 
(системная переменная FIELDEVAL) (рис. 3.14): Open – при открытии 
файла; Save – при сохранении файла; Plot – при печати файла; eTrans-
mit – при формировании комплекта и пересылке файла; Regen – при ре-
генерации файла.

�� В области Priority for Coordinate Data Entry определяются приоритеты ввода 
координат в командную строку над текущими режимами привязки:
•� Running object snap – корректировка введенных с клавиатуры координат 

с учетом текущих режимов объектной привязки (значение 0 системной 
переменной OSNAPCOORD);

•� Keyboard entry – использование координат, введенных с клавиатуры 
(значение 1 системной переменной OSNAPCOORD);

Настройка пользовательской среды
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•� Keyboard entry except scripts – использование координат, введенных с кла-
виатуры, исключая выполнения сценария пакетных файлов (значение 2 
системной переменной OSNAPCOORD).

Рис. 3.14. Диалоговое окно настройки обновления полей

�� В области Associative Dimensioning назначается создание ассоциативных 
размеров с автоматической настройкой местоположения, ориентации и 
величин измерений (системная переменная DIMASSOC).

�� В области Undo/Redo определяются отмена и повтор операции при масшта-
бировании и панорамировании:
•� Combine zoom and pan commands – объединять ли несколько последова-

тельных команд зуммирования и панорамирования в одну операцию 
при выполнении операций отмены и повтора;

•� Combine layer property change – объединять ли изменения свойств слоев, 
выполненных в Диспетчере свойств слоев.

�� Кнопка Block Editor Settings… загружает одноименное диалоговое окно, по-
зволяющее редактировать настройки блока (рис. 3.15):
•� в области Authoring Objects редактируются вариационные объекты:

◊� Parameter color: – задание цвета параметров в редакторе блоков (си-
стемная переменная BPARAMETERCOLOR);

◊� Grip color: – задание цвета пользовательских объектов ручек в редак-
торе блоков (системная переменная BGRIPOBJCOLOR);

◊� Parameter text alignment: – задание горизонтальной ориентации 
текста параметров в редакторе блоков (системная переменная 
BPTEXTHORIZONTAL); 

•� в области Parameter Font устанавливается шрифт для вариационных объ-
ектов:
◊� Font Name: – список имен всех зарегистрированных шрифтов TrueType 

и SHX-шрифтов (системная переменная BPARAMETERFONT);
◊� Font Style: – стиль форматирования символов шрифта для вариаци-

онных объектов;
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Рис. 3.15. Диалоговое окно настройки редактора блока

•� в области Parameter and Grip Size устанавливается размер параметров и 
ручек:
◊� Parameter size – задание размера текста и функций параметра в редак-

торе блоков (системная переменная BPARAMETERSIZE);
◊� Grip size – задание отображаемого размера настраиваемых ручек в ре-

дакторе блоков (системная переменная BGRIPOBJSIZE);
•� в области Constraint Status переопределяются цвета для объектов в редак-

торе блоков с целью показа состояния зависимости:
◊� Unconstrained: – задание цвета независимых объектов;
◊� Partially constrained: – задание цвета частично зависимых объектов;
◊� Fully constrained: – задание цвета полностью зависимых объектов;
◊� Improperly constrained: – задание цвета избыточно зависимых объектов;

•� Highlight dependent objects during selection – автоматическое выделение 
всех объектов, зависящих от текущих выделенных вариационных объ-
ектов (системная переменная BDEPENDENCYHIGHLIGHT); 

Настройка пользовательской среды
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•� Display tickmarks or parameters with value sets – управление отображени-
ем маркера набора значений для параметров (системная переменная 
BTMARKDISPLAY); 

•� Display action bars – управление отображением панелей операций для вы-
бранных параметров (системная переменная BACTIONBARMODE); 

•� кнопка Reset Values – восстановление значений по умолчанию для пара-
метров редактора блоков.

�� Кнопка Lineweight Settings… загружает одноименное диалоговое окно, по-
зволяющие определить параметры весов линий (рис. 3.16):
•� Lineweights – вывод списка допустимых значений весов линий (систем-

ная переменная LWDEFAULT);
•� Units for Listing – установка единиц измерения весов линий (системная 

переменная LWUNITS): Millimeters (mm) – в миллиметрах, Inches (in) – в 
дюймах;

•� Display Lineweight – отображать линии в соответствии с весами (систем-
ная переменная LWDISPLAY). В раскрывающемся списке Default – ука-
зывается значение веса линии по умолчанию 0,25 мм (0,01 дюйма) (си-
стемная переменная LWDEFAULT);

•� Adjust Display Scale – настройка масштаба экранного отображения весов 
линий для пространства модели;

•� Current Lineweight: – текущий вес линий.

Рис. 3.16. Диалоговое окно настройки параметров весов линий

�� Кнопка Default Scale List… загружает одноименное диалоговое окно, по-
зволяющее изменить список масштабов, который хранится в реестре 
(рис. 3.17). Отображение стандартного списка масштабов возможно в: 
Metric – метрической системе и Imperial – британской системе.
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Рис. 3.17. Диалоговое окно изменения списка масштабов

Управление.точностью.построения.
объектов
На вкладке построений Drafting диалогового окна Options, показанной на рис. 3.18, 
можно сделать следующие назначения.

�� В области AutoSnap Settings назначаются следующие параметры автопри-
вязки:
•� Marker – отображение на экране геометрических маркеров автопривяз-

ки, появляющихся при перемещении курсора по точкам привязки объ-
екта (системная переменная AUTOSNAP);

•� Magnet – включение/отключение магнита автопривязки, который обес-
печивает автоматическое перемещение курсора в ближайшую точку 
привязки (системная переменная AUTOSNAP);

•� Display AutoSnap tooltip – управление выводом всплывающих подсказок 
автопривязки, сообщающих, к какой части объекта осуществляется 
привязка (системная переменная AUTOSNAP);

•� Display AutoSnap aperture box – управление прицелом автопривязки, ко-
торый выводится в центре перекрестья при привязке к точке объекта 
(системная переменная APBOX);

•� кнопка Colors… загружает диалоговое окно Drawing Window Colors (см. 
рис. 3.3), позволяющее изменить цвет маркера автопривязки.

�� В области AutoSnap Marker Size определяется размер маркера автопривязки.

Управление точностью построения объектов
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Рис. 3.18. Вкладка управления точностью построения объектов

�� В области Object Snap Options задаются параметры объектной привязки:
•� Ignore hatch objects – объектная привязка игнорирует линии штриховки 

(системная переменная OSOPTIONS);
•� Ignore dimension extension lines – объектная привязка игнорирует вынос-

ные линии размера (системная переменная OSOPTIONS);
•� Ignore negative Z object snaps for Dynamic UCS – игнорировать для динами-

ческой ПСК объектные привязки с отрицательной координатой Z (си-
стемная переменная OSOPTIONS);

•� Replace Z value with current elevation – заменить при объектной привязке 
координату Z на значение Z уровня в текущей ПСК.

�� В области AutoTrack Settings назначаются следующие параметры автоотсле-
живания:
•� Display polar tracking vector – включаются бесконечные линии полярного 

отслеживания (системная переменная TRACKPATH);
•� Display full-screen tracking vector – включаются бесконечные линии объ-

ектного отслеживания (системная переменная TRACKPATH);
•� Display AutoTrack tooltip – включаются всплывающие подсказки автоот-

слеживания (системная переменная AUTOSNAP).
�	В области Alignment Point Acquisition задаются режимы захвата точек 

отслеживания:
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•� Automatic – автоматический вывод вектора отслеживания при прохож-
дении прицела через точку привязки;

•� Shift to acquire – вывод вектора отслеживания при нажатии клавиши Shift 
и наведении прицела на точку привязки.

�� В области Aperture Size определяется размер прицела автопривязки, кото-
рый появляется в перекрестье курсора при выполнении команд построе-
ния объектов.

�� Кнопка Drafting Tooltip Settings… загружает диалоговое окно Tooltip Appearance 
(рис. 3.19), определяющее внешний вид всплывающих подсказок:
•� Model Preview – предварительный просмотр внешнего вида подсказок в 

пространстве модели;
•� Layout Preview – предварительный просмотр внешнего вида подсказок в 

пространстве листа;
•� кнопка Colors… – загружает диалоговое окно Drawing Window Colors 

(см. рис. 3.3), позволяющее изменить цвет подсказок;
•� Size – изменение размера всплывающих подсказок;
•� Transparency – изменение прозрачности всплывающих подсказок;
•� Override OS settings for all drafting tooltips – замена параметров операци-

онной системы для всех подсказок на чертеже (системная переменная 
DYNTOOLTIPS);

•� Use settings only for Dynamic Input tooltips – замена параметров только для 
подсказок динамического ввода (системная переменная DYNTOOLTIPS).

Рис. 3.19. Диалоговое окно настройки внешнего вида подсказок

Управление точностью построения объектов
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�� Кнопка Lights Glyph Settings… загружает диалоговое окно Light Glyph 
Appearance (рис. 3.20), определяющее внешний вид обозначений источни-
ков света:
•� Glyph Preview – предварительный просмотр образцов обозначений ис-

точников света: Point – точечный источник, Spot – прожектор, Web – 
сетка;

•� кнопка Edit Glyph Colors загружает диалоговое окно Drawing Window Colors 
(см. рис. 3.3), позволяющее редактировать цветовую гамму обозначений 
источников света;

•� Glyph Size: – установка размера обозначений источников света.

Рис. 3.20. Диалоговое окно настройки обозначений  
источников света

�� Кнопка Cameras Glyph Settings… загружает диалоговое окно Camera Glyph 
Appearance (рис. 3.21), определяющее внешний вид обозначения каме-
ры:
•� кнопка Edit Glyph Colors… загружает диалоговое окно Drawing Window 

Colors (см. рис. 3.3), позволяющее редактировать цветовую гамму обо-
значения камеры;

•� Glyph size: – установка размера обозначений камеры.
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Рис. 3.21. Диалоговое окно настройки обозначений камер

Настройка.параметров.трехмерного.
моделирования
Вкладка настройки параметров для работы с телами и поверхностями при трех-
мерном моделировании 3D Modeling диалогового окна Options, показанная на 
рис. 3.22, позволяет сделать следующие назначения.

�� В области 3D Crosshairs определяется стиль отображения трехмерного пе-
рекрестья:
•� Show Z axis in crosshairs – показывать ось Z в перекрестьях;
•� Label axes in standard crosshairs – отображать метки осей в стандартных 

перекрестьях;
•� Show labels for dynamic UCS – показывать метки осей на перекрестье для 

динамической ПСК;
•� Crosshair labels – установка параметров меток на перекрестьях:

◊� Use X, Y, Z – использовать обозначение осей X, Y, Z;
◊� Use N, E, z – использовать обозначения N (север), E (восток), z (уро-

вень);
◊� Use custom labels – использовать обозначение осей пользовательскими 

метками, заданными символами.

Настройка параметров трехмерного моделирования



Глава 3. Настройка рабочей среды AutoCAD96

Рис. 3.22. Вкладка настройки параметров трехмерного моделирования

�� В области Display Tools in Viewport определяются параметры показа обозна-
чения видового куба и значка ПСК:
•� Display  the In ViewCube – показывать видовой куб:

◊� 2D Wireframe visual style  – в двухмерном визуальном стиле;
◊� All other visual style – во всех визуальных стилях;

•� Display the UCS Icon – показывать значок ПСК:
◊� 2D Wireframe visual style  – в двухмерном визуальном стиле;
◊� All other visual style – во всех визуальных стилях;

•� Display the Viewport Control – показывать панель управления видами и ви-
зуальными стилями в левом верхнем углу видового экрана.

�� В области 3D Objects определяются параметры отображения трехмерных 
тел, поверхностей и сетей:
•� в списке Visual Style while creating 3D objects устанавливается визуаль-

ный стиль при создании трехмерных объектов (системная переменная 
DRAGVS): ByViewport – по видовому экрану, 2D Wireframe – двухмерный кар-
кас, 3D Hidden – трехмерный скрытый, 3D Wireframe – трехмерный каркас, 
Conceptual – концептуальный, Hidden – скрытые линии; Realistic – реа-
листичный; Shaded – тонированный; Shaded with edges – тонирован-



97

ный с кромками; Shaded of Gray – оттенки серого; Sketchy – эскизный; 
Wireframe – каркас; X-Ray – просвечивание;

•� в списке Deletion control while creating 3D objects осуществляется контроль 
за операцией удаления при создании трехмерных объектов (системная 
переменная DELOBJ):
◊� Retain defining geometry – сохранять определяющие объекты;
◊� Delete profile curves – удалить кривые профиля;
◊� Delete profile and path curves – удалить профиль и криволинейные тра-

ектории;
◊� Prompt to delete profile curves – запрос удаления кривых профиля;
◊� Prompt to delete profile and path curves – запрос удаления профиля и кри-

волинейных траекторий;
◊� Only delete profile and path curves for solids – только удаление профилей 

и кривых траекторий для тел;
◊� Only prompt to delete profile and path curves for solids – только запрос уда-

ления профилей и кривых траекторий для тел;
•� Isolines on surfaces – установка количества изолиний, отображаемых в 

направлении U и V для создаваемых поверхностей (системная перемен-
ная SURFU);

•� Maximum point cloud points per drawing – установка максимального числа 
точек в облаке точек;

•� кнопка Tessellation… – загрузка диалогового окна Mesh Tessellation Options, 
в котором определяются параметры тесселяции, применяемые к объек-
там, преобразуемым в объекты-сети (рис. 3.23):
◊� Select objects to tessellate – временно закрывает диалоговое окно, по-

зволяя выбрать объект для преобразования в объект-сеть. При этом 
можно выбирать 3D-тела, 3D-поверхности, 3D-грани, полигональ-
ные или многогранные сети, области и замкнутые полилинии;

◊� Mesh type: – определяется тип сети для использования в преобразо-
вании (системная переменная FACETERMESHTYPE): Smooth Mesh Opti-
mized – оптимизированная гладкая сеть, форма граней которой адап-
тируется к форме объекта-сети; Mostly Quads – грани сети в основном 
представляют собой четырехугольники; Triangle – грани сети в основ-
ном представляют собой треугольники;

◊� Mesh distance from original faces: – определяется максимальное откло-
нение граней сети от поверхности или формы исходного объекта (си-
стемная переменная FACETERDEVSURFACE);

◊� Maximum angle between new faces: – определяется максимальный угол 
между нормалями к поверхностям двух смежных граней (системная 
переменная FACETERDEVNORMAL);

◊� Maximum aspect ratio for new faces: – определяется максимальная про-
порция (отношение высоты к ширине) новых граней сети (системная 
переменная FACETERGRIDRATIO);

Настройка параметров трехмерного моделирования



Глава 3. Настройка рабочей среды AutoCAD98

◊� Maximum edge length for new faces: – определяется максимальная длина 
любого ребра, создаваемого при преобразовании в объект-сеть (си-
стемная переменная FACETERMAXEDGELENGTH);

◊� Use optimized representation for 3D primitive solids – определяют-
ся параметры, используемые при преобразовании твердотель-
ных объектов-примитивов в объекты-сети (системная переменная 
FACETERPRIMITIVEMODE);

◊� кнопка Mesh Primitives… – загружает диалоговое окно параметров се-
тевых примитивов Mesh primitive Options;

◊� Apply smoothness after tessellation – сглаживание новых объектов-сетей 
после преобразования;

◊� Smoothness level: – определяется степень сглаживания для новых объ-
ектов-сетей (системная переменная FACETERSMOOTHLEV);

◊� Preview – просмотр предварительного результата применения теку-
щих параметров в области чертежа.

Рис. 3.23. Диалоговое окно определения параметров тесселяции

•� кнопка Mesh Primitives… – загрузка диалогового окна настройки парамет-
ров сетевых примитивов Mesh primitive Options;

•� кнопка Surface Analysis… – загрузка диалогового окна настройки парамет-
ров анализа поверхностей Analysis Options (рис. 3.24):
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◊� на вкладке Zebra устанавливается: Stripe Direction – угол отображаемых 
полос; Type: – тип отображения результатов анализа; Size: – ширина 
полос; Color 1: – первый цвет полос; Color 2: – второй цвет полос;

◊� на вкладке Curvature задается соответствие цветов: Display style: – 
стиль отображения; Auto Range и Max Range – вычисление диапазонов 
значений кривизны; 

◊� на вкладке Draft Angle устанавливаются параметры анализа уклона.

Рис. 3.24. Диалоговое окно настройки параметров анализа поверхностей

�� В области 3D Navigation определяются параметры трехмерной навигации:
•� Reverse mouse wheel zoom – установка реверса зуммирования колесиком 

мыши (системная переменная ZOOMWHEEL);
•� кнопка Walk and Fly… – загрузка диалогового окна Walk and Fly Settings 

(рис. 3.25), позволяющего установить параметры навигации обхода и 
облета:
◊� в области Settings – определяется вариант показа окна команд: When 

entering walk and fly modes – при переходе в режимы обхода и облета, 
Once per session – раз за сеанс, Never – не показывать; а также Display 
Position Locator window – показывать диалоговое окно локатора поло-
жения;

◊� в области Current drawing settings определяются параметры текущего 
чертежа: Walk/fly step size: – величина шага обхода/облета в единицах 

Настройка параметров трехмерного моделирования
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чертежа (системная переменная STEPSIZE), Steps per second: – коли-
чество шагов в секунду (системная переменная STEPSPERSEC);

Рис. 3.25. Диалоговое окно установки параметров обхода и облета

•� кнопка Animation… – загрузка диалогового окна Animation Settings 
(рис. 3.26), позволяющего установить параметры анимации: Visual style: – 
визуальные стили и наборы параметров визуализации (обычный, с ви-
зуализацией; трехмерный скрытый, трехмерный каркас, концептуаль-
ный, скрытие линий, реалистичный, тонированный, тонированный с 
кромками, оттенки серого, эскизный, каркас, просвечивание; черновой, 
низкий, средний, высокий, презентационный), Resolution: – возможное 
разрешение, Frame rate (FPS): – частота кадров в секунду (диапазон зна-
чений от 1 до 60), Format: – формат вывода анимации;

Рис. 3.26. Диалоговое окно установки параметров анимации
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•� кнопка ViewCube… – загрузка диалогового окна ViewCube Settings 
(рис. 3.27), позволяющего установить параметры видового куба:

Рис. 3.27. Диалоговое окно установки параметров видового куба

◊� On-screen position: – положение видового куба на экране (системная 
переменная NAVVCUBELOCATION);

◊� ViewCube size: – размер видового куба (системная переменная 
NAVVCUBESIZE);

◊� Automatic – соответствие текущему размеру активного видового экра-
на, масштабному коэффициенту активного листа или окну чертежа;

◊� Inactive opacity: – прозрачность неактивного видового куба (системная 
переменная NAVVCUBEOPACITY);

◊� Show UCS menu – отображение раскрывающегося меню ПСК под ви-
довым кубом;

◊� Snap to dosest view – привязка нового устанавливаемого вида к бли-
жайшему стандартному виду;

◊� Zoom to extents after view change – при изменении вида размер модели 
подгоняется под размер текущего видового экрана;

Настройка параметров трехмерного моделирования
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◊� Use view transitions when switching views – плавные переходы при пере-
ключении между видами;

◊� Orient ViewCube to current UCS – ориентация видового куба в соответ-
ствии с текущей ПСК (системная переменная NAVVCUBEORIENT);

◊� Keep scene upright – сохранение вертикального положения сцены;
◊� Show compass below the ViewCube – отображение компаса под видовым 

кубом;
◊� Restore Defaults – применение к видовому кубу параметров, принятых 

по умолчанию;
•� кнопка SteeringWheels… – загрузка диалогового окна SteeringWheels 

Settings (рис. 3.28), позволяющего установить параметры штурвала:

Рис. 3.28. Диалоговое окно установки параметров штурвала

◊� в области Big Wheels – настройка большого штурвала: Wheel size: – 
размер инструмента (системная переменная NAVSWHEELSIZEBIG); 
Wheel opacity: – уровень прозрачности (системная переменная 
NAVSWHEELOPACITYBIG);

◊� в области Mini Wheels – настройка мини-штурвала: Wheel size: – раз-
мер инструмента (системная переменная NAVSWHEELSIZEMINI); 
Wheel opacity: – уровень прозрачности (системная переменная 
NAVSWHEELOPACITYMINI);
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◊� в области Display – настройка отображения: Show tool messages – 
управляет отображением сообщений для активного инструмента; 
Show tooltips – управляет отображением подсказок для сегментов 
штурвала и кнопок на нем; 

◊� в области Zoom tool – настройка инструмента зуммирования: Enable 
single click incremental zoom – разрешает инкрементное зуммирование 
по однократному щелчку, которое приведет к 25-процентному увели-
чению текущего вида;

◊� Constrain movement angle to the ground plane – ограничение угла обхода 
нулевой плоскостью;

◊� Invert vertical axis for Look tool – инвертирование вертикальной оси для 
инструмента осмотра;

◊� Keep scene upright – сохранение вертикального положения сцены;
◊� кнопка Restore Defaults – применение к штурвалам настроек по умол-

чанию;
◊� в области Walk Tool – настройка инструмента обхода: Walk speed: – 

устанавливает скорость перемещения инструмента обхода;
◊� в области Rewind thumbnail – управление формированием образцов 

для просмотра изменений, внесенных без использования штурвала 
(системная переменная CAPTURETHUMBNAILS): Never – отсутствие соз-
даваемых образцов; On demand when the bracket is moved over an empty 
frame – создание по запросу образцов для инструмента перемотки, 
когда рамка располагается над пустым кадром; Automatically when a 
view change occurs – автоматическое создание образцов для просмотра 
после изменения каждого вида.

�� В области Dynamic Input определяется отображение полей динамического 
ввода при задании координат: Show Z field for pointer input – показывать поле 
координаты Z при динамическом вводе.

Настройка.параметров.выбора.
объектов
Вкладка настройки параметров выбора объектов Selection диалогового окна Options, 
показанная на рис. 3.29, позволяет сделать следующие назначения.

�� В области Pickbox size определяется размер прицела. Прицел выбора по-
является в перекрестье курсора при выполнении команд редактирования 
объектов (системная переменная PICKBOX).

�� В области Selection modes определяются режимы выбора объектов:
•� Noun/verb selection – предварительный выбор, позволяющий выбирать 

объекты перед вызовом команды. Команда при этом работает с объекта-
ми текущего набора (системная переменная PICKFIRST);

Настройка параметров выбора объектов
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•� Use Shift to add to selection – использование нажатой клавиши Shift для 
добавления или удаления объекта из набора. Для быстрой очистки на-
бора нужно очертить рамку выбора в не занятой объектами зоне чертежа 
(системная переменная PICKADD);

Рис. 3.29. Вкладка настройки параметров выбора объектов

•� Object grouping – выбор всей группы объектов после указания одного 
объекта, принадлежащего этой группе (значение 1 системной перемен-
ной PICKSTYLE);

•� Associative Hatch – определяет, какие объекты должны выбираться при 
указании ассоциативной штриховки, при этом выбирается также и кон-
тур штриховки (значение 2 системной переменной PICKSTYLE);

•� Implied windowing – выбор с помощью рамки при указании точки, не при-
надлежащей ни одному объекту. При выделении области рамкой слева 
направо в набор попадают объекты, полностью лежащие в пределах ука-
занной области. При выделении рамкой справа налево в набор попадают 
как полностью лежащие в пределах указанной области, так и пересекаю-
щие эту область объекты (системная переменная PICKAUTO);
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◊� Allow press and drag on object – динамическая рамка, создающаяся при 
перетаскивании устройства указания от одной точки до второй;

◊� Allow press and drag for Lasso – динамическая рамка для лассо;
•� Window selection method – определение метода при выделении объектов 

рамкой;
•� Object limit for Properties palette – количество объектов, которые могут 

быть одновременно изменены с помощью палитры свойств объектов;
•� Selection effect color: – определение тона подсветки выбранного объекта.

�� В области Ribbon options кнопка Contextual Tab States… загружает диалого-
вое окно Ribbon Contextual Tab States Options, которое позволяет установить 
параметры выбора объектов, используемые для отображения контекст-
ных вкладок ленты:
•� Retain pickfirst selections when commands are invoked from a contextual tab – со-

хранение предварительного набора объектов после выполнения коман-
ды из контекстной вкладки ленты (значение 1 системной переменной 
RIBBONSELECTMODE);

•� Object selection maximum for contextual tab display – подавление отображе-
ния контекстных вкладок ленты, если количество объектов в наборе 
превышает заданное (системная переменная RIBBONCONTEXTSELLIM).

�� В области Grip size определяется размер ручек – маленьких квадратиков, 
появляющихся на выбранных объектах (системная переменная GRIPSIZE).

�� В области Grips задаются параметры ручек.
•� Кнопка Grip Colors… – загружает одноименное диалоговое окно, пред-

назначенное для определения цвета ручек и их элементов в различном 
состоянии (рис. 3.30):

Рис. 3.30. Диалоговое окно определения цвета ручек

◊� Unselected grip color: – цвет невыбранных ручек (системная перемен-
ная GRIPCOLOR);

◊� Selected grip color: – цвет выбранных ручек (системная переменная 
GRIPHOT);

Настройка параметров выбора объектов
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◊� Hover grip color: – цвет ручки под курсором (системная переменная 
GRIPHOVER);

◊� Grip coutour color: – цвет контура ручек (системная переменная 
GRIPCONTOUR);

•� Show grips – отображение ручек на выбранных объектах (системная пе-
ременная GRIPS);
◊� Show grips within blocks – отображение всех ручек внутри блоков (си-

стемная переменная GRIPBLOCK);
◊� Show grip tips – вывод подсказки при наведении курсора на ручку 

пользовательского объекта (системная переменная GRIPTIPS);
◊� Show dynamic grip menu – отображение динамического меню при на-

ведении курсора на многофункциональную ручку (системная пере-
менная GRIPMULTIFUNCTIONAL);

◊� Allow Ctrl+cycling behavior – установка режима Ctrl+ циклического пе-
ребора для многофункциональных ручек (системная переменная 
GRIPMULTIFUNCTIONAL);

◊� Show single grip on groups – отображение единой ручки для группы объ-
ектов;

◊� Show bounding box on groups – отображение рамки вокруг группы объ-
ектов;

•� Object selection limit for display of grips – предельное количество выбранных 
объектов для показа ручек. Допустимый диапазон значений – от 1 до 
32 767 (системная переменная GRIPOBJLIMIT).

�� В области Preview определяются параметры просмотра выбранных объек-
тов при наведении на них прицела (системная переменная PREVIEWEFFECT):
•� When a command is active – когда активна команда (системная переменная 

SELECTIONPREVIEW);
•� When no command is active – если нет активных команд (системная пере-

менная SELECTIONPREVIEW);
•� кнопка Visual Effect Settings… загружает одноименное диалоговое окно 

(рис. 3.31), позволяющее определить параметры визуальных эффектов:
◊� в области Selection Area Effect – внешний вид областей при предвари-

тельном выборе: Indicate selection area – при выборе рамкой или за-
черкивании отмечается область выбора другим фоновым цветом (си-
стемная переменная SELECTIONAREA), Window selection color: – опре-
деляет фон для областей, выбранных с помощью рамки (системная 
переменная WINDOWAREACOLOR), Crossing selection color: – определяет 
фон областей, выбранных с помощью зачеркивания (системная пере-
менная CROSSINGAREACOLOR), Selection area opacity: – управляет про-
зрачностью фона для выбранных с помощью рамки областей (систем-
ная переменная SELECTIONAREAOPACITY);

◊� в области Selection Preview Filter – настройка фильтра просмот-
ра выбранных объектов: Exclude: – исключить: Objects on locked 
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layers – объекты на заблокированных слоях (системная переменная 
PREVIEWFILTER); Xrefs – внешние ссылки, Tables – таблицы, Groups – 
группы, Multiline text – многострочный текст, Hatches – штриховки. 

Рис. 3.31. Диалоговое окно определения цвета ручек

•� Command preview – предварительный просмотр результатов рабо-
ты команд обрезки, растягивания, удлинения, разрыва, копирова-
ния свойств, сопряжений, фасок и смещений (системная переменная 
COMMANDPREVIEW);

•� Property preview – предварительный просмотр свойств объектов.

Настройка.профилей
Вкладка Profiles диалогового окна Options используется для создания профилей 
и сохранения в них параметров среды рисования (рис. 3.32). Профиль – набор 
параметров настройки AutoCAD, сохраненный с уникальным именем. Один из 
профилей является текущим; он определяет настройки рабочей среды рисования. 
Пользователи, входящие в систему под одним именем, могут загружать свои на-
стройки из различных профилей. По умолчанию AutoCAD записывает текущие 
параметры в профиль без имени Unnamed Profile. Имена текущего профиля и ри-
сунка всегда выводятся над названиями вкладок диалогового окна Options.

На вкладке Profiles можно осуществлять следующие настройки:

�� в области имеющихся профилей Available profiles: – выбирать необходи-
мый профиль из перечня доступных;

Настройка профилей
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Рис. 3.32. Вкладка настройки профилей

�� нажатием кнопки Set Current – устанавливать выбранный профиль в 
качест ве текущего;

�� используя кнопку Add to List... – добавлять новый профиль;
�� с помощью кнопки Rename… – переименовывать имеющиеся профили;
�� с помощью кнопки Delete – удалять имеющиеся профили;
�� с помощью кнопки Export... – экспортировать настройки текущего профи-

ля во внешний ARG-файл;
�� после щелчка на кнопке Import... – импортировать настройки профиля из 

внешнего ARG-файла;
�� кнопкой Reset – сбрасывать настройки.

Настройка.учетной.записи
Вкладка Online диалогового окна Options  предназначена для настройки вашей 
учетной записи Autodesk 360.
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Ввод.координат
Когда программа AutoCAD запрашивает точку, команда ожидает ввода координат 
какой-либо точки текущего рисунка. В AutoCAD может быть включен контроль 
лимитов рисунка, осуществляемый командой LIMITS. В этом случае, если введен-
ная точка выходит за пределы рисунка, AutoCAD выдает сообщение:

** Outside limits – вне лимитов

и отвергает введенную точку.
В представлении рисунка во внутренней графической базе данных координаты 

каждой точки задаются с точностью не менее 14 значащих цифр.
Ввод координат в AutoCAD может осуществляться в командной строке непо-

средственно с клавиатуры, путем указания численных значений, либо с использо-
ванием графического маркера (курсора), который движется по экрану с помощью 
устройства указания. Ввод координат осуществляется щелчком левой кнопкой 
мыши.

Как следствие в строке состояния происходит отображение текущих значений 
координат. Существуют три режима отображения координат:

�� динамический, при котором обновление координат происходит постоянно 
по мере перемещения указателя мыши;

�� статический, при котором координаты обновляются только после указа-
ния точки;

�� режим относительных координат, формат расстояние < угол, при котором 
обновление значений происходит по мере перемещения указателя мыши 
во время рисования объекта, содержащего более одной точки.

Включение отображения координат в строке состояния осуществляется с по-
мощью системной переменной COORDS. Значение 0 соответствует статическому 
отображению, 1 – динамическому, 2 – относительному.

Для определения координат точек существующих объектов (напри-
мер, точки пересечения или середины отрезка) можно воспользо-
ваться командой iD. При этом следует применять объектную привяз-
ку, иначе полученные координаты могут оказаться неточными. Ко-
манда ID вызывается из падающего меню Tools → Inqury → ID Point.

Для определения координат сразу всех характерных точек объекта 
удобно использовать команду List. Команда вызывается из падаю-
щего меню Tools → Inqury → List.

Еще один метод получения координат точек – выбор объекта с помощью ру-
чек. Ручки представляют собой маленькие прямоугольники, располагающиеся в 
характерных точках объектов, например конечных точках и середине отрезка. При 
привязке курсора к одной из ручек в поле координат строки состояния отобража-
ются ее координаты.
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Для удобства ввода координат можно использовать:

�� ортогональный режим, когда изменение координат происходит только по 
оси X или Y. Ортогональный режим включается либо нажатием функцио-
нальной клавиши F8, либо щелчком на кнопке  Restrict cursor orthogonally 
(Ortho Mode)  в строке состояния;

�� привязку к узлам сетки, определенной с некоторым шагом по X и Y. Такую 
шаговую привязку можно установить, либо нажав функциональную кла-
вишу F9, либо щелкнув на кнопке  Snap mode в строке состояния. 
Если включен шаг привязки, то при перемещении мыши перекрестье бу-
дет «перепрыгивать» с одного узла невидимой сетки на другой.

Значения координат независимо от способа ввода всегда связаны с некоторой 
системой координат. По умолчанию в AutoCAD используется так называемая ми
ровая система координат, МСК – World Coordinate System (WCS). Она опреде-
лена так, что ось OX направлена слева направо, ось OY – снизу вверх, ось OZ – пер-
пендикулярно экрану. Как правило, для выполнения конкретного проекта удобнее 
определить пользовательскую систему координат, ПСК – User Coordinate System 
(UCS), которую можно сместить относительно мировой и/или повернуть под лю-
бым углом. Допускается существование нескольких пользовательских систем ко-
ординат, и в любой момент возможен переход от одной к другой.

Никакие изменения МСК не допускаются. AutoCAD позволяет одновременно 
использовать и координаты, связанные с текущей ПСК, и координаты, связанные 
с МСК. При этом для МСК при вводе с клавиатуры значению координат должен 
предшествовать символ «звездочка» (*).

Динамический.ввод.координат
С помощью функции динамического ввода значения координат можно вводить не 
в командной строке, а в поле всплывающей подсказки, которая отображается ря-
дом с курсором и динамически обновляется по мере перемещения курсора. Функ-
ция динамического ввода включается и отключается в строке состояния кнопкой 

 Dynamic Input.
Существуют два типа динамического ввода:

�� ввод значений координат с помощью мыши;
�� ввод размеров для линейных и угловых значений.

Настройка динамического ввода осуществляется в диалоговом окне режимов 
рисования Drafting Settings, вкладка Dynamic Input (рис. 4.1), которое вызывается из 
падающего меню Tools → Drafting Settings… или из контекстного меню щелчком 
правой кнопки мыши в строке состояния на кнопке Dynamic Input и выбором пунк-
та Dynamic Input Settings….

Здесь настраиваются следующие параметры динамического ввода.

Динамический ввод координат
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Рис. 4.1. Диалоговое окно настройки динамического ввода

�� Enable Pointer Input – включить ввод с помощью мыши (системная пере-
менная DYNMODE).

�� Enable Dimension Input where possible – включить динамический ввод разме-
ров, где возможно (системная переменная DYNMODE).

�� В области Pointer Input кнопкой Settings... загружается диалоговое окно 
Pointer Input Settings (рис. 4.2), позволяющее настроить параметры ввода с 
помощью мыши:
•� в области Format – управление форматом координат, отображаемых в 

подсказках, которые выводятся, когда включен ввод с помощью мыши:
◊� Polar format – отображение подсказки для второй или следующей точ-

ки в формате полярных координат. Чтобы перейти к декартовым ко-
ординатам, необходимо ввести запятую (,) (системная переменная 
DYNPIFORMAT);

◊� Cartesian format – отображение подсказки для второй или следую-
щей точки в декартовом формате. Для перехода к полярным коор-
динатам необходимо ввести обозначение < (системная переменная 
DYNPIFORMAT);

◊� Relative coordinates – отображение подсказки для второй или следую-
щей точки в формате относительных координат. Чтобы перейти к аб-
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солютным координатам, необходимо ввести знак # (системная пере-
менная DYNPICOORDS);

◊� Absolute coordinates – отображение подсказки для второй или сле-
дующей точки в формате абсолютных координат. Чтобы перейти к 
относительным координатам, необходимо ввести знак @ (системная 
переменная DYNPICOORDS);

•� в области Visibility – отображать подсказки для координат (системная 
переменная DYNPIVIS):
◊� As soon as I type coordinate data – одновременно с вводом координатных 

данных;
◊� When a command asks for a point – когда команда содержит запрос для 

точки;
◊� Always – even when not in command – всегда, даже не в составе команды.

Рис. 4.2. Диалоговое окно настройки параметров ввода с помощью мыши

�� В области Dimension Input кнопкой Settings... загружается диалоговое окно 
настройки параметров ввода размеров Dimension Input Settings (рис. 4.3), по-
зволяющее установить видимость при растяжке ручек:
•� Show only 1 dimension input field at a time – показывать одновременно толь-

ко одно поле для ввода размеров (системная переменная DYNDIVIS);
•� Show 2 dimension input fields at a time – показывать одновременно два поля 

для ввода размеров (системная переменная DYNDIVIS);

Динамический ввод координат
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Рис. 4.3. Диалоговое окно настройки параметров ввода размеров

•� Show the following dimension input fields simultaneously: – показывать одно-
временно следующие поля для ввода размеров (системные переменные 
DYNDIVIS и DYNDIGRIP):
◊� Resulting Dimension – итоговый размер;
◊� Length Change – изменение длины;
◊� Absolute Angle – абсолютный угол;
◊� Angle Change – изменение угла;
◊� Arc Radius – радиус дуги.

 Для перехода в следующее поле для ввода размеров необходимо нажать 
клавишу TAB.

�� В области Dynamic Prompts – настроить динамические подсказки:
•� Show command prompting and command input near the crosshairs – показы-

вать подсказку для ввода команды и вводимую команду рядом с пере-
крестьем (системная переменная DYNPROMPT);

•� Show additional tips with command prompting – показывать  дополнительные 
подсказки с запросами команд.

 В динамической подсказке для доступа к параметрам необходимо на-
жать клавишу ↓ (стрелка вниз).

�� Кнопка Drafting Tooltip Appearance… загружает диалоговое окно Tooltip 
Appearance (рис. 4.4), позволяющее настроить внешний вид подсказок на 
чертеже:
•� Model Preview – предварительный просмотр в пространстве модели;
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•� Layout Preview – предварительный просмотр в пространстве листа;
•� Colors… – выбор и изменение цвета всплывающих подсказок, а также их 

фона в определенном контексте в диалоговом окне Drawing Window Colors 
(см. рис. 3.3);

•� Size – установка размера подсказок;
•� Transparency – установка прозрачности подсказок;
•� Override OS settings for all drafting tooltips – заменить параметры операци-

онной системы для всех подсказок на чертеже (системная переменная 
DYNTOOLTIPS);

•� Use settings only for Dynamic Input tooltips – заменить параметры только для 
подсказок динамического ввода (системная переменная DYNTOOLTIPS).

Рис. 4.4. Диалоговое окно настройки внешнего вида подсказок на чертеже

При использовании ввода с помощью мыши в области рисования при пере-
мещении курсора будут отображаться значения координат, для ввода которых 
необходимо сначала ввести значение, затем для перехода к следующей подсказке 
нажать клавишу Tab и после этого ввести значение следующей координаты. При 
определении точки первая координата является абсолютной. Формат второй и 
следующих точек – относительные полярные координаты. Если требуется ввести 
абсолютное значение, необходимо перед ним ввести знак #.

Динамический ввод координат
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Декартовы.и.полярные.координаты
В двухмерном пространстве точка определяется в плоскости XY, которая называет-
ся также плоскостью построений. Ввод координат с клавиатуры возможен в виде 
абсолютных и относительных координат.

Ввод абсолютных координат производится в следующих форматах:

�� декартовы (прямоугольные) координаты. При этом для определения дву-
мерных и трехмерных координат применяются три взаимно перпенди-
кулярные оси: X, Y и Z. Для ввода координат указывается расстояние от 
точки до начала координат по каждой из этих осей, а также направление 
(+ или -). При начале нового рисунка текущей системой всегда является 
мировая система координат World Coordinate System (WCS), следователь-
но, ось X направлена горизонтально, ось Y – вертикально, а ось Z перпен-
дикулярна плоскости XY;

�� полярные координаты. При вводе координат указывается расстояние, на 
котором располагается точка от начала координат, а также величина угла, 
образованного полярной осью и отрезком, мысленно проведенным через 
данную точку и начало координат. Угол задается в градусах против часо-
вой стрелки. Значение 0 соответствует положительному направлению оси 
OX.

Относительные координаты задают смещение от последней введенной точки. 
При вводе точек в относительных координатах можно использовать любой фор-
мат записи в абсолютных координатах: @dx,dy – для декартовых, @r<A – для по-
лярных.

Относительные декартовы координаты удобно применять в том случае, если 
известно смещение точки относительно предыдущей.

Пример..Построение.в.абсолютных.координатах
Постройте многоугольник, задавая точки в абсолютных координатах (рис. 4.5).

Рис. 4.5. Построение многоугольника

Запустите команду формирования отрезка LiNE, вызвав ее из падаю-
щего меню Draw → Line или щелкнув на пиктограмме Line в группе 
Draw ленты Home. Ответьте на запросы:
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_line
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: 190,20 – точка 2
Specify next point or [Undo]: 190,100 – точка 3
Specify next point or [Close/Undo]: 130,40 – точка 4
Specify next point or [Close/Undo]: 130,100 – точка 5
Specify next point or [Close/Undo]: Close – замкните линию

Выполните упражнение L1 из раздела 2.

Пример..Построение.в.относительных.координатах
Постройте многоугольник, задавая точки в относительных координатах 

(см. рис. 4.5).

Запустите команду формирования отрезка LiNE, вызвав ее из падаю-
щего меню Draw → Line или щелкнув на пиктограмме Line в группе Draw 
ленты Home. Ответьте на следующие запросы (символ @ вводится при 
одновременном нажатии клавиш Shift+2):

_line
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: @150,0 – в точку 2 относительно точки 1
Specify next point or [Undo]: @0,80 – в точку 3 относительно точки 2
Specify next point or [Close/Undo]: @-60,-60 – в точку 4 относительно 
точки 3
Specify next point or [Close/Undo]: @0,60 – в точку 5 относительно 
точки 4
Specify next point or [Close/Undo]: Close – замкните линию

Выполните упражнение L2 из раздела 2.

Пример..Построение.в.полярных.координатах
Постройте многоугольник, задавая точки в полярных координатах (см. рис. 4.5).

Запустите команду формирования отрезка LiNE, вызвав ее из падаю-
щего меню Draw → Line или щелкнув на пиктограмме Line в группе Draw 
ленты Home. Ответьте на запросы:

Декартовы и полярные координаты
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_line
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: @150<0 – в точку 2 относительно точки 1
Specify next point or [Undo]: @80<90 – в точку 3 относительно точки 2
Specify next point or [Close/Undo]: @85<-135 – в точку 4 относительно 
точки 3
Specify next point or [Close/Undo]: @60<90 – в точку 5 относительно 
точки 4
Specify next point or [Close/Undo]: Close – замкните линию

Выполните упражнение L3 из раздела 2.

Формирование.точек.методом.
«направление.–.расстояние»
Вместо ввода координат допускается использование прямой записи расстояния, 
что особенно удобно для быстрого ввода длины линии. Такой ввод может про-
изводиться во всех командах, кроме тех, которые предполагают указание просто 
действительного значения, например в командах построения массива ARRAY, раз-
метки MEASURE и деления объекта DIVIDE. При использовании прямой записи рас-
стояния в ответ на запрос точки достаточно переместить мышь в нужном направ-
лении и ввести числовое значение в командной строке. Например, если таким спо-
собом задается отрезок, то он строится путем указания числового значения длины 
и направления под определенным углом. При включенном ортогональном режиме 
этим способом очень удобно рисовать перпендикулярные отрезки.

Определение.трехмерных.координат
Трехмерные координаты задаются аналогично двухмерным, но к двум составляю-
щим по осям X и Y добавляется третья величина – по оси Z. В трехмерном про-
странстве аналогично двухмерному моделированию можно использовать абсолют-
ные и относительные координаты, а также цилиндрические и сферические, которые 
схожи с полярными в двухмерном пространстве.

Значения координат независимо от способа ввода всегда связаны с некоторой 
системой координат. При работе в трехмерном пространстве значения x, y и z ука-
зывают либо в мировой системе координат World Coordinate System (WCS), либо 
в пользовательской User Coordinate System (UCS).
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Правило.правой.руки
При работе в трехмерном пространстве в AutoCAD все системы координат фор-
мируются по правилу правой руки. Оно определяет положительное направление 
оси Z трехмерной системы координат при известных направлениях осей X и Y, а 
также положительное направление вращения вокруг любой из осей трехмерных 
координат.

Для определения положительных направлений осей необходимо поднести 
тыльную сторону кисти правой руки к экрану монитора и направить большой па-
лец параллельно оси X, а указательный – по оси Y. Если согнуть средний палец 
перпендикулярно ладони, как показано на рис. 4.6 справа, то он будет указывать 
положительное направление оси Z.

Рис. 4.6. Правило правой руки

Для определения положительного направления вращения следует ориенти-
ровать большой палец правой руки в положительном направлении оси и согнуть 
остальные пальцы, как показано на рис. 4.6 слева. Положительное направление 
вращения совпадает с направлением, указываемым согнутыми пальцами.

Ввод.трехмерных.декартовых.
координат
Трехмерные декартовы координаты (x, y, z) вводятся аналогично двухмерным 
(x, y). Дополнительно к координатам по осям X и Y необходимо ввести еще и зна-
чение по оси Z. На самом деле в AutoCAD не существует двухмерных координат, и 
если введены значения только x и y, это означает, что отсутствующая координата z 

Ввод трехмерных декартовых координат
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берется по умолчанию равной нулю (системная переменная THICKNESS). При ука-
зании декартовых трехмерных координат с клавиатуры вводятся три числа через 
запятую, например:

3,5,2

В трехмерном пространстве, так же как и в двухмерном, широко используются и 
абсолютные координаты (отсчитываемые от начала координат), и относительные 
(отсчитываемые от последней указанной точки). Признак относительных коорди-
нат – символ @ перед координатами вводимой точки, которая в этом случае берет-
ся относительно последней введенной точки.

Ввод.цилиндрических.координат
Ввод цилиндрических координат аналогичен указанию полярных координат на 
плоскости. Дополнительно появляется значение, определяющее координату z по 
оси Z, перпендикулярной плоскости XY. Цилиндрические координаты описывают 
расстояние от начала системы координат (или от предыдущей точки в случае с от-
носительными координатами) до точки на плоскости XY, угол относительно оси X 
и расстояние от точки до плоскости XY. Угол задается в градусах.

На рис. 4.7 показана точка с координатами 7<30,5. Эта точка лежит на расстоя-
нии 7 единиц от начала системы координат в плоскости XY, под углом 30°�к оси 
X на плоскости XY и имеет координату Z, равную 5. Относительные цилиндриче-
ские координаты строятся так же, как и абсолютные, просто воображаемое начало 
координат переносится в последнюю введенную точку.

Рис. 4.7. Указание цилиндрических координат
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Пример..Построение.в.цилиндрических.
координатах
Цилиндрические координаты применяются при вводе точек трехмерного про-

странства реже, чем декартовы. Их использование бывает необходимо, например, 
для построения спиральных объектов. В следующем примере с помощью команды 
3DPOLY формируется двухвитковая спираль.

Запустите команду формирования трехмерной полилинии 3DPOLY, 
вызвав ее из падающего меню Draw → 3D Polyline или щелкнув на пик-
тограмме 3D Polyline в группе Draw ленты Home. Ответьте на запросы:

_3dpoly
Specify start point of polyline: 0,0,0 – точка 1
Specify endpoint of line or [Undo]: @40<45,20 – точка 2
Specify endpoint of line or [Undo]: @40<135,20 – точка 3
Specify endpoint of line or [Close/Undo]: @40<-135,20 – точка 4
Specify endpoint of line or [Close/Undo]: @40<-45,20 – точка 5
Specify endpoint of line or [Close/Undo]: @40<45,20 – точка 6
Specify endpoint of line or [Close/Undo]: @40<135,20 – точка 7
Specify endpoint of line or [Close/Undo]: @40<-135,20 – точка 8
Specify endpoint of line or [Close/Undo]: @40<-45,20 – точка 9
Specify endpoint of line or [Close/Undo]: Close – замкните линию

При выполнении описанного примера следует учесть, что необязательно вво-
дить с клавиатуры повторяющиеся строки координат. Ранее введенные строки 
текста запоминаются в буфере строк, благодаря чему их удобно вызвать в диало-
говую область с помощью клавиш ↑�и ↓ на функциональной клавиатуре. Напри-
мер, повторный ввод строки @40<45,20 можно осуществить, несколько раз нажав 
клавишу ↑�(пока не появится нужная строка), и затем ввести ее клавишей Enter. Но 
это не единственная возможность использования данного приема: допускаются 
также редактирование «поднятой» строки с помощью клавиш ←�и →, добавление 
символов с клавиатуры и удаление символов с помощью клавиши Backspace.

Ввод.сферических.координат
Ввод сферических координат в трехмерном пространстве также подобен вводу по-
лярных координат на плоскости. Положение точки определяется ее расстоянием 
от начала координат текущей ПСК, углом к оси X в плоскости XY и углом к плос-
кости XY. Все координаты разделяются символом <. Угол задается в градусах.

На рис. 4.8 показана точка с координатами 7<30<45. Эта точка лежит на рас-
стоянии 7 единиц от начала текущей ПСК, под углом 30°�к оси X в плоскости XY 
и под углом 45°�к плоскости XY.

Ввод сферических координат
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Рис. 4.8. Указание сферических координат

Пример..Ввод.сферических.координат
Сферические координаты используются для получения точек на сферической 

поверхности или, например, в случаях построения трубопровода и т. п., когда наи-
более важна длина строящегося объекта, а не его ориентация. В нижеописанном 
примере командой 3DPOLY формируется пятиугольник с вершинами, лежащими 
на сфере, радиус которой равен 50 единицам.

Запустите команду формирования трехмерной полилинии 3DPOLY, 
вызвав ее из падающего меню Draw → 3D Polyline или щелкнув на пик-
тограмме 3D Polyline в группе Draw ленты Home. Ответьте на запросы:

_3dpoly
Specify start point of polyline: 50<20<-20 – точка 1
Specify endpoint of line or [Undo]: 50<30<5 – точка 2
Specify endpoint of line or [Undo]: 50<15<20 – точка 3
Specify endpoint of line or [Close/Undo]: 50<-15<20 – точка 4
Specify endpoint of line or [Close/Undo]: 50<-30<5 – точка 5

Specify endpoint of line or [Close/Undo]: Close – замкните линию

Координатные.фильтры
Координатные фильтры – это способ указания новых точек в пространстве с ис-
пользованием отдельных координат уже имеющихся на чертеже объектов. Наи-
большее распространение координатные фильтры получили при вводе координат 
с помощью мыши. Их применение позволяет задавать значение одной коорди-
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наты, временно игнорируя значения других. Для указания фильтра в командной 
строке используется формат:

<координата>, 

где <координата> – один из символов x, y, z или некоторое их сочетание.
Существует набор из шести фильтров: .x, .y, .z, .xy, .xz и .yz. Если, например, 

ввести .x, AutoCAD запросит указать недостающие координаты по осям Y и Z.
Координатные фильтры можно вводить в командной строке в ответ на запрос 

ввода точки.

Определение.пользовательской.
системы.координат
Как было сказано выше, в AutoCAD существуют: мировая система координат 
World Coordinate System – WCS и пользовательская система координат User 
Coordinate System – UCS. Ось X мировой системы координат направлена гори-
зонтально, ось Y – вертикально, а ось Z проходит перпендикулярно плоскости XY. 
Начало координат – это точка пересечения осей X и Y; по умолчанию она совме-
щается с левым нижним углом рисунка. В любой текущий момент активна только 
одна система координат, которую принято называть текущей. В ней координаты 
определяются любым доступным способом.

Основное отличие мировой системы координат от пользовательской заключа-
ется в том, что мировая система координат (МСК) может быть только одна (для 
каждого пространства модели и листа), и она неподвижна. Применение пользова
тельской системы координат (ПСК) не имеет практически никаких ограничений. 
Она может быть расположена в любой точке пространства под любым углом к 
мировой системе координат. Разрешается определять, сохранять и восстанавли-
вать неограниченное количество ПСК. Проще выровнять систему координат с су-
ществующим геометрическим объектом, чем определять точное размещение трех-
мерной точки. ПСК обычно используется для работы с несмежными фрагментами 
рисунка. Поворот ПСК упрощает указание точек на трехмерных или повернутых 
видах. Узловые точки и базовые направления, определяемые режимами шаговой 
привязки SNAP, сетки GRID и ортогонального режима ORTHO, поворачиваются 
вмес те с ПСК.

При работе в ПСК допускается поворачивать ее плоскость XY и смещать на-
чало координат. Все они при вводе отсчитываются относительно текущей поль-
зовательской системы координат. Соответствующая пиктограмма дает возмож-
ность судить о положении и ориентации текущей ПСК, помогая визуализировать 
эту ориентацию относительно мировой системы координат, а также относительно 
объектов, содержащихся в рисунке.

Пользовательская система координат используется для перемещения начала 
системы координат и/или изменения ориентации осей системы координат в про-

Определение пользовательской системы координат
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странстве, что значительно упрощает процесс создания и редактирования объек-
тов. При создании объекта удобно поместить начало системы координат в базовую 
точку объектов, особенно если в данной точке формируется много объектов.

Пиктограмма ПСК всегда изображается в плоскости XY текущей ПСК и ука-
зывает положительное направление осей X и Y. Сама пиктограмма может распо-
лагаться как в начале пользовательской системы координат, так и в другом месте.

Настроить пиктограмму системы координат, ее размер и цвет можно с по-
мощью команды UCsiCON (рис. 4.9). Команда вызывается из падающего меню 
View → Display → UCS Icon.

Рис. 4.9. Варианты пиктограмм системы координат

Включение/отключение пиктограммы системы координат осуществля-
ется в падающем меню View → Display → UCS Icon → On.

Установка пиктограммы ПСК в начало координат осуществляется в па-
дающем меню View → Display → UCS Icon → Origin.

Свойства пиктограммы ПСК можно настроить в диалоговом окне UCS 
Icon, которое загружается из падающего меню View → Display → UCS 
Icon → Properties… (рис.4.10):

�� В области UCS Icon style определяется стиль пиктограммы ПСК:
•� 2D – отображение двухмерной пиктограммы ПСК без оси Z;
•� 3D – отображение трехмерной пиктограммы ПСК;
•� Line width: – задание толщины линий трехмерной пиктограммы ПСК.

�� В области UCS Icon size определяется размер пиктограммы ПСК в процен-
тах от размеров видового экрана. Допустимый диапазон – от 5 до 95.

�� В области UCS Icon color: задается цвет пиктограммы ПСК:
•� Model space icon color: – цвет пиктограммы ПСК в пространстве модели;
•� Layout space icon color: – цвет пиктограммы ПСК в пространстве листа;
•� Apply single color – использование одного цвета.

Пиктограмма с изображением сломанного карандаша говорит о том, что пло-
скость XY практически параллельна направлению взгляда. В этом случае при ука-
зании значений координат с помощью мыши происходит выбор точек с нулевыми 
координатами z, что обычно не соответствует желанию пользователя. Перед вво-
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дом точек или редактированием модели по виду пиктограммы следует оценить 
угол между направлением взгляда и пиктограммой ПСК: если этот угол мал, точ-
ный выбор точек с помощью мыши или другого манипулятора затруднителен.

Рис. 4.10. Диалоговое окно настройки свойств пиктограммы ПСК

Выбор.пользовательской.системы.
координат.в.пространстве
Для изменения положения ПСК применяются следующие способы:

�� указание новой плоскости XY или новой оси Z;
�� ввод нового начала координат;
�� совмещение ПСК с имеющимся объектом;
�� совмещение ПСК с гранью тела;
�� совмещение ПСК с направлением взгляда;
�� поворот ПСК вокруг одной из ее осей;
�� расположение плоскости XY ПСК перпендикулярно выбранному в качест-

ве оси Z направлению;
�� восстановление ранее сохраненной ПСК для совмещения с МСК;
�� применение имеющейся ПСК к любому видовому экрану;
�� возврат к предыдущей ПСК.

Выбор пользовательской системы координат в пространстве
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Размещение, перемещение, вращение и отображение пользовательских систем 
координат производятся с помощью команды UCs. Вызвать эту команду или ва-
рианты ее исполнения можно с падающего меню Tools → New UCS (рис. 4.11). Так-
же удобно вызывать эту команду в группе Coordinates ленты Home рабочего про-
странства 3D Modeling (рис. 4.12). 

Рис. 4.11. Панели инструментов UCS в падающем меню
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Рис. 4.12. Панели инструментов UCS в группе Coordinates  
ленты Home рабочего пространства 3D Modeling

UCS – определение новой пользовательской системы координат. За-
прос команды UCS:

Current ucs name: *WORLD* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/
Y/Z/ZAxis] <World>: – задать ключ

World – переход к мировой системе координат;

Previous – восстановление предыдущей ПСК. При этом сохраняются 
десять последних определенных ПСК;

Face – определение пользовательской системы координат путем 
прос того указания на грань;

Object – выравнивание системы координат по существующему объ-
екту;

View – выравнивание системы координат в направлении текущего 
вида, то есть определение новой системы координат с плоскостью XY, 
перпендикулярной направлению вида (иначе говоря, параллельно 
экрану);

Origin – размещение ПСК в указанной точке;

Z Axis Vector – определение нового положительного направления оси;

3 P oint – определение нового начала координат и направления осей X 
и Y по трем точкам;

X – поворот системы координат вокруг оси X;

Y – поворот системы координат вокруг оси Y;

Выбор пользовательской системы координат в пространстве
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Z – поворот системы координат вокруг оси Z.

Изменение текущей ПСК не влияет на изображение рисунка на экране, если 
не включена системная переменная UCSFOLLOW; в противном случае показывается 
вид в плане текущей ПСК.

Если пиктограмма ПСК активизирована, она перерисовывается в соответствии 
с ориентацией новой системы координат.

С ПСК связаны следующие системные переменные.

�� UCSXDIR, UCSYDIR определяют направление осей X и Y в мировых коорди-
натах. Переменные доступны только для чтения.

�� UCSNAME определяет имя текущей ПСК.
�� WORLDUCS равна 1, если текущая ПСК совпадает с мировой системой коор-

динат, и 0 – в противном случае.
�� UCSORG определяет начало координат текущей системы координат для те-

кущего пространства.

Управление системами координат осуществляется с помощью коман-
ды DDUCs, вызываемой из падающего меню Tools → Named UCS..., или 
щелчком на пиктограмме Named UCS в группе Coordinates ленты Home 
рабочего пространства 3D Modeling (см. рис. 4.12)

На вкладке Named UCSs диалогового окна UCS можно присвоить любой пользо-
вательской системе координат уникальное имя.

В дальнейшем, открыв вкладку именованных ПСК Named UCSs диалогового 
окна UCS, можно по ранее заданному имени восстановить пользовательскую си-
стему координат. На рис. 4.13 показана вкладка Named UCSs этого окна с ранее 
созданными пользовательскими системами координат. Чтобы сделать систему 
координат текущей, необходимо навести указатель мыши на ее имя и щелкнуть 
на кнопке Set Current.

Чтобы добавить новую пользовательскую систему координат, необходимо 
присвоить текущей ПСК со стандартным именем Unnamed уникальное название. 
Для этого достаточно щелкнуть на имени текущей ПСК и набрать новое с клавиа-
туры в появившемся поле. Другие стандартные названия – World и Previous – заре-
зервированы для мировой системы координат и для той, которая использовалась 
перед текущей. Именованные пользовательские системы координат применяются 
в случаях, когда установленная ПСК, с которой неоднократно придется работать 
в дальнейшем, не совпадает со стандартной. Если пользовательские системы ко-
ординат были определены как именованные, их легко восстановить в диалоговом 
окне UCS, на вкладке Named UCSs.

Для удаления пользовательской системы необходимо навести на ее имя указа-
тель мыши и нажать клавишу Delete.



129

При щелчке на кнопке Details раскрывается подробное диалоговое окно UCS 
Details, в котором отражена вся информация о координатах точки начала и направ-
лении осей относительно текущей системы координат по каждой именованной 
ПСК (рис. 4.14).

Рис. 4.13. Диалоговое окно управления именованными ПСК

Рис. 4.14. Диалоговое окно UCS Details

Работа.с.ПСК.на.видовых.экранах
На видовые экраны выводятся различные виды модели. Например, иногда требу-
ется создать четыре видовых экрана для показа модели сверху, справа, слева и сни-
зу. Чтобы повысить удобство работы, для каждого видового экрана можно задать 
и сохранить отдельную ПСК. В этом случае при переключении между видовыми 
экранами не происходит потери информации о ПСК каждого из них.

Работа с ПСК на видовых экранах
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Сохранение ПСК для каждого видового экрана обеспечивается системной пе-
ременной UCSVP. Если для видового экрана она установлена в 0, то ПСК этого ви-
дового экрана всегда совпадает с ПСК текущего активного видового экрана. Если 
для видового экрана системная переменная UCSVP установлена в 1, то заданная для 
этого экрана ПСК запоминается и не изменяется при переходе на другой.

Вкладка Settings диалогового окна UCS (рис. 4.15) позволяет устанавливать 
различные режимы отображения пиктограммы ПСК. Причем параметры отобра-
жения можно задавать либо отдельно для текущего видового экрана, либо сразу 
для всех активных видовых экранов текущего рисунка. Здесь же можно указать, 
следует ли сохранять систему координат вместе с видовым экраном, а кроме того, 
нужно ли на видовом экране всегда показывать вид модели в плане.

�� В области UCS Icon settings настраиваются режимы отображения пикто-
граммы ПСК:
•� On – включение/отключение пиктограммы ПСК;
•� Display at UCS origin point – установка пиктограммы ПСК в начало коор-

динат;
•� Apply to all active viewports – включение/отключение пиктограммы ПСК 

для всех активных видовых экранов;
•� Allow Selecting UCS icon – выбирать пиктограмму ПСК.

�� В области UCS settings настраиваются режимы ПСК:
•� Save UCS  with viewport – сохранять ПСК с видовым экраном;
•� Update view to Plan when UCS is changed – вид в плане при смене ПСК.

Рис. 4.15. Режимы отображения пиктограммы ПСК
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Выбор.стандартной.пользовательской.
системы.координат
Ориентацию текущей ПСК в зависимости от мировой системы координат, пре-
дыдущей ПСК или ПСК, установленной для текущего вида, можно изменить в 
диалоговом окне UCS, на вкладке Orthographic UCSs, показанной на рис. 4.16. При 
этом достаточно выбрать объект и выполнить команду DDUCsP, вызываемую из 
падающего меню Tools → Named UCS....

Рис. 4.16. Диалоговое окно стандартных ПСК

С помощью данной команды можно определить новую пользовательскую си-
стему координат по отношению либо к мировой, либо к текущей, выбрав соответ-
ствующий слайд в диалоговом окне. Команду DDUCsP используют в основном для 
переноса пользовательской системы координат из одной ортогональной проекции 
в другую.

В AutoCAD имеются шесть стандартных ортогональных ПСК: верхняя, ниж-
няя, передняя, задняя, левая и правая. По умолчанию параметры ортогональных 
ПСК рассчитываются относительно МСК.

Стандартной системой координат удобно пользоваться при переходе от одной 
ортогональной проекции трехмерного объекта к другой. Обычно эти проекции 
располагаются в соседних окнах, и признаком правильной установки ПСК счи-
тается отображение в нужном окне правильной пиктограммы системы координат 

Выбор стандартной пользовательской системы координат
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(ось X направлена вправо, ось Y – вверх). Так как набор стандартных систем коор-
динат ограничен, оптимальным является табличный способ их определения.

Пример..Пользовательская.система.координат
В нижеописанном примере необходимо перенести пользовательскую систему 

координат в другую точку на рабочем поле чертежа. После перемещения пользова-
тельской системы координат из точки мировой системы координат в пиктограмме 
пропадает символ W. О том, что пиктограмма находится в точке пользовательской 
системы координат, свидетельствует значок «плюс» (+).

Запустите команду UCs, вызвав ее из падающего меню Tools → New 
UCS → Origin или щелкнув на пиктограмме Origin в группе Coordinates 
ленты Home рабочего пространства 3D Modeling. Ответьте на запросы:

_UCS
Current ucs name: *WORLD* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/
X/Y/Z/ZAxis]
<World>: _o – переход в режим смещения начала координат
Specify new origin point <0,0,0>: 195,140 – координаты точки смеще-
ния начала координат

Выполните поворот пользовательской системы координат:
_UCS
Current ucs name: *NO NAME* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/
X/Y/Z/ZAxis]
<World>: _z – переход в режим поворота вокруг оси Z
Specify rotation angle about Z axis <90>: 30 – угол поворота вокруг 
оси Z в градусах

Для возвращения в мировую систему координат запустите команду 
UCs, вызвав ее из падающего меню Tools → New UCS → World или 
щелкнув на пиктограмме World в группе Coordinates ленты Home рабо-
чего пространства 3D Modeling. Команда выдаст запросы:

_UCS
Current ucs name: *NO NAME* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/
X/Y/Z/ZAxis]
<World>: _w – возвращение в мировую систему координат

Выполните упражнения Ucs1–Ucs3 из раздела 5.
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Слои подобны лежащим друг на друге прозрачным листам кальки. На различных 
слоях группируются разные типы данных рисунка. Любой графический объект 
рисунка обладает такими свойствами, как цвет, тип, вес (толщина) линии и стиль 
печати. При создании объекта значения этих свойств берутся из описания слоя, на 
котором он создается. При необходимости свойства любого объекта можно изме-
нить. Использование цвета позволяет различать сходные элементы рисунка. При-
менение линий различных типов помогает быстро распознавать такие элементы, 
как осевые или скрытые линии. Вес (толщина) линии определяет толщину на-
чертания объекта и используется для повышения наглядности рисунка. Распо-
ложение объектов на различных слоях позволяет упростить многие операции по 
управлению данными рисунка.

Инструменты, предназначенные для управления слоями и свойствами объек-
тов, расположены в группах Layers и Properties ленты Home рабочего пространства 
2D Drafting & Annotation – рис. 5.1.

Рис. 5.1. Инструменты работы со слоями и свойствами объектов

Разделение.рисунка.по.слоям
Построенные объекты всегда размещаются на определенном слое. Например, 
один слой может содержать несущие конструкции, стены, перегородки здания, 
другой слой – коммуникации, электрику и т. п., а третий – мебель, элементы ди-
зайна и т. д. Таким образом, комбинируя различные сочетания слоев, можно ком-
поновать необходимые комплекты конструкторской документации.

Слои могут применяться по умолчанию, а также определяться и именоваться 
самим пользователем. С каждым слоем связаны заданные цвет, тип, вес (толщина) 
линии и стиль печати. Размещая различные группы объектов на отдельных слоях, 
можно структурировать рисунок. Послойная организация чертежа упрощает мно-
гие операции по управлению его данными.
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Например, можно создать отдельный слой для размещения осевых линий, на-
значить ему голубой цвет и штрихпунктирный тип линии CENTER. Впоследствии, 
если потребуется построить осевую линию, достаточно будет переключиться на 
этот слой и начать рисование. Таким образом, перед каждым построением осевых 
линий не требуется вновь устанавливать их цвет и тип. Кроме того, при необходи-
мости отображение слоя можно отключить. 

Работая в пространстве листа или с плавающими видовыми экранами, можно 
установить видимость слоя индивидуально для каждого видового экрана. При не-
обходимости показ какого-либо слоя на экране или его вывод на печать можно 
легко отключить. Для всех слоев действуют одни и те же установки лимитов ри-
сунка, системы координат и коэффициента экранного увеличения. Если какая-
либо совокупность слоев используется часто, то эти слои, цвета и типы линий 
рекомендуется сохранить в шаблоне. Слои представляют собой неграфические 
объекты, которые также хранятся в файле рисунка.

Управление установками свойств слоев осуществляется в Диспетче-
ре свойств слоев Layer Properties Manager, показанном на рис. 5.2. Он 
загружается из падающего меню Format → Layer... или щелчком на 
пиктограмме Layer Properties в группе Layers ленты Home.

Рис. 5.2. Диалоговое окно управления слоями

При создании нового рисунка автоматически создается слой, названный 0, ко-
торому присваиваются белый цвет, непрерывный тип линии Continuous, вес (тол-
щина) линии Default, по умолчанию соответствующий толщине 0.25 mm. Этот слой 
не может быть удален и переименован.

Слои обладают следующими свойствами:

�� Status – состояние слоя. Назначение слою статуса текущего;
�� Name – имя слоя. Состоит из алфавитно-цифровой информации, включаю-

щей специальные символы и пробелы;
�� On – видимость слоя. При этом на экране изображаются только те прими-

тивы, которые принадлежат видимому слою, однако примитивы в скры-
тых слоях являются частью рисунка и участвуют в регенерации;

Разделение рисунка по слоям
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�� Freeze – замораживание слоя. Означает отключение видимости слоя при 
регенерации и исключение из генерации примитивов, принадлежащих за-
мороженному слою;

�� Lock – блокировка слоя. Примитивы в блокированном слое отобража-
ются, но их нельзя редактировать. Блокированный слой можно сделать 
текущим, рисовать в нем, замораживать и применять к его примитивам 
команды справок и объектную привязку;

�� Color – цвет примитивов заданного слоя;
�� Linetype – тип линии, которым будут отрисовываться все примитивы, при-

надлежащие слою;
�� Lineweight – вес (толщина) линии, которой будут отрисовываться все при-

митивы, принадлежащие слою;
�� Transparency – изменение прозрачности во всем чертеже;
�� Plot Style – стиль печати для заданного слоя;
�� Plot – разрешение/запрет вывода слоя на печать;
�� New VP Freeze – замораживание на видовом экране;
�� Description – описание слоя.

Для удобства список слоев, выводимый в Диспетчере свойств слоев Layer 
Properties Manager, можно упорядочить по любому свойству слоя. Допускается 
сортировка слоев по их имени, видимости, цвету, типу, весу (толщине) линии или 
стилю печати. Для сортировки списка достаточно щелкнуть на заголовке столбца 
того параметра, по которому нужно отсортировать слои. Имена слоев могут быть 
отсортированы в алфавитном порядке, как прямом, так и обратном.

Для создания нового слоя необходимо щелкнуть на пиктограмме New 
Layer (Alt+N), находящейся в верхней части окна Диспетчера свойств 
слоев Layer Properties Manager, показанного на рис. 5.2.

Будет создан новый слой, по умолчанию названный Layer1. Далее все новые 
слои автоматически именуются Layer2, Layer3 и т. д. – в порядке их создания. Что-
бы присвоить слою уникальное имя, необходимо двойным щелчком на текущем 
названии активизировать поле ввода текста, а затем набрать имя с клавиатуры и 
нажать клавишу Enter.

Если при создании нового слоя выделен один из имеющихся, то новый слой 
наследует его свойства. При необходимости свойства нового слоя можно изме-
нить.

Все вновь создаваемые в AutoCAD объекты размещаются на текущем слое. 
При установке нового текущего слоя все объекты будут создаваться на нем с ис-
пользованием назначенных ему свойств: цвета, типа и веса линии. Замороженные 
и зависимые от ссылок слои нельзя сделать текущими.

New Layer VP Frozen in All Viewports – создание нового слоя и заморажи-
вание его во всех видовых экранах.
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Delete Layer (Alt+D) – удаление выбранных неиспользуемых слоев. 
Нельзя удалить слои 0 и DEFPOINTS, а также слои с объектами, теку-
щий слой и слои, зависимые от внешних ссылок.

Чтобы сделать слой текущим, необходимо установить указатель 
мыши в графу Status соответствующего слоя и щелкнуть на пикто-
грамме Set Current (Alt+C).

Сделать слой текущим можно двойным щелчком в графе Status соответствую-
щего слоя или с помощью системной переменной CLAYER.

Установить текущий слой также можно, выбрав его из раскрывающегося спи-
ска управления слоями на панели инструментов (рис. 5.3).

Рис. 5.3. Список управления слоями

Кроме того, удобно устанавливать слой объекта текущим. Для этого 
следует выбрать этот объект, а затем щелкнуть на пиктограмме Make 
Object’s Layer Current в падающем меню Format → Layer tools.

Диспетчер свойств слоев Layer Properties Manager (см. рис. 5.2) включает также 
следующие инструменты.

New Property Filter (Alt+P) – загрузка диалогового окна Layer Filter Proper-
ties, которое позволяет создать фильтр слоев на основе одного или бо-
лее свойств слоев.

New Group Filter (Alt+G) – создание фильтра, содержащего слои, которые 
выбираются вручную пользователем.

Layer States Manager (Alt+S) – загрузка одноименного Диспетчера кон-
фигураций слоев, дающего возможность сохранить текущие настрой-
ки свойств слоев в именованной конфигурации.

Разделение рисунка по слоям
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Refresh – обновление информации об использовании слоя путем про-
смотра всех имеющихся на чертеже объектов.

Settings – загрузка диалогового окна Layer Settings, позволяющего уста-
навливать параметры уведомления о новых слоях (рис. 5.4).

Рис. 5.4. Диалоговое окно параметров слоев



139

�� В области New Layer Notification осуществляется управление вычислениями 
и выводом уведомлений о новых слоях на основе настройки LAYEREVAL 
в файле DWG:
•� Evaluate new layers added to drawing – проверка добавленных в чертеж но-

вых слоев (значение 0 системной переменной LAYEREVAL):
◊� Evaluate new xref layers only – проверка новых слоев, которые были до-

бавлены в присоединенные к чертежу внешние ссылки (значение 1 
системной переменной LAYEREVAL);

◊� Evaluate all new layers – вычисление всех новых слоев (значение 2 си-
стемной переменной LAYEREVAL);

•� Notify when new layers are present – включение функции уведомления о 
новых слоях (значение 0 системной переменной LAYERNOTIFY);
◊� Open – если новые слои присутствуют в момент использования ко-

манды OPEN (значение 2 системной переменной LAYERNOTIFY);
◊� Attach/Reload xrefs – если новые слои присутствуют в момент подклю-

чения или обновления внешних ссылок (значение 4 системной пере-
менной LAYERNOTIFY);

◊� Restore layer state – в момент восстановления конфигурации слоев 
(значение 8 системной переменной LAYERNOTIFY);

◊� Save – если новые слои присутствуют в момент использования коман-
ды SAVE (значение 16 системной переменной LAYERNOTIFY);

◊� Insert – если новые слои присутствуют в момент использования ко-
манды INSERT (значение 32 системной переменной LAYERNOTIFY);

•� Display alert for plot when layers are present – если новые слои присутствуют 
в момент использования команды PLOt (значение 4 системной перемен-
ной LAYERNOTIFY).

�� В области Isolate Layer Settings осуществляется настройка для неизолиро-
ванных слоев:
•� Lock and fade – в качестве способа изоляции выбирается режим блоки-

ровки и слияния;
•� Off – отключение слоев, которые не были выбраны. В видовом экране 

пространства листа использовать: Off – отключение; VP Freeze – заморо-
женный на видовом экране.

�� В области Dialog Settings осуществляется настройка параметров диалога:
•� Apply layer filter to layer toolbar – применение текущего фильтра слоев к 

панели слоев;
•� Indicate layers in use – отображение используемых слоев;
•� Viewport override background color: – переопределение фонового цвета ви-

дового экрана.

�� Также инструменты управления слоями находятся в падающем меню 
Format → Layer tools (рис. 5.5).

Разделение рисунка по слоям
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Рис. 5.5. Инструменты управления слоями 

Выполните упражнение La из раздела 3.

Управление.видимостью.слоя
AutoCAD не отображает на экране объектов, расположенных на невидимых слоях, 
и не выводит их на плоттер. Если при работе с деталями рисунка на одном или 
нескольких слоях чертеж слишком загроможден, допускается отключение или за-
мораживание неиспользуемых слоев. Кроме того, чтобы запретить вывод на пе-
чать объектов определенных слоев, например для вспомогательных линий, можно 
оставить эти слои видимыми, но отключить их вывод на печать.

Запрет печати любого слоя осуществляется в Диспетчере свойств слоев Layer 
Properties Manager (см. рис. 5.2). С этой целью требуется выделить слои, для кото-
рых необходимо разрешить или запретить вывод на печать, и щелкнуть на пикто-
грамме Plot.
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Выбор способа отключения показа слоев зависит от характера их использова-
ния и сложности рисунка. Замораживать слои лучше в тех случаях, когда отобра-
жение слоя можно отключить на длительное время. При этом ускоряется выпол-
нение команд зуммирования ZOOm, панорамирования PAN и VPORts, упроща-
ется выбор объектов и снижается время регенерации сложных рисунков. Объекты 
замороженных слоев не обрабатываются функциями регенерации, скрытия и то-
нирования. Разрешается замораживать и размораживать слои только на активном 
плавающем видовом экране. 

При создании новых плавающих видовых экранов можно автоматически за-
мораживать на них определенные слои. Например, допустимо скрытие размеров 
путем замораживания слоя с размерными линиями для всех новых видовых экра-
нов. Если же на новом видовом экране требуется отображение размеров, для этого 
видового экрана можно разморозить соответствующий слой. Включение или от-
ключение заморозки слоев для новых видовых экранов не изменяет видимости 
слоев на уже имеющихся видовых экранах. 

Объекты отключенных слоев участвуют в регенерации, хотя и не выводятся 
на экран или плоттер. Чтобы сделать слой временно невидимым, его лучше от-
ключить, а не заморозить, так как при размораживании слоя всегда выполняется 
регенерация рисунка. При включении слоя выполняется перерисовка объектов 
данного слоя.

Для отключения слоя необходимо в Диспетчере свойств слоев Layer Properties 
Manager, показанном на рис. 5.2, навести указатель мыши на имя отключаемого 
слоя и затем щелкнуть на пиктограмме в столбце On. Аналогично происходит и 
замораживание слоя при щелчке на пиктограмме Freeze.

Кроме того, управлять видимостью слоев можно в раскрывающемся списке 
управления слоями на панели инструментов Layers (см. рис. 5.3).

Блокировка.слоев
Блокировку слоев полезно применять в случаях, когда требуется редактирова-
ние объектов, расположенных на определенных слоях, с возможностью просмот-
ра объектов на других слоях. Редактировать объекты на заблокированных слоях 
нельзя. Однако они остаются видимыми, если слой включен и разморожен. Мож-
но сделать заблокированный слой текущим и создавать на нем объекты.

Допускаются также применение на заблокированных слоях справочных ко-
манд к объектам и привязка к ним с помощью режимов объектной привязки. За-
блокированные слои можно включать и отключать, а также изменять связанные с 
ними цвета и типы линий.

Блокировка слоя включается либо в Диспетчере свойств слоев Layer Properties 
Manager, показанном на рис. 5.2, либо в раскрывающемся списке управления слоя-
ми на панели инструментов Layers (см. рис. 5.3) – щелчком на пиктограмме Lock 
соответствующего слоя.

Блокировка слоев
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Цвет.линии
Назначение объектам различных цветов облегчает работу с рисунком, поскольку 
позволяет визуально идентифицировать группы объектов.

Присвоение цветов слоям осуществляется в Диспетчере свойств слоев Layer 
Properties Manager, показанном на рис. 5.2. Для этого необходимо щелкнуть на пик-
тограмме Color соответствующего слоя. При этом загружается диалоговое окно 
Select Color, предлагающее выбрать оттенок из палитры (рис. 5.6).

Рис. 5.6. Диалоговое окно выбора цвета

Можно ввести либо его имя, либо номер в виде целого числового значения от 
1 до 255 в таблице индексов цветов AutoCAD Color Index (ACI). Стандартные имена 
присвоены только цветам с номерами от 1 до 7 (1 – красный, 2 – желтый, 3 – зеле-
ный, 4 – голубой, 5 – синий, 6 – фиолетовый, 7 – белый/черный).

Полноцветная палитра цветов True Color располагает набором из 16 миллионов 
оттенков (рис. 5.7). При этом используются две цветовые модели: RGB, где за-
даются красная, зеленая и синяя составляющие цвета, и HSL, где определяются 
оттенок, насыщенность и яркость цвета.
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Рис. 5.7. Диалоговое окно палитры цветов True Color

Цвета можно присваивать как слоям, так и отдельным объектам чертежа.
Кроме того, могут быть заданы ключевые слова ByLayer – по слою и ByBlock – по 

блоку. ByLayer означает, что примитив будет создаваться в соответствии с цветом, 
определенным для текущего слоя. ByBlock означает, что объекты будут изобра-
жаться белым цветом до тех пор, пока их не объединят в блок. Куда бы затем ни 
был вставлен блок, объекты приобретут текущий цвет.

Интерес представляет работа с альбомами цветов – вкладка Color Books диало-
гового окна Select Color (рис. 5.8), – которые содержат именованные образцы, что 
позволяет улучшить вид рисунка и подготовить высококачественные презентаци-
онные материалы.

Тип.линии
Применение различных типов линий – еще один способ визуального представ-
ления информации. Различные типы линий отражают их разное назначение. Тип 
линии описывается повторяющейся последовательностью штрихов, точек и про-
белов. Линии сложных типов могут включать в себя различные символы. Пользо-
ватель имеет возможность создавать собственные типы линий.

Тип линии
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Рис. 5.8. Диалоговое окно альбомов цветов

Конкретные последовательности штрихов и точек, относительные длины 
штрихов и пробелов, а также характеристики включаемых текстовых элементов и 
форм определяются именем типа линии, а также его описанием.

Назначение типа линии слою осуществляется в Диспетчере свойств слоев Layer 
Properties Manager. Для этого необходимо щелкнуть на пиктограмме Linetype соот-
ветствующего слоя. В открывшемся диалоговом окне Select Linetype, показанном 
на рис. 5.9, выбирается подходящий тип линии. Если в предлагаемом списке нет 
нужного варианта, следует подгрузить его, щелкнув на кнопке Load... и указав в 
открывшемся диалоговом окне Load or Reload Linetypes подходящий образец линии 
(рис. 5.10). Затем, вернувшись в диалоговое окно Select Linetype, установить указа-
тель мыши на требуемый тип линии.

Ключевое слово ByLayer означает, что примитив будет создаваться в соответ-
ствии с типом линии, определенным для текущего слоя. Ключевое слово ByBlock 
означает, что примитивы будут изображаться сплошными (continuous) линиями. 
Если эти объекты объединены в блок, им присваивается тип линии, установлен-
ный для слоя, которому принадлежит точка вставки блока.

Длина штрихов и пробелов, составляющих штрихпунктирную линию, измеря-
ется в условных единицах. Начальная установка масштаба типа линии для каждо-
го рисунка – одна единица. AutoCAD позволяет изменять масштаб изображения 
линии. Чем меньше масштаб, тем больше повторений элементарного фрагмента 
линии.
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Рис. 5.9. Диалоговое окно установки типа линии

Рис. 5.10. Диалоговое окно подгрузки различных типов линий

Текущее значение глобального масштабного коэффициента для всех объектов 
хранится в системной переменной LTSCALE. Значением масштаба текущего объ-
екта управляет системная переменная CELTSCALE, которая изменяет масштаб типа 
линий новых объектов. Настройка масштаба типов линий на различных видовых 
экранах листа выполняется с помощью системной переменной PSLTSCALE.

Для задания масштаба типов линий необходимо загрузить Диспетчер типов 
линий Linetype Manager из падающего меню Format → Linetype… и щелкнуть на кноп-
ке Show details для отображения подробного окна (рис. 5.11).

Тип линии
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Рис. 5.11. Диспетчер типов линий

�� В области Linetype filters настаиваются фильтры типов линий:
•� в списке можно отфильтровать типы линий, зависимые от ссылок, ис-

пользуемые или не используемые в объектах;
•� Invert filter – отбор типов линий, не удовлетворяющих условию установ-

ленного фильтра.
�� Кнопка Load… загружает диалоговое окно подгрузки различных типов ли-

ний Load or Reload Linetypes (см. рис. 5.10).
�� Кнопка Delete удаляет выбранные типы линий, не используемые в чертеже.
�� Кнопка Current устанавливает тип линии текущим (системная переменная 
CELTYPE).

�� Кнопка Show/Hide details предоставляет доступ к свойствам и дополнитель-
ным настройкам.

�� В области Details приведены следующие параметры текущей линии:
•� Name: – отображает и позволяет редактировать имя выбранного типа 

линий;
•� Description: – отображает и позволяет редактировать текстовое описание 

для выбранного типа линий;
•� Use paper space units for scaling – указание масштабирования в единицах 

пространства листа и модели (системная переменная PSLTSCALE);
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•� Global scale factor: – указание значения глобального масштабного коэф-
фициента для всех типов линий;

•� Current object scale: – указание значения масштаба типа линий для вновь 
создаваемых объектов. Результирующий масштаб равен произведению 
значений глобального масштаба и текущего масштаба объекта (систем-
ная переменная CELTSCALE);

•� ISO pen width: – присвоение масштабу типа линий одного из стандартных 
значений по ISO. Результирующий масштаб равен произведению значе-
ний глобального масштаба и текущего масштаба объекта.

Имеется возможность переименовывать типы линий в любой момент редак-
тирования рисунка. Переименование какого-либо типа линии приводит к изме-
нению его описания, используемого в текущем рисунке. Название этого типа ли-
нии в библиотечном LIN-файле остается прежним. Нельзя изменить имена типов 
линий ByLayer, ByBlock и Continuous, а также типов линий, зависящих от внешних 
ссылок.

Типы линий можно сортировать по имени и описанию. При этом типы линий 
ByLayer и ByBlock всегда находятся в начале списка. Названия типов линий могут 
быть отсортированы в алфавитном порядке, как прямом, так и обратном.

Типы линий можно назначать любым объектам AutoCAD, кроме текстовых 
объектов, точек, видовых экранов, бесконечных прямых, лучей, трехмерных по-
лилиний и блоков. Если длина объекта меньше длины элементарного фрагмента 
типа линии, такой объект отрисовывается сплошной линией.

Для двухмерной полилинии имеется возможность центрировать образец типа 
линии в пределах каждого сегмента либо размещать образец непрерывно по всей 
ее длине. Управляет этими режимами системная переменная PLINEGEN.

Вес.(толщина).линии
Веса линий определяют толщину начертания объектов и используются при вы-
воде объектов как на экран, так и на печать. Наличие линий различной толщины 
необходимо при оформлении чертежей: начертание линий основного контура, 
размеров, штриховки, невидимых линий и пр.

Для отображения на экране весов линий необходимо в строке состояния на-
жать кнопку LWT.

Вес линии устанавливается в Диспетчере свойств слоев Layer Properties Manager 
(рис. 5.2). Для этого необходимо щелкнуть на пиктограмме Lineweight соответствую-
щего слоя, а затем в открывшемся диалоговом окне Lineweight выбрать из списка 
подходящее значение (рис. 5.12).

Веса линий можно выбирать из определенного ряда значений, среди которых 
есть специальный вес под названием Default. По умолчанию вес линии Default соот-
ветствует толщине 0,25 мм (0,01 дюйма), это значение устанавливается системной 
переменной LWDEFAULT.

Вес (толщина) линии
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В пространстве модели нулевое значение веса линии соответствует линии тол-
щиной в один пиксель, а при выводе на печать – наименьшей величине, обеспе-
чиваемой используемым печатающим устройством. Все объекты, вес линии кото-
рых не превышает 0,025 мм (0,01 дюйма), отрисовываются в пространстве модели 
линией толщиной в один пиксель. Значения весов линии, вводимые в командной 
строке, округляются до ближайшей стандартной величины.

Рис. 5.12. Диалоговое окно установки веса линии

Информация о весе линии сохраняется при экспорте рисунка в другие форма-
ты и при копировании объектов в буфер обмена. Выбрать единицы представления 
веса линий и задать значение для веса Default можно в диалоговом окне Lineweight 
Settings, показанном на рис. 5.13.

Для вызова этого окна необходимо либо щелкнуть правой кнопкой мыши 
на значке  Show/Hide Lineweight в строке состояния и выбрать из контекстно-

го меню пункт Lineweight Settings..., либо выбрать из падающего меню Format → 
Lineweight…, либо нажать кнопку Lineweight Settings... на вкладке User Preferences 
диалогового окна Options, либо ввести в командной строке LWEIGHT. 
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Рис. 5.13. Диалоговое окно установки параметров весов линий

Диалоговое окно Lineweight Settings позволяет установить следующие парамет-
ры весов линий.

�� В области Lineweights – выбор из списка допустимых значений весов ли-
ний (системная переменная LWDEFAULT).

�� В области Units for Listing – единицы измерения весов линий: миллиметры 
Millimeters или дюймы Inches  (системная переменная LWUNITS).

�� Display Lineweight – отображение линий в чертеже в соответствии с весом 
линий в пространстве модели и листа (системная переменная LWDISPLAY). 
Состояние этого флажка не оказывает влияния на вид объектов при печа-
ти.

�� Default – задание значения веса линий по умолчанию (системная перемен-
ная LWDEFAULT).

�� В области Adjust Display Scale – настройка масштаба экранного отображе-
ния весов линий для пространства модели.

�� Current Lineweight: – выводится текущий вес линий, выбранный из списка.

Способы отображения весов линий в пространствах модели и листа несколько 
различаются. В пространстве модели каждому значению веса линии соответству-
ет определенное число пикселей, определяющих видимую на экране толщину ли-
ний. В пространстве листа видимая на экране толщина начертания объекта уста-
навливается пропорциональной текущему коэффициенту экранного увеличения. 
Использование в пространстве модели фиксированного числа пикселей для каж-
дого веса линии облегчает идентификацию объектов по их толщине при любом 
коэффициенте экранного увеличения. При этом необходимо помнить, что в про-
странстве модели видимая толщина линий может не соответствовать их действи-

Вес (толщина) линии
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тельной толщине. Значению веса линии 0 в пространстве модели всегда соответ-
ствует линия толщиной 1 пиксель. Толщина отображения остальных весов линий 
(в пикселях) устанавливается пропорционально их точным значениям.

В пространстве модели, когда включен режим отображения весов линий, в точ-
ках соединения концов отдельных отрезков используется соединение со скосом 
без окончаний линий. При этом угол скоса подбирается автоматически. Оконча-
ния линий определяют способ изображения концов отрезков и могут, например, 
представлять закругление или скос. При выводе на печать с помощью стилей пе-
чати можно задавать различные типы соединений и окончания линий для различ-
ных весов линий.

В пространстве модели в режиме отображения весов линий толщина начерта-
ния любого объекта не зависит от коэффициента экранного увеличения. Напри-
мер, если весу линии соответствует толщина четыре пикселя, то объекты с таким 
весом всегда отрисовываются линией толщиной четыре пикселя даже при умень-
шении экранного изображения до максимально возможного значения.

Можно задавать масштаб отображения весов линий и изменять таким образом 
количество пикселей, соответствующих весам линий в пространстве модели. Из-
менение масштаба отображения не влияет на толщину линий при выводе на печать. 
Следует отметить, что если используемые веса линий представлены более чем од-
ним пикселем, то время регенерации рисунка возрастает. Если устанавливае мый 
по умолчанию масштаб отображения не изменялся, то веса линий, меньшие или 
равные 0,025 мм (0,01 дюйма), отображаются толщиной в один пиксель и потому 
не снижают скорость работы AutoCAD. При изменении масштаба отображения 
весов линий количество весов, соответствующих толщине в один пиксель, также 
изменяется. Для повышения скорости работы AutoCAD в пространстве модели 
можно уменьшить масштаб экранного отображения весов линий или вообще от-
ключить веса линий.

Веса линий игнорируются для шрифтов TrueType, растровых изображений, то-
чек и заливок для плоских фигур.

Фильтрация.слоев
Иногда требуется, чтобы в списке Диспетчера свойств слоев Layer Properties Manager 
перечислялись только определенные слои. Для указания выводимых в список 
слоев используется функция фильтрации. Фильтрация слоев может производить-
ся по следующим критериям:

�� по именам, цветам и типам линий, весам линий и стилям печати, назна-
ченных слоям;

�� по состояниям слоев «включен/отключен»;
�� по состояниям слоев «заморожен/разморожен»;
�� по состояниям слоев «блокирован/разблокирован»;
�� по состояниям слоев «печатать/не печатать»;
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�� по наличию/отсутствию слоев в текущем рисунке;
�� по наличию/отсутствию зависимостей слоев от внешних ссылок.

Инструменты, позволяющие настроить фильтры слоев, находятся в левом 
верхнем углу Диспетчера свойств слоев Layer Properties Manager (см. рис. 5.2).

New Property Filter (Alt+P) – загрузка диалогового окна Layer Filter 
Properties, позволяющего создать фильтр слоев на основе одного или 
более свойств слоев (рис. 5.14).

Рис. 5.14. Диалоговое окно настройки свойств фильтра слоев

New Group Filter (Alt+G) – создание фильтра, содержащего слои, которые 
выбираются вручную пользователем.

Layer States Manager (Alt+S) – загрузка Диспетчера конфигураций слоев 
Layer States Manager (рис. 5.15), позволяющего сохранить текущие на-
стройки свойств слоев в именованной конфигурации.

�� В области Layer states отображается список именованных конфигураций 
слоев, сохраненных в данном чертеже. Имеется возможность создавать, 
переименовывать, изменять и удалять конфигурации слоев. В списке обо-
значено: 
•� Space – пространство, в котором были сохранены слои (пространство 

модели, лист или внешняя ссылка);
•� Same as DWG – совпадает ли данный список слоев со списком, имеющим-

ся в чертеже;
•� Description – дополнительное описание.

Фильтрация слоев
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Рис. 5.15. Диспетчер конфигураций слоев

�� Don’t list layer states in Xrefs – включение/выключение отображения конфи-
гураций слоев во внешних ссылках.

�� В области Restore options назначается восстановление параметров:
•� Turn off layers not found in layer state – при восстановлении конфигурации 

слоев происходит отключение новых слоев, для которых параметры не 
были сохранены, так что чертеж выглядит так же, как при сохранении 
данной именованной конфигурации слоев;

•� Apply properties as viewport overrides – применение переопределений 
свойств слоев к текущему видовому экрану.

�� Кнопка New… – вывод окна New Layer State to Save, в котором можно задать 
имя и описание новой именованной конфигурации слоев.

�� Кнопка Save – сохранение выделенной именованной конфигурации слоев.
�� Кнопка Edit… – вывод диалогового окна Edit Layer State, позволяющего вно-

сить изменения в выбранную именованную конфигурацию слоев.
�� Кнопка Rename – контекстное редактирование имени конфигурации сло-

ев.
�� Кнопка Delete – удаление выделенной именованной конфигурации слоев.
�� Кнопка Import… – импорт файла конфигураций слоев, который загружает-

ся в текущий чертеж.
�� Кнопка Export… – сохранение конфигурации слоев в LAS-файле.
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�� В области Layer properties to restore определяются настройки свойств сло-
ев, которые должны восстанавливаться при восстановлении выделенной 
именованной конфигурации слоев:

•� On / Off – включен/отключен;
•� Frozen / Thawed – заморожен/разморожен;
•� Visibility in Current VP – видимость на текущем видовом экране;
•� Locked / Unlocked – блокирован/разблокирован;
•� Plot / No Plot – печатаемый/непечатаемый;
•� Color – цвет;
•� Linetype – тип линий;
•� Lineweight – вес линий;
•� Transparency – прозрачность;
•� Plot Style – стиль печати;
•� New VP Frozen / Thawed – заморожен/разморожен на новых видовых экра-

нах.
�� Кнопка Select All – выделение всех настроек.
�� Кнопка Clear All – снятие выделения со всех настроек.

Рис. 5.16. Контекстное меню настройки фильтров

При нажатии правой кнопки мыши в левой области Диспетчера свойств слоев 
Layer Properties Manager появляется контекстное меню (рис. 5.16), содержащее 
следующие параметры:

�� Visibility – видимость (включить, отключить, разморозить, заморозить);
�� Lock – блокировать/разблокировать;
�� Viewport – видовой экран;
�� Isolate Group – выделить группу (все видовые экраны, только активный ви-

довой экран);
�� New Properties Filter… – загрузка диалогового окна Layer Filter Properties, по-

зволяющего настроить новый фильтр слоев по свойствам (см. рис. 5.14);

Фильтрация слоев
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�� New Group Filter – новый групповой фильтр;
�� Convert to Group Filter – преобразовать в групповой фильтр;
�� Rename – переименовать;
�� Delete – удалить;
�� Select Layers – выбрать слои (добавить, заменить).

При нажатии правой кнопки мыши в правой области Диспетчера свойств слоев 
Layer Properties Manager появляется контекстное меню (рис. 5.17), содержащее сле-
дующие параметры:

�� Show Filter Tree – показать дерево фильтров;
�� Show Filters in Layer List – показать фильтры в списке;
�� Set current – установить текущим;
�� New Layer – новый слой;
�� Rename Layer – переименовать слой;
�� Delete Layer – удалить слой;
�� Change Description – изменить пояснение;
�� Remove From Group Filter – удалить из группового фильтра;
�� New Layer VP Frozen in All Viewports – создать новый замороженный слой на 

всех видовых экранах;
�� VP Freeze Layer – заморозить слой;
�� VP Thaw Layer in All Viewports – разморозить слой на всех видовых экранах;
�� Isolate selected layers – изолировать текущие слои;
�� Merge selected layer(s) to… – объединить выбранные слои;
�� Select All – выбрать все;
�� Clear All – очистить все;
�� Select All but Current – выбрать все, кроме текущего;
�� Invert Selection – инвертировать выбор;
�� Invert Layer Filter – инвертировать фильтр;
�� Layer Filters – фильтр слоев (все слои, все используемые слои);
�� Save Layer States… – загрузка диалогового окна сохранения новой конфи-

гурации слоев New Layer State to Save;
�� Restore Layer State… – загрузка Диспетчера конфигураций слоев Layer States 

Manager для восстановления конфигурации.

Использование.свойств.слоев
Имеется возможность присваивать свойства как слоям, так и непосредственно 
объектам рисунка. При построении нового объекта ему автоматически назнача-
ются цвет, тип и вес линии, а также стиль печати ByLayer. Если свойство объекта 
имеет специальное значение ByLayer, фактическое значение этого свойства опре-
деляется параметром того слоя, на котором находится объект. 

Например, при построении на слое, которому назначены зеленый цвет, тип ли-
нии Continuous, вес линии 0.25 mm и стиль печати Default, новый объект отображает-
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ся с использованием именно этих значений. Применение специального значения 
ByLayer, доступного для таких свойств объекта, как цвет, тип линии, вес линии и 
стиль печати, упрощает управление и манипуляцию объектами рисунка. Кроме 
того, послойная организации чертежа упрощает визуальную идентификацию раз-
личных его элементов (деталей, крепежа, текстовой информации и т. д.) по свой-
ствам слоев, на которых они располагаются.

Рис. 5.17. Контекстное меню Диспетчера свойств слоев

Если необходимо, любому объекту можно присвоить цвет, тип линии, вес ли-
нии или стиль печати, отличный от соответствующего свойства слоя, на котором 
располагается объект. Свойство объекта может иметь какое-либо определенное 
значение (например, «красный» – для цвета) или одно из специальных значений 
ByLayer либо ByBlock. Новое значение свойства объекта используется вместо соот-
ветствующего свойства слоя до тех пор, пока этому свойству не будет возвращено 
значение ByLayer.

При выборе значения ByBlock свойства новых объектов применяют стандарт-
ные значения до тех пор, пока объекты не будут объединены в блок. После созда-
ния блока из таких объектов значения их свойств определяются свойствами слоя, 
в который вставляется блок.

Рассмотрим пример: блок с именем СТУЛ образован из двух объектов, сиденья 
и спинки. Исходные объекты, изображающие сиденье и спинку стула, находятся 
соответственно на слоях СИДЕНЬЕ и СПИНКА. Пусть блок СТУЛ вставляется в слой 
с именем МЕБЕЛЬ, которому назначен фиолетовый цвет. Если до создания блока 
объекты, соответствующие спинке и сиденью, имели цвет ByLayer, то независимо 
от слоя, в который вставлен блок, цвет сиденья и спинки будет определяться те-
кущим значением цвета слоев СИДЕНЬЕ и СПИНКА. Если до создания блока объекты, 

Использование свойств слоев
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соответствующие спинке и сиденью, имели цвет ByBlock, то цвет сиденья и спинки 
будет определяться текущим цветом того слоя, в который вставлен блок (в данном 
примере это фиолетовый цвет).

При выборе объекта, если ни одна из команд не активна, динамически отобра-
жаются слой, цвет, тип и вес линии данного объекта. Параметры выбранного объ-
екта можно изменить, настроив их в раскрывающихся списках управления цве-
том, типом или весом линии, но при этом не должна выполняться ни одна команда. 
Чтобы сделать цвет, тип или вес линии текущими, достаточно выбрать их соответ-
ственно из раскрывающихся списков управления свойствами линии.

Копирование.свойств.объектов
Команда mAtCHPROP предназначена для копирования свойств за-
данного объекта другому объекту. Она вызывается из падающего 
меню Modify → Match Properties или щелчком на пиктограмме Match 
Properties в группе Properties ленты Home.

Допускается копировать цвет, слой, тип линий, масштаб типа линий, вес ли-
ний, размерный и текстовый стили, стиль печати, трехмерную высоту и другие 
свойства.

В процессе копирования свойств объектов можно изменять параметры на-
стройки свойств, например запретить копирование некоторых из них. Для этого 
необходимо щелкнуть на пиктограмме Match Properties и выбрать объект, свойства 
которого следует скопировать. Далее щелчком правой кнопкой мыши вызвать 
контекстное меню, из которого выбрать пункт Settings. Загрузится диалоговое 
окно настройки свойств Property Settings (рис. 5.18), позволяющее настроить сле-
дующие параметры.

Рис. 5.18. Диалоговое окно настройки свойств
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�� В области Basic Properties – определить основные свойства:
•� Color – цвет;
•� Layer – слой;
•� Linetype – тип линии;
•� Linetype Scale – масштаб типа линий;
•� Lineweight – вес линий;
•� Transparency – прозрачность;
•� Thickness – высота;
•� PlotStyle – стиль печати.

�� В области Special Properties – определить специальные свойства:
•� Dimension – помимо базовых свойств, изменяется размерный стиль;
•� Polyline – помимо основных свойств, изменяются ширина и тип полили-

нии объекта;
•� Material – материал;
•� Text – помимо базовых свойств, изменяется текстовый стиль;
•� Viewport – помимо основных свойств объектов, изменяются следующие 

свойства видового экрана пространства листа: включение/отключение, 
блокировка экрана, стандартный и пользовательский масштаб, визуа-
лизация при печати, привязка, сетка, видимость и расположение значка 
ПСК;

•� Shadow display – помимо основных свойств, изменяется отображение те-
ней;

•� Hatch – помимо основных свойств, изменяется штриховка;
•� Table – помимо основных свойств, изменяется стиль таблица;
•� Multileader – помимо основных свойств, изменяется стиль мультивыно-

сок.

Выполните упражнение Pr8 из раздела 4.

Палитра.свойств.объектов
Палитра свойств объектов Properties, показанная на рис. 5.19, – это 
единый инструмент, управляющий практически всеми свойствами 
объектов рисунка. На палитре собрано около 40 диалоговых окон и 
команд, которые были разрознены в более ранних версиях AutoCAD. 
Загружается она командой PROPERtiEs, либо из падающего меню 
Modify → Properties (Ctrl+1), либо щелчком на стрелочке справа внизу в 
группе Properties ленты Home.

Палитра свойств объектов Properties позволяет производить фильтрацию на-
боров выбранных объектов по их типу, предоставляя возможность редактировать 

Палитра свойств объектов
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свойства каждого объекта. В случае если текущий набор объектов не создан, по-
казывается текущее состояние таких свойств рисунка, как стиль вывода на печать, 
ПСК, данные о видовых экранах, гиперссылки.

Рис. 5.19. Палитра свойств объектов

В верхней части палитры расположен раскрывающийся список, содержащий 
типы и количество выбранных объектов. Справа от него – кнопки переключе-
ния:
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Toggle value of PICKADD Sysvar – переключение системной переменной 
PICKADD;

Select Objects – выбор объектов;

Quick Select – быстрый выбор объектов.

Ниже расположены следующие разделы.

�� General – общие, содержит поля:
•� Color – цвет;
•� Layer – слой;
•� Linetype – тип линий;
•� Linetype scale – масштаб типа линий;
•� Lineweight – вес линий;
•� Transparency – прозрачность;
•� Thickness – высота.

�� 3D Visualization – трехмерная визуализация, содержит поля:
•� Material – материал:

◊� ByBlock – по блоку;
◊� ByLayer – по слою;
◊� Global – глобальный;

•� Shadow display – графические свойства тени:
◊� Casts and Receives Shadows – отбрасываемая и принимаемая тень;
◊� Casts shadows – отбрасываемая тень;
◊� Receives shadows – принимаемая тень;
◊� Ignore shadows – игнорировать тени.

�� Plot style – стиль печати, содержит поля:
•� Plot style – стиль печати;
•� Plot style table – таблица стилей печати;
•� Plot table attached to – пространство таблицы стилей печати;
•� Plot table type – тип стилей печати.

�� View – вид, содержит поля:
•� Center X – центр X;
•� Center Y – центр Y;
•� Center Z – центр Z;
•� Height – высота;
•� Width – ширина.

�� Misc – разное, содержит поля:
•� Annotation scale – масштаб;
•� UCS icon On – включение/отключение пиктограммы ПСК;
•� UCS icon at origin – расположение знак ПСК в начале координат;

Палитра свойств объектов



Глава 5. Свойства примитивов160

•� UCS per viewport – расположение знака ПСК в каждом видовом экране;
•� UCS Name – имя ПСК;
•� Visual Style – визуальный стиль видового экрана (текущий, двухмерный 

каркас, трехмерный скрытый, трехмерный каркас, концептуальный, 
скрытие линий, реалистичный, тонированный, тонированный с кром-
ками, оттенки серого, эскизный, каркас, просвечивание).

Палитра свойств объектов Properties может оставаться открытой в процессе 
работы; она показывает свойства выбранного объекта. Если выделено несколько 
объектов, в окне выводятся только общие свойства, значения которых совпадают 
у всех выбранных объектов. К общим свойствам относятся цвет, слой, тип линии, 
масштаб типа линии, стиль печати, вес линии, гиперссылка, высота.

Выполните упражнения Pr1–Pr8 и Pe1 из раздела 4.



Глава.6

Управление.экраном

Зуммирование ............................162
Панорамирование .......................167
Панель навигации .......................168
Штурвалы ....................................168
Аниматор движения ....................171
Перерисовка и регенерация ........173
Изменение порядка рисования 
объектов .....................................173



Глава 6. Управление экраном162

Система AutoCAD обладает широкими возможностями отображения различных 
видов рисунка. Предусмотрены команды, которые позволяют при редактировании 
чертежа быстро перемещаться от одного его фрагмента к другому для визуального 
контроля внесенных изменений. Можно зуммировать изображение, изменяя его 
экранное увеличение, или производить панорамирование, перемещая рисунок по 
видовому экрану; также допускается сохранение выбранного вида с его последую-
щим восстановлением для вывода на печать или просмотра. Кроме того, обеспечи-
вается одновременный просмотр различных участков рисунка путем разделения 
области рисунка на несколько неперекрывающихся видовых экранов.

Зуммирование
Видом называется совокупность экранного увеличения, положения и ориентации 
части рисунка, видимой на экране. Основной способ изменения вида – выбор од-
ного из имеющихся в AutoCAD режимов зуммирования, при котором размер изо-
бражения фрагмента в области рисунка увеличивается или уменьшается.

При зуммировании либо увеличивают изображение с целью большей детали-
зации, либо уменьшают для того, чтобы на экране помещалась большая часть ри-
сунка (рис. 6.1, 6.2).

Рис. 6.1. Уменьшенное изображение рисунка

Рис. 6.2. Увеличенное изображение рисунка
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При зуммировании абсолютные размеры рисунка остаются прежними – изме-
няется лишь его видимая часть в графической области. 

В AutoCAD существуют различные способы изменения вида, в том числе ука-
зание его границ рамкой, изменение коэффициента увеличения/уменьшения на 
заданную величину и показ рисунка в его границах.

Операция зуммирования осуществляется командой ZOOm, вызываемой из па-
дающего меню View → Zoom (рис. 6.3).

Рис. 6.3. Команда зуммирования в падающем меню

Удобно работать с командами управления экраном 
на панели навигации (рис. 6.4).

Запрос команды ZOOm:
Specify corner of window, enter a scale factor 
(nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>: – указать угол рамки, 
ввести масштаб или один из ключей (Все/Центр/Ди-
намика/Границы/Предыдущий/Масштаб/Рамка/
Объект)

Ниже приводится подробное описание каждого ис-
полнения команды ZOOm.

Рис. 6.4. Инструменты 
зуммирования в панели 

навигации

Зуммирование
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Zoom Realtime – увеличение и уменьшение масштаба изображения в ре-
жиме реального времени.

Команда ZOOm с ключом real time обеспечивает возможность интерактив-
ного зуммирования изображения в режиме реального времени. При перемещении 
указателя мыши по видовому экрану происходит динамическое увеличение или 
уменьшение выводимого на экране рисунка.

В этом режиме пользователь может изменять экранное увеличение выводимо-
го изображения, перемещая вверх или вниз по видовому экрану указатель мыши. 
Поместив его в середину изображения на экране и удерживая нажатой кнопку 
мыши, можно увеличить или уменьшить изображение на 100%.

Если отпустить кнопку мыши, зуммирование приостанавливается. Пользова-
тель может отпустить кнопку, переместить указатель в другую позицию на рисун-
ке, а затем снова нажать, чтобы продолжить зуммирование в новой позиции.

Для выхода из режима зуммирования можно использовать контекстное меню, 
выбрав в нем пункт Enter, или нажать на клавиатуре клавишу Esc.

Если применяется функция предварительного просмотра печатаемого черте-
жа, то пределы зуммирования ограничены разрешающей способностью использу-
емого плоттера. При увеличении изображения в окне предварительного просмо-
тра операция зуммирования прекращается в тот момент, когда точка на экране в 
точности соответствует точке (или шагу) используемого плоттера. 

При достижении предела увеличения изображения на текущем виде символ 
«плюс» (+) на указателе зуммирования исчезает, что свидетельствует о невозмож-
ности дальнейшего зуммирования в данном направлении. Аналогичным образом 
при уменьшении рисунка до предела (до границ текущего вида) на указателе зум-
мирования исчезает символ «минус» (–). Еще больше уменьшить рисунок после 
вывода границ текущего вида нельзя.

Zoom Previous – использование предыдущего вида рисунка. 

При работе с мелкими деталями часто возникает необходимость уменьшить 
изображение, чтобы просмотреть сделанные изменения в общем виде. Для быст-
рого возврата к предыдущему виду служит команда ZOOm с ключом Previous. 
Она восстанавливает только экранное увеличение и положение вида, но не содер-
жимое редактируемого рисунка.

Программа AutoCAD способна восстанавливать последовательно до 10 преды-
дущих видов. В это число входят виды, полученные не только при зуммировании, 
но и при панорамировании, восстановлении и установке вида в перспективе или 
в плане.

Zoom Window – определение области отображения с помощью рамки. 
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При использовании Zoom Window следует задать два противоположных угла 
прямоугольной рамки. При этом левый нижний угол обозначенной рамки стано-
вится левым нижним углом нового вида. Форма нового вида может несколько от-
личаться от формы рамки, так как при зуммировании вид вписывается в область 
рисунка. Команда ZOOm с ключом Window выдает следующие запросы:

Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _w
Specify first corner: – указать первый угол окна
Specify opposite corner: – указать противоположный угол окна

Zoom Dynamic – динамическое определение области отображения. 

Используется для изменения вида без регенерации рисунка. Команда ZOOm 
с ключом Dynamic отображает видимую часть рисунка в рамке, представляющую 
текущий вид. Путем перемещения этой рамки и изменения ее размеров выпол-
няются зуммирование и панорамирование рисунка. Видовое окно перемещается 
по рисунку при нажатой левой кнопке мыши; аналогичным способом изменяются 
и размеры окна. Видовое окно можно передвигать по изображению, когда окно 
содержит символ Х, и изменять его размеры в состоянии, когда имеется символ 
стрелки →. Переключение из одного состояния в другое осуществляется щелчком 
левой кнопки мыши. При нажатии клавиши Enter изображение, заключенное в ви-
довом окне, выводится на видовой экран. В зависимости от используемого видео-
монитора границы текущего вида обозначаются зеленой пунктирной линией, а 
границы рисунка – синей. Границы рисунка в данном случае либо соответствуют 
лимитам рисунка, либо ограничивают область, реально занимаемую изображени-
ем (если она выходит за пределы лимитов).

Zoom Scale – установка масштабного коэффициента увеличения. 

Масштабирование вида используется в том случае, если изображение требует-
ся уменьшить или увеличить на точно заданную величину. При этом необходимо 
указать коэффициент экранного увеличения одним из трех способов:

�� относительно лимитов рисунка;
�� относительно текущего вида;
�� относительно единиц пространства листа.

Команда ZOOm с ключом Scale выдает следующие запросы:

Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _s
Enter a scale factor (nX or nXP): – указать масштабный коэффициент

Чтобы экранное увеличение было задано относительно лимитов рисунка, до-
статочно лишь ввести значение коэффициента. Например, если это 1, то в гра-

Зуммирование
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фической области будет располагаться рисунок в своих лимитах. Центр рисунка 
совпадает с центром предыдущего вида. Для увеличения или уменьшения изобра-
жения следует указать соответственно большее или меньшее значение коэффици-
ента. Если ввести 2, изображение будет вдвое больше, чем при коэффициенте 1, а 
если ввести 0.5 – вдвое меньше.

Для масштабирования вида относительно текущего нужно после значения 
коэффициента добавить латинскую букву x. Так, для увеличения изображения 
текущего вида вдвое понадобится ввести 2x, а для уменьшения вдвое – 0.5x. Ввод 
1x не изменяет изображение.

Zoom Center – определение области изображения путем ввода точки 
центра и высоты окна в единицах рисунка. 

Команда ZOOm с ключом Center выдает следующие запросы:

Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _c
Specify center point: – указать центральную точку
Enter magnification or height: – указать увеличение или высоту

Для указания высоты можно использовать абсолютное значение – число. При 
этом изменение происходит относительно полного вида. Если требуется задать 
изменение масштаба относительно текущего вида, за числом следует ввести ла-
тинскую букву x. При работе с плавающими видовыми окнами для увеличения 
вида относительно пространства листа необходимо ввести после числа латинские 
буквы xp.

Zoom Object – отображение области, которая содержит выбранные объ
екты. 

Команда ZOOm с ключом Object производит вычисление коэффициента 
экранного увеличения с учетом границ, в которые вписан выбранный объект, и 
выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _o
Select objects: – выбрать объекты

Zoom In – увеличение изображения. 

Команда ZOOm с ключом 2x выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: 2x

Zoom Out – уменьшение изображения. 
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Команда ZOOm с ключом .5x выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: .5x

Zoom All – отображение всей области чертежа или области внутри гра-
ниц, если они заданы. 

Команда ZOOm с ключом All позволяет увидеть на экране рисунок целиком. 
Если некоторые его объекты расположены вне лимитов, он изображается в сво-
их собственных границах. При этом происходит регенерация рисунка. Если все 
объекты находятся в пределах лимитов, команда выводит чертеж в его лимитах. 
С помощью данного метода удобно контролировать размещение объектов относи-
тельно области рисования.

Zoom Extents – отображение области, которая содержит все примитивы 
чертежа. 

Команда ZOOm с ключом Extents производит вычисление коэффициента 
экранного увеличения с учетом границ текущего видового экрана, а не текущего 
вида. Чаще всего видовой экран отображается полностью; в таком случае резуль-
тат работы функции очевиден и понятен. Однако, когда команда ZOOm исполь-
зуется в пространстве модели при работе в видовом экране пространства листа 
для зуммирования за пределами границ этого видового экрана, некоторая часть 
зуммируемой области может остаться за пределами видимости.

Выполните упражнения Z1–Z3 из раздела 2.

Панорамирование

Pan Realtime – панорамирование в реальном времени.

Команда PAN обеспечивает возможность интерактивного панорамирования 
изображения. Для активизации функции панорамирования в реальном времени 
нужно выбрать команду из падающего меню View → Pan → Realtime или на панели 
навигации (см. рис. 6.4, 6.5).

Чтобы изменить положение изображения на видовом экране в режиме панора-
мирования в реальном времени, следует перемещать указатель мыши, удерживая 
ее левую кнопку нажатой. Панорамирование может выполняться в одном направ-
лении до тех пор, пока не потребуется полная регенерация изображения или не 
будут достигнуты лимиты рисунка. В этом случае к изображению указателя пано-
рамирования добавляется соответствующий направлению символ-ограничитель.

Панорамирование
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Рис. 6.5. Команда панорамирования в падающем меню

Для выхода из режима панорамирования или переключения между режимами 
панорамирования и зуммирования можно использовать контекстное меню; при 
этом необходимо нажать клавишу Enter или Esc.

Выполните упражнение Pa1 из раздела 2.

Панель.навигации
Панель навигации представляет собой элемент пользовательского 
интерфейса, который включает ряд инструментов, обеспечивающих 
работу с командами навигации (рис. 6.6). На Рабочем столе панель 
присутствует в фоновом режиме. При наведении курсора на один из 
инструментов она активизируется и готова к работе (системная пере-
менная NAVBARDISPLAY).

Панель навигации включает следующие инструменты: штурвалы, 
панорамирование, инструменты зуммирования и орбиты, аниматор 
движения.

Штурвалы
Штурвалы представляют собой набор инструментов, которые дают возможность 
переходить от одной команды навигации к другой. Каждый сегмент штурвала яв-
ляется отдельным инструментом навигации.

Рис. 6.6. 
Панель 

навигации
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Предлагается несколько стилей штурвалов, которые можно установить в кон-
текстном меню панели навигации. Для этого необходимо щелкнуть кнопкой на 
стрелке с пиктограммой штурвала (рис. 6.7):

�� Full Navigation Wheel – суперштурвал (рис. 6.8);
�� Mini Full Navigation Wheel – мини-суперштурвал (рис. 6.9);
�� Mini View Object Wheel – мини-штурвал для объектов (рис. 6.10);
�� Mini Tour Building Wheel – мини-штурвал для зданий (рис. 6.11);
�� Basic View Object Wheel – основной штурвал для объектов (рис. 6.12);
�� Basic Tour Building Wheel – основной штурвал для зданий (рис. 6.13);
�� 2D Wheel – упрощенный штурвал для зданий (рис. 6.14).

                                     

                                                                                        

                              

Рис. 6.7. Установка стиля штурвала Рис. 6.8. Суперштурвал

Рис. 6.9.  
Мини-суперштурвал

Рис. 6.10. Мини-штурвал 
для объектов

Рис. 6.11. Мини-штурвал 
для зданий

Рис. 6.13. Основной 
штурвал для зданий

Рис. 6.12. Основной 
штурвал для объектов

Рис. 6.14. Упрощенный 
штурвал для зданий

Штурвалы
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Набор инструментов варьируется в зависимости от стиля штурвала:

�� ZOOM – зуммирование из позиции по щелчку;
�� REWIND – перемотка истории перемещений;
�� PAN – панорамирование вида;
�� ORBIT – орбита вокруг точки вращения;
�� CENTER – определение центра зуммирования/орбиты;
�� WALK – обход объекта;
�� UP/DOWN – перемещение вверх/вниз;
�� LOOK – осмотр текущей позиции.

При щелчке и удерживании кнопки мыши на одном из сегментов штурвала 
активизируется указанный инструмент навигации.

Рис. 6.15. Контекстное меню штурвала

Контекстное меню штурвала включает в себя следующие инструменты 
(рис. 6.15):

�� Mini View Object Wheel – мини-штурвал для объектов;
�� Mini Tour Building Wheel – мини-штурвал для зданий;
�� Mini Full Navigation Wheel – мини-суперштурвал;
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�� Full Navigation Wheel – суперштурвал;
�� Basic Wheels – основные штурвалы:
•� View Object Wheel – большой штурвал для объектов;
•� Tour Building Wheel – большой штурвал для зданий;

�� Go Home – переход к исходному виду;
�� Fit to Window – изменение размера и центра текущего вида для отображе-

ния всех объектов, вписанных в окно;
�� Restore Original Center – восстановление центральной точки вида по грани-

цам модели;
�� Level Camera – выровнять камеру поворотом текущего вида относительно 

нулевой плоскости XY;
�� Increase Walk Speed – увеличение скорости обхода в два раза;
�� Decrease Walk Speed – уменьшение скорости обхода в два раза;
�� Help… – вызов справочной системы;
�� SteeringWheel Settings… – вызов одноименного диалогового окна настройки 

параметров штурвала (см. рис. 3.28);
�� Close Wheel – закрытие штурвала.

Аниматор.движения
С помощью аниматора движения можно вывести на экран средства создания и 
воспроизведения анимированных перемещений камеры для просмотра проекта, 
его презентации и навигации по закладкам. Панель аниматора движения располо-
жена в нижней части Рабочего стола (рис. 6.16).

Рис. 6.16. Панель аниматора движения

Аниматор движения устанавливается кнопкой ShowMotion  на панели навига-
ции (см. рис. 6.6) и включает следующие инструменты:

�� Unpin/Pin ShowMotion – прикрепить/открепить панель аниматора 
движения;

�� Play all – включить воспроизведение;

�� Stop – остановить воспроизведение;

�� Turn on Looping – включить повтор;

�� New Shot… – загрузка диалогового окна создания нового снимка New 
View/Shot Properties, вкладка Shot Properties (рис. 6.17);

�� Close ShowMotion – закрыть панель аниматора движения.

Аниматор движения
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Рис. 6.17. Диалоговое окно создания нового снимка

На вкладке Shot Properties диалогового окна New View/Shot Properties настраива-
ются следующие параметры.

�� В поле View name: указывается имя вида.
�� В списке View category: задается категория именованного вида.
�� В списке View type: определяется тип именованного вида:
•� Cinematic – кинематеческий;
•� Still – неподвижный;
•� Recorded Walk – записанный обход.

�� В области Transition определяется переход, используемый при воспроиз-
ведении вида:
•� Transition type: – тип перехода:

◊� Fade from black into this shot – плавное выведение от черного на снимке;
◊� Fade from white into this shot – плавное выведение от белого на снимке;
◊� Cut to shot – обрезать по снимку;
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•� Transition duration (seconds) – устанавливает длительность времени пере-
хода в секундах.

�� В области Motion определяется перемещение при воспроизведении вида:
•� Movement type: – тип перемещения:

◊� Zoom In – увеличить;
◊� Zoom out – уменьшить;
◊� Track left – движение слева;
◊� Track right – движение справа;
◊� Crane up – поднять;
◊� Crane down – опустить;
◊� Look – осмотр;
◊� Orbit – орбита;

•� Duration: (seconds) – устанавливается длительность времени проигрыва-
ния анимации в секундах;

•� Distance: – указывается расстояние, необходимое для завершения дви-
жения.

�� Кнопка Preview обеспечивает предварительный просмотр перехода и дви-
жения.

�� Loop – выполняет непрерывное воспроизведение перехода и движения.

Перерисовка.и.регенерация
Чтобы обновить изображение на экране монитора, его можно перерисовывать 
или регенерировать. При регенерации, кроме перерисовки изображения текуще-
го видового экрана, производится пересчет экранных координат (преобразование 
значений с плавающей точкой из базы данных в соответствующие целочисленные 
экранные координаты) всех объектов базы данных рисунка. Таким образом, пере-
рисовка происходит быстрее, чем регенерация.

Иногда в процессе работы возникает необходимость полной регенерации ри-
сунка с пересчетом экранных координат всех объектов. В этом случае AutoCAD 
выполняет регенерацию автоматически, выдавая соответствующее сообщение.

Команда REDRAwALL перерисовывает или «освежает» текущий видо-
вой экран. Она вызывается из падающего меню View → Redraw.

Для регенерации рисунка используется команда REGEN, вызываемая 
из падающего меню View → Regen или View → Regen All.

Изменение.порядка.рисования.объектов
По умолчанию объекты отображаются на экране в порядке их создания. Порядок 
отображения можно изменить, поместив один объект перед другим. Это сущес-
твенно, когда один объект перекрывает другой. Изменение порядка отображения 

Изменение порядка рисования объектов
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объектов производится с помощью команды DRAwORDER, которая вызывается 
из падающего меню Tools → Draw Order (рис. 6.18).

Рис. 6.18. Панель инструментов порядка следования объектов

Bring to Front – размещение объекта на переднем плане.

Send to Back – размещение объекта на заднем плане.

Bring Above Objects – размещение объекта впереди заданного объекта.

Send Under Objects – размещение объекта позади заданного объекта.

Bring Annotation to Font – размещение на переднем плане аннотированных объ-
ектов:

Text Objects Only – размещение только текста на переднем плане;

Dimension Objects Only – размещение только размера на переднем пла-
не;

Leaders Objects – размещение выносок на переднем плане;

All Annotation Objects – размещение на переднем плане всех аннотиро-
ванных объектов;

Send Hatches to Back – размещение штриховки на заднем плане.
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Объектная.привязка.координат
Объектная привязка – наиболее быстрый способ точно указать точку на объекте, 
не обязательно зная ее координаты, а также построить вспомогательные линии. 
Например, объектная привязка позволяет построить отрезок от центра окруж-
ности, от середины сегмента полилинии, от реального или видимого пересечения 
объектов.

Объектную привязку можно задать в любой момент, когда AutoCAD ожидает 
ввода координат точки. В этом случае указанный режим применяется только к 
следующему выбранному объекту. Кроме того, имеется возможность установки 
одного или нескольких режимов объектной привязки в качестве текущих. Таким 
образом, активизация объектной привязки мо-
жет осуществляться двумя способами:

�� разовые режимы объектной привязки, 
действующие при указании только те-
кущей (одной) точки;

�� текущие режимы объектной привязки, 
действующие постоянно до их отклю-
чения.

Режимы объектной привязки выбирают-
ся из контекстного меню, которое вызывается 
щелчком правой кнопкой мыши на любом мес-
те области рисования при нажатой клавише 
Shift (рис. 7.1).

Режимы объектной привязки можно также 
установить в контекстном меню, которое вы-
зывается в строке состояния щелчком правой 

кнопкой мыши на кнопке  Object Snap, либо 
щелчком на стрелочке этой кнопки (рис. 7.2).

В режиме объектной привязки точка поме-
чается маркером; его форма зависит от исполь-
зуемого режима, имя которого появляется воз-
ле точки в виде подсказки.

Отслеживание
Temporary track point – точка отсле
живания.

Отслеживание применяется для наглядного 
указания точек, связанных с другими точками 
рисунка. Оно может использоваться в любой 

Рис. 7.1. Панель инструментов 
и контекстное меню объектной 

привязки
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момент, когда AutoCAD запрашивает координаты точки. После включения режи-
ма Temporary track point и указания первой точки AutoCAD включает ортогональ-
ный режим ORTHO и ставит выбор следующей точки в зависимость от положения 
вершины вертикальной или горизонтальной траектории, проведенной из первой 
точки. Для смены направления траектории необходимо вернуть указатель мыши 
в первую точку, а затем перемещать его в нужном направлении (вертикальном или 
горизонтальном).

Рис. 7.2. Контекстное меню объектной привязки в строке состояния

Направление траектории определяет, какая из координат первой точки 
(x или y) сохраняется неизменной, а какая получает новое значение. Если резино-
вая линия траектории направлена по горизонтали, изменяется координата x; если 
же по вертикали, – изменяется координата y.

После выбора второй точки и нажатия клавиши Enter для завершения отсле-
живания AutoCAD фиксирует точку, находящуюся на пересечении воображаемых 
ортогональных линий, проходящих через две выбранные точки.

Отслеживание
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Использование режима Temporary track point – наиболее легкий способ обнару-
жения центральной точки прямоугольника. Чтобы включить режим отслежива-
ния, необходимо щелкнуть на пиктограмме Temporary track point на стандартной 
панели инструментов, а затем указать центры вертикальной и горизонтальной 
сторон прямоугольника.

Режим Temporary track point в комбинации с прямым вводом расстояния может 
использоваться для размещения объектов или текста на заданном расстоянии от 
другого объекта.

После включения режима отслеживания AutoCAD не отображает выбираемые 
точки до тех пор, пока этот режим не будет отключен нажатием клавиши Enter. По-
этому для отслеживания можно использовать любое количество точек.

Смещение
From – смещение.

Режим объектной привязки From отличается от остальных тем, что позволяет 
установить временную базовую точку для построения следующих точек. Обыч-
но режим смещения используется в сочетании с другими режимами объектной 
привязки и относительными координатами, поскольку довольно часто требуется 
определить точку, у которой известны координаты относительно некоторой точки 
уже нарисованного объекта.

Выполните упражнение L13 из раздела 2.

Середина.между.точками
Mid Between 2 Points – привязка к середине между двумя точками.

Привязка удобна для нахождения точки, расположенной посередине между 
двумя другими точками.

Конечная.точка
Endpoint – привязка к ближайшей из конечных точек объектов (отрез-
ков, дуг и т. п.).

В случае пространственного моделирования, если объект имеет ненулевую 
высоту, допускается привязка к его нижней и верхней границе. В режиме Endpoint 
привязка может производиться к границам трехмерных тел и областей, например 
к конечной точке (вершине) параллелепипеда.
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Пример..Привязка.к.конечным.точкам.примитивов
Постройте отрезки, нарисованные пунктирной линией, задавая их точки с объ-

ектной привязкой к конечным точкам объектов (рис. 7.3).

Рис. 7.3. Построение с привязкой к конечным точкам

Запустите команду формирования отрезка LiNE, вызвав ее из падающего меню 
Draw → Line или щелкнув на пиктограмме в группе Draw ленты Home. Ответьте на 
запросы:

_LINE
Specify first point: ENDPOINT – укажите точку 1
Specify next point or [Undo]: ENDPOINT – укажите точку 2
Specify next point or [Undo]: – для завершения команды нажмите клавишу Enter
_LINE
Specify first point: ENDPOINT – укажите точку 3
Specify next point or [Undo]: ENDPOINT – укажите точку 4
Specify next point or [Undo]: – для завершения команды нажмите клавишу Enter

Выполните упражнение L6 из раздела 2.

Средняя.точка
Midpoint – привязка к средним точкам объектов (отрезков, дуг и т. п.).

Привязка для бесконечных прямых и лучей производится к первой из опре-
деляющих их точек. Для сплайнов и эллипсов в режиме Midpoint осуществляется 
привязка к точке объекта, расположенной на равных расстояниях от начальной и 
конечной точек.

В случае пространственного моделирования, если отрезок или дуга имеет не-
нулевую высоту, можно осуществлять привязку к серединам верхней и нижней 
границ объекта. Режим Midpoint позволяет также производить привязку к грани-
цам трехмерных тел и областей.

Средняя точка
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Пример..Привязка.к.средним.точкам.примитивов
Постройте отрезок, изображенный пунктирной линией, задавая его точки с 

объектной привязкой к средним точкам объектов (рис. 7.4).

Рис. 7.4. Построение с привязкой к средним точкам

Запустите команду формирования отрезка LiNE, вызвав ее из падающего меню 
Draw → Line или щелкнув на пиктограмме Line в группе Draw ленты Home. Ответьте 
на запросы:

_LINE
Specify first point: MIDPOINT – укажите точку 1
Specify next point or [Undo]: MIDPOINT – укажите точку 2
Specify next point or [Undo]: – для завершения команды нажмите клавишу Enter

Выполните упражнение L7 из раздела 2.

Пересечение
Intersection – привязка к точкам пересечениий объектов (отрезков, 
окружностей, дуг, сплайнов и т. п.).

В случае пространственного моделирования в режиме Intersection допускается 
привязка к угловым точкам объектов, имеющих ненулевую высоту выдавливания. 
Если два таких объекта с пересекающимися основаниями имеют одинаковое на-
правление выдавливания, можно произвести привязку к пересечениям их верхней 
и нижней границ. Если высоты объектов различны, точка пересечения определя-
ется объектом с меньшей высотой.

Привязка к пересечениям дуг и окружностей, входящих в блоки (в них группы 
объектов рассматриваются как единый объект), производится только в том слу-
чае, если масштабы вставки блока по осям равны. К пересечениям отрезков внутри 
блока сказанное не относится.

Можно осуществлять привязку к пересечениям границ областей и кривых, за 
исключением криволинейных границ трехмерных тел.
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Режим Intersection позволяет выполнить привязку к точке воображаемого пере-
сечения двух любых объектов. Если в прицел попадает только один из объектов, 
AutoCAD предлагает указать второй и производит привязку к точке, в которой эти 
объекты пересекались бы при их естественном удлинении. Режим расширенного 
пересечения Extended Intersection включается автоматически при выборе режима 
объектной привязки Intersection.

Пример..Привязка.к.точкам.пересечения.
примитивов
Постройте отрезок, нарисованный пунктирной линией, задавая его точки с 

объектной привязкой к точкам пересечения объектов (рис. 7.5).

Рис. 7.5. Построение с привязкой  
к точкам пересечения

Запустите команду формирования отрезка LiNE, вызвав ее из падающего меню 
Draw → Line или щелкнув на пиктограмме Line в группе Draw ленты Home. Ответьте 
на запросы:

_LINE
Specify first point: INTERSECTION – укажите точку 1
Specify next point or [Undo]: INTERSECTION – укажите точку 2
Specify next point or [Undo]: – для завершения команды нажмите клавишу Enter

Выполните упражнение L9 из раздела 2.

Предполагаемое.пересечение
Apparent Intersect – привязка к точке видимого на экране предполагаемо
го пересечения.

Режим предполагаемого пересечения Apparent Intersect ищет точку пересечения 
двух объектов, которые не имеют явной точки пересечения в пространстве. Режим 
предполагаемого пересечения обеспечивает эффективную работу с границами об-

Предполагаемое пересечение
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ластей и кривыми, но не работает с границами и углами трехмерных тел. Если 
объекты находятся в одной плоскости, то описываемый режим повторяет возмож-
ности режима пересечения Intersection.

Режим Apparent Intersect включает в себя два отдельных режима: собственно 
Apparent Intersect и режим расширенного предполагаемого пересечения Extended 
Apparent Intersect. Привязка в этих режимах может применяться к пересечениям 
границ областей и кривых, кроме криволинейных границ трехмерных тел.

В режиме Apparent Intersect выполняется привязка к точке пересечения двух 
объектов, которые реально не пересекаются в трехмерном пространстве, но на те-
кущем виде выглядят пересекающимися. Если существует несколько точек кажу-
щихся пересечений, AutoCAD производит привязку к пересечению, расположен-
ному ближе ко второй точке выбора.

Режим расширенного предполагаемого пересечения Extended Apparent Intersect 
позволяет осуществить привязку к точке воображаемого пересечения двух любых 
объектов. Если в прицел попадает только один объект, AutoCAD предлагает ука-
зать второй и производит привязку к точке, в которой эти объекты пересекались 
бы при их естественном удлинении.

Режим Extended Apparent Intersect включается автоматически при выборе ре-
жима объектной привязки Apparent Intersect; при этом он активен тогда, когда в 
прицел попадает только один объект и другие режимы объектной привязки от-
ключены. Оба указанных режима могут использоваться как для разовой привязки 
точки, так и в качестве текущих режимов привязки.

Пример..Привязка.к.точкам.предполагаемого.
пересечения.примитивов
Постройте отрезок, нарисованный пунктирной линией, задавая его точ-

ки с объектной привязкой к точкам предполагаемого пересечения объектов 
(рис. 7.6).

Рис. 7.6. Построение с привязкой к точкам  
предполагаемого пересечения

Запустите команду формирования отрезка LiNE, вызвав ее из падающего меню 
Draw → Line или щелкнув на пиктограмме Line в группе Draw ленты Home. Ответьте 
на запросы:
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_LINE
Specify first point: APPINT OF AND – укажите точки 1 и 2
Specify next point or [Undo]: APPINT OF AND – укажите точки 3 и 4
Specify next point or [Undo]: – для завершения команды нажмите клавишу 
Enter

Выполните упражнение L10 из раздела 2.

Продолжение.объекта
Extension – привязка к продолжению объектов.

Она необходима в том случае, когда при построении объектов требуется ис-
пользовать линии, являющиеся временным продолжением существующих ли-
ний и дуг. Данный режим можно совмещать с режимом Apparent Intersect с целью 
осуществить привязку к точке воображаемого пересечения объектов, для чего 
нужно медленно перемещать указатель мыши рядом с конечной точкой отрезка 
или дуги. Появляющийся символ «плюс» (+) свидетельствует о захвате конеч-
ной точки отрезка или дуги. После этого следует провести указатель вдоль вре-
менной линии продолжения. Если включен режим привязки Apparent Intersect, 
можно найти точку пересечения воображаемого продолжения отрезка или дуги 
с другим объектом.

Точка.центра

Center – привязка к центру дуги, окружности или эллипса.

При использовании режима Center необходимо указывать c помощью мыши на 
линию дуги, окружности или эллипса, а не на их центр.

В этом режиме можно осуществлять привязку и к центрам окружностей, 
являю щихся частью тел и областей. При привязке к центру нужно выбирать ви-
димую часть дуги, окружности или эллипса.

Пример..Привязка.к.центру.окружности,..
дуги.или.эллипса
Постройте линию, нарисованную пунктиром, задавая ее точки с объектной 

привязкой к центру объектов (рис. 7.7).

Точка центра
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Рис. 7.7. Построение с привязкой к центру

Запустите команду формирования отрезка LiNE, вызвав ее из падающего меню 
Draw → Line или щелкнув на пиктограмме Line в группе Draw ленты Home. Ответьте 
на запросы:

_LINE
Specify first point: CENTER – укажите точку 1
Specify next point or [Undo]: CENTER – укажите точку 2
Specify next point or [Undo]: CENTER – укажите точку 3
Specify next point or [Close/Undo]: CLOSE – замкните линию

Выполните упражнение L8 из раздела 2.

Геометрический.центр
Geometric Center – привязка к ближайшему геометрическому центу лю-
бой замкнутой полиилинии или сплайна.

Квадрант
Quadrant – привязка к ближайшему квадранту (точке, расположен-
ной под углом 0, 90, 180 или 270°�от центра) дуги, окружности или 
эллипса.

Расположение точек квадрантов окружностей и дуг определяется текущей 
ориентацией ПСК. Если дуга, окружность или эллипс входят в блок, вставленный 
с ненулевым углом поворота, точки квадрантов ориентируются в соответствии с 
этим углом.

Касательная
Tangent – привязка к точке на дуге, окружности, эллипсе или плоском 
сплайне, принадлежащей касательной к другому объекту.
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С помощью режима объектной привязки Tangent можно, например, построить 
по трем точкам окружность, касающуюся трех других окружностей.

При выборе точки на дуге, полилинии или окружности в качестве первой точки 
привязки в режиме Tangent автоматически активизируется режим задержанной ка-
сательной Deferred Tangent, который может быть использован для построения окруж-
ностей по двум и трем точкам, при формировании окружности, касательной к трем 
другим объектам. Режим Deferred Tangent неприменим к эллипсам и сплайнам. Если 
необходимо построить отрезок, касательный к эллипсу или сплайну, функция при-
вязки будет выдавать ряд точек на эллипсе или сплайне, через которые может быть 
проведен касательный отрезок, но положения этих точек непредсказуемы.

Режим привязки Tangent работает с дугами и окружностями, входящими в бло-
ки, только если масштабные коэффициенты вставки блока по осям равны, а на-
правления выдавливания объектов параллельны текущей ПСК. Для сплайнов и 
эллипсов вторая указанная точка должна лежать в той же плоскости, что и точка 
привязки.

При совместном использовании режимов привязки From и Tangent для построе-
ния объектов, отличных от касательных отрезков к дугам и окружностям, первая 
точка объекта лежит на касательной к дуге или окружности, проведенной через 
последнюю указанную в пространстве рисунка точку.

Пример..Построение.касательной
Постройте отрезки, нарисованные пунктирной линией, выходящие из точки 1 

и касательные к окружности (рис. 7.8).

Рис. 7.8. Построение касательной

Запустите команду формирования отрезка LiNE, вызвав ее из падающего меню 
Draw → Line или щелкнув на пиктограмме Line в группе Draw ленты Home. Ответьте 
на запросы:

_LINE
Specify first point: – укажите точку 1
Specify next point or [Undo]: TANGENT – укажите точку 2
Specify next point or [Undo]: – для завершения команды нажмите клавишу Enter
_LINE
Specify first point: – укажите точку 1

Касательная
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Specify next point or [Undo]: TANGENT – укажите точку 3
Specify next point or [Undo]: – для завершения команды нажмите клавишу 
Enter

Выполните упражнение L14 из раздела 2.

Нормаль
Perpendicular – привязка к точке объекта, лежащей на нормали к друго-
му объекту или к его воображаемому продолжению.

Режим Perpendicular может использоваться для таких объектов, как отрезки, 
окружности, эллипсы, сплайны и дуги.

Если режим привязки Perpendicular применяется для указания первой точки 
отрезка или окружности, происходит построение отрезка или окружности, пер-
пендикулярных выбранному объекту. Если должна быть указана вторая точка от-
резка или окружности, AutoCAD производит привязку к точке объекта, которая 
принадлежит нормали, проведенной к первой указанной точке.

Когда описываемый режим используется для сплайнов, функция выполняет 
привязку к точке на сплайне, через которую проходит вектор нормали, проведен-
ный из указанной точки. Вектором нормали в любой точке сплайна является век-
тор, перпендикулярный касательной в данной точке. Если указанная пользовате-
лем точка лежит на сплайне, то в режиме Perpendicular она будет считаться одной 
из возможных точек привязки. В некоторых случаях при работе со сплайнами по-
ложение точек привязки оказывается неочевидным. Кроме того, для некоторых 
сплайнов в данном режиме объектной привязки таких точек может вообще не су-
ществовать.

Пример..Построение.нормали
Постройте отрезки, нарисованные пунктирной линией, выходящие из точки 1 

и перпендикулярные объектам (рис. 7.9).

Рис. 7.9. Построение нормали
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Запустите команду формирования отрезка LiNE, вызвав ее из падающего меню 
Draw → Line или щелкнув на пиктограмме Line в группе Draw ленты Home. Ответьте 
на запросы:

_LINE
Specify first point: – укажите точку 1
Specify next point or [Undo]: PERPENDICULAR – укажите точку 2
Specify next point or [Undo]: – для завершения команды нажмите клавишу Enter
_LINE
Specify first point: – укажите точку 1
Specify next point or [Undo]: PERPENDICULAR – укажите точку 3
Specify next point or [Undo]: – для завершения команды нажмите клавишу Enter

Выполните упражнение L15 из раздела 2.

Параллель
Parallel – привязка объектов к параллелям.

Эта привязка удобна при необходимости построения прямолинейных объек-
тов, параллельных имеющимся прямолинейным сегментам. В области прицела 
должен находиться только один отрезок. Появление символа параллельной при-
вязки свидетельствует о выборе отрезка. Теперь следует медленно перемещать 
указатель мыши из начальной точки в направлении, приблизительно параллель-
ном выбранному объекту. При этом появляется линия отслеживания, отображае-
мая пунктиром. Ее положение и ориентация определяются заданной начальной 
точкой и выбранным объектом. Чтобы в качестве конечной точки создаваемого 
параллельного отрезка использовать точку пересечения линии отслеживания 
с имею щимися объектами, можно включить режимы привязки пересечения 
Intersection и кажущегося пересечения Apparent Intersect.

Точечный.элемент
Node – привязка к геометрическому объекту «точка», сформированно-
му командой POiNt.

Точки, входящие в определение блока, после его вставки могут служить узлами 
привязки.

Выполните упражнение L12 из раздела 2.

Точечный элемент
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Точка.вставки
Insert – привязка к точке вставки блока, формы, текста, атрибута (со-
держащего информацию о блоке) или определения атрибута (задаю-
щего характеристики атрибута).

При выборе атрибута, входящего в блок, AutoCAD производит привязку к точ-
ке вставки атрибута, а не блока. Таким образом, если блок не содержит ничего, 
кроме атрибутов, привязка к точке вставки самого блока возможна только в слу-
чае, если эта точка совпадает с точкой вставки одного из атрибутов.

Ближайшая.точка
Nearest – привязка к точке на объекте, которая является ближайшей к 
позиции перекрестья.

Выполните упражнение L11 из раздела 2.

Отмена.объектной.привязки
None – режим отмены всех текущих и разовых режимов объектной 
привязки.

Выбор.режимов.привязки
Osnap Settings… – установка режима текущей объектной привязки на 
вкладке объектных привязок Object Snap диалогового окна режимов 
рисования Drafting Settings (рис. 7.10). Это окно загружается из падаю-
щего меню Tools → Drafting Settings... или при выборе пункта Object Snap 
Settings... из контекстного меню, которое вызывается при щелчке на 
стрелке кнопки  Object Snap в строке состояния.

Если требуется несколько раз подряд произвести привязку определенного типа 
(например, к конечным точкам или центрам), можно задать один или несколько 
текущих режимов объектной привязки. Следует иметь в виду, что режимы объ-
ектной привязки From и Mid Between 2 Points не могут быть установлены текущими.

Специальные средства повышения наглядности, называемые автопривязкой 
AutoSnap, облегчают выбор точек привязки и повышают эффективность использо-
вания объектной привязки. Средства автопривязки включают в себя следующие 
элементы:
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�� маркеры обозначают тип объектной привязки в точке привязки с по-
мощью соответствующего символа;

�� всплывающие подсказки автопривязки поясняют тип объектной привяз-
ки в точке привязки ниже позиции указателя мыши;

�� магнит автоматически перемещает в точку привязки указатель мыши, 
если он находится около возможной точки привязки;

�� прицел окружает перекрестье указателя мыши и ограничивает область 
рисунка, в пределах которой при перемещении указателя определяются 
возможные точки привязки. Показ прицела можно включать и отключать, 
а его размер – изменять.

Рис. 7.10. Диалоговое окно установки режима текущей объектной привязки

Для включения или отключения сразу всех текущих режимов объектной при-
вязки без вызова диалогового окна Drafting Settings необходимо щелкнуть на кнопке 
Object Snap в строке состояния (или нажать клавиши Ctrl+F или F3). Если текущие 
режимы объектной привязки не заданы, автоматически вызывается диалоговое 
окно Drafting Settings.

По умолчанию включены следующие элементы автопривязки: маркеры, всплы-
вающие подсказки и магнит. Параметры автопривязки всегда можно изменить в 

Выбор режимов привязки
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области AutoSnap Settings на вкладке Drafting диалогового окна Options, которое вы-
зывается щелчком на кнопке Options... в диалоговом окне Drafting Settings либо из 
падающего меню Tools → Options... (см. рис. 3.18).

Если задано несколько режимов объектной привязки, AutoCAD использует 
режим, наиболее подходящий для выбранного объекта. Если в прицел выбора 
попадают две точки, удовлетворяющие заданному режиму, система производит 
привязку к той из них, которая лежит ближе к центру прицела. При необходимо-
сти можно переключаться между точками, нажимая клавишу Tab. Например, если 
активизированы режимы привязки Quadrant и Center, а в прицел попадает часть 
окружности, то нажатие Tab позволит поочередно перебрать все возможные точки 
привязки: четыре квадранта и центр окружности.

Также режимы объектной привязки можно установить в контекстном меню, 
которое вызывается щелчком правой кнопкой мыши на кнопке  Object Snap в 
строке состояния (см. рис. 7.2).

Выполните упражнение L16 из раздела 2.

Автоотслеживание
Средства автоотслеживания Autotrack облегчают построение объектов в опре-
деленных направлениях или в определенной зависимости относительно других 
объектов рисунка. При включенных режимах автоотслеживания специальные 
временные линии отслеживания помогают выполнять точные построения. По 
умолчанию эти линии являются бесконечными и продолжаются до границ обла-
сти рисования. Однако можно установить такой режим, при котором длина линий 
отслеживания ограничивается текущим положением курсора.

Имеются два режима автоотслеживания: полярное отслеживание и отслежи-
вание при объектной привязке. Режимы автоотслеживания можно быстро вклю-
чать и отключать нажатием кнопок  Polar Tracking и  Object Snap Tracking 
в строке состояния.

Для изменения параметров автоотслеживания используется вкладка Drafting 
диалогового окна Options, которое загружается из падающего меню Tools → Options... 
(см. рис. 3.18).

В области параметров автоотслеживания AutoTrack Settings устанавливаются 
следующие флажки:

�� Display polar tracking vector – отображение линий полярного отслеживания 
в виде бесконечных лучей. Если флажок снят, линия полярного отслежи-
вания проводится от предыдущей указанной точки до курсора;

�� Display full-screen tracking vector – отображение линий объектного отслежи-
вания в виде бесконечных прямых. Если флажок снят, линия объектного 
отслеживания проводится от точки привязки до курсора;
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�� Display AutoTrack tooltip – отображение всплывающих подсказок к режимам 
автоотслеживания, выводимых ниже позиции курсора. Всплывающие 
подсказки дают информацию о типе объектной привязки (при объектном 
отслеживании), текущем угле отслеживания и расстоянии до предыдущей 
точки.

Способ захвата характерных точек объектов для отслеживания устанавливает-
ся в области Alignment Point Acquisition:

�� Automatic – захват точек отслеживания осуществляется автоматически. 
Если выбран данный способ, для предотвращения захвата характерной 
точки объекта можно удерживать нажатой клавишу Shift;

�� Shift to acquire – захват точек происходит только при нажатии клавиши Shift 
в момент, когда курсор находится над точкой объектной привязки.

Системные переменные TRACKPATH и POLARMODE управляют соответственно 
отображением линий отслеживания и способом захвата точек отслеживания.

Объектное.отслеживание
Объектное отслеживание расширяет и дополняет возможности объектной при-
вязки. Для его использования необходимо, чтобы были включены режимы объ-
ектной привязки. При этом размер прицела определяет зону, в пределах которой 
происходит активизация линий отслеживания.

При объектном отслеживании по умолчанию захват подходящих точек осу-
ществляется автоматически. Однако можно установить такой режим, при котором 
захват точек будет происходить только после нажатия клавиши Shift.

Автопривязка позволяет более простыми способами строить объекты, имею-
щие определенную геометрическую зависимость от других объектов. Удобно ис-
пользовать следующие рекомендации:

�� для выбора точек, лежащих на перпендикулярах к концам или серединам 
объектов, объектное отслеживание следует применять совместно с режи-
мами привязки Perpendicular, Endpoint и Midpoint;

�� для выбора точек, лежащих на касательной к конечной точке дуги, объект-
ное отслеживание следует использовать совместно с режимами привязки 
Tangent и Endpoint;

�� отслеживание можно осуществлять от так называемых временных точек 
отслеживания. Для указания такой точки в ответ на запрос команды вы-
брать точку, ввести сочетание _TT и задать нужную точку. Она помечается 
маленьким маркером в виде знака «плюс» (+). Далее по мере перемещения 
указателя мыши поочередно появляются линии отслеживания, проходя-
щие через временную точку отслеживания. Для удаления временной точ-
ки при перемещении достаточно задержать указатель мыши на ее маркере 
(знаке «плюс»);

Объектное отслеживание
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�� можно выбрать точку, находящуюся на заданном расстоянии от точки объ-
ектной привязки вдоль линии отслеживания. Для этого после появления 
линии отслеживания следует ввести в командной строке требуемое рас-
стояние;

�� изменение способа захвата точек осуществляется на вкладке Drafting диа-
логового окна Options с помощью положения переключателя Alignment Point 
Acquisition – Automatic или Shift to acquire. По умолчанию устанавливается 
автоматический способ. Для предотвращения автоматического выбора 
точек в областях рисунка с высокой плотностью объектов можно удержи-
вать нажатой клавишу Shift.

Полярное.отслеживание
Полярное отслеживание облегчает выбор точек, лежащих на воображаемых ли-
ниях, которые можно провести через последнюю указанную в команде точку под 
одним из заданных полярных углов. Если, например, шаг углов полярного от-
слеживания равен 45°, линии отслеживания и всплывающие подсказки могут по-
являться под углами, кратными 45° относительно текущего направления отсчета 
углов. Текущая линия полярного отслеживания исчезает, так же как и всплываю-
щая подсказка, если она оказывается вне прицела курсора.

Полярное отслеживание может осуществляться под углами, кратными следую-
щим стандартным значениям: 90, 45, 30, 22,5, 18, 15, 10 или 5°. Кроме того, пользо-
ватель может определить другие значения углов.

Для включения полярного отслеживания необходимо нажать функциональ-
ную клавишу F10 или кнопку  Polar Tracking в строке состояния.

Линия полярного отслеживания и всплывающая подсказка появляются, если 
прямая, мысленно проведенная через предыдущую указанную точку и курсор, 
проходит под углом, близким к одному из полярных углов отслеживания. По 
умолчанию шаг полярных углов равен 90°. Линию полярного отслеживания и ин-
формацию, содержащуюся во всплывающей подсказке, можно использовать при 
построении объектов. Для нахождения точки пересечения линии полярного от-
слеживания с другими объектами удобно задействовать режимы объектной при-
вязки Intersection и Apparent Intersect.

Ортогональный режим ORTHO разрешает указание только тех точек, которые 
лежат на прямой, параллельной оси X или Y текущей ПСК и проходящей через 
последнюю указанную в текущей команде точку. При включении режима ортого-
нального рисования режим полярного отслеживания автоматически отключается, 
поскольку они не могут быть активными одновременно. Аналогичным образом 
при включении полярного отслеживания отключается режим ORTHO.

Изменение параметров полярного отслеживания осуществляется на вкладке 
Polar Tracking диалогового окна Drafting Settings (рис. 7.11). Это окно загружается 
из падающего меню Tools → Drafting Settings... или из контекстного меню, которое 
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вызывается при щелчке правой кнопкой мыши на кнопке  Polar Tracking в 

строке состояния и последующем выборе пункта Tracking Settings....

Рис. 7.11. Диалоговое окно изменения параметров полярного отслеживания

В этом окне можно настроить следующие параметры.

�� Polar Tracking On (F10) – включение полярного отслеживания (системная 
переменная AUTOSNAP).

�� В области Polar Angle Settings устанавливаются углы выравнивания линий 
полярного отслеживания (системная переменная POLARANG):
•� Increment angle: – шаг (приращение) углов, используемых для генерации 

линий полярного отслеживания;
•� Additional angles – значения углов полярного отслеживания, не подчиняю-

щиеся правилу шага (системные переменные POLARMODE, POLARADDANG).
�� В области Object Snap Tracking Settings задаются параметры объектного от-

слеживания:
•� Track orthogonally only – линии отслеживания рисуются только в ортого-

нальных направлениях, то есть горизонтально и вертикально (систем-
ная переменная POLARMODE);

Полярное отслеживание
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•� Track using all polar angle settings – применение параметров полярного от-
слеживания к объектному, при этом перемещение курсора происходит 
от точки объектной привязки под углами выравнивания (системная 
переменная POLARMODE).

�� В области Polar Angle measurement определяются параметры отсчета поляр-
ных углов:
•� Absolute – от нулевого направления текущей ПСК;
•� Relative to last segment – от направления, определяемого последним по-

строенным сегментом.
�� Кнопка Options... загружает вкладку управления точностью построе-

ния объектов Drafting диалогового окна настройки рабочей среды Options 
(см. рис. 3.20).

Выполните упражнение L5 из раздела 2.
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Рисунки в AutoCAD строятся из набора геометрических примитивов. Под геомет-
рическим примитивом понимается элемент чертежа, обрабатываемый системой 
как целое, а не как совокупность точек или объектов. Геометрические примитивы 
создаются командами, которые вызываются из падающего меню Draw или в группе 
Draw ленты Home рабочего пространства Drafting & Annotation (рис. 8.1).

Рис. 8.1. Инструменты формирования геометрических примитивов

Необходимо отметить, что одни и те же элементы чертежа могут быть получе-
ны по-разному, с помощью различных команд вычерчивания.

Точка
Команда POiNt, формирующая точку, вызывается из падающего 
меню Draw → Point или щелчком на пиктограмме Multiple Point в группе 
Draw ленты Home.
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Точка определяется указанием ее координат. Запросы команды POiNt:

Current point modes: PDMODE=33 PDSIZE=10.0000 – текущие режимы точек
Specify a point: – указать точку

В падающем меню предлагаются два режима построения точек:

�� Single Point – одиночная точка;
�� Multiple Point – несколько точек.

Пиктограмма Point в группе Draw ленты Home использует режим построения 
нескольких точек.

Точки могут пригодиться, например, в качестве узлов или ссылок для объект-
ной привязки и отсчета расстояний. Форма символа точки и его размер устанавли-
ваются либо относительно размера экрана, либо в абсолютных единицах.

Задать форму точки можно с помощью системной переменной PDMODE, а ее раз-
мер – с помощью переменной PDSIZE. Если PDSIZE положительна, она указывает 
абсолютный размер маркера точки, а если отри-
цательна, то размер указывается в процентах от 
размера экрана монитора. В последнем случае 
величина символа точки инвариантна по отноше-
нию к текущему масштабу изображения.

Значения системных переменных 
PDMODE и PDSIZE следует устанавли-
вать в диалоговом окне Point Style 

(рис. 8.2). Оно вызывается из падающего 
меню Format → Point Style....

Размер маркера точки задается в поле Point 
Size:. При этом если выбран вариант Set Size 
Relative to Screen – размер маркера определяется 
в процентах от размера экрана монитора, а если 
выбран вариант Set Size in Absolute Units – указы-
вается абсолютный размер маркера.

Отрезок
Базовым примитивом в AutoCAD является линия. Линии бывают различного 
рода – одиночные отрезки, ломаные (с сопряжениями дугами или без них – по-
лилинии), пучки параллельных линий (мультилинии), а также эскизные.

Команда LiNE, формирующая отрезок, вызывается из падающего 
меню Draw → Line или щелчком на пиктограмме Line в группе Draw 
ленты Home.

Отрезки могут быть одиночными или объединенными в ломаную линию. Не-
смотря на то что сегменты соприкасаются в конечных точках, каждый из них пред-

Рис. 8.2. Диалоговое окно 
установки параметров точки

Отрезок
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ставляет собой отдельный объект. Отрезки используются, если требуется работа 
с каждым сегментом в отдельности; если же необходимо, чтобы набор линейных 
сегментов представлял единый объект, лучше применять полилинии. Последова-
тельность отрезков может быть замкнутой – в этом случае конец последнего сег-
мента совпадает с началом первого.

Запросы команды LiNE:

Specify first point: – указать начало отрезка
Specify next point or [Undo]: – указать конец отрезка
Specify next point or [Undo]:
Specify next point or [Close/Undo]:
Specify next point or [Close/Undo]:

Запросы команды LiNE организованы циклически. Это означает, что при по-
строении непрерывной ломаной линии конец предыдущего отрезка служит нача-
лом следующего. При перемещении к каждой следующей точке за перекрестьем 
тянется «резиновая нить». Это позволяет отслеживать положение строящегося 
отрезка ломаной линии. При этом каждый отрезок ломаной линии представляет 
собой отдельный примитив.

Цикл заканчивается после нажатия клавиши Enter в ответ на очередной запрос 
Specify next point or [Close/Undo]:. К аналогичному результату приведет 
щелчок правой кнопкой мыши с последующим выбором пункта Enter из появив-
шегося контекстного меню.

Ключи команды LiNE:

�	Close – замкнуть ломаную;
�	Undo – отменить последний нарисованный отрезок.

Работа команды LiNE проиллюстрирована примерами в главах 4 и 7.

Выполните упражнения L1–L16 и тест 1 из раздела 2.

Прямая.и.луч
В AutoCAD допускается построение линий, не имеющих конца в одном или в обо-
их направлениях. Такие линии называются соответственно лучами и прямыми. 
Их можно использовать в качестве вспомогательных при построении других объ-
ектов.

Наличие бесконечных линий не изменяет границ рисунка. Следовательно, 
бесконечные линии не влияют на процесс зуммирования и на видовые экраны. 
Прямые и лучи разрешается перемещать, поворачивать и копировать таким же 
образом, как и любые другие объекты. Бесконечные линии рекомендуется строить 
на отдельном слое, который перед выводом на плоттер можно заморозить или от-
ключить.
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Команда XLiNE, формирующая прямую, вызывается из падающего 
меню Draw → Construction Line или щелчком на пиктограмме Construction 
Line в группе Draw ленты Home.

Прямые могут располагаться в любом месте трехмерного пространства. 
Сущест вуют различные способы установки ориентации прямой. По умолчанию 
прямая строится путем указания двух точек, задающих ее ориентацию. Первая 
точка называется корневой – это условная середина прямой.

Запросы команды XLiNE:

Specify a point or [Hor/Ver/Ang/Bisect/Offset]: – указать точку
Specify through point: – указать точку, через которую проходит прямая
Specify through point:

Ключи команды XLiNE:

�� Hor – построение горизонтальной прямой, проходящей через заданную 
точку;

�� Ver – построение вертикальной прямой, проходящей через заданную точку;
�� Ang – построение прямой по точке и углу. Есть два способа задать угол 

для построения прямых. Можно либо выбрать опорную линию и указать 
угол между нею и прямой, либо (для построения прямой, лежащей под 
определенным углом к горизонтальной оси) указать угол и точку, через 
которую должна проходить прямая. Построенные прямые всегда парал-
лельны текущей ПСК;

�� Bisect – по точке и половине угла, заданного тремя точками. При этом 
создается прямая, делящая какой-либо угол пополам. Нужно указать вер-
шину угла и определяющие его линии;

�� Offset – по смещению от базовой линии. При этом создается прямая, па-
раллельная какой-либо базовой линии. Следует задать величину смеще-
ния, выбрать базовую линию, а затем указать, с какой стороны от базовой 
линии должна проходить прямая.

Команда RAY, формирующая луч, вызывается из падающего меню 
Draw → Ray.

Луч представляет собой линию в трехмерном пространстве, начинающуюся в 
заданной точке и уходящую в бесконечность. В отличие от прямых, бесконечных 
с обеих сторон, луч не имеет конца только в одном направлении. Использование 
лучей вместо прямых помогает избежать загромождения рисунка. Как и прямые, 
лучи игнорируются командами, с помощью которых рисунок в его границах вы-
водится на экран.

Запросы команды RAY:

Specify start point: – указать первую точку
Specify through point: – указать точку, через которую проходит луч.

Прямая и луч
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Мультилиния
Команда mLiNE, формирующая мультилинию, вызывается из падаю-
щего меню Draw → Multiline.

Мультилиния состоит из пучка параллельных линий, 
называемых ее элементами (рис. 8.3). Можно создавать 
и сохранять стили мультилиний или же пользоваться 
стилем по умолчанию (мультилиния из двух элементов). 
Для каждого элемента задаются цвет и тип линии; соот-
ветствующие вершины элементов соединяются отрезка-
ми. Мультилинии могут иметь торцевые ограничители 
различного вида, например отрезки или дуги.

Запросы команды mLiNE:

Current settings: Justification = Top, Scale = 20.00, Style = STANDARD – 
текущие настройки

Specify start point or [Justification/Scale/STyle]: – указать началь-
ную точку

Specify next point: – указать следующую точку
Specify next point or [Undo]: – указать следующую точку
Specify next point or [Close/Undo]: – указать следующую точку
Specify next point or [Close/Undo]:

Ключи команды MLINE:

�� Justification – определение положения точки начала черчения: верх Top, 
центр Zero, низ Bottom. Линия проходит соответственно с максимальным 
положительным, с нулевым или максимальным отрицательным смещени-
ем от заданной точки;

�� Scale – коэффициент масштабирования. Смещение между линиями 
равняется заданному коэффициенту, умноженному на величину Offset, 
определенную в стиле;

�� Style – выбор стиля.

При построении мультилинии используется стиль мультилинии. Он 
создается в диалоговом окне Multiline Style, которое вызывается из па-
дающего меню Format → Multiline Style… (рис. 8.4).

Щелчком на кнопке Load... можно загрузить существующий стиль, нажатием 
кнопки Save... – сохранить вновь созданный стиль на диске. По умолчанию ис-
пользуется стиль STANDARD.

Для создания нового стиля необходимо щелкнуть на кнопке New…, в открыв-
шемся диалоговом окне Create New Multiline Style в поле New Style Name: указать имя 
создаваемого стиля, затем щелкнуть на кнопке Continue. При этом открывается 
диалоговое окно New Multiline Style (рис. 8.5).

Рис. 8.3. Примеры 
мультилиний
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Рис. 8.4. Диалоговое окно создания стилей мультилинии

Рис. 8.5. Диалоговое окно определения свойств мультилинии

Мультилиния
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В этом окне определяются свойства мультилинии.

�� В поле Description: размещается описание создаваемого стиля мультили-
нии.

�� В области формирования торцов Caps определяется вид концевых элемен-
тов:
•� Line: – линия;
•� Outer arc: – внешняя дуга;
•� Inner arcs: –внутренние дуги;
•� Angle: – величина угла наклона концевого элемента к мультилинии.

�� В области Fill обеспечивается заполнение мультилинии цветом и опреде-
ляется цвет фона.

�� В области Display joints: назначается показ стыков.

�� В области Elements настраиваются параметры элементов мультилинии:
•� в полях Offset, Color и Linetype показаны смещение, цвет и тип линии со-

ответственно;
•� кнопками Add и Delete можно добавить и удалить вышерасположенные 

значения Offset, Color и Linetype;
•� в поле Offset: определяется смещение линий мультилинии друг относи-

тельно друга;
•� в списке Color: устанавливается цвет каждой линии из предлагаемого 

списка или загружается диалоговое окно Select Color;
•� кнопка Linetype... выводит на экран диалоговое окно Select Linetype, пред-

назначенное для определения типа линии.

По умолчанию используется файл стиля с именем acad.mln. Имя текущего 
стиля мультилинии содержит системная переменная CMLSTYLE.

Полилиния
Команда PLiNE, формирующая полилинию, вызывается из падающе-
го меню Draw → Polyline или щелчком на пиктограмме Polyline в группе 
Draw ленты Home.

Полилиния представляет собой связанную последовательность линейных и 
дуговых сегментов и обрабатывается системой как графический примитив. По-
лилинии используют, если требуется работа с набором сегментов как целым, хотя 
допускается их редактирование по отдельности. Можно задавать ширину или 
полуширину отдельных сегментов, сужать полилинию или замыкать ее. При по-
строении дуговых сегментов первой точкой дуги является конечная точка преды-
дущего сегмента. Дуги описываются путем указания угла, центра, направления 
или радиуса. Кроме того, дугу можно построить, указав вторую и конечную точки.

Запросы команды PLiNE:
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Specify start point: – указать начальную точку
Current line-width is 0.0000 – текущая ширина полилинии
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: – указать 

следующую точку
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: – 

указать следующую точку

Запросы команды PLiNE организованы циклически. Цикл заканчивается пос-
ле нажатия клавиши Enter в ответ на очередной запрос команды. К аналогичному 
результату приводит щелчок правой кнопкой мыши с последующим выбором пун-
кта Enter в появившемся контекстном меню.

Ключи команды PLiNE:

�� Arc – обеспечивает переход в режим дуг;
�� Close – замыкает полилинию отрезком. Замыкающий отрезок существен-

но отличается от обычного, проведенного от конечной точки к начальной. 
Они по-разному обрабатываются при редактировании и сглаживании по-
лилиний, а также при подрезке углов стыков широких сегментов. Практи-
чески всегда предпочтительно использовать замыкающие отрезки;

�� Halfwidth – позволяет задать полуширину, то есть расстояние от осевой 
линии широкого сегмента до края;

�� Length – задает длину сегмента, созданного как продолжение предыдуще-
го в том же направлении;

�� Undo – отменяет последний созданный сегмент;
�� Width – позволяет задать ширину последующего сегмента. AutoCAD за-

прашивает начальную и конечную ширину. Введенное значение началь-
ной ширины автоматически предлагается установить значением конечной 
ширины по умолчанию. Начальная и конечная точки широких линейных 
сегментов лежат на оси полилинии. Обычно угловые стыки смежных ши-
роких сегментов полилинии подрезаются; исключение составляют случаи, 
когда линейные сегменты не являются касательными к смежным дуговым 
сегментам, а также когда углы схождения очень острые или используются 
штрихпунктирные линии.

При переходе команды PLiNE в режим дуг запрос меняется следующим образом:

Current line-width is 0.0000 – текущая ширина полилинии
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: ARC – пере-

ход в режим построения дуг
Specify endpoint of arc or [Angle/CEnter/CLose/Direction/Halfwidth/

Line/Radius/Second pt/Undo/Width]: – указать конечную точку дуги

Ключи команды PLiNE в режиме построения дуг:

�� Angle – ввести центральный угол. По умолчанию дуга отрисовывается 
против часовой стрелки. Если требуется отрисовка дуги по часовой стрел-
ке, необходимо задать отрицательное значение угла;

Полилиния
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�� Center – указать центр дуги;
�� Close – замкнуть дугой;
�� Direction – задать направление касательной;
�� Halfwidth – определить полуширину полилинии;
�� Line – перейти в режим построения отрезков;
�� Radius – ввести радиус дуги;
�� Second pt – указать вторую точку дуги по трем точкам. Если дуга не яв-

ляется первым сегментом полилинии, то она начинается в конечной точке 
предыдущего сегмента и по умолчанию проводится по касательной к нему;

�� Undo – отменить последнюю точку;
�� Width – определить ширину полилинии.

Дуговые сегменты полилинии задаются любым из способов, характерных для 
команды формирования дуги ARC (см. соответствующий раздел данной главы). 
Кроме того, такие сегменты можно построить, задав радиус, центральный угол и 
направление хорды. Это единственный случай, когда дуга, предлагаемая по умол-
чанию, не строится по касательной.

Пример..Построение.полилинии.с.установкой.
толщины
Постройте полилинию, изображенную на рис. 8.6.
Запустите команду PLiNE, вызвав ее из па-

дающего меню Draw → Polyline или щелкнув на 
пиктограмме Polyline в группе Draw ленты Home. 
Ответьте на запросы:

_PLINE
Specify start point: 40,10 – точка 1
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: W – переход 

в режим установки ширины полилинии
Specify starting width <0.0000>: 0.5 – стартовая ширина
Specify ending width <0.5000>: 0.5 – конечная ширина
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 50,12 – 

точка 2
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: W – 

переход в режим установки ширины полилинии
Specify starting width <0.5000>: 3 – стартовая ширина
Specify ending width <3.0000>: 0 – конечная ширина
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 

60,14 – точка 3
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: – 

для завершения команды нажмите клавишу Enter

Рис. 8.6. Построение полилинии 
с установкой толщины
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Выполните упражнение P1 из раздела 2.

Пример..Построение.полилинии.
в.режиме.дуг
Постройте полилинию, изображенную на рис. 8.7.
Запустите команду PLiNE, вызвав ее из падающе-

го меню Draw → Polyline или щелкнув на пиктограмме 
Polyline в группе Draw ленты Home. Ответьте на запросы:

_PLINE
Specify start point: 40,8 – точка 1
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: W – переход 

в режим установки ширины полилинии
Specify starting width <0.0000>: 0 – стартовая ширина
Specify ending width <0.0000>: 5 – конечная ширина
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: A – переход 

в режим построения дуги
Specify endpoint of arc or [Angle/CEnter/CLose/Direction/Halfwidth/

Line/Radius/Second pt/Undo/Width]: A – переход в режим задания углом
Specify included angle: 60 – величина угла 2
Specify endpoint of arc or [CEnter/Radius]: CE – переход в режим 

указания центра
Specify center point of arc: 40,24 – центр дуги 3
Specify endpoint of arc or [Angle/CEnter/CLose/Direction/Halfwidth/

Line/Radius/Second pt/Undo/Width]: 65,8 – конечная точка дуги 4
Specify endpoint of arc or [Angle/CEnter/CLose/Direction/Halfwidth/

Line/Radius/Second pt/Undo/Width]: – для завершения команды нажмите кла-
вишу Enter

Выполните упражнения P2–P4 и тест 3 из раздела 2.

Многоугольник
Команда POLYGON, обеспечивающая формирование правильного 
многоугольника, вызывается из падающего меню Draw → Polygon или 
щелчком на пиктограмме Polygon в группе Draw ленты Home (рис. 8.8).

Многоугольники представляют собой замкнутые полилинии; они могут иметь 
от 3 до 1024 сторон равной длины. Многоугольник можно построить, либо вписав 

Рис. 8.7. Построение 
полилинии в режиме дуг

Многоугольник
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его в воображаемую окружность, либо описав вокруг нее, либо задав начало и ко-
нец одной из его сторон. Так как длины сторон многоугольников всегда равны, с их 
помощью легко строить квадраты и равносторонние треугольники.

Рис. 8.8. Инструмент Polygon в группе Draw ленты Home

Запросы команды POLYGON:

Enter number of sides <default>: – указать количество сторон много-
угольника

Specify center of polygon or [Edge]: – указать центр многоугольника
Enter an option [Inscribed in circle/Circumscribed about circle] <I>: – 

задать ключ размещения
Specify radius of circle: – указать радиус окружности

Ключи команды POLYGON:

�� Inscribed in circle – формирование многоугольника, вписанно-
го в окружность. Вписанные многоугольники строятся, когда известно 
расстоя ние между центром многоугольника и его вершинами;

�� Circumscribed about circle – формирование многоугольника, опи-
санного вокруг окружности. Описанные многоугольники – когда извест-
но расстояние между центром многоугольника и серединами его сторон. 
В обоих случаях это расстояние совпадает с радиусом окружности;

�� Edge – указание одной стороны. При использовании этого ключа команда 
POLYGON выдает следующие запросы:
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Specify first endpoint of edge: – указать первую 
точку стороны
Specify second endpoint of edge: – указать 
вторую конечную точку стороны

Пример..Построение.многоугольника.
по.известной.стороне
Постройте квадрат, если известна его сторона, располо-

женная между точками 1 и 2 (рис. 8.9).
Запустите команду POLYGON, вызвав ее из падающего меню Draw → Polygon 

или щелкнув на пиктограмме Polygon в группе Draw ленты Home. Ответьте на за-
просы:

_POLYGON
Enter number of sides <10>: 4 – количество сторон
Specify center of polygon or [Edge]: E – переход в режим указания 

квадрата стороной
Specify first endpoint of edge: 60,80 – точка 1
Specify second endpoint of edge: 60,20 – точка 2

Выполните упражнение Pg1 из раздела 2.

Пример..Построение.
многоугольника,.вписанного.
в.окружность
Постройте пятиугольник, вписанный в окружность 

(рис. 8.10).
Запустите команду POLYGON, вызвав ее из падаю-

щего меню Draw → Polygon или щелкнув на пиктограмме 
Polygon в группе Draw ленты Home. Ответьте на запросы:

_POLYGON
Enter number of sides <4>: 5 – количество сторон
Specify center of polygon or [Edge]: 120,60 – центр пятиугольника
Enter an option [Inscribed in circle/Circumscribed about circle] 

<I>: I – переход в режим формирования многоугольника, вписанного в окруж-
ность

Specify radius of circle: 50 – радиус окружности

Выполните упражнение Pg2 из раздела 2.

Рис. 8.9. 
Построение 

многоугольника по 
известной стороне

Рис. 8.10. Построение 
вписанного 

многоугольника

Многоугольник
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Пример..Построение.многоугольника,.описанного.
вокруг.окружности
Постройте треугольник, описанный вокруг окруж-

ности (рис. 8.11).
Запустите команду POLYGON, вызвав ее из падаю-

щего меню Draw → Polygon или щелкнув на пиктограмме 
Polygon в группе Draw ленты Home. Ответьте на запросы:

_POLYGON
Enter number of sides <4>: 3 – количество сто-

рон
Specify center of polygon or [Edge]: 120,60 – 

центр треугольника
Enter an option [Inscribed in circle/

Circumscribed about circle] <I>: C – переход в режим формирования много-
угольника, описанного вокруг окружности

Specify radius of circle: 50 – радиус окружности

Выполните упражнение Pg3 из раздела 2.

Прямоугольник
Команда RECtANG формирует прямоугольник по двум противопо-
ложным углам. Вызывается из падающего меню Draw → Rectangle или 
щелчком на пиктограмме Rectangle в группе Draw ленты Home.

Запросы команды RECtANG:
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/

Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: – указать 

противоположный угол прямоугольника

Ключи команды POLYGON:

�� Chamfer – формирует прямоугольник со скошенными углами. При этом 
команда выдает следующие запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: C – переход в режим фаски
Specify first chamfer distance for rectangles: – указать длину 
первой фаски прямоугольника
Specify second chamfer distance for rectangles: – указать длину 
второй фаски прямоугольника

Рис. 8.11. Построение 
описанного 

многоугольника
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Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: – 
указать противоположный угол прямоугольника

�� Elevation – задает уровень для прямоугольника. При этом команда вы-
дает следующие запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: E – переход в режим задания уровня
Specify the elevation for rectangles: – указать уровень прямо-
угольника
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: – ука-
зать противоположный угол прямоугольника

�� Fillet – формирует прямоугольник со скругленными углами. При этом 
команда выдает следующие запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: F – переход в режим сопряжения
Specify fillet radius for rectangles: – указать радиус сопряжения 
прямоугольника
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: – ука-
зать противоположный угол прямоугольника

�� Thickness – формирует прямоугольник с заданной трехмерной высотой. 
При этом команда выдает следующие запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: T – переход в режим задания трехмерной высоты
Specify thickness for rectangles: – указать значение трехмерной 
высоты прямоугольника
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: – 
указать противоположный угол прямоугольника

�� Width – формирует прямоугольник с заданной шириной полилинии. При 
этом команда выдает следующие запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: W – переход в режим задания ширины полилинии 
прямоугольника
Specify line width for rectangles: – указать значение ширины по-
лилинии прямоугольника

Прямоугольник
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Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: – ука-
зать противоположный угол прямоугольника

�� Area – создает прямоугольник с использованием значений площади, а так-
же значений длины или ширины. Прим этом программа вычисляет другой 
размер и завершает построение прямоугольника. Если параметр Chamfer 
или Fillet включен, эффекты фаски или сопряжения на углах прямоу-
гольника включаются в площадь. При этом команда выдает следую щие 
запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: A – 
переход в режим задания площади прямоугольника
Enter area of rectangle in current units: – указать площадь пря-
моугольника в текущих единицах
Calculate rectangle dimensions based on [Length/Width] 
<Length>: L – указать вычислять размеры прямоугольника на основе па-
раметра длины или ширины
Enter rectangle length: – указать длину прямоугольника

�� Dimensions – построение прямоугольника по заданным значениям длины 
и ширины. При этом команда выдает следующие запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: D – 
переход в режим построения прямоугольника по заданным значениям 
длины и ширины
Specify length for rectangles: – указать длину прямоугольника
Specify width for rectangles: – указать ширину прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: – 
указать противоположный угол прямоугольника

�� Rotation – создает прямоугольник под заданным углом поворота. При 
этом команда выдает следующие запросы:
Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: – указать первый угол прямоугольника
Specify other corner point or [Area/Dimensions/Rotation]: R – 
переход в режим задания угла
Specify rotation angle or [Pick points]: – указать угол поворота 
или точки выбора
Specify other corner point or [Area/Dimensions/Rotation]: – 
указать противоположный угол прямоугольника
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Выполните упражнения Re1–Re4 из раздела 2.

Эскиз
Команда sKEtCH обеспечивает рисование эскиза, вызывается из командной стро-
ки.

Эскизы состоят из множества прямолинейных сегментов (рис. 8.12). Каждый 
сегмент представляет собой либо отдельный объект, либо отрезок полилинии. 
Имеется возможность задавать минимальную длину, или приращение сегмен-
тов. Эскизное рисование используется при формировании линий неправильной 
формы и при снятии копий с помощью дигитайзера. Состоящие из множества ма-
леньких линейных сегментов эскизы позволяют рисовать с достаточно высокой 
точностью, но при этом резко возрастает объем файла рисунка. Поэтому данное 
средство следует применять только в крайнем случае.

Рис. 8.12. Пример эскизной линии

При эскизном рисовании устройство указания используется как перо. После 
щелчка перо «опускается» и рисует на экране; следующий щелчок приводит к 
«подъему» пера и прекращению рисования.

Запросы команды sKEtCH:

Record increment <default>: – указать приращение
Sketch. Pen eXit Quit Record Erase Connect.

Перед началом эскизного рисования следует убедиться, что системная пере-
менная CELTYPE задает тип линии Continuous. Если рисуется линия, включающая в 
себя точки или штрихи, а величина приращения меньше длины точки или штриха, 
эти элементы не будут видны на рисунке.

Эскиз
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Кроме того, при эскизном рисовании рекомендуется отключать режимы ORTHO 
и SNAP, иначе результаты могут быть непредсказуемы.

Выполните упражнение Sk1 из раздела 2.
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Дуга
Команда ARC, формирующая дугу, вызывается из падающего меню Draw → Arc 
или щелчком на пиктограмме Arc в группе Draw ленты Home рабочего пространства 
Drafting & Annotation (рис. 9.1, 9.2).

Рис. 9.1. Команда построения дуги в падающем меню

Дуги можно строить различными способами. По умолчанию построение про-
изводится путем указания трех точек: начальной, промежуточной и конечной. 
Дугу можно также определить, задав центральный угол, радиус, направление или 
длину хорды. Хордой называется отрезок, соединяющий начало и конец дуги. По 
умолчанию дуга рисуется против часовой стрелки.
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Рис. 9.2. Варианты команды построения дуги

Запросы команды ARC:

Specify start point of arc or [Center]: – указать начальную точку дуги
Specify second point of arc or [Center/End]: – указать вторую точку 

дуги
Specify end point of arc: – указать конечную точку дуги

Ключи команды ARC:

�� Center – точка центра дуги;
�� End – конечная точка дуги;
�� Angle – величина угла;
�� chord Length – длина хорды;
�� Direction – направление касательной;
�� Radius – радиус дуги.

Дуга
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Существует несколько способов построения дуги при помощи команды ARC:

3 Points – построение дуги по трем точкам, лежащим на дуге;

Start, Center, End – построение дуги по стартовой точке, центру и ко-
нечной точке дуги. Положительным направлением считается 
построе ние дуги против часовой стрелки. Запросы:

Specify start point of arc or [Center]: – указать начальную 
точку дуги
Specify second point of arc or [Center/End]: C – переход в 
режим построения дуги по центру
Specify center point of arc: – указать центр дуги
Specify end point of arc or [Angle/chord Length]: – указать 
конечную точку дуги

Start, Center, Angle – построение дуги по стартовой точке, центру и 
углу. Положительным направлением считается построение дуги про-
тив часовой стрелки; изменить направление на противоположное 
можно, задав отрицательное значение угла. Запросы:

Specify start point of arc or [Center]: – указать начальную 
точку дуги
Specify second point of arc or [Center/End]: C – переход в 
режим построения дуги по центру
Specify center point of arc: – указать центр дуги
Specify end point of arc or [Angle/chord Length]: A – переход 
в режим построения дуги по углу
Specify included angle: – указать центральный угол

Start, Center, Length – построение дуги по стартовой точке, центру и 
длине хорды. Дуга строится против часовой стрелки от начальной 
точки, причем по умолчанию – меньшая из двух возможных (то есть 
дуга, которая меньше 180°). Если же вводится отрицательное значе-
ние длины хорды, будет нарисована большая дуга. Запросы:

Specify start point of arc or [Center]: – указать начальную 
точку дуги
Specify second point of arc or [Center/End]: C – переход в 
режим построения дуги по центру
Specify center point of arc: – указать центр дуги
Specify end point of arc or [Angle/chord Length]: L – переход 
в режим построения дуги по длине хорды
Specify length of chord: – указать длину хорды
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Start, End, Angle – построение дуги по стартовой точке, конечной точке 
и углу. Положительным направлением считается построение дуги 
против часовой стрелки, изменить направление на противоположное 
можно, задав отрицательное значение угла. Запросы:

Specify start point of arc or [Center]: – указать начальную 
точку дуги
Specify second point of arc or [Center/End]: E – переход в 
режим построения дуги по конечной точке
Specify end point of arc: – указать конечную точку дуги
Specify center point of arc or [Angle/Direction/Radius]: A – 
переход в режим построения дуги по углу
Specify included: – указать центральный угол

Start, End, Direction – построение дуги по стартовой точке, конечной 
точке и направлению – углу наклона касательной из начальной точ-
ки. Запросы:

Specify start point of arc or [Center]: – указать начальную 
точку дуги
Specify second point of arc or [Center/End]: E – переход в 
режим построения дуги по конечной точке
Specify end point of arc: – указать конечную точку дуги
Specify center point of arc or [Angle/Direction/Radius]: D – 
переход в режим построения дуги по направлению касательной
Specify tangent direction for the start point of arc: – ука-
зать направление касательной от начальной точки дуги

Start, End, Radius – построение дуги по стартовой точке, конечной точке 
и радиусу. Строится меньшая дуга против часовой стрелки. Запросы:

Specify start point of arc or [Center]: – указать начальную 
точку дуги
Specify second point of arc or [CEnter/ENd]: E – переход в 
режим построения дуги по конечной точке
Specify end point of arc: – указать конечную точку дуги
Specify center point of arc or [Angle/Direction/Radius]: R – 
переход в режим построения дуги по радиусу
Specify radius of arc: – указать радиус дуги

Center, Start, End – построение дуги по центру, стартовой и конечной 
точкам. Запросы:

Specify start point of arc or [Center]: C – переход в режим 
построения дуги по центру
Specify center point of arc: – указать центр дуги

Дуга
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Specify start point of arc: – указать начальную точку дуги
Specify end point of arc or [Angle/chord Length]: – указать 
конечную точку дуги

Center, Start, Angle – построение дуги по центру, стартовой точке и 
углу. Запросы:

Specify start point of arc or [Center]: C – переход в режим 
построения дуги по центру
Specify center point of arc: – указать центр дуги
Specify start point of arc: – указать начальную точку дуги
Specify end point of arc or [Angle/chord Length]: A – пере-
ход в режим построения дуги по углу
Specify included angle: – указать центральный угол

Center, Start, Length – построение дуги по центру, стартовой точке и 
длине хорды. Запросы:

Specify start point of arc or [Center]: C – переход в режим 
построения дуги по центру
Specify center point of arc: – указать центр дуги
Specify start point of arc: – указать начальную точку дуги
Specify end point of arc or [Angle/chord Length]: L – пере-
ход в режим построения дуги по длине хорды
Specify length of chord: – указать длину хорды

Continue – построение дуги как продолжения предшествующей ли-
нии или дуги. При этом начальной точкой дуги и ее начальным на-
правлением станут, соответственно, конечная точка и конечное на-
правление последней созданной дуги или последнего созданного 
отрезка. Такой способ особенно удобен для построения дуги, каса-
тельной к заданному отрезку. Запросы:

Specify start point of arc or [Center]: – указать начальную 
точку дуги
Specify end point of arc: – указать конечную точку дуги

Пример..Построение.дуги.по.трем.
точкам
Постройте дугу по варианту 3 Points – рис. 9.3.
Запустите команду ARC, вызвав ее из падающего меню 

Draw → Arc → 3 Points или щелкнув на пиктограмме Arc в 
группе Draw ленты Home. Ответьте на запросы:

Рис. 9.3. Построение 
дуги по трем точкам



219

_ARC
Specify start point of arc or [Center]: 50,80 – точка 1
Specify second point of arc or [Center/End]: 50,20 – точка 2
Specify end point of arc: 20,50 – точка 3

Выполните упражнение A1 из раздела 2.

Пример..Построение.дуги.по.
стартовой.точке,.центру.и.углу
Постройте дугу по варианту Start, Center, Angle – рис. 9.4.
Запустите команду ARC, вызвав ее из падающего меню 

Draw → Arc → Start, Center, Angle или щелкнув на пиктограм-
ме Arc в группе Draw ленты Home. Ответьте на запросы:

_ARC
Specify start point of arc or [Center]: 20,50 – точка 1
Specify second point of arc or [Center/End]: C – переход в режим по-

строения дуги по центру
Specify center point of arc: 50,50 – точка 2
Specify end point of arc or [Angle/chord Length]: A – переход в режим 

построения дуги по углу
Specify included angle: 135 – угол

Выполните упражнение A2 из раздела 2.

Пример..Построение.дуги.
по.стартовой.точке,.конечной.
точке.и.радиусу
Постройте дугу по варианту Start, End, Radius – 

рис. 9.5.
Запустите команду ARC, вызвав ее из падающего 

меню Draw → Arc → Start, End, Radius или щелкнув на 
пиктограмме Arc в группе Draw ленты Home. Ответьте на 
запросы:

_ARC
Specify start point of arc or [Center]: 80,50 – точка 1
Specify second point of arc or [Center/End]: E – переход в режим по-

строения дуги по конечной точке
Specify end point of arc: 50,80 – точка 2

Рис. 9.4. Построение 
дуги по стартовой 

точке, центру и углу

Рис. 9.5. Построение 
дуги по стартовой точке, 
конечной точке и радиусу

Дуга
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Specify center point of arc or [Angle/Direction/Radius]: R – переход 
в режим построения дуги по радиусу

Specify radius of arc: 30 – радиус дуги

Выполнитe упражнения A3–A5 из раздела 2.

Окружность
Команда CiRCLE, формирующая окружность, вызывается из падаю-
щего меню Draw → Circle или щелчком на пиктограмме Circle в группе 
Draw ленты Home в рабочем пространстве Drafting & Annotation 
(рис. 9.6, 9.7).

Рис. 9.6. Команда построения окружности в падающем меню
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Рис. 9.7. Команда формирования окружности  
в рабочем пространстве Drafting & Annotation 

Окружности можно строить различными способами. По умолчанию построе-
ние производится путем указания центра и радиуса. Можно задавать центр и диа-
метр или только диаметр, указывая его начальную и конечную точки. Окружность 
также может строиться по трем точкам. Кроме того, имеется возможность опреде-
лять окружность, касающуюся либо трех объектов рисунка, либо двух (в послед-
нем случае задается еще и радиус).

Запросы команды CiRCLE:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: – 
указать центр окружности

Specify radius of circle or [Diameter]: – указать радиус

Ключи команды CiRCLE:

Center,Diameter – строит окружность по центру и диаметру. При 
этом команда CiRCLE выдает следующие запросы:

Окружность
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Specify center point for circle or [3P/2P/Ttr (tan tan 
radius)]: – указать центр окружности
Specify radius of circle or [Diameter]: _d – переход в режим 
построения окружности по диаметру
Specify diameter of circle: – указать диаметр

2-Point – строит окружность по двум точкам, лежащим на диаметре. 
При этом команда CiRCLE выдает следующие запросы:

Specify center point for circle or [3P/2P/Ttr (tan tan 
radius)]: 2P – переход в режим построения окружности по двум 
точкам
Specify first end point of circle's diameter: – указать первую 
конечную точку диаметра
Specify second end point of circle's diameter: – указать вто-
рую конечную точку диаметра

3-Point – строит окружность по трем точкам, лежащим на окруж-
ности. При этом команда CiRCLE выдает следующие запросы:

Specify center point for circle or [3P/2P/Ttr (tan tan 
radius)]: 3P – переход в режим построения окружности по трем 
точкам
Specify first point on circle: – указать первую точку окружности
Specify second point on circle: – указать вторую точку окруж-
ности
Specify third point on circle: – указать третью точку окружности

Tan,Tan,Radius – строит окружность по двум касательным и радиу-
су. При этом команда CiRCLE выдает следующие запросы:

Specify center point for circle or [3P/2P/Ttr (tan tan 
radius)]: TTR – переход в режим построения окружности по двум 
касательным и радиусу
Specify point on object for first tangent of circle: – указать 
точку на объекте, задающую первую касательную
Specify point on object for second tangent of circle: – ука-
зать точку на объекте, задающую вторую касательную
Specify radius of circle <default>: – указать радиус окруж-
ности

Tan,Tan,Tan – строит окружность, касательную к трем объектам. 
При этом команда CiRCLE выдает следующие запросы:

Specify center point for circle or [3P/2P/Ttr (tan tan 
radius)]: _3p – переход в режим построения окружности, каса-
тельной к трем объектам
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Specify first point on circle: _tan to – указать точку на объ-
екте, задающую первую касательную
Specify second point on circle: _tan to – указать точку на 
объекте, задающую вторую касательную
Specify third point on circle: _tan to – указать точку на объ-
екте, задающую третью касательную

Пример..Построение.окружности.по.центру.
и.радиусу
Постройте окружность по центру и радиусу (рис. 9.8).
Запустите команду CiRCLE, вызвав ее из падающего меню 

Draw → Circle → Center, Radius или щелкнув на пиктограмме 
Circle → Center, Radius в группе Draw ленты Home. Ответьте на 
запросы:

_CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]: 50,50 – точка центра окружности
Specify radius of circle or [Diameter] <50>: 30 – 

радиус окружности

Выполните упражнение C1 из раздела 2.

Пример..Построение.окружности.по.двум.точкам.
диаметра
Постройте окружность по двум точкам диаметра (рис. 9.9).
Запустите команду CiRCLE, вызвав ее из падающего меню 

Draw → Circle → 2 Points или щелкнув на пиктограмме Circle → 
2-Point в группе Draw ленты Home. Ответьте на запросы:

_CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]: 2P – переход в режим построения окружности 
по двум точкам

Specify first end point of circle's diameter: 50,80 – 
точка 1

Specify second end point of circle's diameter: 
50,20 – точка 2

Выполните упражнение C2 из раздела 2.

Рис. 9.8. 
Построение 

окружности по 
центру и радиусу

Рис. 9.9. 
Построение 

окружности по 
двум точкам 

диаметра

Окружность
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Пример..Построение.окружности.по.трем.точкам
Постройте окружность по трем точкам (рис. 9.10).
Запустите команду CiRCLE, вызвав ее из падающего меню 

Draw → Circle → 3 Points или щелкнув на пиктограмме Circle → 
3-Point в группе Draw ленты Home. Ответьте на запросы:

_CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]: 3P – переход в режим построения окружности 
по трем точкам

Specify first point on circle: 50,80 – точка 1
Specify second point on circle: 50,20 – точка 2
Specify third point on circle: 20,50 – точка 3

Выполните упражнение C3 из раздела 2.

Пример..Построение.окружности,.касательной.
двум.примитивам
Постройте несколько изображенных пунктир-

ной линией вариантов окружности, касательной 
отрезку и окружности (рис. 9.11).

Запустите команду CiRCLE, вызвав ее из падаю-
щего меню Draw → Circle → Tan, Tan, Radius или щел-
кнув на пиктограмме Circle → Tan, Tan, Radius в груп-
пе Draw ленты Home. Ответьте на запросы:

_CIRCLE
Specify center point for circle or [3P/2P/

Ttr (tan tan radius)]: T – переход в режим 
построения окружности по двум касательным и ра-
диусу

Specify point on object for first tangent of circle: – точка 1
Specify point on object for second tangent of circle: – точка 2
Specify radius of circle: 15 – радиус касательной окружности

Местоположение строящейся окружности зависит от того, в каком месте ука-
зываются точка 1, принадлежащая большей окружности, и точка 2, принадлежа-
щая отрезку.

Выполните упражнение C4 из раздела 2.

Рис. 9.10. 
Построение 

окружности по 
трем точкам

Рис. 9.11. Построение 
окружности, касательной  

двум примитивам
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Пример..Построение.окружности,.касательной.
двум.другим.окружностям
Постройте два изображенных пунктирной линией ва-

рианта окружности, касательной двум другим окружно-
стям (рис. 9.12).

Запустите команду CiRCLE, вызвав ее из падающе-
го меню Draw → Circle → Tan, Tan, Radius или щелкнув на 
пиктограмме Circle → Tan, Tan, Radius в группе Draw ленты 
Home. Ответьте на запросы:

_CIRCLE
Specify center point for circle or [3P/2P/Ttr 

(tan tan radius)]: T – переход в режим построения 
окружности по двум касательным и радиусу

Specify point on object for first tangent of 
circle: – точка 1

Specify point on object for second tangent of circle: – точка 2
Specify radius of circle: 50 – радиус касательной окружности

Местоположение строящейся окружности зависит от того, в каком месте ука-
зываются точки 1 и 2.

Выполните упражнение C5 из раздела 2.

Пример..Построение.окружности,.касательной.
прямой
Постройте окружность, касательную по центру и 

радиусу, изображенную пунктирной линией (рис. 9.13). 
При указании центра и радиуса используйте объект-
ную привязку.

Запустите команду CiRCLE, вызвав ее из падающе-
го меню Draw → Circle → Center, Radius или щелкнув на 
пиктограмме Circle → Center, Radius в группе Draw ленты 
Home. Ответьте на запросы:

_CIRCLE
Specify center point for circle or [3P/2P/Ttr 

(tan tan radius)]: INTERSECTION – укажите точку 
центра окружности с объектной привязкой к пересече-
нию

Specify radius of circle or [Diameter] <50>: TANGENT – укажите радиус 
окружности с объектной привязкой к точке касания

Рис. 9.12. Построение 
окружности, 

касательной двум 
другим окружностям

Рис. 9.13. Построение 
окружности, касательной 

прямой

Окружность
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Выполните упражнение C6 из раздела 2.

Пример..Построение.окружности.по.двум.точкам.
диаметра,.лежащим.на.концах.отрезка
Постройте окружность, изображенную пунктирной лини-

ей, по двум точкам диаметра (рис. 9.14). При указании точек 
используйте объектную привязку.

Запустите команду CiRCLE, вызвав ее из падающего меню 
Draw → Circle → 2 Points или щелкнув на пиктограмме Circle → 
2-Point в группе Draw ленты Home. Ответьте на запросы:

_CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]: 2P – переход в режим построения окружно-
сти по двум точкам

Specify first end point of circle's diameter: 
ENDPOINT – укажите точку 1

Specify second end point of circle's diameter: 
ENDPOINT – укажите точку 2

Выполните упражнение C7 из раздела 2.

Пример..Построение.концентрической.окружности
Постройте концентрическую окружность, изображенную 

пунктирной линией, по центру и радиусу (рис. 9.15). При ука-
зании центра используйте объектную привязку.

Запустите команду CiRCLE, вызвав ее из падающего меню 
Draw → Circle → Center, Radius или щелкнув на пиктограмме 
Circle → Center, Radius в группе Draw ленты Home. Ответьте на за-
просы:

_CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]: CENTER – укажите на точку 1 с объектной при-
вязкой к центру дуги, для определения центра окружности

Specify radius of circle or [Diameter] <50>: 50 – радиус окружности

Выполните упражнение C8 и тест 2 из раздела 2.

Рис. 9.14. 
Построение 

окружности по 
двум точкам 
диаметра, 

лежащим на 
концах отрезка

Рис. 9.15. 
Построение 

концентрической 
окружности
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Кольцо
Команда DONUt, формирующая кольца, вызывается из падающего 
меню Draw → Donut или щелчком на пиктограмме Donut в группе Draw 
ленты Home в рабочем пространстве Drafting & Annotation.

С помощью функции построения колец легко формировать закрашенные 
кольцеобразные объекты и круги. В действительности они представляют собой 
замкнутые полилинии ненулевой ширины. Для построения кольца необходи-
мо задать его внутренний и внешний диаметры, а также центр. За один вызов 
команды можно построить любое количество колец одинакового диаметра, но с 
разными центрами. Работа команды завершается нажатием клавиши Enter. Если 
требуется построить заполненный круг, следует задать нулевой внутренний диа-
метр кольца.

Текущее значение внутреннего диаметра кольца хранится в системной пере-
менной DONUTID, а значение внешнего диаметра – в переменной DONUTOD. Закрас-
кой колец и широких полилиний управляет системная переменная FILLMODE.

Запросы команды DONUt:

Specify inside diameter of donut <default>: – указать внутренний диа-
метр кольца

Specify outside diameter of donut <default>: – указать внешний диа-
метр кольца

Specify center of donut or <exit>: – указать центр кольца
Specify center of donut or <exit>: – указать центр кольца
Specify center of donut or <exit>: – нажать клавишу Enter для заверше-

ния команды

Пример..Построение.кольца
Постройте несколько колец-«бубликов» 

(рис. 9.16).
Запустите команду DONUt, вызвав ее из 

падающего меню Draw → Donut или щелкнув на 
пиктограмме Donut в группе Draw ленты Home. 
Ответьте на запросы:

_DONUT
Specify inside diameter of donut <20.0000>: 30 – внутренний диаметр 

кольца
Specify outside diameter of donut <40.0000>: 35 – внешний диаметр 

кольца
Specify center of donut or <exit>: 10,60 – центр 1-го кольца
Specify center of donut or <exit>: 50,40 – центр 2-го кольца
Specify center of donut or <exit>: 90,50 – центр 3-го кольца

Рис. 9.16. Построение кольца

Кольцо



Глава 9. Построение криволинейных объектов228

Specify center of donut or <exit>: – для завершения команды нажмите 
клавишу Enter

Выполните упражнение Do1 из раздела 2.

Сплайн
Команда sPLiNE, формирующая сплайн, вызывается из падающего меню Draw → 
Spline или щелчком на пиктограммах Spline Fit или Spline CV в группе Draw ленты 
Home в рабочем пространстве Drafting & Annotation (рис. 9.17, 9.18).

Рис. 9.17. Команда построения сплайна в падающем меню

Сплайн представляет собой гладкую кривую, проходящую через заданный на-
бор точек. AutoCAD работает с одной из разновидностей сплайнов – неоднород-
ными рациональными B-сплайновыми кривыми NURBS. Использование NURBS 
обеспечивает достаточную гладкость кривых, проходящих через заданные конт-
рольные точки. Сплайны применяются для рисования кривых произвольной фор-
мы, например горизонталей в географических информационных системах или при 
проектировании автомобилей.
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Рис. 9.18. Команда построения сплайна в рабочем пространстве Drafting & Annotation 

Сплайн можно строить путем интерполяции по набору точек, через которые 
он должен проходить. Таким способом при построении кривых для двухмерного и 
трехмерного моделирования достигается намного большая точность, чем при ис-
пользовании полилиний. К тому же рисунок, использующий сплайны, занимает 
меньше места на диске и в оперативной памяти, чем рисунок с полилиниями.

AutoCAD предлагает два способа создания сплайнов: с помощью определяю-
щих точек или управляющих вершин.

Fit Points – построение сплайна путем задания определяющих то-
чек. При этом команда выдает запросы:

Current settings: Method=…   Knots=… – текущие настройки
Specify first point or [Method/Knots/Object]: _M – переход в 
режим выбора метода построения
Enter spline creation method [Fit/CV]: _FIT – переход в ре-
жим построения определяющих точек
Current settings: Method=Fit   Knots=Chord – текущие на-
стройки
Specify first point or [Method/Knots/Object]: – указать пер-
вую точку
Enter next point or [start Tangency/toLerance]: – указать 
следующую точку
Enter next point or [end Tangency/toLerance/Undo/Close]: – 
указать следующую точку
Enter next point or [end Tangency/toLerance/Undo/Close]: – 
указать следующую точку
. . .

Сплайн
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Control Vertices – построение сплайна путем задания управляю-
щих вершин. Этот способ является предпочтительным, если требует-
ся создать геометрию для работы с 3D NURBS-поверхностями. При 
этом команда выдает запросы:

Current settings: Method=…   Knots=… – текущие настройки
Specify first point or [Method/Knots/Object]: _M – переход в 
режим выбора метода построения
Enter spline creation method [Fit/CV]: _CV – переход в режим 
построения управляющих вершин
Current settings: Method=CV   Degree=3 – текущие настройки
Specify first point or [Method/Degree/Object]: – указать пер-
вую точку
Enter next point: – указать следующую точку
Enter next point or [Close/Undo]: – указать следующую точку
Enter next point or [Close/Undo]: – указать следующую точку
...

Ключи команды sPLiNE:

�� Method – управление способом создания сплайна (системная переменная 
SPLMETHOD);

�� Degree – определение максимального количества изгибов на каждом 
участке (от 1 до 3);

�� Knots – применение узловой параметризации, влияющей на форму кри-
вой при ее прохождении через определяющую точку (системная перемен-
ная SPLKNOTS);

�� Chord – нумерация точек для редактирования с использованием десятич-
ных значений, соответствующих их местоположению на кривой;

�� Square root – нумерация точек для редактирования на основе значения, 
равного квадратному корню из длины хорды между последовательными 
узлами;

�� Uniform – нумерация точек для редактирования с использованием после-
довательных целых чисел;

�� Object – преобразование сглаженных сплайнами двухмерных и трехмер-
ных полилиний в эквивалентные им сплайны;

�� Fit – построение сплайна путем задания определяющих точек;
�� CV – построение сплайна путем задания управляющих вершин;
�� start Tangency – создание сплайнов на основе направления касательной;
�� end Tangency – завершение создания сплайнов на основе направления 

касательной;
�� tolerance – определение расстояния-допуска, на котором сплайн должен 

проходить от заданных определяющих точек;
�� Undo – отмена последней заданной точки;
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�� Close – замкнуть сплайн. При этом команда выдает запрос на указание 
направления касательной.

Сплайн строится путем указания координат определяющих точек. Сплайны 
могут быть замкнутыми; при этом совпадают как сами конечная и начальная точ-
ки, так и направления касательных в них. Кроме того, в ходе построения можно из-
менять допуск сплайновой аппроксимации – величину, определяющую, насколь-
ко близко проходит сплайн к указанным определяющим точкам. Чем меньше зна-
чение допуска, тем ближе сплайн к определяющим точкам; при нулевом допуске 
он проходит прямо через них.

Эллипс
Команда ELLiPsE, обеспечивающая формирование эллипса, вызывается из падаю-
щего меню Draw → Ellipse или щелчком на соответствующих пиктограммах в груп-
пе Draw ленты Home в рабочем пространстве Drafting & Annotation (рис. 9.19, 9.20). 

Имеется возможность строить эллипсы и эллиптические дуги, причем с мате-
матической точки зрения эти объекты – действительно эллипсы, а не какие-либо 
аппроксимирующие их кривые. Самая длинная ось эллипса называется его боль
шой осью, самая короткая – малой. Оси могут определяться в любом порядке.

Рис. 9.19. Команда построения эллипса в падающем меню

Эллипс
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Рис. 9.20. Инструменты формирования эллипса  
в рабочем пространстве Drafting & Annotation 

Способы формирования эллипса:

Center – создание эллипса с помощью точки центра, конечной точки 
первой оси и длины второй оси. При этом команда выдает запросы:

Specify axis endpoint of ellipse or [Arc/Center]: _c – пере-
ход в режим указания точки центра 
Specify center of ellipse: – указать точку центра эллипса
Specify endpoint of axis: – указать конечную точку оси эллипса
Specify distance to other axis or [Rotation]: – указать длину 
другой оси

Axis,End – построение эллипса путем указания начальной и конеч-
ной точек первой оси, а также половины длины второй оси. При этом 
команда выдает запросы:

Specify axis endpoint of ellipse or [Arc/Center]: – указать 
конечную точку оси эллипса
Specify other endpoint of axis: – указать вторую конечную 
точку оси
Specify distance to other axis or [Rotation]: – указать длину 
другой оси

Elliptical Arc – построение эллиптической дуги. При этом коман-
да выдает запросы:

Specify axis endpoint of ellipse or [Arc/Center]: _a – пере-
ход в режим построения эллиптической дуги
Specify axis endpoint of elliptical arc or [Center]: – ука-
зать конечную точку оси эллиптической дуги
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Specify other endpoint of axis: – указать вторую конечную 
точку оси
Specify distance to other axis or [Rotation]: – указать длину 
другой оси
Specify start angle or [Parameter]: – указать начальный угол
Specify end angle or [Parameter/Included angle]: – указать 
конечный угол

Ключи команды ELLiPsE.

�� Arc – режим построения эллиптических дуг. По умолчанию эллиптиче-
ские дуги, как и эллипсы, строятся путем указания конечных точек пер-
вой оси и половины длины второй. После этого задаются начальный и 
конечный углы. Нулевым углом считается направление от центра эллип-
са вдоль его большой оси. Направление возрастания угла определяется 
значением системной переменной ANGDIR. Если она равна 0, то возраста-
ние угла происходит при движении против часовой стрелки; если 1 – по 
часовой стрелке. Если начальный и конечный углы совпадают, строится 
полный эллипс. Вместо конечного угла можно указать центральный угол 
дуги, измеренный от начальной точки. 

�� Center – указание центра эллипса. 
�� Rotation – режим построения эллипса указанием поворота относительно 

главной оси. 
�� Parameter – эллиптическая дуга строится на основании параметрическо-

го векторного уравнения.
�� Included angle – задание внутреннего угла эллиптической дуги.

Пример..Построение.эллипса.по.двум.осям
Постройте эллипс по конечным точкам первой оси и по-

ловине длины второй оси (рис. 9.21).
Запустите команду ELLiPsE, вызвав ее из падающего 

меню Draw → Ellipse → Axis,End  или щелкнув на пиктограм-
ме Axis,End  в группе Draw ленты Home. Ответьте на запросы:

_ELLIPSE
Specify axis endpoint of ellipse or [Arc/Center]: 

10,20 – начало первой оси эллипса
Specify other endpoint of axis: 80,80 – конечная 

точка первой оси эллипса
Specify distance to other axis or [Rotation]: 20 – половина длины 

второй оси эллипса

Выполните упражнение El1 из раздела 2.

Рис. 9.21. 
Построение эллипса

Эллипс
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Облако
Команда REVCLOUD предназначена для формирования облака, вы-
зывается из падающего меню Draw → Revision Cloud или щелчком на 
соответствующих пиктограммах в группе Draw ленты Home (рис. 9.22).

Рис. 9.22. Инструменты формирования облака  
в рабочем пространстве Drafting & Annotation 

Геометрический объект «облако», использующийся для нанесения различных 
пояснительных надписей и пометок к элементам чертежа, представляет собой по-
лилинию с дуговыми сегментами (рис. 9.23).

Рис. 9.23. Построение облака 
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Запросы команды REVCLOUD:

Minimum arc length: 15  Maximum arc length: 15  Style: Normal – зна-
чения максимальной и минимальной длины дуги и установленный стиль

Specify first point or [Arc length/Object/ Rectangular/Polygonal/
Freehand/Style/Modify] <Object>: – указать начальную точку или ввести ключ

Guide crosshairs along cloud path... – провести курсор по контуру облака
Revision cloud finished. – облако построено

Ключи команды REVCLOUD:

�� Arc length – режим указания значения максимальной и минимальной 
длины дуги. Запросы:

Minimum arc length: 15  Maximum arc length: 15  Style: Normal – 
значения максимальной и минимальной длины дуги и установленный 
стиль
Specify first point or [Arc length/Object/ Rectangular/Polygonal/
Freehand/Style/Modify] <Object>: A – указать начальную точку или 
ввести ключ
Specify minimum length of arc: – указать минимальную длину дуги
Specify maximum length of arc: – указать максимальную длину дуги
Guide crosshairs along cloud path... – провести курсор по контуру 
облака
Revision cloud finished. – облако построено

�� Object – преобразование объекта в облако. Запросы:

Minimum arc length: 15  Maximum arc length: 15  Style: Normal – 
значения максимальной и минимальной длины дуги и установленный 
стиль
Specify first point or [Arc length/Object/ Rectangular/Polygonal/
Freehand/Style/Modify] <Object>: O – переход в режим преобразова-
ния объекта
Select object: – выбрать преобразуемый объект
Reverse direction [Yes/No] <No>: – указать, изменить ли направление 
на противоположное
Revision cloud finished. – облако построено

�� Rectangular – формирование прямоугольного облака путем указания 
противоположных углов.

�� Polygonal – формирование полигонального облака путем указания трех 
или более точек в качестве его вершин.

�� Freehand – формирование произвольного облака путем рисования его «от 
руки».

�� Style – стиль
Minimum arc length: 15  Maximum arc length: 15  Style: Normal – 
значения максимальной и минимальной длины дуги и установленный стиль

Облако
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Specify first point or [Arc length/Object/ Rectangular/Polygonal/
Freehand/Style/Modify] <Object>: S – переход в режим задания стиля
Select arc style [Normal/Calligraphy] <Normal>: – определить 
стиль дуг
Arc style = Calligraphy – выбранный стиль дуг
Specify first point or [Arc length/Object/ Rectangular/Polygonal/
Freehand/Style/Modify] <Object>: – указать начальную точку или 
ввес ти ключ
Guide crosshairs along cloud path... – провести курсор по контуру 
облака
Revision cloud finished. – облако построено

Команда REVCLOUD не поддерживает прозрачное панорамирование и мас-
штабирование в режиме реального времени.
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Текстовые.стили
С каждой текстовой надписью в AutoCAD связан некоторый текстовый стиль. 
При нанесении надписей используется текущий стиль, в котором заданы шрифт, 
высота, угол поворота, ориентация и другие параметры. В одном рисунке можно 
создавать и использовать несколько текстовых стилей, причем их быстрое копи-
рование из одного рисунка в другой обеспечивается благодаря Центру управле-
ния. Текстовые стили представляют собой неграфические объекты, которые также 
хранятся в файле рисунка. Все текстовые стили, кроме Standard, пользователь соз-
дает по своему желанию.

Команды формирования текстовых надписей, создания новых и редактирова-
ния имеющихся стилей находятся в группе Annotation ленты Home, или в группе 
Text ленты Annotate рабочего пространства Drafting & Annotation (рис. 10.1, 10.2).

Рис. 10.1. Инструменты формирования текстовых надписей

Рис. 10.2. Инструменты формирования текста на ленте Home
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Создание и модификация текстового стиля производятся в диалого-
вом окне Text Style, вызываемом из падающего меню Format → Text Style… 
или щелчком на пиктограмме Text Style… в группе Annotation ленты 
Home (рис. 10.3).

Рис. 10.3. Диалоговое окно текстовых стилей

Для создания нового стиля необходимо щелкнуть на кнопке New... – при этом 
будет загружено диалоговое окно New Text Style. Здесь вводится имя создаваемого 
стиля, которое может содержать до 255 символов. Ему присваиваются значения 
параметров, первоначально заданные текущему текстовому стилю в окне Text Style 
и, как правило, нуждающиеся в изменении.

�� В области Styles: отображается список текстовых стилей данного чертежа. 
Для изменения имени существующего текстового стиля необходимо уста-
новить курсор на его имя и щелкнуть левой кнопкой мыши, далее ввести 
необходимое изменение.

�� В области Font определяются следующие параметры шрифта:
•� в списке SHX Font: следует выбрать подходящий шрифт, определяющий 

форму текстовых символов (например, simplex.shx). В списке присут-
ствуют как откомпилированные SHX-шрифты AutoCAD, так и систем-
ные шрифты TrueType;

•� в списке Font Style: определяется начертание символов шрифта (курсив, 
полужирный или обычный);

•� флажок Use Big Font – использование большого шрифта (для азиатских 
языков). Опция доступна, только если основным является SHX-шрифт. 

Текстовые стили
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При этом список Font Style: заменяется на Big Font: и используется для 
выбора имени файла большого шрифта.

�� В области Size устанавливается изменение размера текста:
•� Annotative – указание, что текст является аннотативным;
•� Match text orientation to layout – ориентация текста в видовых экранах про-

странства листа совпадает с ориентацией в разметке листа;
•� Paper Text Height – задание высоты текста и определение размера знаков 

используемого шрифта. Если в процессе описания стиля задана фикси-
рованная высота текста, при создании однострочных надписей запрос 
Height: не выводится. Если планируется наносить надписи разной вы-
соты с использованием одного и того же текстового стиля, при его соз-
дании следует указать высоту 0.

�� В области Effects доступны следующие параметры:
•� Upside down – обеспечивает поворот текста на 180° сверху вниз симмет-

рично горизонтальной оси;
•� Backwards – обеспечивает поворот текста на 180° слева направо симмет-

рично вертикальной оси;
•� Vertical – обеспечивает вертикальное расположение текста, то есть сим-

волы выстраиваются один над другим;
•� в поле Width Factor: устанавливается степень сжатия/растяжения текста, 

то есть масштабный коэффициент;
•� в поле Oblique Angle: устанавливается угол наклона символов по от-

ношению к нормали, причем положительным считается угол наклона 
вправо – по часовой стрелке, а отрицательным – влево, против часовой 
стрелки. Максимально возможное значение данного параметра – 85°.

Сделанные изменения наглядно представлены в области предварительного 
просмотра слева, внизу диалогового окна.

В диалоговом окне Text Style имеется возможность изменять параметры уже су-
ществующих текстовых стилей. Изменение типа шрифта или ориентации текста 
в каком-либо стиле вызывает обновление всех текстовых объектов, использую-
щих его. Изменение высоты символов, коэффициента сжатия или угла наклона 
не влия ет на имеющиеся текстовые объекты и применяется только при создании 
новых надписей.

Однострочный.текст
Текстовые надписи, добавляемые в рисунок, несут различную информацию. Они 
могут представлять собой сложные спецификации, элементы основной надписи, 
заголовки. Кроме того, надписи могут быть полноправными элементами самого 
рисунка. Сравнительно короткие тексты, не требующие внутреннего форматиро-
вания, создаются с помощью команд DtEXt и tEXt и записываются в одну строку. 
Однострочный текст хорошо подходит для создания заголовков.
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Команда DtEXt, формирующая однострочный текст, позволяет соз-
давать одну или несколько строк текста, каждая из которых является 
отдельным объектом. Строки можно по отдельности перемещать, фор-
матировать или редактировать. Команда вызывается из падающего 
меню Dra → Text → Single Line Text или щелчком на пиктограмме Single 
Line в группе Annotation ленты Home, или в группе Text ленты Annotate 
(см. рис. 10.1, 10.2).

Команда DtEXt предназначена для создания набора строк, расположенных 
одна под другой. Переход к следующей строке производится нажатием клавиши 
Enter. Каждая строка представляет собой отдельный объект, который можно пере-
мещать и форматировать.

Запросы команды DtEXt:
Current text style: "Standard" Text height: 2.5000 Annotative: 

Yes – текущий текстовый стиль, высота текста и аннотативность
Specify start point of text or [Justify/Style]: – указать начальную 

точку текста
Specify height <default>: – указать высоту текста
Specify rotation angle of text <0>: – указать угол поворота текста
далее ввести текст.

Запрос для ввода текста осуществляется циклически. Для завершения работы 
команды следует нажать клавишу Enter после пустой строки.

Запрос определения высоты Specify height <default>: появляется только 
в том случае, если в описании текущего текстового стиля высота была задана рав-
ной нулю.

Высоту текста можно установить графическим способом. От точки вставки 
текста к указателю мыши в виде перекрестья протягивается «резиновая нить». 
Если нажать левую кнопку мыши, то высоте будет присвоено значение длины этой 
нити в момент нажатия.

При вводе символы отображаются на экране, но надпись еще не размещена 
окончательно. Если в процессе ввода текста указать точку в любой части рисунка, 
курсор перемещается в нее. После этого можно продолжать вводить текст. Фраг-
мент текста, набранный после указания точки, представляет собой самостоятель-
ный объект.

Ключи команды DtEXt:

�� Style – установить текущий стиль;
�� Justify – установить режим выравнивания текстовой строки с использо-

ванием ключей выравнивания. При этом выдаются следующие запросы:
Current text style: "Standard" Text height: 2.5000 Annotative: 
Yes – текущий текстовый стиль и высота текста
Specify start point of text or [Justify/Style]: J – переход в 
режим выравнивания текстовой строки

Однострочный текст
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Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]: – задать ключ

где:

�� Align – формирует вписанный текст, запрашивая его начальную и конеч-
ную точки. Высота и ширина каждого символа вычисляются автоматиче-
ски так, чтобы текст точно вписывался в заданную область. При этом вы-
даются следующие запросы:
Current text style: "Standard" Text height: 2.5000 Annotative: 
Yes – текущий текстовый стиль и высота текста
Specify start point of text or [Justify/Style]: J – переход в 
режим выравнивания текстовой строки
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]: A – переход в режим формирования вписанного текста
Specify first endpoint of text baseline: – указать первую конечную 
точку базовой линии текста
Specify second endpoint of text baseline: – указать вторую конеч-
ную точку базовой линии текста
далее ввести текст.

Для завершения работы команды нажать клавишу Enter после пустой 
строки или щелкнуть кнопкой мыши вне текста.

�� Fit – формирует вписанный текст, выровненный по ширине и высоте. За-
прашивает начальную и конечную точки текста, а также его высоту. При 
этом выдаются следующие запросы:
Current text style: "Standard" Text height: 2.5000 Annotative: 
Yes – текущий текстовый стиль и высота текста
Specify start point of text or [Justify/Style]: J – переход в 
режим выравнивания текстовой строки
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]: F – переход в режим формирования текста, вписанного по 
ширине и высоте
Specify first endpoint of text baseline: – указать первую конечную 
точку базовой линии текста
Specify second endpoint of text baseline: – указать вторую конеч-
ную точку базовой линии текста
Specify height <2.5000>: – указать высоту текста
далее ввести текст.

Для завершения работы команды нажать клавишу Enter после пустой 
строки или щелкнуть кнопкой мыши вне текста.

�� Center – обеспечивает центрирование базовой линии текстовой стро-
ки относительно заданной точки. При этом выдаются следующие за-
просы:



243

Current text style: "Standard" Text height: 2.5000 Annotative: 
Yes – текущий текстовый стиль и высота текста
Specify start point of text or [Justify/Style]: J – переход в 
режим выравнивания текстовой строки
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]: C – переход в режим формирования центрированного тек-
ста
Specify center point of text: – указать центральную точку текста
Specify height <2.5000>: – указать высоту текста
Specify rotation angle of text <0>: – указать угол поворота текста
далее ввести текст.

Для завершения работы команды нажать клавишу Enter после пустой 
строки или щелкнуть кнопкой мыши вне текста.

�� Middle – обеспечивает горизонтальное и вертикальное центрирование 
текстовой строки относительно заданной точки. Различие между данным 
ключом и ключом MC, о котором пойдет речь ниже, состоит в том, что ис-
пользуется не средняя точка между верхом и базовой линией, а середина 
воображаемой рамки, в которую заключена строка текста. Таким образом, 
разница видна при наличии символов, доходящих до нижней или верхней 
базовой линии. При этом выдаются следующие запросы:
Current text style: "Standard" Text height: 2.5000 Annotative: 
Yes – текущий текстовый стиль и высота текста
Specify start point of text or [Justify/Style]: J – переход в 
режим выравнивания текстовой строки
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]: M – переход в режим формирования текста, центрирован-
ного по горизонтали и вертикали
Specify middle point of text: – указать среднюю точку текста
Specify height <2.5000>: – указать высоту текста
Specify rotation angle of text <0>: – указать угол поворота текста
далее ввести текст.

Для завершения работы команды нажать клавишу Enter после пустой 
строки или щелкнуть кнопкой мыши вне текста.

�� Right – служит для выравнивания текстовой строки по правому краю. 
При этом выдаются следующие запросы:
Current text style: "Standard" Text height: 2.5000 Annotative: 
Yes – текущий текстовый стиль и высота текста
Specify start point of text or [Justify/Style]: J – переход в 
режим выравнивания текстовой строки
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]: R – переход в режим формирования текстовой строки, 
выровненной по правому краю

Однострочный текст
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Specify right endpoint of text baseline: – указать правую конеч-
ную точку базовой линии текста
Specify height <2.5000>: – указать высоту текста
Specify rotation angle of text <0>: – указать угол поворота
далее ввести текст.

Для завершения работы команды нажать клавишу Enter после пустой 
строки или щелкнуть кнопкой мыши вне текста.

�� TL – формирует текстовую строку, выровненную по верхнему и левому 
краям;

�� TC – формирует текстовую строку, выровненную по верхнему краю и цент-
рированную по горизонтали;

�� TR – формирует текстовую строку, выровненную по верхнему и правому 
краям;

�� ML – формирует текстовую строку, центрированную по вертикали и вы-
ровненную по левому краю;

�� MC – формирует текстовую строку, центрированную по вертикали и по го-
ризонтали относительно средней точки;

�� MR – формирует текстовую строку, центрированную по вертикали и вы-
ровненную по правому краю;

�� BL – формирует текстовую строку, выровненную по нижнему и левому 
краям;

�� BC – формирует текстовую строку, выровненную по нижнему краю и цент-
рированную по горизонтали;

�� BR – формирует текстовую строку, выровненную по нижнему и правому 
краям.

Формируя текстовую строку с помощью команды DtEXt, можно включать в 
нее специальные символы с помощью управляющих кодов, которые начинаются с 
двух знаков процента %%:

�� %%nnn – вставка символа с номером nnn;
�� %%o – включение/отключение зачеркивания;
�� %%u – включение/отключение подчеркивания;
�� %%d – вставка обозначения градуса (°);
�� %%p – вставка обозначения допуска (±);
�� %%c – вставка обозначения диаметра круга (∅);
�� %%%– вставка одного символа процента (%).

Для обозначения евро необходимо, удерживая клавишу Alt, ввести с клавиату-
ры последовательность цифр 0128.

Выполните упражнения T1–T7 из раздела 2.
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Многострочный.текст
Длинные сложные надписи оформляются как многострочный текст с помощью 
команды mtEXt.

Многострочный текст состоит из текстовых строк или абзацев, вписанных в 
указанную пользователем ширину абзаца. Количество строк не лимитировано. 
Весь многострочный текст представляет собой единый объект, который можно 
перемещать, поворачивать, стирать, копировать, зеркально отображать, растяги-
вать и масштабировать. Допускается форматирование отдельных слов и симво-
лов.

Возможности редактирования многострочного текста шире, чем однострочно-
го. Например, для многострочных надписей предусмотрены режимы подчеркива-
ния и надчеркивания выделенных фрагментов; также разрешено указывать для 
них отдельные шрифты, цвета, высоту символов и пр.

При вставке текста из другого приложения подготовки текстов, например из 
Microsoft Word, форматирование этого текста в значительной степени сохраня-
ется.

Команда mtEXt, формирующая многострочный текст, вызывается из 
падающего меню Draw → Text → Мultiline Text... или щелчком на пикто-
грамме Мultiline Text в группе Annotation ленты Home, или в группе Text 
ленты Annotate (см. рис. 10.1, 10.2).

Запросы команды mtEXt:
Current text style: "Standard" Text height: 10.0000 Annotative: 

Yes – текущий текстовый стиль и высота текста
Specify first corner: – указать первый угол окна абзаца
Specify opposite corner or [Height/Justify/Line spacing/Rotation/

Style/Width/Columns]: – указать противоположный угол окна абзаца или соот-
ветствующий ключ

Ключи команды mtEXt:

�� Height – высота;
�� Justify – выравнивание;
�� Line spacing – межстрочный интервал;
�� Rotation – поворот;
�� Style – стиль;
�� Width – ширина;
�� Columns – колонки текста.

После указания размеров абзаца загружается редактор многострочного текста, 
содержащий панель форматирования текста Text Formatting и контекстное меню 
(рис. 10.4).

Многострочный текст
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Рис. 10.4. Редактор многострочного текста

Лента Text Editor позволяет определить следующие параметры формата текста.

Группа инструментов Style:

Annotative – включение и отключение аннотативного режима для теку-
щего многострочного текстового объекта.

Style – список текстовых стилей, которые можно применить 
для многострочного текста. При этом соответственно изменя-
ется исходный формат символов – шрифт, высота и начерта-
ние. Выбор стиля не влияет на используемый стиль формати-
рования отдельных символов (полужирный, курсивный, 
дробный и т. д.). Если стиль, в котором задано вертикальное 
начертание, применяется к SHX-шрифту, то в редакторе текст 
будет выведен горизонтально. Стили, в которых задано обрат-
ное или перевернутое начертание символов текста, не приме-
няются. Текущий стиль запоминается в системной перемен-
ной TEXTSTYLE.

Text Height – установка высоты символов или ее изменение 
для выделенного фрагмента текста. Высота задается в еди-
ницах рисунка, причем для разных символов может быть 
разной. Если высота символов не определена в выбранном 
текстовом стиле, ее значение хранится в системной пере-
менной TEXTSIZE.

Mask  – загружает диалоговое окно Background Mask  (рис. 10.5), 
позволяю щее назначить скрытие заднего плана: Use background mask – 
скрывать задний план; Border offset factor: – коэффициент перекрытия; 
Fill Color – цвет заливки; Use drawning background color – использовать 
цвет фона чертежа.
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Рис. 10.5. Диалоговое окно скрытия заднего плана

Группа инструментов Formatting:

Match Text Formatting – применение форматирования выделенного тек-
ста для других символов. Для завершения форматирования необходи-
мо либо повторно нажать эту кнопку, либо нажать клавишу Esc.

Bold – включение и отключение полужирного начертания символов 
для нового или выделенного текста. Функция доступна только для 
символов, использующих шрифты TrueType.

Italic – включение и отключение курсивного начертания для нового 
или выделенного текста. Параметр доступен только для символов, ис-
пользующих шрифты TrueType.

Strikethrought – включение и отключение зачеркивания для нового или 
выделенного текста.

Underline – включение и отключение подчеркивания для нового или 
выделенного текста.

Overrline – включение и отключение надчеркивания для нового или вы-
деленного текста.

Stack – создание дробного текста, представляющего собой фрагменты 
текста одной строки, расположенные на разных уровнях относительно 
базовой линии строки и служащие для записи натуральных дробей, 
предельных отклонений размеров и т. д. Для указания места разбиения 
текста используются специальные символы:

�� косая черта (/) – для создания двухуровневого текста в виде обыкновен-
ной дроби, числитель и знаменатель которой располагаются друг над дру-
гом и разделяются горизонтальной чертой, длина которой соответствует 
длине наибольшей из выводимых друг над другом строк;

�� решетка (#) – для создания двухуровневого текста в виде обыкновенной 
дроби, числитель и знаменатель которой располагаются по диагонали и 
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разделяются косой чертой, длина которой зависит от высоты обеих раз-
деляемых строк;

�� крышка (^) – при создании двухуровневого текста для записи предельных 
отклонений, элементы которого располагаются один над другим без раз-
делительной черты.

Например, если после 1#3 ввести какой-либо нецифровой символ или пробел, 
средство автоформатирования разместит эти цифры в виде дроби с косой чертой. 
Кроме того, можно автоматически удалять незначащие пробелы перед целой и 
дробной частями числа.

Если был выделен дробный текст, нажатие кнопки Stack превращает его в обыч-
ный. При преобразовании обычного текста в дробный фрагмент, расположенный 
слева от специальных символов, выводится над частью, расположенной справа от 
них.

Средство автоформатирования преобразует числа в дробный текст только в том 
случае, если между цифрами и символом-разделителем (косой чертой, решеткой 
или крышкой) нет пробелов. Для преобразования в дробный вид произвольного 
фрагмента, содержащего символ-разделитель, этот фрагмент следует выделить, а 
затем нажать кнопку Stack.

При редактировании дробного текста можно изменять содержимое верхнего 
и нижнего элементов текста по отдельности, применять стандартные параметры 
или сохранять текущие значения параметров в качестве стандартных.

Superscript – превращение выделенного текста в надстрочный, немного 
меньшего размера и расположенного выше основного текста. 

Subscript – превращение выделенного текста в подстрочный, немного 
меньшего размера и расположенного ниже основного текста.

Change Case – изменение регистра: UPPERCASE – верхний регистр, 
lowercase – нижний регистр.

Font – установка шрифта для нового тек-
ста или изменение шрифта выделенного 

фрагмента. Шрифты TrueType упорядочиваются в списке по именам шрифто-
вых семейств. AutoCAD выводит список шрифтов SHX, упорядоченный по 
именам соответствующих им файлов.

Color – назначение цвета нового текста 
или изменение цвета выделенного фраг-
мента. Можно присваивать тексту цвет 

ByLayer, заданный для слоя, на котором он расположен, или цвет блока, в кото-
рый он входит, – ByBlock, а также задать любой из цветов, перечисленных в 
списке.
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Clear – очищение форматирования.

Oblique Angle – угол наклона, определяющий наклон символов вправо 
или влево. Положительный угол наклона определяет наклон символов 

вправо, а отрицательный – наклон символов влево. Значение угла наклона от-
считывается относительно перпендикуляра, проведенного к основанию стро-
ки, и может лежать в диапазоне от –85 до 85°.

Tracking – слежение, изменяющее межсимвольное расстояние. Для уве-
личения интервала используются значения, превышающие 1.0; для 

уменьшения – значения, меньшие 1.0.

Width Factor – степень сжатия, увеличивающая или уменьшающая шири-
ну выбранных символов. Например, значение 2 можно использовать 

для увеличения ширины символа вдвое, а значение 0.5 – для уменьшения ши-
рины вдвое.

Группа инструментов Paragraph:
Justification – загрузка контекстного меню, позволяющего осущест-
вить девять вариантов выравнивания текста: Top Left TL – вверх вле-
во, Top Center TC – вверх по центру, Top Right TR – вверх вправо, Middle 

Left ML – середина влево, Middle Center MC – середина по центру, Middle Right 
MR – середина вправо, Bottom Left BL – вниз влево, Bottom Center BC – вниз по 
центру, Bottom Right BR – вниз вправо.

Bullets and Numbering  – загрузка меню формирования нумерованного и 
маркированного списка:

•� Off – из выделенного текста, к которому применено форматирова-
ние списка, удаляются буквы, цифры и маркеры. Отступ не изме-
няется;

•� Numbered – форматирование нумерованного списка;
•� Lettered – форматирование списка, в котором для элементов исполь-

зуются буквы: Lowercase – нижнего регистра и Uppercase – верхнего 
регистра;

•� Bulleted – форматирование маркированного списка;
•� Start  – новая последовательность из букв или цифр в форматиро-

вании списка;
•� Continue – добавление выбранных абзацев в последний список и 

продолжение последовательности;
•� Allow Auto Bullets and Numbering – автоматическое форматирование 

списка при вводе текста;
•� Allow Bulletes and Lists – форматирование применяется ко всему 

обычному тексту, который похож на список, то есть начинается с 
буквы или цифры, после которых стоит знак препинания, и пр. 
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Line Spacing  – установка межстрочного расстояния.

Default – выравнивание текста по умолчанию.

Left – выравнивание текста по левому краю.

Center – выравнивание текста по центру.

Right – выравнивание текста по правому краю.

Justify – формирование вписанного текста.

Disribute – формирование разреженного текста.

Combine Paragraphs – слияние выбранных абзацев в один. При этом каждый 
знак абзаца автоматически заменяется пробелом.

Paragraph… – загружает одноименное диалоговое окно (рис. 10.6), позволяю-
щее назначить отступы и табуляции.

Рис. 10.6. Диалоговое окно определения отступов и табуляции
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Группа инструментов Insert:
Columns – загрузка контекстного меню, позволяющего настроить пара-
метры колонок текста:

•� No Columns – формирование текста в один столбец;
•� Dynamic Columns – режим динамических столбцов: Auto height – ав-

томатическая настройка высоты, Manual height – настройка высоты 
вручную;

•� Static Columns – режим статических столбцов. Задаются общая ши-
рина и высота текста и количество столбцов. При этом все столбцы 
имеют одну и ту же высоту и выровнены по обоим краям;

•� Insert Columns Break Alt+Enter – вставка разрыва столбца вручную;
•� Columns Settings… – загрузка одноименного диалогового окна для за-

дания параметров столбцов.

Symbol – загрузка меню, позволяющего осуществить вставку выбранно-
го в списке символа или неразрывного пробела в текущей позиции кур-
сора:

•� Degrees %%d – градус;
•� Plus/Minus %%p – плюс/минус;
•� Diameter %%c – диаметр;
•� Almost Equal \U+2248 – приближенно равно;
•� Angle \U+2220 – угол;
•� Boundary Line \U+E100 – линия раздела;
•� Center Line \U+2104 – осевая линия;
•� Delta \U+0394 – дельта;
•� Electrical Phase \U+0278 – фаза;
•� Flow Line \U+E101 – линия связи;
•� Identity \U+2261 – тождество;
•� Intial Length \U+E200 – исходная длина;
•� Monument Line \U+E102 – опорная линия;
•� Not Equal \U+2260 – не равно;
•� Ohm \U+2126 – Ом;
•� Omega \U03A9 – омега;
•� Property Line \U+214A – граница участка;
•� Subscript 2 \U+2082 – нижний индекс 2;
•� Squared \U+00B2 – квадратный;
•� Cubed \U+00B3 – кубический;
•� Non-breaking Space Ctrl+Shift+Space – неразрываемый пробел;
•� Other… – загрузка таблицы символов, в которой представлен весь на-

бор символов текущего шрифта. Для вставки нужно последователь-
но выделить один или несколько символов, нажать кнопку выбора, а 
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затем – копирования; при этом отмеченные символы копируются в 
буфер обмена. Далее необходимо в редакторе многострочного текста 
выбрать из контекстного меню пункт Paste.

Insert Field… Ctrl+F – загружает диалоговое окно вставки поля Field 
(рис. 10.7), содержащего следующие параметры: категории, имена и 
значения полей, список форматов, а также формулы для полей.

Рис. 10.7. Диалоговое окно вставки полей

Группа инструментов Spell Check:

Команда sPELL осуществляет проверку орфографических ошибок во 
всех видах текста в чертеже. Она вызывается из падающего меню 
Tools → Spelling… или щелчком на пиктограмме Spell Check. При этом 
загружается диалоговое окно Check Spelling.

Edit Dictionaries – загрузка диалогового окна настройки словарей 
Dictionaries.



253

Группа инструментов Tools:

Find and Replace… Ctrl+R – загружает одноименное диалоговое окно, 
позволяющее осуществить поиск фрагментов текста и заменить их 
новыми (рис. 10.8). При этом настраиваются следующие параметры.

•� В списке Find what: осуществляется задание текстовой строки, ко-
торую необходимо найти. 

•� В списке  Replace with: вводится фрагмент текста, которым следует 
заменить искомый фрагмент.

•� Кнопка Find Next – поиск указанного фрагмента текста.
•� Кнопка Replace – замена найденного фрагмента текста на указан-

ную.
•� Кнопка Replace All – замена всех найденных вхождений текста, и 

замена их на указанный фрагмент. 
•� Match case – поиск текста с учетом регистра.
•� Find whole words only – поиск только целых слов, соответствующих 

заданному тексту.
•� Use wildcards – использование подстановочных знаков при поиске.
•� Match diacritics – результаты поиска с учетом диакритических зна-

ков (языков, использующих латиницу).
•� Match half/full width forms (East Asian languages) – результаты поиска 

с учетом полуширинных и полноширинных символов в языках с 
письмом иероглифами.

Рис. 10.8. Диалоговое окно поиска текста

Import Text – загружает диалоговое окно Select Fiel, позволяющее выбрать файл 
для импорта текста. Для импорта следует выбрать файл в формате ASCII или 
RTF. Импортированный текст сохраняет исходные форматирование и свой-
ства, заданные стилем, однако его можно отредактировать и переформатиро-
вать. Объем файла с импортируемым текстом не должен превышать 32 Кбайт.
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AutoCAPS – преобразование вводимого и импортируемого текста в верхний ре-
гистр. Функция не влияет на уже набранный в редакторе текст. Для изменения 
регистра имеющегося текста следует выделить нужный фрагмент, щелкнуть 
правой кнопкой мыши и выбрать из контекстного меню пункт Change Case.

Группа инструментов Options:

More:

•� Character Set – набор символов (рис. 10.9): центральноевропейский, 
кириллический, иврит, арабский, балтийский, греческий, турецкий, 
вьетнамский, японский, корейский, китайский (GB2312), китай-
ский (BIG5), западный, тайский.

•� Editor Settings – настройка параметров редактора: Always Display as 
WYSIWYG – всегда как WYSIWYG; Show Toolbar – показать панель; 
Show Bacrground – показать фон; Text Highlight Color… – загрузка диа-
логового окна установки цвета Select Color для выделения текста.

•� Help F1 – вызов справочной системы.

Ruler – отображение линейки в верхней части окна редактора. При пе-
ретаскивании стрелок на концах линейки изменяется ширина много-
строчного текста.

Undo – отмена последней операции редактирования. Комбинация кла-
виш Ctrl+Z.

Redo – повторение последней операции редактирования. Комбинация 
клавиш Ctrl+Y.

Группа инструментов Close:

CloseText Editor – закрытие текстового редактора.

Команда tEXtEDit предназначена для редактирования текстов, в том 
числе размерных, определений атрибутов и допусков формы и распо-
ложения. Она вызывается из падающего меню Modify → Object → Text → 
Edit…. 

Команда sCALEtEXt осуществляет масштабирование текстовых объ-
ектов без изменения их расположения. Она вызывается из падающего 
меню Modify → Object → Text  Scale или щелчком на пиктограмме Scale в 
группе Text ленты Annotate. 

Команда JUstiFYtEXt изменяет точку выравнивания для выбранных 
текстовых объектов без изменения их положения. Она вызывается из 
падающего меню Modify → Objec → Text → Justify или щелчком на пикто-
грамме Justify в группе Text ленты Annotate. 
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Блок
Блоком называется совокупность связанных объектов рисунка, обрабатываемых 
как единый объект. Формирование часто используемых объектов может быть про-
изведено всего один раз. Затем они объединяются в блок и при построении чер-
тежа играют роль «строительных материалов». Применяя блоки, легко создавать 
фрагменты чертежей, которые будут неоднократно требоваться в работе. Блоки 
можно вставлять в рисунок с масштабированием и поворотом, расчленять их на 
составляющие объекты и редактировать, а также изменять описание блока. В по-
следнем случае AutoCAD обновляет все существующие вхождения блока и при-
меняет новое описание ко вновь вставляемым блокам.

Применение блоков упрощает процесс рисования. Их можно использовать, на-
пример, в следующих целях:

�� для создания стандартной библиотеки часто используемых символов, уз-
лов и деталей. После этого можно неограниченное число раз вставлять 
готовые блоки, вместо того чтобы каждый раз отрисовывать все их эле-
менты;

�� для быстрого и эффективного редактирования рисунков путем вставки, 
перемещения и копирования целых блоков, а не отдельных геометриче-
ских объектов;

�� для экономии дискового пространства путем адресации всех вхождений 
одного блока к одному и тому же описанию блока в базе данных рисунка.

Блок может содержать любое количество графических примитивов любого 
типа, а воспринимается AutoCAD как один графический примитив наравне с от-
резком, окружностью и т. д.

Блок может состоять из примитивов, созданных на разных слоях, разного цве-
та, с разными типами и весами линий. Все эти свойства примитивов сохраняются 
при объединении их в блок и при вставке блока в рисунок. Однако необходимо 
учесть следующее:

�� примитивы блока, созданные в специальном слое с именем 0, свойства ко-
торых определены как ByLayer, при вставке генерируются в текущем слое, 
наследуя его свойства;

�� примитивы блока, свойства которых определены как ByBlock, наследуют 
текущие значения;

�� свойства примитивов, заданные явно, сохраняются независимо от теку-
щих значений свойств.

Один блок может включать в себя другие. Если внутренний блок содержит при-
митивы, созданные в слое 0 или характеризуемые цветом и типом линии ByBlock, 
то эти примитивы «всплывают» наверх сквозь вложенную структуру блоков до 
тех пор, пока не попадут в блок с фиксированным слоем, цветом или типом линии, 
иначе они генерируются в слое 0.

Блок
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Блоку может быть присвоено имя. AutoCAD создает блоки без имени (аноним-
ные), например для ассоциативных размеров, то есть для примитивов, к которым 
не обеспечен прямой доступ пользователя.

Применение блоков позволяет значительно сэкономить память. При каждой 
новой вставке блока в рисунок AutoCAD добавляет к имеющейся информации 
лишь данные о месте вставки, масштабных коэффициентах и угле поворота.

С каждым блоком можно связать атрибуты, то есть текстовую информацию, 
которую разрешается изменять в процессе вставки блока в рисунок и которая мо-
жет изображаться на экране или оставаться невидимой.

При вставке блока на рисунке появляется так называемое вхождение блока. Во 
время каждой вставки блока задаются масштабные коэффициенты и угол его по-
ворота. Масштабные коэффициенты по осям X, Y, Z могут быть различными.

Использование блоков в AutoCAD значительно упрощает создание, редакти-
рование и сортировку объектов рисунка и связанной с ними информации.

Создание.блока
Описание блока можно создать различными способами:

�� сгруппировать объекты в текущем рисунке;
�� сохранить блок в отдельном файле;
�� создать файл с чертежом и вставлять его в качестве блока в другой чертеж;
�� добавлять функции динамического изменения в описание блока в теку-

щем чертеже с помощью редактора блоков, что позволяет манипулиро-
вать геометрией вхождения блока с помощью настраиваемых ручек или 
настраиваемых свойств;

�� создать файл с чертежом, имеющий несколько описаний логически родст-
венных блоков для использования в качестве библиотеки компонентов.

При создании описания блока задается базовая точка и выбираются объекты, 
входящие в блок. Кроме того, указывается, что происходит с исходными объек-
тами: остаются ли они, удаляются или преобразуются в блок в текущем рисунке. 
Есть возможность сопровождать создаваемый блок текстовым пояснением. Опи-
сания блоков представляют собой неграфические объекты, которые наряду с дру-
гими символами хранятся в файле рисунка.

Следует помнить, что имена DIRECT, LIGHT, AVE_RENDER, RM_SDB, SH_SPOT и 
OVERHEAD не могут быть использованы в качестве имен блоков.

Команда BLOCK формирует блок для использования его только в те-
кущем рисунке. Она вызывается из падающего меню Draw → Block → 
Make... или щелчком на пиктограмме Create Block в группе Block 
Definition ленты Insert рабочего пространства Drafting & Annotation 
(рис. 10.9). В результате открывается диалоговое окно Block 
Definition – рис. 10.10.
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Рис. 10.9. Инструмент создания блока

Рис. 10.10. Диалоговое окно описания блока

При создании описания блока в диалоговом окне Block Definition следует задать 
следующие параметры.

�� В поле Name: ввести уникальное имя создаваемого блока, которое может 
содержать до 255 символов и состоять из букв, цифр, пробелов и любых 
специальных символов, не используемых операционной системой.

Создание блока



Глава 10. Построение сложных объектов258

�� В области Base point задать координаты базовой точки вставки или нажать 
кнопку Pick point для выбора базовой точки с помощью мыши. При уста-
новленном флажке Specify On-screen – при закрытии диалогового окна бу-
дет выдан запрос для указания базовой точки на экране.

�� В области Objects выделить объекты и задать способ обработки выбранных 
объектов после создания описания блока:
•� Specify On-screen – при закрытии диалогового окна будет выдан запрос 

для выбора объектов на экране;
•� кнопка Select objects позволяет выделить объекты, входящие в блок. При 

этом диалоговое окно временно закрывается. По окончании выделения 
необходимо нажать клавишу Enter, и диалоговое окно откроется снова. 
Воспользовавшись кнопкой быстрого выбора QuickSelect, можно приме-
нять фильтры для выбора объектов;

•� Retain – выбранные объекты остаются в текущем рисунке в их исходном 
состоянии;

•� Convert to block – выбранные объекты заменяются вхождением блока.
•� Delete – после создания описания блока выбранные объекты удаляются.

�� В области Behavior – определяется режим работы блока:
•� Annotative – указывается на то, что блок является аннотативным;
•� Match block orientation to layout – осуществляет ориентацию блока на ви-

довых экранах по листу;
•� Scale uniformly – защищает вхождение блока от применения разного мас-

штаба;
•� Allow exploding – разрешает расчленение блока.

�� В области Settings – сделать следующие настройки:
•� в списке Block unit: – установить единицы вставки для вхождения блока: 

безразмерный, футы, дюймы, мили, миллиметры, сантиметры, метры, 
километры, микродюймы, милы, ярды, ангстремы, нанометры, микро-
ны, дециметры, декаметры, гектометры, гигаметры, астрономические, 
световые годы, пасеки;

•� кнопка Hyperlink… – загрузка диалогового окна вставки гиперссылки 
Insert Hyperlink, в котором можно связать гиперссылку с описанием соз-
даваемого блока.

�� В поле Description – ввести текстовые пояснения для облегчения иденти-
фикации и поиска блока впоследствии.

�� Open in block editor – открыть текущее определение блока в редакторе бло-
ков.

Описание блока сохраняется в текущем рисунке.

Для получения блоков, которыми можно воспользоваться при созда-
нии любых чертежей в AutoCAD, применяется команда wBLOCK. 
Она вызывается инструментом Write Block в группе Block Definition лен-
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ты Insert рабочего пространства Drafting & Annotation (см. рис. 10.9) и позволяет 
загрузить диалоговое окно записи блока на диск Write Block (рис. 10.11), где 
доступны следующие настройки.

Рис. 10.11. Диалоговое окно записи блока на диск

�� В области Source определяются источники данных:
•� Block: – блок, сохраняемый в отдельном файле;
•� Entire drawing – блоком становится весь рисунок;
•� Objects – сохранение выбранных объектов текущего чертежа без измене-

ний после записи их в файл.
�� В области Base point – определяются координаты базовой точки блока:
•� кнопка Pick point – указание базовой точки на рисунке;
•� поля X:, Y:, Z: – прямой ввод соответствующих координат базовой точки 

блока.
�� В области Objects – определяются объекты, вошедшие в блок:
•� кнопка Select objects – выбор объектов блока;
•� кнопка QuickSelect – быстрый выбор объектов блока с возможностью 

фильтрации набора объектов;
•� Retain – сохранение выбранных объектов текущего чертежа без измене-

ний после записи их в файл;

Создание блока
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•� Convert to block – преобразование выбранных объектов текущего чертежа 
в блок;

•� Delete from drawing – удаление выбранных объектов из текущего чертежа 
после записи их в файл.

�� В области Destination – определяются параметры размещения блока:
•� File name and path: – ввод имени и определение пути записи нового файла. 

Если выбран блок, то команда wBLOCK автоматически использует его 
имя для нового файла;

•� список Insert units: – выбор единиц измерения вставки, используемых в 
Центре управления AutoCAD.

Описание блока сохраняется в отдельном рисунке.

Выполните упражнение Bl1 из раздела 4.

Вставка.блока
Команда iNsERt осуществляет вставку в текущий чертеж предва-
рительно определенных блоков или существующих файлов рисун-
ков в качестве блока.

Команда iNsERt вызывается из падающего меню Insert → Block... или щелч-
ком на пиктограмме Insert в группе Block ленты Insert рабочего пространства 
Drafting & Annotation (см. рис. 10.9). При этом загружается диалоговое окно Insert 
(рис. 10.12), позволяющее настроить следующие параметры вставки блока.

�� В поле Name: указывается имя вставляемого блока.
�� Path: Locate using Geographic Data – вставка чертежа с использованием гео-

графических данных в качестве ссылки.
�� В области Insertion point определяется точка вставки блока.
�� В области Scale задается масштаб для вставки блока.
�� В области Rotation определяется угол поворота вставляемого блока в теку-

щей пользовательской системе координат.

Если флажки Specify On-screen установлены, то команда iNsERt выдает запро-
сы, необходимые для определения точки вставки, масштаба и угла поворота:

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate]: – указать 
точку вставки блока

Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: – 
указать коэффициент масштабирования по оси X

Enter Y scale factor <use X scale factor>: – указать коэффициент 
масштабирования по оси Y

Specify rotation angle <0>: – указать угол поворота блока
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Рис. 10.12. Диалоговое окно вставки блока

�� Флажок Uniform Scale – использование равных масштабов по всем трем 
направлениям осей.

�� В области Block Unit устанавливаются единицы блока:
•� Unit: – единицы измерения;
•� Factor: – коэффициент масштабирования.

�� Флажок Explode – разбить устанавливаемый блок на составляющие его 
объекты.

Следует учесть, что при указании коэффициента масштабирования может 
быть задано число или точка. Заданная точка вместе с точкой вставки определяют 
углы масштабного прямоугольника, таким образом определяя одновременно мас-
штаб по осям X и Y. Если ввести ключ Corner, будет выдан запрос:

Other corner: – указать точку, противоположную точке вставки угла мас-
штабного прямоугольника

При указании коэффициента масштабирования по оси Y по умолчанию при-
нимается значение, равное масштабу по оси Х. Если коэффициент масштабиро-
вания задан со знаком «минус», то осуществляется зеркальное отображение. При 
указании угла поворота точка включения является центром поворота. Если для 
установки угла поворота вводится точка, AutoCAD измеряет угол наклона линии 
от точки вставки до этой точки и использует его в качестве угла поворота. Чтобы 
угол поворота был кратен 90°, следует включить режим ORTHO.

Вставка блока
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При вставке одного рисунка в другой AutoCAD обрабатывает вставленный ри-
сунок так же, как и обычное вхождение блока.

Выполните упражнение In1 из раздела 4.

Разбиение.блока
Команда EXPLODE разбивает блок на составляющие его объекты.

Команда EXPLODE вызывается из падающего меню Modify → Explode.
При включении блока в чертеж AutoCAD обрабатывает его как графический 

примитив. Для обеспечения работы с его отдельными составляющими блок не-
обходимо разбить или «взорвать». Это можно сделать и в момент вставки его в 
рисунок, установив в диалоговом окне Insert флажок Explode (см. рис. 10.12).

Выполните упражнение Ep1 из раздела 4.

Динамический.блок
Для обеспечения регулировки состояния блока по месту его расположения соз-
даются динамические блоки. Они определяются путем указания настраиваемых 
свойств. Динамический блок должен содержать хотя бы один параметр и одну свя-
занную с ним операцию. Редактирование такого блока осуществляется в палитре 
свойств или с помощью ручек, которые автоматически добавляются при описании 
динамического блока.

Добавление параметров и операций осуществляется в редакторе блоков. При 
этом параметры определяют настраиваемые свойства и указывают положения, 
расстояния и углы для геометрии блока. Операции – способ перемещения или 
изменения геометрии динамического вхождения блока при его редактировании. 
Операции должны быть связаны с параметрами и геометрией.

Содержимое динамических блоков необходимо планировать перед их созда-
нием, при этом следует представлять, как должен выглядеть динамический блок и 
как он будет использоваться на чертеже.

Геометрия блока формируется в области рисования или в редакторе блоков. 
Можно также воспользоваться существующей геометрией на чертеже или описа-
нием ранее созданного блока. Необходимо соблюдать взаимосвязь параметров и 
операций в описании блока, а также взаимосвязь с геометрией внутри блока. Это 
обеспечивается настройкой правильных зависимостей.
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Редактор.блоков
Редактор блоков вызывается командой BEDit из падающего меню 
Tools → Block Editor или щелчком на пиктограмме Block Editor в группе 
Block Definition ленты Insert рабочего пространства Drafting & Annotation 
(см. рис. 10.9). При этом сначала загружается диалоговое окно ре-
дактирования описания блока Edit Block Definition (рис. 10.13), в кото-
ром следует выбрать имя создаваемого или редактируемого блока, а 
затем загружается лента редактора блоков Block Editor (рис. 10.14), 
которая содержит следующие инструменты.

Рис. 10.13. Диалоговое окно редактирования описания блока

Рис. 10.14. Редактор блоков в рабочем пространстве Drafting & Annotation

�� Группа Open/Save – инструменты открытия и сохранения блоков:

•� Edit Block – вызов диалогового окна Edit Block Definition 
(см. рис. 10.13) для изменения или создания описания блока;

•� Save Block – сохранение описания блока;

Редактор блоков
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•� Text Block – загрузка ленты тестирования блока;

•� Save Block As – сохранение блока под другим именем.

�� Группа Geometric – инструменты настройки геометрических зависимостей:

•� Auto Constrain – автоматическое наложение геометрических 
зависимостей на выбранные объекты;

•� Coincident – совпадение двух точек или принадлежность точки 
объекту или его продолжению;

•� Collinear – принадлежность двух линий одной и той же бесконеч-
ной линии;

•� Concentric – наличие общего центра у двух окружностей, дуг или 
эллипсов;

•� Fix – закрепление точки или кривой в определенном положении 
или ориентации относительно МСК;

•� Parallel – наличие у двух линий одинакового угла;

•� Perpendicular – сохранение угла в 90° между двумя линиями или 
сегментами полилинии;

•� Horizontal – параллельность линии или двух точек, расположен-
ных параллельно оси OX текущей ПСК;

•� Vertical – параллельность линии или двух точек, расположенных 
параллельно оси OY текущей ПСК;

•� Tangent – взаимное касание двух кривых или их продолжений;

•� Smooth – сохранение для сплайна непрерывности, обеспечиваю-
щей наличие плавной непрерывной кривой с другим сплайном, 
линией, дугой или полилинией;

•� Symmetric – симметричность двух кривых или точек на объектах 
относительно выбранной линии;

•� Equal – равенство длины двух сегментов полилинии или равен-
ство радиуса, дуг и окружности;

•� Show/Hide – отображение или скрытие геометрических зависи-
мостей для выбранных объектов;

•� Show All – отображение всех геометрических зависимостей в чер-
теже;

•� Hide All – скрытие всех геометрических зависимостей в чертеже;
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•� Constraint Settings – загрузка одноименного диалогового окна управле-
ния отображением типов зависимостей на панелях зависимостей.

�� Группа Dimensional – инструменты настройки размерных зависимостей:

•� Linear – создание зависимости горизонтальности или верти-
кальности и пользовательского свойства;

•� Horizontal – наложение зависимости на расстояние отрезка по 
оси X или между двумя точками на разных объектах;

•� Vertical – наложение зависимости на расстояние отрезка по оси 
Y или между двумя точками на разных объектах;

•� Aligned – наложение зависимости на длину отрезка или на рас-
стояние между двумя отрезками, точкой на объекте и отрезком 
между двумя точками на различных объектах;

•� Radius – наложение зависимости по радиусу на окружность 
или дугу;

•� Diameter – наложение зависимости на диаметр окружности или 
дуги;

•� Angular – наложение зависимости на угол между двумя отрез-
ками или сегментами полилинии;

•� Convert – преобразование размерной зависимости в параметр 
зависимости;

•� Block Table – создание таблицы свойств блоков и ручки;

•� Constraint Settings – загрузка одноименного диалогового окна определе-
ния стандартных режимов поведения при отображении размерных за-
висимостей.

�� Группа Manage – инструменты управления параметрами редактора блоков:

•� Delete – удаление всех геометрических и размерных зависимо-
стей из выбранных объектов;

•� Construction – преобразование объектов во вспомогательную 
геометрию;

•� Constraint Status – включение/отключение статуса отображения 
зависимостей и управление раскрашиванием объектов на ос-
нове их уровня зависимости;

•� Parameters Manager – отображение или скрытие Диспетчера па-
раметров;

Редактор блоков
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•� Block Authoring Palette – открытие или закрытие Палитры вариа-
ций блоков;

•� Block Editor – загрузка диалогового окна управления параметрами редак-
тора блоков Block Editor Settings.

�� Группа Action Parameters – инструменты настройки параметров операций:

•� Point – добавление точечного параметра определения пользова-
тельских свойств X и Y для вхождения блока;

•� Linear – добавление линейного параметра расстояния между 
двумя ключевыми точками в определении блока;

•� Polar – добавление полярного параметра определения расстоя-
ния и угла для двух ключевых точек в определении блока;

•� XY – добавление параметра расстояния по оси X и Y от базовой 
точки определения блока;

•� Rotation – добавление параметра угла поворота для вхождения 
блока;

•� Flip – добавление параметра зеркального отражения объектов 
или всего вхождения блока относительно линии отражения;

•� Alignment – добавление параметра поворота вхождения блока 
относительно точки с целью его выравнивания с другими объ-
ектами в чертеже;

•� Visibility – добавление параметра видимости объектов, которые 
отображаются или не отображаются в определении блока;

•� Lookup – добавление пользовательских параметров, заданных в 
таблице выбора;

•� Basepoint – добавление изменяемой базовой точки для вхожде-
ния динамического блока относительно геометрии в блоке;

•� Move – перемещение набора объектов при выполнении опера-
ции во вхождении динамического блока;

•� Stretch – растяжение набора объектов при выполнении опера-
ции во вхождении динамического блока;

•� Polar Stretch – растяжение набора объектов при выполнении 
операции во вхождении динамического блока;
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•� Scale – масштабирование набора объектов относительно опре-
деленной базовой точки при выполнении операции во вхожде-
нии динамического блока;

•� Rotate – поворот набора объектов при выполнении операции во 
вхождении динамического блока;

•� Flip – отражение набора объектов относительно оси симметрии 
(линии отражения), определяемой параметром отражения, 
когда данная операция запускается во вхождении блока;

•� Array – создание массива набора объектов при выполнении опе-
рации во вхождении динамического блока;

•� Lookup – при выполнении операции выбора осуществляется 
вывод диалогового окна создания таблицы выбора для вхожде-
ния блока;

•� Attribute Definition – загрузка одноименного диалогового окна 
определения атрибутов (рис. 10.15), позволяющего настроить 
следующие параметры:
◊� в области Mode устанавливаются режимы: Invisible – скрытый, 

Constant – постоянный, Verify – контролируемый, Preset – 
установленный, Lock position – фиксированное положение, 
Multiple lines – несколько строк;

◊� в области Insertion Point определяется точка вставки: Specify 
оn-screen – указать точку вставки на экране; X:, Y:, Z: – коор-
динаты по соответствующим осям;

◊� в области Attribute описывается атрибут: Tag: – имя; Prompt: – 
подсказка; Default: – значение; кнопка Insert field – загрузка 
диалогового окна Field, позволяющего осуществить вставку 
поля;

◊� в области Text Settings определяются параметры текста: 
Justification: – выравнивание (Left – влево; Align – вписать; 
Fit – по ширине; Center – по центру; Middle – по середине; 
Right – вправо; Top left – вверх влево; Top center – вверх по 
центру; Top right – вверх вправо; Middle left – середина вле-
во; Middle center – середина по центру; Middle right – середина 
вправо; Bottom left – вниз влево; Bottom center – вниз по цент-
ру; Bottom right – вниз вправо); Text style: – текстовый стиль; 
Annotative – аннотативный; Text height: – высота; Rotation: – 
угол поворота; Boundary width: – ширина рамки;

◊� Align below previous attribute definition – выровнять по предыду-
щему атрибуту;

Редактор блоков
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Рис. 10.15. Диалоговое окно описания атрибута

•� Show All Actions – показать все операции;

•� Hide All Actions – скрыть все операции.

�� Группа Visibility – инструменты настройки параметров видимости:

•� Visibility States – загрузка диалогового окна управления состоя-
нием видимости Visibility States;

•� Visiblity Mode – управление режимом отображения объектов, не-
видимых для текущего состояния видимости;

•� Make Visible – сделать объекты видимыми;

•� Make Invisible – сделать объекты невидимыми.

•� Close – закрыть редактор блоков.
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Палитры.вариаций.блоков
Загрузка палитр вариаций блоков Block Authoring Palettes осуществ-
ляется из редактора блоков щелчком на инструменте Authoring 
Palettes. Палитры содержат следующие вкладки.

Вкладка Parameters включает набор инструментов 
для определения параметров (рис. 10.16).

Point – создание параметра точки. За-
просы команды BPARAmEtER с клю-
чом pOint:

Specify parameter location or 
[Name/Label/Chain/Description/
Palette]: – указать местоположение 
параметра или один из ключей: имя, 
метка, цепочка, описание, палитра
Specify label location: – указать 
положение метки

Linear – создание линейного параметра. 
Запросы команды BPARAmEtER с 
ключом Linear:

Specify start point or [Name/Label/
Chain/Description/Base/Palette/
Value set]: – указать начальную точку 
или один из ключей: имя, метка, цепочка, 
описание, база, палитра, набор значений
Specify endpoint: – указать конеч-
ную точку
Specify label location: – указать 
положение метки

Polar – создание полярного параметра. Запросы команды 
BPARAmEtER с ключом Polar:

Specify base point or [Name/Label/Chain/Description/Palette/
Value set]: – указать базовую точку или один из ключей: имя, метка, 
цепочка, описание, палитра, набор значений
Specify endpoint: – указать конечную точку
Specify label location: – указать положение метки

XY – создание параметра XY. Запросы команды BPARAmEtER с 
ключом Xy:

Рис. 10.16. Закладка 
параметров палитры 

вариаций блоков
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Specify base point or [Name/Label/Chain/Description/Palette/
Value set]: – указать базовую точку или один из ключей: имя, метка, 
цепочка, описание, палитра, набор значений
Specify endpoint: – указать конечную точку

Rotation – создание параметра поворота. Запросы команды 
BPARAmEtER с ключом Rotation:

Specify base point or [Name/Label/Chain/Description/Palette/
Value set]: – указать базовую точку или один из ключей: имя, мет-
ка, цепочка, описание, палитра, набор значений
Specify radius of parameter: – указать радиус параметра
Specify default rotation angle or [Base angle] <0>: – ука-
зать угол поворота по умолчанию или базовый угол
Specify label location: – указать положение метки

Alignment – создание параметра выравнивания. Запросы команды 
BPARAmEtER с ключом Alignment:

Specify base point of alignment or [Name]: – указать базовую 
точку выравнивания или имя
Alignment type = Perpendicular – тип выравнивания = нормаль
Specify alignment direction or alignment type [Type] <Type>: – 
указать направление выравнивания или тип выравнивания

Flip – создание параметра отражения. Запросы команды 
BPARAmEtER с ключом Flip:

Specify base point of reflection line or [Name/Label/
Description/Palette]: – указать базовую точку линии отражения 
или один из ключей: имя, метка, описание, палитра
Specify endpoint of reflection line: – указать конечную точку 
линии отражения
Specify label location: – указать положение метки

Visibility – создание параметра видимости. Запросы команды 
BPARAmEtER с ключом Visibility:

Specify parameter location or [Name/Label/Description/
Palette]: – указать местоположение параметра или один из клю-
чей: имя, метка, описание, палитра

Lookup – создание параметра выбора. Запросы команды 
BPARAmEtER с ключом looKup:

Specify parameter location or [Name/Label/Description/
Palette]: – указать местоположение параметра или один из клю-
чей: имя, метка, описание, палитра
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Basepoint – создание параметра базовой точки. Запросы команды 
BPARAmEtER с ключом Base:

Specify parameter location: – указать местоположение параметра

Закладка Actions – включает набор инструментов для определения операций 
(рис. 10.17).

Move – создание операции перемеще-
ния. Запросы команды BACtiONtOOL 
с ключом Move:

Select parameter: – выбрать пара-
метр
Specify parameter point to 
associate with action or enter 
[Base point/Second point/Xcorner/
Ycorner] <Base>: – указать точку па-
раметра, которую необходимо связать с 
операцией, или ввести ключ: начальная 
точка, вторая точка
Specify selection set for action – 
указать набор объектов для операции
Select objects: – выбрать объекты
Select objects: – выбрать объекты 
или нажать Enter при завершении вы-
бора
Specify action location or 
[Multiplier/Offset/Xy]: – указать 
местоположение операции или ввести 
ключ: множитель, сместить

Scale – создание операции масштаби-
рования. Запросы команды BACtiONtOOL с ключом Scale:

Select parameter: – выбрать параметр
Specify selection set for action – указать набор объектов для 
операции
Select objects: – выбрать объекты
Select objects: – выбрать объекты или нажать Enter при заверше-
нии выбора
Specify action location or [Base type]: – указать местополо-
жение операции или тип базы

Stretch – создание операции растягивания. Запросы команды 
BACtiONtOOL с ключом sTretch:

Select parameter: – выбрать параметр

Рис. 10.17. Закладка 
операций палитры  
вариаций блоков

Палитры вариаций блоков
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Specify parameter point to associate with action or enter 
[sTart point/Second point] <Start>: – указать точку парамет-
ра, которую необходимо связать с операцией, или ввести один из 
ключей: начальная точка, вторая точка
Specify first corner of stretch frame or [CPolygon]: – ука-
зать первый угол рамки растягивания или многоугольник
Specify opposite corner: – указать противоположный угол
Specify objects to stretch – указать объекты для растяжения
Select objects: – выбрать объекты
Select objects: – выбрать объекты или нажать Enter при заверше-
нии выбора
Specify action location or [Multiplier/Offset]: – указать 
местоположение операции или ключи: множитель, сместить

Polar Stretch – создание операции полярного растягивания. Запросы 
команды BACtiONtOOL с ключом Polar stretch:

Select parameter: – выбрать параметр
Specify parameter point to associate with action or enter 
[sTart point/Second point] <Start>: – указать точку парамет-
ра, которую необходимо связать с операцией, или ввести один из 
ключей: начальная точка, вторая точка
Specify first corner of stretch frame or [CPolygon]: – ука-
зать первый угол рамки растягивания или многоугольник
Specify opposite corner: – указать противоположный угол
Specify objects to stretch – указать объекты для растяжения
Select objects: – выбрать объекты
Select objects: – выбрать объекты или нажать Enter при заверше-
нии выбора
Specify objects to rotate only – указать только для поворота
Select objects: – выбрать объекты
Select objects: – выбрать объекты или нажать Enter при заверше-
нии выбора
Specify action location or [Multiplier/Offset]: – указать 
местоположение операции или ключи: множитель, сместить

Rotate – создание операции поворота. Запросы команды 
BACtiONtOOL с ключом Rotate:

Select parameter: – выбрать параметр
Specify selection set for action – указать набор объектов для 
операции
Select objects: – выбрать объекты
Select objects: – выбрать объекты или нажать Enter при заверше-
нии выбора
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Specify action location or [Base type]: – указать местополо-
жение операции или тип базы

Flip – создание операции отражения. Запросы команды 
BACtiONtOOL с ключом Flip:

Select parameter: – выбрать параметр
Specify selection set for action – указать набор объектов для 
операции
Select objects: – выбрать объекты
Select objects: – выбрать объекты или нажать Enter при заверше-
нии выбора
Specify action location: – указать местоположение операции

Array – создание операции с массивом. Запросы команды 
BACtiONtOOL с ключом Array:

Select parameter: – выбрать параметр
Specify selection set for action – указать набор объектов для 
операции
Select objects: – выбрать объекты
Select objects: – выбрать объекты или нажать Enter при заверше-
нии выбора
Enter the distance between columns (|||): – ввести расстоя-
ние между столбцами
Specify action location: – указать местоположение операции

Lookup – создание операции поиска. Запросы команды 
BACtiONtOOL с ключом Lookup:

Select parameter: – выбрать параметр
Specify selection set for action – указать набор объектов для 
операции

Block Properties Table – загрузка таблицы выбора свойств блока.

Вкладка Parameter Sets включает набор инструментов для определения парамет-
ров (рис. 10.18).

Point Move – перемещение точки: создание параметра точки с одной 
декартовой ручкой, связанной с операцией перемещения. Запросы 
команды BPARAmEtER с ключом pOint:

Specify parameter location or [Name/Label/Chain/Descrip-
tion/Palette]: – указать местоположение параметра или один из 
ключей: имя, метка, цепочка, описание, палитра

Палитры вариаций блоков
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Specify label location: – указать 
положение метки

Linear Move – линейное перемещение: 
создание линейного параметра с одной 
линейной ручкой, связанной с опера-
цией перемещения. Запросы команды 
BPARAmEtER с ключом Linear:

Specify start point or [Name/La-
bel/Chain/Description/Base/Pal-
ette/Value set]: – указать началь-
ную точку или один из ключей: имя, 
метка, цепочка, описание, база, палит-
ра, набор значений
Specify endpoint: – указать конеч-
ную точку
Specify label location: – указать 
положение метки

Linear Stretch – линейное растяжение: соз-
дание линейного параметра с одной ли-
нейной ручкой, связанной с операцией 
растягивания. Запросы команды 
BPARAmEtER с ключом Linear анало-
гичны запросам инструмента Linear Move.

Linear Array – линейный массив: создание 
линейного параметра с одной линейной 
ручкой, связанной с операцией с масси-
вом. Запросы команды BPARAmEtER с 
ключом Linear аналогичны запросам 
инструмента Linear Move.

Linear Move Pair – пара линейных пере-
мещений: создание линейного парамет-
ра с двумя линейными ручками, свя-
занными с операцией перемещения. 
Запросы команды BPARAmEtER с 
ключом Linear аналогичны запросам 
инструмента Linear Move.

Linear Stretch Pair – пара линейных рас-
тяжений: создание линейного парамет-
ра с двумя линейными ручками, связан-

Рис. 10.18. Вкладка 
наборов параметров 

палитры вариаций блоков
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ными с операцией перемещения на обоих концах. Запросы команды 
BPARAmEtER с ключом Linear аналогичны запросам инструмента Linear Move.

Polar Move – полярное перемещение: создание полярного параметра с 
одной полярной ручкой, связанной с операцией перемещения. За-
просы команды BPARAmEtER с ключом Polar:
Specify base point or [Name/Label/Chain/Description/Palette/
Value set]: – указать базовую точку или один из ключей: имя, метка, 
цепочка, описание, палитра, набор значений
Specify endpoint: – указать конечную точку
Specify label location: – указать положение метки

Polar Stretch – полярное растяжение: создание полярного параметра с 
одной полярной ручкой, связанной с операцией растягивания. За-
просы команды BPARAmEtER с ключом Polar аналогичны запро-
сам инструмента Polar Move.

Polar Array – круговой массив: создание полярного параметра с одной 
полярной ручкой, связанной с операцией с массивом. Запросы ко-
манды BPARAmEtER с ключом Polar аналогичны запросам инстру-
мента Polar Move.

Polar Move Pair – пара полярных перемещений: создание полярного 
параметра с двумя полярными ручками, связанными с операцией 
перемещения. Запросы команды BPARAmEtER с ключом Polar 
аналогичны запросам инструмента Polar Move.

Polar Stretch Pair – пара полярных растяжений: создание полярного 
параметра с двумя полярными ручками, связанными с операцией 
растягивания на каждом конце. Запросы команды BPARAmEtER с 
ключом Polar аналогичны запросам инструмента Polar Move.

XY Move – перемещение XY: создание параметра XY с одной декарто-
вой ручкой, связанной с операцией перемещения. Запросы команды 
BPARAmEtER с ключом Xy:

Specify base point or [Name/Label/Chain/Description/Pal-
ette/Value set]: – указать базовую точку или один из ключей: 
имя, метка, цепочка, описание, палитра, набор значений
Specify endpoint: – указать конечную точку

XY Move Pair – пара перемещений XY: создание параметра XY с двумя 
декартовыми ручками, связанными с операцией перемещения. За-
просы команды BPARAmEtER с ключом Xy аналогичны запросам 
инструмента XY Move.

Палитры вариаций блоков
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XY Move Box Set – управляющая группа произвольного перемещения 
XY: создание параметра XY с четырьмя декартовыми ручками, свя-
занными с операцией перемещения. Запросы команды BPARAmEtER 
с ключом Xy аналогичны запросам инструмента XY Move.

XY Stretch Box Set – набор рамок растяжения XY: создание параметра 
XY с четырьмя декартовыми ручками, связанными с операцией рас-
тягивания в каждом углу. Запросы команды BPARAmEtER с клю-
чом Xy аналогичны запросам инструмента XY Move.

XY Array Box Set – управляющая группа прямоугольного массива XY: 
создание параметра XY с четырьмя декартовыми ручками, связан-
ными с операцией с массивом. Запросы команды BPARAmEtER с 
ключом Xy аналогичны запросам инструмента XY Move.

Rotation Set – управляющая группа поворота: создание параметра по-
ворота с одной ручкой поворота, связанной с операцией поворота. 
Запросы команды BPARAmEtER с ключом Rotation:
Specify base point or [Name/Label/Chain/Description/Palette/
Value set]: – указать базовую точку или один из ключей: имя, метка, 
цепочка, описание, палитра, набор значений
Specify radius of parameter: – указать радиус параметра
Specify default rotation angle or [Base angle] <0>: – ука-
зать угол поворота по умолчанию или базовый угол
Specify label location: – указать положение метки

Flip Set – набор отражения: создание параметра отражения с одной 
ручкой отражения, связанной с операцией отражения. Запросы ко-
манды BPARAmEtER с ключом Flip:
Specify base point of reflection line or [Name/Label/
Description/Palette]: – указать базовую точку линии отражения 
или один из ключей: имя, метка, описание, палитра
Specify endpoint of reflection line: – указать конечную точку 
линии отражения
Specify label location: – указать положение метки

Visibility Set – управляющая группа видимости: создание параметра 
видимости с одной ручкой выбора (операция предполагается). За-
просы команды BPARAmEtER с ключом Visibility:
Specify parameter location or [Name/Label/Description/
Palette]: – указать местоположение параметра или один из клю-
чей: имя, метка, описание, палитра

Lookup Set – управляющая группа выбора: создание параметра вы-
бора с одной ручкой выбора, связанной с операцией поиска. Запро-
сы команды BPARAmEtER с ключом looKup:
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Specify parameter location or [Name/Label/Description/
Palette]: – указать местоположение параметра или один из клю-
чей: имя, метка, описание, палитра

Вкладка Constrants включает набор инструментов для определения зависимо-
стей.

Атрибуты.блока
Атрибут блока представляет собой некое подобие метки или ярлыка, используе-
мых для связывания с блоком текстовой строки или каких-либо иных данных. 
В процессе вставки блока с переменными атрибутами AutoCAD предлагает ввес-
ти значение атрибута, которое затем сохраняется вместе с блоком. Примерами 
данных атрибутов могут служить номера деталей, технические требования, стои-
мость, комментарии, фамилии владельцев и т. п.

Можно экспортировать информацию, хранящуюся в атрибутах рисунка, с це-
лью последующего использования в электронных таблицах или базах данных для 
генерации документов типа спецификаций или ведомостей материалов. С одним 
блоком допускается связывать несколько атрибутов, имена которых различаются.

Атрибуты могут быть скрытыми. Скрытый атрибут не виден ни на экране мо-
нитора, ни на вычерченном рисунке. Несмотря на это, данные такого атрибута хра-
нятся в файле чертежа и извлекаются по мере необходимости.

При формировании атрибута вначале создается описание, в которое заносятся 
его характеристики.

Команда AttDEF создает описание атрибута. Она вызывается 
щелчком на пиктограмме Define Attribute в группе Block Definition лен-
ты Insert в рабочем пространстве Drafting & Annotation и загружает 

диалоговое окно Attribute Definition, показанное на рис. 10.15. Здесь необходимо 
определить имя атрибута, подсказку, значение по умолчанию, форматирова-
ние текста, расположение атрибута и при желании – его необязательные ха-
рактеристики: скрытый, постоянный, контролируемый и установленный, а 
также другие параметры в следующих областях.

�� В области Mode доступна настройка четырех режимов атрибута:
•� Invisible – скрытый режим. При вставке блока значение атрибута не 

отобра жается на рисунке и не выводится на печать. Его можно отменить 
с помощью команды AttDisP;

•� Constant – постоянный режим. Атрибут имеет фиксированное значение 
для всех вхождений блока;

•� Verify – контролируемый режим, позволяющий проверять правильность 
значения атрибута во время вставки;

•� Preset – установленный режим, позволяющий создавать атрибуты, зна-
чения которых не запрашиваются при вставке блока, но могут быть из-

Атрибуты блока
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менены. Основная цель режима – уменьшить количество запросов. По-
этому включать его не имеет смысла, если для ввода значений атрибутов 
используется диалоговое окно Attribute Definition;

•� Lock position – фиксированное положение атрибута внутри вхождения 
блока. При отмене фиксации атрибута его можно перемещать относи-
тельно остальной части блока с помощью ручек редактирования; 

•� Multiple lines – многострочный режим, при котором значение атрибута 
может содержать несколько строк текста.

Значения текущих режимов атрибутов для команды AttDEF по умолчанию 
можно установить с помощью системной переменной AFLAGS.

�� Область Attribute позволяет задать данные атрибута – текстовую инфор-
мацию:
•� Tag: – имя атрибута, используемое для идентификации каждого вхож-

дения атрибута в рисунок. Имя не может быть пустым и содержать про-
белов. Строчные буквы в нем автоматически переводятся в прописные;

•� Prompt: – текст подсказки, которая выдается при запросе значения атри-
бута во время вставки блока. Если нажатием клавиши Enter введена пус-
тая строка, то в качестве текста подсказки используется имя атрибута. 
Если атрибуту назначено свойство Constant, текстовое поле Prompt: ста-
новится недоступным;

•� Default: – определяет значение атрибута по умолчанию. Это поле может 
быть пустым;

•� кнопка Insert field – загружает диалоговое окно вставки поля Field.

Если подсказка Prompt: или параметр Value: должны начинаться с пробела, то 
первым символом набираемой строки должна быть обратная косая черта (\). 
Если же первый символ подсказки или значения атрибута – обратная косая 
черта, то вводимый в поле текст должен начинаться двумя обратными косыми 
чертами (\\).

�� Область Insertion point позволяет задать координаты точки вставки в рисун-
ке с помощью мыши, для чего следует включить флажок Specify оn-screen.

�� При выборе выравнивания по предыдущему атрибуту Align below previous 
attribute definition имя атрибута автоматически помещается под предыду-
щим определением атрибута, если таковой есть, в противном случае пара-
метр остается недоступным.

�� В области Text Settings определяются параметры текста:
•� Justification: – выравнивание;
•� Text style: – текстовый стиль;
•� Annotative – аннотативность атрибута;
•� Text Height: – указание высоты текста атрибута;
•� Rotation: – указание угла поворота текста атрибута;
•� Boundary width: – ширина рамки. Если длина строки текста в многостроч-
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ном атрибуте превышает заданную, то выполняется перенос на следую-
щую строку.

После того как атрибут создан, его можно включать в набор объектов при соз-
дании описания блока. Связывание атрибутов с блоками производится и в случае 
переопределения блоков. В ответ на запрос AutoCAD о выборе объектов, включае-
мых в блок, следует включить в набор не только геометрические объекты самого 
блока, но и необходимые атрибуты. Порядок выбора атрибутов определяет поря-
док следования запросов на ввод их значений при вставке блока.

Если описание атрибута включено в блок, то при вставке блока AutoCAD пред-
лагает ввести значение атрибута, используя как подсказку указанную в описании 
текстовую строку, за которой последуют запросы о значениях определенных атри-
бутов:

Enter attribute values – ввести значения атрибутов

Значения атрибута для разных вхождений блока могут различаться.
Запросы значений атрибутов можно подавить, приравняв системную пере-

менную ATTREQ, сохраняющуюся вместе с рисунком, нулю. При этом значениями 
атрибутов автоматически становятся их значения по умолчанию или «пусто».

Имеется возможность создания отдельных атрибутов, не связанных с блоками. 
Если сохранить рисунок, где имеются такие атрибуты, то при выполнении встав-
ки этого рисунка в другой рисунок AutoCAD выдаст запросы на ввод значений 
атрибутов.

Атрибуты, связанные с вставленными в рисунок блоками, можно редактиро-
вать.

Команда AttEDit, позволяющая редактировать описание атрибута, загружа-
ет диалоговое окно Edit Attributes, показанное на рис. 10.19. Здесь можно изменять 
характеристики атрибутов, за исключением таких, как положение, высота или гар-
нитура шрифта. 

Запрос команды AttEDit:

Select block reference: – выбрать вхождение блока

Команда EAttEDit вызывается щелчком на пиктограмме Edit 
Attribute в группе Block ленты Insert, в рабочем пространстве 
Drafting & Annotation и загружает диалоговое окно редактирования 
атрибутов блоков Enhanced Attribute Editor, которое содержит следую-
щие вкладки.

�� Вкладка Attribute отображает атрибуты блока (рис. 10.20):
•� Block: – имя блока;
•� Tag: – атрибут;
•� Prompt – подсказку;
•� Value – значение атрибута;
•� кнопка Select block позволяет выбрать блок.

Атрибуты блока
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Рис. 10.19. Диалоговое окно редактирования атрибутов

Рис. 10.20. Диалоговое окно редактора атрибутов блоков

�� Вкладка Text Options дает возможность редактировать параметры текста 
(рис. 10.21):

•� Text Style: – текстовый стиль;
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•� Justification: – выравнивание;
•� Height: – высота;
•� Rotation: – поворот;
•� Backwards – справа налево;
•� Upside down – перевернутый;
•� Width Factor: – степень растяжения;
•� Oblique Angle – угол наклона;
•� Annotative – аннотативность атрибута;
•� Boundary width: – ширина рамки.

Рис. 10.21. Диалоговое окно редактирования параметров текста атрибутов блока

�� Вкладка Properties осуществляет редактирование следующих свойств 
атрибута (рис. 10.22):

•� Layer: – слой;
•� Linetype: – тип линий;
•� Color: – цвет;
•� Lineweight: – вес линий;
•� Plot style: – стиль печати.

Команда EAttEDit позволяет переопределить блок и изменить атрибуты. Вы-
дает следующие запросы:

Enter name of the block you wish to redefine: – указать имя переопре-
деляемого блока

Select objects for new Block... – выбрать объекты для нового блока
Select objects: – выбрать объекты

Атрибуты блока
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Рис. 10.22. Диалоговое окно редактирования свойств атрибутов блока

Команда BAttmAN управляет описаниями атрибутов в блоках те-
кущего рисунка. Эти описания можно редактировать, удалять атри-
буты из блоков и изменять порядок, согласно которому запрашива-
ются значения атрибутов при вставке блока. Команда вызывается 
щелчком на пиктограмме Manage Attributes в группе Block Definition 
ленты Insert в рабочем пространстве Drafting & Annotation.

Команда загружает Диспетчер атрибутов блоков Block Attribute Manager 
(рис. 10.23). Здесь отображается список атрибутов выбранного блока. По 
умолчанию в список включены имя атрибута, подсказка, значение по умол-
чанию, а также режимы вставки и отображения атрибута. С помощью кнопки 
Settings... можно задать свойства атрибута, которые должны быть показаны 
в списке. Нажатие кнопки Edit... загружает диалоговое окно редактирования 
атрибута Edit Attribute.

Рис. 10.23. Диалоговое окно диспетчера атрибутов блоков



283

Допускается извлечение данных из рисунка с помощью команды 
DAtAEXtRACtiON, которая загружает Мастер извлечения данных 
Data Extraction. Вызывается команда щелчком на пиктограмме Data 
Extraction… в группе Linking & Extraction ленты Insert в рабочем про-
странстве Drafting & Annotation.

Результаты выполнения запросов на извлечение данных из рисунка сохраня-
ются в таблице текущего файла формата DWG или в отдельном текстовом файле 
формата ASCII, который впоследствии может быть передан в какую-либо систе-
му управления базами данных. Извлечение данных никак не влияет на рисунок. 
Запи си в файле разделяются запятыми или знаками табуляции. Кроме того, поль-
зователь может формировать результаты в формате Microsoft Excel или Access.

Мастер извлечения данных – удобное средство создания различных специфи-
каций и отчетов, оперирующее данными, получаемыми непосредственно из ри-
сунков. Например, можно создать рисунок, где каждый блок представляет опре-
деленное производственное оборудование. Если с каждым таким блоком связаны 
атрибуты, идентифицирующие модель и производителя оборудования, то можно 
автоматизировать подготовку различных отчетов о составе и общей стоимости 
имеющегося оборудования.

На первой странице Мастера извлечения данных Data Extraction – Begin (рис. 10.24) 
настраиваются следующие параметры:

Рис. 10.24. Мастер извлечения данных, страница 1 – начало

Атрибуты блока
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�� Create a new data extraction – создание нового извлечения данных;
�� Use previous extraction as a template (.dxe or .blk) – использование предыдуще-

го извлечения в качестве шаблона;
�� Edit an existing data extraction – редактирование существующих извлеченных 

данных.

Для использования ранее сохраненых параметров необходимо выбрать вари-
ант использования шаблона.

На странице 2 Мастера извлечения данных Data Extraction – Define Data Source 
(рис. 10.25) осуществляется определение источника данных.

Рис. 10.25. Мастер извлечения данных, страница 2 – определение источника данных

�� В области Data source определяются параметры источника данных:
•� Drawings/Sheet set – выбор чертежей/подшивок;
•� Include current drawing – включение текущего чертежа;
•� Select objects in the current drawing – выбор объектов в текущем чертеже.

�� В области Drawing files and folders: – показаны файлы чертежей.

�� Кнопка Add Folder … – загружает диалоговое окно дополнительных настро-
ек Add Folder Options (рис. 10.26), где настраиваются следующие параметры:
•� Folder – определение папки;
•� в области Options задаются параметры:

◊� Automatically include new drawings added in this folder to the data extraction – 
автоматическое включение новых чертежей, добавленных в папку к 
извлеченным данным;
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◊� Include subfolders – включение внутренних папок;
◊� Utilize wild-card characters to select drawings – использование кода для 

выбора чертежей.

Рис. 10.26. Диалоговое окно дополнительных настроек

На странице 3 Мастера извлечения данных Data Extraction – Select Objects 
(рис. 10.27) осуществляется выбор объектов. Здесь необходимо выбрать объекты, 
которые нужно включить как заголовки столбцов и строк в конечном файле.

Рис. 10.27. Мастер извлечения данных, страница 3 – выбор объектов

Атрибуты блока



Глава 10. Построение сложных объектов286

Для отображения списка дополнительных параметров следует щелкнуть пра-
вой кнопкой мыши на элементе в списке. Если необходимо, можно указать дру-
гое имя, которое будет отображаться в заголовках столбцов выводимых данных. 
В этом диалоговом окне настраиваются следующие параметры.

�� В области Objects перечислены объекты и выводимые имена.
�� В области Display options настраиваются параметры экрана:
•� Display all object types – отображение объектов всех типов;
•� Display blocks only – отображение только блоков;
•� Display non-blocks only – отображение объектов, не являющихся блоками;
•� Display blocks with attributes only – отображение только блоков с атрибу-

тами;
•� Display objects currently in-use only – отображение только текущих исполь-

зуемых объектов.

На странице 4 Мастера извлечения данных Data Extraction – Select Properties 
(рис. 10.28) осуществляется выбор свойств. В окне просмотра можно изменить 
порядок элементов в таблице с помощью перетаскивания. Для того чтобы отсор-
тировать данные, следует щелкнуть на заголовке столбца.

Рис. 10.28. Мастер извлечения данных, страница 4 – выбор свойств

Для доступа к дополнительным параметрам необходимо щелкнуть правой 
кнопкой мыши на заголовке столбца. При этом открывается контекстное меню 
(рис. 10.29), позволяющее:
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�� Check All – выбор всех элементов;
�� Uncheck All – отмена всего выбора;
�� Invert Selection – замена выбора на обрат-

ный;
�� Edit Display Name – редактирование выво-

димых имен.

На странице 5 Мастера извлечения данных Data 
Extraction – Refine Data (рис. 10.30) осуществлюется 
упорядочение и сортировка колонок, настройка 
фильтров, добавление колонок с формулами, а также создание связей с внешними 
данными:

�� Combine identical rows – объединение рядов;
�� Show count column – отображение номера столбца;
�� Show name column – отображение имени столбца;
�� кнопка Link External Data… загружает одноименное диалоговое окно описа-

ния связей с внешними данными;
�� кнопка Sort Columns Options… загружает диалоговое окно сортировки 

столбцов Sort Columns;
�� кнопка Full Preview… загружает диалоговое окно предварительного про-

смотра Data Extraction-Full Preview.

Рис. 10.30. Мастер извлечения данных, страница 5 – структуризация данных

На странице 6 Мастера извлечения данных Data Extraction – Choose Output 
(рис. 10.31) осуществляется размещение данных:

�� Insert data extraction table into drawing – вставка извлеченных данных табли-
цы в чертеж;

�� Output data to external file (.xls .csv .mdb .txt) – размещение данных во внешнем 
файле.

Рис. 10.29. Контекстное меню 
Мастера извлечения данных

Атрибуты блока
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Рис. 10.31. Мастер извлечения данных, страница 6 – размещение данных

На странице 7 Мастера извлечения данных Data Extraction – Table Style (рис. 10.32) 
создается стиль таблицы.

Рис. 10.32. Мастер извлечения данных, страница 7 – стиль таблицы
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�� Select the table style to use for the inserted table – выбор стиля таблицы.
�� В области Formating and structure осуществляется форматирование:
•� Use table in table style for label rows – использование табличного стиля для 

названия рядов;
•� Manually setup table – формирование таблицы вручную;
•� Enter a title for your table: – ввод заголовка таблицы;
•� Tile cell style: – название ячейки;
•� Header cell style: – заголовок ячейки;
•� Data cell style: – содержимое ячейки;
•� Use property names as additional column headers – использование имен 

свойств в качестве заголовков дополнительных столбцов.

На странице 8 Мастера извлечения данных Data Extraction – Finish (рис. 10.33) за-
вершается работа с Мастером. Для извлечения данных необходимо нажать кнопку 
Finish. Если выбрано извлечение в таблицу, то после нажатия кнопки Finish по-
явится запрос точки вставки. Если выбрано извлечение во внешний файл, то про-
изойдет создание файла.

Рис. 10.33. Мастер извлечения атрибутов, страница 8 – завершение

Таблицы
Команда tABLE осуществляет создание пустой таблицы объектов в 
чертеже. Вызывается команда из падающего меню Draw → Table... или 
щелчком на пиктограмме Table в группе Annotation ленты Home в рабо-

Таблицы
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чем пространстве Drafting & Annotation. В результате открывается диалоговое 
окно вставки таблицы Insert Table – рис. 10.34.

Рис. 10.34. Диалоговое окно вставки таблицы

Таблица представляет собой прямоугольную структуру ячеек, организованных 
по строкам и столбцам, в которых содержатся текстовые объекты или блоки.

Перед заполнением ячеек информацией создается пустая таблица.
В диалоговом окне Insert Table настраиваются следующие параметры.

�� В области Table style определяется стиль таблицы.
�� В области Insert options – способы вставки таблицы:
•� Start from empty table – создание пустой таблицы, которую можно запол-

нить данными вручную;
•� From a data link – создание таблицы по данным из внешней электронной 

таблицы;
•� From object data in the drawing (Data Extraction) – запуск Мастера извлечения 

данных.

�� В области Insertion behavior определяется способ вставки:
•� Specify insertion point – запрос точки вставки, то есть расположения лево-

го верхнего угла таблицы;
•� Specify window – запрос занимаемой области, то есть размера и располо-

жения таблицы.
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�� В области Column & row settings задаются параметры строк и столбцов:
•� Columns: – количество столбцов;
•� Column width: – ширина столбца;
•� Data rows: – количество строк;
•� Row height: – высота строки.

�� В области Set cell styles устанавливаются стили ячеек.
�� В области Preview устанавливается просмотр таблицы.

После создания таблицы можно вводить текст или добавлять блоки в ячейки. 
Для редактирования размеров таблицы достаточно указать с помощью мыши лю-
бую линию сетки, а затем изменить их с помощью ручек или палитры свойств. При 
этом строки и столбцы меняются пропорционально.

Чтобы выделить ячейку, следует указать точку внутри нее. Ручки появляются 
на середине каждой границы ячейки. С помощью ручек можно изменить ширину 
и высоту ячейки и, соответственно, ширину и высоту ее столбца и строки.

Чтобы выделить нескольких ячеек, следует выбрать одну из них, а затем, удер-
живая нажатой кнопку мыши, указать все осталь-
ные ячейки.

Контекстное меню таблицы (рис. 10.35) вызы-
вается нажатием правой кнопки мыши при выде-
ленной ячейке. Оно позволяет вставлять и удалять 
столбцы и строки, комбинировать смежные ячейки 
и пр.

�� Cut – вырезать.
�� Copy – копировать.
�� Paste – вставить.
�� Recent Input – последний ввод.
�� Cell Style – стиль ячеек: By Row/Column – по 

строке или столбцу; Data – данные; Header – 
заголовок; Title – название; Save as New Cell 
Style…– сохранение нового стиля ячеек.

�� Background Fill – заливка фона.
�� Alignment – выравнивание: Top Left – вверх 

влево; Top Center – вверх по центру; Top 
Right – вверх вправо; Middle Left – середина 
влево; Middle Center – середина по центру; 
Middle Right – середина вправо; Bottom Left – 
вниз влево; Bottom Center – вниз по центру; 
Bottom Right – вниз вправо.

�� Borders… – загрузка диалогового окна опре-
деления свойств границ ячеек Cell Border 
Properties (рис. 10.36), в котором опреде-
ляются свойства границ: Lineweight: – вес 

Рис. 10.35. Контекстное 
меню таблицы

Таблицы
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линий; Linetype: – тип линий; Color: – цвет; Double line – двойная линия; 
Spacing: – интервал.

Рис. 10.36. Диалоговое окно определения свойств границ ячеек

�� Locking – блокирование: Unlocked – разблокировано; Content Locked – со-
держимое заблокировано; Format Locked – формат заблокирован; Content 
and Format Locked – содержимое и формат заблокированы.

�� Data Format… – загрузка диалогового окна определения формата ячейки 
таблицы Table Cell Format.

�� Match Cell – установка формата по образцу.
�� Remove All Property Overrides – снятие переопределения свойств.
�� Data Link… – загрузка диалогового окна выбора связи данных Select a Data 

Link.
�� Insert – вставка:
•� Block… – загрузка диалогового окна Insert a Block in a Table Cell (рис. 10.37), 

предназначенного для вставки блока в ячейку таблицы:
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Рис. 10.37. Диалоговое окно вставки блока в ячейку таблицы

◊� Name: – имя вставляемого блока;
◊� кнопка Browse… – загрузка диалогового окна, позволяющего сделать 

обзор и выбор существующих файлов;
◊� Scale: – коэффициент масштабирования;
◊� AutoFit – вписать;
◊� Rotation angle: – угол поворота;
◊� Overall cell alignment: – способ выравнивания;

•� Field… – загрузка диалогового окна Field, позволяющего выбрать такие 
категории полей, как дата и время, документ, объекты, печать, подшив-
ка, связи и пр.;

•� Formula – вставка формулы: Sum – сумма; Average – среднее; Count – ко-
личество; Cell – ячейка; Equation – уравнение.

�� Edit Text – изменение текста.
�� Manage Content… – управление содержимым.
�� Delete Content – удаление содержимого.
�� Delete All Contents – удаление всего содержимого.
�� Columns – вставка столбцов: Insert Left – слева, Insert Right – справа, Delete – 

удаление столбцов, Size Equally – формирование столбцов одного размера.
�� Rows – вставка строк: Insert Above – выше, Insert Below – ниже, Delete – уда-

ление строк, Size Equally – формирование строк одного размера.
�� Merge – объединение ячеек: All – всех, By Row – по строкам, By Column – по 

столбцам.
�� Unmerge – разделение ячеек.
�� Properties – загрузка палитры свойств объектов PROPERTIES.
�� Quick Properties – загрузка быстрой палитры свойств.

Таблицы
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Есть возможность добавить таблицу в инструментальную палитру. При этом 
в описании инструмента сохраняются свойства таблицы – ее стиль, число строк, 
столбцов. Но содержимое таблицы и форматирование символов – игнорируют-
ся.

При выделении ячеек таблицы загружается лента редактора таблиц Table Cell 
(рис. 10.38).

Рис. 10.38. Инструменты редактора таблиц

Данная лента содержит следующие инструменты.

�� Группа Rows:

•� Insert Above – вставка ряда выше;

•� Insert Below – вставка ряда ниже;

•� Delete Row(s) – удаление ряда.

�� Группа Columns:

•� Insert Left – вставка столбца слева;

•� Insert Right – вставка столбца справа;

•� Delete Column(s) – удаление столбца.

�� Группа Merge:

•� Merge Cells – объединение ячеек: Merge All – всех, Merge By 
Row – по строкам, Merge By Column – по столбцам;

•� Unmerge Cells – разделение ячеек.

�� Группа Cell Styles:

•� Match Cell – формат по образцу;
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•� Alignment – выравнивание: Top Left – вверх влево; Top Center – 
вверх по центру; Top Right – вверх вправо; Middle Left – середи-
на влево; Middle Center – середина по центру; Middle Right – се-
редина вправо; Bottom Left – вниз влево; Bottom Center – вниз 
по центру; Bottom Right – вниз вправо;

•� Table Cell Styles – определение стиля 
ячеек таблицы: By Row/Column – по 
строке или столбцу; Data – данные; 
Header – заголовок; Title – название; 
Create new cell style… – создание но-
вого стиля ячеек, Manage cell 
style… – управление стилями ячеек;

•� Table Cell Background Color – опреде-
ление цвета фона ячеек таблицы;

•� Edit Borders – загрузка диалогового окна определения внешнего 
вида границ ячеек Cell Border Properties.

�� Группа Cell Format:

•� Cell Locking – блокировка: Unlocked – разблокировано; Content 
Locked – содержимое заблокировано; Format Locked – формат 
заблокирован; Content and Format Locked – содержимое и фор-
мат заблокированы;

•� Data Format… – загрузка диалогового окна определения форма-
та ячейки таблицы Table Cell Format.

�� Группа Insert:

•� Block – загрузка диалогового окна Insert a Block in a Table Cell 
(см. рис. 10.43), предназначенного для вставки блока в ячейку 
таблицы;

•� Field – вставка текстового поля в текущую ячейку таблицы, 
при этом загружается диалоговое окно Field, позволяющее вы-
брать такие категории полей, как дата и время, документ, объ-
екты, печать, подшивка, связи и пр.;

•� Formula – вставка формулы: Sum – сумма, Average – среднее, 
Count – количество, Cell – ячейка, Equation – уравнение;

•� Manage Cell Contents – управление содержимым ячейки.

Таблицы
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�� Группа Data:

•� Link Cell – установление связи ячейки и загрузка диалогового 
окна Select a Data Link;

•� Download from Source – загрузка изменений из файла.
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Штриховка
Штрихование – это заполнение указанной области по определенному образцу. 
При этом можно выбрать один из способов определения контуров штриховки: 
указать точку на области, ограниченной объектами, или выбрать объекты, окру-
жающие область, либо перетащить образец штриховки на заданный контур из ин-
струментальной палитры или DesignCenter.

Команда HAtCH, формирующая ассоциативную штриховку, вызыва-
ется из падающего меню Draw → Hatch... или щелчком на пиктограм-
ме Hatch в группе Draw ленты Home в рабочем пространстве 
Drafting & Annotation (рис. 11.1). При этом загружается лента Hatch 
Creation (рис. 11.2).

Рис. 11.1. Диалоговое окно штриховки

Рис. 11.2. Инструменты штриховки

В группе Boundaries определяются контуры штриховки. Можно штриховать 
область, ограниченную замкнутой кривой, как путем простого указания внутри 
контура, так и путем выбора объектов. При этом контур определяется автоматиче-
ски, а любые целые примитивы и их составляющие, которые не являются частью 
контура, игнорируются:

•� Pick Points – контур штриховки определяется указанием точки 
выбора;

•� Select – контур штриховки определяется указанием объектов;
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•� Remove – исключение островков;

•� Recreate – восстановление контура;

•� Retain Boundaries Objects – назначение сохранения контуров (си-
стемная переменная HPBOUNDRETAIN): Polyline – тип объекта по-
лилиния; Region – тип объекта область (системная переменная 
HPBOUND);

•� Select New  Boundary Set – создание набора контуров: Use Current 
Viewport – использование текущего видового экрана.

В группе Pattern определяется образец штриховки, для чего используется рас-
крывающийся список, в котором содержатся пиктограммы с графическими об-
разцами различных штриховок (рис. 11.3). Для выбора образца штриховки до-
статочно указать на его изображение. Имя образца штриховки запоминается в 
системной переменной HPNAME. В поставку AutoCAD входит более 50 образцов 
штриховки, удовлетворяющих промышленным стандартам и служащих для обо-
значения различных компонентов объектов или графического представления 
различных материалов. В программе имеется 14 образцов штриховки, удовлетво-
ряющих стандартам ISO (Международной организации по стандартизации). Для 
штриховки по стандарту ISO можно задать ширину пера, которая определяет вес 
линии образца. Помимо образцов, поставляемых с AutoCAD, можно использовать 
образцы из внешних библиотек.

Рис. 11.3. Раскрывающийся список образцов штриховки

Штриховка
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В группе Properties  определяются свойства штриховки.

•� Hatch Type – тип штриховки: Solid – сплошное заполнение; Gradient – 
градиентная штриховка; Pattern – штриховка по образцу; User 
defined – штриховка из линий.

В зависимости от выбранного типа штриховки доступна установка сле-
дующих параметров:

•�  Hatch Color и  Background Color  – определение текущего цвета 

штриховки (системная переменная HPCOLOR) и цвета фона для но-
вых объектов штриховки (системная переменная HPBACKGROUNDCOLOR); 

•� Hatch Transparency – назначение уровня прозрачности для новых штри-
ховок или заливок с переопределением текущей настройки прозрачно-
сти объектов (системная переменная HPTRANSPARENCY);

•� Hatch Angle – определение угла поворота образца штриховки (системная 
переменная HPANG);

•� Scale – указание масштабного коэффициента образца штриховки 
(системная переменная HPSCALE);

•� Hatch Layer Override – определение слоя, на который назначаются 
новые объекты штриховки, с переопределением текущего слоя (си-
стемная переменная HPLAYER);

•� Relative to paper space – масштабирование относительно листа;

•� Double – отрисовка дополнительных линий под углом 90°�к основ-
ным линиям штриховки, крест-накрест;

•� ISO Pen Width – толщина пера по ISO.

В группе Origin определяется исходящая точка штриховки. Выравнивание 
штриховки можно изменить, указав исходную точку для образца:

•� Specify New Origin – указание местоположения новой исходной точ-
ки;

•� Bottom Left – слева внизу; Bottom Right – справа внизу;

Top Left – слева вверху; Top Right – справа вверху; 

Center – центр;

•� Use Current Origin – использование текущей исходной точки;

•� Store As Default Origin – сохранить указанную точку как исходную 
точку по умолчанию.
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В группе Options осуществляются следующие настройки:

•� Associative – ассоциативность штриховки (системная переменная 
HPASSOC). Ассоциативность означает, что при изменении границ 
контура изменяется и заштрихованная область. Неассоциативная 
штриховка не зависит от контура границы. Определение контура 
в команде производится автоматически на основании указания 
точки, принадлежащей штрихуемой области. Все объекты, полно-
стью или частично попадающие в область штриховки и не являю-
щиеся ее контуром, игнорируются и не влияют на процесс штри-
ховки;

•� Annotative – аннотативность штриховки позволяет выполнять ав-
томатическое масштабирование аннотаций в соответствии с фор-
матом листа при выводе на печать или экран (системная перемен-
ная HPANNOTATIVE);

•� Match Properties – копирование свойств с помощью наследования 
параметров выбранного объекта (системная переменная 
HPINHERIT): Use current origin – использовать текущую исходную 
точку; Use source hatch origin – использовать начало исходной 
штриховки;

•� Gap Tolerance – определение допуска замкнутости в единицах чертежа, 
то есть максимально допустимой величины зазора между объектами, 
образующими контур штриховки (системная переменная HPGAPTOL);

•� Create Separate Hatches – создание отдельных штриховок (систем-
ная переменная HPSEPARATE);

•� Islands Detection  – режим обнаружения островков (системная перемен-
ная HPISLANDDETECTIONMODE) – задание способа нанесения штриховки 
или заливки при наличии контуров внутри внешнего контура. В неко-
торых случаях контур содержит выступающие края и островки, кото-
рые можно либо штриховать, либо пропускать. Островками называются 
замкнутые области, расположенные внутри области штрихования. Тип 
решения островков (системная переменная HPISLANDDETECTION): 

◊� Normal Islands Detection   – нормальный стиль; 

◊� Outer Islands Detection   – внешний стиль; 

◊� Ignore Islands Detection   – игнорирующий стиль;

Hatch Settings – загрузка диалогового окна Hatch and Gradient, вкладка Hatch 
(рис. 11.4), в котором устанавливаются следующие параметры.

Штриховка
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Рис. 11.4. Диалоговое окно штриховки

�� В области Type and pattern – тип и массив штриховки:

•� Type: – тип штриховки: Predefined – стандартный; User defined – из линий; 
Custom – пользовательский.

•� Чтобы создать новый пользовательский образец штриховки, необ-
ходимо из раскрывающегося списка Type: выбрать пункт User defined. 
При этом следует задать угол наклона в поле Angle:, расстояние между 
линиями штриховки – в поле Spacing: и, если необходимо, установить 
флажок Double для отрисовки дополнительных линий под углом 90° к 
основным линиям штриховки; 

•� Pattern: – образец штриховки. Удобно пользоваться как раскрывающим-
ся списком, так и диалоговым окном Hatch Pattern Palette (рис. 11.5), кото-
рое загружается кнопкой с многоточием, находящейся справа от списка 
образцов. В этом диалоговом окне содержатся пиктограммы с графиче-
скими образцами различных штриховок. Для выбора образца штрихов-
ки достаточно указать его изображение. Имя образца штриховки запо-
минается в системной переменной HPNAME.
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•� В поставку AutoCAD входит более 50 образцов штриховки, удовлет-
воряющих промышленным стандартам и служащих для обозначения 
различных компонентов объектов или графического представления 
различных материалов. В программе имеется 14 образцов штриховки, 
удовлетворяющих стандартам ISO (Международной организации по 
стандартизации). Для штриховки по стандарту ISO можно задать ши-
рину пера, которая определяет вес линии образца. Помимо образцов, 
поставляемых с AutoCAD, можно использовать образцы из внешних 
библиотек;

•� Color: – переопределение текущего цвета (системная переменная 
HPCOLOR) и цвета фона для новых объектов штриховки (системная пере-
менная HPBACKGROUNDCOLOR);

•� Swatch: – отображается образец выбранного узора;
•� Custom pattern: – список имеющихся пользовательских образцов (си-

стемная переменная HPNAME).

Рис. 11.5. Диалоговое окно с образцами штриховки

�� В области Angle and scale определяются:

•� Angle: – угол поворота образца штриховки. Значение запоминается в си-
стемной переменной HPANG;

•� Scale: – масштабный коэффициент образца штриховки. Значение запо-
минается в системной переменной HPSCALE;

•� Double – штриховка крест-накрест;
•� Relative to paper space – относительно листа;

Штриховка
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•� Spacing: – интервал;
•� ISO pen width: – толщина пера по ISO.

�� В области Hatch origin определяется исходящая точка штриховки. Вырав-
нивание штриховки можно изменить, указав исходную точку для образца:

•� Use current origin – использование текущей исходной точки;
•� Specified origin – указание местоположения исходной точки;
•� Click to set new origin – щелкнуть для указания новой исходной точки;
•� Default to boundary extents – по умолчанию до контура: Bottom left – слева 

внизу; Bottom right – справа внизу; Top right – справа вверху; Top left – сле-
ва вверху; Center – центр;

•� Store as default origin – исходную точку по умолчанию.

�� В области Boundaries – определение контуров штриховки. Команда BHAtCH 
позволяет штриховать область, ограниченную замкнутой кривой, как пу-
тем простого указания внутри контура, так и путем выбора объектов. При 
этом контур определяется автоматически, а любые целые примитивы и их 
составляющие, которые не являются частью контура, игнорируются:

•� Add: Pick points – определить контур указанием точки выбора;
•� Add: Select objects – определить контур указанием объектов;
•� Remove boundaries – исключение островков;
•� Recreate boundary – восстановление контура;
•� Display boundary objects  – просмотр набора.

�� В области Options осуществляются настройки:

•� Annotative – аннотативность штриховки позволяет выполнять автомати-
ческое масштабирование аннотаций в соответствии с форматом листа 
при выводе на печать или экран (системная переменная HPANNOTATIVE);

•� Associative – ассоциативность штриховки (системная переменная 
HPASSOC). Ассоциативность означает, что при изменении границ конту-
ра изменяется и заштрихованная область. Неассоциативная штриховка 
не зависит от контура границы. Определение контура в команде произ-
водится автоматически на основании указания точки, принадлежащей 
штрихуемой области. Все объекты, полностью или частично попадаю-
щие в область штриховки и не являющиеся ее контуром, игнорируются 
и не влияют на процесс штриховки;

•� Separate hatches – создание отдельных штриховок (системная перемен-
ная HPSEPARATE);

•� Draw order: – порядок прорисовки (системная переменная HPDRAWORDER): 
Do not Change – не назначать; Send to Back – на задний план; Bring to Front – 
на передний план; Send Behind Boundary – поместить за контуром; Bring in 
Front of Boundary – поместить перед контуром;

•� Layer: – задание слоя, на который назначаются новые объекты штрихов-
ки, с переопределением текущего слоя (системная переменная HPLAYER);
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•� Transparency: – назначение уровня прозрачности для новых штриховок 
или заливок с переопределением текущей настройки прозрачности объ-
ектов (системная переменная HPTRANSPARENCY).

�� В области Islands – задание способа нанесения штриховки или заливки 
при наличии контуров внутри внешнего контура. В некоторых случаях 
контур содержит выступающие края и островки, которые можно либо 
штриховать, либо пропускать. Островками называются замкнутые обла-
сти, расположенные внутри области штрихования:

•� Island detection – режим обнаружения островков (системная переменная 
HPISLANDDETECTIONMODE);

•� Island display style: – тип решения островков (системная переменная 
HPISLANDDETECTION): Normal – обычное; Outer – внешний; Ignore – про-
пустить.

�� В области Boundary retention – сохранение контуров:

•� Retain boundaries – назначение сохранения контуров (системная пере-
менная HPBOUNDRETAIN);

•� Object type: – тип объекта (системная переменная HPBOUND): Region – об-
ласть; Polyline – полилиния.

�� В области Boundary set – набор контуров: Current viewport – текущий видо-
вой экран; Existing set – имеющийся набор; кнопка New – создание набора 
контуров.

�� В области Gap tolerance – определение допуска замкнутости в едини-
цах чертежа, то есть максимально допустимой величины зазора между 
объектами, образующими контур штриховки (системная переменная 
HPGAPTOL).

�� В области Inherit options – наследование параметров (системная перемен-
ная HPINHERIT):

•� Use current origin – использовать текущую исходную точку;
•� Use source hatch origin – использовать начало исходной штриховки.

�� Кнопка Preview – просмотр образца перед завершением работы команды 
HAtCH.

�� Кнопка Inherit Properties – копирование свойств.

Для автоматического определения контура штриховки путем указания точек 
необходимо нажать кнопку Pick Points. При этом выдаются запросы:

Pick internal point or [Select objects/Undo/seTtings]: – указать 
внутреннюю точку

Selecting everything... – выбор всех объектов
Selecting everything visible... – выбираются все видимые объекты
Analyzing the selected data... – анализ выбранных данных
Analyzing internal islands... – анализ внутренних островков

Штриховка
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Pick internal point or [Select objects/ Undo/
seTtings]: – указать внутреннюю точку

Analyzing internal islands... – анализ внутренних 
островков

Select internal point: – нажать клавишу Enter для 
завершения выбора штрихуемой области

При определении нескольких контуров штриховки не-
обходимо выбрать несколько внутренних точек, а затем на-
жать клавишу Enter.

Если AutoCAD определяет, что контур не замкнут или 
точка находится не внутри контура, то на экране появляется 
диалоговое окно Hatch – Boundary Definition Error с сообщени-
ем об ошибке.

Для выбора объектов в качестве контура штриховки не-
обходимо нажать кнопку Select.

Контуры штриховки могут представлять собой любую 
комбинацию отрезков, дуг, окружностей, двухмерных поли-
линий, эллипсов, сплайнов, блоков и видовых экранов про-
странства листа. Каждый из компонентов контура должен 
хотя бы частично находиться в текущем виде. По умолча-
нию AutoCAD определяет контуры путем анализа всех зам-
кнутых объектов рисунка.

Когда штрихование производится нормальным стилем 
Normal, островки остаются незаштрихованными, а вложен-
ные островки штрихуются, как показано на рис. 11.6. При 
этом штрихование производится внутрь, начиная от внеш-
него контура. Если обнаружено внутреннее пересечение, 
штрихование прекращается, а на следующем пересечении 
возобновляется. Таким образом, данный стиль задает штри-
хование областей, отделенных от внешней части нечетным 
числом замкнутых контуров; области, отделенные четным 
числом контуров, не штрихуются.

При использовании игнорирующего Ignore и внешнего 
стиля Outer штриховка аналогичного контура выглядит ина-
че (рис. 11.7, 11.8). Стиль Ignore задает штрихование всей об-
ласти, ограниченной внешним контуром, без учета вложен-
ных контуров. При использовании стиля Outer штрихование 
производится от внешнего контура и окончательно прекра-
щается при первом обнаруженном пересечении.

Стили Normal, Ignore и Outer устанавливаются в области 
Islands диалогового окна Hatch and Gradient (см. рис. 11.4).

Если на пути линии штриховки встречаются текст, атри-
бут, форма, полоса или закрашенная фигура и данный объ-

Рис. 11.6. 
Пример контура, 
заштрихованного 

нормальным стилем

Рис. 11.7. 
Пример контура, 
заштрихованного 

игнорирующим 
стилем

Рис. 11.8. 
Пример контура, 
заштрихованного 
внешним стилем
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ект входит в набор контуров, AutoCAD не наносит на него штриховку. В результа-
те, например, читаемость текста, размещенного внутри заштрихованного контура, 
не ухудшается. Если же перечисленные объекты также нужно заштриховывать, 
следует воспользоваться стилем Ignore.

Образец штриховки можно выбрать в окне инструментальной палитры, пере-
тащив образец штриховки на заданный контур.

Довольно эффектно использование градиентной заливки, состоящей из оттен-
ков одного цвета или представляющей собой плавный переход из одного цвета 
в другой. Градиентные заливки применяются для украшения чертежей, создавая 
эффект отражающегося от объекта света. При этом заливка наносится так же, как 
и сплошная, и может иметь ассоциативную связь с контурами областей, а значит, 
автоматически обновляться при изменении контура.

Команда GRADiENt, формирующая градиентную заливку, вызыва-
ется из падающего меню Draw → Gradient... или щелчком на пикто-
грамме Hatch Type в группе Properties ленты Hatch Creation. При обраще-
нии к команде GRADiENt загружается лента Hatch Creation (рис. 11.9).

Рис. 11.9. Инструменты градиентной заливки

При щелчке по стрелочке Hatch Settings  в группе Options ленты Hatch Creation за-
гружается диалоговое окно Hatch and Gradient, вкладка Gradient (рис. 11.10).

На вкладке Gradient диалогового окна Hatch and Gradient устанавливаются сле-
дующие параметры.

�� В области Color определяется тип цветового перехода – монохромный или 
двухцветный (системная переменная GFCLRSTATE):

•� One color – использование одного цвета: Shade – темнее, Tint – светлее. 
Одноцветная градиентная заливка может содержать плавный переход 
цвета от более светлого к более темному, от более темного к более свет-
лому или сочетание таких переходов;

•� Two color – использование двух цветов: Color 1 – цвет 1, Color 2 – цвет 2. 
Двухцветная градиентная заливка состоит из переходов от светлых к 
темным оттенкам, а также от одного цвета к другому;

•� кнопка с многоточием – загрузка диалогового окна выбора цвета Select 
Color.

�� В области Orientation определяется ориентация градиентной заливки:
•� Centered – симметричная конфигурация градиента по центру (систем-

ная переменная GFSHIFT);
•� Angle: – угол наклона заливки (системная переменная GFANG).

Штриховка
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Рис. 11.10. Диалоговое окно градиентной заливки

Остальные параметры аналогичны параметрам вкладки Hatch диалогового окна 
Hatch and Gradient (см. рис. 11.4).

Для быстрого измерения площади области штриховки следует воспользоваться 
палитрой Properties (рис. 11.11). Для этого необходимо выбрать штриховку и 
щелкнуть на ней правой кнопкой мыши, затем выбрать из контекстного меню 
пункт Properties, тем самым загрузить палитру свойств объектов. Значение площади 
штриховки будет отражено в области параметров геометрии Geometry, в поле Area. 
При выборе нескольких штриховок можно вычислить их общую площадь.

Рис. 11.11. Измерение площади области штриховки на палитре Properties
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Выполните упражнения H1–H3 из раздела 3.

Контур
Команда BOUNDARY, формирующая контур из замкнутого набора 
объектов, вызывается из падающего меню Draw → Boundary.... В рабо-
чем пространстве Drafting & Annotation инструмент формирования кон-
тура находится в группе Draw ленты Home (см. рис. 11.1). При обраще-
нии к команде BOUNDARY загружается диалоговое окно Boundary 
Creation, показанное на рис. 11.12, где устанавливаются следующие 
параметры.

�� Кнопка Pick Points предназначена для указания внутренних точек контура.
�� Island detection – режим определения островков.
�� Область Boundary retention предназначена для указания параметров сохра-

нения контуров:
•� Retain boundaries – установка режима сохранения контуров;
•� Object type: – тип объекта: Region – область; Polyline – полилиния.

�� Область Boundary set предназначена для определения набора контуров:
•� Current viewport – создает набор контуров из всех объектов, находящихся 

в границах текущего видового экрана; Existing set – имеющийся набор;
•� кнопка New предназначена для создания набора контуров.

Рис. 11.12. Диалоговое окно создания контура

Контур
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Область
Областью называются плоские замкнутые объекты, которые образуются из не-
скольких двухмерных объектов.

Команда REGiON формирует область и вызывается из падающего 
меню Draw → Region или щелчком на пиктограмме Region в группе 
Draw ленты Home в рабочем пространстве Drafting & Annotation.

Над созданными областями можно производить следующие операции:

�� объединять несколько областей в одну область;
�� формировать область с помощью вычитания нескольких областей;
�� получать область путем пересечения нескольких областей;
�� рассчитывать площадь области;
�� выполнять штрихование и закрашивание областей;
�� получать информацию о расположении центра масс.

Маскировка
Команда wiPEOUt формирует маскирующие объекты и вызывается 
из падающего меню Draw → Wipeout или щелчком на пиктограмме 
Wipeout в группе Draw ленты Home в рабочем пространстве Drafting & 
Annotation. 

Эта команда формирует многоугольники фонового цвета, которыми можно 
закрывать объекты чертежа. При этом область ограничивается контурами, види-
мость которых можно включать при ре-
дактировании и отключать при печати.

Маскирующие объекты можно созда-
вать в пространстве листа для скрытия 
объектов, находящихся в пространстве 
модели.

Простановка.
размеров
Размеры показывают геометрические ве-
личины объектов, расстояния и углы меж-
ду ними, координаты отдельных точек. 
В AutoCAD используется 11 видов раз-
меров, которые можно разделить на пять 
основных типов: линейные, радиальные, 

Рис. 11.13. Горизонтальный, 
вертикальный и параллельный 

размеры
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угловые, ординатные и длина дуги (рис. 11.13–11.17). Линейные размеры, в свою 
очередь, делятся на горизонтальные, вертикальные, параллельные, повернутые, 
ординатные, базовые и размерные цепи. Ниже будут приведены простые примеры 
нанесения различных типов размеров.

                 
                 Рис. 11.14. Базовые размеры                                   Рис. 11.15. Размерные цепи

                  
                     Рис. 11.16. Радиальные размеры                             Рис. 11.17. Угловые размеры

Команды простановки размеров находятся в падающем меню Dimension (рис. 11.18).
В рабочем пространстве Drafting & Annotation инструменты формирования раз-

меров находятся в группе Annotation ленты Home (рис. 11.19), а также в группе 
Dimensions ленты Annotate.

В изображения размеров входят следующие составные элементы:

�� размерная линия – линия со стрелками на концах, выполненная парал-
лельно соответствующему измерению. Как правило, размерные линии 
помещаются между выносными. Если на короткой размерной линии не 
хватает места, размерные стрелки или текст размещаются снаружи в зави-
симости от настроек размерного стиля. Для угловых размеров размерной 
линией является дуга;

Простановка размеров
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�� размерные стрелки – стрелки, засечки или произвольный маркер, опреде-
ляемый как блок, для обозначения концов размерной линии;

�� выносные линии проводятся от объекта к размерной линии. Могут быть 
построены перпендикулярно ей или быть наклонными. Формируются 
только для линейных и угловых размеров (используются, если размерная 
линия находится вне объекта, на котором проставляется размер);

�� размерный текст – текстовая строка, содержащая величину размера и 
другую информацию (например, обозначения диаметра, радиуса, допус-
ка). Это необязательный элемент, то есть его вывод на рисунок можно по-
давить. Есть возможность принять размер, автоматически вычисленный 
AutoCAD, или заменить его другим текстом. Если принимается текст по 
умолчанию, к нему можно автоматически добавить допуски и ввести пре-
фикс и суффикс;

�� выноски используются, если размерный текст невозможно расположить 
рядом с объектом;

Рис. 11.18. Падающее меню и панель 
инструментов Dimension

Рис. 11.19. Инструменты 
формирования размеров
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�� маркер центра – небольшой крестик, отмечающий центр окружности или 
дуги;

�� осевые линии – линии с разрывом (штрихпунктирные), пересекающиеся в 
центре окружности или дуги и делящие ее на квадранты.

Все линии, стрелки, дуги и элементы текста, составляющие размер, будут рас-
сматриваться как один геометрический примитив, если установлен режим ассо-
циативной простановки размеров. Существует три типа ассоциативности между 
объектами и размерами:

�� ассоциативные размеры – автоматически изменяют свое положение, ори-
ентацию и значения величин при редактировании геометрических объек-
тов, на которые проставлены эти размеры. Размеры в пространстве листа 
могут ассоциироваться с объектами в пространстве модели. При этом си-
стемной переменной DIMASSOC присвоено значение 2;

�� неассоциативные размеры – при изменении объектов, на которые простав-
лены эти размеры, неассоциативные размеры не изменяются. Системной 
переменной DIMASSOC присвоено значение 1;

�� расчлененные размеры – представляют собой не единый геометрический 
примитив, а наборы отдельных объектов: линии, стрелки, дуги и элементы 
текста, составляющие размер. Для системной переменной DIMASSOC уста-
новлено значение 0.

Ассоциативные размеры не могут быть применены для штриховки, мультили-
нии, двухмерных фигур и объектов с ненулевой трехмерной высотой. А также не 
сохраняется ассоциативность между размером и трехмерным телом после изме-
нения этого объекта.

Линейные.размеры
AutoCAD обеспечивает несколько видов простановки линейных размеров, отли-
чающихся углом, под которым проводится размерная линия.

Команда DimLiNEAR позволяет создавать горизонтальный, верти
кальный или повернутый размеры. Команда вызывается из падающе-
го меню Dimension → Linear или щелчком на пиктограмме Linear в 
группе Annotation ленты Home.

Запросы команды DimLiNEAR:

Specify first extension line origin or <select object>: – указать на-
чало первой выносной линии

Specify second extension line origin: – указать начало второй выносной 
линии

Specify dimension line location or 
  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – указать положение 
размерной линии

Линейные размеры
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Dimension text = измеренное значение

Если на первый запрос нажать клавишу Enter, команда DimLiNEAR выдает сле-
дующие запросы:

Specify first extension line origin or <select object>: – нажать кла-
вишу Enter для указания объекта

Select object to dimension: – выбрать объект для нанесения размера
Specify dimension line location or 

  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – указать положение 
размерной линии

Dimension text = измеренное значение

Ключи команды DimLiNEAR:

�� Mtext – позволяет редактировать размерный текст в редакторе много-
строчного текста. Можно полностью изменить текст или сохранить из-
меренное значение с помощью угловых скобок <> и при необходимости 
добавить любой текст до и после скобок;

�� Text – позволяет редактировать размерный текст. При этом выдается за-
прос:
Enter dimension text <измеренное значение>: – ввести необходимую 
текстовую строку

�� Angle – позволяет задать угол поворота размерного текста. При этом вы-
дается запрос:
Specify angle of dimension text: – указать угол поворота размерного 
текста

�� Horizontal – определяет горизонтальную ориентацию размера, отмеряет 
расстояние между двумя точками по оси X;

�� Vertical – определяет вертикальную ориентацию размера, отмеряет рас-
стояние между двумя точками по оси Y;

�� Rotated – осуществляет поворот размерной и выносных линий, отмеряет 
расстояние между двумя точками вдоль заданного направления в текущей 
ПСК. При этом выдается запрос:
Specify angle of dimension line <0>: – указать угол поворота раз-
мерной линии

Пример..Простановка.
горизонтального.размера
Проставьте горизонтальный размер прямоугольни-

ка (рис. 11.20).
Запустите команду DimLiNEAR, вызвав ее из пада-

ющего меню Dimension → Linear или щелчком на пикто-
грамме Linear в группе Annotation ленты Home. Ответьте 
на запросы:

Рис. 11.20. Простановка 
горизонтального размера
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_DIMLINEAR
Specify first extension line origin or <select object>: – укажите 

точку 1
Specify second extension line origin: – укажите точку 2
Specify dimension line location or 

  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – укажите точку 3
Dimension text = 200

Выполните упражнение R1 из раздела 3.

Пример..Простановка.
вертикального.размера
Проставьте вертикальный размер прямоуголь-

ника (рис. 11.21).
Запустите команду DimLiNEAR, вызвав ее из 

падающего меню Dimension → Linear или щелчком 
на пиктограмме Linear в группе Annotation ленты 
Home. Ответьте на запросы:

_DIMLINEAR
Specify first extension line origin or <select object>: – укажите 

точку 1
Specify second extension line origin: – укажите точку 2
Specify dimension line location or 

  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – укажите точку 3
Dimension text = 80

Выполните упражнение R2 из раздела 3.

Пример..Простановка.
повернутого.размера
Проставьте размер под заданным углом (рис. 11.22).
Запустите команду DimLiNEAR, вызвав ее из па-

дающего меню Dimension → Linear или щелчком на 
пиктограмме Linear в группе Annotation ленты Home. 
Ответьте на запросы:

_DIMLINEAR
Specify first extension line origin or <select object>: – укажите 

точку 1

Рис. 11.21. Простановка 
вертикального размера

Рис. 11.22. Простановка 
повернутого размера

Линейные размеры
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Specify second extension line origin: – укажите точку 2
Specify dimension line location or 

  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: R – переход в режим 
простановки повернутого размера

Specify angle of dimension line <0>: – укажите точку 2, задавая угол по-
ворота размерной линии как направление

Specify second point: – укажите точку 3, задавая угол поворота размерной 
линии как направление

Specify dimension line location or 
  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – укажите точку 4

Dimension text = 128.7

Выполните упражнение R3 из раздела 3.

Параллельный.размер
С помощью команды DimALiGNED создается размер, параллельный 
измеряемой линии объекта; это позволяет выровнять размерную ли-
нию по объекту. Размер создается подобно горизонтальному, верти-
кальному и повернутому, при этом размерная линия расположена 
параллельно прямой, проходящей через размерные точки. Команда 
вызывается из падающего меню Dimension → Aligned или щелчком на 
пиктограмме Aligned в группе Annotation ленты Home.

Запросы команды DimALiGNED:
Specify first extension line origin or <select object>: – указать на-

чало первой выносной линии
Specify second extension line origin: – указать начало второй выносной 

линии
Specify dimension line location or [Mtext/Text/Angle]: – указать по-

ложение размерной линии
Dimension text = измеренное значение

Пример..Простановка.
параллельного.размера
Проставьте размер, параллельный измеряемой ли-

нии объекта (рис. 11.23).
Запустите команду DimALiGNED, вызвав ее из па-

дающего меню Dimension → Aligned или щелчком на 
пиктограмме Aligned в группе Annotation ленты Home. 
Ответьте на запросы:

Рис. 11.23. Простановка 
параллельного размера
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_DIMALIGNED
Specify first extension line origin or <select object>: – укажите 

точку 1
Specify second extension line origin: – укажите точку 2
Specify dimension line location or [Mtext/Text/Angle]: – укажите 

точку 3
Dimension text = 223.61

Выполните упражнение R4 из раздела 3.

Длина.дуги
С помощью команды DimARC создается размер длины дуги, указываю-
щий расстояние вдоль дуги или дугового сегмента полилинии 
(рис. 11.24). Чтобы отличать эти размеры от линейных и угловых, для 
размеров длины дуги по умолчанию отображается символ дуги. Ко-
манда вызывается из падающего меню Dimension → Arc Length или 
щелчком на пиктограмме Arc Length в группе Annotation ленты Home.

Рис. 11.24. Простановка размера длины дуги

Запросы команды DimARC:

Select arc or polyline arc segment: – выбрать дугу или дуговой сегмент 
полилинии

Specify arc length dimension location, or [Mtext/Text/Angle/Partial/
Leader]: – указать положение размера длины дуги или один из ключей

Dimension text = измеренное значение

Ключи команды DimARC:

�� Mtext – загрузка интерфейса мультитекста;
�� Text – ввод размерного текста;
�� Angle – ввод угла поворота размерного текста;

Длина дуги
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�� Partial – режим указания положения первой и второй точек размера 
длины дуги;

�� Leader – режим указания размера длины дуги с линией-выноской.

Символ дуги отображается над или перед размерным текстом. Настройка этого 
параметра осуществляется в Диспетчере размерных стилей или в палитре свойств 
объектов.

Выносные линии данного типа размера могут быть либо ортогональными, либо 
радиальными. При этом ортогональные выносные линии возможны только в слу-
чае, если прилежащий угол дуги меньше 90°.

Ординатные.размеры
Ординатные размеры определяют расстояние по оси координат от базовой точки 
до образмериваемого объекта (например, до отверстия в детали). Применение та-
ких размеров предохраняет от накапливающихся ошибок, поскольку положение 
объектов отмеряется от единой базовой точки.

Ординатный размер состоит из значения координаты x или y и выноски. Орди-
натный размер по X выражает расстояние от начала координат до объекта вдоль 
оси X, а ординатный размер по Y – соответственно вдоль оси Y. Если указана точка, 
AutoCAD автоматически определяет, по какой оси проставлять ординатный раз-
мер. Такой способ называется автоматическим нанесением ординатных размеров.

Текст ординатного размера располагается вдоль выноски независимо от ориен-
тации текста, заданной текущим размерным стилем. Ключи команды позволяют 
изменять размерный текст и угол его наклона.

Выноска-отрезок или каждый сегмент выноски-ломаной отрисовывается пер-
пендикулярно одной из осей координат, поэтому целесообразно включать ортого-
нальный режим ORTHO.

Команда DimORDiNAtE позволяет проставлять ординатные разме-
ры. Она вызывается из падающего меню Dimension → Ordinate или 
щелчком на пиктограмме Ordinate в группе Annotation ленты Home.

Запросы команды DimORDiNAtE:

Specify feature location: – указать положение элемента
Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/Angle]: – ука-

зать конечную точку выноски или координату, которую необходимо изменить; как 
следствие, изменится ориентация выносок и размерного текста

Dimension text = измеренное значение

Ключи команды DimORDiNAtE:

�� Xdatum – режим указания координаты X;
�� Ydatum – режим указания координаты Y;
�� Mtext – загрузка интерфейса мультитекста;
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�� Text – ввод размерного текста;
�� Angle – ввод угла поворота размерного текста;

Размер.радиуса
Команда DimRADiUs, позволяющая построить радиус окружности 
или дуги, вызывается из падающего меню Dimension → Radius или 
щелчком на пиктограмме Radius в группе Annotation ленты Home.

Запросы команды DimRADiUs:

Select arc or circle: – выбрать дугу или круг
Dimension text = измеренное значение
Specify dimension line location or [Mtext/Text/Angle]: – указать по-

ложение размерной линии

По умолчанию при простановке радиуса текст начинается с символа R.

Пример..Простановка.радиуса
Проставьте два варианта радиального размера на дугу 

(рис. 11.25).
Запустите команду DimRADiUs, вызвав ее из пада-

ющего меню Dimension → Radius или щелчком на пикто-
грамме Radius в группе Annotation ленты Home. Ответьте 
на запросы:

_DIMRADIUS
Select arc or circle: – укажите точку 1, лежащую на дуге
Dimension text = 90
Specify dimension line location or [Mtext/Text/Angle]: – укажите 

местоположение размерной линии

Выполните упражнение R8 из раздела 3.

Размер.радиуса.с.изломом
Команда DimJOGGED, позволяющая построить радиус окружности 
или дуги с изломом, вызывается из падающего меню Dimension → 
Jogget или щелчком на пиктограмме Jogget в группе Annotation ленты 
Home.

Размеры радиусов с изломом, или укороченные размеры радиуса, проставля-
ются в том случае, если центр дуги или круга располагается за пределами листа и 
его истинное положение не может быть показано.

Рис. 11.25. 
Простановка радиуса

Размер радиуса с изломом
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Запросы команды DimJOGGED:

Select arc or circle: – выбрать дугу или круг
Specify center location override: – указать новое положение центра
Dimension text = измеренное значение
Specify dimension line location or [Mtext/Text/Angle]: – указать по-

ложение размерной линии
Specify jog location: – указать положение излома

Переопределением положения центра называется исходная точка размера, за-
данная в более удобном месте.

Размер.диаметра
Команда DimDiAmEtER строит диаметр окружности или дуги. Ко-
манда вызывается из падающего меню Dimension → Diameter или 
щелчком на пиктограмме Diameter в группе Annotation ленты Home.

Запросы команды DimDiAmEtER:

Select arc or circle: – выбрать дугу или круг
Dimension text = измеренное значение
Specify dimension line location or [Mtext/Text/Angle]: – указать по-

ложение размерной линии

При простановке размера диаметра текст по умолчанию начинается со знака ∅. 
Ключи команды позволяют изменять размерный текст и угол наклона размерного 
текста. Маркеры центра и осевые линии автоматически появляются в центре дуги 
или круга, если размер проставляется снаружи, и не наносятся, если размер про-
ставляется внутри круга или дуги, а также в случае, когда маркеры центра отклю-
чены. Имеется возможность произвести принудительное размещение размерного 
текста и линии-выноски внутри круга или дуги.

Пример..Простановка.диаметра
Проставьте два варианта диаметрального размера на окружность (рис. 11.26).
Запустите команду DimDiAmEtER, вызвав ее из падающего меню Dimension → 

Diameter или щелчком по пиктограмме Diameter в 
группе Annotation ленты Home. Ответьте на запросы:

_DIMDIAMETER
Select arc or circle: – укажите точку 1, 

лежащую на окружности
Dimension text = 180
Specify dimension line location or 

[Mtext/Text/Angle]: – укажите местоположе-
ние размерной линии

Рис. 11.26. Простановка  
диаметра
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Выполните упражнение R7 из раздела 3.

Угловые.размеры
Команда DimANGULAR позвояет проставить угловой размер. Она 
вызывается из падающего меню Dimension → Angular или щелчком на 
пиктограмме Angular в группе Annotation ленты Home.

Запросы команды DimANGULAR:

Select arc, circle, line, or <specify vertex>: – выбрать дугу, круг, 
отрезок

Select second line: – если первое указание было отрезком, следует указать 
второй отрезок, непараллельный первому

Specify dimension arc line location or [Mtext/Text/Angle]: – указать 
положение размерной дуги

Dimension text = измеренное значение

Если в ответ на первый запрос нажата клавиша Enter, то угловой размер строит-
ся по трем точкам и команда DimANGULAR выдает следующие запросы:

Specify angle vertex: – указать вуршину угла
Specify first angle endpoint: – указать первую конечную точку угла
Specify second angle endpoint: – указать вторую конечную точку угла
Specify dimension arc line location or [Mtext/Text/Angle]: – указать 

положение размерной дуги
Dimension text = измеренное значение

При простановке углового размера текст по умолчанию завершается знаком 
градуса °. Ключи команды позволяют изменять размерный текст и угол его на-
клона.

Когда угол образован двумя непараллельными прямыми, размерная дуга стя-
гивает угол между ними. Если в этом случае дуга не пересекается с обоими или 
с одним из образмериваемых отрезков, AutoCAD прово-
дит одну или две выносные линии до пересечения с раз-
мерной дугой. Стягиваемый угол всегда меньше 180°.

Пример..Простановка.углового.
размера
Проставьте два варианта углового размера (рис. 11.27).
Запустите команду DimANGULAR, вызвав ее из пада-

ющего меню Dimension → Angular или щелчком на пикто-
грамме Angular в группе Annotation ленты Home. Ответьте 
на запросы:

Рис. 11.27. 
Простановка углового 

размера

Угловые размеры
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_DIMANGULAR
Select arc, circle, line, or <specify vertex>: – укажите точку 1
Select second line: – укажите точку 2
Specify dimension arc line location or [Mtext/Text/Angle]: – укажите 

местоположение размерной линии
Dimension text = 125

Выполните упражнение R9 из раздела 3.

Быстрое.нанесение.размеров
Команда QDim обеспечивает быстрое нанесение размеров. Она вызы-
вается из падающего меню Dimension → Quick Dimension или щелчком на 
пиктограмме Quick в группе Dimensions ленты Annotate.

Запросы команды QDim:

Select geometry to dimension: – выбрать объекты для нанесения размеров
Select geometry to dimension: – выбрать объекты для нанесения размеров
Select geometry to dimension: – нажать клавишу Enter для завершения 

выбора объектов
Specify dimension line position, or 

  [Continuous/Staggered/Baseline/Ordinate/Radius/Diameter/datumPoint/
Edit/SeTtings]<Continuous>: – указать положение размерной линии

Команда QDim запрашивает лишь указание контуров, на которые необходимо 
проставить размеры, и требует выбрать тип проставляемых размеров путем уста-
новки соответствующего ключа.

Пример..Быстрое.нанесение.размеров
Проставьте размеры на деталь (рис. 11.28).
Запустите команду QDim, вызвав ее из па-

дающего меню Dimension → Quick Dimension 
или щелчком на пиктограмме Quick в группе 
Dimensions ленты Annotate. Ответьте на запросы:

_QDIM
Select geometry to dimension: – укажите 

точку 1
Select geometry to dimension: – укажите 

точку 2
Select geometry to dimension: – укажите 

точку 3
Рис. 11.28. Быстрое нанесение 

размеров
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Select geometry to dimension: – нажмите клавишу Enter для завершения 
выбора объектов

Specify dimension line position, or 
  [Continuous/Staggered/Baseline/Ordinate/Radius/Diameter/datumPoint/
Edit/SeTtings]<Continuous>: – указать точку 4

Выполните упражнение R10 из раздела 3.

Базовые.размеры
Базовые размеры и размерные цепи представляют собой последовательность ли-
нейных размеров.

Базовые размеры – это последовательность размеров, отсчитываемых от одной 
базовой линии. У размерных цепей начало каждого размера совпадает с концом 
предыдущего. Перед построением базового размера или цепи на объекте должен 
быть проставлен хотя бы один линейный, ординатный или угловой размер.

Команда DimBAsELiNE позволяет создавать базовые размеры. Вы-
зывается она из падающего меню Dimension → Baseline или щелчком 
на пиктограмме Baseline в группе Dimensions ленты Annotate.

Запросы команды DimBAsELiNE:

Specify a second extension line origin or [Undo/Select] <Select>: – 
указать начало второй выносной линии

Dimension text = измеренное значение
Specify a second extension line origin or [Undo/Select] <Select>: – 

указать начало следующей выносной линии
Dimension text = измеренное значение
Specify a second extension line origin or [Undo/Select] <Select>: – 

указать начало следующей выносной линии
Dimension text = измеренное значение
Specify a second extension line origin or [Undo/Select] <Select>: – 

нажать клавишу Enter для окончания простановки размеров
Select base dimension: – нажать клавишу Enter для завершения работы ко-

манды

Если предыдущий размер не был линейным или если в ответ на первый за-
прос была нажата клавиша Enter, то предлагается выбрать линейный размер, ко-
торый будет использоваться в качестве базового. При этом выдается следующий 
запрос:

Select base dimension: – выберите исходный размер

Далее следуют стандартные запросы команды DimBAsELiNE.

Базовые размеры
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Расстояние между размерными линия-
ми в базовых размерах задается систем-
ной переменной DIMDLI.

Пример..Простановка.
базовых.размеров
Проставьте линейный размер, а затем 

от него – базовые (рис. 11.29).
Запустите команду DimLiNEAR, вы-

звав ее из падающего меню Dimension → 
Linear или щелчком на пиктограмме Linear 
в группе Dimensions ленты Annotate. От-
ветьте на запросы:

_DIMLINEAR
Specify first extension line origin or <select object>: – укажите 

точку 1
Specify second extension line origin: – укажите точку 2
Specify dimension line location or 

  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – укажите точку 5
Dimension text = 120

Запустите команду DimBAsELiNE, вызвав ее из падающего меню Dimension → 
Baseline или щелчком на пиктограмме Baseline в группе Dimensions ленты Annotate. 
Ответьте на запросы:

_DIMBASELINE
Specify a second extension line origin or [Undo/Select] <Select>: – 

укажите точку 3
Dimension text = 220
Specify a second extension line origin or [Undo/Select] <Select>: – 

укажите точку 4
Dimension text = 270
Specify a second extension line origin or [Undo/Select] <Select>: – 

нажмите клавишу Enter
Select base dimension: – нажмите клавишу Enter для завершения команды

Выполните упражнение R5 из раздела 3.

Размерная.цепь
Команда DimCONtiNUE позволяет создавать последовательную размер
ную цепь. Команда вызывается из падающего меню Dimension → Continue 
или щелчком на пиктограмме Continue в группе Dimensions ленты Annotate.

Рис. 11.29. Простановка базовых 
размеров
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Запросы команды DimCONtiNUE:

Specify a second extension line origin or [Undo/Select] <Select>: – 
указать начало второй выносной линии

Dimension text = измеренное значение
Specify a second extension line origin or [Undo/Select] <Select>: – 

указать начало следующей выносной линии
Dimension text = измеренное значение
Specify a second extension line origin or [Undo/Select] <Select>: – 

указать начало следующей выносной линии
Dimension text = измеренное значение
Specify a second extension line origin or [Undo/Select] <Select>: – 

указать начало следующей выносной линии или нажать клавишу Enter
Select continued dimension: – выбрать исходный размер или нажать кла-

вишу Enter для завершения команды

Если предыдущий размер не был линейным или если в ответ на первый запрос 
была нажата клавиша Enter, то предлагается выбрать линейный размер, который 
будет использован для продолжения. При этом выдается следующий запрос:

Select continued dimension: – выбрать исходный размер

Далее следуют стандартные запросы команды DimCONtiNUE.

Пример..
Простановка.
последовательной.
размерной.цепи
Проставьте линейный размер, 

а затем от него – последователь-
ную размерную цепь (рис. 11.30).

Запустите команду 
DimLiNEAR, вызвав ее из падаю-
щего меню Dimension → Linear или 
щелчком на пиктограмме Linear в 
группе Dimensions ленты Annotate. 
Ответьте на запросы:

_DIMLINEAR
Specify first extension line origin or <select object>: – укажите 

точку 1
Specify second extension line origin: – укажите точку 2
Specify dimension line location or 

  [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – укажите точку 4
Dimension text = 100

Рис. 11.30. Простановка последовательной 
размерной цепи

Размерная цепь
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Запустите команду DimCONtiNUE, вызвав ее из падающего меню Dimension → 
Continue или щелчком на пиктограмме Continue в группе Dimensions ленты Annotate. 
Ответьте на запросы:

_DIMCONTINUE
Specify a second extension line origin or [Undo/Select] <Select>: – 

укажите точку 3
Dimension text = 100
Specify a second extension line origin or [Undo/Select] <Select>: – 

нажмите клавишу Enter
Select continued dimension: – нажмите клавишу Enter для завершения ра-

боты команды

Выполните упражнение R6 из раздела 3.

Смещение.размеров
Команда DimsPACE позволяет выравнивать расстояние между па-
раллельными размерными линиями. Команда вызывается из падаю-
щего меню Dimension → Dimension Space или щелчком на пиктограмме 
Adjust Space в группе Dimensions ленты Annotate.

Запросы команды DimsPACE:

Select base dimension: – выбрать параллельный линейный или угловой 
размер

Select dimensions to space: – выбрать параллельный линейный или угло-
вой размер для размещения на постоянном расстоянии от базового размера

Select dimensions to space: – выбрать параллельный линейный или угло-
вой размер для размещения на постоянном расстоянии от базового размера или 
нажать клавишу Enter

Enter value or [Auto] <Auto>: – указать расстояние между размерами или 
нажать клавишу Enter

Если на последний запрос нажата клавиша Enter, то вычисление расстояния 
смещения производится автоматически и основывается на высоте текста, задан-
ной в размерном стиле выбранного базового размера. Результирующее значение 
смещения составляет двойную высоту размерного текста.

Разрыв.размера
Команда DimBREAK позволяет разрывать или восстанавливать раз-
мерные и выносные линии, пересекающие другие объекты. Команда 
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вызывается из падающего меню Dimension → Dimension Break или щелчком на 
пиктограмме Break в группе Dimensions ленты Annotate в рабочем пространстве 
Drafting & Annotation.

Разрывы размеров можно добавлять к линейным, угловым и ординатным раз-
мерам.

Запросы команды DimBREAK:

Select dimension to add/remove break or [Multiple]: – выбрать размер 
для добавления или удаления разрыва

Select object to break dimension or [Auto/Manual/Remove] <Auto>: – 
выбрать объект, пересекающий размерные или выносные линии указанного ранее 
размера

Select object to break dimension: – выбрать объект, проходящий через 
размер

Select object to break dimension: – выбрать объект, проходящий через 
размер, или нажать клавишу Enter для завершения команды

N objects modified – количество измененных объектов

Ключи команды DimBREAK:

�� Multiple – выбор нескольких размеров, из которых нужно удалить раз-
рывы или к которым нужно добавить разрывы;

�� Auto – разрывы размеров появляются автоматически во всех точках пере-
сечения объектов, которые пересекают выбранный размер. При измене-
нии объекта разрывы размера обновляются автоматически; 

�� Manual – ручное размещение разрывов;
�� Remove – все разрывы размеров удаляются из выбранных размеров.

Выноски.и.пояснительные.надписи
Команда mLEADER, предназначенная для построения выноски, вы-
зывается из падающего меню Dimension → Multileader или щелчком на 
пиктограмме Leader в группе Leaders ленты Annotate, а также в группе 
Annotation ленты Home в рабочем пространстве Drafting & Annotation 
(рис. 11.31. 11.32).

Рис. 11.31. Инструменты построения выносок на ленте Annotate

Выноски и пояснительные надписи
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Рис. 11.32. Инструменты построения выносок на ленте Home

Запросы команды mLEADER:
Specify leader arrowhead location or [leader Landing first/Content 

first/Options] <Options>: – указать первую точку выноски
Specify leader landing location: – указать следующую точку выноски, 

а затем ввести текст

Выноской называется линия, соединяющая на рисунке пояснительную надпись 
с объектом, к которому она относится. Выноски и пояснительные надписи ассо-
циативны, то есть при редактировании одного из этих объектов соответственно 
изменяется и другой.

Выноску можно начать от любой точки и от любого объекта рисунка. Все свой-
ства выноски, ее цвет, вес линии, масштаб, тип стрелки, размер и пр. определяются 
установкой текущего размерного стиля для первой размерной стрелки.

Для связи пояснительной надписи и выноски применяется короткий отрезок, 
который называется полкой. Полки ставятся в случае, если отклонение от гори-
зонтального положения превышает 15°. Для точного указания начальной точки 
выноски следует использовать объектную привязку.

Пояснительные надписи могут представлять собой многострочные тексты, рам-
ки допусков формы и расположения поверхностей или вхождения блоков. Они 
либо строятся «с нуля», либо копируются из уже существующих пояснений.

Тексты пояснительных надписей вводятся в диалоговом окне Text Formatting.

Параметры линии-выноски, стрелки и пояснения, а также способ рас-
положения текста относительно выноски можно задать в диалоговом 
окне Multileader Style Manager (рис. 11.33), которое загружается коман-
дой mLEADERstYLE из падающего меню Format → Multileader Style или 
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щелчком на пиктограмме Multileader Style Manager в группе Annotation ленты 
Home, а также в группе Leaders ленты Annotate в рабочем пространстве Drafting & 
Annotation. 

Рис. 11.33. Диалоговое окно описания стиля линии-выноски

Для создания нового стиля следует, щелкнув на кнопке New…, загрузить диа-
логовое окно Create New Multileader Style, в котором указываются имя создаваемого 
стиля и его прототип.

Затем загружается диалоговое окно Modify Multileader Style (рис. 11.34), в кото-
ром на вкладке Leader Format настраиваются следующие параметры.

�� В области General задаются общие параметры линии-выноски:
•� Type: – конфигурация линии-выноски: Straight – ломаная, Spline – сплайн, 

None – ничего;
•� Color: – цвет линии-выноски;
•� Linetype: – тип линии-выноски;
•� Lineweight: – ширина линии-выноски.

�� В области Arrowhead задаются параметры внешнего вида стрелок:
•� Symbol: – форма стрелки;
•� Size: – размер стрелки.

�� В области Leader break задаются параметры разрыва: Break size: – длина раз-
рыва.

Выноски и пояснительные надписи
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Рис. 11.34. Диалоговое окно настройки формата линии-выноски

На вкладке Leader Structure диалогового окна Modify Multileader Style (рис. 11.35) 
определяются следующие параметры.

�� В области Constraints задаются параметры ограничений для выноски:
•� Maximum leader points – максимальное количество точек для линии-вы-

носки;
•� First segment angle – угол первого сегмента линии-выноски;
•� Second segment angle – угол второго сегмента линии-выноски.

�� В области Landing settings задаются параметры полки-выноски:
•� Automatically include landing – автоматическое включение горизонтально 

полки-выноски;
•� Set landing distance – размер полки-выноски.

�� В области Scale задается масштаб линии-выноски:
•� Annotative – аннотированная мультивыноска;
•� Scale multileaders to layout – масштабирование линии-выноски по листу;
•� Specify scale: – коэффициент масштабирования линии-выноски.
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Рис. 11.35. Диалоговое окно настройки параметров начертания линии-выноски

На вкладке Content диалогового окна Modify Multileader Style (рис. 11.36) 
определяются следующие параметры.

�� Multileader type: – тип надписи: Mtext – мультитекст; Block – блок, заключен-
ный в рамки различной конфигурации; None – ничего.

�� В области Text options задаются параметры текста линии-выноски:
•� Default text: – текст по умолчанию;
•� Text style: – список доступных текстовых стилей;
•� Text angle: – угол наклона текстовой строки;
•� Text color: – цвет текста;
•� Text height: – высота текста;
•� Always left justify – выравнивание текста по левому краю;
•� Frame text – заключение текста в рамку.

�� В области Leader connection выбирается способ соединения мультивыноски:
•� Horizontal attachment – выноска вставляется слева или справа от тексто-

вого содержимого. При горизонтальном присоединении между текстом 
и выноской создается полка:

Выноски и пояснительные надписи
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Рис. 11.36. Диалоговое окно настройки параметров текста линии-выноски

◊� Left attachment: – подсоединение слева: Top of top line – верх первой 
строки; Middle of top line – середина первой строки; Bottom of top line – 
низ первой строки; Underline of top line – подчеркивание первой стро-
ки; Middle of text – середина текста; Middle of Bottom line – середина по-
следней строки; Bottom of Bottom line – низ последней строки; Underline 
Bottom line – подчеркивание последней строки; Underline all text – под-
черкивание всего текста;

◊� Right attachment: – подсоединение справа (раскрывающийся список 
аналогичен варианту присоединения слева);

◊� Landing gap: – расстояние между линией полки и текстом мультивы-
носки;

•� Vertical attachment – выноска вставляется сверху или снизу от текстового 
содержимого. При вертикальном присоединении полка между текстом 
и выноской не создается:
◊� Top attachment: – выноска присоединяется к верхней стороне тексто-

вого содержимого: Center – по центру; Overline and center – надчерки-
вание и по центру;



333

◊� Bottom attachment: – выноска присоединяется к низу текстового содер-
жимого: Center – по центру; Underline and center – подчеркивание и по 
центру.

Если в списке Multileader type: выбран параметр Block, то вкладка Content диало-
гового окна Modify Multileader Style содержит следующие параметры для настройки 
(рис. 11.37).

Рис. 11.37. Диалоговое окно настройки текста в форме блока

В области Block options задаются параметры блока:

�� Source block: – форма блока, используемого в качестве содержимого муль-
тивыноски: Detail Callout – выноска детали; Slot – сегмент; Circle – окруж-
ность; Box – прямоугольник; Hexagon – шестиугольник; Triangle – треуголь-
ник; User Block – пользовательский блок;

�� Attachment: – способ прикрепления блока к мультивыноске: Center Extents – 
по центру границ; Insertion point – точка вставки;

�� Color: – цвет блока содержимого мультивыноски;
�� Scale: – масштаб блока после вставки.

Выполните упражнение R11 из раздела 3.

Выноски и пояснительные надписи
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Допуски.формы.и.расположения
Допуски формы и расположения проставляются в прямоугольных рамках и 

показывают отклонения формы, контура, ориентации и расположения элементов 
чертежа. Допуски формы подразделяются на допуски прямолинейности, 
плоскостности, округлости, цилиндричности и профиля продольного сечения.

Команда tOLERANCE, предназначенная для формирования допусков 
формы и расположения, вызывается из падающего меню Dimension →   
Tolerance… или щелчком на пиктограмме Tolerance в группе Dimensions 
ленты Annotate в рабочем пространстве Drafting & Annotation.

Команда tOLERANCE загружает диалоговое окно Geometric Tolerance, пред-
назначенное для определения параметров допусков формы и расположения 
(рис. 11.38).

Рис. 11.38. Диалоговое окно допусков формы и расположения

�� В области Sym – вызов диалогового окна обозначения геометрических ха-
рактеристик Symbol и выбор символа (рис. 11.39).

Рис. 11.39. Диалоговое окно символов
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�� В области Tolerance 1 – вызов диалогового окна Material Condition (рис. 11.40) 
и установка зависимого допуска 1:
•� 1 поле – вставка обозначения диаметра перед значением допуска;
•� 2 поле – формирование значения допуска;
•� 3 поле – выбор в диалоговом окне зависимого допуска Material Condition 

обозначений-модификаторов.

Рис. 11.40. Диалоговое окно установки зависимого допуска

�� В области Tolerance 2 – вызов диалогового окна Material Condition и форми-
рование значения второго допуска в управляющем контуре элемента.

�� В области Datum 1 – вызов диалогового окна Material Condition и формирова-
ние обозначения первой базы комплекта баз:
•� 1 поле – поле для ввода обозначения базы;
•� 2 поле – выбор в диалоговом окне зависимого допуска Material Condition 

обозначений-модификаторов.
�� В области Datum 2 – вызов диалогового окна Material Condition и формирова-

ние обозначения второй базы комплекта баз.
�� В области Datum 3 – вызов диалогового окна Material Condition и формирова-

ние обозначения третьей базы комплекта баз.
�� В поле Height: – установка значения выступающего поля допуска распо-

ложения.
�� В поле Datum Identifier: – определение идентификатора базы.
�� В поле Projected Tolerance Zone: – обозначение выступающего поля допуска.

Маркер.центра
Маркер центра имеет вид крестика для обозначения центра круга или дуги.

Команда DimCENtER обеспечивает простановку маркера центра 
круга или дуги и вызывается из падающего меню Dimension → Center 
Mark или щелчком на пиктограмме Center Mark в группе Dimensions лен-
ты Annotate в рабочем пространстве Drafting & Annotation.

Запросы команды DimCENtER:

Select arc or circle: – выбрать дугу или круг

Размер и видимость маркера центра устанавливаются в диалоговом окне управ-
ления размерными стилями Dimension Style Manager. Значение настройки маркера 
центра хранится в системной переменной DIMCEN.

Маркер центра
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Размер маркера центра равен расстоянию от центра круга или дуги до конца 
маркера центра.

Контрольный.размер
Команда DimiNsPECt добавляет в выбранные размеры или удаляет из 
них рамку с контрольным размером и вызывается из падающего меню 
Dimension → Inspection или щелчком на пиктограмме Inspect в группе 
Dimensions ленты Annotate в рабочем пространстве Drafting & Annotation.

Команда DimiNsPECt загружает диалоговое окно Inspection Dimension, в кото-
ром настраиваются следующие параметры (рис. 11.41).

Рис. 11.41. Диалоговое окно контрольного размера

�� Кнопка Select dimensions – выбор размера для добавления или удаления 
контрольного размера.

�� Кнопка Remove Inspection – удаление контрольного размера.
�� Область Shape – управление формой рамки, которая рисуется вокруг мет-

ки, значения размера и процента контроля контрольного размера:
•� Round – создание рамки с закругленными вершинами на двух концах и 

полями внутри рамки, разделенными вертикальными линиями;
•� Angular – создание угловой рамки и полями внутри, разделенными вер-

тикальными линиями;
•� None – отсутствие рамки.
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�� Область Label/Inspection rate – формирование текста метки и процента 
конт роля для контрольного размера:
•� Label – включение/отключение поля, в котором указывается текст мет-

ки;
•� Inspection rate – включение/отключение поля, в котором указывается пе-

риодичность контрольного осмотра детали.

Линейный.размер.с.изломом
Команда DimJOGLiNE добавляет в выбранные размеры или удаляет из 
них линии с изломом (рис. 11.42) и вызывается из падающего меню 
Dimension → Jogged Linear или щелчком на пиктограмме Dimension, 
Dimjogline в группе Dimensions ленты Annotate в рабочем пространстве 
Drafting & Annotation.

Запросы команды DimJOGLiNE:

Select dimension to add jog or [Remove]: – выбрать размер для добав-
ления излома

Specify jog location (or press ENTER): – указать положение излома или 
нажать Enter

Рис. 11.42. Линейный размер с изломом

Наклон.выносных.линий
Команда DimEDit с ключом Oblique осуществляет наклон выносных 
линий линейных размеров (рис. 11.43) и вызывается из падающего 
меню Dimension → Oblique или щелчком на пиктограмме Oblique в груп-
пе Dimensions ленты Annotate в рабочем пространстве Drafting & 

Annotation.

Запросы команды DimEDit:

Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>: _o – 
операция редактирования размеров, переход в режим наклона выносных линий

Наклон выносных линий
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Select objects: – выбрать редактируемый размер
Select objects: – выбрать редактируемый размер или нажать Enter для за-

вершения выбора
Enter obliquing angle (press ENTER for none): – указать угол наклона 

выносных линий или нажать Enter, если наклон не нужен

Рис. 11.43. Линейный размер с наклоном выносных линий

Редактирование.размерного.текста
Команда DimtEDit обеспечивает редактирование размерного текста и вызы-
вается из падающего меню Dimension → Align Text или щелчком на соответствую-
щих пиктограммах в группе Dimensions ленты Annotate в рабочем пространстве 
Drafting & Annotation.
Щелчком на пиктограмме Dimension Text Edit на панели инструментов Dimension.

Запросы команды DimtEDit:

Select dimension: – выбрать размер
Specify new location for dimension text or [Left/Right/Center/Home/

Angle]: – указать новое положение размерного текста или ввести один из ключей

Ключи команды DimtEDit:

�� Left – выравнивание размерного текста по левому краю. Команда 
DimtEDit с ключом Left вызывается из падающего меню 
Dimension → Align Text → Left;

�� Right – выравнивание размерного текста по правому краю. Коман-
да DimtEDit с ключом Right вызывается из падающего меню 
Dimension → Align Text → Right;

�� Center – размещение размерного текста по центру. Команда 
DimtEDit с ключом Center вызывается из падающего меню 
Dimension → Align Text → Center;

�� Home – возвращение размерного текста в первоначальное положе-
ние. Команда DimtEDit с ключом Home вызывается из падающего 
меню Dimension → Align Text → Home;
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�� Angle – поворот размерного текста на заданный угол. Команда 
DimtEDit с ключом Angle вызывается из падающего меню 
Dimension → Align Text → Angle. При этом выдаются запросы:

Select dimension: – выбрать размер
Specify new location for dimension text or [Left/Right/Center/Home/

Angle]: A – переход в режим указания угла
Specify angle for dimension text: – указать угол поворота размерного 

текста

Обновление.размера
Команда DimstYLE с ключом apply обеспечивает обновление размера 
и вызывается из падающего меню Dimension → Update или щелчком на 
пиктограмме Update в группе Dimensions ленты Annotate в рабочем про-
странстве Drafting & Annotation.

Редактирование.размера
Команда DimEDit обеспечивает редактирование.
Запросы команды DimEDit:

Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>: – 
выполнить операцию редактирования размеров, указав один из ключей

Select objects: – выбрать объекты

Ключи команды DimEDit:

�� Home – вернуть;
�� New – создание нового текста и загрузка интерфейса мультитекста;
�� Rotate – поворот размерного текста. При этом выдаются запросы:

Enter type of dimension editing [Home/New/Rotate/Oblique] 
<Home>: R – режим поворота размерного текста
Specify angle for dimension text: – указать угол поворота размер-
ного текста
Select objects: – выбрать объекты

�� Oblique – наклонить размер. Команда DimEDit с ключом Oblique вы-
зывается из падающего меню Dimension → Oblique. При этом выдаются за-
просы:
Enter type of dimension editing [Home/New/Rotate/Oblique] 
<Home>: O – режим наклона
Select objects: – выбрать объекты
Select objects: – нажать Enter для окончания выбора объектов
Enter obliquing angle (press ENTER for none): – указать угол на-
клона или нажать Enter, если наклон не нужен

Редактирование размера
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Управление.размерными.стилями
Размерный стиль – это именованная совокупность значений всех размерных пере-
менных, определяющая внешний вид размера на рисунке: стиль стрелок, располо-
жение текста и пр.

Команда DimstYLE обеспечивает работу с размерными стилями в 
диалоговом окне Dimension Style Manager – рис. 11.44. Команда вызыва-
ется из падающего меню Dimension → Dimension Style... или щелчком на 
пиктограмме Dimension Style… в группе Annotation ленты Home или в 
группе Dimensions ленты Annotate в рабочем пространстве Drafting & 
Annotation.

Рис. 11.44. Диалоговое окно управления размерными стилями

Диспетчер размерных стилей Dimension Style Manager позволяет выполнить мно-
жество различных задач:

�� Set Current – установить текущий стиль;
�� New… – создать новый размерный стиль;
�� Modify… – изменить имеющийся размерный стиль;
�� Override… – на время переопределить имеющийся размерный стиль;
�� Compare… – сравнить два размерных стиля или создать перечень всех 

свойств стиля;
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�� воспользоваться предварительным просмотром размерных стилей рисун-
ка и их свойств;

�� переименовать размерные стили;
�� удалить размерные стили.

Размерные стили задают внешний вид и формат размеров. Они позволяют 
обес печить соблюдение стандартов и упрощают редактирование размеров. Раз-
мерный стиль определяет следующие характеристики:

�� формат и положение размерных линий, линий-выносок, стрелок и марке-
ров центра;

�� внешний вид, положение и поведение размерного текста;
�� правила взаимного расположения текста и размерных линий;
�� глобальный масштаб размера;
�� формат и точность основных, альтернативных и угловых единиц;
�� формат и точность значений допусков.

Для нанесения размера программа AutoCAD применяет текущий размерный 
стиль. По умолчанию в качестве такового используется ISO–25 (International 
Standards Organization), если пользователем не задан иной. Стиль STANDARD соз-
дан на основе стандарта ANSI (American National Standards Institute, США), хотя 
и не полностью с ним совпадает. Если в рисунке используются британские едини-
цы, то стиль STANDARD применяется по умолчанию. Стили DIN (Deutsches Institut 
fur Normung, Германия) и JIS (Japanese Industrial Standards, Япония) имеются в 
шаблонах рисунков AutoCAD DIN и JIS.

Определение базового размерного стиля следует начать с присвоения ему име-
ни и сохранения. Новый стиль базируется на текущем и включает в себя все по-
следующие изменения расположения размерных элементов, размещения текста 
и вида пояснительных надписей. Для создания нового размерного стиля необхо-
димо в Диспетчере размерных стилей Dimension Style Manager щелкнуть на кнопке 
New.... Откроется диалоговое окно Create New Dimension Style – рис. 11.45.

Рис. 11.45. Диалоговое окно создания размерного стиля

Управление размерными стилями
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�� New Style Name: – имя создаваемого размерного стиля.
�� Start With: – имя стиля, на основе которого создается новый размерный 

стиль.
�� Annotative – создание аннотативного размерного стиля.
�� Use for: – создание размерного субстиля, применимого только к отдельным 

типам размеров:
•� All dimensions – все размеры;
•� Linear dimensions – линейные размеры;
•� Angular dimensions – угловые размеры;
•� Radius dimensions – радиусы;
•� Diameter dimensions – диаметры;
•� Ordinate dimensions – ординатные размеры;
•� Leaders and Tolerances – выноски и допуски.

После определения этих параметров на экране появится диалоговое окно New 
Dimension Style, содержащее семь вкладок. Результат действия каждого параметра, 
устанавливаемого в этом диалоговом окне, сразу можно просмотреть на образце.

�� Вкладка Lines (рис. 11.46) позволяет осуществлять:
•� в области Dimension lines – управление внешним видом размерных ли-

ний:
◊� Color: – цвет размерных линий (системная переменная DIMCLRD);
◊� Linetype: – тип размерных линий (системная переменная DIMLTYPE);
◊� Lineweight: – толщина размерных линий (системная переменная 

DIMLWD);
◊� Extend beyond ticks: – удлинение размерных линий за выносные линии 

(системная переменная DIMDLE);
◊� Baseline spacing: – шаг в базовых размерах (системная переменная 

DIMDLI);
◊� Suppress: – подавление размерных линий: Dim line 1 – от первой точки; 

Dim line 2 – от второй точки (системные переменные DIMSD1 и DIMSD2);
•� в области Extension lines – управление внешним видом выносных ли-

ний:
◊� Color: – цвет выносных линий (системная переменная DIMCLRE);
◊� Linetype ext line 1: – тип первой выносной линии (системная перемен-

ная DIMLTEX1);
◊� Linetype ext line 2: – тип второй выносной линии (системная перемен-

ная DIMLTEX2);
◊� Lineweight: – толщина выносной линий (системная переменная 

DIMLWE);
◊� Suppress: – подавление выносных линий: Ext line 1 – от первой точки; 

Ext line 2 – от второй точки (системные переменные DIMSE1 и DIMSE2);
◊� Extend beyond dim lines: – удлинение выносных линий за размерные 

линии (системная переменная DIMEXE);
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◊� Offset from origin: – отступ выносных линий от объекта (системная 
переменная DIMEXO);

◊� Fixed length extension lines – выносные линии фиксированной длины 
(системная переменная DIMFXLON);

◊� Length: – полная длина выносных линий от размерной линии до ис-
ходной точки размера (системная переменная DIMFXL).

Рис. 11.46. Диалоговое окно определения параметров размерного стиля:  
вкладка управления линиями

�� Вкладка Symbols and Arrows (рис. 11.47) позволяет осуществлять настрой-
ку параметров символов и стрелок:
•� в области Arrowheads – управление геометрией размерных стрелок:

◊� First: – стрелка от первой точки (системная переменная DIMBLK1);
◊� Second: – стрелка от второй точки (системная переменная DIMBLK2);
◊� Leader: – стрелка от линии-выноски (системная переменная 

DIMLDRBLK);
◊� Arrow size: – размер стрелок (системная переменная DIMASZ);

Управление размерными стилями
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Рис. 11.47. Диалоговое окно определения параметров размерного стиля:  
вкладка управления символами и стрелками

•� в области Center marks – управление формой и размером маркера центра 
при нанесении диаметров и радиусов (системная переменная DIMCEN):
◊� None: – маркер центра отсутствует;
◊� Mark: – наличие маркера центра;
◊� Line: – маркер центра в виде центровых линий;
◊� Size: – размер маркера центра или центровой линии;

•� в области Dimension Break – управление шириной зазора разрывов раз-
мера; 
◊� Break size: – размер зазора; 

•� в области Arc length symbol – формирование символа длины дуги (си-
стемная переменная DIMARCSYM):
◊� Preceding dimension text – расположение символа длины дуги перед 

текстом размера;
◊� Above dimension text – расположение символа длины дуги над текстом 

размера;
◊� None – отсутствие символа длины дуги;
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•� в области Radius jog dimension – формирование отображения излома 
(зигзага) для радиальных размеров:
◊� Jog angle: – угол излома (системная переменная DIMJOGANG);

•� в области Linear jog dimension – формирование отображения излома для 
линейных размеров:
◊� Jog height factor: – высота излома, которая определяется расстоянием 

между двумя вершинами углов, составляющих излом.

�� Вкладка Text обеспечивает управление размерным текстом: его стилем, вы-
сотой, местоположением относительно размерной линии, зазором между 
текстом и размерной линией и пр. (рис. 11.48):
•� в области Text appearance – определяются свойства текста:

◊� список Text style: – доступные текстовые стили. Чтобы создать или 
отредактировать текстовый стиль, следует нажать кнопку , распо-

ложенную рядом с этим списком, и тем самым загрузить диалоговое 
окно Text Style (системная переменная DIMTXSTY);

◊� Text color: – цвет размерного текста (системная переменная DIMCLRT);
◊� Fill color: – цвет фона текста в размерах (системные переменные 

DIMTFILL и DIMTFILLCLR);
◊� Text height: – высота текста (системная переменная DIMTXT). Если в 

текстовом стиле задана фиксированная высота, она имеет приори-
тет перед величиной, указанной в списке Text height:. Поэтому, чтобы 
пользователь имел возможность изменять данный параметр на вклад-
ке Text, высота в описании используемого текстового стиля должна 
быть равна 0;

◊� Fraction height scale: – масштаб дробных значений относительно 
остального текста (системная переменная DIMTFAC);

◊� Draw frame around text – заключение размерного текста в рамку (си-
стемная переменная DIMGAP);

•� в области Text placement определяются размещение и выравнивание тек-
ста относительно размерных и выносных линий, а также образмеривае-
мого объекта:
◊� Vertical: – вертикальное расположение текста (системная переменная 

DIMTAD): Centered – по центру, с разрывом размерной линии; Above – 
над размерной линией и параллельно ей. Оба варианта учитывают на-
правление осей X и Y. Outside – текст всегда размещается за предела-
ми образмериваемого объекта независимо от направления осей X и Y; 
JIS – над размерной линией, даже если не параллельно ей. Варианты 
вертикального выравнивания основаны на горизонтальных размерах;

◊� Horizontal: – расположение текста по горизонтали (системная пере-
менная DIMJUST): Centered – по центру между двумя выносными ли-
ниями; At Ext Line 1 – выравнивание текста влево и расположение его у 
первой выносной линии вдоль размерной линии; At Ext Line 2 – вправо; 

Управление размерными стилями
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Over Ext Line 1 – вдоль первой выносной линии; Over Ext Line 2 – вдоль 
второй выносной линии;

◊� View Direction: – направление взгляда для размерного текста (систем-
ная переменная DIMTXTDIRECTION): Left-to-Right – слева направо; Right-
to-Left – справа налево;

◊� Offset from dim line: – отступ от размерной линии (системная перемен-
ная DIMGAP);

•� в области Text alignment – определяется ориентация размерного текста 
между размерными линиями и вне их (системные переменные DIMTIH 
и DIMTOH):
◊� Horizontal – горизонтальное размещение текста;
◊� Aligned with dimension line – размещение текста вдоль размерной линии;
◊� ISO standard – если размерный текст находится внутри выносных ли-

ний, то он располагается вдоль размерной линии; если текст находит-
ся снаружи, то он располагается горизонтально.

Рис. 11.48. Диалоговое окно определения параметров размерного стиля,  
вкладка управления размерным текстом
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�� Вкладка Fit позволяет установить правила взаимного расположения раз-
мерных, выносных линий и текста (рис. 11.49). Здесь же задается глобаль-
ный масштаб для размеров:
•� в области Fit options осуществляется подбор оптимального варианта раз-

мещения текста и стрелок при недостатке места между выносными ли-
ниями (системные переменные DIMATFIT, DIMTIX и DIMSOXD):
◊� Either text or arrows (best fit) – оптимальное перемещение либо текста, 

либо стрелок за пределы выносных линий (системная переменная 
DIMATFIT);

◊� Arrows – перемещение стрелок за пределы выносных линий (систем-
ная переменная DIMATFIT);

◊� Text – перемещение текста за пределы выносных линий (системная 
переменная DIMATFIT);

◊� Both text and arrows – перемещение и текста, и стрелок за пределы вы-
носных линий (системная переменная DIMATFIT);

◊� Always keep text between ext lines – текст всегда размещается между вы-
носными линиями (системная переменная DIMTIX);

◊� Suppress arrows if they don’t fit inside extension lines – подавление стрелок 
в случае, если они не помещаются между выносными линиями (си-
стемная переменная DIMSOXD);

•� область Text placement предназначена для установки правил перемеще-
ния размерного текста, если текст был помещен программой или вруч-
ную за пределы выносных линий (системная переменная DIMTMOVE):
◊� Beside the dimension line – перемещать вместе с размерной линией. Кро-

ме того, текст может быть отодвинут от размерной линии (системная 
переменная DIMTMOVE);

◊� Over dimension line, with leader – отодвинутый размерный текст нанести 
с выноской (системная переменная DIMTMOVE);

◊� Over dimension line, without leader – отодвинутый размерный текст на-
нести без выноски (системная переменная DIMTMOVE);

•� в области Scale for dimension features – настраиваются параметры масшта-
бов размерных элементов:
◊� Annotative – аннотативный размер;
◊� Scale dimensions to layout – использование масштаба видового экрана 

относительно пространства листа (системная переменная DIMSCALE);
◊� Use overall scale of: – позволяет указать глобальный коэффициент мас-

штаба для всех параметров размерного стиля, задающих размеры, 
расстояния и отступы, включая высоту текста и величину стрелок 
(системная переменная DIMSCALE). Глобальный масштаб не влияет на 
отмеренные расстояния, координаты, углы и допуски. По умолчанию 
он принимается равным 1. Для увеличения размерных элементов сле-
дует задать больший масштаб, для уменьшения – меньший;

Управление размерными стилями
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•� в области Fine tuning управляют подгонкой размерных элементов:
◊� Place text manually – размещение текста вручную (системная перемен-

ная DIMUPT);
◊� Draw dim line between ext lines – размерная линия размещается между 

выносными, даже если стрелки и размерный текст вынесены за их 
пределы (системная переменная DIMTOFL).

Рис. 11.49. Диалоговое окно определения параметров размерного стиля,  
вкладка размещения

�� Вкладка Primary Units позволяет определить формат и точность основ-
ных линейных и угловых единиц, вид измеренных значений размеров 
(рис. 11.50):
•� в области Linear dimensions задаются формат и точность для цепей, ли-

нейных, параллельных, ординатных и неугловых базовых размеров:
◊� Unit format: – определяется формат единиц (системная переменная 

DIMLUNIT): Scientific – научные, Decimal – десятичные, Engineering – 
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технические, Architectural – архитектурные, Fractional – дробные или 
Windows Desktop – установленные в Windows. В последнем случае еди-
ницы берутся из настроек языка и стандартов на панели управления;

◊� Precision: – задается число десятичных знаков для единиц, и в зави-
симости от выбранных единиц показывается формат представления 
величин (системная переменная DIMDEC);

◊� Fraction format: – определяется формат дробных единиц (системная 
переменная DIMFRAC): Horizontal – с горизонтальной чертой, Diagonal – 
с косой чертой или Not Stacked – в одну строку;

◊� Decimal separator: – назначается десятичный разделитель (системная 
переменная DIMDSEP): Period – точка, Comma – запятая или Space – 
пробел. Если выбраны единицы, установленные в Windows, AutoCAD 
использует десятичный разделитель, заданный в настройках языка и 
стандартов на панели управления;

◊� Round off: – устанавливается точность округления величин всех ли-
нейных размеров (системная переменная DIMRND). Здесь можно вво-
дить любое число, содержащее до пяти десятичных знаков. Значение 
для округления не должно превышать величину точности, заданную 
на этой вкладке;

◊� Prefix: – указание префикса, добавляемого перед величиной размера 
(системная переменная DIMPOST). Заданный здесь префикс заменяет 
обозначения радиуса и диаметра, которые AutoCAD автоматически 
проставляет для соответствующих размеров. Для записи префикса 
можно использовать специальные символы и управляющие коды;

◊� Suffix: – указание суффикса, проставляемого после величины размера 
(системная переменная DIMPOST). Для записи суффикса можно ис-
пользовать специальные символы и управляющие коды;

•� в области Measurement scale производятся следующие настройки линей-
ных параметров масштаба измерений:
◊� Scale factor: – масштабный коэффициент для линейных размеров (си-

стемная переменная DIMLFAC);
◊� Apply to layout dimensions only – масштабный коэффициент применяет-

ся только к размерам, нанесенным на листах (системная переменная 
DIMLFAC);

•� в области Zero suppression устанавливается подавление нулей (систем-
ная переменная DIMZIN).
◊� Leading – подавление ведущих нулей во всех десятичных размерах;
◊� Traling – подавление замыкающих нулей во всех десятичных размерах;
◊� Sub-units factor: – количество вспомогательных единиц в основной 

единице;
◊� Sub-unit suffix: – включение суффикса для вспомогательной единицы 

значения размера;
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◊� 0 feet – подавление вывода значения футов в размере формата футы-
дюймы, если расстояние меньше одного фута;

◊� 0 inches – подавление вывода значения дюймов в размере формата фу-
ты-дюймы, если расстояние равно целому числу футов;

•� в области Angular dimensions устанавливаются параметры угловых раз-
меров:
◊� Units format: – формат единиц для угловых размеров (системная пе-

ременная DIMAUNIT): Decimal Degrees – десятичные градусы, Degrees 
Minutes Seconds – градусы/минуты/секунды, Gradians – градиенты, 
Radians – радианы;

◊� Precision: – число десятичных знаков в угловых размерах (системная 
переменная DIMADEC);

•� в области Zero suppression устанавливается подавление ведущих и замы-
кающих нулей (системная переменная DIMAZIN):
◊� Leading – ведущие нули в угловых десятичных размерах;
◊� Traling – замыкающие нули в угловых десятичных размерах.

Рис. 11.50. Диалоговое окно определения параметров размерного стиля,  
вкладка определения основных единиц
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�� Вкладка Alternate Units позволяет определить формат и точность альтерна-
тивных единиц, которые используются для обозначения величин разме-
ров в дополнительной системе единиц (рис. 11.51). Обычно с их помощью 
проставляются значения размеров в метрических единицах, если рисунок 
выполнен в британской системе, и наоборот. Величина размера в альтер-
нативных единицах наносится в квадратных скобках [] непосредственно 
после размерного текста в основных единицах. Для нанесения в размерах 
альтернативных единиц следует установить флажок Display alternate units 
(системная переменная DIMALT):

Рис. 11.51. Диалоговое окно определения параметров размерного стиля,  
вкладка определения альтернативных единиц

•� в области Alternate units устанавливается формат единиц для всех типов 
размеров, кроме угловых:
◊� Unit format: – формат единиц (системная переменная DIMALTU): 

Scientific – научные, Decimal – десятичные, Engineering – техниче-
ские, Architectural Stacked – архитектурные, Fractional Stacked – дроб-
ные, Architectural – архитектурные, Fractional – дробные или Windows 
Desktop – установленные в Windows;
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◊� Precision – число знаков после запятой для альтернативных единиц 
(системная переменная DIMALTD);

◊� Multiplier for alt units: – коэффициент пересчета из основных единиц 
в альтернативные (системная переменная DIMALTF). Альтернативные 
единицы получаются путем умножения основных единиц на задан-
ный здесь коэффициент (по умолчанию предлагается коэффициент 
0.03937, используемый для пересчета миллиметров в дюймы);

◊� Round distances to: – округление значений для всех типов размеров, 
кроме угловых (системная переменная DIMALTRND);

◊� Prefix: – префикс альтернативного размерного текста (системная пе-
ременная DIMAPOST);

◊� Suffix: – суффикс альтернативного размерного текста (системная пе-
ременная DIMAPOST);

•� в области Zero suppression устанавливается значение ведущих и замы-
кающих нулей, а также нулевых значений футов и дюймов (системная 
переменная DIMALTZ). Параметры данной области аналогичны настрой-
кам вкладки Primary Units (см. выше);

•� в области Placement настраивается размещение альтернативных единиц 
в размерном тексте:
◊� After primary value – альтернативные единицы размещаются за основ-

ным значением.
◊� Below primary value – основные единицы размещаются над размерной 

линией, а альтернативные – под ней.

�� Вкладка Tolerances управляет параметрами формата и точности проста-
новки допусков, показывающих пределы, в которых может варьироваться 
размер (рис. 11.52):
•� в области Tolerance format настраиваются следующие параметры нанесе-

ния допусков:
◊� Method: – способ нанесения допусков (системная переменная DIMTOL): 

None – отключение нанесения допусков; Symmetrical – верхнее и ниж-
нее отклонения симметричны, Deviation – верхнее и нижнее отклоне-
ния различаются; Limits – максимальная и минимальная величины 
размера; Basic – построение рамки вокруг размерного текста, обычно 
используется для обозначения теоретически точных размеров;

◊� Precision – число десятичных разрядов в значениях допусков (систем-
ная переменная DIMTDEC);

◊� Upper value: – максимальное значение при нанесении отклонений и 
предельных размеров (системная переменная DIMTP). AutoCAD ис-
пользует эту же величину для симметричных допусков;

◊� Lower value: – значение нижнего предельного отклонения (системная 
переменная DIMTM);

◊� Scaling for height: – отношение высоты текста допусков к высоте основ-
ного размерного текста (системная переменная DIMTFAC);
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◊� Vertical position: – вертикальное выравнивание текстов симметричных 
допусков и отклонений (системная переменная DIMTOLJ): Bottom – по 
нижней границе размерного текста; Middle – по середине текста; Top – 
по верхней границе;

•� в области Tolerance alignment – устанавливаются выравнивание значений 
верхнего и нижнего допусков при помещении их друг над другом:
◊� Align decimal separators – выравнивание по десятичным разделителям;
◊� Align operational symbols – выравнивание по рабочим обозначениям;

•� в области Alternate unit tolerance – устанавливаются допуски для альтер-
нативных единиц:
◊� Precision: – число десятичных разрядов в значениях допусков после 

запятой (системная переменная DIMALTTD);
•� в области Zero suppression – устанавливается подавление ведущих и за-

мыкающих нулей, а также нулевых значений футов и дюймов (систем-
ная переменная DIMALTTZ). Параметры данной области аналогичны на-
стройкам вкладки Primary Units (см. выше).

Рис. 11.52. Диалоговое окно определения параметров размерного стиля,  
вкладка простановки допусков
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Выполните упражнения RS1–RS6 и тест 4 из раздела 3.

Кнопка Compare… в Диспетчере размерных стилей Dimension Style Manager 
(см. рис. 11.44) позволяет сравнить два размерных стиля или создать пере-
чень всех свойств стиля. При этом загружается диалоговое окно сравнения 
размерных стилей Compare Dimension Styles (рис. 11.53).

Рис. 11.53. Диалоговое окно сравнения размерных стилей

�� В списке Compare: устанавливается стиль, который необходимо сравнить.
�� В списке With: устанавливается стиль, с которым необходимо сравнить.
�� Ниже приведены все свойства сравниваемых размерных стилей:
•� Description – описание свойства;
•� Variable – размерная переменная, задающая это свойство;
•� значения системных переменных для свойств, различающихся для срав-

ниваемых размерных стилей.
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Выбор.объектов
Большинство команд редактирования AutoCAD требует предварительного указа-
ния объектов для работы с ними. Выбранные объекты – один или несколько – на-
зываются набором. Он может, например, включать в себя все объекты определен-
ного цвета или объекты, расположенные на определенном слое. Такой набор можно 
создать как до, так и после вызова команды редактирования. С одним и тем же 
набором допустимо производить несколько операций редактирования. Если уста-
новлена системная переменная HIGHLIGHT, выбранные объекты будут подсвечены.

После того как вызвана одна из команд редактирования, AutoCAD предлагает 
выбрать объекты. В командной строке появляется запрос:

Select objects: – выбрать объекты

При этом перекрестье указателя мыши заменяется прицелом выбора. Выбор 
отдельных объектов производится с помощью мыши или одним из способов, ко-
торые описаны ниже в этом разделе.

При формировании набора можно выбрать последний созданный объект, теку-
щий набор объектов, а также все объекты рисунка. Имеется возможность добав-
лять объекты в набор и удалять их оттуда. Различные объекты могут заноситься в 
набор разными способами. Например, для выбора всех объектов области рисунка, 
кроме нескольких, нужно сначала выделить все объекты, а затем удалить из на-
бора те, которые не предназначены для редактирования.

Способы и ключи выбора объектов:

�� Add – включает режим добавления для пополнения существующего набо-
ра. Это начальный режим, устанавливаемый для выбора объектов;

�� ALL – позволяет выбрать все примитивы, в том числе те, которые располо-
жены на отключенных, заблокированных и замороженных слоях;

�� AUto – выделяет объект, на который установлен указатель мыши. Если 
не было выбрано ни одного объекта, указанная точка становится первым 
углом рамки;

�� BOX – задает прямоугольник по двум точкам. Если вторая точка находится 
справа от первой, процесс выбора аналогичен выбору рамкой Window, а 
если слева – выбору секущей рамкой Crossing;

�� Crossing – секущая рамка выделяет все объекты, которые находятся 
внутри или пересекают контур рамки. По умолчанию в ответ на запрос 
Select objects: можно указать первый угол рамки, а затем второй в на-
правлении справа налево. Для того чтобы объект можно было выбрать, он 
должен быть хотя бы частично видимым. При выборе секущей рамкой в 
командной строке появляются запросы:
Select objects: C – переход в режим выбора объектов с помощью 
секущей рамки
Specify first corner: – указать первый угол рамки
Specify opposite corner: – указать противоположный угол рамки
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�� CPolygon – сочетает режимы Crossing и Wpolygon и позволяет выбрать 
объекты как полностью заключенные в многоугольник, так и пересекаю-
щие его границу. Область задается путем указания точек вокруг объектов, 
которые следует выбирать. Многоугольник строится по мере установки 
этих точек; он может быть любой формы, но без самопересечений, и авто-
матически замыкается при указании каждой новой вершины. От послед-
ней заданной точки до указателя мыши протянута «резиновая нить». При 
этом в командной строке появляются запросы:
Select objects: CP – переход в режим выбора объектов с помощью 
многоугольника
First polygon point: – указать первую точку многоугольника
Specify endpoint of line or [Undo]: – указать конечную точку 
отрезка
Specify endpoint of line or [Undo]: – указать конечную точку 
отрезка
Specify endpoint of line or [Undo]: – нажать клавишу Enter для 
завершения выбора объектов с помощью многоугольника

�� Fence – выбирает только объекты, которые пересекает линия. В отличие от 
рамочного или секущего многоугольника, она может пересекать саму себя. 
При указании точек генерируется линия выбора и «резиновая нить» про-
тягивается к перекрестью графического курсора. При этом в командной 
строке появляются запросы:
First fence point: – указать первую точку линии
Specify endpoint of line or [Undo]: – указать конечную точку 
отрезка
Specify endpoint of line or [Undo]: – указать конечную точку 
отрезка
Specify endpoint of line or [Undo]: – нажать клавишу Enter для 
завершения выбора объектов

�� Group – выбирает все объекты внутри заданной группы;
�� Last – выбирает последний нарисованный объект, видимый на экране;
�� Multiple – одновременно выбирает несколько объектов. Процесс выбора 

не считается законченным до тех пор, пока на очередной запрос выбора 
объекта не нажата клавиша Enter или пробел;

�� Previous – выбирает текущий набор объектов;
�� Remove – устанавливает режим удаления указанных объектов из набора;
�� SIngle – устанавливает режим выбора единственного объекта. Когда ука-

зан один объект или одна группа, выбор считается законченным и запрос 
выбора объектов не повторяется;

�� Undo – отменяет (удаляет) последний добавленный в набор объект;
�� Window – выбирает объекты, которые целиком попадают в рамку. По умол-

чанию в ответ на запрос Select objects: можно указать первый угол 

Выбор объектов
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рамки, а затем второй угол по диагонали от первого в направлении слева 
направо;

�� WPolygon – аналогичен режиму Window, но при этом позволяет выбрать 
объекты, содержащиеся внутри области, границы которой составляет мно
гоугольник.

Если системная переменная PICKDRAG включена, определение рамки произво-
дится при нажатой левой кнопке мыши. Если PICKDRAG отключена (такова на-
стройка по умолчанию), то рамка задается двумя щелчками кнопкой мыши в пер-
вой и второй точках.

Очень трудно выбирать объекты, которые лежат близко или непосредственно 
друг на друге. Для этой цели удобнее пользоваться мышью, одновременно удер-
живая нажатой клавишу Ctrl: в результате включается режим циклического пере-
бора, когда по щелчку мыши объекты выбираются один за другим, до тех пор пока 
не будет выделен требуемый.

Для управления процессом выбора объектов необходимо загрузить из падаю-
щего меню Tools → Options... диалоговое окно Options. Задать метод сортировки 
объектов можно на вкладке User Preferences. Режим выбора объектов и размер при-
цела определяются на вкладке Selection диалогового окна Options. Подробнее об 
этом рассказывается в главе 3.

Существует возможность ограничить выбираемый набор объектов такими 
свойствами, как цвет, слой и тип объекта и пр., путем использования функции 
быст рого выбора или фильтра списков. Например, можно выбрать на рисунке 
только окружности красного цвета или, наоборот, выбрать все объекты, кроме 
окружностей красного цвета.

Функция Quick Select позволяет сформировать набор объектов по заданному 
критерию отбора. В диалоговом окне Object Selection Filters задаются и сохраняются 
для дальнейшего применения различные фильтры выбора объектов.

При фильтрации распознаются только цвета, типы линий и веса линий, явно 
присвоенные объектам, но не унаследованные по слою. Например, объект может 
быть красным, потому что для него задан цвет ByLayer, а слою присвоен красный 
цвет. Следовательно, фильтр должен учитывать также объекты, расположенные 
на слое, которому присвоен красный цвет, и имеющие цвет ByLayer, а не красный. 
В частично загруженных рисунках функция Quick Select не учитывает незагружен-
ных объектов.

Для формирования набора объектов с помощью функции быстрого 
выбора следует выбрать из падающего меню Tools → Quick Select... и в 
открывшемся диалоговом окне Quick Select установить необходимые 
параметры (рис. 12.1).

В рабочем пространстве Drafting & Annotation инструмент быстрого выбора на-
ходится на ленте Home в группе Utilities.



359

Рис. 12.1. Диалоговое окно быстрого выбора

�� В списке Apply to: указывается набор объектов, к которому необходимо 
применить быстрый выбор:
•� Entire drawing – весь чертеж;
•� Current srlection – текущий набор.

�� Кнопка Select objects позволяет сформировать текущий набор объектов.
�� В списке Object type: указывается тип выбранных объектов для включения 

в критерии фильтрации.
�� В списке Properties: перечисляются свойства объектов для фильтра.
�� В списке Operator: указывается диапазон применения фильтра:
•� = Equals – равно;
•� <> Not Equal – не равно;
•� > Greater than – больше;
•� < Less than – меньше;
•� Select All – выбрать все.

�� В списке Value: устанавливается значение выбранного свойства для фильт-
ра.

Выбор объектов
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�� В области How to apply: определяется действие над отобранными объекта-
ми:
•� Include in new selection set – включить в новый набор;
•� Exclude from new selection set – исключить из нового набора.

�� Append to current selection set – добавить в текущий набор.

Для настройки более сложных фильтров выбора объектов и сохранения их 
под заданными именами достаточно в ответ на запрос Select objects: ввести 
‘filter и в диалоговом окне Object Selection Filters, показанном на рис. 12.2, опреде-
лить фильтр-список.

�� В области Select Filter осуществляется выбор фильтра: ACIS-тело, атрибут, 
блок, вектор нормали, выноска, высота, высота текста, видовой экран, до-
пуск, дуга, значение текста, изображение, имя атрибута, имя блока, имя 
данных, имя формы, конец отрезка, круг, луч, масштаб типа линий, муль-
тилиния, начало отрезка, область, образец штриховки, основание DWF, 
отрезок, плоскость сечения, поворот блока, поворот текста, полилиния, 
положение атрибута, положение блока, положение текста, положение 
точки, положение формы, полоса, прямая, радиус дуги, радиус круга, раз-
мер, размерный стиль, слой, спираль, сплайн, стиль мультилиний, табли-
ца, твердое тело, текст, текстовый стиль, тип линий, точка, точка вставки 
изображения, уровень, фигура, форма, цвет, центр видового экрана, центр 
дуги, центр круга, центр эллипса, штриховка, эллипс, трехмерная грань, 
начало AND, конец AND, начало OR, конец OR, начало NOT, конец NOT, 
начало XOR, конец XOR.
•� кнопка Select… – выбрать из списка возможных значений для данного 

типа объектов;
•� кнопка Add to List: – добавить в список свойств текущего фильтра новый 

параметр отбора;
•� кнопка Substitute – заменить текущее свойство фильтра;
•� кнопка Add Selected Object< – добавить объект в список фильтра.

�� Кнопка Edit Item – изменить свойство.

�� Кнопка Delete – удалить выбранное свойство из текущего фильтра.

�� Кнопка Clear List – удалить все свойства из текущего фильтра.

�� В области Named Filters – просмотр, сохранение и удаление списков име-
нованных фильтров:
•� в списке Current: – текущий фильтр;
•� кнопка Save As: – сохранить фильтр и его свойства под именем;
•� кнопка Delete Current Filter List – удалить текущий список.

�� Кнопка Apply – применить.

�� Кнопка Cancel – отмена установок.

�� Кнопка Help – вызов справочной системы.
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Рис. 12.2. Диалоговое окно определения фильтр-списков

Редактирование.с.помощью.ручек
Выбранными объектами можно манипулировать с помощью ручек – маленьких 
квадратиков, которые высвечиваются в определяющих точках выбранных объек-
тов (рис. 12.3).

Рис. 12.3. Примеры примитивов с ручками

Редактирование с помощью ручек
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При включенном режиме работы с ручками выбор объектов производится до 
редактирования, а манипуляции с ними выполняются с помощью указателя мыши 
или ключевых слов. Таким образом, использование ручек позволяет минимизиро-
вать обращения к меню.

Графический курсор привязывается к ручке, по которой он проходит. Если ре-
жим работы с ручками включен, то объекты, удаляемые из набора, перестают под-
свечиваться, но ручки на них остаются. Удаление ручек из набора объектов про-
изводится нажатием клавиши Esc. Для удаления из набора, содержащего ручки, 
какого-либо объекта следует нажать клавишу Shift при его выборе.

Определением ручек в блоках управляет системная переменная GRIPBLOCK. 
Если она равна 1, ручки устанавливаются на всех объектах, входящих в блок, а 
если 0, на блоке изображается только одна ручка в точке его вставки.

Для включения ручек используется команда DDGRiPs. При этом все установ-
ки назначаются на вкладке Selection диалогового окна Options. Оно вызывается из 
падающего меню Tools → Options... (см. главу 3).

Для редактирования с помощью ручек нужно 
выбрать ручку, точка расположения которой бу-
дет базовой точкой редактирования. После этого 
выбирается один из режимов ручек: Move – пере-
нести, Mirror – симметрировать, Rotate – повер-
нуть, Scale – масштабировать или Stretch – рас-
тянуть. Переключение этих режимов осуществля-
ется при вводе начальной буквы или циклически, 
последовательным нажатием клавиши Пробел или 
Enter. Например, для установки режима Stretch 
нужно ввести S или нажимать Enter до тех пор, пока 
в командной строке не появится ключ Stretch. 
Чтобы выйти из режима работы с ручками и вер-
нуться к подсказке Command:, необходимо ввести Х 
или нажать клавишу Esc. Наиболее удобный спо-
соб выбора режима редактирования с помощью 
ручек – использование контекстного меню ручек 
(рис. 12.4), которое открывается щелчком правой 
кнопки мыши при выделенной ручке.

Если при указании в команде редактирования первого нового положения для 
объекта нажата клавиша Shift, активизируется режим многократного копирования. 
Например, в режиме Stretch функция многократного копирования растягивает 
объект, такой как отрезок, и копирует его в любую точку графической области, 
указанную пользователем. Другой способ активизировать режим многократного 
копирования – выбрать ключ Copy в командной строке, а затем указывать поло-
жение или вводить координаты для каждой копии объекта. Режим многократного 
копирования остается активным до тех пор, пока не будет выбран другой текущий 
режим ручек или нажата клавиша Enter для завершения операции.

Рис. 12.4. Контекстное меню 
ручки



363

Набор команд редактирования в программе AutoCAD находится в падающем 
меню Modify (рис. 12.5).

Рис. 12.5. Инструменты команд редактирования

В рабочем пространстве Drafting & Annotation инструменты команд редактирова-
ния расположены на ленте инструментов Home в группе Modify (рис. 12.6).

Редактирование с помощью ручек
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Рис. 12.6. Инструменты команд редактирования  
в рабочем пространстве Drafting & Annotation

Удаление.и.восстановление.объектов
Команда ERAsE осуществляет удаление (стирание) объектов. Она вы-
зывается из падающего меню Modify → Erase или щелчком на пикто-
грамме Erase в группе Modify ленты Home в рабочем пространстве 
Drafting & Annotation.

Запросы команды ERAsE:
Select objects: – выбрать объекты
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения работы команды

Выбор объектов, которые следует стереть, может производиться любым из до-
ступных способов.

Для восстановления удаленных последней командой ERAsE объектов исполь-
зуется команда OOPs. Ее название – «ОЙ» – весьма удачно отражает эмоции 
пользователя, испытываемые в момент применения этой команды.

Пример..Удаление.объектов
Удалить из рисунка две нижние окружности и окружность в центре (рис. 12.7).
Запустите команду ERAsE, вызвав ее из падающего меню Modify → Erase, или 

щелчком на пиктограмме Erase в группе Modify ленты Home. Ответьте на запросы:
_ERASE
Select objects: W – переход в режим выбора объектов рамкой
Specify first corner: – укажите точку 1
Specify opposite corner: – укажите точку 2
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Select objects: – укажите точку 3 для выбора окружности в центре
Select objects: – нажмите клавишу Enter для завершения работы команды

Рис. 12.7. Удаление объектов

Выполните упражнения Er1–Er3 из раздела 4.

Копирование.объектов
Команда COPY осуществляет копирование объектов. Она вызывается 
из падающего меню Modify → Copy или щелчком на пиктограмме Copy 
в группе Modify ленты Home в рабочем пространстве Drafting & Annotation.

Запросы команды COPY:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify base point or [Displacement/mOde] <Displacement>: – указать 

базовую точку или перемещение
Specify second point or <use first point as displacement>: – указать 

вторую точку размещения копии объекта или считать перемещением первую точ-
ку

Specify second point or [Exit/Undo] <Exit>: – указать вторую точку раз-
мещения копии объекта или нажать Enter для завершения команды

Specify second point or [Exit/Undo] <Exit>:

Запрос, требующий указания точки смещения копии объекта, делается много-
кратно. Каждое смещение определяется относительно исходной базовой точки. 
После получения нужного количества копий в ответ на запрос необходимо нажать 
клавишу Enter.

Копирование объектов
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Пример..Копирование.
объектов
Получить две копии детали (рис. 12.8).
Запустите команду COPY, вызвав ее из 

падающего меню Modify → Copy или щелч-
ком на пиктограмме Copy в группе Modify 
ленты Home. Ответьте на запросы:

_COPY
Select objects: – укажите точку 1
Select objects: – нажмите клавишу Enter для завершения выбора объектов
Specify base point or [Displacement/mOde] <Displacement>: – укажите 

точку 2
Specify second point or <use first point as displacement>: – укажите 

точку 3
Specify second point or [Exit/Undo] <Exit>: – укажите точку 4
Specify second point or [Exit/Undo] <Exit>: – нажмите клавишу Enter 

для завершения работы команды

Выполните упражнения Co1 и Co2 из раздела 4.

Зеркальное.отображение.объектов
Команда miRROR осуществляет зеркальное отображение объектов. 
Она вызывается из падающего меню Modify → Mirror или щелчком на 
пиктограмме Mirror в группе Modify ленты Home в рабочем пространстве 
Drafting & Annotation.

Запросы команды miRROR:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify first point of mirror line: – указать первую точку оси отражения
Specify second point of mirror line: – указать вторую точку оси отра-

жения
Delete source objects? [Yes/No] <N>: – удалить или оставить исходные 

объекты

При зеркальном отображении тексты, атрибуты и их определения также при-
обретают зеркальный вид. Это происходит из-за того, что операция зеркального 
отображения выполняется в строгом соответствии с математическими законами 
отражения.

Рис. 12.8. Копирование объектов
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Чтобы полученный в результате зеркального отображения текст имел при-
вычный вид, следует присвоить системной переменной MIRRTEXT значение 0. По 
умолчанию эта переменная включена. Если же ее отключить, отображенный текст 
будет ориентирован и выровнен точно так же, как и исходный. При этом коман-
да miRROR особым образом обрабатывает элементы текста и примитивы атри-
бутов, отображая их в прежней ориентации. Переменная MIRRTEXT воздействует 
только на простые объекты текста, созданные командами tEXt, DtEXt, mtEXt, а 
также на определения атрибутов и их переменные, не входящие внутрь вставлен-
ного блока. Тексты и постоянные атрибуты внутри блока отражаются, как и все 
составляющие блока, зеркально, независимо от установки системной переменной 
MIRRTEXT.

Пример..Зеркальное.отображение.объектов
Зеркально отобразить деталь относительно вертикальной оси, не удаляя ста-

рый объект (рис. 12.9).
Запустите команду miRROR, вызвав ее из падающего меню Modify → Mirror или 

щелчком на пиктограмме Mirror в группе Modify ленты Home. Ответьте на запросы:
_MIRROR
Select objects: W – переход в режим выбора объектов рамкой
Specify first corner: – укажите точку 1
Specify opposite corner: – укажите точку 2
Select objects: – нажмите клавишу Enter для завершения выбора объектов
Specify first point of mirror line: END – укажите точку 3 с динамической 

объектной привязкой к конечной точке отрезка
Specify second point of mirror line: END – укажите точку 4 с динамиче-

ской объектной привязкой к конечной точке отрезка
Delete source objects? [Yes/No] <N>: – нажмите клавишу Enter для отказа 

от удаления старого объекта

Рис. 12.9. Зеркальное отображение объектов

Выполните упражнения Mi1–Mi3 из раздела 4.

Зеркальное отображение объектов
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Создание.подобных.объектов
Команда OFFsEt осуществляет создание подобных объектов (эквидис-
тант) с заданным смещением. Она вызывается из падающего меню 
Modify → Offset или щелчком на пиктограмме Offset в группе Modify лен-
ты Home в рабочем пространстве Drafting & Annotation.

Можно строить подобные отрезки, дуги, окружности, двухмерные полили-
нии, эллипсы, эллиптические дуги, прямые, лучи и плоские сплайны. Подобные 
окружности имеют диаметр, больший или меньший, чем исходный, в зависимости 
от того, как задано смещение. Если оно указано точкой вне окружности, то новая 
окружность имеет больший диаметр, а если внутри окружности – меньший.

Запросы команды OFFsEt:

Current settings: Erase source=No Layer=Source OFFSETGAPTYPE=0 – 
текущие установки команды

Specify offset distance or [Through/Erase/Layer] <Through>: – ука-
зать величину смещения

Select object to offset or [Exit/Undo] <Exit>: – выбрать объект для 
создания подобных

Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: – 
указать точку, определяющую сторону смещения

Select object to offset or [Exit/Undo] <Exit>: – выбрать объект для 
создания подобных

Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: – 
указать точку, определяющую сторону смещения

Select object to offset or [Exit/Undo] <Exit>: – нажать клавишу Enter 
для завершения команды

Ключи команды OFFsEt:

�� Through – позволяет задать смещение через точку. При этом выдаются 
следующие запросы:

Specify offset distance or [Through/Erase/Layer] <Through>: T – 
переход в режим указания смещения через точку
Select object to offset or [Exit/Undo] <Exit>: – выбрать объект 
для создания подобных
Specify through point or [Exit/Multiple/Undo] <Exit>: – указать, 
через какую точку
Select object to offset or [Exit/Undo] <Exit>: – нажать клавишу 
Enter для завершения работы команды

�� Erase – позволяет удалить исходный объект после смещения;
�� Layer – позволяет ввести параметр слоя для смещаемых объектов: теку-

щий или источник;
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�� Multiple – осуществляет создание нескольких подобных объектов (экви-
дистант) с заданным смещением.

Значение текущей величины смещения хранит системная переменная 
OFFSETDIST. Переменная OFFSETGAPTYPE управляет способом создания подобных 
полилиний, если при смещении образуется зазор между отдельными сегментами 
полилинии.

Пример..Построение.эквидистанты
Построить несколько вариантов эквидистанты заданной 

полилинии (рис. 12.10).
Запустите команду OFFsEt, вызвав ее из падающего 

меню Modify → Offset, или щелчком на пиктограмме Offset в 
группе Modify ленты Home. Ответьте на запросы:

_OFFSET
Specify offset distance or [Through/Erase/Layer] 

<Through>: 15 – смещение
Select object to offset or [Exit/Undo] <Exit>: – 

укажите точку 1
Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: – 

укажите точку 2
Select object to offset or [Exit/Undo] <Exit>: – укажите точку 3
Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: – 

укажите точку 4
. . .
Select object to offset or <exit>: – нажмите клавишу Enter для завер-

шения работы команды

Выполните упражнение Of1 из раз-
дела 4.

Размножение.
объектов.массивом
Команды, осуществляющие размножение объ
ектов массивом, вызываются из падающего 
меню Modify → Array. В рабочем пространстве 
Drafting & Annotation соответствующие инстру-
менты расположены в группе Modify ленты 
Home (рис. 12.11).

Рис. 12.10. 
Построение 

эквидистанты

Рис. 12.11. Инструменты 
размножения объектов массивом

Размножение объектов массивом
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Команда ARRAYRECt  осуществляет размножение объектов прямо
угольным массивом (рис. 12.12). Она вызывается из падающего меню 
Modify → Array → Rectangular Array или щелчком на пиктограмме 
Rectangular Array в группе Modify ленты Home в рабочем пространстве 
Drafting & Annotation.

Запросы команды ARRAYRECt:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Type = Rectangular  Associative = Yes
Select grip to edit array or [ASsociative/Base point/COUnt/Spacing/

COLumns/Rows/Levels/eXit]<eXit>: – выбрать ручку для редактирования мас-
сива

Рис. 12.12. Пример прямоугольного массива

При обращении к команде ARRAYRECt загружается инструментальная лета 
Array Creation (рис. 12.13), которая содержит следующие инструменты настройки 
прямоугольного массива.

Рис. 12.13. Инструменты настройки прямоугольного массива
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�� Группа Columns:

•�  Column Count – количество столбцов в массиве;

•�  Column Spacing – расстояние между столбцами;

•�  Total Column Distance – общее расстояние между первым и по-
следним столбцами.

�� Группа Rows:

•�  Row Count – количество рядов в массиве;

•�  Row Spacing – расстояние между рядами;

•�  Total Row Distance – общее расстояние между первым и послед-
ним рядами;

•� Incremental Elevation – расстояние между уровнями рядов.

�� Группа Levels:

•�  Level Count – количество уровней в массиве;

•�  Level Spacing – расстояние между уровнями;

•�  Total Level Distance – общее расстояние между первым и по-
следним уровнями.

�� Группа  Properties:

•�  Associative – контроль ассоциативности массива; 

•�  Base Point – переопределение базовой точки массива.

�� Close Array – закрытие инструментальной ленты Array Creation.

Команда ARRAYPAtH осуществляет размножение объектов по задан
ной траектории (рис. 12.14). Она вызывается из падающего меню 
Modify → Array → Path Array или щелчком на пиктограмме Path Array в 
группе Modify ленты Home в рабочем пространстве Drafting & Annotation.

Запросы команды ARRAYPAtH:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Type = Path  Associative = Yes

Размножение объектов массивом
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Select path curve: – выбрать траекторию
Select grip to edit array or [ASsociative/Method/Base point/Tangent 

direction/Items/Rows/Levels/Align items/Z direction/eXit]<eXit>: – 
выбрать ручку для редактирования массива

Рис. 12.14. Пример массива с заданной траекторией

При обращении к команде ARRAYPAtH загружается инструментальная лента 
Array (рис. 12.15), которая содержит следующие инструменты настройки массива.

Рис. 12.15. Инструменты настройки массива, формируемого по траектории

�� Группа Items:

•� Item Count – количество элементов в массиве;

•� Item Spacing – расстояние между элементами;

•� Total Item Distance – общее расстояние между первым и по-
следним элементами.

Инструменты групп Rows и Levels аналогичны инструментам настройки пря-
моугольного массива:

�� Группа Properties:

•� Base Point – переопределение базовой точки массива. Обеспе-
чивает перемещение первого элемента массива относительно на-
чальной точки траектории; 
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•� Measure Method – сохранение текущего интервала, при  редак-
тировании траектории  или количества элементов;

•� Divide Method – перераспределение элементов равномерным 
делением вдоль длины траектории;

•� Align Items – выравнивание элементов с учетом угла поворота 
относительно ориентации траектории;

�� Close Array – закрытие инструментальной ленты Array.

Команда ARRAYPOLAR осуществляет размножение объектов круго
вым массивом (рис. 12.16). Она вызывается из падающего меню 
Modify → Array → Polar Array, или щелчком на пиктограмме Polar Array в 
группе Modify ленты Home в рабочем пространстве Drafting & Annotation.

Рис. 12.16. Пример кругового массива

Запросы команды ARRAYPOLAR:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Type = Polar  Associative = Yes
Specify center point of array or [Base point/Axis of rotation]: – 

указать центр кругового массива 
Enter number of items or [Angle between/Expression] <4>:– указать 

количество элементов
Specify the angle to fill (+=ccw, -=cw) or [EXpression] <360>:– ука-

зать угол заполнения

Размножение объектов массивом
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Press Enter to accept or [ASsociative/Base point/Items/Angle 
between/Fill angle/ROWs/Levels/ROTate items/eXit]<eXit>:– нажать кла-
вишу Enter для завершения команды

Выполните упражнения Ar1 и Ar2 из раздела 4.

Перемещение.объектов
Команда mOVE осуществляет перемещение объектов. Она вызывает-
ся из падающего меню Modify → Move или щелчком на пиктограмме 
Move в группе Modify ленты Home в рабочем пространстве Drafting & 
Annotation.

Запросы команды mOVE:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify base point or [Displacement] <Displacement>: – указать базо-

вую точку или перемещение
Specify second point or <use first point as displacement>: – указать 

вторую точку перемещения или считать перемещением первую точку

Пример..Перемещение.объектов
Переместите две нижние окружности так, чтобы их центры совпали с маркера-

ми центров, обозначенными в нижней части рисунка (рис. 12.17).
Запустите команду mOVE, вызвав ее 

из падающего меню Modify → Move или 
щелчком на пиктограмме Move в группе 
Modify ленты Home. Ответьте на запросы:

_MOVE
Select objects: W – переход в ре-

жим выбора объектов рамкой
Specify first corner: – укажите 

точку 1
Specify opposite corner: – ука-

жите точку 2
Select objects: – нажмите клави-

шу Enter для завершения выбора объек-
тов

Specify base point or [Displacement] <Displacement>: CEN – укажите 
точку 3 с динамической объектной привязкой к центру левой окружности

Рис. 12.17. Перемещение объектов
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Specify second point or <use first point as displacement>: INT – 
укажите точку 4 с динамической объектной привязкой к пересечению отрезков 
маркера

Выполните упражнения Mo1 и Mo2 из раздела 4.

Поворот.объектов
 Команда ROtAtE осуществляет поворот объектов. Она вызывается 
из падающего меню Modify → Rotate или щелчком на пиктограмме 
Rotate в группе Modify ленты Home в рабочем пространстве Drafting & 
Annotation.

Запросы команды ROtAtE:

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0 – 
текущие установки отсчета углов в ПСК

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify base point: – указать базовую точку
Specify rotation angle or [Copy/Reference] <0>: – указать угол пово-

рота

Ключи команды ROtAtE:

�� Copy – копировать поворачиваемый объект;
�� Reference – используется для поворота относительно существующего 

угла. При этом выдаются следующие запросы:
Current positive angle in UCS: ANGDIR=counterclockwise 
ANGBASE=0 – текущие установки отсчета углов в ПСК
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объ-
ектов
Specify base point: – указать базовюу точку
Specify rotation angle or [Copy/Reference] <0>: R – переход в 
режим задания угла со ссылкой
Specify the reference angle <0>: – указать опорный угол
Specify the new angle or [Points] <0>: – указать новый угол

Пример..Поворот.объектов
Поверните деталь на 45° (рис. 12.18).
Запустите команду ROtAtE, вызвав ее из падающего меню Modify → Rotate, или 

щелчком на пиктограмме Rotate в группе Modify ленты Home. Ответьте на запросы:

Поворот объектов
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_ROTATE
Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0
Select objects: – укажите точку 1
Select objects: – нажмите клавишу Enter для завершения выбора объектов
Specify base point: CEN – укажите точку 2 с динамической объектной при-

вязкой к центру дуги
Specify rotation angle or [Copy/Reference] <0>: 45 – угол поворота

Рис. 12.18. Поворот объектов

Выполните упражнения Ro1–Ro3 из раздела 4.

Масштабирование.объектов
Команда sCALE осуществляет масштабирование объектов. Она вы-
зывается из падающего меню Modify → Scale или щелчком на пикто-
грамме Scale в группе Modify ленты Home в рабочем пространстве 
Drafting & Annotation.

Запросы команды sCALE:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify base point: – указать базовую точку
Specify scale factor or [Copy/Reference] <default>: – указать коэф-

фициент масштабирования

При масштабировании объектов масштабные коэффициенты по осям X и Y 
одинаковы. Таким образом, можно делать объект больше или меньше, но нельзя 
изменять соотношение его размеров по этим осям. Масштабирование выполняет-
ся путем указания базовой точки и новой длины объекта, из которой выводится 
масштабный коэффициент для текущих единиц, или путем явного ввода коэффи-
циента. Кроме того, коэффициент может определяться путем указания текущей 
длины и новой длины объекта.
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При масштабировании с указанием масштабного коэффициента производится 
изменение размеров выбранного объекта во всех измерениях. Если масштабный 
коэффициент больше единицы, то объект увеличивается, а если меньше едини-
цы – уменьшается.

Ключи команды sCALE:

�� Copy – копировать масштабируемый объект;
�� Reference – применяется для определения коэффициента масштабиро-

вания с использованием размеров существующих объектов в качестве 
ссылок. При этом выдаются следующие запросы:
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify base point: – указать базовую точку
Specify scale factor or [Copy/Reference] <default>: R – переход 
в режим указания масштабного коэффициента со ссылкой
Specify reference length <default>: – указать длину опорного 
отрезка
Specify new length or [Points] <default>: – указать новую длину

Один из наиболее эффективных вариантов использования ключа Reference – 
изменение масштаба всего рисунка. Если оказалось, что выбранные единицы 
рисунка не соответствуют заданным требованиям, то для выбора всех объектов 
на чертеже (например, при помощи рамки) можно воспользоваться командой 
sCALE, а затем, применяя ключ Reference, указать два конца объекта, требуемая 
длина которого известна, и ввести данную длину. При этом масштаб всех объектов 
на рисунке изменится соответствующим образом.

Пример..Масштабирование.
объектов
Увеличить изображение детали в 2,5 раза 

(рис. 12.19).
Запустите команду sCALE, вызвав ее из 

падающего меню Modify → Scale, или щелчком 
на пиктограмме Scale в группе Modify ленты 
Home. Ответьте на запросы:

_SCALE
Select objects: W – переход в режим вы-

бора объектов рамкой
Specify first corner: – укажите точку 1
Specify opposite corner: – укажите 

точку 2
Select objects: – нажмите клавишу Enter для завершения выбора объектов
Specify base point: – укажите точку 3

Рис. 12.19. Масштабирование 
объектов

Масштабирование объектов
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Specify scale factor or [Copy/Reference] <1.0000>: 2.5 – коэффици-
ент масштабирования

Выполните упражнения Sc1–Sc3 из раздела 4.

Растягивание.объектов
Команда stREtCH осуществляет растягивание объектов, сохраняя 
при этом связь с остальными частями рисунка. Она вызывается из па-
дающего меню Modify → Stretch или щелчком на пиктограмме Stretch в 
группе Modify ленты Home в рабочем пространстве Drafting & Annotation.

Запросы команды stREtCH:
Select objects to stretch by crossing-window or crossing-poly-

gon... – выбор растягиваемых объектов секущей рамкой или секущим много-
угольником

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify base point or [Displacement] <Displacement>: – указать базо-

вую точку или перемещение
Specify second point or <use first point as displacement>: – указать 

вторую точку перемещения или считать перемещением первую точку

Ключ команды stREtCH:

�� теперь для команды stREtCH существует параметр перемещения 
Displacement, с помощью которого определяются относительное рассто-
яние и направление. Последнее введенное значение перемещения сохра-
няется.

Формирование набора объектов для этой команды должно производиться 
с ключом секущей рамки Crossing или Cpolygon. Любые объекты, полностью 
заключенные в рамку или многоугольник, перемещаются командой stREtCH 
точно так же, как командой mOVE. Отрезки, дуги и сегменты полилиний, пере-
секающие рамку, растягиваются только путем перемещения конечных точек, на-
ходящихся внутри нее: конечные точки за рамкой остаются неизменными. В дугах 
центральная точка и ее начальный и конечный углы регулируются таким образом, 
что стрелка дуги (расстояние от центральной точки хорды до дуги) поддержива-
ется постоянной. Команда stREtCH не влияет на ширину полилиний, на инфор-
мацию о сопряжениях и углах касания.

Вершины полос и фигур, находящиеся внутри рамки, также перемещаются, 
в то время как вершины за пределами рамки остаются на месте. Другие прими-
тивы перемещаются или остаются на месте в зависимости от того, находится ли 
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определяющая их точка внутри рамки. Определяющими точками являются центр 
круга, точка вставки формы или блока (если точка вставки блока перемещается 
командой stREtCH, то перемещаются и все его атрибуты), крайняя левая точка 
базовой линии для текста и для определения атрибута – независимо от типа вы-
равнивания, использованного при вычерчивании элемента.

Если команда stREtCH вызывается при действующем предварительном на-
боре, то для рассмотрения определяющих точек, подпадающих под действие ко-
манды, используются только примитивы, которые выбраны с помощью обычной 
или секущей рамки.

Пример..Растягивание.
объектов
Растянуть объект со смещением вправо 

(рис. 12.20).
Запустите команду stREtCH, вызвав ее из 

падающего меню Modify → Stretch, или щелчком 
на пиктограмме Stretch в группе Modify ленты 
Home. Ответьте на запросы:

_STRETCH
Select objects to stretch by cross-

ing-window or crossing-polygon...
Select objects: C – переход в режим вы-

бора объектов секущей рамкой
Specify first corner: – укажите точку 1
Specify opposite corner: – укажите точку 2
Select objects: – нажмите клавишу Enter для завершения выбора объектов
Specify base point or [Displacement] <Displacement>: – укажите точку 3
Specify second point or <use first point as displacement>: – укажите 

точку 4

Выполните упражнения St1–St3 из раздела 4.

Увеличение.объектов
Команда LENGtHEN, которая осуществляет увеличение объектов, вы-
зывается из падающего меню Modify → Lengthen или щелчком на пикто-
грамме Lengthen в группе Modify ленты Home в рабочем пространстве 
Drafting & Annotation (см. рис. 12.6).

Действие команды LENGtHEN не распространяется на замкнутые объекты.

Рис. 12.20. Растягивание 
объектов

Увеличение объектов
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Запросы команды LENGtHEN:

Select an object or [DElta/Percent/Total/DYnamic]: – выбрать объект 
или один из ключей

Current length: – текущая длина

Ключи команды LENGtHEN:

�� Delta – изменение длины объекта на заданную величину со стороны, 
ближней к точке указания. Ключ Delta также изменяет угол дуги на задан-
ную величину со стороны выбранной конечной точки дуги. При задании 
положительного значения дуга удлиняется, а при задании отрицательного 
значения – укорачивается. При использовании этого ключа выдаются сле-
дующие запросы:

Select an object or [DElta/Percent/Total/DYnamic]: DE – переход 
в режим изменения длины объекта на заданную величину
Enter delta length or [Angle] <0.0000>: – указать приращение 
длины или ключ Angle, который позволяет изменить центральный угол 
дуги на заданную величину
Select an object to change or [Undo]: – выбрать объект для изменения
Select an object to change or [Undo]: – нажать клавишу Enter для 
завершения команды

�� Percent – задание длины объекта в процентном отношении относительно 
исходной. При использовании этого ключа выдаются следующие запросы:

Select an object or [DElta/Percent/Total/DYnamic]: P – переход в 
режим задания длины объекта в процентном отношении
Enter percentage length <100.0000>: – указать процент длины
Select an object to change or [Undo]: – выбрать объект для изменения
Select an object to change or [Undo]: – нажать клавишу Enter для 
завершения команды

�� Total – задание длины объекта или угла дуги равными абсолютной ве-
личине, отсчитываемой от фиксированного конца объекта. Ключ Total 
также устанавливает для внутреннего угла выбранной дуги значение за-
данного полного угла. При использовании этого ключа выдаются следую-
щие запросы:

Select an object or [DElta/Percent/Total/DYnamic]: T – переход 
в режим задания длины объекта или угла дуги равными абсолютной 
величине
Specify total length or [Angle] <1.0000)>: – указать полную длину 
или ключ Angle, который позволяет изменить угол выбранной дуги
Select an object to change or [Undo]: – выбрать объект для изменения
Select an object to change or [Undo]: – нажать клавишу Enter для 
завершения команды
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�� Dynamic – включение режима динамического задания длины. Длина вы-
бранного объекта изменяется путем динамического перемещения одной 
из его конечных точек, а другой конец объекта остается фиксированным. 
При использовании этого ключа выдаются следующие запросы:

Select an object or [DElta/Percent/Total/DYnamic]: DY – переход 
в режим динамического задания длины
Select an object to change or [Undo]: – выбрать объект для изменения
Specify new end point: – указать новую конечную точку
Select an object to change or [Undo]: – выбрать объект для изменения
Specify new end point: – указать новую конечную точку
Select an object to change or [Undo]: – нажать клавишу Enter для 
завершения команды

Обрезка.объектов
Команда tRim, которая осуществляет отсечение объектов по режу-
щей кромке, вызывается из падающего меню Modify → Trim или щелч-
ком на пиктограмме Trim в группе Modify ленты Home в рабочем про-
странстве Drafting & Annotation.

Запросы команды tRim:

Current settings: Projection=UCS Edge=None – текущие установки
Select cutting edges ... – выбор режущих кромок
Select objects or <select all>: – выбрать объекты, являющиеся режущей 

кромкой
Select objects: – нажать клавишу Enter для завершения выбора режущей 

кромки
Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo]: – выбрать обрезаемый объ-

ект (при использовании клавиши Shift – удлиняемый) или один из ключей
Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo]: – нажать клавишу Enter для 

завершения работы команды

Секущей кромкой могут служить отрезки, дуги, окружности, двухмерные по-
лилинии, эллипсы, сплайны, прямые, лучи. Объект, не пересекающийся с секущей 
кромкой, можно отсечь в месте их воображаемого пересечения. Когда секущая 
кромка определяется двухмерной полилинией, ее ширина не учитывается и обрез-
ка проводится по осевой линии. В пространстве листа секущими кромками могут 
служить границы видовых экранов.

Ключи команды tRim.

�� Fence – объекты выбираются с помощью пересекающей их линии. Линия 
выбора представляет собой последовательность временных линейных сег-

Обрезка объектов
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ментов и задается с помощью двух или более точек. При этом линия вы-
бора не образует замкнутого контура.

�� Crossing – объекты выбираются с помощью секущей рамки. При этом 
выбираются объекты, находящиеся внутри прямоугольной рамки и пере-
секающие ее. Разрешается выбор вдоль прямоугольной секущей рамки по 
часовой стрелке от первой точки до первого обнаруженного объекта.

�� Project – определяет режим отсечения объектов по пересечению их про-
екции с границей в трехмерном пространстве:
•� None – отсечение только тех объектов, которые пересекаются с заданной 

границей;
•� Ucs – определение проекции объекта в плоскости XY текущей ПСК и 

отсечение объекта, не пересекающегося с границей;
•� View – определение проекции объекта в направлении заданного вида и 

отсечение объекта, не пересекающегося с границей.
�� Edge – определяет режим поиска пересечения по продолженной кромке 

другого объекта или только до объекта, который пересекает подлежащий 
обрезке объект в трехмерном пространстве. При обрезке заштрихованных 
объектов не следует присваивать ключу Edge значение Extend, иначе не 
будет происходить соединения режущих кромок, даже если значение до-
пуска замкнутости лежит в пределах нормы:
•� Extend – отсечение объекта по воображаемой продолженной границе;
•� No extend – отсечение объектов по границе, с которой они имеют пере-

сечение.
�� eRase – удаление выбранных объектов. С помощью этого параметра удоб-

но стирать ненужные объекты, не выходя из режима команды TRIM.

Пример..Обрезка.объектов
Отсечь части окружности, нарисованные пунктирной 

линией (рис. 12.21).
Запустите команду tRim, вызвав ее из падающего 

меню Modify → Trim, или щелчком на пиктограмме Trim в 
группе Modify ленты Home. Ответьте на запросы:

_TRIM
Current settings: Projection=UCS Edge=None
Select cutting edges ...
Select objects or <select all>: – укажите точку 1
Select objects: – нажмите клавишу Enter для завершения выбора секущей 

кромки
Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo]: – укажите точку 2
Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo]: – укажите точку 3

Рис. 12.21. Обрезка 
объектов
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Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo]: – нажмите клавишу Enter для 

завершения работы команды

Выполните упражнение Tr1 из раздела 4.

Удлинение.объектов
Команда EXtEND, которая осуществляет удлинение объектов до гра-
ничной кромки, вызывается из падающего меню Modify → Extend или 
щелчком на пиктограмме Extend в группе Modify ленты Home в рабочем 
пространстве Drafting & Annotation.

Запросы команды EXtEND:

Current settings: Projection=UCS Edge=None – текущие установки
Select boundary edges ... – выбор граничных кромок
Select objects or <select all>: – выбрать объекты, являющиеся гранич-

ными кромками
Select objects: – нажать клавишу Enter для завершения выбора граничной 

кромки
Select object to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Undo]: – выбрать удлиняемый объект (при 

использовании клавиши Shift – обрезаемый) или один из ключей
Select object to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Undo]: – нажать клавишу Enter для завер-

шения работы команды

Для удлинения полилиний можно использовать только разомкнутые. Смысл 
этой операции заключается в том, что первый или последний сегмент полилинии 
удлиняется так, как если бы он был одиночным отрезком или дугой.

При удлинении широкой полилинии граничная кромка соприкасается с ее осе-
вой линией. Поскольку торцевой срез широкой полилинии проводится под углом 
90°, то, если граничная кромка не перпендикулярна удлиняемому сегменту, конец 
полилинии частично заходит за кромку. При удлинении конусного сегмента ко-
нечная ширина сегмента корректируется так, чтобы текущая конусность остава-
лась неизменной. Если в результате получается отрицательная конечная ширина, 
она устанавливается равной 0.

Допускается удлинение лучей, но удлинение прямых невозможно. Так же, как 
и окружность, прямая линия не имеет граничной кромки и конечной точки. Луч 
является полуограниченным объектом, поэтому его можно удлинить до новой на-
чальной точки.

Удлинение объектов
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Имеется возможность изменять центральные углы дуг и длин некоторых объ-
ектов. В частности, допускается изменение длины разомкнутых последователь-
ностей отрезков, дуг, разомкнутых полилиний, эллиптических дуг и разомкнутых 
сплайнов. В зависимости от ситуации этот процесс подобен либо удлинению, либо 
обрезке. Изменение длины может производиться различными способами:

�	динамически – буксировкой конечной точки объекта;
�	указанием новой длины в процентном отношении к текущей длине или 

углу;
�	указанием приращения длины или угла, откладываемого от конечной 

точки;
�	установкой полной абсолютной длины объекта или его центрального 

угла.

Граничными кромками могут служить отрезки, дуги, двухмерные полилинии. 
Когда в качестве кромки используется двухмерная полилиния, ее ширина игнори-
руется и объекты удлиняются до ее осевой линии.

Удлиняемые объекты выбираются путем указания той части, которая должна 
удлиняться. Объекты нельзя выделять рамкой, секущей рамкой или объявлять 
последним набором; допустимы только прямое указание, ввод координат и выбор 
линией.

Ключи команды EXtEND.

�� Fence – объекты выбираются с помощью пересекающей их линии. Линия 
выбора представляет собой последовательность временных линейных сег-
ментов и задается с помощью двух или более точек. При этом линия вы-
бора не образует замкнутого контура.

�� Crossing – объекты выбираются с помощью секущей рамки. При этом 
выбираются объекты, находящиеся внутри прямоугольной рамки и пере-
секающие ее. Разрешается выбор вдоль прямоугольной секущей рамки по 
часовой стрелке от первой точки до первого обнаруженного объекта.

�� Project – определяет режим удлинения объектов до пересечения их про-
екции с границей в трехмерном пространстве:
•� None – удлинение только тех объектов, которые пересекаются с задан-

ной границей;
•� Ucs – определение проекции объекта в плоскости XY текущей ПСК и 

удлинение объекта, не пересекающегося с границей;
•� View – определение проекции объекта в направлении заданного вида и 

удлинение объекта, не пересекающегося с границей.
�� Edge – определяет режим продолжения кромки до воображаемого пере-

сечения. Удлинение объекта происходит до пересечения с воображаемой 
гранью другого объекта или только до объекта, действительно пересекаю-
щего этот объект в трехмерном пространстве:
•� Extend – удлинение объекта до воображаемой продолженной границы;
•� No extend – удлинение объектов до границы без ее удлинения.
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Если задано несколько граничных кромок, объект удлиняется до тех пор, пока 
не достигнет первой из них. Этот же объект можно выбрать вновь, чтобы удлинить 
его до следующей граничной кромки.

Пример..Удлинение.объектов
Удлинить верхнюю полилинию до границ дуги 

(рис. 12.22).
Запустите команду EXtEND, вызвав ее из падающего 

меню Modify → Extend или щелчком на пиктограмме 
Extend в группе Modify ленты Home. Ответьте на запросы:

_EXTEND
Current settings: Projection=UCS Edge=None
Select boundary edges ...
Select objects or <select all>: – укажите точку 1
Select objects: – нажмите клавишу Enter для завершения выбора объектов
Select object to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Undo]: – укажите точку 2
Select object to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Undo]: – укажите точку 3
Select object to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Undo]: – укажите точку 4
Select object to extend or shift-select to trim or
[Fence/Crossing/Project/Edge/Undo]: – нажмите клавишу Enter для завер-

шения работы команды

Выполните упражнение Ex1 из раздела 4.

Разбиение.объектов.на.части
Команда BREAK, которая осуществляет разрыв объектов, вызывается 
из падающего меню Modify → Break или щелчком на пиктограмме Break 
в группе Modify ленты Home в рабочем пространстве Drafting & Annotation.

Запросы команды BREAK:

Select objects: – выбрать объекты
Specify second break point or [First point]: – указать вторую точку 

разрыва

Ключ команды BREAK:

�� First point – первая точка, определенная программой автоматически, 
заменяется на указанную пользователем в ответ на запрос:

Рис. 12.22. Удлинение 
объектов

Разбиение объектов на части
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Specify second break point or [First point]: F – переход в режим 
указания первой точки
Specify first break point: – указать первую точку разрыва
Specify second break point: – указать вторую точку разрыва

В зависимости от используемых ключей разрыв можно осуществить без стира-
ния или со стиранием части отрезка, окружности, дуги, двухмерной полилинии, эл-
липса, сплайна, прямой или луча и некоторых других типов объектов. Для разбие-
ния объекта можно либо выбрать объект в первой точке разрыва, а затем указать 
вторую точку разрыва, либо вначале просто выбрать объект, а затем произвести 
указание двух точек разрыва.

Программа преобразует окружность в дугу, удаляя ее часть от первой до вто-
рой точки против часовой стрелки. Чтобы разбить объект на две части, ничего не 
удаляя, нужно указать вторую точку, совпадающую с первой. Это можно сделать 
вводом @ в ответ на запрос второй точки.

Команда BREAK, которая осуществляет разрыв объектов в одной точ-
ке, вызывается щелчком на пиктограмме Break at Point в группе Modify 
ленты Home в рабочем пространстве Drafting & Annotation. При этом вы-
даются запросы:

Select objects: – выбрать объекты
Specify second break point or [First point]: F – переход в 
режим указания первой точки
Specify first break point: – указать первую точку разрыва
Specify second break point: @ – завершение работы команды

Пример..Разбиение.объектов.на.части
Разорвать и удалить часть окружности, нарисованную пунктирной линией 

(рис. 12.23).
Запустите команду BREAK, вызвав ее из падающего меню Modify → Break, 

или щелчком на пиктограмме Break в группе Modify ленты Home. Ответьте на 
запросы:

_BREAK
Select object: – укажите точку 1
Specify second break point or [First point]: – 

укажите точку 2

Выполните упражнение Br1 из раздела 4.
Рис. 12.23. 

Разбиение объектов 
на части



387

Объединение.сегментов
Команда JOiN осуществляет объединение отдельных сегментов объ-
ектов для формирования одного целого объекта. Команда вызывается 
из падающего меню Modify → Join или щелчком на пиктограмме Join в 
группе Modify ленты Home в рабочем пространстве Drafting & Annotation.

Запросы команды JOiN:

Select source object: – выбрать исходный поддерживаемый объект: от-
резок, разомкнутую полилинию, дугу, эллиптическую дугу, разомкнутую линию 
сплайна или спираль

В зависимости от того, какой выбран исходный объект, отобразится один из 
следующих вариантов команды JOiN:

�� отрезок – объединяемые отрезки должны быть коллинеарны, то есть ле-
жать на одной бесконечной линии, но между ними должны быть зазоры:

Select source object: – выбрать исходный отрезок
Select lines to join to source: – выбрать отрезки, которые необхо-
димо объединить с источником
Select lines to join to source: – нажать клавишу Enter для завер-
шения работы команды

�� полилиния – объединяемыми объектами могут быть линии, полилинии 
или дуги. Между объектами не может быть зазоров, и они должны лежать 
в одной плоскости, параллельной плоскости XY ПСК;

�� дуга – объединяемые дуговые сегменты должны лежать на одной вообра-
жаемой окружности, и между ними должны быть зазоры, то есть дуги мо-
гут быть соприкасающиеся и несоприкасающиеся, но у них должен быть 
общий центр и радиус. Ключ cLose преобразует исходную дугу в окруж-
ность. При объединении двух или более дуг их объединение начинается с 
исходной дуги в направлении против часовой стрелки:

Select source object: – выбрать исходную дугу
Select arcs to join to source or [cLose]: – выбрать дуги, которые 
необходимо объединить с источником
Select arcs to join to source: – нажать клавишу Enter для заверше-
ния работы команды

�� эллиптическая дуга – объединяемые эллиптические дуги должны лежать 
на одном эллипсе, но между ними должны быть зазоры. Ключ cLose за-
мыкает исходную эллиптическую дугу и преобразует ее в законченный 
эллипс. При объединении двух или более эллиптических дуг их объеди-
нение начинается с исходной эллиптической дуги в направлении против 
часовой стрелки:

Select source object: – выбрать исходную эллиптическую дугу

Объединение сегментов
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Select elliptical arcs to join to source or [cLose]: – выбрать 
эллиптические дуги, которые необходимо объединить с источником
Select elliptical arcs to join to source: – нажать клавишу Enter 
для завершения работы команды

�� сплайн – объединяемые сплайны и спирали должны быть непрерывными 
от начала до конца. Результирующим объектом является один сплайн:

Select source object: – выбрать исходный сплайн
Select splines or helixes to join to source: – выбрать сплайны 
или спирали, которые необходимо объединить с источником
Select splines or helixes to join to source: – нажать клавишу 
Enter для завершения работы команды

�� спираль – объединяемые спирали должны быть непрерывными от начала 
до конца. Результирующим объектом является один сплайн.

Снятие.фасок
Команда CHAmFER осуществляет снятие фасок на объектах. Коман-
да вызывается из падающего меню Modify → Chamfer или щелчком на 
пиктограмме Chamfer в группе Modify ленты Home в рабочем простран-
стве Drafting & Annotation.

Запросы команды CHAmFER:

(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 – режим 
с обрезкой, параметры фаски

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple]: – выбрать первый отрезок

Select second line or shift-select to apply corner or [Distance/
Angle/Method]: – выбрать второй отрезок

Процесс снятия фасок заключается в соединении двух непараллельных объ-
ектов путем их удлинения или обрезки до пересечения либо друг с другом, либо с 
линией фаски. Снятие фасок можно выполнять для отрезков, полилиний, прямых 
и лучей.

При установке фаски методом длин указываются расстояния, на которые каж-
дый объект нужно удлинить или обрезать. При установке фаски методом угла 
также можно указать длину линии фаски и угол, образуемый ею с первой линией. 
Соединяемые объекты либо оставляют в том виде, который они имели до снятия 
фаски, либо обрезают или удлиняют, используя линию фаски в качестве кромки.

Если оба соединяемых объекта лежат на одном слое, линия фаски проводится 
на нем же. В противном случае она располагается на текущем слое. То же справед-
ливо в отношении цвета, типа и веса линии фаски.

Если точка пересечения объектов находится за лимитами рисунка, а функция 
контроля лимитов включена, то снятие фаски не выполняется.
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Теперь команда снятия фаски CHAmFER более эффективна: можно применить 
ключ Multiple для соединения нескольких наборов линий сопряжениями или 
фасками без повторного запуска команды. При работе в многооконном режиме 
для этой команды можно использовать ключ отмены Undo.

Появилась возможность быстро создавать фаску с нулевой длиной нажатием 
клавиши Shift при выборе двух линий.

Ключи команды CHAmFER:

�� Undo – отмена предыдущей операции в команде снятия фаски;
�� Polyline – снятие фасок вдоль всей полилинии, то есть в каждом пересе-

чении ее сегментов. При этом обрабатываются только те сегменты, длины 
которых превосходят длину фаски. Построенные вдоль полилинии фаски 
становятся ее новыми сегментами, даже если их длина равна нулю;

�� Distance – настройка длины фаски, то есть расстояния между точкой 
реального или воображаемого пересечения объектов и точкой, до кото-
рой удлиняется или обрезается объект при снятии фаски. Если обе дли-
ны фаски равны нулю, то объекты обрезаются или удлиняются до точки 
их пересечения, а линия фаски не строится. В качестве значения первой 
длины фаски по умолчанию выступает последняя заданная длина. Значе-
ние второй длины по умолчанию совпадает со значением первой длины, 
так что стандартными считаются симметричные фаски, хотя значения по 
умолчанию можно изменить. Величины первой и второй длин запомина-
ются в файле рисунка. Исходные длины фасок нового рисунка опреде-
ляет шаблон. При использовании ключа Distance выдаются следующие 
запросы:

(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 – 
режим с обрезкой, параметры фаски
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple]: D – переход в режим настройки длины фаски
Specify first chamfer distance <default>: – первая длина фаски
Specify second chamfer distance <default>: – вторая длина фаски

�� Angle – позволяет задать длину для первой линии и угол относительно 
первой линии для подрезания второй. При использовании ключа Distance 
выдаются следующие запросы:

(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 – 
режим с обрезкой, параметры фаски
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple]: A – переход в режим задания величины угла
Specify chamfer length on the first line: – первая длина фаски
Specify chamfer angle from the first line: – угол фаски с первым 
отрезком
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple]: – выбрать первый отрезок или один из ключей

Снятие фасок
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Select second line or shift-select to apply corner or [Distance/
Angle/Method]: – выбрать второй отрезок или нажать клавишу Shift при 
выборе, чтобы создать угол

�� Trim – позволяет определить, следует ли обрезать линии до снятия фаски. 
Если следует, то первая линия отсекается на величину первого расстоя-
ния, а вторая линия – на величину второго. Если расстояние равно нулю, 
то происходит подгонка в одну точку. По умолчанию соединяемые фаской 
объекты обрезаются. При включении обрезки системной переменной 
TRIMMODE присваивается значение 1. При отключении – значение 0. При 
обрезке пересекающиеся линии отсекаются по конечным точкам линии 
фаски. Если выбранные линии не пересекаются, то они удлиняются или 
обрезаются так, чтобы пересеклись;

�� mEthod – позволяет выбрать один из методов установки размеров фасок: 
либо расстояниями, либо расстоянием и углом;

�� Multiple – создание фаски для кромок нескольких наборов объектов. 
При этом будет выдан основной запрос команды, а также запрос выбора 
второго отрезка до тех пор, пока не будет нажата клавиша Enter для завер-
шения команды.

Пример..Снятие.фасок
Снять с детали фаски, нарисованные пунктир-

ной линией (рис. 12.24).
Запустите команду CHAmFER, вызвав ее из па-

дающего меню Modify → Chamfer или щелчком на 
пиктограмме Chamfer в группе Modify ленты Home. 
Ответьте на запросы:

_CHAMFER
(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/

Multiple]: D – переход в режим настройки длины фаски
Specify first chamfer distance <0.0000>: 20 – первая длина фаски
Specify second chamfer distance <20.0000>: – нажмите клавишу Enter, 

согласившись со значением, предлагаемым по умолчанию
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/

Multiple]: P – переход в режим снятия фасок с полилинии
Select 2D polyline: – укажите точку 1
4 lines were chamfered
_CHAMFER
(TRIM mode) Current chamfer Dist1 = 20.0000, Dist2 = 20.0000
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/

Multiple]: D – переход в режим настройки длины фаски
Specify first chamfer distance <20.0000>: 30 – первая длина фаски

Рис. 12.24. Снятие фасок
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Specify second chamfer distance <30.0000>: – нажмите клавишу Enter, 
согласившись со значением, предлагаемым по умолчанию

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple]: – укажите точку 2

Select second line or shift-select to apply corner or [Distance/
Angle/Method]: – укажите точку 3

_CHAMFER
(TRIM mode) Current chamfer Dist1 = 30.0000, Dist2 = 30.0000
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/

Multiple]: – укажите точку 4
Select second line or shift-select to apply corner or [Distance/

Angle/Method]: – укажите точку 5

Выполните упражнения Ch1 и Ch2 из раздела 4.

Рисование.скруглений
Команда FiLLEt осуществляет плавное скругление (сопряжение) 
объектов. Она вызывается из падающего меню Modify → Fillet или 
щелчком на пиктограмме Fillet в группе Modify ленты Home в рабочем 
пространстве Drafting & Annotation.

Запросы команды FiLLEt:

Current settings: Mode = TRIM, Radius = 10.0000 – текущие настройки
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: – вы-

брать первый объект
Select second object or shift-select to apply corner or [Radius]: – 

выбрать второй объект

Сопряжением называется плавное соединение двух объектов дугой заданного 
радиуса. AutoCAD не делает различия между внутренними и внешними сопряже-
ниями.

Если оба сопрягаемых объекта лежат на одном слое, линия сопряжения прово-
дится на нем же. В противном случае она располагается на текущем слое. Сказан-
ное справедливо для цвета, типа и веса линии сопряжения.

Можно сопрягать пары отрезков, линейные (но не дуговые) сегменты полили-
ний, прямые, лучи, круги, дуги и реальные (то есть не многоугольные) эллипсы. 
Сопряжение отрезков, прямых и лучей применимо даже к параллельным объек-
там. Сопряжения в вершинах полилинии производятся друг за другом по одному. 
Сопрягать можно отрезки и полилинии в любых комбинациях, а также все твер-
дотельные объекты.

Допускается сопряжение отрезка и окружности, отрезка и дуги или окруж-
ности и дуги. Правила скругления в этом случае такие же, как при сопряжении 

Рисование скруглений
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отрезков. Однако в случае с дугами и окружностями возможно построение более 
одной дуги сопряжения. AutoCAD выберет сопряжение, конечные точки которого 
ближе всего к точкам выбора объектов для скругления.

Для плавного соединения с дугой сопряжения отрезки и дуги могут обрезаться 
или удлиняться. Отсекаемый фрагмент – это та часть на стороне дуги сопряжения, 
которая образует точку пересечения с исходным объектом. Такая логика гаранти-
рует плавность скругления и обычно совпадает с интуитивным представлением, 
согласно которому сохраняется та часть, которая указана. Окружности никогда не 
обрезаются; при этом дуга сопряжения плавно соединяется с окружностью.

При выборе линий, дуг или полилиний их длины регулируются для соответ-
ствия длине сопрягающей дуги. Если удерживать нажатой клавишу Shift при вы-
боре объектов, то осуществляется замена значения текущего радиуса сопряжения 
на 0.

Ключи команды FiLLEt:

�� Undo – отмена предыдущей операции в команде скругления;
�� Polyline – означает, что операция сопряжения выполняется со всей по-

лилинией, строятся дуги сопряжения во всех точках пересечения линей-
ных сегментов двухмерной полилинии. Если два линейных сегмента раз-
делены дугой, при приближении к которой они сходятся, команда FiLLEt 
заменяет эту дугу сопрягающей дугой. При этом выдаются запросы:

Current settings: Mode = TRIM, Radius = 0.5000 – текущие на-
стройки
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: P – 
переход в режим сопряжения полилиний
Select 2D polyline: – выбрать 2D-полилинию

�� Radius – позволяет задать радиус скругления, то есть радиус дуги, со-
единяющей сопрягаемые объекты. По умолчанию радиус сопряжения 
равен 0.5000 или последнему введенному значению. Изменение данно-
го параметра действует только на выполняемые после этого сопряжения, 
оставляя неизменными существующие. При установке радиуса выдаются 
запросы:

Current settings: Mode = TRIM, Radius = 0.5000 – текущие настройки
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: R – 
переход в режим указания радиуса скругления
Specify fillet radius <default>: – указать радиус сопряжения

�� Trim – позволяет определить, следует ли обрезать выбранные кромки по 
конечным точкам дуги сопряжения;

�� Multiple – скругление углов у нескольких наборов объектов. При этом 
будет выдан основной запрос команды, а также запрос выбора второго 
объекта до тех пор, пока не будет нажата клавиша Enter для завершения 
команды.
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Пример..Сопряжение.объектов
Скруглить контуры детали, нарисованные 

пунк тирной линией (рис. 12.25).
Запустите команду FiLLEt, вызвав ее из пада-

ющего меню Modify → Fillet или щелчком на пикто-
грамме Fillet в группе Modify ленты Home. Ответьте 
на запросы:

_FILLET
Current settings: Mode = TRIM, Radius = 

0.5000
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: R – 

переход в режим указания радиуса скругления
Specify fillet radius <0.5000>: 50 – радиус скругления
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: P – 

переход в режим сопряжения полилиний
Select 2D polyline: – укажите точку 1
4 lines were filleted
_FILLET
Current settings: Mode = TRIM, Radius = 50.0000
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: R – 

переход в режим указания радиуса скругления
Specify fillet radius <50.0000>: 20 – радиус скругления
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: – ука-

жите точку 2
Select second object or shift-select to apply corner or [Radius]: – 

укажите точку 3
_FILLET
Current settings: Mode = TRIM, Radius = 20.0000
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: – ука-

жите точку 4
Select second object or shift-select to apply corner or [Radius]: – 

укажите точку 5

Выполните упражнения Fi1–Fi3, тесты 5–7 и Лист из раздела 4.

Расчленение.объектов
Команда EXPLODE осуществляет расчленение блоков на составляю-
щие их примитивы. Команда вызывается из падающего меню Modify → 
Explode или щелчком на пиктограмме Explode в группе Modify ленты 
Home в рабочем пространстве Drafting & Annotation.

Рис. 12.25. Сопряжение 
объектов

Расчленение объектов
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Запросы команды EXPLODE:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для окончания выбора объектов и 

завершения работы команды

При расчленении блока изображение на экране получается идентичным ис-
ходному, но при этом цвет, тип и вес линии объектов могут изменяться. Так, у 
объектов, входивших в блок, после его расчленения восстанавливаются исходные 
свойства.

Если расчленению подвергнута двухмерная полилиния, то любая информация 
о ширине или касательной игнорируется, получаемые отрезки и дуги следуют по 
осевой линии полилинии. По завершении работы команды EXPLODE примени-
тельно к полилинии, имеющей ширину, отличную от нуля, будет выдано сообще-
ние о том, что при ее расчленении потеряны сведения о ширине:

Exploding this polyline has lost width information.
The UNDO command will restore it. – при расчленении этой полилинии по-

теряны сведения о ширине, их можно восстановить командой отмены

Действие команды EXPLODE в каждый момент распространяется только на 
один уровень вложенности. Это значит, что если блок содержит полилинию, то 
при его расчленении появится цельная полилиния. Если потребуются отдельные 
дуговые или линейные сегменты, полилинию надо будет расчленить отдельно.

Расчленение блоков, вставленных с неравными масштабными коэффициента-
ми по осям X, Y и Z, может привести к самым неожиданным последствиям. Внеш-
ние ссылки и связанные с ними блоки расчленить нельзя. При расчленении из 
блоков удаляются атрибуты, однако их исходные описания при этом сохраняются.

Выполните упражнение Ep1 из раздела 4.
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Программа AutoCAD включает набор команд для выполнения математических 
расчетов и получения справочной информации об объектах чертежа. Например, 
вычисление расстояния между двумя заданными точками или угла между точка-
ми в плоскости XY. Имеется возможность вычисления угла между воображаемым 
отрезком, проведенным через точки, и плоскостью XY, а также разности коорди-
нат точек по осям X, Y и Z.

Функции, сообщающие справочную информацию об объектах чертежа, вы-
зываются из падающего меню Tools → Inquiry (рис. 13.1). В рабочем простран-
стве Drafting & Annotation эти инструменты находятся в группе Utilites ленты Home 
(рис. 13.2).

Рис. 13.1. Инструменты, содержащие сведения об объектах
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Рис. 13.2. Измерительные инструменты

Измерение.расстояний.и.углов
Команда mEAsUREGEOm с ключом distance измеряет расстояние 
и угол между точками, вызывается из падающего меню Tools → 
Inquiry → Distance или щелчком на пиктограмме Distance в группе 
Utilites ленты Home в рабочем пространстве Drafting & Annotation.

Запросы команды mEAsUREGEOm:
Enter an option [Distance/Radius/Angle/ARea/Volume] <Distance>: _distance
Specify first point: – указать первую точку
Specify second point or [Multiple points]: – указать вторую точку
Distance = вычисленное значение расстояния
Angle in XY Plane = значение угла в плоскости XY
Angle from XY Plane = значение угла от плоскости XY
Delta X = значение разности X
Delta Y = значение разности Y 
Delta Z = значение разности Z
Enter an option [Distance/Radius/Angle/ARea/Volume/eXit] <ARea>: X – 

завершение работы команды

Команда mEAsUREGEOm вычисляет расстояние между точками в трехмер-
ном пространстве. Если координата Z первой или второй точки опущена, то пара-
метр Distance подразумевает текущий уровень.

Угол в плоскости XY отсчитывается от текущей оси X, а угол с плоскостью XY – 
от текущей плоскости XY. При этом значения расстояний выражены в текущем 
формате единиц.

Измерение расстояний и углов
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Вычисление.площади.и.периметра
Команда mEAsUREGEOm с ключом area вычисляет площадь и пе
риметр объекта или заданной области. Вызывается из падающего 
меню Tools → Inquiry → Area или щелчком на пиктограмме Area в груп-
пе Utilites ленты Home в рабочем пространстве Drafting & Annotation.

Воображаемая фигура, предназначенная для вычисления площади и перимет-
ра, формируется указанием точек, лежащих в плоскости, параллельной плоскости 
XY текущей системы координат. 

Запросы команды mEAsUREGEOm:
Enter an option [Distance/Radius/Angle/ARea/Volume] <Distance>: _area
Specify first corner point or [Object/Add area/Subtract area/eXit] 

<Object>: – указать первую угловую точку или один из ключей
Specify next point or [Arc/Length/Undo]: – указать следующую угловую 

точку
Specify next point or [Arc/Length/Undo]: – указать следующую угловую 

точку
Specify next point or [Arc/Length/Undo/Total] <Total>: – указать 

следующую угловую точку
Specify next point or [Arc/Length/Undo/Total] <Total>: – нажать кла-

вишу Enter для вычисления
Area = значение площади
Perimeter = значение периметра
Enter an option [Distance/Radius/Angle/ARea/Volume/eXit] <ARea>: X – 

завершение работы команды

Ключи команды AREA:

�� Object – осуществляется вычисление площади и периметра выбранно-
го объекта. Таким образом можно находить площади кругов, эллипсов, 
сплайнов, полилиний, многоугольников, областей и тел. В случае незамк-
нутой полилинии значение площади вычисляется так, как если бы послед-
няя и первая точка были соединены прямым отрезком. При вычислении 
периметра длина этого отрезка не учитывается. Для полилиний с ненуле-
вой шириной площадь и длина (периметр) вычисляются по их продоль-
ной оси;

�� Add area – включение режима добавления последовательно вычисляе-
мых площадей к итоговому значению. Пользователю выдаются сведения 
как о площади и периметре отдельных областей и объектов, так и об общей 
площади;

�� Subtract area – включение режима вычитания последовательно вычис-
ляемых площадей из накапливаемого суммарного значения.

Вычисленные значения площади и периметра сохраняются в системных пере-
менных AREA и PERIMETER.
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Вычисление.радиуса
Команда mEAsUREGEOm с ключом radius вычисляет радиус дуги 
или окружности. Вызывается из падающего меню Tools → Inquiry → 
Radius или щелчком на пиктограмме Radius в группе Utilites ленты 
Home в рабочем пространстве Drafting & Annotation.

Запросы команды mEAsUREGEOm:
Enter an option [Distance/Radius/Angle/ARea/Volume] <Distance>: _radius
Select arc or circle: – указать дугу или окружность
Radius = значение радиуса
Diameter = значение диаметра
Enter an option [Distance/Radius/Angle/ARea/Volume/eXit] <Radius>: X – 

завершение работы команды

Вычисление.угла
Команда mEAsUREGEOm с ключом angle вычисляет радиус дуги 
или окружности. Вызывается из падающего меню Tools → Inquiry → 
Angle или щелчком на пиктограмме Angle в группе Utilites ленты Home 
в рабочем пространстве Drafting & Annotation.

Запросы команды mEAsUREGEOm:
Enter an option [Distance/Radius/Angle/ARea/Volume] <Distance>: _angle
Select arc, circle, line, or <Specify vertex>: – указать дугу, окруж-

ность или линию
Select second line: – указать вторую линию
Angle = значение угла
Enter an option [Distance/Radius/Angle/ARea/Volume/eXit] <Radius>: X – 

завершение работы команды

Вычисление.объема
Команда mEAsUREGEOm с ключом volume вычисляет объем объ-
екта или заданной области. Вызывается из падающего меню Tools → 
Inquiry → Volume или щелчком на пиктограмме Volume в группе Utilites 
ленты Home в рабочем пространстве Drafting & Annotation.

При выборе двухмерного объекта необходимо указать высоту для вычисления 
объема этого объекта. 

Запросы команды mEAsUREGEOm:
Enter an option [Distance/Radius/Angle/ARea/Volume] <Distance>: _volume
Specify first corner point or [Object/Add volume/Subtract volume/

eXit] <Object>: – указать первую угловую точку

Вычисление объема
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Specify next point or [Arc/Length/Undo]: – указать следующую точку
Specify next point or [Arc/Length/Undo]: – указать следующую точку
Specify next point or [Arc/Length/Undo/Total] <Total>: – указать 

следующую точку
Specify next point or [Arc/Length/Undo/Total] <Total>: – указать 

следующую точку
Specify next point or [Arc/Length/Undo/Total] <Total>: – нажать 

клавишу Enter для введения следующего параметра
Specify height: – указать высоту объекта
Volume = значение вычисленного объема
Enter an option [Distance/Radius/Angle/ARea/Volume/eXit] 

<Volume>: – задать параметр или нажать клавишу Enter для продолжения работы 
в режиме вычисления объема

Specify first corner point or [Object/Add volume/Subtract volume/
eXit] <Object>: – указать первую угловую точку или нажать клавишу Enter для 
выбора ранее построенного объекта

Select objects: – выбрать объект
Volume = значение вычисленного объема
Enter an option [Distance/Radius/Angle/ARea/Volume/eXit] <Volume>: – X – 

завершение работы команды

Ключи команды mEAsUREGEOm:

�� Add volume – режим сложения и сохранение промежуточной суммы объ-
емов при добавлении областей;

�� Subtract volume – режим вычитания и вычитание указанного объема из 
общего объема.

Вычисление.геометрии.и.массы
Команда mAssPROP вычисляет массовые характеристики областей 
и тел. Вызывается из падающего меню Tools → Inquiry → Region/Mass 
Properties.

Команда mAssPROP отображает массовые характеристики в текстовом окне. 
При необходимости их можно записать в текстовый файл.

Характеристики, отображаемые командой mAssPROP, зависят от того, явля-
ются ли выбранные объекты телами или областями, и компланарны ли выбранные 
области плоскости XY текущей ПСК. При выборе нескольких областей принима-
ются только области, компланарные первой из выбранных.

Запросы команды mAssPROP:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
 ---------------- SOLIDS ----------------
Mass: – масса
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Volume: – объем
Bounding box:  – ограничивающая рамка     X:
         Y:
         Z:
Centroid: – центр масс       X: 
         Y:
         Z:
Moments of inertia: – моменты инерции   X: 
         Y:
         Z:
Products of inertia: – центробежный момент инерции  XY: 
         YZ:
         ZX:
Radii of gyration: – радиусы инерции    X:
         Y:
         Z:
Principal moments and X-Y-Z directions about centroid: – 

главные моменты и направления X-Y-Z относительно центра масс
         I:
         J:
         K:
Press ENTER to continue: – нажать Enter для завершения работы команды
Write analysis to a file? [Yes/No] <N>: – указать, следует ли записать 

результаты анализа в файл

Ниже приведены массовые характеристики, выводимые для тел:

�� масса – мера инерции тела. Значения массы и объема равны, так как ис-
пользуется единичная плотность;

�� объем – область трехмерного пространства, ограничиваемая телом;
�� ограничивающая рамка – координаты противоположных углов паралле-

лепипеда, ограничивающего тело;
�� центр масс – трехмерная координата центра масс для тел. Предполагается, 

что плотность тела распределена равномерно;
�� момент инерции – момент инерции тела используется при определении 

сил, требуемых для вращения объекта вокруг оси (например, вращении 
колеса вокруг оси). Размерность момента инерции тела – единицы массы, 
умноженные на единицы длины в квадрате;

�� центробежный момент инерции – величина, используемая для определе-
ния сил, вызывающих перемещение объекта. Вычисляется относительно 
двух ортогональных плоскостей. Размерность центробежных моментов 
инерции – единицы массы, умноженные на единицы расстояния в квадрате;

�� радиус инерции – эта характеристика является еще одним способом выра-
жения моментов инерции тела. Размерность радиусов инерции – единицы 
длины;

Вычисление геометрии и массы
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�� главные моменты и направления X, Y, Z относительно центра масс – вы-
числяются на основании центробежных моментов инерции и имеют те 
же размерности. Относительно одной из осей, проходящих через центр 
масс объекта, момент инерции является наибольшим. Ось, относительно 
которой момент инерции является наименьшим, располагается перпенди-
кулярно первой оси и также проходит через центр масс. Третье значение, 
представленное в результатах, является промежуточным.

Ниже приведены массовые характеристики, выводимые для всех областей:

�� площадь – площадь поверхности тел или внутренняя площадь областей;
�� периметр – общая длина внешних и внутренних петель области. Периметр 

тела не вычислен;
�� ограничивающая рамка – определяется двумя координатами. Для обла-

стей, компланарных плоскости XY текущей пользовательской системы 
координат, координатами ограничивающей рамки являются координаты 
противоположных углов прямоугольника, ограничивающего область. Для 
областей, не являющихся компланарными плоскости XY текущей ПСК, 
координатами ограничивающей рамки являются координаты противопо-
ложных углов параллелепипеда, ограничивающего область;

�� центр масс – двухмерная или трехмерная точка геометрического центра 
областей. Для областей, компланарных плоскости XY текущей ПСК, это 
двухмерная точка. Для областей, не являющихся компланарными плоско-
сти XY текущей ПСК, это трехмерная точка.

Ниже приведены дополнительные массовые характеристики, выводимые для 
областей, компланарных плоскости XY текущей ПСК:

�� момент инерции – величины используются при расчете распределенных 
нагрузок, например давления жидкости на плиту, или при вычислении сил 
при изгибе или кручении балок. Размерность моментов инерции – едини-
цы длины в четвертой степени;

�� центробежный момент инерции – величина, используемая для определе-
ния сил, вызывающих перемещение объекта. Вычисляется относительно 
двух ортогональных плоскостей. Размерность центробежных моментов 
инерции – единицы массы, умноженные на единицы расстояния в квадрате;

�� радиус инерции – эта характеристика является еще одним способом выра-
жения моментов инерции тела. Размерность радиусов инерции – единицы 
длины;

�� главные моменты и направления X, Y, Z относительно центра масс – вы-
числяются на основании центробежных моментов инерции и имеют те 
же размерности. Относительно одной из осей, проходящих через центр 
масс объекта, момент инерции является наибольшим. Ось, относительно 
которой момент инерции является наименьшим, располагается перпенди-
кулярно первой оси и также проходит через центр масс. Третье значение, 
представленное в результатах, является промежуточным.
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Информация.о.выбранных.объектах.
из.базы.данных.чертежа

Команда List вычисляет информацию о выбранных объектах из базы 
данных чертежа. Вызывается из падающего меню Tools → Inquiry → 
List или щелчком на пиктограмме List в группе Properties ленты Home в 
рабочем пространстве Drafting & Annotation.

Результатом работы команды List является сообщение в текстовом окне, где 
отображаются тип объекта, слой объекта, координаты X, Y, Z в текущей ПСК, а 
также пространство, в котором объект находится (модель или лист). Выводится 
также и трехмерная высота объекта, если она ненулевая.

В зависимости от конкретного выбранного объекта команда List может выво-
дить и другие данные.

Определение.координат.точек
Команда iD вычисляет координаты точек. Вызывается из падающего 
меню Tools → Inquiry → ID Point или щелчком на пиктограмме ID Point в 
группе Utilites ленты Home в рабочем пространстве Drafting & Annotation.

В командной строке выводятся координаты точки в текущей пользовательской 
системе координат, которые запоминаются как координаты последней введенной 
точки и могут быть использованы с помощью символа @.

Сведения.о.дате.и.времени.создания.
чертежа

Команда timE сообщает сведения о дате и времени создания чертежа. 
Вызывается из падающего меню Tools → Inquiry → Time.

Команда timE выводит на экран следующую информацию:

Current time: – отображение текущей даты и времени в 24-часовом формате 
с точностью до миллисекунды

Times for this drawing: – время доступа к данному чертежу
Created: – дата и время создания текущего чертежа
Last updated: – отображение даты и времени последнего обновления теку-

щего чертежа, изменение которого производится при каждом сохранении файла 
чертежа

Total editing time: – отображение времени, затраченного на редактиро-
вание текущего чертежа. Счетчик времени постоянно обновляется программой, 
его нельзя сбросить или остановить. Время вывода чертежа на печать, а также за-

Сведения о дате и времени создания чертежа
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вершение сеанса редактирования без сохранения чертежа при подсчете времени 
не учитываются

Elapsed timer (on): – дополнительный счетчик, функционирующий в про-
цессе работы программы. Его можно при необходимости включать, отключать и 
сбрасывать

Next automatic save in: <disabled> – отображение времени, оставшегося 
до очередного автоматического сохранения

Enter option [Display/ON/OFF/Reset]: – введите один из ключей

Ключи команды timE:

�� Display – повторный вывод сведений о дате и времени чертежа с обнов-
лением;

�� ON – запуск пользовательского счетчика затраченного времени, в том слу-
чае если он отключен;

�� OFF – остановка пользовательского счетчика затраченного времени, в том 
случае если он включен;

�� Reset – присвоение пользовательскому счетчику затраченного времени 
значения 0 дней 00:00:00.000.

Статистическая.информация.о.чертеже
Команда stAtUs сообщает статистические сведения о чертеже – 
дате и времени создания чертежа, а также о режимах и границах. Вы-
зывается из падающего меню Tools → Inquiry → Status.

Команда stAtUs выводит на экран число объектов в текущем чертеже: графи-
ческие объекты (дуги, полилинии), неграфические объекты (слои, типы линий и 
описания блоков). Если ввести stAtUs в ответ на запрос команды DIM, на экран 
будут выведены значения и описания всех системных переменных, хранящих ин-
формацию о размерах.

Кроме того, команда stAtUs выводит на экран следующую информацию:

�� Model space limits are – показывает лимиты сетки. В первой строке 
находятся координаты X, Y нижнего левого угла лимита, хранящиеся в 
системной переменной LIMMIN. Во второй строке находятся координаты 
X, Y верхнего правого угла лимита, хранящиеся в системной переменной 
LIMMAX. Замечание Off справа от координаты Y говорит об отключенном 
контроле за лимитами чертежа;

�� Model space uses – показывает границы чертежа, которые включают 
все объекты базы данных и могут выходить за лимиты сетки. В первой 
строке находятся координаты X, Y нижнего левого угла. Во второй строке 
находятся координаты X, Y верхнего правого угла. Замечание Over справа 
от координаты Y говорит о том, что чертеж выходит за заданные лимиты 
сетки;



405

�� Display shows – выдает часть границ чертежа, видимую на текущем ви-
довом экране. В первой строке находятся координаты X, Y нижнего левого 
угла экрана. Во второй строке находятся координаты X, Y верхнего право-
го угла;

�� Insertion base is – точка вставки чертежа, которая хранится в систем-
ной переменной INSBASE и выражается в координатах X, Y, Z;

�� Snap resolution is – интервалы шаговой привязки в направлениях X и 
Y, сохраняемые в системной переменной SNAPUNIT;

�� Grid spacing is – интервалы шага сетки в направлениях X и Y, сохраняе-
мые в системной переменной GRIDUNIT;

�� Current space: – показывает, какое из пространств (модели или листа) 
активно в данный момент.

�� Current layout: – отображает Model или имя текущего листа;
�� Current layer: – показывает текущий слой, задаваемый системной пере-

менной CLAYER;
�� Current color: – показывает текущий цвет, задаваемый системной пере-

менной CECOLOR;
�� Current linetype: – показывает текущий тип линий, задаваемый си-

стемной переменной CELTYPE;
�� Current material: – показывает текущий материал;
�� Current lineweight: – показывает текущий вес линий, задаваемый си-

стемной переменной CELWEIGHT.
�� Current elevation: – показывает текущий уровень, задаваемый систем-

ной переменной ELEVATION;
�� thickness: – показывает текущую высоту, задаваемую системной пере-

менной THICKNESS;
�� Fill – указывает состояние Вкл/Откл для режима закрашивания;
�� Grid – указывает состояние Вкл/Откл для режима установки сетки;
�� Ortho – указывает состояние Вкл/Откл для ортогонального режима;
�� Qtext – указывает состояние Вкл/Откл для режима текста;
�� Snap – указывает состояние Вкл/Откл для режима установки шага;
�� Tablet – указывает состояние Вкл/Откл для режима планшета;
�� Object snap modes: – перечисляет текущие режимы объектной привяз-

ки, задаваемые командой OsNAP;
�� Free dwg disk (C:) space: – показывает количество свободного про-

странства на диске, выделенном для чертежей;
�� Free temp disk (C:) space: – показывает количество свободного про-

странства на диске, выделенном для временных файлов;
�� Free physical memory: – показывает количество свободной оператив-

ной памяти на компьютере;
�� Free swap file space: – показывает количество свободного простран-

ства в файле подкачки.

Статистическая информация о чертеже
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Список.системных.переменных
Команда sEtVAR выводит список системных переменных, а также 
изменяет их значения. Вызывается из падающего меню Tools → 
Inquiry → Set Variable.

Запросы команды sEtVAR:

Enter variable name or [?]: – ввести имя системной переменной, которой 
требуется присвоить значение

Enter new value for «NAME»: – ввести новое значение системной перемен-
ной или нажать клавишу Enter

Значения системных переменных также можно изменять непосредственно в 
командной строке. Для этого необходимо на запрос Command: ввести имя пере-
менной и ее новое значение.

Ключ команды sEtVAR:

�� ? – вывод списка текущих значений всех системных переменных, исполь-
зуемых в чертеже. Необходимо:

Enter variable name or [?]: ? – переход в режим запроса списка 
переменных
Enter variable(s) to list <*>: – ввести символ-шаблон имен пере-
менных для получения целевого списка, или нажать клавишу Enter

Калькулятор
Удобным инструментом для выполнения вычислений, преобразования единиц из-
мерения и других операций является палитра калькулятор, используя который, 
можно выполнять следующие действия:

�� математические и тригонометрические расчеты;
�� просмотр и использование ранее выполненных расчетов;
�� изменение свойств объектов при совместном использовании калькулято-

ра и палитры свойств;
�� преобразование единиц измерения;
�� осуществление геометрических расчетов;
�� копирование и вставка значений и выражений при совместном использо-

вании калькулятора и палитры свойств или командной строки;
�� выполнение расчетов со смешанными числами, имеющими целые и дроб-

ные части, величинами в футах и дюймах;
�� определение, хранение и использование переменных калькулятора;
�� использование геометрических функций из калькулятора.

Команда QUiCKCALC загружает палитру калькулятор. Вызывается из 
падающего меню Tools → Palettes → QuickCalc или щелчком на пикто-



407

грамме Quick Calculator в группе Utilites ленты Home в рабочем пространстве 
Drafting & Annotation (рис. 13.3).

Рис. 13.3. Палитра калькулятор

Калькулятор состоит из следующих областей: панель, область журнала, поле 
ввода, кнопка More/Less, цифровая клавиатура, область научных расчетов, об-
ласть преобразования единиц, область переменных.

Калькулятор
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�� Панель – выполняет быстрые вычисления для стандартных функций и 
содержит следующие инструменты:

•� Clear – сбрасывает и очищает значение в поле ввода;

•� Clear History – удаляет данные из области журнала;

•� Paste value to command line – вставляет величину из поля ввода в 
командную строку;

•� Get Coordinates – вычисляет координаты точки, выбранной на чер-
теже с помощью мыши;

•� Distance Between Two Points – вычисляет расстояние между двумя 
точками, выбранными на объекте с помощью мыши;

•� Angle of Line Defined by Two Points – вычисляет угол между двумя 
точками, выбранными на объекте с помощью мыши;

•� Intersection of Two Lines Defined by Four Points – вычисляет точку пе-
ресечения двух линий, заданных четырьмя точками, выбранными 
на объекте с помощью мыши;

•� Help (F1) – вызывает страницу справочной системы о калькулято-
ре.

�� Область журнала – отображает бегущий список ранее вычисленных вы-
ражений. В контекстном меню области журнала содержится несколько 
пунктов, включая пункт для копирования выбранного выражения в буфер 
обмена (рис. 13.4):

•� Copy – копирование;
•� Append Expression to Input Area – добавление выражения в область ввода;
•� Append Value to Input Area – добавление значения в область ввода;
•� Clear History – очистка журнала.

Рис. 13.4. Контекстное меню области журнала калькулятора
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�� Поле ввода – поле для ввода и извлечения выражений. При нажатии кноп-
ки со знаком равенства = или клавиши Enter калькулятор производит вы-
числение и отображает результаты.

�� Кнопка More/Less – скрывает или отображает все области функций 
калькулятора. Это же действие можно выполнить с помощью кон-
текстного меню, нажав правую кнопку мыши (рис. 13.5):

•� Number Pad – цифровая клавиатура;
•� Scientific – научные;
•� Units Conversion – преобразование единиц;
•� Variables – переменные.

Рис. 13.5. Контекстное меню кнопки More/Less калькулятора

�� Number Pad – стандартная цифровая клавиатура калькулятора, с помощью 
которой можно вводить цифры, символы для арифметических выраже-
ний. Нажатие знака равенства = позволяет вычислить введенное выраже-
ние. Ниже приведены дополнительные функции управления, доступные 
на цифровой клавиатуре:

•� C (Clear) – удаляет значение в поле ввода и сбрасывает его в ноль;
•�  (Bascspace) – перемещает курсор на один символ влево в поле ввода, 

при этом один десятичный знак или символ удаляется;
•� √ (Square Root (sqrt)) – вычисляет квадратный корень значения;
•� 1/x (Inverse) – вычисляет значение или выражение, обратное находяще-

муся в поле ввода;
•� x^2 (X to the Pover of 2) – возводит значение в квадрат;
•� x^3 (X to the Pover of 3) – возводит число или выражение в поле ввода в 

степень 3;
•� x^y (X to the Pover of Y) – возводит число или выражение в поле ввода в 

указанную степень;

Калькулятор
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•� ( ) – открывающая и закрывающая скобки при объединении в пары ис-
пользуются для группирования части выражения. Элементы, заключен-
ные в скобки, обрабатываются раньше, чем оставшаяся часть выраже-
ния;

•� = – вычисляет выражение в поле ввода;
•� MS (Store To Memory) – сохраняет текущее значение в памяти калькуля-

тора;
•� M+ (Add to Value Stored in Memory) – добавляет текущее значение к значе-

нию, сохраненному в памяти калькулятора;
•� MR (Restore Memory Value) – восстанавливает в окне ввода значение, хра-

нящееся в памяти калькулятора;
•� MC (Clear Memory) – удаляет значение, хранящееся в памяти калькулятора.

�� Scientific – область научных расчетов, с помощью которой вычисляют зна-
чения тригонометрических, логарифмических, показательных и других 
выражений, обычно используемых в научных и инженерных приложени-
ях. Ниже описываются элементы управления области научных расчетов:
•� sin (Sine) – вычисляет синус угла, указанного в поле ввода;
•� cos (Cosine) – вычисляет косинус угла, указанного в поле ввода;
•� tan (Tangent) – вычисляет тангенс угла, указанного в поле ввода;
•� log (Base-10 Log) – вычисляет логарифм значения, указанного в поле вво-

да;
•� 10^x (Base-10 Exponent) – вычисляет степень по основанию 10 значения, 

указанного в поле ввода;
•� asin (Arcsine) – вычисляет арксинус числа, указанного в поле ввода. Чис-

ло должно лежать в пределах от -1 до 1;
•� acos (Arccosine) – вычисляет арккосинус числа, указанного в поле ввода. 

Число должно лежать в пределах от -1 до 1;
•� atan (Arctangent) – вычисляет арктангенс числа, указанного в поле ввода;
•� ln (Natural Log) – вычисляет натуральный логарифм числа, указанного в 

поле ввода;
•� e^x (Natural Exponent) – вычисляет натуральный показатель числа, ука-

занного в поле ввода;
•� r2d (Convert Radians to Degrees) – преобразует радианы в градусы;
•� d2r (Convert Degrees to Radians) – преобразует углы из градусов в радианы;
•� abs (Absolute Value) – возвращает абсолютное значение числа, указанного 

в поле ввода;
•� rnd (Round) – округляет число, указанное в поле ввода, до ближайшего 

целого числа;
•� trunc (Truncate) – отображает целую часть числа, указанного в поле ввода.

�� Units Conversion – область преобразования единиц конвертирует единицы 
измерения одного типа в другой. В области преобразования единиц можно 
использовать только целые значения:
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•� Units type – выбор из списка типа единиц: Length – длина; Area – площадь; 
Volume – устройство; Angular – угловой;

•� Convert from – отображает список исходных единиц измерения: сантимет-
ры, футы, дюймы, километры, метры, мили, миллиметры, топографиче-
ские футы, ярды;

•� Convert to – отображает список конечных единиц измерения, аналогич-
ный списку Convert from;

•� Value to convert – отображает поле для ввода преобразуемого значения;
•� Converted value – преобразует введенные единицы и отображает резуль-

тат;
•� Return Conversion to Calculator Input Area – значок калькулятора возвраща-

ет преобразованное значение в поле ввода.

�� Variables – область переменных обеспечивает доступ к предопределенным 
константам и функциям, а также эту область можно использовать для 
определения и хранения дополнительных констант и функций. Дерево 
переменных используется для хранения функций сокращенного вида и 
переменных, заданных пользователем. Функции сокращенного вида – это 
часто используемые выражения, в которых функция связана с привязкой 
к объекту. Ниже описываются стандартные функции сокращенного вида:
•� Phi – константа со значением 1.61803399;
•� dee – dist(end,end) расстояние между двумя конечными точками;
•� ille – ill(end,end,end,end) пересечение двух линий, проведенных через 

четыре конечные точки;
•� mee – (end+end)/2 середина отрезка, соединяющего две конечные точки;
•� nee – nor(end,end) единичный вектор в плоскости XY, нормальный к 

двум конечным точкам;
•� rad – rad радиус выбранной окружности, дуги или дуги полилинии;
•� vee – vec(end,end) вектор от одной конечной точки к другой;
•� vee1 – vec1(end,end) единичный вектор в направлении от одной конеч-

ной точки к другой.

Ниже описываются инструменты области переменных:

�� кнопка New Variable… загружает диалоговое окно описания новой 
переменной Variable Definition (рис. 13.6):

•� в области Variable type устанавливается тип переменной: Contannt – со-
храняет новую переменную в качестве константы; Function – сохраняет 
новую переменную в качестве функции;

•� в области Variable properties определяются свойства переменной: Name: – 
сохраняет имя переменной, при этом в именах констант нельзя исполь-
зовать пробелы; Group with: – сохраняет именованную переменную в вы-
бранной категории; Value or expression: – сохраняет значение выражения 
для переменной; Descrition: – сохраняет описание для переменной;

Калькулятор
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Рис. 13.6. Диалоговое окно описания переменной

�� кнопка Edit Variable… загружает диалоговое окно описания перемен-
ной Variable Definition для внесения изменений в выбранную перемен-
ную;

�� кнопка Delete удаляет выбранную переменную;

�� кнопка Return Variable to Input Area – кнопка калькулятора, возвращаю-
щая выбранную переменную в поле ввода.
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Существует много способов разработки чертежей в среде AutoCAD. Квалифици-
рованные пользователи, обладающие большим опытом работы, имеют в своем ба-
гаже собственные подходы к разработке конструкторской документации. Вашему 
вниманию предлагается методика на примере разработки чертежа детали, хотя, в 
принципе, она может использоваться при разработке любых чертежей и служить 
основой для серьезной и регулярной работы в среде AutoCAD.

Создание чертежа детали, изображенного на рис. 14.1, рекомендуется выпол-
нять в следующей последовательности.

Рис. 14.1. Чертеж детали
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1. Создать новый рисунок с помощью команды NEW, вызываемой из падающе-
го меню File → New....

2. Для вызова Мастера подготовки в диалоговом окне создания нового черте-
жа Create New Drawing выбрать пиктограмму Use a Wizard. Далее в списке Select 
a Wizard: выбрать Quick Setup.

3. В диалоговом окне QuickSetup в качестве единиц измерения длины Units 
установить Decimal. При определении границы области черчения Area уста-
новить ширину – 210 мм, длину – 297 мм. Щелкнуть на кнопке Готово.

4. Включить отображение сетки на экране щелчком на кнопке GRID в строке 
состояния или нажатием функциональной клавиши F7.

5. Отобразить всю область чертежа на экране командой ZOOm, вызываемой 
из падающего меню View → Zoom All. См. упражнение Z2 из раздела 2.

6. Установить шаг привязки курсора к узлам сетки 5 мм в диалоговом окне 
Drafting Settings, загружаемом из падающего меню Tools → Drafting Settings... 
или выбором пункта Settings... в контекстном меню, вызываемом щелчком 
правой кнопкой мыши на кнопке SNAP в строке состояния. Значение при-
вязки устанавливается в области Snap spacing в текстовых полях Snap X 
spacing: и Snap Y spacing:.

7. Сохранить рисунок с помощью команды QsAVE, вызываемой из падающего 
меню File → Save.

8. Вставить в рисунок рамку формата А4 (при условии, что эта заготовка уже 
существует). Вставка осуществляется командой iNsERt, вызываемой из па-
дающего меню Insert → Block.... При этом загружается диалоговое окно Insert. 
См. упражнение In1 из раздела 4.

9. Создать новые слои в Диспетчере свойств слоев Layer Properties Manager, ко-
торое загружается из падающего меню Format → Layer.... См. упражнение La 
из раздела 3. Рекомендуется создать 4 слоя:
•� Контур – для линий основного контура;
•� Размеры – для размерных линий;
•� Осевые линии – для осевых линий;
•� Тонкие линии – для штриховки.

10. В диалоговом окне Layer Properties Manager установить вес линий для вновь 
созданных слоев: для слоя Контур – 0.8; для слоев Размеры, Осевые ли-
нии, Тонкие линии – 0.3. Для слоя Осевые линии установить тип линии 
Center2. Рекомендуется установить для всех слоев различные оттенки цве-
товой гаммы.

11. Создать наклонный текстовый стиль в диалоговом окне Text Style, вызывае-
мом из падающего меню Format → Text Style.... В области Font в раскрываю-
щемся списке Font Name: следует выбрать шрифт simplex.shx; в поле Oblique 
Angle: задать угол наклона к нормали 15; в поле Height: установить высоту 0 
(ноль). См. упражнение T7 из раздела 2.

12. Заполнить штамп. Рекомендуется увеличить изображение штампа с помо-

Разработка чертежей в среде AutoCAD
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щью зуммирования. Затем использовать команду DtEXt, вызываемую из 
падающего меню Draw → Text → Single Line Text. При заполнении штампа 
удобно использовать ключ выравнивания по ширине Fit команды DtEXt. 
См. упражнение T4 из раздела 2.

13. Прежде чем формировать основной контур, следует сделать слой Контур 
текущим. См. упражнение Test1 из раздела 2.

14. Включить привязку курсора к узлам сетки щелчком на кнопке SNAP в стро-
ке состояния или нажатием функциональной клавиши F9.

15. С помощью команд построения прямоугольника RECtANG и окружности 
CiRCLE построить основной контур горизонтальной проекции детали. 
С помощью команды построения отрезков LiNE сформировать основной 
контур ее фронтальной проекции. См. упражнения C1, Re1, L4 из раздела 2.

16. Сделать слой Осевые линии текущим, и с помощью команды LiNE сформи-
ровать осевые линии обеих проекций детали.

17. Сделать слой Тонкие линии текущим и заштриховать область разреза де-
тали с помощью команды HAtCH, вызываемой из падающего меню Draw →  
Hatch.... При этом загружается диалоговое окно Hatch and Gradient, в котором 
необходимо задать: в поле Pattern: – ANSI31; в поле Scale: – значение 2; в поле 
Angle: – значение 0. См. упражнение H1 из раздела 3.

18. Проставить размеры. См. упражнения R1–R11 из раздела 3. Слой Разме-
ры сделать текущим, затем создать размерный стиль с помощью команды 
DimstYLE в диалоговом окне Dimension Style Manager. Команда вызывается 
из падающего меню Dimension → Dimension Style.... См. упражнения RS1–RS6 
из раздела 3. Рекомендуется установить размер стрелок в поле Arrow size:, 
равный 5; в списке Offset from origin: выбрать значение 0, определяющее от-
ступ выносных линий от объекта; в списке Text style: указать имя созданного 
наклонного текстового стиля; в списке Text height: выбрать значение 3.5, в 
поле Offset from dim line: выбрать значение 1.3.

19. Для отображения веса (толщины) линий на экране необходимо щелкнуть 
на кнопке LWT в строке состояния, расположенной в нижней части рабочего 
стола.

20. Сохранить рисунок.
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Формирование в AutoCAD модели объекта, в том числе трехмерной, обычно не 
является самоцелью. Это делается для дальнейшего использования такой модели 
в системах прочностных расчетов и кинематического моделирования, при полу-
чении проектно-конструкторской документации, фотографически достоверного 
изображения готового изделия до его производства, при экспорте трехмерных 
моделей в другие программы компьютерной графики и т. д. Во всех случаях при-
менения модели необходимо ее отображение либо на экране монитора, либо в виде 
твердой копии.

В данной главе будут рассмотрены возможности отображения и редактиро-
вания моделей в двух пространствах – пространстве модели Model Space и про-
странстве листа Paper Space, используемых при создании чертежа. Важно пони-
мать, как и когда следует пользоваться пространством листа или модели. Овладев 
этим инструментом, можно значительно ускорить разработку изделия и повысить 
производительность.

Обычно в пространстве модели создаются и редактируются модели разрабаты-
ваемого объекта, а в пространстве листа формируется отображение этого объекта 
на плоскости, то есть чертеж с необходимыми графическими изображениями, рам-
кой чертежного листа, надписями и другой графической информацией, необходи-
мой для вывода на плоттер. Когда пользователь находится в пространстве листа, 
допускается создание плавающих видовых экранов, на которых размещаются раз-
личные виды рисунка. В зависимости от ситуации можно вычертить содержимое 
одного или нескольких видовых экранов, задать элементы чертежа, выводимые на 
плоттер, выбрать способ компоновки изображения на листе бумаги. При этом не 
загромождается рисунок пространства модели, что ускоряет и облегчает редакти-
рование разрабатываемого объекта.

На чертеже в пространстве листа, как правило, представлены ортогональные 
(прямоугольные) проекции объекта с различных точек зрения на трехмерную 
модель, а иногда и ее аксонометрическое изображение. Все изображения должны 
находиться в соответствующих областях просмотра. Создание окон просмотра, 
выбор и модификация видов, показываемых через эти окна, необходимы как при 
формировании трехмерных моделей, так и при их модификации. Качественное 
отображение трехмерных объектов позволяет существенно упростить работу с 
моделью.

В AutoCAD окно рисунка разделено на закладки; на одной из них расположе-
на модель, а остальные (их может быть несколько) представляют собой аналоги 
листов бумаги. Для перехода в пространство модели необходимо либо выбрать за-
кладку Model, либо сделать текущим плавающий видовой экран на листе. Именно 
в закладке Model работает пользователь, создавая и редактируя объект. Если она 
активна, это всегда означает, что работа ведется в пространстве модели. Заклад-
ка Model может быть разделена на неперекрывающиеся видовые экраны, которые 
представляют различные виды модели.

Набор закладок Layout предназначен для компоновки и подготовки к пе-
чати лис тов, представляющих собой изображения модели на бумаге. Листы в 
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AutoCAD – это элементы среды пространства листа, на каждом из которых созда-
ются видовые экраны и отдельно устанавливаются параметры печати. Последние 
сохраняются в рисунке вместе с листами. Имеется возможность сохранить набор 
параметров листа, присвоив ему некоторое имя, и впоследствии назначать другим 
листам. Также предусмотрено создание листов на основе имеющихся файлов ша-
блонов (DWT или DWG).

Пространство.модели.и.пространство.
листа
Пространство модели (Model Space) – это пространство AutoCAD, где формиру-
ются модели объектов как при двухмерном, так и при трехмерном моделировании. 
О том, что в окне AutoCAD на текущий момент установлено пространство модели, 
говорят соответствующая пиктограмма ПСК на рабочем поле чертежа, индика-
ция кнопок Model в нижней части рабочего поля (рис. 15.1) и MODEL в строке со-
стояния. Если пользователь AutoCAD работает только с двухмерными объектами, 
ему нет особой необходимости переходить в пространство листа: все изображения 
объекта, а также дополнительная информация (рамка формата, размеры, основная 
надпись и пр.) могут формироваться в пространстве модели.

Рис. 15.1. Пиктограмма пользовательской  
системы координат пространства модели

Работа в пространстве модели производится на неперекрывающихся видовых 
экранах (окнах); там создается основной рисунок или модель. Если в окне про-
граммы присутствует несколько видовых экранов, то редактирование, произво-
димое в одном из них, оказывает действие на все остальные. Несмотря на это, зна-
чения экранного увеличения, точки зрения, интервала сетки и шага для каждого 
видового экрана могут устанавливаться отдельно.

Пространство листа (Paper Space) – это пространство AutoCAD, необходимое 
для отображения объекта, сформированного в пространстве модели, на перекры
вающихся (плавающих) видовых экранах. Пространство листа облегчает полу-

Пространство модели и пространство листа
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чение твердых копий рисунков и чертежей, разработанных автоматизированным 
путем. Если бы пространство листа не использовалось, пришлось бы загромож-
дать пространство модели графической информацией, необходимой лишь для 
формирования чертежных листов. Ведь такие элементы, как рамка чертежного 
листа, основная надпись и другая графическая и текстовая информация, не имеют 
отношения к реальной модели и требуются только в распечатке.

Листом называется компонент среды AutoCAD, имитирующий лист бумаги и 
хранящий в себе набор установок, используемых при выводе на плоттер. На листе 
можно размещать видовые экраны, а также строить геометрические объекты (на-
пример, элементы основной надписи). Рисунок может содержать несколько лис-
тов с разными видами модели; для каждого листа автономно задаются значения 
масштаба печати и размеров сторон. Изображение листа выглядит на экране точно 
так же, как и вычерченный на плоттере лист.

Видовой экран (viewport) представляет собой участок графического экрана, на 
котором отображается некоторая часть пространства модели рисунка.

Пространство листа строго двухмерно, и видеть его можно только с точки зрения, 
перпендикулярной плоскости листа. О том, что в AutoCAD на текущий момент 
установлено пространство листа, говорят соответствующая пиктограмма ПСК 
и индикация кнопки PAPER в строке состояния внизу рабочего стола AutoCAD 
(рис. 15.2).

В пространстве листа пиктограмма ПСК имеет треугольную форму; располага-
ется она всегда в левом нижнем углу области рисунка.

После создания плавающих видовых экранов вносить изменения в модель 
можно, переходя с закладки Layout на закладку Model. На листе в любое время до-
пускается изменение параметров, например формата бумаги или масштаба печати.

Чтобы сделать текущей закладку Model, необходимо щелкнуть на ней кнопкой 
мыши или ввести MSPACE в командной строке. Чтобы перейти из этой закладки в 
пространство листа, достаточно щелкнуть на одной из закладок Layout или ввести 
LAYOUT в командной строке.

Открыв лист, можно работать либо в пространстве листа, либо в пространстве 
модели (в последнем случае нужно сделать текущим какой-либо из видовых экра-
нов). Для того чтобы сделать видовой экран текущим, достаточно установить на 
него указатель мыши и дважды щелкнуть ее левой кнопкой. Чтобы текущим стало 
пространство листа, следует дважды щелкнуть кнопкой мыши на том месте, где 
нет ни одного видового экрана. Переключаться между пространствами модели и 
листа можно также с помощью кнопок MODEL/PAPER в строке состояния. При та-
ком способе переключения в пространство модели текущим становится видовой 
экран, который был активен последним.

Пространство листа – это аналог листа бумаги, на котором производится ком-
поновка чертежа перед его выводом на плоттер. В AutoCAD имеется несколько 
закладок Layout, благодаря чему одна и та же модель может быть представлена на 
чертеже в различных вариантах. Каждый лист рисунка можно считать отдельной 
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единицей комплекта проектной документации. После создания нового листа на 
нем размещаются плавающие видовые экраны, которые представляют модель в 
различных видах. Каждому видовому экрану могут быть присвоены отдельные 
значение масштаба и состояние видимости слоев.

Рис. 15.2. Рабочий стол в пространстве листа

После щелчка кнопкой мыши на закладке Layout AutoCAD переходит в среду 
пространства листа (см. рис. 15.2). Прямоугольник с тенью соответствует на экра-
не формату бумаги, на который настроено устройство печати. Границы области 
печати обозначены штриховыми линиями.

Управление отображением полей и разметки листа производится на вкладке 
Display диалогового окна Options. Там же пользователь может указать, должен ли 
при первом входе на лист открываться Диспетчер параметров для новых листов 
Page Setup Manager.

Пространство модели и пространство листа



Глава 15. Пространство и компоновка чертежа422

Часто проект не ограничивается одним листом: для одной и той же модели 
предусмотрено создание дополнительных листов, на которых размещаются ее раз-
личные виды и их комбинации.

Когда лист впервые делается активным и на нем создается первый видовой 
экран, значение точности аппроксимации кривых на нем устанавливается равным 
аналогичному значению для видового экрана пространства модели.

Для создания нового листа необходимо щелкнуть правой кнопкой мыши на 
ярлыке закладки Layout и в открывшемся контекстном меню выбрать пункт New 
layout. Для переименования закладки Layout следует вызвать контекстное меню и 
воспользоваться пунктом Rename.

Выполните упражнения Spa1 и Spa2 из раздела 5.

Мастер.компоновки.листа
Настройка параметров листа может производиться с помощью Мастера компо-
новки листа. Для этого необходимо загрузить диалоговое окно Create Layout, пока-
занное на рис. 15.3, из падающего меню Tools → Wizards → Create Layout... или ввести 
LAYOUTWIZARD в командной строке.

Рис. 15.3. Диалоговое окно Мастера компоновки листа, начало
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Мастер компоновки листа имеет восемь страниц.

�� Begin – начальная страница информирует пользователя о том, что дан-
ный Мастер предоставляет возможность скомпоновать новый лист 
(см. рис. 15.3). Здесь можно назначить устройство для вычерчивания и 
параметры печати, а также вставить основную надпись и разместить ви-
довые экраны. Все параметры, установленные в Мастере, записываются в 
чертеж, но в любой момент их можно отредактировать. Далее предлагает-
ся ввести имя создаваемого листа.

�� Printer – выбор плоттера для будущей печати создаваемого листа из чис-
ла сконфигурированных в системе (рис. 15.4). Если плоттера, на котором 
должна производиться печать, нет в списке, следует зайти в папку Принте-
ры Панели управления Windows и выбрать ярлык Установка принтера.

Рис. 15.4. Диалоговое окно Мастера компоновки листа, принтер

�� Paper Size – задание формата для нового листа (рис. 15.5). Набор доступ-
ных форматов определяется выбранным устройством печати. Далее осу-
ществляется выбор единиц для листа:
•� в области Drawing units – единицы чертежа: Millimeters – миллиметры; 

Inches – дюймы; Pixels – пикселы. Следует учесть: если одна единица 
рисунка должна равняться 1 дюйму на чертеже, необходимо установить 
в качестве единиц дюймы (даже для миллиметровых форматов листа 
по стандарту ISO). Если же единица рисунка соответствует 1 мм, то не-
обходимо установить миллиметры;

Мастер компоновки листа
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•� в области Paper size in units – отображается выбранный формат в текущих 
единицах: Width: – ширина; Height: – высота.

Рис. 15.5. Диалоговое окно Мастера компоновки листа, формат

�� Orientation – выбор ориентации чертежа на листе (рис. 15.6):
•� Portrait – книжная ориентация;
•� Landscape – альбомная ориентация.

Рис. 15.6. Диалоговое окно Мастера компоновки листа, ориентация
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�� Title Block – выбор используемой основной надписи (рис. 15.7), которая 
размещается, начиная от левого нижнего угла листа бумаги. Рамка чер-
тежа вместе с основной надписью выбирается из списка, где представ-
лены все стандартные блоки рамок форматов ANSI (American National 
Standards Institute) и ISO (International Standards Organization). Реко-
мендуется, чтобы рамка согласовывалась с установленными единицами 
чертежа, иначе возникает опасность того, что она не поместится на листе 
заданного формата или, наоборот, окажется слишком маленькой. Рамки 
ANSI рассчитываются в дюймах, а ISO, DIN и JIS – в миллиметрах. Раз-
меры рамки ANSI A составляют приблизительно 10×8 единиц. Если же 
установить в качестве единиц миллиметры и вставить эту рамку на лист 
A4 (297×210), выяснится, что для такого формата она слишком мала.
•� Path: – отображение пути файла выбранной основной надписи;
•� Preview – иллюстрация образца;
•� Type – способ вставки основной надписи: Block – блок; Xref – ссылка.

Рис. 15.7. Диалоговое окно Мастера компоновки листа, основная надпись

�� Define Viewports – выбор расположения видовых экранов (рис. 15.8):
•� Viewport setup – способ расположения:

◊� None – нет видовых экранов;
◊� Single – один видовой экран;
◊� Std. 3D Engineering Views – стандартный конструкторский набор видов: 

массив 2×2, включающий в себя виды сверху, спереди, сбоку и изо-
метрический;

◊� Array – массив;

Мастер компоновки листа
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•� Viewport scale: – масштаб видовых экранов. По умолчанию принято зна-
чение Scaled to Fit – вписанный. Если установить другой масштаб, вид 
будет отцентрирован в соответствии с границами области, занимаемой 
объектами в пространстве модели. Масштаб печати по умолчанию ра-
вен 1:1;

•� Rows: – число рядов;
•� Spacing between rows: – интервал между рядами;
•� Columns: – число столбцов;
•� Spacing between columns: – интервал между столбцами.

Рис. 15.8. Диалоговое окно Мастера компоновки листа, видовые экраны

�� Pick Location – указание положения видовых экранов (рис. 15.9). При на-
жатии кнопки Select location < Мастер предложит указать на листе угловые 
точки области, занимаемой видовыми экранами.

�� Finish – завершение создания листа.

Созданный лист можно редактировать: перемещать видовые экраны, строить 
дополнительные объекты и изменять параметры листа, используя падающее меню 
File → Page Setup Manager....

Работа.с.листами
После того как пользователь завершил создание модели, он обычно переходит в 
закладку Layout и начинает компоновать лист чертежа. При первом обращении к 
листу на нем создается один видовой экран; изображение листа с тенью и выпол-
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ненный штриховыми линиями прямоугольник символизируют текущий формат 
листа и границы области его печати.

Рис. 15.9. Диалоговое окно Мастера компоновки листа, положение

Диспетчер наборов параметров листов Page Setup Manager, содержащий сведе-
ния о выделенном наборе параметров, 
открывается при первом обращении 
к листу, либо из контекстного меню, 
которое вызывается щелчком пра-
вой кнопки мыши на закладке Layout 
(рис. 15.10). Диспетчер наборов пара-
метров листов предлагает настроить 
следующие параметры (рис. 15.11):

�� Device name: – имя устройства;
�� Plotter: – плоттер;
�� Plot size: – формат печати;
�� Where: – подключение;
�� Description: – пояснение;
�� Display when creating a new 

layout – установка данного па-
раметра обеспечивает откры-
тие Диспетчера наборов пара-
метров листов Page Setup при 
создании нового листа.

Рис. 15.10. Контекстное меню закладки 
Layout

Работа с листами
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Рис. 15.11. Диспетчер параметров листа

Для того чтобы отредактировать параметры листа, следует в диалоговом окне 
Page Setup Manager щелкнуть на кнопке Modify…, при этом загружается диалоговое 
окно Page Setup (рис. 15.12):

�� В области Page setup – сообщается имя набора параметров листа. Значок 
DWG справа означает, что диалоговое окно Page Setup открыто из листа. 
Значок выглядит иначе, если это диалоговое окно открыто из Диспетчера 
подшивок.

�� В области Printer/plotter определяются параметры сконфигурированного 
устройства печати для использования при распечатке (публикации) лис-
тов чертежа или подшивки:
•� Name: – список доступных PC3-файлов или системных устройств пе-

чати, выбираемых для вывода на печать (публикаций) текущего листа 
чертежа или подшивки. Значок спереди имени устройства обозначает 
его в качестве PC3-файла или системного принтера;
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•� кнопка Properties – загружает редактор параметров плоттера Plotter 
Configuration Editor, в котором можно просмотреть или изменить теку-
щую конфигурацию плоттера, задать параметры портов, устройства и 
носителя;

Рис. 15.12. Диалоговое окно определения параметров листа

•� Plotter: – отображает устройство печати, указанного в выбранном на те-
кущий момент наборе параметров листа;

•� Where: – физическое размещение выбранного устройства печати для те-
кущего набора параметров листа;

•� Description: – текстовое пояснение к устройству вывода, указанному в 
выбранном на текущий момент наборе параметров листа. Для редакти-
рования пояснения применяется редактор параметров плоттера Plotter 
Configuration Editor;

•� на образце показано точное отображение действительной области пе-
чати, соотносимое с форматом бумаги и печатаемой областью. Там же 
подписаны размеры формата листа и обозначена область печати.

�� В области Paper size приведен список стандартных форматов, разрешен-
ных для применения в выбранном устройстве печати. Если плоттер еще не 

Работа с листами
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выбран, в списке перечислены все поддерживаемые форматы листов. Об-
ласть печати, определенная в соответствии с типом печатающего устрой-
ства и форматом листа, выделяется в листе штриховой линией. При вы-
воде в растровый формат (например, в BMP- или TIFF-файл) размеры 
чертежа отображаются не в дюймах/миллиметрах, а в пикселях.

�� В области Plot area определяется выводимая на печать часть чертежа:

•� What to plot: – выбор части чертежа, которая будет напечатана: Display – 
экран; Extens – границы; Layout – лист; Window – рамка.

�� В области Plot offset (origin set to printable area) определяется смещение об-
ласти печати относительно левого нижнего угла печатаемой страницы 
или края бумаги, в зависимости от установки параметра Specify plot offset 
relative to диалогового окна Options, вкладка Plot and Publish:

•� X: – указывается начальная точка чертежа в направлении X по отно-
шению к точке, определяемой текущим значением параметра отсчета 
смещения чертежа Specify plot offset relative to диалогового окна Options, 
вкладка Plot and Publish;

•� Y: – указывается начальная точка чертежа в направлении Y по отно-
шению к точке, определяемой текущим значением параметра отсчета 
смещения чертежа Specify plot offset relative to диалогового окна Options, 
вкладка Plot and Publish;

•� Center the plot – центрирование, то есть автоматическое определение сме-
щений по X и Y так, чтобы чертеж оказался на бумаге в центре. Данный 
параметр не доступен, если в качестве области печати выбран Layout.

�� В области Plot scale – устанавливается масштаб единиц чертежа, выво-
димых на печать. По умолчанию для листа Layout устанавливается мас-
штаб 1:1. Для закладки Model – значение масштаба Fit to paper:
•� Fit to paper – масштаб соответствует чертежу, вписанному в выбранный 

размер бумаги. В полях Scale:, inches = и unit отображается пользователь-
ский масштабный коэффициент;

•� Scale: – точное значение масштаба печати. Custom является нестандарт-
ным пользовательским масштабом. Он задается путем ввода количества 
дюймов (или миллиметров), приравниваемого к числу единиц чертежа;

•� inches=/mm=/picsel= – определяет количество дюймов, миллиметров или 
пикселов, приравниваемое к указанному числу единиц чертежа;

•� unit – определяет соответствие единиц чертежа установленному числу 
единиц чертежа в дюймах, миллиметрах или пикселах;

•� Scale lineweights – масштабирование весов линий пропорционально мас-
штабу печати. Веса линий, как правило, обозначают ширину линий объ-
ектов чертежа, и печать для них выполняется с шириной линий, не за-
висимой от масштаба печати.
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�� В области Plot style table (pen assignments) устанавливается текущая таблица 
стилей печати (назначение перьев), редактируются имеющиеся и созда-
ются новые таблицы стилей печати:
•� в списке без маркировки приведена таблица стилей печати, назначенная 

текущей закладке Model или закладке листа Layout, и список доступных 
на текущий момент таблиц стилей печати. Если выбрать New…, то вызы-
вается Мастер стилей печати, в котором можно создать новую таблицу 
стилей печати. Вид Мастера определяется типом стилей печати, исполь-
зуемых в текущем чертеже (цветозависимые или именованные);

•� Display plot styles – определяет, отображаются ли на экране свойства сти-
лей печати, назначенных объектам;

•� кнопка Edit… – загружает Редактор таблиц стилей печати Plot Style Table 
Editor, где производятся просмотр и редактирование стилей, входящих в 
назначенную таблицу стилей печати:
◊� вкладка General (рис. 15.13) содержит общие сведения об имени и 

пояснениях к файлу таблицы стилей печати, а также информацию о 
нем: количество стилей, путь, версию, информацию о совместимости 
для импорта старых чертежей. С помощью параметра Apply global scale 
factor to non-ISO linetypes можно применить глобальный масштаб к ти-
пам линий, не относящимся к ISO;

◊� вкладки Table View и Form View (рис. 15.14, 15.15) – содержат все сущест-
вующие в таблице стили и их параметры;

◊� Name – имя. Имена стилей в таблицах именованных стилей печати 
разрешено менять. Имена цветозависимых стилей печати тесно свя-
заны с цветами объектов и не подлежат изменению. Программа под-
держивает имена стилей, содержащие до 255 символов;

◊� Description – текстовое пояснение к стилю печати;
◊� Color – цвет, которым печатается объект;
◊� Enable dithering – разрешение размывания, которое используется в 

плоттерах для имитации составных цветов путем пространственно-
го комбинирования точек, имеющих стандартные цвета AutoCAD 
(то есть цвета чернил картриджей). Если плоттер не поддерживает 
размывания, параметр игнорируется. Его отключение может по-
требоваться для того, чтобы избежать появления псевдоштриховых 
линий из-за размывания тонких векторов. Кроме того, отключение 
размывания делает более четкими матовые цвета. Если размывание 
отключено, программа использует ближайшие по значению стандарт-
ные цвета;

◊� Convert to grayscale – печатать оттенками серого (при условии, что 
плоттер поддерживает печать оттенками серого). Если этот параметр 
отключен, для печати цветов объекта используются значения модели 
RGB;

Работа с листами
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Рис. 15.13. Редактор таблиц стилей печати, вкладка общих сведений

◊� Use assigned pen # – номер назначенного пера, которым вычерчивают-
ся объекты, использующие данный стиль печати. Применим только 
для перьевых плоттеров. Допустимые значения находятся в интер-
вале от 1 до 32. Изменение номера пера невозможно в случае, если 
цвет в стиле печати имеет значение Use object color, а также для цвето-
зависимых стилей печати. В этих случаях в поле номера всегда стоит 
значение Automatic;

◊� Virtual pen # – номер виртуального пера в диапазоне от 1 до 255. Мно-
гие неперьевые плоттеры могут эмулировать работу перьевых с по-
мощью виртуальных перьев. В большинстве случаев программирова-
ние толщины перьев, образцов заполнения, стилей концов линий и 
соединений, цветов и интенсивности выполняется с передней панели 
устройства;
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Рис. 15.14. Редактор таблиц стилей печати, вкладка таблицы

◊� Screening – интенсивность. Допустимый диапазон значений – от 0 до 
100. Значение 0 соответствует выводу белым цветом, а значение 100 – 
полной интенсивности. Управление интенсивностью вывода возмож-
но только при активной настройке Enable dithering;

◊� Linetype – список с описаниями и образцами всех доступных типов 
линий;

◊� Adaptive adjustment – подстройка масштаба регулирует масштаб типа 
линий так, чтобы в каждом объекте укладывалось целое число эле-
ментарных образцов. Если он отключен, элементарные образцы могут 
обрываться в линиях на середине. Параметр необходимо отключать, 
если приоритет имеет соблюдение точного масштаба. Включение па-
раметра означает, что масштабы типов линий будут разными, но за 
счет этого будет достигнута корректность отображения объектов, вы-
полненных штриховыми и пунктирными линиями;

◊� Lineweight – список образцов и численных значений доступных весов 
линий. Значения в списке выражены в миллиметрах;

◊� Line End Style – стиль окончания линий может быть одним из следую-
щих: Butt – срез, Square – квадрат, Round – полукруг и Diamond – тре-
угольник;

◊� Line Join style – стиль соединения линий может быть одним из следую-
щих: Miter – угол, bevel – скос, Round –дуга и Diamond – треугольник;

Работа с листами
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Рис. 15.15. Редактор таблиц стилей печати, вкладка карточки

◊� Fill Style – стиль заполнения может быть одним из следующих: Solid – 
сплошное, Checkerboard – решетка, Crosshatch – штриховка, Diamonds – 
шахматы, Horizontal Bars – горизонтальные полосы, Slant Left – наклон-
ные влево, Slant Right – наклонные вправо, Square Dots – квадраты и 
Vertical Bars – вертикальные полосы;

◊� кнопка Add Style используется для добавления стиля в таблицу име-
нованных стилей печати;

◊� кнопка Delete Style используется для удаления выбранного стиля из 
таблицы стилей печати;

◊� кнопка Edit Lineweights… загружает диалоговое окно редактирования 
весов линий Edit Lineweights.
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�� В области Shaded viewport options задается способ вывода на печать раскра-
шенных и тонированных видовых экранов и определяются их уровни раз-
решения и количество точек на дюйм (т/дюйм):
•� Shade plot – способ вывода видов на печать. Чтобы задать этот параметр 

для видового экрана во вкладке листа, нужно выбрать видовой экран, 
а затем из падающего меню Tools → Properties. Для видового экрана на 
вкладке Model возможны следующие варианты:
◊� As displayed – объекты выводятся на печать так же, как они выглядят 

на экране;
◊� Wireframe – на печать выводятся только контуры объектов, независи-

мо от того, как они выглядят на экране;
◊� Hidden – скрытые линии на печать не выводятся, независимо от того, 

видны ли они на экране;
◊� 3D Hidden – объекты печатаются с применением визуального стиля 

3D Hidden независимо от способа отображения объектов на экране;
◊� 3D Wireframe – объекты печатаются с применением визуального стиля 

3D Wireframe независимо от способа отображения объектов на экране;
◊� Conceptual – объекты печатаются с применением концептуального 

визуального стиля независимо от способа отображения объектов на 
экране;

◊� Realistic – объекты печатаются с применением реалистичного визуаль-
ного стиля независимо от способа отображения объектов на экране;

◊� Rendered – выполняется печать объектов с тонированием независимо 
от того, как они выглядят на экране;

◊� Draft – выполняется печать объектов в черновом варианте;
◊� Low – выполняется печать объектов с низким разрешением;
◊� Medium – выполняется печать объектов со средним разрешением;
◊� High – выполняется печать объектов высокого качества;
◊� Presentation – выполняется презентационная печать объектов;

•� Quality – задание качества разрешения для печати раскрашенных и тони-
рованных видовых экранов. Для видового экрана возможны следующие 
варианты:
◊� Draft – тонированные и раскрашенные виды пространства модели пе-

чатаются в черновом каркасном режиме;
◊� Preview – тонированные и раскрашенные виды пространства модели 

печатаются в режиме просмотра с разрешением 1/4 от текущего раз-
решения устройства печати, максимум 150 т/дюйм;

◊� Normal – тонированные и раскрашенные виды пространства модели 
печатаются с нормальным разрешением 1/2 от текущего разрешения 
устройства печати, максимум 300 т/дюйм;

◊� Presentation – тонированные и раскрашенные виды пространства мо-
дели печатаются с презентационным текущим разрешением устрой-
ства печати, максимум 600 т/дюйм;
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◊� Maximum – тонированные и раскрашенные виды пространства модели 
печатаются с текущим разрешением устройства печати без установки 
максимального ограничения;

◊� Custom – тонированные и раскрашенные виды пространства модели 
печатаются с пользовательским разрешением, которое задается в поле 
DPI и не может быть больше текущего разрешения устройства печати;

•� DPI – задание разрешения (т/дюйм) для печати раскрашенных и тони-
рованных видов. Задаваемое пользователем разрешение не может быть 
больше текущего разрешения устройства печати. Данное поле доступно 
для редактирования, только если в списке Quality выбрано Custom.

�� В области Plot options устанавливаются параметры печати:
•� Plot object lineweights – определяет, учитываются ли при печати веса ли-

ний, назначенные объектам и слоям. Данный параметр недоступен, если 
выбран параметр Plot with plot styles;

•� Plot transparency – устанавливает прозрачность при печати:
•� Plot with plot styles – определяет, учитываются ли при печати стили пе-

чати, применяемые к объектам и слоям. При выборе данного варианта 
автоматически активизируется также настройка Plot object lineweights;

•� Plot paperspace last – печать объектов пространства модели в первую оче-
редь, а объектов листа – последними;

•� Hide paperspace objects – определяет, применяется ли скрытие к объектам 
на видовых экранах листа. Доступно только для вкладок-листов. Эф-
фект от данной настройки проявляется в образце для предварительного 
просмотра, но не в листе.

�� В области Drawing orientation – задание ориентации чертежа на листе для 
плоттеров, поддерживающих ее книжный и альбомный варианты:
•� Portrait – чертеж ориентируется таким образом, что при печати верх 

страницы соответствует короткой стороне листа;
•� Landscape – чертеж ориентируется таким образом, что при печати верх 

страницы соответствует длинной стороне листа;
•� Plot upside-down – осуществляется поворот чертежа на 180°.

 Значок указывает ориентацию выбранной бумаги и задает ориентацию 
чертежа на странице в виде, совпадающем с расположением букв на бу-
маге. Значение параметра ориентации чертежа хранится в системной 
переменной PLOTROTMODE.

�	Кнопка Preview… предназначена для предварительного просмотра 
чертежа на экране в таком виде, в каком он появится на бумаге. Для 
выхода из режима предварительного просмотра необходимо нажать Esc 
или Enter.

Если не нужно, чтобы диалоговое окно Page Setup Manager открывалось при 
начале работы с каждым новым листом, следует убрать флажок Show Page Setup 
Manager for new layouts на вкладке Display диалогового окна Options. Для того чтобы 
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программа AutoCAD не создавала автоматически видовой экран на каждом новом 
листе, потребуется отключить там же функцию Create viewport in new layouts.

Имеющиеся в рисунке листы можно удалять, переименовывать, переставлять 
местами и копировать. Для этого достаточно щелкнуть правой кнопкой мыши на 
ярлыке листа, а затем выбрать нужный пункт из контекстного меню.

Если присвоить имя набору параметров, установленных для листа, и сохранить 
этот набор, его разрешается впоследствии применять к другим листам. Используя 
для листа различные наборы параметров, можно выводить его на печать в разных 
вариантах, не затрачивая на это значительных усилий.

Вставка.листа.с.помощью.Центра.
управления.AutoCAD
Центр управления AutoCAD DesignCenter позволяет перетаскивать в текущий 
рисунок листы вместе с находящимися на них геометрическими объектами. Су-
ществует несколько способов вставки листов с помощью Центра управления:

�� выбрать значок листа на палитре Центра управления AutoCAD и пере-
тащить его на новый лист;

�� выбрать значок листа на палитре Центра управления AutoCAD, щелкнуть 
правой кнопкой мыши и выбрать пункт Copy из контекстного меню, а за-
тем из падающего меню Edit → Paste;

�� дважды щелкнуть на значке листа на палитре Центра управления.

Физически процесс вставки листа с помощью Центра управления AutoCAD 
сводится к созданию в рисунке нового листа, на который копируются все геомет-
рические объекты, символьные таблицы и описания блоков из исходного. Для 
того чтобы удалить из созданного листа ненужные элементы символьных таблиц 
и описания блоков, следует применить команду PURGE.

Видовые.экраны
Видовой экран (viewport) представляет собой участок графического экрана, где 
отображается некоторая часть пространства модели рисунка.

Существуют два типа видовых экранов – неперекрывающиеся и перекрываю-
щиеся (рис. 15.16). Неперекрывающиеся видовые экраны располагаются на экра-
не монитора подобно кафельным плиткам на стене. Они полностью заполняют 
графическую зону и не могут накладываться друг на друга. На плоттер непере-
крывающиеся видовые экраны выводятся только поодиночке. Перекрывающиеся 
видовые экраны подобны прямоугольным окнам, которые располагаются на экра-
не и перемещаются по нему произвольным образом. Эти видовые экраны могут 
накладываться друг на друга и вычерчиваться одновременно.

Видовые экраны
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Рис. 15.16. Примеры неперекрывающихся и перекрывающихся видовых экранов

Именованные.виды
С целью последующего использования виды можно сохранять под уникальными 
именами. Допускается сохранение видового экрана целиком или только какой-
либо его части. Виды пространства модели и пространства листа сохраняются от-
дельно. Если использовано несколько видовых экранов, то восстанавливается вид 
на активном видовом экране. Восстанавливая различные виды на разных видовых 
экранах, можно одновременно получить несколько видов одной и той же модели. 
При этом восстанавливаются следующие характеристики:

�� центральная точка;
�� направление взгляда;
�� коэффициент зуммирования;
�� перспектива (фокусное расстояние).

Кроме того, может быть восстановлена текущая ПСК, если она была сохранена 
с видом.

AutoCAD позволяет строить по методу прямоугольного проецирования шесть 
основных видов, соответствующих принятым в чертежной практике направлени-
ям взгляда. Эти виды широко используются для изображения трехмерных пред-
метов.

В пространстве модели можно сохранять вид только на одном видовом экране. 
При восстановлении сохраненный вид замещает ранее находившийся на выбран-
ном видовом экране.

В пространстве листа сохраненный вид может содержать сразу несколько ви-
довых экранов. В этом случае восстанавливается весь вид пространства листа с 
учетом положений модели и масштабных коэффициентов для каждого видового 
экрана.

Настройка отображения любого видового экрана, а также простран-
ства листа сохраняется под уникальным именем и затем восстанавли-
вается с помощью команды ViEw, которая вызывает диалоговое окно 
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управления видами View Manager – см. рис. 15.17. Это же диалоговое окно мож-
но открыть из падающего меню View → Named Views....

Рис. 15.17. Диалоговое окно управления видами

Для создания вида необходимо нажать кнопку New... и в появившемся диало-
говом окне New View, показанном на рис. 15.18, назначить следующие параметры.

Именованные виды
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Рис. 15.18. Диалоговое окно определения нового вида
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�� В текстовом поле View Name: указать имя вида.
�� В текстовом поле View category: указывается категория для именованного 

вида. Необходимо выбрать категорию из выпадающего списка, ввести имя 
новой категории или оставить это поле пустым.

�� В области Boundary – определить границы:
•� Current display – в качестве границ для создаваемого вида использовать 

границы текущего экрана;
•� Define window – в качестве границ нового вида используется окно, опре-

деляемое в области рисования с помощью рамки по двум противопо-
ложным углам;

•� кнопка Define view window позволяет задать границы нового вида с по-
мощью мыши.

�� В области Settings определить следующие параметры:
•� Save layer snapshot with view – сохранить настройки видимости текущего 

слоя вместе с создаваемым видом;
•� UCS: – для сохранения с новым видом указывается ПСК для вида моде-

ли и вида на листе;
•� Live section: – для видов моделей указывается псевдосечение, применяе-

мое при восстановлении вида;
•� Visual style: – указывается визуальный стиль для видов моделей:

◊� None – нет;
◊� Current – текущий;
◊� 2D Wreframe – двухмерный каркас;
◊� 3D Hidden – трехмерный скрытый;
◊� 3D Wreframe – трехмерный каркас;
◊� Conceptual – концептуальный;
◊� Realistic – скрытый.

�� В области Background определяется фон для видов моделей, значение ви-
зуального стиля которых отлично от 2D Wreframe:
•� список предназначен для переопределения стандартного фона и загруз-

ки диалогового окна Background (рис. 15.19), параметры которого не-
сколько отличаются в зависимости от выбранного типа:
◊� Type: – тип фона: Solid – тело; Gradient – градиент; Image – изображение;
◊� Gradient options – параметры градиента: Three color – три цвета; Top 

color: – верхний цвет; Middle color: – средний цвет; Bottom color: – ниж-
ний цвет; Rotation: – угол поворота;

◊� Preview – окно просмотра;
•� Current override: – отображение типа переопределения текущего фона, 

если он задан.
�� Кнопка ... – если выбран параметр Override default background, то открыва-

ется диалоговое окно Background, в котором можно изменить выбор теку-
щего фона.

Именованные виды
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Рис. 15.19. Диалоговое окно переопределения стандартного фона

Неперекрывающиеся.видовые.экраны
Графическую область в пространстве модели можно разбить на несколько непере-
крывающихся видовых экранов, а в пространстве листа создать перекрывающиеся 
(плавающие) видовые экраны.

Обычно работа с новым рисунком в пространстве модели вначале производится на 
одном видовом экране, занимающем всю графическую область. Этот видовой экран 
можно разделить на несколько, выводя на них одновременно различные виды: напри-
мер, на одном – общий вид, а на другом – вид какого-либо элемента. При этом удобно 
наблюдать, как редактирование данного элемента отражается на рисунке в целом.

На неперекрывающихся видовых экранах допускается:

�� производить панорамирование и зуммирование, настраивать режимы сет-
ки, шаговой привязки и изображения пиктограммы ПСК;

�� задавать систему координат и восстанавливать виды для каждого отдель-
ного видового экрана;
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�� переключаться с одного видового экрана на другой в ходе выполнения ко-
манд рисования;

�� сохранять именованную конфигурацию видовых экранов в пространстве 
модели или применять ее в пространстве листа.

При работе с трехмерными моделями обычно требуется назначение различных 
систем координат для отдельных видовых экранов. Можно также задать систем-
ную переменную UCSVP такой, чтобы ПСК в данном видовом экране совпадала с 
ПСК текущего видового экрана.

В процессе рисования все изменения, производимые на одном из видовых 
экранов, немедленно отражаются на остальных. Переключение с одного видового 
экрана на другой можно производить в любой момент, даже в ходе выполнения 
команды.

Создание.нескольких.видовых.экранов
Конфигурации неперекрывающихся видовых экранов могут быть различными. 
Возможности размещения видовых экранов зависят от их количества и разме-
ров.

Когда системная переменная TILEMODE установлена в 1, для создания 
видовых экранов и манипулирования ими используется команда 
VPORts, открывающая диалоговое окно Viewports. С помощью этой 
команды графический экран разделяется на несколько неперекрыва-
ющихся частей, каждая из которых может содержать отдельный вид 
рисунка. Команда VPORts вызывается из падающего меню View → 
Viewports → New Viewports... либо щелчком на пиктограмме Viewports 
Configuration в группе Model Viewports ленты View в рабочем простран-
стве Drafting & Annotation (рис. 15.20, 15.21).

Плавающие.видовые.экраны
Когда пользователь впервые переключается в пространство листа, графический 
экран пуст и представляет собой «чистый лист», где будет компоноваться чертеж. 
В пространстве листа создаются перекрывающиеся (плавающие) видовые экраны, 
содержащие различные виды модели. Здесь эти видовые экраны рассматривают-
ся как отдельные объекты, которые можно перемещать и масштабировать, чтобы 
подходящим образом расположить их на листе чертежа. В отличие от неперекры-
вающихся видовых экранов, нет ограничений, разрешающих вывод на плоттер 
только одного вида пространства модели. Допускается вычерчивать на бумаге 
любую комбинацию плавающих видовых экранов. Кроме того, различного рода 
объекты (например, основную надпись или примечания) можно создавать и непо-
средственно в пространстве листа, не затрагивая модели.

Плавающие видовые экраны
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Рис. 15.20. Инструменты создания видовых экранов

Поскольку плавающие видовые экраны трактуются как самостоятельные объ-
екты, редактировать модель в пространстве листа нельзя. Для получения доступа 
к ней на плавающем видовом экране необходимо переключиться из пространства 
листа в пространство модели. Редактирование при этом производится в пределах 
одного из плавающих видовых экранов. На рисунке определить, какой из видовых 
экранов является текущим, можно по находящемуся внутри него перекрестью. 
Кроме того, о работе в пространстве модели говорит соответствующая форма пик-
тограммы ПСК. В результате появляется возможность при работе с моделью ви-
деть и скомпонованный лист.

Как указывалось выше, пространство модели можно увидеть из пространства 
листа через окна видовых экранов. Видовые экраны в пространстве листа – это 
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прямоугольники, где отображаются определенные части и виды модели, сформи-
рованной в пространстве модели.

Рис. 15.21. Диалоговое окно создания видовых экранов

Возможности редактирования и смены вида плавающих видовых экранов 
почти те же, что и неперекрывающихся. Однако в первом случае имеется больше 
средств управления отдельными видами. Например, на некоторых видовых экра-
нах можно заморозить либо отключить отдельные слои без воздействия на другие 
экраны. Кроме того, предусмотрены включение и отключение тех или иных ви-
довых экранов. Есть возможность выравнивать вид на одном видовом экране от-
носительно вида в другом, а также масштабировать виды относительно масштаба 
листа в целом.

Плавающие видовые экраны создаются и управляются командой MVIEW. Не-
которые стандартные конфигурации (включая стандартную конструкторскую с 
различными видами на каждом видовом экране) вызываются с помощью команды 
MVSETUP.

Вновь создаваемые плавающие видовые экраны можно расположить в любом 
месте области рисунка. Как и в случае с неперекрывающимися видовыми экрана-
ми, для них допустим выбор одной из стандартных конфигураций.

Плавающие видовые экраны
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После указания количества создаваемых видовых экранов задаются границы 
области, которую эти экраны покрывают. Хотя плавающие видовые экраны фор-
мируются одновременно, они представляют собой отдельные объекты, которые 
при необходимости можно перемещать, стирать, изменять их размеры.

После создания плавающих видовых экранов, изменяя их положение и ха-
рактеристики, легко добиться требуемой конфигурации видов. Видовые экраны 
разрешено копировать, перемещать, растягивать, масштабировать и стирать с по-
мощью стандартных команд, а также большинства режимов редактирования с ис-
пользованием ручек. Кроме того, к ним применимы режимы объектной привязки. 
Редактирование видовых экранов ведется в пространстве листа; при этом отобра-
жение их границ должно быть включено.

При масштабировании вида на видовом экране иногда требуется изменение его 
размеров. Масштабирование и растягивание границы видового экрана не влияет 
на находящийся в нем вид.

Перемещая границы видового экрана, можно «подрезать» вид так, чтобы отобра-
жалась только требуемая часть рисунка.

При создании плавающих видовых экранов существуют разные подходы к их 
размещению на листе. В некоторых случаях создают всего один видовой экран, за-
нимающий весь лист, в других же пользуются более сложными конфигурациями.

Созданная на листе конфигурация плавающих видовых экранов не может быть 
сохранена под определенным именем. Такая операция допустима только для не-
перекрывающихся видовых экранов пространства модели.

Поскольку видовые экраны являются объектами AutoCAD, у них имеются все 
свойства, присущие объектам: цвет, слой, тип и вес линии, масштаб типа линии, 
стиль печати. Вес и тип линии отображаются только для видовых экранов произ-
вольной формы; для прямоугольных же эти параметры игнорируются. Для изме-
нения свойств видового экрана необходимо его выбрать, а затем загрузить палит-
ру Properties из падающего меню Tools → Properties.

Масштабирование и растягивание границы плавающего видового экрана не 
влияют на масштаб находящегося на нем вида. Для согласования масштабов всех 
видов можно воспользоваться масштабированием относительно единиц простран-
ства листа – это обеспечивает корректность всех масштабов при выводе рисунка 
на плоттер.

Когда работа ведется в пространстве листа, масштабный коэффициент выра-
жает отношение размера изображения на листе к действительному размеру мо-
дели на видовом экране. Листы, как правило, выводятся на печать в масштабе 1:1. 
Для определения величины коэффициента нужно разделить единицу длины про-
странства листа на единицу длины пространства модели. Например, чтобы вывес-
ти чертеж в масштабе 1:4, в качестве коэффициента следует указать отношение 
одной единицы пространства листа к четырем единицам пространства модели. 
Для изменения масштаба вычерчивания видового экрана можно воспользоваться 
палитрой свойств объектов Properties или панелью Viewports.



447

Видовые.экраны.произвольной.формы
Удобными представляются возможность создания в пространстве листа непрямо-
угольных видовых экранов и связывание с видовыми экранами контуров подрез-
ки, благодаря которым их видимая форма может быть любой.

При создании видового экрана произвольной формы обычному видовому 
экрану ставится в соответствие подрезающий контур – полилиния, окружность, 
область, сплайн или эллипс. Ассоциативная связь между этими объектами дей-
ствует, пока они оба существуют в рисунке.

Допускается модификация уже имеющихся видовых экранов путем переопре-
деления их границ. В качестве новой границы при переопределении можно задать 
замкнутую полилинию, окружность, сплайн, эллипс, область или дуговой сегмент.

Для создания видовых экранов предназначены два ключа команды VPORts – 
Object и Polygonal.

Ключи команды VPORts:

�� Object – позволяет преобразовать в видовой экран объект, постро-
енный в пространстве листа. Вызов команды осуществляется из 
падающего меню View → Viewports → Object. При этом команда 
VPORts выдает следующие запросы:
Specify corner of viewport or
[ON/OFF/Fit/Shadeplot/Lock/Object/Polygonal/
Restore/2/3/4] <Fit>: _o – переход в режим преобразования 
видового экрана в объект
Select object to clip viewport: – выбрать объект для под-
резки видового экрана

Если выбирается полилиния, она должна быть замкнутой и иметь не менее 
трех вершин. Допускается наличие в ней сегментов любого типа (как линейных, 
так и дуговых), а также самопересечения. Полилиния связывается с вновь созда-
ваемым видовым экраном; в результате получается видовой экран неправильной 
формы. Этот процесс происходит так: AutoCAD описывает прямоугольник вокруг 
выбранного объекта, создает на его основе прямоугольный видовой экран, а затем 
«подрезает» его этим объектом.

�� Polygonal – позволяет описать границу видового экрана путем 
указания точек-вершин. Последовательность запросов аналогична 
той, которая используется при построении полилиний. Вызов ко-
манды при этом осуществляется из падающего меню View → 
Viewports → Polygonal Viewport. При этом команда VPORts выдает 
следующие запросы:
Specify corner of viewport or
[ON/OFF/Fit/Shadeplot/Lock/Object/Polygonal/Restore/2/3/4] 
<Fit>: _p – переход в режим посроения видового экрана в форме 
многоугольника

Видовые экраны произвольной формы
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Specify start point: – указать начальную точку
Specify next point or [Arc/Length/Undo]: – указать следую-
щую точку
Specify next point or [Arc/Close/Length/Undo]: – указать 
следующую точку
Specify next point or [Arc/Close/Length/Undo]:

Как и любые другие объекты, контуры подрезки можно редактировать с по-
мощью ручек.

Выполните упражнения Vpr1–Vpr3 и тест 9 из раздела 5.
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Создание трехмерных моделей – более трудоемкий процесс, чем построение их 
проекций на плоскости, но при этом трехмерное моделирование обладает рядом 
преимуществ, среди которых:

�� возможность рассмотрения модели из любой точки;
�� автоматическая генерация основных и дополнительных видов на плоскости;
�� построение сечений на плоскости;
�� подавление скрытых линий, добавление источников освещения, назначе-

ние материалов и создание реалистичных сцен;
�� проверка взаимодействий объектов, инженерный анализ и расчеты;
�� перемещение по модели и создание анимации;
�� экспорт модели в анимационные приложения;
�� извлечение характеристик, необходимых для производства.

AutoCAD поддерживает следующие типы трехмерных моделей: каркасные, по-
верхности, сети и твердотельные. Каждый из них обладает определенными досто-
инствами и недостатками. Для моделей каждого типа существует своя технология 
создания и редактирования.

Поскольку перечисленным типам моделирования присущи собственные мето-
ды создания пространственных моделей и способы редактирования, не рекомен-
дуется смешивать несколько типов в одном рисунке. 

Каркасная модель представляет собой скелетное описание трехмерного объ-
екта. Она не имеет граней и состоит только из точек, отрезков и кривых, описы-
вающих ребра объекта. AutoCAD дает возможность создавать каркасные модели 
путем размещения плоских объектов в любом месте трехмерного пространства. 
Имеется несколько способов такого размещения:

�� ввод значений трехмерных точек (с координатами x, y и z) в ходе построе-
ния объекта;

�� указание плоскости построений (то есть плоскости XY) для рисования дву-
мерного объекта путем установки пользовательской системы координат;

�� перемещение и определение пространственной ориентации созданного 
ранее плоского объекта.

Кроме того, AutoCAD позволяет непосредственно строить некоторые виды 
трехмерных объектов типа каркасных моделей, например трехмерные полилинии 
и сплайны.

Поскольку каждый объект, составляющий такую модель, должен рисоваться 
и размещаться независимо от других, моделирование часто занимает очень много 
времени.

Ниже описаны трехмерные примитивы, используемые в каркасных моделях.

Точка
Команда POiNt, формирующая примитив точка, вызывается из падаю-
щего меню Draw → Point или щелчком на пиктограмме Multiple Point в 
группе Draw ленты Home рабочего пространства 3D Modeling. Трехмерная 
точка задается тремя координатами x, y, z.
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Запросы команды POiNt:
Current point modes: PDMODE=0 PDSIZE=0.0000 – 

текущие режимы точек
Specify a point: – указать точку
Для указания точек на рисунке AutoCAD исполь-

зует фиксированную декартову систему координат 
(рис. 16.1). Ось X определяет расстояния по горизон-
тали, ось Y – по вертикали, ось Z проходит под прямым 
углом к плоскости, образованной осями X и Y (то есть 
плоскости XY). Началом трехмерной системы коорди-
нат считается точка с координатами (0,0,0).

Чтобы получить проекции точки на плоскостях про-
екций XY, XZ, YZ, достаточно приравнять к нулю одну из 
координат. Например, для получения проекции точки в 
плоскости XY нужно приравнять к нулю координату Z.

Отрезок
Команда LiNE, формирующая отрезок, вызывается из падающего 
меню Draw → Line или щелчком на пиктограмме Line в группе Draw 
ленты Home рабочего пространства 3D Modeling.

Запросы команды LiNE:
Specify first point: – указать первую точку отрезка
Specify next point or [Undo]: – указать следующую точку отрезка
Specify next point or [Undo]: – указать следующую точку отрезка
Specify next point or [Close/Undo]:

При выполнении этой команды необходимо указать оба конца отрезка, введя 
их трехмерные координаты x, y, z.

В момент перемещения к каждой следующей точке за перекрестьем тянется 
«резиновая нить», которая помогает отслеживать положение каждого следующего 
сегмента ломаной линии.

Трехмерные.полилинии
Команда 3DPOLY, которая формирует трехмерные полилинии, состоя-
щие только из прямолинейных сегментов, вызывается из падающего 
меню Draw → 3D Polyline или щелчком на пиктограмме 3D Polyline в 
группе Draw ленты Home рабочего пространства 3D Modeling.

Запросы команды 3DPOLY:
Specify start point of polyline: – указать начальную точку полилинии
Specify endpoint of line or [Undo]: – указать конечную точку сегмента
Specify endpoint of line or [Undo]: – указать конечную точку сегмента
Specify endpoint of line or [Close/Undo]: – указать конечную точку 

сегмента или замкнуть линию

Рис. 16.1. 
Фиксированная 

декартова система 
координат

Трехмерные полилинии
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Ответом по умолчанию является точка. Далее можно ввести сколько угодно 
новых точек. Для отрисовки замыкающего сегмента, направленного к первой точ-
ке, необходимо ввести ключ Close или просто C, а для удаления последнего вве-
денного сегмента и продолжения построения от предыдущей точки – Undo или 
U. Нажатие клавиши Enter завершает отрисовку трехмерной полилинии в послед-
ней введенной точке. Трехмерные полилинии можно редактировать с помощью 
команды PEDit, а если требуется, выполнить трехмерное сглаживание вершин 
такой полилинии В-сплайном.

Спираль
Команда HELiX, формирующая спираль, вызывается из падающего 
меню Draw → Helix или щелчком на пиктограмме Helix на панели ин-
струментов Modeling.

Спираль представляет собой открытую двухмерную или трехмерную переход-
ную кривую, которую можно использовать в качестве траектории для команды 
swEEP. Например, при сдвиге круга вдоль траектории спирали может быть соз-
дана твердотельная модель пружины.

Запросы команды HELiX:
Number of turns = 3.0000  Twist=CCW – количество и наклон витков
Specify center point of base: – указать центральную точку основания
Specify base radius or [Diameter]: – указать радиус основания или диаметр
Specify top radius or [Diameter]: – указать радиус верхнего основания 

или диаметр
Specify helix height or [Axis endpoint/Turns/turn Height/tWist]: – 

указать высоту спирали или один из ключей
Ключи команды HELiX:

�� Axis endpoint – задание расположения конечной точки для оси спира-
ли. Конечная точка оси определяет длину и ориентацию спирали и может 
быть расположена в любом месте трехмерного пространства;

�� Turns – задание количества витков (вращений) спирали, которое не мо-
жет быть больше 500;

�� turn Height – задание высоты одного полного витка спирали;
�� tWist – задание направления вычерчивания спирали: по часовой стрелке 

или против часовой стрелки.
Если для радиуса в основании и радиуса при вершине задать равные значения, 

будет создана цилиндрическая спираль. По умолчанию радиус при вершине и 
радиус в основании задаются равными. Значение 0 не может быть задано ни для 
радиуса при вершине, ни для радиуса в основании.

Если для радиуса в основании и радиуса при вершине задать разные значения, 
будет создана коническая спираль. Если задать высоту витка равной 0, создается 
плоская двухмерная спираль. 
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Моделирование с помощью поверхностей – более сложный процесс, чем форми-
рование каркасных моделей, так как в нем описываются не только ребра трехмер-
ного объекта, но и его грани. AutoCAD строит поверхности на базе многоугольных 
сетей. Поскольку грани сети плоские, представление криволинейных поверхно-
стей производится путем их аппроксимации. Чтобы было проще различать два 
упомянутых типа поверхностей, под термином «сети» будем понимать те из них, 
которые составлены из плоских участков.

Модель поверхности – это тонкая оболочка, не имеющая массы или объема. 
В AutoCAD предусмотрены два типа поверхностей: процедурные поверхности 
и NURBS-поверхности. Процедурные поверхности позволяют воспользоваться 
преимуществами ассоциативного моделирования, а NURBS-поверхности – пре-
имуществами образования рельефа с помощью управляющих вершин.

Модели поверхностей создают с помощью сдвига, выдавливания, поворота и 
построения по сечениям. Можно также создавать поверхности путем создания 
перехода, замыкания, смещения, сопряжения и удлинения других поверхностей.

При формировании поверхностей используется падающее меню Draw → 
Modeling → Surfaces (рис. 17.1).

Рис. 17.1. Падающее меню для формирования поверхностей
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В рабочем пространстве 3D Modeling команды формирования поверхностей на-
ходятся на ленте Surface (рис. 17.2).

Рис. 17.2. Иструменты для формирования поверхностей в пространстве 3D Modeling

Плоская.поверхность
Команда PLANEsURF обеспечивает создание плоских поверхностей в 
пространстве между замкнутыми подобъектами-кромками (ребрами) 
и другими двухмерными и трехмерными кривыми (рис.  17.3). Команда 
вызывается из падающего меню Draw → Modeling → Surfaces → Planar 
или щелчком на пиктограмме Planar Surface в группе Create ленты 
Surface рабочего пространства 3D Modeling.

Запросы команды PLANEsURF:
Specify first corner or [Object] <Object>: – указать первый угол по-

верхности
Specify other corner: – указать другой угол поверхности

Ключи команды PLANEsURF:

�� Object – создание плоской или усеченной поверхности при выборе одно-
го замкнутого объекта или множества объектов, образующих замкнутую 
область.

Рис. 17.3. Формирование плоских поверхностей

Сетевая.поверхность
Команда sURFNEtwORK обеспечивает создание поверхности в про-
странстве между несколькими кривыми в направлениях осей U и V с 

Сетевая поверхность
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использованием подобъектов-кромок поверхности и ребер тела (рис. 17.4). 
Команда вызывается из падающего меню Draw → Modeling → Surfaces → Network 
или щелчком на пиктограмме Network Surface в группе Create ленты Surface ра-
бочего пространства 3D Modeling.

Рис. 17.4. Пример сетевой поверхности

Запросы команды sURFNEtwORK:
Select curves or surface edges in first direction: – выбрать сеть 

незамкнутых кривых, незамкнутые кромки поверхностей или кромки областей в 
первом направлении оси U или V

Select curves or surface edges in first direction: – выбрать сеть 
незамкнутых кривых, незамкнутые кромки поверхностей или кромки областей в 
первом направлении оси U или V

Select curves or surface edges in first direction: – нажать Enter для 
завершения выбора

Select curves or surface edges in second direction: – выбрать сеть 
незамкнутых кривых, незамкнутые кромки поверхностей или кромки областей во 
втором направлении оси U или V

Select curves or surface edges in second direction: – выбрать сеть 
незамкнутых кривых, незамкнутые кромки поверхностей или кромки областей во 
втором направлении оси U или V

Select curves or surface edges in second direction: – нажать Enter для 
завершения выбора
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Поверхность.перехода
Команда sURFBLEND обеспечивает создание поверхности непре-
рывного перехода между двумя существующими поверхностями 
(рис. 17.5). Команда вызывается из падающего меню Draw → 
Modeling → Surfaces → Blend или щелчком на пиктограмме Surface 
Blend в группе Create ленты Surface рабочего пространства 3D Modeling.

Рис. 17.5. Пример поверхности перехода

Запросы команды sURFBLEND:
Continuity = G1 - tangent, bulge magnitude = 0.5 – текущие значения 

непрерывности и величины прогиба
Select first surface edges to blend: – выбрать кромки первой поверх-

ности для сглаживания
Select first surface edges to blend: – выбрать кромки первой поверх-

ности для сглаживания
Select first surface edges to blend: – нажать Enter для завершения вы-

бора
Select second surface edges to blend: – выбрать кромки второй поверх-

ности для сглаживания
Select second surface edges to blend: – выбрать кромки второй поверх-

ности для сглаживания
Select second surface edges to blend: – нажать Enter для завершения 

выбора

Поверхность перехода
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Press Enter to accept the blend surface or [CONtinuity/Bulge magnitude]: – 
нажать Enter для завершения команды

Ключи команды sURFBLEND:
�� CONtinuity – указание плавности перехода одной поверхности в другую;
�� Bulge magnitude – указание скругления кромки переходной поверхности 

в месте ее соединения с исходной поверхностью (допустимые значения – 
от 0 до 1).

Замыкающая.поверхность
Команда sURFPAtCH обеспечивает создание поверхности, служа-
щей ограничителем по кромке поверхности, формирующей замкну-
тый контур (рис. 17.6). Команда вызывается из падающего меню 
Draw → Modeling → Surfaces → Patch или щелчком на пиктограмме 
Surface Patch в группе Create ленты Surface рабочего пространства 3D 
Modeling.

Рис. 17.6. Пример формирования замыкающей поверхности

Запросы команды sURFPAtCH:
Continuity = G0 - position, bulge magnitude = 0.5 – текущие значения 

непрерывности и величины прогиба
Select surface edges to patch or <Select Curves>: – выбрать одну или 

несколько кромок (или кривых) замыкаемой поверхности
Select surface edges to patch or <Select Curves>: – нажать Enter для 

завершения выбора
Press Enter to accept the patch surface or [CONtinuity/Bulge 

magnitude/CONStrain geometry]: – нажать Enter для завершения команды
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Ключи команды sURFPAtCH:
�� CONtinuity – указание плавности перехода одной поверхности в другую;
�� Bulge magnitude – указание скругления кромки переходной поверхности 

в месте ее соединения с исходной поверхностью (допустимые значения – 
от 0 до 1);

�� CONStrain geometry – использование дополнительных направляющих 
кривых для придания формы замыкающей поверхности.

Поверхность.смещения
Команда sURFOFFsEt  обеспечивает создание параллельной по-
верхности на заданном расстоянии от исходной поверхности 
(рис. 17.7). Команда вызывается из падающего меню Draw → 
Modeling → Surfaces → Offset или щелчком на пиктограмме Surface 
Offset в группе Create ленты Surface рабочего пространства 3D Modeling.

Рис. 17.7. Пример формирования поверхности смещения

Запросы команды sURFOFFsEt:

Connect adjacent edges = No – соединение смежных кромок
Select surfaces or regions to offset: – выбрать поверхности или об-

ласти для смещения
Select surfaces or regions to offset: – нажать Enter для завершения 

выбора
Specify offset distance or [Flip direction/Both sides/Solid/Con-

nect]: – указать расстояние для смещения

Поверхность смещения
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… object(s) to offset. – количество выбранных объектов для смещения
… offset operation(s) successful. – количество выполненных операций 

смещения

Ключи команды sURFOFFsEt:

�� Flip direction – изменить направление смещения;
�� Both sides – формирование двух поверхностей смещения в двух направ-

лениях;
�� Solid – формирование тела в результате операции смещения;
�� Connect – соединение нескольких смещенных поверхностей в случае со-

единения их исходных поверхностей.

Поверхность.сопряжения
Команда sURFFiLLEt обеспечивает создание поверхности сопряже-
ния между двумя другими поверхностями (рис. 17.8). Команда вы-
зывается из падающего меню Draw → Modeling → Surfaces → Fillet или 
щелчком на пиктограмме Surface Fillet в группе Edit ленты Surface ра-
бочего пространства 3D Modeling.

Рис. 17.8. Пример формирования поверхности сопряжения

Запросы команды sURFFiLLEt:

Radius = 1.0000, Trim Surface = yes – значение радиуса и установка об-
резки

Select first surface or region to fillet or [Radius/Trim surface]: – 
выбрать первую сопрягаемую поверхность либо область
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Select second surface or region to fillet or [Radius/Trim surface]: – 
выбрать вторую сопрягаемую поверхность либо область

Press Enter to accept the fillet surface or [Radius/Trim surfaces]: – 
нажать Enter для завершения команды

Ключи команды sURFFiLLEt:

�� Radius – изменение значения радиуса (системная переменная 
FILLETRAD3D);

�� Trim surfaces – обрезка исходных поверхностей или областей по кром-
кам поверхности сопряжения.

Поверхность.по.сечениям
Команда LOFt  обеспечивает создание поверхности в пространстве 
между несколькими поперечными сечениями (рис. 17.9). Команда 
вызывается из падающего меню Draw → Modeling → Loft или щелчком 
на пиктограмме Loft в группе Create ленты Surface рабочего простран-
ства 3D Modeling.

Рис. 17.9. Пример формирования поверхности по сечениям

Запросы команды LOFt:
Current wire frame density:  ISOLINES=4, Closed profiles creation mode 

= Surface – текущая плотность каркаса и режим создания замкнутых профилей
Select cross sections in lofting order or [POint/Join multiple 

edges/MOde]: _mo – выбор режима
Closed profiles creation mode [SOlid/SUrface]: _su – переход в режим 

формирования поверхностей
Select cross sections in lofting order or [POint/Join multiple 

edges/MOde]: – выбрать поперечные сечения в том порядке, в котором через них 
будет проходить поверхность

Поверхность по сечениям
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Select cross sections in lofting order or [POint/Join multiple 
edges/MOde]: – выбрать поперечные сечения в том порядке, в котором через них 
будет проходить поверхность

Select cross sections in lofting order or [POint/Join multiple 
edges/MOde]: – нажать Enter для завершения выбора

… cross sections selected – количество выбранных поперечных сечений
Enter an option [Guides/Path/Cross sections only/Settings] <Cross 

sections only>: – задать параметр

Ключи команды LOFt:

�� Point – выбор замкнутой кривой;
�� Join multiple edges – соединение нескольких соединенных криволи-

нейных сегментов и их использование в качестве единого поперечного се-
чения;

�� Mode – выбор режима: создание поверхности или тела;
�� Guides – задание направляющих кривых, которые управляют формой 

создаваемой поверхности;
�� Path – задание одиночной траектории создаваемой поверхности;
�� Cross sections only – создание поверхности по сечениям без использо-

вания направляющих или траекторий;
�� Settings – загрузка диалогового окна управления параметрами создавае-

мой поверхности Loft Settings (рис. 17.10):
•� Ruled – указывает, что тело или поверхность является кусочно-линейча-

тыми между соседними поперечными сечениями и имеют острые кром-
ки на поперечных сечениях (системная переменная LOFTNORMALS);

•� Smooth Fit – указывает, что между поперечными сечениями строится 
сглаженная поверхность, имеющая острые кромки на начальном и ко-
нечном поперечных сечениях (системная переменная LOFTNORMALS);

•� Start continuity: – задание касания и кривизны для первого поперечного 
сечения;

•� Start bulge magnitude: – задание размера прогиба кривой для первого по-
перечного сечения;

•� End continuity: – задание касания и кривизны для последнего поперечно-
го сечения;

•� End bulge magnitude: – задание размера прогиба кривой для последнего 
поперечного сечения;

•� Normal to: – управляет нормалью к поверхности в местах, где она про-
ходит через поперечные сечения (системная переменная LOFTNORMALS):
◊� Start cross section – к начальному поперечному сечению;
◊� End cross section – к конечному поперечному сечению;
◊� Start and end cross sections – к начальному и конечному поперечным 

сечениям;
◊� All cross sections – ко всем поперечным сечениям;
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•� Draft angles: – управление углом и величиной конусных ограничений 
первого и последнего поперечных сечений поверхности (системная пе-
ременная LOFTNORMALS);

Рис. 17.10. Диалоговое окно управления параметрами  
поверхности, создаваемой по сечениям

•� Start angle: – конусное ограничение для начального поперечного сечения 
(системная переменная LOFTANG1);

•� End angle: – конусное ограничение для конечного поперечного сечения 
(системная переменная LOFTANG2);

•� Start magnitude: – относительное расстояние поверхности от начального 
поперечного сечения в направлении конусного ограничения до начала 
изгиба поверхности к следующему поперечному сечению (системная 
переменная LOFTMAG1);

•� End magnitude: – относительное расстояние от поверхности до конечного 
поперечного сечения в направлении конусного ограничения до начала 
изгиба поверхности к предыдущему поперечному сечению (системная 
переменная LOFTMAG2);

•� Close surface or solid – замыкает или размыкает поверхность (системная 
переменная LOFTPARAM);

Поверхность по сечениям
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•� Periodic (smooth ends) – сглаживание замкнутой поверхности, у которой 
при изменении формы на швах нет точек излома.

Поверхность.выдавливания
Команда EXtRUDE обеспечивает создание поверхности в простран-
стве путем выдавливания разомкнутого или замкнутого объекта 
(рис. 17.11). Команда вызывается из падающего меню Draw → 
Modeling → Extrude или щелчком на пиктограмме Extrude в группе Create 
ленты Surface рабочего пространства 3D Modeling.

Рис. 17.11. Пример формирования поверхности выдавливания

Запросы команды EXtRUDE:
Current wire frame density:  ISOLINES=4, Closed profiles creation 

mode = Surface – текущие параметры плотности каркаса и режима создания 
замкнутых профилей

Select objects to extrude or [MOde]: _mo – выбор режима
Closed profiles creation mode [SOlid/SUrface] <Solid>: _su – переход 

в режим формирования поверхностей
Select objects to extrude or [MOde]: – выбрать объекты для выдавли-

вания
Select objects to extrude or [MOde]: – нажать Enter для завершения вы-

бора
Specify height of extrusion or [Direction/Path/Taper angle] <83.3615>: – 

указать высоту выдавливания

Ключи команды EXtRUDE:
�� Mode – выбор режима: создание поверхности или тела;
�� Direction – задание длины и направления выдавливания с помощью 

двух указанных точек;
�� Path – задание траектории выдавливания на основе выбранного объекта;
�� Taper angle – задание значения угла конуса для выдавливания.
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Поверхность.сдвига
Команда swEEP  обеспечивает создание поверхности путем сдвига 
двухмерного или трехмерного объекта либо подобъекта вдоль некото-
рой траектории (рис. 17.12). Команда вызывается из падающего меню 
Draw → Modeling → Sweep или щелчком на пиктограмме Sweep в группе 
Create ленты Surface рабочего пространства 3D Modeling.

Рис. 17.12. Пример формирования поверхности сдвига

Запросы команды swEEP:
Current wire frame density: ISOLINES=4, Closed profiles creation 

mode = Surface – текущие параметры плотности каркаса и режима создания 
замкнутых профилей

Select objects to sweep or [MOde]: _mo – выбор режима
Closed profiles creation mode [SOlid/SUrface] <Solid>: _su – переход 

в режим формирования поверхностей
Select objects to sweep or [MOde]: – выбрать объекты для сдвига
Select objects to sweep or [MOde]: – нажать Enter для завершения выбора
Select sweep path or [Alignment/Base point/Scale/Twist]: – выбрать 

траекторию сдвига 

Ключи команды swEEP:
�� Mode – выбор режима: создание поверхности или тела;
�� Alignment – выравнивание профиля по нормали касательной к траекто-

рии сдвига;
�� Base point – базовая точка для объектов, подлежащих сдвигу;
�� Scale – масштабный коэффициент для операции сдвига;
�� Twist – задание угла закручивания для объектов, подлежащих сдвигу.

Поверхность сдвига
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Поверхность.вращения
Команда REVOLVE обеспечивает создание поверхности путем враще-
ния объекта вокруг оси (рис. 17.13). Команда вызывается из падающе-
го меню Draw → Modeling → Revolve или щелчком на пиктограмме 
Revolve в группе Create ленты Surface рабочего пространства 3D Modeling.

Рис. 17.13. Пример формирования поверхности вращения

Запросы команды REVOLVE:
Current wire frame density:  ISOLINES=4, Closed profiles creation 

mode = Surface – текущие параметры плотности каркаса и режима создания 
замкнутых профилей

Select objects to revolve or [MOde]: _mo – выбор режима
Closed profiles creation mode [SOlid/SUrface] <Solid>: _su – переход 

в режим формирования поверхностей
Select objects to revolve or [MOde]: – выбрать объекты для вращения
Select objects to revolve or [MOde]: – нажать Enter для завершения выбора
Specify axis start point or define axis by [Object/X/Y/Z] <Object>: – 

указать начальную точку оси вращения
Specify axis endpoint: – указать конечную точку оси вращения
Specify angle of revolution or [STart angle/Reverse]: – указать угол 

вращения
Ключи команды REVOLVE:

�� Mode – выбор режима: создание поверхности или тела;
�� Object – использование в качестве оси существующего объекта;
�� X – использование оси X в качестве положительной оси вращения;
�� Y – использование оси Y в качестве положительной оси вращения;
�� Z – использование оси Z в качестве положительной оси вращения;
�� STart angle – величина смещения для поворота относительно плоскости 

вращаемого объекта;
�� Reverse – изменение направления вращения.
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Сеть представляет собой модель поверхности объекта, состоящую из плоских гра-
ней. Плотность сети, то есть количество ее граней, задается матрицей M×N подоб-
но сетке, состоящей из M рядов и N столбцов. Для сети значения M и N определя-
ют, соответственно, ряд и столбец каждой вершины. Сети можно создавать как на 
плоскости, так и в пространстве, однако на практике последнее встречается чаще.

Поскольку, в отличие от моделей тел, сеть не имеет свойств массы, веса, центра 
масс и пр., то моделирование объектов с помощью сетей применяют в случаях, 
когда можно игнорировать их физические свойства. Но при этом имеется возмож-
ность подавления скрытых линий, тонирования и визуализации (эти средства не-
применимы к каркасным моделям). Сети имеет смысл использовать также при 
создании нестандартных сетеобразных моделей, к примеру трехмерной топогра-
фической модели холмистой местности.

Модель сети состоит из вершин, ребер и граней, в которых для определения 
трехмерной формы используется многоугольное представление (включающее 
треугольники и четырехугольники).

Как и в случае с трехмерными телами, имеется возможность создавать прими-
тивные формы сети (ящики, конусы, пирамиды и др.). Затем модели сети можно 
изменять способами, которые не предназначены для трехмерных тел и поверх-
ностей. Например, можно применять сгибы, разделения и повышенные степени 
сглаживания. Чтобы изменить форму объекта, можно перетаскивать подобъекты 
сети (грани, ребра и вершины). 

Тесселяция сетей предоставляет расширенные возможности более детального 
моделирования форм объектов. Тесселяция – это набор плоских форм, образую-
щих объект-сеть. Тесселяционные секции, которые видны на невыбранных объ-
ектах-сетях, обозначают ребра доступных для редактирования граней сети. Для 
отображения секций в визуальных стилях 3D Hidden или Conceptual системной 
переменной VSEDGES должно быть присвоено значение 1.

Когда выполняются сглаживание и уточнение объектов-сетей, повышается 
плотность тесселяции, то есть увеличивается количество тесселяционных секций 
и поверхность сети приближается к округлой форме. 

При формировании сетей используется падающее меню Draw → Modeling → 
Meshes (рис. 18.1).

В рабочем пространстве 3D Modeling команды формирования сетей находятся 
на ленте Mesh (рис. 18.2).

Сеть-параллелепипед
Команда mEsH с ключом Box формирует сетьпараллелепипед 
(рис. 18.3). Команда вызывается из падающего меню Draw → 
Modeling → Meshes → Primitives  Box или щелчком на пиктограмме 
Mesh Box в группе Primitives ленты Mesh рабочего пространства 
3D Modeling.
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Рис. 18.1. Падающее меню для формирования сетей

Запросы команды mEsH с ключом Box:
Current smoothness level is set to : 0
Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/

SEttings]: _Box – перейти в режим формирования параллелепипеда
Specify first corner or [Center]: – задать точку первого угла основания 

параллелепипеда
Specify other corner or [Cube/Length]: – задать точку противоположного 

угла основания параллелепипеда
Specify height or [2Point] <default>: – указать высоту параллелепипеда

Ключи команды mEsH с ключом Box:

�� Center – позволяет сформировать параллелепипед, указав положение его 
центральной точки. При этом выдаются запросы:

Сеть-параллелепипед
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Specify first corner or [Center]: C – перейти в режим указания 
центра параллелепипеда
Specify center: – указать центр параллелепипеда
Specify corner or [Cube/Length]: – указать угол
Specify height or [2Point]: – указать высоту

�� Cube – создает параллелепипед, у которого все ребра равны. При этом вы-
даются запросы:
Specify first corner or [Center]: – указать угол параллелепипеда
Specify other corner or [Cube/Length]: C – переход в режим фор-
мирования куба
Specify length: – указать длину

�� Length – создает параллелепипед заданных длины (по оси X), ширины (по 
оси Y) и высоты (по оси Z) текущей ПСК. При этом выдаются запросы:
Specify first corner or [Center]: – указать угол параллелепипеда
Specify other corner or [Cube/Length]: L – перейти в режим указа-
ния длины, ширины и высоты
Specify length: – указать длину
Specify width: – указать ширину
Specify height or [2Point]: – указать высоту

Рис. 18.2. Инструменты формирования 
сетей в рабочем пространстве  

3D Modeling

Рис. 18.3. Формирование 
сети-параллелепипеда
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Сеть-конус
Команда mEsH с ключом Cone формирует сеть в форме заостренного 
или усеченного конуса с круговым или эллиптическим основанием 
(рис. 18.4). Команда вызывается из падающего меню Draw → 
Modeling → Meshes → Primitives → Cone или щелчком на пиктограмме 
Mesh Cone в группе Primitives ленты Mesh рабочего пространства 3D 
Modeling.

Запросы команды mEsH с ключом Cone:
Current smoothness level is set to : 0
Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/

SEttings]: _Cone – перейти в режим формирования конуса
Specify center point of base or [3P/2P/Ttr/Elliptical]: – указать 

центральную точку основания конуса
Specify base radius or [Diameter] <default>: – указать радиус основа-

ния конуса
Specify height or [2Point/Axis endpoint/Top radius] <default>: – 

указать высоту конуса

Ключи команды mEsH с ключом Cone:

�� 3Р – строит основание конуса в виде окружности по трем точкам, лежа-
щим на ней. При этом выдаются запросы:
Specify center point of base or [3P/2P/Ttr/Elliptical]: 3P – 
перейти в режим построения окружности по трем точкам
Specify first point: – указать первую точку окружности
Specify second point: – указать вторую точку окружности
Specify third point: – указать третью точку окружности
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� 2P – строит основание конуса в виде окружности по двум точкам, лежа-
щим на диаметре. При этом выдаются запросы:
Specify center point of base or [3P/2P/Ttr/Elliptical]: 2P – 
перейти в режим построения окружности по двум точкам
Specify first end point of diameter: – указать первую конечную 
точку диаметра
Specify second end point of diameter: – указать вторую конечную 
точку диаметра
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� Ttr – строит основание конуса в виде окружности по двум касательным и 
радиусу. При этом выдаются запросы:
Specify center point of base or [3P/2P/Ttr/Elliptical]: TTR – 
перейти в режим построения окружности по двум касательным и радиусу

Сеть-конус



Глава 18. Построение сетей472

Specify point on object for first tangent: – указать точку на 
объекте, задающую первую касательную
Specify point on object for second tangent: – указать точку на 
объекте, задающую вторую касательную
Specify radius of circle: – указать радиус окружности
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� Elliptical – позволяет создавать основание конуса в виде эллипса. За-
просы аналогичны тем, что используются в AutoCAD при создании эл-
липса:
Specify center point of base or [3P/2P/Ttr/Elliptical]: E – 
перейти в режим указания основания конуса в виде эллипса
Specify endpoint of first axis or [Center]: – указать конечную 
точку оси эллипса для основания конуса
Specify other endpoint of first axis: – указать вторую конечную 
точку оси эллипса для основания конуса
Specify endpoint of second axis: – указать длину другой оси для 
основания конуса
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� 2Point – указывает, что высотой конуса является расстояние между дву-
мя заданными точками;

�� Axis endpoint – задает положение конечной точки для оси конуса, кото-
рой является верхняя точка конуса или центральная точка верхней грани 
усеченного конуса. Конечная точка оси может быть расположена в любой 
точке трехмерного пространства. Она определяет длину и ориентацию ко-
нуса;

�� Top radius – определяет радиус при вершине усеченного конуса.

Рис. 18.4. Формирование сети-конуса
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Сеть-цилиндр
Команда mEsH с ключом Cylinder формирует сетьцилиндр с кру-
говым или эллиптическим основанием (рис. 18.5). Команда вызыва-
ется из падающего меню Draw → Modeling → Meshes → Primitives → 
Cylinder или щелчком на пиктограмме Mesh Cylinder в группе Primitives 
ленты Mesh рабочего пространства 3D Modeling.

Запросы команды mEsH с ключом Cylinder:
Current smoothness level is set to : 0
Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/

SEttings]: _ Cylinder – перейти в режим формирования цилиндра
Specify center point of base or [3P/2P/Ttr/Elliptical]: – указать 

центральную точку основания цилиндра
Specify base radius or [Diameter]: – указать радиус основания цилиндра
Specify height or [2Point/Axis endpoint]: – указать высоту цилиндра

Информация, необходимая для описания поверхности цилиндра, аналогична 
той, что используется для описания поверхности конуса, поэтому запросы команды 
mEsH с ключом Cylinder совпадают с запросами команды mEsH с ключом Cone.

Рис. 18.5. Формирование сети-цилиндра

Сеть-пирамида
Команда mEsH с ключом Pyramid формирует сетьпирамиду, со-
держащую до 32 граней (рис. 18.6). Команда вызывается из падающе-
го меню Draw → Modeling → Meshes → Primitives → Pyramid или щелчком 
на пиктограмме Mesh Pyramid в группе Primitives ленты Mesh рабочего 
пространства 3D Modeling.

Сеть-пирамида
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Рис. 18.6. Формирование сети-пирамиды

Запросы команды mEsH с ключом Pyramid:
Current smoothness level is set to : 0
Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/SEttings] 

<Cone>: _ Pyramid – перейти в режим формирования пирамиды
4 sides Circumscribed – текущие значения количества сторон и режима опи-

санный/вписанный
Specify center point of base or [Edge/Sides]: – указать центральную 

точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: – указать высоту 

или один из ключей

Ключи команды mEsH с ключом Pyramid:

�� Edge – указывается длина одной кромки основания пирамиды. При этом 
выдаются запросы:
Specify center point of base or [Edge/Sides]: E – перейти в режим 
указания кромки
Specify first endpoint of edge: – указать первую конечную точку 
стороны
Specify second endpoint of edge: – указать вторую конечную точку 
стороны
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту или один из ключей

�� Sides – указывается количество сторон для пирамиды. Возможен ввод 
значения от 3 до 32. При этом выдаются запросы:
Specify center point of base or [Edge/Sides]: S – перейти в режим 
указания количества сторон
Enter number of sides: – указать количество сторон
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Specify center point of base or [Edge/Sides]: – указать центральную 
точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту или один из ключей

�� Inscribed – указывается, что основание пирамиды вписывается в преде-
лах (строится внутри) радиуса основания пирамиды. При этом выдаются 
запросы:
Specify center point of base or [Edge/Sides]: – указать центральную 
точку основания или один из ключей
Specify base radius or [Inscribed]: I – перейти в режим построения 
основания, вписанного в окружность
Specify base radius or [Circumscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту или один из ключей

�� Circumscribed – указывается, что основание пирамиды описывается во-
круг (строится по периметру) радиуса основания пирамиды. При этом вы-
даются запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Circumscribed]: C – перейти в режим по-
строения основания, описанного вокруг окружности
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту или один из ключей

�� 2Point – указывается, что высота пирамиды равняется расстоянию между 
двумя указанными точками. При этом выдаются запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: 2P – перей-
ти в режим указания высоты пирамиды с помощью двух точек
Specify first point: – указать первую точку
Specify second point: – указать вторую точку

�� Axis endpoint – указывается местоположение конечной точки для оси 
пирамиды. Данная конечная является вершиной пирамиды. Возможно 
расположение конечной точки оси в любом месте 3D-пространства. Ко-
нечная точка оси определяет длину пирамиды и ее положение в простран-
стве. При этом выдаются запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания

Сеть-пирамида
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Specify height or [2Point/Axis endpoint/Top radius]: A – перейти 
в режим указания конечной точки оси пирамиды
Specify axis endpoint: – указать конечную точку оси

�� Top radius – указывается верхний радиус пирамиды при создании усе-
ченной пирамиды. При этом выдаются запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: T – перейти 
в режим указания верхнего радиуса пирамиды
Specify top radius: – указать радиус верхнего основания
Specify height or [2Point/Axis endpoint]: – указать высоту

Сеть-сфера
Команда mEsH с ключом Sphere формирует сетьсферу (рис. 18.7). 
Команда вызывается из падающего меню Draw → Modeling → Meshes → 
Primitives → Sphere или щелчком на пиктограмме Mesh Sphere в группе 
Primitives ленты Mesh рабочего пространства 3D Modeling.

Рис. 18.7. Формирование сети-сферы

Запросы команды mEsH с ключом Sphere:
Current smoothness level is set to : 0
Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/SEttings]: 

_ Sphere – перейти в режим формирования сферы
Specify center point or [3P/2P/Ttr]: – указать центр сферы
Specify radius or [Diameter] <default>: – указать радиус сферы

Ключи команды MESH с ключом Sphere:
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�� 3P – определяет окружность сферы путем задания трех произвольных 
точек в трехмерном пространстве. Три заданные точки также определяют 
плоскость окружности сферы. При этом выдаются запросы:
Specify center point or [3P/2P/Ttr]: 3P – переход в режим задания 
трех произвольных точек
Specify first point: – указать первую точку
Specify second point: – указать вторую точку
Specify third point: – указать третью точку

�� 2P – определяет окружность сферы путем задания двух произвольных то-
чек в трехмерном пространстве. Плоскость окружности сферы определя-
ется координатой Z первой точки. При этом выдаются запросы:
Specify center point or [3P/2P/Ttr]: 2P – перейти в режим задания 
двух произвольных точек
Specify first end point of diameter: – указать первую конечную 
точку диаметра
Specify second end point of diameter: – указать вторую конечную 
точку диаметра

�� Ttr – построение сферы по заданному радиусу, касательному к двум объ-
ектам. Указанные точки касания проецируются на текущую ПСК. При 
этом выдаются запросы:
Specify center point or [3P/2P/Ttr]: T – перейти в режим задания 
касательных и радиуса
Specify point on object for first tangent: – указать на объекте 
точку для первой касательной
Specify point on object for second tangent: – указать на объекте 
точку для второй касательной
Specify radius of circle: – указать 
радиус

Сеть-клин
Команда mEsH с ключом Wedge 
формирует сетьклин с прямоуголь-
ными или квадратными гранями 
(рис. 18.8). Команда вызывается из 
падающего меню Draw → Modeling → 
Meshes → Primitives → Wedge или 
щелчком на пиктограмме Mesh Wedge 
в группе Primitives ленты Mesh рабоче-
го пространства 3D Modeling.

Запросы команды mEsH с ключом Wedge:
Current smoothness level is set to : 0

Рис. 18.8. Формирование 
сети-клина

Сеть-клин
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Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/
SEttings]: _ Wedge – перейти в режим формирования клина

Specify first corner or [Center]: – указать первый угол клина
Specify other corner or [Cube/Length]: – указать противоположный угол 

клина
Specify height or [2Point]: – указать высоту

Все запросы и ключи команды mEsH с ключом Wedge аналогичны запросам и 
ключам команды mEsH с ключом Box.

Сеть-тор
Команда mEsH с ключом Torus формирует сетьтор (рис. 18.9). Ко-
манда вызывается из падающего меню Draw → Modeling → Meshes → 
Primitives → Torus или щелчком на пиктограмме Mesh Torus в группе 
Primitives ленты Mesh рабочего пространства 3D Modeling.

Рис. 18.9. Формирование сети-тора

Запросы команды mEsH с ключом Torus:
Current smoothness level is set to : 0
Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/

SEttings]: _ Torus – перейти в режим формирования тора
Specify center point or [3P/2P/Ttr]: – указать центр тора
Specify radius or [Diameter]: – указать радиус тора
Specify tube radius or [2Point/Diameter]: – указать радиус полости

Ключи команды mEsH с ключом Torus:

�� 3P – задание длины окружности тора по трем точкам. Три заданные точки 
также определяют плоскость окружности тора. При этом выдаются запросы:

Specify center point or [3P/2P/Ttr]: 3P – перейти в режим задания 
трех точек
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Specify first point: – указать первую точку
Specify second point: – указать вторую точку
Specify third point: – указать третью точку
Specify tube radius or [2Point/Diameter]: – указать радиус полости

�� 2P – задание длины окружности тора по двум точкам. Плоскость окруж-
ности тора определяется координатой Z первой точки. При этом выдаются 
запросы:
Specify center point or [3P/2P/Ttr]: 2P – перейти в режим задания 
двух точек
Specify first end point of diameter: – указать первую конечную 
точку диаметра
Specify second end point of diameter: – указать вторую конечную 
точку диаметра
Specify tube radius or [2Point/Diameter]: – указать радиус полости

�� Ttr – построение тора по заданному радиусу, касающемуся двух объектов. 
Указанные точки касания проецируются на текущую ПСК. При этом вы-
даются запросы:
Specify center point or [3P/2P/Ttr]: T – перейти в режим задания 
двух касательных и радиуса
Specify point on object for first tangent: – указать на объекте 
точку для первой касательной
Specify point on object for second tangent: – указать на объекте 
точку для второй касательной
Specify radius of circle: – указать радиус
Specify tube radius or [2Point/Diameter]: – указать радиус полости

Пространственные.грани
Команда 3DFACE обеспечивает создание пространственной грани, 
аналогичной двухмерной фигуре. Однако, в отличие от фигуры, угло-
вые точки грани могут иметь различные координаты по оси Z и обра-
зовывать тем самым участок плоскости в пространстве. Задавая раз-
личные координаты z угловых точек, можно формировать неплоские 
грани, хотя плоские используются чаще. Комбинирование трехмер-
ных граней позволяет моделировать сложные пространственные объ-
екты.

Команда 3DFACE вызывается из падающего меню Draw → Modeling → Meshes 
→ 3D Face.

Запросы команды 3DFACE:
Specify first point or [Invisible]: – указать первую точку
Specify second point or [Invisible]: – указать вторую точку
Specify third point or [Invisible] <exit>: – указать третью точку

Пространственные грани
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Specify fourth point or [Invisible] <create three-sided face>: – 
указать четвертую точку

Specify third point or [Invisible] <exit>: – указать третью точку

Для создания обычной трехмерной грани точки вводятся в естественном по-
рядке: по часовой стрелке или против нее. Чтобы сделать какой-нибудь край грани 
невидимым, необходимо первую его точку ввести с предшествующим признаком 
Invisible или просто I, независимо от способа ввода точки. 

Существует возможность создания трехмерной грани, у которой все края не-
видимы. Такую грань образно называют «призраком»: она не видна в каркасных 
моделях, но скрывает находящиеся за ней объекты в рисунках с удаленными скры-
тыми линиями и появляется в тонированных изображениях. Отображением не-
видимых краев трехмерных граней управляет системная переменная SPLFRAME. 
Если присвоить ей ненулевое значение, то все грани-«призраки» и невидимые 
края граней проявятся на экране, и их можно будет редактировать как полностью 
видимые. Трехмерные грани никогда не закрашиваются, а отображаются как про-
волочные каркасы; их нельзя выдавливать, и если все углы такой грани лежат в 
одной плоскости, грань становится непрозрачной для команды HIDE.

Пример..Формирование.пространственной.грани
Построить пространственные грани по заданным координатам (рис. 18.10).
Запустите команду 3DFACE, вызвав ее из падающего меню Draw → Modeling → 

Meshes → 3D Face. Ответьте на запросы:
_3DFACE
Specify first point or Invisible]: 0,20,25 – укажите точку 1
Specify second point or [Invisible]: 0,0,15 – укажите точку 2
Specify third point or [Invisible] <exit>: 25,0,10 – укажите точку 3
Specify fourth point or [Invisible] <create three-sided face>: 

25,20,12 – укажите точку 4
Specify third point or [Invisible] <exit>: 50,20,10 – укажите точку 5
Specify fourth point or [Invisible] <create three-sided face>: – на-

жмите клавишу Enter
Specify third point or [Invisible] <exit>: – 

для завершения работы команды нажмите клавишу 
Enter

Сеть.вращения
Команда REVsURF, формирующая сеть 
вращения путем поворота определяющей 
кривой вокруг выбранной оси (рис. 18.11), 
применяется для получения поверхно-

Рис. 18.10. 
Формирование 

пространственной грани
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стей, обладающих осевой симметрией. Команда вызывается из падающего 
меню Draw → Modeling → Meshes → Revolved Mesh или щелчком на пиктограмме 
Modeling, Meshes, Revolved Surface в группе Primitives ленты Mesh рабочего про-
странства 3D Modeling.

Запросы команды REVsURF:
Current wire frame density: SURFTAB1=6 SURFTAB2=6 – текущая плотность 

каркаса
Select object to revolve: – выбрать объект для вращения
Select object that defines the axis of revolution: – выбрать объект, 

определяющий ось вращения
Specify start angle <0>: – указать начальный угол
Specify included angle (+=ccw, -=cw) <360>: – указать центральный угол

Рис. 18.11. Пример сети вращения

В качестве определяющей кривой могут быть выбраны отрезок, окружность, 
дуга, эллипс, эллиптическая дуга, полилиния или трехмерная полилиния, сплайн, 
многоугольник. Определяющая кривая задает направление N сети поверхности. 
Осью вращения может быть отрезок, а также незамкнутая двухмерная или трехмер-
ная полилиния. Если выбрана полилиния, то ось вращения определяется векто-
ром, соединяющим первую вершину полилинии с последней; все промежуточные 
вершины игнорируются. Ось вращения задает направление М сети.

Начальный угол определяет отступ начала поверхности вращения от опреде-
ляющей кривой, а центральный задает угол поворота кривой вокруг оси враще-
ния. Если принимаются значения этих углов по умолчанию (0°�и центральный 

Сеть вращения
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угол 90°), для определения направления вращения применяется правило правой 
руки. Если вытянуть большой палец вдоль оси вращения в сторону конца оси и 
согнуть остальные пальцы, то они укажут направление вращения и направление 
отсчета начального угла.

Рис. 18.12. Определение направления вращения

Плотность создаваемой сети управляется системными переменными SURFTAB1 
и SURFTAB2. Поверхность вращения делится вдоль направления вращения на рав-
ные угловые интервалы, количество которых равно значению SURFTAB1. Если 
определяющая кривая – это отрезок, дуга, круг или сглаженная сплайном поли-
линия, то кривая делится на одинаковые интервалы, количество которых равно 
значению SURFTAB2. Если кривая представляет собой полилинию, не сглаженную 
сплайном, то у прямолинейных сегментов вершинами сети становятся концы, а 
каждый дуговой сегмент делится на интервалы, число которых равно значению 
SURFTAB2.

Пример..Формирование.
поверхности.вращения
Постройте поверхность вращения (рис. 18.13).
Запустите команду REVsURF, вызвав ее из падаю-

щего меню Draw → Modeling →  Meshes → Revolved Mesh 
или щелчком на пиктограмме Modeling, Meshes, Revolved 
Surface в группе Primitives ленты Mesh. Ответьте на за-
просы:

_REVSURF
Current wire frame density: SURFTAB1=6 

SURFTAB2=6 – текущая плотность каркаса
Select object to revolve: – укажите кривую 1
Select object that defines the axis of 

revolution: – укажите ось 2
Specify start angle <0>: 0 – начальный угол
Specify included angle(+=ccw,-=cw)<360>: 

200 – охватывающий угол поверхности

Рис. 18.13. 
Формирование сети 

вращения
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Сеть,.заданная.кромками
Команда EDGEsURF формирует сеть, аппроксимирующую замыкаю-
щий фрагмент поверхности Кунса по четырем смыкающимся кром-
кам. Участок поверхности Кунса – это бикубическая (то есть обладаю-
щая кубической кривизной как в направлении M, так и в направлении 
N) поверхность, «натянутая» на четыре пространственные кривые 
(рис. 18.14). Команда вызывается из падающего меню Draw → 
Modeling → Meshes → Edge Mesh или щелчком на пиктограмме Modeling, 
Meshes, Edge Surface в группе Primitives ленты Mesh рабочего простран-
ства 3D Modeling.

Рис. 18.14. Пример сети, заданной кромками

Запросы команды EDGEsURF:
Current wire frame density: SURFTAB1=20 SURFTAB2=20 – текущая плот-

ность каркаса
Select object 1 for surface edge: – выбрать первую кромку поверхности
Select object 2 for surface edge: – выбрать вторую кромку поверхности
Select object 3 for surface edge: – выбрать третью кромку поверхности
Select object 4 for surface edge: – выбрать четвертую кромку поверх-

ности

Края могут представлять собой отрезки, дуги, эллиптические дуги, сплайны 
или незамкнутые полилинии (двухмерные или трехмерные); при этом они должны 
попарно смыкаться в конечных точках, образуя топологически замкнутый криво-
линейный четырехугольник.

Порядок выбора краев не имеет значения. Первый выбранный край задает на-
правление М сети поверхности: от конечной точки, ближайшей к точке указания, 
до другой конечной точки (см. рис. 15.25). Два других края, касающиеся первого, 
определяют направление N сети. Системная переменная SURFTAB1 задает коли-
чество интервалов вдоль направления M (первый выбранный край), а системная 
переменная SURFTAB2 – количество интервалов вдоль направления N. В результа-
те создается сеть размером (SURFTAB1+1)×(SURFTAB2+1).

Сеть, заданная кромками
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Пример..Формирование.поверхности.Кунса
Постройте сеть – поверхность Кунса 

для четырех граничных B-сплайн кривых 
(рис. 18.15).

Запустите команду EDGEsURF, вызвав 
ее из падающего меню Draw → Modeling → 
Meshes → Edge Mesh или щелчком на пикто-
грамме Modeling, Meshes, Edge Surface в группе 
Primitives ленты Mesh. Ответьте на запросы:

_EDGESURF
Current wire frame density: SURFTAB1=20 SURFTAB2=20
Select object 1 for surface edge: – укажите кромку 1
Select object 2 for surface edge: – укажите кромку 2
Select object 3 for surface edge: – укажите кромку 3
Select object 4 for surface edge: – укажите кромку 4

Сеть.соединения
Команда RULEsURF формирует многоугольную сеть, натянутую на 
две заданные линии (рис. 18.16). Исходные объекты (кромки) сети 
соединения могут представлять собой отрезки, точки, дуги, круги, эл-
липсы, эллиптические дуги, двухмерные и трехмерные полилинии, а 
также сплайны. Команда вызывается из падающего меню Draw → Mod-
eling → Meshes → Ruled Mesh или щелчком на пиктограмме Modeling, 
Meshes, Ruled Surface в группе Primitives ленты Mesh рабочего простран-
ства 3D Modeling.

Рис. 18.16. Примеры сетей соединения: а) между двумя разомкнутыми линиями; 
б) между двумя замкнутыми линиями; в) между точкой и разомкнутой линией; 

 г) между точкой и замкнутой линией

Рис. 18.15. Формирование 
поверхности Кунса
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Запросы команды RULEsURF:
Current wire frame density: SURFTAB1=6 – текущая плотность каркаса
Select first defining curve: – выбрать первую определяющую кривую
Select second defining curve: – выбрать вторую определяющую кривую

Допустим, требуется указать два примитива, 
определяющих края сети соединения. Если одна 
граница замкнута (например, в случае с кругом 
или замкнутой полилинией), то и другая также 
должна быть замкнута (см. рис. 18.16, б). Одной 
из границ может быть точка, а другой – разомкну-
тая или замкнутая кривая линия (рис. 18.16, в, г). 
В случае с разомкнутыми кривыми выбор точек 
указания определяет, откуда будет начато по-
строение сети (рис. 18.16, а). AutoCAD начинает 
с конечной точки каждой линии, ближайшей к 
точке, с помощью которой линия была указана. 
На рис. 18.17, а Т1 – это точка, с помощью ко-
торой была указана первая граница, в то время 
как Т2 – точка указания второй границы. Если на 
определяющих линиях указаны разнесенные точки (рис. 18.17, б), то сеть соедине-
ния может перехлестнуться. Для замкнутых кривых точки указания не играют роли.

Сеть соединения строится как многоугольная размером 2×N. Команда 
RULEsURF размещает половину вершин сети с равными интервалами вдоль од-
ной определяющей линии, а половину – также с равными интервалами вдоль дру-
гой линии. Плотностью сети (то есть количеством граней) в направлениях М и N 
управляют системные переменные SURFTAB1 и SURFTAB2 соответственно.

Пример..Формирование.линейчатой..
сети.соединения
Постройте линейчатую сеть по двум направляющим 

(рис. 18.18).
Запустите команду RULEsURF, вызвав ее из падающе-

го меню Draw → Modeling → Meshes → Ruled Mesh или щелч-
ком на пиктограмме Modeling, Meshes, Ruled Surface в группе 
Primitives ленты Mesh. Ответьте на запросы:

_RULESURF
Current wire frame density: SURFTAB1=6 – текущая 

плотность каркаса
Select first defining curve: – выберите левую кривую
Select second defining curve: – выберите правую 

кривую

Рис. 18.17. Сети соединения 
между двумя разомкнутыми 

линиями: a) начальные точки 
заданы правильно; б) начальные 

точки заданы неправильно

Рис. 18.18. 
Формирование 
линейчатой сети 

соединения

Сеть соединения
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Сеть.сдвига
Команда tABsURF формирует многоугольную сеть, которая представ-
ляет собой поверхность сдвига, заданную определяющей кривой и на-
правляющим вектором (рис. 18.19). Созданная сеть – это, по сути, на-
бор многоугольников с параллельными направляющему вектору сто-
ронами. И определяющая кривая, и направляющий вектор должны 
существовать на рисунке к моменту выполнения команды. Она вызы-
вается из падающего меню Draw → Modeling → Meshes → Tabulated Mesh 
или щелчком на пиктограмме Modeling, Meshes, Tabulated Surface в группе 
Primitives ленты Mesh рабочего пространства 3D Modeling.

Рис. 18.19. Сеть сдвига: а) определяющая кривая разомкнута;  
б) определяющая кривая замкнута

Запросы команды tABsURF:
Select object for path curve: – текущая определяющая кривая
Select object for direction vector: – текущий направляющий вектор

Определяющая кривая может представлять собой отрезок, дугу, круг, эллипс, 
эллиптическую дугу, двухмерную или трехмерную полилинию, а также сплайн. На-
правляющий вектор может быть отрезком либо разомкнутой двухмерной или трех-
мерной полилинией. Если выбрана полилиния, имеют значение только ее первая и 
последняя вершины, а все промежуточные игнорируются. Направляющий вектор 
показывает сдвиг от конечной точки, ближайшей к точке указания (на рис. 18.19 
это T1), до другой его конечной точки.

С помощью команды tABsURF строится многоугольная сеть 2×N. Половина 
вершин размещается вдоль определяющей кривой, начиная с ближайшего к точке 
указания конца. Другая половина расположена вдоль кривой, параллельной пер-
вой и сдвинутой от нее на вектор направления. Направление N сети лежит вдоль 
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определяющей кривой. Расстояние между двумя кривыми равно расстоянию меж-
ду двумя конечными точками примитива, выбранного как вектор направления. 
Вдоль вектора направления лежит направление M сети. Плотностью сетью сдвига 
в направлении N управляет системная переменная SURFTAB1. Если определяющая 
кривая – это отрезок, дуга, круг или сглаженная сплайном полилиния, то кривая 
делится на одинаковые интервалы, число которых равно значению системной пе-
ременной SURFTAB1. Если кривая представляет собой полилинию, не сглаженную 
сплайном, то у прямолинейных сегментов вершинами сети становятся концы, а 
каждый дуговой сегмент делится на интервалы, число которых равно значению 
системной переменной SURFTAB1.

Пример..Формирование.линейчатой.сети.сдвига
Постройте линейчатую сеть, заданную опре-

деляющей кривой и направляющим вектором 
(рис. 18.20).

Запустите команду tABsURF, вызвав ее из 
падаю щего меню Draw → Modeling → Meshes → 
Tabulated Mesh или щелчком на пиктограмме Modeling, 
Meshes, Tabulated Surface в группе Primitives ленты 
Mesh. Ответьте на запросы:

_TABSURF
Select object for path curve: – выберите 

кривую 1
Select object for direction vector: – вы-

берите вектор 2

Сеть,.созданная.путем.
преобразования

Команда mEsHsmOOtH создает сеть путем преобразования трех-
мерных тел, поверхностей и объектов-сетей предыдущих версий в 
объект-сеть улучшенного типа, для использования операций сгла-
живания, уточнения, разделения и сгиба. Команда вызывается из 
падающего меню Draw → Modeling → Meshes → Smooth Mesh или 
щелчком на пиктограмме Smooth Object в группе Mesh ленты Mesh 
рабочего пространства 3D Modeling.

Запросы команды mEsHsmOOtH:
Select objects to convert: – выбрать объекты для преобразования
Select objects to convert: – выбрать объекты для преобразования
Select objects to convert: – нажать Enter для завершения команды

Рис. 18.20. Формирование 
линейчатой сети сдвига

Сеть, созданная путем преобразования
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Настройка.параметров.тесселяции.
сети

Команда mEsHOPtiONs загружает диалоговое окно настройки пара-
метров тесселяции сети Mesh Tessellation Options (рис. 18.21) и вызывает-
ся в рабочем пространстве 3D Modeling стрелочкой вправо в группе Mesh 
на лентах Home или Mesh.

Рис. 18.21. Диалоговое окно настройки параметров тесселяции сети

В диалоговом окне Mesh Tessellation Options настраиваются параметры, которые 
определяют внешний вид объектов, преобразуемых в трехмерные объекты-сети:

�� Кнопка Select objects to tessellate – предназначена для выбора объектов, 
преобразующихся в объект-сеть. Допускается выбирать трехмерные тела, 
поверхности, грани, полигональные или многогранные сети, области и 
замкнутые полилинии.
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�� Область Mesh Type and Tolerance – определение типа сети и допусков:
•� Mesh type: – тип сети для использования в преобразовании (системная 

переменная FACETERMESHTYPE):
◊� Smooth Mesh Optimized – оптимизированная гладкая сеть, при которой 

форма граней сети адаптируется к форме объекта-сети;
◊� Mostly Quads – грани сети в основном представляют собой четырех-

угольники;
◊� Triangle – грани сети в основном представляют собой треугольники;

•� Mesh distance from original faces: – максимальное отклонение граней сети 
от поверхности или формы исходного объекта (системная переменная 
FACETERDEVSURFACE);

•� Maximum angle between new faces: – максимальный угол между норма-
лями к поверхностям двух смежных граней (системная переменная 
FACETERDEVNORMAL);

•� Maximum aspect ratio for new faces: – максимальная пропорция (отно-
шение высоты к ширине) новых граней сети (системная переменная 
FACETERGRIDRATIO);

•� Maximum edge length for new faces: – максимальная длина любого ребра, 
создаваемого при преобразовании в объект-сеть (системная переменная 
FACETERMAXEDGELENGTH).

�� Область Meshing Primitive Solids позволяет настроить параметры, используе-
мые при преобразовании трехмерных твердотельных объектов-примити-
вов в объекты-сети:
•� Use optimized representation for 3D primitive solids – позволяет указать парамет-

ры, используемые при преобразовании твердотельных объектов-прими-
тивов в объекты-сети (системная переменная FACETERPRIMITIVEMODE);

•� кнопка Mesh Primitives… – загрузка диалогового окна настройки парамет-
ров сетевых примитивов Mesh Primitive Options (рис. 18.22):
◊� Mesh Primitive – позволяет указать, параметры какого сетевого прими-

тива требуется изменить;
◊� Tessellation Divisions – количество участков (делений) на каждой сто-

роне для каждого выбранного типа сетевого примитива;
◊� Preview’s smoothness level: – изменение изображения при просмотре 

таким образом, что в нем отобразится указанная пользователем сте-
пень сглаживания;

◊� Auto-update – автоматическое обновление изображения в окне про-
смотра при изменении значений параметров;

◊� кнопка Update – обновление изображения в окне просмотра в соот-
ветствии с внесенными изменениями.

�� Область Smooth Mesh After Tessellation – позволяет указать, какую сте-
пень сглаживания следует применять к объектам после преобразова-
ния в сеть:

Настройка параметров тесселяции сети
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•� Apply smoothness after tessellation – сглаживание новых объектов-сетей 
после преобразования;

•� Smoothness lever: – степень сглаживания для новых объектов-сетей (си-
стемная переменная FACETERSMOOTHLEV).

Рис. 18.22. Диалоговое окно настройки параметров сетевых примитивов
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Твердотельный объект, или тело, представляет собой изображение объекта, храня-
щее, помимо всего прочего, информацию о его объемных свойствах: массе, объеме, 
центре тяжести и моменте инерции. Следовательно, тела наиболее полно из всех 
типов трехмерных моделей отражают моделируемые объекты. 

Средства AutoCAD позволяют создавать трехмерные объекты на основе базо-
вых пространственных форм (твердотельных примитивов): параллелепипедов, 
конусов, цилиндров, сфер, клинов и торов (колец). Из этих форм путем их объ-
единения, вычитания и пересечения строятся более сложные пространственные 
тела. Кроме того, тела можно строить, сдвигая плоский объект вдоль заданного 
вектора или вращая его вокруг оси.

Модификация тел осуществляется путем сопряжения их граней и снятия фа-
сок. В AutoCAD имеются также команды, с помощью которых тело можно разре-
зать на две части или получить его двухмерное сечение.

Тела могут быть преобразованы в более простые типы моделей – сети и кар-
касные модели.

Плотность линий искривления, используемых для визуализации криволиней-
ных элементов модели, определяется системной переменной ISOLINES. Систем-
ная переменная FACETRES задает степень сглаживания тонированных объектов с 
подавленными скрытыми линиями.

Ниже приведены некоторые понятия и определения, принятые в трехмерном 
твердотельном моделировании:

�� грань – ограниченная часть поверхности. Поддерживаются пять типов 
граней: планарные, цилиндрические, конические, сферические и торои-
дальные;

�� ребро – элемент, ограничивающий грань. Поддерживаются четыре типа 
ребер: прямолинейные, эллиптические (круговые), параболические и ги-
перболические. Например, грань куба ограничена четырьмя прямолиней-
ными ребрами, а коническая грань ограничена в основании одним эллип-
тическим или круговым ребром;

�� полупространство – часть трехмерного пространства, лежащая по одну 
сторону от поверхности. Другими словами, каждая поверхность являет-
ся границей двух полупространств, на которые делится трехмерное про-
странство. Полупространство – часть трехмерного пространства, имею-
щая объем, а поверхность – часть трехмерного пространства, у которой 
есть площадь, но нет объема;

�� тело – часть пространства, ограниченная замкнутой поверхностью и имею-
щая определенный объем;

�� тело (примитив) – наипростейший (основной, базовый) твердотельный 
объект, который можно создать и строить из него более сложные твердо-
тельные модели;

�� область – часть плоскости, ограниченная одной или несколькими пла-
нарными гранями, которые называются границами. Например, квадрат с 
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кругом внутри имеет внешнюю границу, состоящую из четырех прямоли-
нейных ребер, и внутреннюю – из одного кругового ребра;

�� область (примитив) – замкнутая двухмерная область, которая получена 
путем преобразования существующих двухмерных примитивов AutoCAD, 
имеющих нулевую высоту (кругов, фигур, двухмерных полилиний, много-
угольников, эллипсов, колец и полос), и описана как тело без высоты;

�� составная область – единая область, получаемая в результате выполне-
ния логических операций объединения, вычитания или пересечения не-
скольких областей. Она может иметь отверстия, и для нее так же, как и для 
твердых тел, можно вычислить площадь и другие характеристики. Интег-
рация двухмерного и объемного конструирования позволяет создавать из 
областей твердые тела, и наоборот. Например, автоматически преобразуя 
сечение тела в область, можно вычислить ее площадь, а выдавливая или 
вращая области – создать сложные тела;

�� объект – общее наименование области или тел, причем тип объекта не 
имеет значения: это может быть область, тело или составная модель (груп-
па объектов, связанных в единое целое);

�� пустой объект – составное тело, не имеющее объема, или составная об-
ласть, не имеющая площади.

�� Команды формирования твердотельных моделей запускаются из падаю-
щего меню Draw → Modeling (рис. 19.1).

Рис. 19.1. Инструменты для формирования тел

Построение тел
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Для трехмерного моделирования удобно использовать рабочее пространство 
3D Modeling или упрощенное 3D Basics. Оно устанавливается командой WSCURRENT 
и включает только необходимые наборы меню, инструментальные панели и 
палит ры, сгруппированные и упорядоченные соответственно решаемой задаче. 
Элементы интерфейса, не являющиеся необходимыми для решения текущей зада-
чи, скрываются, максимально освобождая область экрана, доступную для работы.

Команда wsCURRENt вызывается из падающего меню Tools → 
Workspaces или щелчком на стрелочке инструмента Workspaces 
Switching в строке состояния (рис. 19.2, 19.3, 19.4).

Рис. 19.2. Панель рабочих пространств

Рис. 19.3. Рабочее пространство 3D Modeling
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Рис. 19.4. Инструменты рабочего пространства 3D Basics

Твердотельный.параллелепипед
Команда BOX формирует твердотельный 
параллелепипед (ящик, куб). Основание 
параллелепипеда всегда параллельно 
плоскости XY текущей ПСК. Команда вы-
зывается из падающего меню Draw → 
Modeling → Box, либо щелчком на пикто-
грамме Box в группе Modeling ленты Home 
или в группе Primitive ленты Solid рабочего 
пространства 3D Modeling (рис. 19.5).

Запросы команды BOX:
Specify first corner or [Center]: – указать 

первый угол параллелепипеда
Specify other corner or [Cube/Length]: – ука-

зать противоположный угол параллелепипеда
Specify height or [2Point]: – указать высоту 

параллелепипеда

При формировании параллелепипеда следует за-
дать параметры в одном из нижеперечисленных вари-
антов:

�� положение диагонально противоположных углов;
�� положение противоположных углов основания и высота;
�� положение центра ящика с назначением угла или высоты либо длины и 

ширины ящика.

Ключи команды BOX:

�� Center – позволяет сформировать ящик, указав положение его централь-
ной точки. При этом выдаются запросы:
Specify first corner or [Center]: C – перейти в режим указания 
центра параллелепипеда
Specify center: – указать центр параллелепипеда
Specify corner or [Cube/Length]: – указать угол
Specify height or [2Point]: – указать высоту

�� Cube – создает куб, то есть параллелепипед, у которого все ребра равны. 
При этом выдаются запросы:

Рис. 19.5. Инструмент 
команды BOX

Твердотельный параллелепипед
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Specify first corner or [Center]: – указать угол параллелепипеда
Specify other corner or [Cube/Length]: C – переход в режим фор-
мирования куба
Specify length: – указать длину

�� Length – создает параллелепипед заданных длины (по оси X), ширины 
(по оси Y) и высоты (по оси Z) текущей ПСК. При этом выдаются запросы:
Specify first corner or [Center]: – указать угол параллелепипеда
Specify other corner or [Cube/Length]: L – перейти в режим указа-
ния длины, ширины и высоты
Specify length: – указать длину
Specify width: – указать ширину
Specify height or [2Point]: – указать высоту

Пример..Формирование.твердотельного.
параллелепипеда
Постройте твердотельный параллелепипед (рис. 19.6).

Рис. 19.6. Формирование твердотельного параллелепипеда

Запустите команду BOX, вызвав ее из падающего меню Draw → Modeling → 
Box или щелчком на пиктограмме Box в группе Modeling ленты Home. Ответьте на 
запросы:

_BOX
Specify first corner or [Center]: 50,70 – координаты угла параллелепипеда
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Specify other corner or [Cube/Length]: 150,200 – координаты другого 
угла параллелепипеда

Specify height or [2Point]: 80 – высота параллелепипеда

Выполните упражнение Box1 из раздела 5.

Твердотельный.клин
Команда wEDGE, формирующая твердо-
тельный клин, вызывается из падающего 
меню Draw → Modeling → Wedge, или щелч-
ком на пиктограмме Wedge в группе 
Modeling ленты Home рабочего простран-
ства 3D Modeling (рис. 19.7).

Запросы команды wEDGE:
Specify first corner or [Center]: – указать 

первый угол клина
Specify other corner or [Cube/Length]: – 

указать противоположный угол клина
Specify height or [2Point]: – указать высоту

Основание клина всегда параллельно плоскости 
построений XY текущей системы координат; при этом 
наклонная грань располагается напротив первого ука-
занного угла основания. Высота клина может быть как 
положительной, так и отрицательной и обязательно 
параллельна оси Z.

Все запросы и ключи команды wEDGE аналогичны запросам и ключам коман-
ды BOX.

Пример..Формирование.твердотельного.клина
Постройте твердотельный клин (рис. 19.8).
Запустите команду wEDGE, вызвав ее из падающего меню Draw → Modeling → 

Wedge или щелчком на пиктограмме Wedge в группе Modeling ленты Home. Ответьте 
на запросы:

_WEDGE
Specify first corner or [Center]: 40,50 – координаты угла клина
Specify other corner or [Cube/Length]: 150,180 – координаты 

противоположного угла клина
Specify height or [2Point]: 100 – высота клина

Рис. 19.7. Инструмент 
команды WEDGE

Твердотельный клин
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Рис. 19.8. Формирование твердотельного клина

Выполните упражнение Wed1 из раздела 5.

Твердотельный.конус
Команда CONE формирует твердотельный 
конус, основание которого (окружность 
или эллипс) лежит в плоскости ХY теку-
щей системы координат, а вершина распо-
лагается по оси Z. Команда вызывается из 
падающего меню Draw → Modeling → Cone, 
или щелчком на пиктограмме Cone в группе 
Modeling ленты Home рабочего пространства 
3D Modeling (рис. 19.9).

Запросы команды CONE:
Specify center point of base or [3P/2P/Ttr/

Elliptical]: – указать центральную точку основания 
конуса

Specify base radius or [Diameter]: – указать 
радиус основания конуса

Рис. 19.9. Инструмент 
команды CONE
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Specify height or [2Point/Axis endpoint/Top radius]: – указать высоту 
конуса

Ключи команды CONE:

�� 3Р – строит основание конуса в виде окружности по трем точкам, ле-
жащим на ней. При использовании этого ключа команда CONE выдает 
следую щие запросы:
Specify center point of base or [3P/2P/Ttr/Elliptical]: 3P – 
перейти в режим построения окружности по трем точкам
Specify first point: – указать первую точку окружности
Specify second point: – указать вторую точку окружности
Specify third point: – указать третью точку окружности
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� 2P – строит основание конуса в виде окружности по двум точкам, лежа-
щим на диаметре. При использовании этого ключа команда CONE выдает 
следующие запросы:
Specify center point of base or [3P/2P/Ttr/Elliptical]: 2P – 
перейти в режим построения окружности по двум точкам
Specify first end point of diameter: – указать первую конечную 
точку диаметра
Specify second end point of diameter: – указать вторую конечную 
точку диаметра
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� Ttr – строит основание конуса в виде окружности по двум касательным 
и радиусу. При использовании этого ключа команда CONE выдает следу-
ющие запросы:
Specify center point of base or [3P/2P/Ttr/Elliptical]: TTR – 
перейти в режим построения окружности по двум касательным и радиусу
Specify point on object for first tangent: – указать точку на объ-
екте, задающую первую касательную
Specify point on object for second tangent: – указать точку на 
объекте, задающую вторую касательную
Specify radius of circle: – указать радиус окружности
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� Elliptical – позволяет создавать основание конуса в виде эллипса. За-
просы аналогичны тем, что используются в AutoCAD при создании эл-
липса:
Specify center point of base or [3P/2P/Ttr/Elliptical]: E – 
перейти в режим указания основания конуса в виде эллипса
Specify endpoint of first axis or [Center]: – указать конечную 
точку оси эллипса для основания конуса

Твердотельный конус
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Specify other endpoint of first axis: – указать вторую конечную 
точку оси эллипса для основания конуса
Specify endpoint of second axis: – указать длину другой оси для 
основания конуса
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту конуса

�� 2Point – указывает, что высотой конуса является расстояние между дву-
мя заданными точками;

�� Axis endpoint – задает положение конечной точки для оси конуса, кото-
рой является верхняя точка конуса или центральная точка верхней грани 
усеченного конуса. Конечная точка оси может быть расположена в любой 
точке трехмерного пространства. Она определяет длину и ориентацию ко-
нуса;

�� Top radius – определяет радиус при вершине усеченного конуса.

Чтобы построить усеченный конус или конус, ориентированный под некото-
рым углом, можно вначале нарисовать двухмерную окружность, а затем с помощью 
команды EXtRUDE произвести коническое выдавливание под углом к оси Z. Если 
необходимо усечь конус, можно, используя команду sUBtRACt, вычесть из него 
параллелепипед, внутри которого находится вершина конуса.

Пример..Формирование.кругового.твердотельного.
конуса
Постройте твердотельный конус, в основании которого лежит окружность 

(рис. 19.10).

Рис. 19.10. Формирование твердотельного кругового конуса
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Запустите команду CONE, вызвав ее из падающего меню Draw → Modeling → 
Cone или щелчком на пиктограмме Cone в группе Modeling ленты Home. Ответьте 
на запросы:

_CONE
Specify center point of base or [3P/2P/Ttr/Elliptical]: 100,100 – 

центральная точка конуса
Specify base radius or [Diameter]: 80 – радиус основания конуса
Specify height or [2Point/Axis endpoint/Top radius]: 100 – высота 

конуса

Выполните упражнение Con1 из раздела 5.

Пример..Формирование.твердотельного.
эллиптического.конуса
Постройте твердотельный конус с основанием в виде эллипса (рис. 19.11).

Рис. 19.11. Формирование твердотельного эллиптического конуса

Запустите команду CONE, вызвав ее из падающего меню Draw → Modeling → 
Cone или щелчком на пиктограмме Cone в группе Modeling ленты Home. Ответьте 
на запросы:

Твердотельный конус



Глава 19. Построение тел502

_CONE
Specify center point of base or [3P/2P/Ttr/Elliptical]: E – перей-

дите в режим указания основания конуса в виде эллипса
Specify endpoint of first axis or [Center]: 10,70 – координаты первой 

точки
Specify other endpoint of first axis: 190,140 – координаты второй 

точки
Specify endpoint of second axis: 20 – половина длины второй оси эл-

липса
Specify height or [2Point/Axis endpoint/Top radius]: 70 – высота 

конуса

Выполните упражнение Con2 из раздела 5.

Твердотельный.шар
Команда sPHERE формирует твердо-
тельный шар. Для этого достаточно за-
дать его радиус или диаметр. Каркасное 
представление шара располагается та-
ким образом, что его центральная ось со-
впадает с осью Z текущей системы коор-
динат. Команда вызывается из падаю-
щего меню Draw → Modeling → Sphere, или 
щелчком на пиктограмме Sphere в группе 
Modeling ленты Home рабочего простран-
ства 3D Modeling (рис. 19.12).

Запросы команды sPHERE:

Specify center point or [3P/2P/Ttr]: – ука-
зать центр шара

Specify radius or [Diameter]: – указать ра-
диус шара

Ключи команды sPHERE:

�� 3P – определяет окружность сферы путем задания трех произвольных 
точек в трехмерном пространстве. Три заданные точки также определяют 
плоскость окружности шара. При этом команда sPHERE выдает следую-
щие запросы:
Specify center point or [3P/2P/Ttr]: 3P – перейти в режим задания 
трех произвольных точек

Рис. 19.12. Инструмент 
команды SPHERE
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Specify first point: – указать первую точку
Specify second point: – указать вторую точку
Specify third point: – указать третью точку

�� 2P – определяет окружность сферы путем задания двух произвольных 
точек в трехмерном пространстве. Плоскость окружности шара опреде-
ляется координатой Z первой точки. При этом команда sPHERE выдает 
следую щие запросы:
Specify center point or [3P/2P/Ttr]: 2P – перейти в режим задания 
двух произвольных точек
Specify first end point of diameter: – указать первую конечную 
точку диаметра
Specify second end point of diameter: – указать вторую конечную 
точку диаметра

�� Ttr – построение шара по заданному радиусу, касательному к двум объек-
там. Указанные точки касания проецируются на текущую ПСК. При этом 
команда sPHERE выдает следующие запросы:
Specify center point or [3P/2P/Ttr]: T – перейти в режим задания 
касательных и радиуса
Specify point on object for first tangent: – указать на объекте 
точку для первой касательной
Specify point on object for second tangent: – указать на объекте 
точку для второй касательной
Specify radius of circle: – указать радиус

Чтобы построить часть шара в виде купола или чаши, нужно, используя ко-
манду sUBtRACt, вычесть из него параллелепипед. Если необходимо построить 
шаро образное тело специальной формы, следует вначале создать его двухмерное 
сечение, а затем, применив команду REVOLVE, вращать сечение под заданным 
углом к оси Z.

Пример..Формирование.твердотельного.шара
Постройте твердотельный шар (рис. 19.13).
Запустите команду sPHERE, вызвав ее из падающего меню Draw → Modeling → 

Sphere или щелчком на пиктограмме Sphere в группе Modeling ленты Home. Ответьте 
на запросы:

_SPHERE
Specify center point or [3P/2P/Ttr]: 100,150 – координаты точки 

центра шара
Specify radius or [Diameter]: 80 – радиус шара

Выполните упражнение Sph1 из раздела 5.

Твердотельный шар
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Рис. 19.13. Формирование твердотельного шара

Твердотельный.цилиндр
Команда CYLiNDER, формирующая 
твердотельный цилиндр, вызывается из 
падающего меню Draw → Modeling → 
Cylinder, или щелчком на пиктограмме 
Cylinder в группе Modeling ленты Home 
рабочего пространства 3D Modeling 
(рис. 19.14).

Запросы команды CYLiNDER:
Specify center point of base or [3P/2P/

Ttr/Elliptical]: – указать центральную точку ос-
нования цилиндра

Specify base radius or [Diameter]: – ука-
зать радиус основания цилиндра

Specify height or [2Point/Axis endpoint]: – 
указать высоту цилиндра

Информация, необходимая для описания цилинд-
ра, аналогична той, что используется для описания 

Рис. 19.14. Инструмент 
команды CYLINDER
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конуса, поэтому запросы команды CYLiNDER совпадают с запросами команды 
CONE.

Если необходимо построить цилиндр специальной формы (например, с па-
зами), следует вначале при помощи команды PLiNE создать двухмерное изобра-
жение его основания в виде замкнутой полилинии, а затем, используя команду 
EXtRUDE, придать ему высоту вдоль оси Z.

Пример..Формирование.твердотельного.цилиндра
Постройте твердотельный цилиндр, в основании которого лежит окружность 

(рис. 19.15).

Рис. 19.15. Формирование твердотельного цилиндра

Запустите команду CYLiNDER, вызвав ее из падающего меню Draw → Modeling → 
Cylinder, или щелчком на пиктограмме Cylinder в группе Modeling ленты Home. От-
ветьте на запросы:

_CYLINDER
Specify center point of base or [3P/2P/Ttr/Elliptical]: 200,150 – 

координаты центральной точки основания цилиндра
Specify base radius or [Diameter]: 140 – радиус основания цилиндра
Specify height or [2Point/Axis endpoint]: 250 – высота цилиндра

Выполните упражнение Cyl1 из раздела 5.

Твердотельный цилиндр
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Твердотельный.тор
Команда tORUs формирует твердотель-
ный тор, напоминающий по форме каме-
ру автомобильной шины. При этом необ-
ходимо ввести значения радиуса образу-
ющей окружности трубы и радиуса, 
определяющего расстояние от центра 
тора до центра трубы. Тор строится па-
раллельно плоскости XY текущей систе-

мы координат. Команда вызывается из падающе-
го меню Draw → Modeling → Torus, или щелчком на 
пиктограмме Torus в группе Modeling ленты Home 
рабочего пространства 3D Modeling (рис. 19.16).

Запросы команды tORUs:
Specify center point or [3P/2P/Ttr]: – ука-

зать центр тора
Specify radius or [Diameter]: – указать ра-

диус тора
Specify tube radius or [2Point/Diameter]: – 

указать радиус полости

Ключи команды tORUs:

�� 3P – задание окружности тора по трем точкам. Три указанные точки также 
определяют плос кость окружности тора. При этом команда tORUs вы-
дает следующие запросы:
Specify center point or [3P/2P/Ttr]: 3P – перейти в режим задания 
трех точек
Specify first point: – указать первую точку
Specify second point: – указать вторую точку
Specify third point: – указать третью точку
Specify tube radius or [2Point/Diameter]: – указать радиус полости

�� 2P – задание длины окружности тора по двум точкам. Плоскость окруж-
ности тора определяется координатой Z первой точки. При этом команда 
TORUS выдает следующие запросы:
Specify center point or [3P/2P/Ttr]: 2P – перейти в режим задания 
двух точек
Specify first end point of diameter: – указать первую конечную 
точку диаметра
Specify second end point of diameter: – указать вторую конечную 
точку диаметра
Specify tube radius or [2Point/Diameter]: – указать радиус полости

Рис. 19.16. Инструмент 
команды TORUS
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�� Ttr – построение тора по заданному радиусу, касающемуся двух объектов. 
Указанные точки касания проецируются на текущую ПСК. При этом ко-
манда TORUS выдает следующие запросы:
Specify center point or [3P/2P/Ttr]: T – перейти в режим задания 
двух касательных и радиуса
Specify point on object for first tangent: – указать на объекте 
точку для первой касательной
Specify point on object for second tangent: – указать на объекте 
точку для второй касательной
Specify radius of circle: – указать радиус
Specify tube radius or [2Point/Diameter]: – указать радиус полости

Радиус тора может иметь отрицательное значение, но радиус трубы дол-
жен быть положительным и превосходить абсолютную величину радиу-
са тора (например, если радиус тора равен -2.0, то радиус трубы должен 
быть больше +2.0). Данное условие необходимо соблюдать, чтобы не по-
лучить в итоге пустое тело (тело без объема). При этом сформированный 
объект имеет форму мяча для регби.
Допускается построение самопересекающихся торов – таких, у которых 
нет центрального отверстия. Для этого нужно задавать радиус сечения 
большим, чем радиус тора.

Пример..Формирование.твердотельного.тора
Постройте твердотельный тор (рис. 19.17).

Рис. 19.17. Формирование твердотельного тора

Твердотельный тор
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Запустите команду tORUs, вызвав ее из падающего меню Draw → Modeling → 
Torus или щелчком на пиктограмме Torus в группе Modeling ленты Home. Ответьте 
на запросы:

_TORUS
Specify center point or [3P/2P/Ttr]: 100,150 — координаты точки цен-

тра тора
Specify radius or [Diameter]: 50 — радиус тора
Specify tube radius or [2Point/Diameter]: 15 — радиус трубы тора

Выполните упражнения Tor1–Tor3 из раздела 5.

Твердотельная.пирамида
Команда PYRAmiD формирует твердо-
тельную пирамиду. Команда вызывает-
ся из падающего меню Draw → 
Modeling → Pyramid, или щелчком на 
пиктограмме Pyramid в группе Modeling 
ленты Home рабочего пространства 
3D Modeling (рис. 19.18, 19.19).

Запросы команды PYRAmiD:

�� Edge – указывается длина одной кромки 
основания пирамиды. При этом команда 
PYRAmiD выдает следующие запросы:
Specify center point of base or [Edge/
Sides]: E – перейти в режим указания 
кромки
Specify first endpoint of edge: – ука-
зать первую конечную точку стороны
Specify second endpoint of edge: – ука-
зать вторую конечную точку стороны
Specify height or [2Point/Axis 
endpoint/Top radius]: – указать высоту 
или один из ключей

�� Sides – указывается количество сторон для 
пирамиды. Возможен ввод значения от 3 
до 32. При этом команда PYRAmiD выдает следующие запросы:
Specify center point of base or [Edge/Sides]: S – перейти в режим 
указания количества сторон
Enter number of sides: – указать количество сторон

Рис. 19.18. Инструмент 
команды PYRAMID
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Рис. 19.19. Формирование твердотельной пирамиды

Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту или один из ключей

�� Inscribed – указывается, что основание пирамиды вписывается в преде-
лах (строится внутри) радиуса основания пирамиды. При этом команда 
PYRAMID выдает следующие запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: I – перейти в режим построе-
ния основания, вписанного в окружность
Specify base radius or [Circumscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту или один из ключей

�� Circumscribed – указывается, что основание пирамиды описывается во-
круг (строится по периметру) радиуса основания пирамиды. При этом ко-
манда PYRAmiD выдает следующие запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Circumscribed]: C – перейти в режим по-
строения основания, описанного вокруг окружности

Твердотельная пирамида
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Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: – указать 
высоту или один из ключей

�� 2Point – указывается, что высота пирамиды равняется расстоянию между 
двумя указанными точками. При этом команда PYRAmiD выдает следую-
щие запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: 2P – перей-
ти в режим указания высоты пирамиды с помощью двух точек
Specify first point: – указать первую точку
Specify second point: – указать вторую точку

�� Axis endpoint – указывается местоположение конечной точки для оси 
пирамиды. Данная конечная является вершиной пирамиды. Возможно 
расположение конечной точки оси в любом месте 3D-пространства. Ко-
нечная точка оси определяет длину пирамиды и ее положение в простран-
стве. При этом команда PYRAmiD выдает следующие запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: A – перейти 
в режим указания конечной точки оси пирамиды
Specify axis endpoint: – указать конечную точку оси

�� Top radius – указывается верхний радиус пирамиды при создании 
усеченной пирамиды (рис. 19.20). При этом команда PYRAmiD выдает 
следую щие запросы:
Specify center point of base or [Edge/Sides]: – указать централь-
ную точку основания или один из ключей
Specify base radius or [Inscribed]: – указать радиус основания
Specify height or [2Point/Axis endpoint/Top radius]: T – перейти 
в режим указания верхнего радиуса пирамиды
Specify top radius: – указать радиус верхнего основания
Specify height or [2Point/Axis endpoint]: – указать высоту

Политело
Команда POLYsOLiD преобразует имеющуюся линию, двухмерную 
полилинию, дугу или окружность в тело с прямоугольным профи-
лем, которое может содержать криволинейные сегменты, но профиль 
при этом всегда является прямоугольным. Команда вызывается из 
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падающего меню Draw → Modeling → Polysolid или щелчком на пиктограмме 
Polysolid в группе Modeling ленты Home рабочего пространства 3D Modeling.

Рис. 19.20. Формирование твердотельной усеченной пирамиды

Ширину тела определяет системная переменная PSOLWIDTH, высоту – систем-
ная переменная PSOLHEIGHT.

Запросы команды POLYsOLiD:
Specify start point or [Object/Height/Width/Justify] <Object>: – 

указать начальную точку для профиля тела или выбрать один из ключей
Specify next point or [Arc/Undo]: – указать следующую точку
Specify next point or [Arc/Undo]: – указать следующую точку
Specify next point or [Arc/Close/Undo]: – указать следующую точку
Specify next point or [Arc/Close/Undo]: – указать следующую точку или 

нажать клавишу Enter
Ключи команды POLYsOLiD:

�� Object – указывается объект для преобразования в тело: линия, дуга, дву-
мерная полилиния или окружность;

�� Height – указывается высота тела, которая по умолчанию равна текущему 
значению системной переменной PSOLHEIGHT;

�� Width – указывается высота тела, которая равна текущему значению си-
стемной переменной PSOLWIDTH;

Политело
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�� Justify – задаются значения ширины и высоты, обеспечивающие вырав-
нивание тела. Выравнивание привязывается к начальному направлению 
первого сегмента профиля:
•� Left – слева;
•� Center – по центру;
•� Right – справа;

�� Arc – к телу добавляется дуговой сегмент. Начальным направлением дуги 
по умолчанию является касательная к последнему построенному сегмен-
ту. При этом команда выдает следующие запросы:
Specify start point or [Object/Height/Width/Justify] <Object>: – 
указать начальную точку для профиля тела или выбрать один из клю-
чей
Specify next point or [Arc/Undo]: – указать следующую точку
Specify next point or [Arc/Undo]: A – переход в режим дуг
Specify endpoint of arc or [Close/Direction/Line/Second point/
Undo]: – указать конечную точку дуги или выбрать один из ключей:
•� Close – тело замыкается путем построения линейного или дугового сег-

мента от заданной последней вершины до начальной точки тела. Для 
применения этого ключа следует указать как минимум две точки;

•� Direction – задание начального направления дугового сегмента;
•� Line – выход из режима построения дуговых сегментов и возврат к на-

чальным запросам команды POLYsOLiD;
•� Second point – указываются вторая точка и конечная точка трехточеч-

ного дугового сегмента;
•� Undo – удаление последнего дугового сегмента, добавленного к телу.

Выдавленное.тело
Команда EXtRUDE позволяет соз-
давать твердотельные объекты мето-
дом выдавливания двухмерных объек-
тов в заданном направлении и на за-
данное расстояние. Команда вызы-
вается из падающего меню Draw → 
Modeling → Extrude или щелчком на 
пиктограмме Extrude в группе Model-
ing ленты Home рабочего простран-
ства 3D Modeling (рис. 19.21).

Запросы команды EXtRUDE:

Current wire frame density: ISOLINES=4 – 
текущая плотность каркаса

Рис. 19.21. Инструмент 
команды EXTRUDE
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Select objects to extrude: – выбрать объекты
Select objects to extrude: – нажать клавишу Enter для завершения выбора 

объектов
Specify height of extrusion or [Direction/Path/Taper angle]: – ука-

зать глубину выдавливания

Ключи команды EXtRUDE:

�� Direction – определяет длину и направление выдавливания. При этом 
выдаются следующие запросы:
Select objects to extrude: – выбрать объекты
Select objects to extrude: – нажать клавишу Enter для завершения 
выбора объектов
Specify height of extrusion or [Direction/Path/Taper angle]: D – 
перейти в режим указания направления выдавливания
Specify start point of direction: – указать начальную точку на-
правления
Specify end point of direction: – указать конечную точку направления

�� Path – позволяет указать высоту и направление выдавливания по задан-
ной траектории. При этом выдаются следующие запросы:
Select objects to extrude: – выбрать объекты
Select objects to extrude: – нажать клавишу Enter для завершения 
выбора объектов
Specify height of extrusion or [Direction/Path/Taper angle]: P – 
перейти в режим указания высоты и направления выдавливания по заданной 
траектории
Select extrusion path or [Taper angle]: – выбрать траекторию вы-
давливания

�� Taper angle – позволяет задать угол сужения конуса для выдавливания. 
При этом выдаются следующие запросы:
Select objects to extrude: – выбрать объекты
Select objects to extrude: – нажать клавишу Enter для завершения 
выбора объектов
Specify height of extrusion or [Direction/Path/Taper angle]: T – 
перейти в режим указания угла сужения конуса
Specify angle of taper for extrusion: – указать угол сужения для 
выдавливания
Value must be nonzero. – значение должно быть ненулевым
Specify height of extrusion or [Direction/Path/Taper angle]: – 
указать высоту выдавливания

Допускается выдавливание следующих объектов: отрезков, дуг, эллиптиче-
ских дуг, двухмерных полилиний, двухмерных сплайнов, окружностей, эллипсов, 
трехмерных граней, двухмерных фигур, полос, областей, плоских поверхностей, 
плоских граней на телах. Нельзя выдавить объекты, входящие в блоки, а также 

Выдавленное тело
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полилинии с пересекающимися сегментами. С помощью одной команды можно 
выдавить сразу несколько объектов. Направление выдавливания определяется 
траекторией или указанием глубины и угла конусности.

Команда EXtRUDE часто используется для формирования моделей таких объ-
ектов, как шестерни или звездочки. Особенно удобна она при создании объектов, 
имеющих сопряжения, фаски и аналогичного рода элементы, которые трудно вос-
произвести, не используя выдавливания сечений.

Конусное выдавливание часто применяется при рисовании объектов с наклон-
ными сторонами, например литейных форм. Не рекомендуется задавать большие 
углы конусности: в противном случае образующие конуса могут сойтись в одну 
точку прежде, чем будет достигнута требуемая глубина выдавливания.

Глубину выдавливания можно определять ненулевым значением или указа-
нием двух точек. При вводе положительного значения происходит выдавливание 
объектов вдоль положительной оси Z объектной системы координат, при вводе 
отрицательного значения – вдоль отрицательной оси Z.

Траекториями для выдавливания могут быть следующие объекты: отрезки, 
окружности, дуги, эллипсы, эллиптические дуги, двухмерные полилинии, трех-
мерные полилинии, двухмерные сплайны, трехмерные сплайны, грани тел, грани 
поверхностей, спирали.

Системная переменная DELOBJ определяет, будут ли объекты и путь (если он 
выбран) при создании тела удалены автоматически или об их удалении будет вы-
дан запрос.

Пример..Формирование.выдавленного.тела
Постройте твердотельный примитив путем выдавливания; при этом контур 

для выдавливания должен быть заготовлен заранее (рис. 19.22).

Рис. 19.22. Формирование выдавленного тела
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Запустите команду EXtRUDE, вызвав ее из падающего меню Draw → Modeling → 
Extrude или щелчком на пиктограмме Extrude в группе Modeling ленты Home. Ответь-
те на запросы:

_EXTRUDE
Current wire frame density: ISOLINES=8 – текущая плотность каркаса
Select objects to extrude: C – перейдите в режим выбора объектов секу-

щей рамкой
Specify first corner: – укажите первый угол секущей рамки
Specify opposite corner: – укажите противоположный угол секущей рам-

ки
Select objects to extrude: – нажмите клавишу Enter для завершения вы-

бора объектов
Specify height of extrusion or [Direction/Path/Taper angle]: T – 

перейдите в режим определения угла сужения для выдавливания
Specify angle of taper for extrusion: 7 – укажите угол сужения (конус-

ности) граней
Specify height of extrusion or [Direction/Path/Taper angle]: 70 – 

укажите глубину выдавливания

Выполните упражнения Ext1–Ext3 из 
раздела 5.

Тело.вращения
Команда REVOLVE формирует 
твердотельные объекты путем 
вращения существующих объек-
тов или облас тей на заданный 
угол вокруг оси X или Y текущей 
ПСК. Команда вызывается из па-
дающего меню Draw → Modeling → 
Revolve или щелчком на пикто-
грамме Revolve в группе Modeling 
ленты Home рабочего простран-
ства 3D Modeling (рис. 19.23, 19.24).

Запросы команды REVOLVE:

Current wire frame density: ISOLINES=20 – текущая плотность каркаса
Select objects to revolve: – выбрать объекты для вращения
Select objects to revolve: – нажать клавишу Enter для завершения выбора 

объектов для вращения

Тело вращения

Рис. 19.23. Инструмент команды 
REVOLVE



Глава 19. Построение тел516

Рис. 19.24. Формирование тела вращения

Specify axis start point or define axis by [Object/X/Y/Z] <Object>: – 
указать начальную точку оси вращения

Specify axis endpoint: – указать конечную точку оси вращения
Specify angle of revolution or [STart angle] <360>: – указать угол 

вращения

Ключи команды REVOLVE:

�� Object – требует указания объекта, используемого в качестве оси. Конец 
этого отрезка (сегмента), ближайший к точке указания, становится нача-
лом оси. Ее положительное направление определяется по правилу правой 
руки. При этом выдается запрос:

Select an object: – указать объект в качестве оси вращения

�� X – использует в качестве оси вращения положительную ось X текущей 
ПСК;

�� Y – применяет в качестве оси вращения положительную ось Y текущей 
ПСК;

�� Z – использует в качестве оси вращения положительную ось Z текущей 
ПСК.
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Можно использовать для вращения следующие объекты: отрезки, дуги, эл-
липтические дуги, двухмерные полилинии, двухмерные сплайны, круги, эллипсы, 
плоские трехмерные грани, двухмерные фигуры, полосы, области, плоские грани на  
телах или поверхностях. Невозможно применить вращение к объектам, входящим 
в блоки, а также к самопересекающимся.

Объект можно вращать вокруг отрезка, линейных сегментов полилинии, двух 
заданных точек, линейных кромок тел или поверхностей.

Как и EXtRUDE, команду REVOLVE удобно применять к объектам, имеющим 
сопряжения и другие аналогичные элементы, которые трудно воспроизвести, не 
используя вращения сечений.

Выполните упражнение Rev1 из раздела 5.

Тело.сдвига
Команда swEEP формирует но-
вый твердотельный объект путем 
сдвига разомкнутой или замкнутой 
плос кой кривой (контура) вдоль 
разомк нутой или замкнутой дву-
мерной или трехмерной траекто-
рии. Команда вызывается из падаю-
щего меню Draw → Modeling → Sweep 
или щелчком на пиктограмме Sweep 
в группе Modeling ленты Home рабо-
чего пространства 3D Modeling 
(рис. 19.25, 19.26).

Запросы команды swEEP:

Current wire frame density: ISOLINES=4 – 
текущая плотность каркаса

Select objects to sweep: – выбрать объекты для сдвига
Select objects to sweep: – нажать клавишу Enter для завершения выбора 

объектов для сдвига
Select sweep path or [Alignment/Base point/Scale/Twist]: – выбрать 

траекторию сдвига или один из ключей

Ключи команды swEEP:

�� Alignment – выравнивание. Определяет, будет ли профиль выровнен по 
нормали к касательной траектории сдвига. При этом выдаются запросы:
Current wire frame density: ISOLINES=4 – текущая плотность каркаса

Тело сдвига

Рис. 19.25. Инструмент 
команды SWEEP
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Рис. 19.26. Формирование объекта путем сдвига контура вдоль траектории

Select objects to sweep: – выбрать объекты для сдвига
Select objects to sweep: – нажать клавишу Enter для завершения вы-
бора объектов для сдвига
Select sweep path or [Alignment/Base point/Scale/Twist]: A – 
перейти в режим выравнивания
Align sweep object perpendicular to path before sweep [Yes/
No]<Yes>: – установить ли перед сдвигом объект сдвига перпендикуляр-
но траектории
Select sweep path or [Alignment/Base point/Scale/Twist]: – вы-
брать траекторию сдвига

�� Base point – указание базовой точки для объектов, подлежащих сдвигу. 
Если указанная точка не лежит в плоскости выбранных объектов, она про-
ецируется на эту плоскость;

�� Scale – указание масштабного коэффициента для операции сдвига. Объ-
екты, сдвигаемые из начальной точки траектории в конечную, масштаби-
руются как единый объект;

�� Twist – указание угла закручивания для объектов, подлежащих сдвигу. 
Угол закручивания определяет вращение вдоль всей длины траектории 
сдвига. При этом выдаются запросы:
Current wire frame density: ISOLINES=4 – текущая плотность каркаса
Select objects to sweep: – выбрать объекты для сдвига
Select objects to sweep: – нажать клавишу Enter для завершения вы-
бора объектов для сдвига
Select sweep path or [Alignment/Base point/Scale/Twist]: T – 
перейти в режим закручивания
Enter twist angle or allow banking for a non-planar sweep path 
[Bank]: – ввести угол закручивания или разрешить перекос неплоской 
траектории сдвига
Select sweep path or [Alignment/Base point/Scale/Twist]: – вы-
брать траекторию сдвига
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Операция сдвига отличается от операции выдавливания тем, что при выполне-
нии сдвига контур перемещается и устанавливается перпендикулярным к траек-
тории, затем он сдвигается вдоль траектории.

При сдвиге вдоль замкнутой кривой получается тело, а при разомкнутой – по-
верхность.

Для построения тела сдвига можно использовать следующие объекты: отре-
зок, дугу, эллиптическую дугу, двухмерную полилинию, двухмерный сплайн, окруж-
ность, эллипс, плоскую трехмерную грань, двухмерное тело, полосу, область, плос-
кую поверхность, плоские грани тела.

В качестве траектории используются следующие объекты: отрезок, дуга, эллип-
тическая дуга,  двухмерная полилиния,  двухмерный сплайн, окружность,  эллипс,  трех-
мерный сплайн, трехмерная полилиния, спираль, кромки тела или поверхности.

Системная переменная DELOBJ определяет способ удаления контуров и тра-
екторий сдвига при создании тела или поверхности – автоматически или по зап-
росу.

Тело,.созданное.с.помощью.сечений
Команда LOFt позволяет создавать 
новые тела, задавая ряд поперечных 
сечений. Команда вызывается из па-
дающего меню Draw → Modeling → 
Loft или щелчком на пиктограмме 
Loft в группе Modeling ленты Home 
рабочего пространства 3D Modeling 
(рис. 19.27).

При построении тела с помощью команды 
LOFt следует указать как минимум два попереч-
ных сечения, которые определят форму резуль-
тирующего объекта (рис. 19.28).

Запросы команды LOFt:
Select cross-sections in lofting 

order: – выбрать поперечные сечения в восходя-
щем порядке

Select cross-sections in lofting order: – 
нажать клавишу Enter для завершения выбора объектов

Enter an option [Guides/Path/Cross-sections only] <Cross-sections 
only>: – ввести один из ключей

Ключи команды LOFt:

�� Guides – задает направляющие кривые, которые управляют формой соз-
даваемого объекта путем добавления информации каркаса к объекту. Для 

Тело, созданное с помощью сечений

Рис. 19.27. Инструмент 
команды LOFT
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получения корректного результата каждая направляющая кривая должна 
пересекать каждое поперечное сечение, начинаться на первом поперечном 
сечении, завершаться на последнем поперечном сечении;

�� Path – задает одиночную траекторию для создаваемого по сечениям объ-
екта, при этом траектория должна пересекать все плоскости поперечных 
сечений;

�� Cross-sections only – только поперечные сечения.

Рис. 19.28. Пример тела, созданного с помощью сечений

В качестве поперечного сечения можно использовать: отрезки, дуги, эллипти-
ческие дуги, двухмерные полилинии, двухмерные сплайны, окружности, эллипсы, 
точки (только для первого и последнего поперечных сечений).

В качестве траектории сечения можно использовать: линию, дугу, эллиптиче-
скую дугу, сплайн, спираль, окружность, эллипс, двухмерные полилинии и трех-
мерные полилинии.

Направляющим объектом могут служить: линия, дуга, эллиптическая дуга, 
двухмерный или трехмерный сплайн, двухмерная или трехмерная полилиния.

Системная переменная DELOBJ определяет, требуется ли автоматическое уда-
ление поперечных сечений, направляющих и траектории после создания тела или 
поверхности, а также  будет ли выдан запрос на удаление этих объектов.

Вытянутое.тело
Команда PREssPULL позволяет сжимать или растягивать ограничен-
ные области. Команда вызывается щелчком на пиктограмме Presspull в 
группе Modeling ленты Home рабочего пространства 3D Modeling.
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Запросы команды PREssPULL:
Click inside bounded areas to press or pull. – щелкнуть кнопкой мыши 

в области контура для вытягивания

Допускается сжимать или растягивать ограниченные области следующих типов:

�� области, доступные для штриховки методом выбора точек;
�� области, замыкаемые пересечением компланарных линейных объектов, 

включая кромки и геометрические объекты в блоках;
�� замкнутые полилинии, области, трехмерные грани и двухмерные тела, со-

стоящие из компланарных вершин;
�� области, создаваемые геометрией, включая ребра на гранях, вычерчивае-

мой компланарно любой грани трехмерного тела.

Системная переменная IMPLIEDFACE позволяет указывать, допускается ли об-
наружение ограниченной области и ее сжатие или вытягивание.

Объединение.объектов
Команды, предназначенные для формирования слож-
ных объектов булевыми операциями, вызываются из 
падающего меню Modify → Solid Editing либо щелчком 
на соответствующей пиктограмме в группе Solid Editing 
ленты Home или в группе Boolean ленты Solid рабочего 
пространства 3D Modeling (рис. 19.29).

Команда UNiON предназначена для объединения объектов и создает 
сложный объект, который занимает суммарный объем всех его со-
ставляющих. Команда позволяет создавать новые составные тела 
или области из нескольких существующих тел или областей, в том 
числе не имеющих общего объема или площади (то есть не пересекаю-
щихся). Команда вызывается из падающего меню Modify → Solid 
Editing  Union или щелчком на пиктограмме Union в группе Boolean лен-
ты Solid рабочего пространства 3D Modeling.

Запросы команды UNiON:

Select objects: – выбрать объекты
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения работы команды

Пример..Формирование.тела.путем.объединения.
объектов
Постройте фигуру, объединив параллелепипед и две сферы (рис. 19.30).

Объединение объектов

Рис. 19.29. Инструменты 
булевых операций
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Рис. 19.30. Формирование тела путем объединения объектов

Запустите команду UNiON, вызвав ее из падающего меню Modify → Solid 
Editing → Union или щелчком на пиктограмме Union в группе Boolean ленты Solid. 
Ответьте на запросы:

_UNION
Select objects: – выберите сферу большего радиуса
Select objects: – выберите сферу меньшего радиуса
Select objects: – выберите параллелепипед
Select objects: – нажмите клавишу Enter для завершения работы команды

Выполните упражнение Uni1 из раздела 5.

Вычитание.объектов
Команда sUBtRACt обеспечивает вычитание одного объекта из 
другого. Таким образом команда позволяет сформировать новое со-
ставное тело или область. Области создаются путем вычитания пло-
щади одного набора областей или двухмерных примитивов из площа-
ди другого набора. Тела создаются путем вычитания одного набора 
объемных тел из другого подобного набора. Команду можно вызвать 
из падающего меню Modify → Solid Editing → Subtract или щелчком на 
пиктограмме Subtract в группе Boolean ленты Solid рабочего про-
странства 3D Modeling.
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Запросы команды sUBtRACt:

Select solids and regions to subtract from .. – выбрать тела и области, 
из которых будет выполняться вычитание

Select objects:
Select objects: – нажать клавишу Enter для завершения выбора объектов
Select solids and regions to subtract .. – выбрать тела или области 

для вычитания
Select objects:
Select objects: – нажать клавишу Enter для завершения работы команды

Пример..Формирование.тела.путем.вычитания.
объектов
Постройте фигуру путем вычитания сферы и цилиндра из параллелепипеда 

(рис. 19.31).

Рис. 19.31. Формирование тела путем вычитания объектов

Запустите команду sUBtRACt, вызвав ее из падающего меню Modify → Solid 
Editing → Subtract или щелчком на пиктограмме Subtract в группе Boolean ленты 
Solid. Ответьте на запросы:

_SUBTRACT
Select solids and regions to subtract from ..
Select objects: – выберите параллелепипед
Select objects: – нажмите клавишу Enter для завершения выбора объектов
Select solids and regions to subtract ..
Select objects: – выберите сферу
Select objects: – выберите цилиндр
Select objects: – нажмите клавишу Enter для завершения работы команды

Вычитание объектов
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Выполните упражнение Sub1 из раздела 5.

Пересечение.объектов
Команда iNtERsECt позволяет при пересечении нескольких 
сущест вующих объектов создать новые составные тела и области 
(рис. 19.32). Созданное сложное тело занимает объем, общий для 
двух или более пересекающихся тел, при этом непересекающиеся 
части объемов из рисунка удаляются. Команда вызывается из 
падаю щего меню Modify → Solid Editing  Intersect или щелчком на пик-
тограмме Intersect в группе Boolean ленты Solid рабочего простран-
ства 3D Modeling.

Рис. 19.32. Формирование тела путем пересечения объектов

Запросы команды iNtERsECt:
Select objects: – выбрать объекты
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения работы команды

Выполните упражнения Int1 и Int2 из раздела 5.
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Команды редактирования двухмерного пространства, например команды пере-
носа mOVE, копирования COPY, поворота ROtAtE, зеркального отображения 
miRROR и размножения массивом ARRAY, могут использоваться и в трехмерном 
пространстве. Кроме того, существуют команды редактирования, предназначен-
ные только для трехмерных объектов: команды поворота 3DROtAtE, создания 
массива объектов 3DARRAY, зеркального отображения miRROR3D и др.

Команды редактирования трехмерных объектов запускаются из падающего 
меню Modify → 3D Operations. В рабочем пространстве трехмерного моделирования 
3D Modeling команды редактирования расположены в группе Modify ленты Home 
(рис. 20.1, 20.2).

Рис. 20.1. Инструменты для редактирования трехмерных объектов
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Рис. 20.2. Инструменты для редактирования трехмерных  
объектов в рабочем пространстве 3D Modeling

Трехмерный.перенос
Команда 3DmOVE перемещает объекты на указанное расстояние в 
заданном направлении, при этом отображает инструмент ручки пере-
мещения в трехмерном виде. Вызывается команда из падающего 
меню Modify → 3D Operations → 3D Move или щелчком на пиктограмме 
3D Move в группе Modify ленты Home рабочего пространства 3D Modeling.

Запросы команды 3DmOVE:
Select objects: – выбрать объекты для переноса
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify base point or [Displacement] <Displacement>: – указать базо-

вую точку
Specify second point or <use first point as displacement>: – указать 

вторую точку или считать перемещением первую точку

Инструмент ручки перемещения отображается в заданной базовой точке. Для 
ограничения движения перемещением по осям необходимо нажать ручку оси.

Трехмерный.поворот.вокруг.оси
В двухмерном пространстве команда ROtAtE производит поворот объекта вокруг 
указанной точки; при этом направление поворота определяется текущей ПСК. При 
работе в трехмерном пространстве объект поворачивается вокруг оси. Ось может 
определяться указанием двух точек, объекта, одной из осей координат (Х, Y или 
Z) или текущего направления взгляда. Для поворота трехмерных объектов можно 
использовать как команду ROtAtE, так и ее трехмерный аналог.

Трехмерный поворот вокруг оси
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Команда 3DROtAtE вращает объекты вокруг базовой точки, при 
этом на трехмерном виде отображает ручку поворота. Вызывается ко-
манда из падающего меню Modify → 3D Operations → 3D Rotate или 
щелчком на пиктограмме 3D Rotate в группе Modify ленты Home рабоче-
го пространства 3D Modeling.

Запросы команды 3DROtAtE:
Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0 – 

текущие установки отсчета углов в ПСК
Select objects: – выбрать объекты для поворота
Select objects: – нажать клавишу Enter для окончания выбора объектов
Specify base point: – указать базовую точку
Pick a rotation axis: – указать ось вращения
Specify angle start point: – указать точку на первом луче угла
Specify angle end point: – указать точку на втором луче угла

Команда ROtAtE3D осуществляет поворот объектов в трехмерном простран-
стве вокруг заданной оси.

Запросы команды ROtAtE3D:
Current positive angle: ANGDIR=counterclockwise ANGBASE=0 – текущие 

установки отсчета углов
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для окончания выбора объектов
Specify first point on axis or define axis by
[Object/Last/View/Xaxis/Yaxis/Zaxis/2points]: – указать первую точку оси
Specify second point on axis: – указать вторую точку оси
Specify rotation angle or [Reference]: – указать угол поворота

Ключи команды ROtAtE3D:

�� Object – поворот вокруг выбранного объекта. Такими объектами могут 
быть отрезок, окружность, дуга или сегмент двухмерной полилинии;

�� Last – поворот вокруг оси, использовавшейся в предыдущей команде по-
ворота;

�� View – поворот вокруг оси, выровненной вдоль направления вида текуще-
го видового экрана и проходящей через заданную точку;

�� Xaxis, Yaxis, Zaxis – поворот вокруг оси, выровненной соответственно 
вдоль направления оси X, Y или Z и проходящей через заданную точку;

�� 2point – поворот вокруг оси, проходящей через две заданные точки.

Выполните упражнение Rot1 из раздела 5.

Выравнивание.объектов
Команда ALiGN осуществляет выравнивание объектов относительно 
других объектов в двухмерном и трехмерном пространствах. Вызыва-
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ется команда из падающего меню Modify → 3D Operations → Align или щелчком 
на пиктограмме Align в группе Modify ленты Home рабочего пространства 
3D Modeling.

Запросы команды ALiGN:
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для окончания выбора объектов
Specify first source point: – указать первую исходную точку
Specify first destination point: – указать первую целевую точку
Specify second source point: – указать вторую исходную точку
Specify second destination point: – указать вторую целевую точку
Specify third source point or <continue>: – указать третью исходную 

точку или продолжить
Specify third destination point or [eXit] <X>: – указать третью целе-

вую точку

При указании только одной пары исходных и целевых точек выбранные объекты 
перемещаются на плоскости или в пространстве на расстояние, заданное точками.

При указании двух пар исходных и целевых точек выбранные объекты могут 
быть перемещены, повернуты и масштабированы на плоскости или в простран-
стве. Первая пара точек задает базовую точку выравнивания, вторая пара точек 
описывает угол поворота. После ввода второй пары точек отображается запрос 
на масштабирование объекта. В качестве опорной длины для масштабирования 
берется расстояние между первой и второй целевыми точками. Масштабирование 
доступно только при выравнивании с помощью двух пар точек.

При указании трех пар исходных и целевых точек выбранные объекты могут 
быть перемещены и повернуты в пространстве. Вначале объекты перемещаются 
вдоль вектора, проведенного из исходной точки к целевой, затем исходный объект 
поворачивается, выравниваясь с целевым объектом. Далее исходный объект пово-
рачивается еще раз, выравниваясь с целевым объектом.

Команда 3DALiGN осуществляет выравнивание объектов относитель-
но других объектов в трехмерном пространстве. Вызывается команда 
из падающего меню Modify → 3D Operations → 3D Align или щелчком на 
пиктограмме 3D Align в группе Modify ленты Home рабочего простран-
ства 3D Modeling.

Запросы команды 3DALiGN:
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для окончания выбора объектов
Specify source plane and orientation ... – исходная плоскость и ориен-

тация
Specify base point or [Copy]: – указать базовую точку или копировать
Specify second point or [Continue] <C>: – указать вторую точку или 

продолжить

Выравнивание объектов



Глава 20. Редактирование трехмерных объектов530

Specify third point or [Continue] <C>: – указать третью точку или про-
должить

Specify destination plane and orientation ... – целевая плоскость и 
ориентация

Specify first destination point: – указать первую целевую точку
Specify second destination point or [eXit] <X>: – указать вторую це-

левую точку
Specify third destination point or [eXit] <X>: – указать третью целе-

вую точку

Для исходного объекта можно указать одну, две или три точки. Затем можно 
указать одну, две или три точки для места назначения. Выбранный объект переме-
щается и поворачивается так, что совпадают базовые точки и оси X и Y исходного 
объекта и места назначения выравниваются в трехмерном пространстве. Команда 
3DALiGN работает с динамической ПСК, так что можно динамически перетаски-
вать выбранные объекты и выравнивать их с гранью твердотельного объекта.

Зеркальное.отображение.
относительно.плоскости

Команда miRROR3D, осуществляющая зеркальное отображение 
объектов относительно заданной плоскости, вызывается из падающе-
го меню Modify → 3D Operations → 3D Mirror или щелчком на пиктограм-
ме 3D Mirror в группе Modify ленты Home рабочего пространства 
3D Modeling.

Запросы команды miRROR3D:
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для окончания выбора объектов
Specify first point of mirror plane (3 points) or
[Object/Last/Zaxis/View/XY/YZ/ZX/3points] <3points>: – указать пер-

вую точку плоскости отражения
Specify second point on mirror plane: – указать вторую точку плоскости 

отражения
Specify third point on mirror plane: – указать третью точку плоскости 

отражения
Delete source objects? [Yes/No] <N>: – удалять ли исходные объекты

Ключи команды miRROR3D:

�� Object – отображение относительно выбранного плоского объекта: отрез-
ка, окружности, дуги или сегмента двухмерной полилинии;

�� Last – отображение относительно плоскости, использовавшейся в преды-
дущей команде отображения;
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�� Zaxis – отображение относительно плоскости, заданной двумя точками, 
первая из которых лежит на плоскости, а вторая определяет вектор нор-
мали к плоскости;

�� View – плоскость отражения ориентируется согласно плоскости взгляда 
текущего видового экрана, проходящей через указанную точку;

�� XY, YZ, ZX – плоскость отражения ориентируется вдоль одной из стандарт-
ных плоскостей (XY, YZ или ZX), проходящей через указанную точку;

�� 3points – отображение относительно плоскости, проходящей через три 
заданные точки.

Плоскость отображения может представлять собой:

�� плоскость построения двухмерного объекта;
�� плоскость, параллельную одной из плоскостей координат (XY, YZ или XZ) 

текущей ПСК и проходящую через заданную точку;
�� плоскость, определяемую тремя указанными точками.

Выполните упражнение Mir1 из раздела 5.

Размножение.трехмерным.массивом
Команда 3DARRAY позволяет создавать прямоугольный и круговой 
массивы объектов в трехмерном пространстве. Отличие от аналогич-
ной команды, применяемой в двухмерном моделировании, состоит в 
том, что при создании прямоугольного массива объектов, кроме коли-
чества столбцов и строк, запрашивается (задается вдоль направления 
оси Z) количество уровней, а при создании кругового массива вместо 
центра вращения используется ось вращения, начальная и конечная 
точки которой следует указать в ответ на запросы. Команда 3DARRAY 
вызывается из падающего меню Modify → 3D Operations → 3D Array. 

Запросы команды 3DARRAY:
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для окончания выбора объектов
Enter the type of array [Rectangular/Polar] <R>: – указать тип массива
Enter the number of rows (---) <1>: – указать число рядов
Enter the number of columns (|||) <1>: – указать число столбцов
Enter the number of levels (...) <1>: – указать число уровней
Specify the distance between rows (---): – указать расстояние между 

рядами
Specify the distance between columns (|||): – указать расстояние между 

столбцами
Specify the distance between levels (...): – указать расстояние между 

уровнями

Размножение трехмерным массивом
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Для формирования кругового массива следует выбрать ключ Polar. При этом 
команда выдает следующие запросы:

Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для окончания выбора объектов
Enter the type of array [Rectangular/Polar] <R>: R – выбрать круговой 

тип массива
Enter the number of items in the array: – указать количество элементов 

в массиве
Specify the angle to fill (+=ccw, -=cw) <360>: – указать угол заполнения
Rotate arrayed objects? [Yes/No] <Y>: – указать, поворачивать ли объ-

екты массива
Specify center point of array: – указать центральную точку массива
Specify second point on axis of rotation: – указать вторую точку оси 

поворота

Обрезка.и.удлинение.трехмерных.
объектов
Любой трехмерный объект можно обрезать либо удлинить до другого объекта не-
зависимо от того, лежат ли они оба в одной плоскости и каким кромкам параллель-
ны: режущим или граничным. Чтобы произвести обрезку (удлинение), с помощью 
системных переменных PROJMODE и EXTEDGE следует выбрать одну из трех про-
екций: плоскость XY текущей ПСК, плоскость текущего вида или реальное трех-
мерное пространство.

Чтобы данные операции были выполнены успешно, объекты должны пересе-
каться с граничными кромками в пространстве, иначе в результате обрезки (удли-
нения) с проецированием на плоскость XY текущей ПСК новые границы объектов 
могут не соответствовать указанным кромкам в пространстве.

При вызове команд tRim и EXtEND, первая из которых выполняет обрезку 
части объекта по заданной границе, а вторая осуществляет вытягивание до грани-
цы в трехмерном пространстве, используется ключ Project, который определяет 
режим отсечения/вытягивания.

Сопряжение.трехмерных.объектов
В AutoCAD можно сопрягать любые объекты, расположенные в одной плоскости 
и имеющие направления выдавливания, не параллельные оси Z текущей ПСК. 
Направление выдавливания сопрягающей трехмерной дуги определяется следую-
щим образом:

�� если объекты расположены в одной плоскости и имеют одно направление 
выдавливания, перпендикулярное ей, сопрягающая дуга лежит в той же 
плоскости и имеет то же направление выдавливания;
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�� если объекты расположены в одной плоскости, но имеют противополож-
ные или вообще различные направления выдавливания, сопрягающая 
дуга располагается в этой же плоскости. Направление ее выдавливания 
перпендикулярно плоскости построения объектов; из двух перпендикуля-
ров выбирается ближайший к оси Z текущей ПСК.

Предположим, например, что в одной плоскости трехмерного пространства 
находятся две дуги – A и B. Векторы направления выдавливания дуг противопо-
ложны: (0, 0.5, 0.8) и (0, -0.5, -0.8) относительно текущей ПСК. Тогда для 
сопрягающей дуги будет принято направление выдавливания (0, 0.5, 0.8).

Построение.сечений
Команда sECtiON осуществляет построение поперечного сечения тела в виде об-
ласти или неименованного блока. Поперечное сечение – это пересечение плоско-
сти и выбранного тела (рис. 20.3).

Рис. 20.3. Формирование сечения

Запросы команды sECtiON:
Select objects: – выбрать объекты
Select objects: – нажать клавишу Enter для завершения выбора объектов
Specify first point on Section plane by
[Object/Zaxis/View/XY/YZ/ZX/3points] <3points>: – указать первую точ-

ку на секущей плоскости или один из ключей
Specify second point on plane: – указать вторую точку на плоскости
Specify third point on plane: – указать третью точку на плоскости

Ключи команды sECtiON:

Построение сечений
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�� Object – выравнивание секущей плоскости с сегментом круга, эллипса, 
круговой или эллиптической дуги, двухмерного сплайна или двухмер- 

�� Zaxis – определение секущей плоскости посредством задания двух точек 
этой плоскости, одна из которых расположена на оси Z;

�� View – размещение секущей плоскости параллельно плоскости вида на те-
кущем видовом экране. Расположение секущей плоскости определяется 
указанной точкой;

�� XY – выравнивание секущей плоскости с плоскостью XY текущей ПСК;
�� YZ – выравнивание секущей плоскости параллельно плоскости YZ теку-

щей ПСК;
�� ZX – выравнивание секущей плоскости параллельно плоскости ZX теку-

щей ПСК;
�� 3points – задание секущей плоскости по трем точкам.

По умолчанию секущая плоскость задается путем указания трех точек. При 
использовании других методов она определяется плоскостью построения другого 
объекта, плоскостью текущего вида, осью Z или одной из плоскостей координат 
(XY, YZ или XZ). AutoCAD помещает секущую плоскость в текущий слой.

Поперечное сечение представляет собой область или неименованный блок, 
формируемые на текущем слое, а не на слое, где находится объемное тело, попе-
речное сечение которого создается.

Построение.разрезов
Команда sLiCE осуществляет построение нового тела путем разре
зания какого-либо существующего тела плоскостью (рис. 20.4). Ко-
манда вызывается из падающего меню Modify → 3D Operations → Slice 
или щелчком на пиктограмме Slice в группе Solid Editing ленты Home 
рабочего пространства 3D Modeling.

Запросы команды sLiCE:
Select objects to slice: – выбрать объекты
Select objects to slice: – нажать клавишу Enter для завершения выбора 

объектов
Specify start point of slicing plane or [planar Object/Surface/

Zaxis/View/XY/YZ/ZX/3points] <3points>: – указать первую точку на режу-
щей плоскости

Specify second point on plane: – указать вторую точку на плоскости
Specify a point on desired side or [keep Both sides] <Both>: – указать 

точку с нужной стороны от плоскости

Полученные части можно оставить на рисунке или же удалить одну из них. 
Разрезанные тела наследуют слой и цвет исходного тела, но являются новыми со-
ставными телами. При разрезании по умолчанию тремя точками задается режу-

ной полилинии;
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щая плоскость, а затем указывается, какая часть (или обе) должна быть сохране-
на. При использовании других способов режущая плоскость может определяться 
другим объектом, плоскостью текущего вида, осью Z или одной из координатных 
плоскостей (XY, YZ или XZ).

Рис. 20.4. Формирование разреза

Ключи команды sLiCE:

�� Object – задает плоскость с помощью выбранного плоского объекта: от-
резка, окружности, дуги, эллипса, эллиптической дуги, двухмерного сплай-
на или сегмента двухмерной полилинии;

�� Zaxis – задает плоскость двумя точками, первая из которых лежит на ней, 
а вторая определяет вектор нормали к плоскости;

�� View – задает плоскость, выровненную с плоскостью вида текущего видо-
вого экрана и проходящую через заданную точку;

�� XY, YZ, ZX – задают плоскость, выровненную соответственно с плоскостью 
XY, YZ или ZX и проходящую через заданную точку;

�� 3points – определяет плоскость, проходящую через три заданные точки;
�� keep Both sides – оставляет обе части разрезанного тела.

Выполните упражнение Sli1 из раздела 5.

Придание.толщины
Команда tHiCKEN осуществляет преобразование поверхности в 
трехмерное тело с заданной толщиной. Команда вызывается из 
падаю щего меню Modify → 3D Operations → Thicken или щелчком на 

Придание толщины
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пиктограмме Thicken в группе Solid Editing ленты Home рабочего пространства 
3D Modeling.

Запросы команды tHiCKEN:
Select surfaces to thicken: – выбрать поверхности для придания толщины
Select surfaces to thicken: – нажать Enter для завершении выбора объектов
Specify thickness: – указать толщину

Преобразование.в.тело
Команда CONVtOsOLiD преобразует в трехмерные тела трехмерные 
сети, полилинии и круги, для которых задана толщина. Команда вы-
зывается из падающего меню Modify → 3D Operations → Convert to Solid 
или щелчком на пиктограмме Convert to Solid в группе Solid Editing лен-
ты Home рабочего пространства 3D Modeling.

Системная переменная DELOBJ определяет, будут ли выбранные пользователем 
объекты удалены после создания тела, или будет выдана подсказка на удаление 
объектов.

Преобразование.в.поверхность
Команда CONVtOsURFACE преобразует объекты в трехмерные по-
верхности. Команда вызывается из падающего меню Modify → 
3D Operations → Convert to Sufrace или щелчком на пиктограмме Convert 
to Sufrace в группе Solid Editing ленты Home рабочего пространства 
3D Modeling.

В поверхности можно преобразовать следующие объекты:
�� двухмерные фигуры;
�� области;
�� трехмерные тела;
�� разомкнутые полилинии с нулевой шириной, имеющие высоту;
�� отрезки, имеющие высоту;
�� дуги, имеющие высоту;
�� объекты сети;
�� плоские трехмерные грани.

Извлечение.ребер
Команда XEDGEs создает каркасную геометрию на основе ребер 
трехмерного тела, поверхности, сети, области или подобъекта. Ко-
манда вызывается из падающего меню Modify → 3D Operations → Extract 
Edges или с ленты Solid рабочего пространства 3D Modeling.
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Команды редактирования поверхностей находятся в падающем меню Modify → 
Surface Editing, а также на ленте Surface рабочего пространства трехмерного моде-
лирования 3D Modeling (рис. 21.1, 21.2).

Рис. 21.1. Инструменты для редактирования поверхностей в падающем меню
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Рис. 21.2. Инструменты для редактирования поверхностей на ленте Surface

Обрезка.поверхности
Команда sURFtRim  производит  обрезку частей поверхности по 
линии пересечения с другой поверхностью или геометрией другого 
типа (рис. 21.3). Вызывается команда из падающего меню Modify → 
Surface Editing → Trim  или щелчком на пиктограмме Surface Trim  в 
группе Edit ленты Surface рабочего пространства 3D Modeling.

Рис. 21.3. Обрезка поверхности

В качестве режущей кромки или контура могут использоваться отрезки, дуги, 
окружности, эллипсы, двухмерные и трехмерные полилинии, сглаженные сплайна-
ми и кривыми двухмерные и трехмерные полилинии, сплайны и спирали, поверх-
ности и области.

Запросы команды sURFtRim:
Extend surfaces = Yes, Projection = Automatic – установки удлинения 

поверхности и направления проецирования
Select surfaces or regions to trim or [Extend/PROjection direction]: – 

выбрать обрезаемые поверхности или области
Select surfaces or regions to trim or [Extend/PROjection direction]: – 

нажать Enter для завершения выбора объектов

Обрезка поверхности
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Select cutting curves, surfaces or regions: – выбрать режущие кривые, 
поверхности или области

Select cutting curves, surfaces or regions: – нажать Enter для завер-
шения выбора объектов

Select area to trim [Undo]: – выбрать обрезаемую область
Select area to trim [Undo]: – нажать Enter для завершения работы команды

Ключи команды sURFtRim:

�� Extend – обрезка режущей поверхности по кромке обрезаемой поверхно-
сти;

�� PROjection direction – режущая геометрия проецируется на поверх-
ность.

Отмена.обрезки.поверхности
Команда sURFUNtRim производит восстановление областей поверх-
ности, удаленных обрезкой. Команда вызывается из падающего меню 
Modify → Surface Editing → Untrim или щелчком на пиктограмме Surface 
Untrim в группе Edit ленты Surface рабочего пространства 3D Modeling.

Запросы команды sURFUNtRim:
Select edges on surface to un-trim or [SURface]: – выбрать кромки на 

поверхности для отмены обрезки
Select edges on surface to un-trim or [SURface]: – нажать Enter для 

завершения работы команды

Ключи команды sURFUNtRim:

�� SURface – выбор поверхности, для которой требуется восстановить все 
обрезанные области.

Удлинение.поверхности
Команда sURFEXtEND  производит  удлинение поверхности на за-
данное расстояние (рис. 21.4). Вызывается команда из падающего 
меню Modify → Surface Editing → Extend или щелчком на пиктограмме 
Surface Extend в группе Edit ленты Surface рабочего пространства 
3D Modeling.

Запросы команды sURFEXtEND:
Modes = Extend,  Creation = Append – установки режима и типа создания
Select surface edges to extend: – выбрать удлиняемые кромки поверх-

ности
Select surface edges to extend: – нажать Enter для завершения выбора 

объектов



541

Рис. 21.4. Удлинение поверхности

Specify extend distance [Expression/Modes]: – указать расстояние удли-
нения

Ключи команды sURFEXtEND:

�� Expression – величина удлинения поверхности, выраженная формулой 
или уравнением;

�� Modes – режим работы команды. При этом выдаются запросы:
Select surface edges to extend: – выбрать удлиняемые кромки по-
верхности
Select surface edges to extend: – нажать Enter для завершения вы-
бора объектов
Specify extend distance [Expression/Modes]: M – выбор режима 
работы команды
Extension mode [Extend/Stretch] <Extend>: S – выбор режима рас-
тяжения
Creation type [Merge/Append] <Append>: – выбор типа создания объ-
екта
Specify extend distance [Expression/Modes]: – указать расстояние 
удлинения

�� Extend – продолжение формы поверхности при выдавливании;
�� Stretch – растяжение без продолжения формы поверхности;
�� Merge – удлинение поверхности на заданное расстояние без создания но-

вой поверхности;
�� Append – создание новой поверхности удлинения, смежной с исходной. 

Если первоначальная поверхность является NURBS-поверхностью, новая 
поверхность удлинения также будет NURBS-поверхностью.

Удлинение поверхности
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Наполнение.поверхности
Команда sURFsCULPt производит обрезку и объединение поверх-
ностей, ограничивающих непроницаемую область, с созданием тела. 
Команда вызывается из падающего меню Modify → Surface Editing → 
Sculpt или щелчком на пиктограмме Surface Sculpt в группе Edit ленты 
Surface рабочего пространства 3D Modeling.

Запросы команды sURFsCULPt:
Mesh conversion set to: Smooth and optimized. – установки преобразо-

вания сети
Select surfaces or solids to sculpt into a solid: – выбрать поверх-

ности или тела для преобразования в объем с созданием тела
Select surfaces or solids to sculpt into a solid: – выбрать поверх-

ности или тела для преобразования в объем с созданием тела
Select surfaces or solids to sculpt into a solid: – нажать Enter для 

завершения работы команды

Преобразование..
в.NURBS-поверхности

Команда CONVtONURBs производит преобразование поверхно-
стей в NURBS-поверхности. Команда вызывается из падающего 
меню Modify → Surface Editing → Convert to NURBS или щелчком на 
пиктограмме Surface Sculpt в группе Control Vertices ленты Surface ра-
бочего пространства 3D Modeling.

Запросы команды CONVtONURBs:
Select objects to convert to: – выбрать объекты для преобразования
Select objects to convert to: – нажать Enter для завершения работы ко-

манды

Преобразование.в.сеть
Команда mEsHsmOOtH производит преобразование объектов в сети. 
Команда вызывается из падающего меню Modify → Surface Editing → 
Convert to Mesh.

Запросы команды mEsHsmOOtH:
Select objects to convert: – выбрать объекты для преобразования
Select objects to convert: – нажать Enter для завершения работы коман-

ды



543

Редактирование.NURBS-поверхности
Команда CVsHOw отображает управляющие вершин для заданных 
NURBS-поверхностей или кривых (рис. 21.5). Вызывается команда 
из падающего меню Modify → Surface Editing → NURBS Surface Editing → 
Show CV или щелчком на пиктограмме Surface CV-Show в группе 
Control Vertices ленты Surface рабочего пространства 3D Modeling.

Запросы команды CVsHOw:
Select NURBS surfaces or curves to display control Vertices: – вы-

брать NURBS-поверхности или кривые для отображения управляющих вершин
Select NURBS surfaces or curves to display control Vertices: – на-

жать Enter для завершения работы команды

Рис. 21.5. Отображение управляющих вершин NURBS-поверхностей

Команда CVHiDE  отключает отображение управляющих вершин 
для заданных NURBS-поверхностей или кривых. Вызывается ко-
манда из падающего меню Modify → Surface Editing → NURBS Surface 
Editing → Hide CV или щелчком на пиктограмме Surface CV-Hide в груп-
пе Control Vertices ленты Surface рабочего пространства 3D Modeling.

Команда CVADD  добавляет управляющие вершины к NURBS-
поверхностям и сплайнам (рис. 21.6). Вызывается команда из падаю-
щего меню Modify  Surface Editing → NURBS Surface Editing → Add CV или 
щелчком на пиктограмме Surface CV-Add в группе Control Vertices лен-
ты Surface рабочего пространства 3D Modeling.

Редактирование NURBS-поверхности
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Рис. 21.6. Добавление управляющих вершин к NURBS-поверхностям

Запросы команды CVADD:
Select a NURBS surface or curve to add control vertices: – выбрать 

NURBS-поверхность или кривую для добавления управляющих вершин
Adding control vertices in U direction – добавление управляющих вер-

шин в направлении оси U
Select point on surface or [insert Knots/Direction]: – выбрать точку 

на поверхности или

Ключи команды CVADD:

�� insert Knots – возможность разместить точку непосредственно на по-
верхности;

�� Direction – добавление управляющих вершин в направлении оси U или V.

Команда CVREmOVE  удаляет управляющие вершины с NURBS-
поверхностей и сплайнов. Вызывается команда из падающего меню 
Modify → Surface Editing → NURBS Surface Editing → Remove CV или щелч-
ком на пиктограмме Surface CV-Remove в группе Control Vertices ленты 
Surface рабочего пространства 3D Modeling.

Запросы команды CVREmOVE аналогичны запросам команды CVADD.

Команда CVREBUiLD перестраивает управляющие вершины и вос-
создает форму NURBS-поверхностей и кривых (рис. 21.7). Вызывает-
ся команда из падающего меню Modify → Surface Editing → NURBS Surface 
Editing → Rebuild или щелчком на пиктограмме Surface – Rebuild в груп-
пе Control Vertices ленты Surface рабочего пространства 3D Modeling.
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Рис. 21.7. Пример перестроенной NURBS-поверхности

Команда применяется в случае, если управляющих вершин слишком много, 
что осложняет редактирование объекта.

Запросы команды CVREBUiLD:

Select a NURBS surface or curve to rebuild: – выбрать NURBS-поверхность 
или кривую для повторного построения. После указания поверхности загружает-
ся диалоговое окно Rebuild Surface (рис. 21.8), в котором настраиваются параметры.

�� Область Control Vertices Count – количество управляющих вершин в на-
правлениях осей U и V:
•� In U direction: – количество управляющих вершин в направлениях оси U 

(системная переменная REBUILDU);
•� In V direction: – количество управляющих вершин в направлениях оси V 

(системная переменная REBUILDV).

�� Область Degree – количество управляющих вершин на участке:
•� In U direction: – порядок NURBS-поверхности в направлении оси U (си-

стемная переменная REBUILDDEGREEU);
•� In V direction: – порядок NURBS-поверхности в направлении оси V (си-

стемная переменная REBUILDDEGREEV).

�� Область Options – параметры построения (системная переменная 
REBUILDOPTIONS):
•� Delete original geometry – удалить исходную геометрию;
•� Retrim previously trimmed surfaces – повторить обрезку ранее обрезанных 

поверхностей.

Редактирование NURBS-поверхности
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�� Maximum Deviation: – максимальное отклонение новой поверхности от ис-
ходной.

Рис. 21.8. Диалоговое окно повторного построения поверхности
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Команды редактирования сетей находятся в падающем меню Modify → Mesh 
Editing, а также на ленте Mesh рабочего пространства трехмерного моделирования 
3D Modeling (рис. 22.1, 22.2).

Рис. 22.1. Инструменты для редактирования сетей в падающем меню
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Рис. 22.2. Инструменты для редактирования сетей на ленте Mesh

Увеличение.степени.сглаживания
Команда mEsHsmOOtHmORE увеличивает степень сглаживания 
для объектов-сетей на одну ступень (рис. 22.3). Вызывается команда 
из падающего меню Modify → Mesh Editing → Smooth More или щелчком 
на пиктограмме Smooth More в группе Mesh ленты Mesh рабочего про-
странства 3D Modeling.

Запросы команды mEsHsmOOtHmORE:
Select mesh objects to increase the smoothness level: – выбрать объ-

екты-сети для увеличения степени сглаживания
Select mesh objects to increase the smoothness level: – нажать Enter 

для завершения работы команды 

Рис. 22.3. Увеличение степени сглаживания объектов-сетей

Уменьшение.степени.сглаживания
Команда mEsHsmOOtHLEss уменьшает степень сглаживания для 
объектов-сетей на одну ступень. Вызывается команда из падающего 
меню Modify → Mesh Editing → Smooth Less или щелчком на пиктограм-
ме Smooth Less в группе Mesh ленты Mesh рабочего пространства 
3D Modeling.

Запросы команды mEsHsmOOtHLEss аналогичны запросам команды 
mEsHsmOOtHmORE.

Уменьшение степени сглаживания
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Уточнение.сети
Команда mEsHREFiNE увеличивает количество граней в выбранных 
объектах (рис. 22.4, 22.5). Вызывается команда из падающего меню 
Modify → Mesh Editing → Refine Mesh или щелчком на пиктограмме Refine 
Mesh в группе Mesh ленты Mesh рабочего пространства 3D Modeling.

Запросы команды mEsHREFiNE:
Select mesh object or face subobjects to refine: – выбрать объект-сеть 

или подобъекты-грани для уточнения
Select mesh object or face subobjects to refine: – нажать Enter для за-

вершения работы команды

Рис. 22.4. Исходное количество граней

Рис. 22.5. Увеличенное количество граней
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Сгиб
Команда mEsHCREAsE осуществляет заострение кромок вы-
бранных подобъектов сети в выбранных объектах (рис. 22.6). Вы-
зывается команда из падающего меню Modify → Mesh Editing → 
Crease или щелчком на пиктограмме Refine Mesh в группе Mesh лен-
ты Mesh рабочего пространства 3D Modeling.

Запросы команды mEsHCREAsE:
Select mesh subobjects to crease: – выбрать подобъекты сети для фор-

мирования сгиба
Select mesh subobjects to crease: – нажать Enter для завершения выбора
Specify crease value [Always] <Always>: – задать значение для сгиба

Ключи команды MESHREFINE:

�� Always – сгиб сохраняется всегда, даже при сглаживании или уточнении 
объекта.

Рис. 22.6. Заострение кромок сети

Удаление.сгиба
Команда mEsHUNCREAsE осуществляет удаление сгиба из вы-
бранных граней, ребер, вершин сети и восстановление гладкости 
согнутого ребра. Вызывается команда из падающего меню Modify → 
Mesh Editing → Uncrease или щелчком на пиктограмме Remove Crease 
в группе Mesh ленты Mesh рабочего пространства 3D Modeling.

Запросы команды mEsHUNCREAsE аналогичны запросам команды 
mEsHCREAsE.

Удаление сгиба
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Разделение.грани
Команда mEsHsPLit  осуществляет разделение грани сети на две 
(рис. 22.7). Вызывается команда из падающего меню Modify → Mesh 
Editing → Split Face или щелчком на пиктограмме Split Face в группе 
Mesh Edit ленты Mesh рабочего пространства 3D Modeling.

Запросы команды mEsHsPLit:
Select a mesh face to split: – выбрать грань сети для разбиения
Specify first split point on face edge or [Vertex]: – задать первую 

точку разделения на кромке грани
Specify second split point on face edge or [Vertex]: – задать вторую 

точку разделения на кромке грани

Ключи команды mEsHsPLit:

�� Vertex – первая конечная точка траектории разделения должна совпадать 
с одной из вершин сети.

Рис. 22.7. Разделение грани сети

Выдавливание.грани
Команда mEsHEXtRUDE осуществляет выдавливание грани сети 
в трехмерное пространство (рис. 22.8). Вызывается команда из па-
дающего меню Modify → Mesh Editing → Extrude Face или щелчком на 
пиктограмме Extrude Face в группе Mesh Edit ленты Mesh рабочего 
пространства 3D Modeling.

Запросы команды mEsHEXtRUDE:
Adjacent extruded faces set to: Join – настройка для смежных выдав-

ленных граней
Select mesh face(s) to extrude or [Setting]: – выбрать грани сети для 

выдавливания
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Select mesh face(s) to extrude or [Setting]: – нажать Enter для завер-
шения выбора

Specify height of extrusion or [Direction/Path/Taper angle]: – ука-
зать высоту выдавливания

Ключи команды mEsHEXtRUDE:

�� Setting – настройка для объединения смежных выдавленных граней;
�� Direction – задание величины и направления выдавливания;
�� Path – задание траектории и величины выдавливания;
�� Taper angle – установка угла конусности для выдавливания.

Рис. 22.8. Выдавливание грани

Объединение.граней
Команда mEsHmERGE осуществляет объединение смежных граней в 
одну грань (рис. 22.9). Вызывается команда из падающего меню  
Modify → Mesh Editing → Merge Face или щелчком на пиктограмме Merge 
Face в группе Mesh Edit ленты Mesh рабочего пространства 3D Modeling.

Рис. 22.9. Выдавливание грани

Объединение граней
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Запросы команды mEsHmERGE:
Select adjacent mesh faces to merge: – выбрать смежные грани сети для 

объединения
Select adjacent mesh faces to merge: – нажать Enter для завершения ра-

боты команды

Вращение.треугольной.грани
Команда mEsHsPiN осуществляет вращение ребра, прилегающего к 
двум треугольным граням сети (рис. 22.10). Вызывается команда из 
падающего меню Modify → Mesh Editing → Spin Triangle Face или щелчком 
на пиктограмме Spin Triangle Face в группе Mesh Edit ленты Mesh рабочего 
пространства 3D Modeling.

Запросы команды mEsHsPiN:
Select first triangular mesh face to spin: – выбрать первую треуголь-

ную грань сети для вращения
Select second adjacent triangular mesh face to spin: – выбрать вторую 

смежную треугольную грань сети для вращения

Рис. 22.10. Вращение треугольной грани

Закрытие.отверстия
Команда mEsHCAP создает грань сети, соединяющую открытые ребра 
(рис. 22.11). Вызывается команда из падающего меню Modify → Mesh 
Editing → Close Hole или щелчком на пиктограмме Close Hole в группе 
Mesh Edit ленты Mesh рабочего пространства 3D Modeling.

Запросы команды mEsHCAP:
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Select connecting mesh edges to create a new mesh face: – выбрать 
соединяющиеся кромки сети для создания новой грани сети

Select connecting mesh edges to create a new mesh face: – нажать Enter 
для завершения работы команды

Рис. 22.11. Соединение открытых ребер

Сжатие.грани.или.кромки
Команда mEsHCOLLAPsE осуществляет объединение вершин вы-
бранных граней или ребер сети (рис. 22.12). Вызывается команда из 
падающего меню Modify → Mesh Editing → Collapse Face or Edge или щелч-
ком на пиктограмме Collapse Face or Edge в группе Mesh Edit ленты Mesh 
рабочего пространства 3D Modeling.

Рис. 22.12. Объединение вершин граней

Сжатие грани или кромки
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Запросы команды mEsHCOLLAPsE:
Select mesh face or edge to collapse: – выбрать грань или кромку сети 

для сжатия

Преобразование.в.многогранник
Команда CONVtOsOLiD осуществляет преобразование выбранной 
сети в многогранник. Вызывается команда из падающего меню Modify → 
Mesh Editing → Convert to Faceted Solid.

Запросы команды CONVtOsOLiD:
Select objects: – выбрать объекты для преобразования
Select objects: – нажать Enter для завершения работы команды

Преобразование.в.многогранную.
поверхность

Команда CONVtOsURFACE осуществляет преобразование выбран-
ной сети в многогранную поверхность. Вызывается команда из падаю-
щего меню Modify → Mesh Editing → Convert to Faceted Surface.

Запросы команды CONVtOsURFACE:
Select objects: – выбрать объекты для преобразования
Select objects: – нажать Enter для завершения работы команды

Преобразование.в.гладкое.тело
Команда CONVtOsOLiD  осуществляет преобразование выбранной 
сети в гладкое тело. Вызывается команда из падающего меню Modify → 
Mesh Editing → Convert to Smooth Solid.

Запросы команды CONVtOsOLiD:
Select objects: – выбрать объекты для преобразования
Select objects: – нажать Enter для завершения работы команды

Преобразование.в.гладкую.поверхность
Команда CONVtOsURFACE осуществляет преобразование выбран-
ной сети в гладкую поверхность. Вызывается команда из падающего 
меню Modify → Mesh Editing → Convert to Smooth Surface.

Запросы команды CONVtOsURFACE:
Select objects: – выбрать объекты для преобразования
Select objects: – нажать Enter для завершения работы команды
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В данном разделе описывается техника редактирования трехмерных твердотель-
ных объектов: снятие фасок, сопряжение, построение разрезов, сечений и деление 
тел на части.

Существует возможность непосредственно редактировать грани и ребра моде-
ли. Есть функция, удаляющая дополнительные поверхности и ребра, появившие-
ся после выполнения команд FiLLEt и CHAmFER. Допускается изменение цвета 
граней и ребер, а также создание их копий, представляющих собой ACIS-тела, об-
ласти, отрезки, дуги, круги, эллипсы и сплайны. Путем клеймения (то есть на-
несения геометрических объектов на грани) создаются новые грани или слива-
ются имеющиеся избыточные. Смещение граней изменяет их пространственное 
положение в твердотельной модели. С помощью этой операции, например, можно 
увеличивать и уменьшать диаметры отверстий. Функция разделения создает из 
одного тела несколько новых, независимых. И наконец, имеется возможность пре-
образования тел в тонкостенные оболочки заданной толщины.

Команды редактирования трехмерных тел запускаются из падающего меню 
Modify → Solid Editing (рис. 23.1), а также на лентах Home и Solid рабочего простран-
ства трехмерного моделирования 3D Modeling (рис. 23.2, 23.3).

Рис. 23.1. Команды редактирования трехмерных тел в падающем меню
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Рис. 23.2. Команды редактирования трехмерных тел на ленте Home

Рис. 23.3. Команды редактирования трехмерных тел на ленте Solid

Снятие.фасок.на.гранях
Команда CHAmFEREDGE осуществляет снятие фасок (скашивание) 
для ребер трехмерных тел и поверхностей (рис. 23.4). Команда вы-
зывается из падающего меню Modify → Solid Editing → Chamfer edges 
или щелчком на пиктограмме Chamfer Edges в группе Solid Editing лен-
ты Solid рабочего пространства 3D Modeling. 

Запросы команды CHAmFEREDGE:
Distance1 = 1.0000, Distance2 = 1.0000 – установленные значения раз-

меров фаски
Select an edge or [Loop/Distance]: – выбрать кромку
Select an edge belongs to the same face or [Loop/Distance]: – выбрать 

кромку, принадлежащую той же грани
Select an edge belongs to the same face or [Loop/Distance]: – нажать 

Enter для завершения выбора
Press Enter to accept the chamfer or [Distance]: – нажать Enter для 

завершения работы команды

Ключи команды CHAmFEREDGE:

�� Loop – снятие фасок осуществляется на всех кромках (ребрах) одной гра-
ни;

�� Distance – задание длин катетов фасок, измеренных от выбранной кром-
ки.

Снятие фасок на гранях
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Рис. 23.4. Пример снятия фаски с тела

Выполните упражнения Cha1 и Cha2 из раздела 5.

Сопряжение.граней
Команда FiLLEtEDGE осуществляет сопряжение ребер трехмерных 
тел и поверхностей (рис. 23.5). Команда вызывается из падающего 
меню Modify → Solid Editing → Fillet edges или щелчком на пиктограмме 
Fillet  Edges в группе Solid Editing ленты Solid рабочего пространства 
3D Modeling. 

Запросы команды FiLLEtEDGE:
Radius = 1.0000 – установленное значение радиуса скругления
Select an edge or [Chain/Radius]: – выбрать ребро
Select an edge or [Chain/Radius]: – нажать Enter для завершения выбора
… edge(s) selected for fillet. – количество выбранных ребер для сопря-

жения
Press Enter to accept the fillet or [Radius]: – нажать Enter для завер-

шения работы команды

Ключи команды FiLLEtEDGE:

�� Chain – задание нескольких ребер или кромок;
�� Radius – задание радиуса сопрягающей дуги.
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Рис. 23.5. Пример скругления тела

Выполните упражнения Fil1 и Fil2 из раздела 5.

Клеймение.грани
Команда imPRiNt, осуществляющая клеймение грани трехмерного 
тела, вызывается из падающего меню Modify → Solid Editing → Imprint 
Edges или щелчком на пиктограмме Imprint в группе Solid Editing ленты 
Solid рабочего пространства 3D Modeling.

С помощью команды imPRiNt возможно создание на трехмерных телах новых 
граней. Например, для пересекаемого окружностью трехмерного тела можно вы-
полнить клеймение кривой пересечения.

Запросы команды imPRiNt:
Select a 3D solid: – выбрать трехмерное тело
Select an object to imprint: – выбрать клеймящий объект
Delete the source object [Yes/No] <N>: – удалять ли исходный объект
Select an object to imprint: – нажать клавишу Enter для завершения ра-

боты команды

Для того чтобы операция клеймения выбранного тела другим объектом была 
успешной, необходимо наличие пересечения клеймящего объекта и грани выбран-
ного тела.

Клеймение грани
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Клеймение может быть применено к дугам, окружностям, отрезкам, двухмер-
ным и трехмерным полилиниям, эллипсам, сплайнам, областям и трехмерным 
телам.

Изменение.цвета.ребер
Команда редактирования тел sOLiDEDit дает пользователю воз-
можность перекрашивать ребра трехмерного тела. Для этого коман-
ду sOLiDEDit следует вызывать из падающего меню Modify → Solid 
Editing → Color edges или щелчком на пиктограмме Color Edges в груп-
пе Solid Editing ленты Home рабочего пространства 3D Modeling 
(рис. 23.6).

Рис. 23.6. Инструмент изменения цвета ребер

Запросы команды sOLiDEDit с ключами Edge, Color:
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: 

_edge – переход в режим редактирования ребер
Enter an edge editing option [Copy/coLor/Undo/eXit] <eXit>: _color – 

переход в режим изменения цвета ребер
Select edges or [Undo/Remove]: – выбрать ребра
Select edges or [Undo/Remove]: – нажать клавишу Enter для завершения 

выбора ребер
Enter an edge editing option [Copy/coLor/Undo/eXit] <eXit>: – нажать 

клавишу Enter для завершения работы команды
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 

нажать клавишу Enter для завершения работы команды
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Назначение нового цвета производится в диалоговом окне Select color. Цвет, 
явно назначенный ребру данной командой, имеет приоритет перед цветом слоя, 
на котором находится тело.

Копирование.ребер
Команда редактирования тел sOLiDEDit дает возможность созда
вать копии ребер трехмерного тела. Для этого команду sOLiDEDit 
следует вызывать из падающего меню Modify → Solid Editing → Copy 
edges или щелчком на пиктограмме Copy Edges в группе Solid Editing 
ленты Home рабочего пространства 3D Modeling (см. рис. 23.6).

Запросы команды sOLiDEDit с ключами Edge, Copy:
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: 

_edge – переход в режим редактирования ребер
Enter an edge editing option [Copy/coLor/Undo/eXit] <eXit>: _copy – 

переход в режим копирования ребер
Select edges or [Undo/Remove]: – выбрать ребра
Select edges or [Undo/Remove]: – нажать клавишу Enter для завершения 

выбора ребер
Specify a base point or displacement: – указать базовую точку или пере-

мещение
Specify a second point of displacement: – указать вторую точку пере-

мещения
Enter an edge editing option [Copy/coLor/Undo/eXit] <eXit>: – нажать 

клавишу Enter для завершения работы команды
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 

нажать клавишу Enter для завершения работы команды

Результирующими объектами при копировании являются отрезки, дуги, 
окружности, эллипсы и сплайны. Если указаны две точки, то в качестве базовой 
используется первая из них, и копия размещается относительно нее. Если указана 
одна точка, то в качестве базовой берется точка выбора объекта.

Выдавливание.граней
Для выдавливания граней команду редактирования тел sOLiDEDit 
следует вызвать из падающего меню Modify → Solid Editing → Extrude 
faces или щелчком на пиктограмме Extrude Faces в группе Solid Editing 

Выдавливание граней
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ленты Home рабочего пространства 3D Modeling (рис. 23.7, 23.8). При этом в ко-
манде используются ключи Face, Extrude и выдаются следующие запросы:

Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-
верка тел при редактировании

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: 
_face – переход в режим редактирования граней

Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>:_extrude – переход в режим выдавливания граней
Select faces or [Undo/Remove]: – выбрать грани
Select faces or [Undo/Remove/ALL]: – продолжить выбор граней или на-

жать клавишу Enter для перехода к настройке параметров
Specify height of extrusion or [Path]: – указать глубину выдавливания
Specify angle of taper for extrusion <0>: – указать угол сужения для 

выдавливания
Solid validation started. – выполняется проверка тела
Solid validation completed. – проверка тела завершена
Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>: – нажать клавишу Enter
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 

нажать клавишу Enter для завершения работы команды

Рис. 23.7. Инструменты редактирования граней
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Рис. 23.8. Примеры выдавливания граней

У каждой грани имеется сторона положительного смещения, определяемая на-
правлением нормали к ней. Нормалью к поверхности называется вектор, перпен-
дикулярный ей. Ввод положительной глубины приводит к выдавливанию грани 
в положительном направлении (как правило, от тела), отрицательной – в отрица-
тельном направлении (внутрь тела). Положительное значение угла сужения со-
ответствует постепенному удалению грани от вектора, отрицательное значение – 
приближению к вектору. По умолчанию угол сужения равен 0, и грань выдавлива-
ется перпендикулярно своей плоскости без изменения размеров. Установка слиш-
ком больших значений угла сужения или глубины выдавливания может привести 
к тому, что объект сузится до нуля, не достигнув заданной высоты. В этом случае 
выдавливание не выполняется.

Для выдавливания по заданной траектории после выбора грани следует ис-
пользовать ключ Path. Вдоль указанной траектории сдвигаются все контуры, об-
разующие выбранную грань. Траекториями могут служить отрезки, окружности, 
дуги, эллипсы, эллиптические дуги, полилинии и сплайны. Траектория не должна 
лежать в одной плоскости с выдавливаемой гранью и не должна иметь участков с 
большой кривизной.

Выполните упражнения Sed1 и Sed2 из раздела 5.

Перенос.граней
Для переноса граней в пространстве команду редактирования тел 
sOLiDEDit следует вызывать из падающего меню Modify → Solid 
Editing → Move faces или щелчком на пиктограмме Move Faces в группе 

Перенос граней
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Solid Editing ленты Home рабочего пространства 3D Modeling (см. рис. 23.7). В ко-
манде используются ключи Face, Move. При переносе граней их ориентация 
остается неизменной (рис. 23.9). 

Рис. 23.9. Примеры переноса граней

Эта функция полезна, например, при подборе положения отверстия внутри 
тела. При этом команда выдает следующие запросы:

Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-
верка тел при редактировании

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>:_
face – переход в режим редактирования граней

Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>:_move – переход в режим переноса граней
Select faces or [Undo/Remove]: – выбрать грани
Select faces or [Undo/Remove/ALL]: – продолжить выбор граней или на-

жать клавишу Enter для перехода к настройке параметров
Specify a base point or displacement: – указать базовую точку
Specify a second point of displacement: – указать вторую точку пере-

мещения
Solid validation started. – выполняется проверка тела
Solid validation completed. – проверка тела завершена
Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>: – нажать клавишу Enter
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Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-
верка тел при редактировании

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 
нажать клавишу Enter для завершения работы команды

Выполните упражнение Sed3 из раздела 5.

Смещение.граней
Для равномерного смещения граней команду редактирования тел 
sOLiDEDit следует вызывать из падающего меню Modify → Solid 
Editing → Offset faces или щелчком на пиктограмме Offset Faces в груп-
пе Solid Editing ленты Home рабочего пространства 3D Modeling (см. 
рис. 23.7 и рис. 23.10). При этом в команде используются ключи Face, 
Offset. 

Рис. 23.10. Примеры равномерного смещения граней

Команда выдает следующие запросы:
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>:_

face – переход в режим редактирования граней

Смещение граней
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Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit] <eXit>: _offset – переход в режим смещения граней
Select faces or [Undo/Remove]: – выбрать грани
Select faces or [Undo/Remove/ALL]: – продолжить выбор граней или на-

жать клавишу Enter для перехода к настройке параметров
Specify the offset distance: – указать расстояние смещения
Solid validation started. – выполняется проверка тела
Solid validation completed. – проверка тела завершена
Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit] <eXit>: – нажать клавишу Enter
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 

нажать клавишу Enter для завершения работы команды

Смещение каждой грани выполняется в направлении нормали к ней. Данная 
операция может быть использована, например, для расширения или сужения 
имеющихся в теле отверстий. Положительное значение смещения соответству-
ет увеличению объема тела или отверстия в нем, отрицательное – уменьшению. 
Величину смещения можно также задать неявно, указав на рисунке точку, через 
которую должна проходить новая грань. Если в смещении участвуют все грани 
тела, имеющего отверстия и вырезы, увеличение объема тела приводит к тому, что 
отверстия сужаются.

Выполните упражнение Sed5 из раздела 5.

Удаление.граней
Для удаления граней команду редактирования тел sOLiDEDit следу-
ет вызывать из падающего меню Modify → Solid Editing → Delete faces 
или щелчком на пиктограмме Delete Faces в группе Solid Editing ленты 
Home рабочего пространства 3D Modeling (см. рис. 23.7 и рис. 23.11). 
При этом в команде используются ключи Face, Delete.

При использовании команды sOLiDEDit с ключами Face, Delete происходит 
удаление граней, в том числе полученных в результате построения фасок и со-
пряжений.

Выполните упражнение Sed7 из раздела 5.
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Рис. 23.11. Пример удаления грани

Поворот.граней
Для поворота граней в пространстве команду редактирования тел 
sOLiDEDit следует вызывать из падающего меню Modify → Solid 
Editing → Rotate faces или щелчком на пиктограмме Rotate Faces в груп-
пе Solid Editing ленты Home рабочего пространства 3D Modeling (см. 
рис. 23.7 и рис. 23.12). При этом в команде используются ключи Face, 
Rotate.

Поворот граней тела осуществляется путем выбора базовой точки и установ-
ки относительного или абсолютного значения угла. Все пространственные грани 
поворачиваются вокруг выбранной оси. Направление поворота определяется по-
ложением текущей ПСК и значением системной переменной ANGDIR. Ось может 
определяться следующими способами: указанием двух точек, объекта, одной из 
осей координат или направления взгляда. Ось поворота также может быть задана 
указанием точки на оси X или Y, двух точек или объекта (в этом случае ось со-
вмещается с ним). Положительным направлением оси считается направление от 
начальной точки к конечной. Поворот подчиняется правилу правой руки, если не 
задано обратное при настройке системной переменной ANGDIR.

Выполните упражнение Sed4 из раздела 5.

Поворот граней



Глава 23. Редактирование трехмерных тел570

Рис. 23.12. Пример поворота грани

Сведение.граней.на.конус
Для сведения граней на конус относительно заданного вектора на-
правления команду редактирования тел sOLiDEDit следует вызы-
вать из падающего меню Modify → Solids Editing → Taper faces или 
щелчком на пиктограмме Taper Faces в группе Solid Editing ленты Home 
рабочего пространства 3D Modeling (см. рис. 23.7 и рис. 23.13). 

В команде используются ключи Face, Taper и выдаются следующие запросы:
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>:_

face – переход в режим редактирования граней
Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>:_taper – переход в режим сведения граней на конус
Select faces or [Undo/Remove]: – выбрать грани
Select faces or [Undo/Remove/ALL]: – продолжить выбор граней или на-

жать клавишу Enter для перехода к настройке параметров
Specify the base point: – указать базовую точку
Specify another point along the axis of tapering: – указать другую 

точку на оси конуса
Specify the taper angle: – указать угол сужения
Solid validation started. – выполняется проверка тела
Solid validation completed. – проверка тела завершена
Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>: – нажать клавишу Enter
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Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-
верка тел при редактировании

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 
нажать клавишу Enter для завершения работы команды

Рис. 23.13. Пример сведения граней на конус

Положительное значение угла сужения соответствует постепенному удалению 
грани от вектора, отрицательное значение – приближению к вектору. Не рекомен-
дуется задавать большие углы сужения, поскольку образующие грани могут сой-
тись в одну точку до того, как будет достигнута требуемая глубина. В этом случае 
сведение на конус не выполняется.

Выполните упражнение Sed6 из раздела 5.

Изменение.цвета.граней
При изменении цвета граней команду редактирования тел sOLiDEDit 
следует вызывать из падающего меню Modify → Solid Editing → Color 
faces или щелчком на пиктограмме Color Faces в группе Solid Editing 
ленты Home рабочего пространства 3D Modeling (см. рис. 23.7 и 
рис. 23.14). В команде используются ключи Face, Color.

Назначение нового цвета производится в диалоговом окне Select color. Цвет, 
явно назначенный грани данной командой, имеет приоритет перед цветом слоя, 
на котором находится тело.

Изменение цвета граней
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Рис. 23.14. Пример изменения цвета граней

Выполните упражнение Sed9 из раздела 5.

Копирование.граней
При копировании граней команду редактирования тел sOLiDEDit 
следует вызывать из падающего меню Modify → Solid Editing → Copy 
faces или щелчком на пиктограмме Copy Faces в группе Solid Editing 
ленты Home рабочего пространства 3D Modeling (см. рис. 23.7 и 
рис. 23.15). В команде используются ключи Face, Copy.

В результате копирования граней могут быть образованы области или тела 
ACIS. Если указаны две точки, то первая точка используется в качестве базовой и 
копия размещается относительно нее. Если указать одну точку и нажать клавишу 
Enter, то эта точка будет использована в качестве нового расположения.

Выполните упражнения Sed8 из раздела 5.

Упрощение
При упрощении трехмерного тела команду редактирования 
sOLiDEDit следует вызывать из падающего меню Modify → Solid 
Editing → Clean или щелчком на пиктограмме Clean в группе Solid 
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Editing ленты Home рабочего пространства 3D Modeling (рис. 23.16). В команде 
применяются ключи Body, Clean.

При использовании команды sOLiDEDit с ключами Body, Clean происходит 
слияние смежных ребер или вершин, лежащих на одной поверхности или кривой, 
а также удаление всех избыточных ребер, вершин и неиспользуемой геометрии. 
При это клейменные ребра не удаляются.

Рис. 23.15. Пример копирования граней

Разделение.тел
При разделении трехмерного тела команду редактирования 
sOLiDEDit следует вызывать из падающего меню Modify → Solid 
Editing → Separate или щелчком на пиктограмме Separate в группе Solid 
Editing ленты Home рабочего пространства 3D Modeling (см. рис. 23.16). 
В команде применяются ключи Body, Separate.

При использовании команды sOLiDEDit с ключами Body, Separate проис-
ходит разделение трехмерных тел, занимающих несколько замкнутых объемов в 
пространстве, на отдельные тела. Следует учесть, что разделение не действует на 
тела, части которых обладают общим объемом. Такие тела, как правило, получены 
в результате логических операций.

Разделение тел
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Рис. 23.16. Инструменты редактирования граней

Оболочка
При создании оболочки  команду редактирования sOLiDEDit следу-
ет вызывать из падающего меню Modify → Solid Editing → Shell или 
щелчком на пиктограмме Shell в группе Solid Editing ленты Home рабо-
чего пространства 3D Modeling (см. рис. 23.16 и рис. 23.17). 

В команде используются ключи Body, Shell и выдаются следующие запросы:
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: 

_body – переход в режим редактирования тела
Enter a body editing option
[Imprint/seParate solids/Shell/cLean/Check/Undo/eXit] <eXit>: _shell – 

переход в режим создания оболочки
Select a 3D solid: – выбрать трехмерное тело
Remove faces or [Undo/Add/ALL]: – выбрать грани для исключения
Remove faces or [Undo/Add/ALL]: – нажать клавишу Enter для завершения 

выбора граней
Enter the shell offset distance: – указать толщину стенок оболочки
Solid validation started. – выполняется проверка тела
Solid validation completed. – проверка тела завершена
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Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>: – нажать клавишу Enter
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 

нажать клавишу Enter для завершения работы команды

Рис. 23.17. Пример создания оболочки

Преобразовать тело в тонкостенную оболочку можно только один раз. В резуль-
тате преобразования создаются новые грани с помощью смещения существую щих 
граней наружу от их исходных позиций. Имеется возможность исключения от-
дельных граней исходного тела из оболочки.

При положительной толщине новые грани создаются внутри исходного тела, 
при отрицательной – снаружи. При этом толщина всех стенок одинакова.

Выполните упражнения Sed10 из раздела 5.

Проверка.корректности.тела
При проверке трехмерного тела команду редактирования sOLiDEDit 
следует вызывать из падающего меню Modify → Solid Editing → Check 
или щелчком на пиктограмме Check в группе Solid Editing ленты Home 
рабочего пространства 3D Modeling (см. рис. 23.16). 

Проверка корректности тела
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В команде используются ключи Body, Check и выдаются следующие запросы:

Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-
верка тел при редактировании

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: 
_body – переход в режим редактирования тела

Enter a body editing option
[Imprint/seParate solids/Shell/cLean/Check/Undo/eXit] <eXit>: _ check – 

переход в режим проверки
Select a 3D solid: – выбрать трехмерное тело
This object is a valid ShapeManager solid. – объект является коррект-

ным телом ShapeManager
Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/

Undo/eXit]<eXit>: – нажать клавишу Enter
Solids editing automatic checking: SOLIDCHECK=1 – автоматическая про-

верка тел при редактировании
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: – 

нажать клавишу Enter для завершения работы команды
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Использование AutoCAD для создания трехмерных моделей и их изображений 
имеет множество преимуществ, по сравнению с применением программы в дву-
мерном моделировании, но вместе с тем требует несколько иного подхода. Работа 
в трехмерном пространстве представляет собой сочетание рисования, редактиро-
вания и установки видов и видовых экранов для изображения модели. Следова-
тельно, от пользователя требуется умение сформировать корректную трехмерную 
модель, работать с различными трехмерными системами координат, правильно 
задавать пользовательские системы координат, а также корректно устанавливать 
необходимые виды трехмерных моделей.

При построении трехмерной модели приходится работать более чем с одним 
видом объекта. Возможно, что изображение объекта будет достаточно инфор-
мативным на одном виде и нечитаемым на другом. В любом случае при работе с 
трехмерными объектами следует установить несколько видовых экранов, напри-
мер один – с видом в плане, другой – с видом слева, дополнительный – с аксоно-
метрическим видом.

Чтобы повысить удобство работы, для каждого видового экрана можно задать 
и сохранить отдельную ПСК. Независимо от того, что происходит с ПСК на теку-
щем видовом экране, системы координат на остальных видовых экранах остаются 
неизменными, и при переключении между экранами не происходит потери ин-
формации о ПСК каждого из них.

Сохранением ПСК для каждого видового экрана управляет системная пере-
менная UCSVP. На видовых экранах, где UCSVP равна 1, ПСК, использованная непо-
средственно перед переходом на другой видовой экран, запоминается; при возвра-
те происходит ее восстановление. Если системная переменная UCSVP установлена 
в 0 для некоторого видового экрана, то его ПСК всегда совпадает с ПСК текущего 
активного видового экрана.

Находясь в пространстве модели, можно рассматривать сформированные объ-
екты с любой точки зрения. Точкой зрения (видом) называется направление, за-
даваемое из трехмерной точки пространства на начало системы координат. Уста-
новка направления взгляда производится в начале работы с моделью или при не-
обходимости рассмотреть завершенную модель из какой-либо конкретной точки. 
AutoCAD позволяет взглянуть на рисунок из любой точки пространства, даже 
изнутри изображаемого объекта. Перемещая точку зрения в нужную позицию, 
удобнее формировать объекты, редактировать их, а также получать изображения 
со скрытыми линиями, закрашенные и тонированные. Можно получать виды в 
ортогональной и перспективной проекциях.

С помощью инструментов трехмерного просмотра и навигации можно пере-
мещаться по чертежу, настраивать камеру на определенный вид и создавать ани-
мации для обеспечения параллельного доступа к своему проекту другим пользо-
вателям. Можно перемещаться по всей трехмерной модели в режиме движения 
по кругу, разворота, обхода или облета, настраивать камеру, создавать анимацию 
предварительного просмотра и записывать анимации траектории перемещения, 
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которые можно передавать другим пользователям для визуального ознакомления 
с проектом.

Команды определения трехмерных видов вызываются из падающего меню View 
или панели инструментов View или из группы меню View рабочего пространства 
3D Modeling.

Установка.вида.в.плане
План – это вид в заданной ПСК из точки зрения, находящейся точно над началом 
координат плоскости построений (точки с координатами 0,0,1). Таким образом, 
в плане плоскость построений параллельна экрану.

Команда PLAN, обеспечивающая установку вида рисунка в плане, дей-
ствует только на текущем видовом экране. Пользоваться этой коман-
дой в пространстве листа недопустимо. Можно выбрать план текущей 

ПСК, предварительно сохраненной ПСК или МСК.

Команда PLAN вызывается из падающего меню View → 3D Views → Plan View. 
Далее выбираются, соответственно, пункты Current UCS, World UCS или Named UCS 
(рис. 24.1).

Рис. 24.1. Падающее меню View

Установка вида в плане
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Запросы команды PLAN:
Enter an option [Current ucs/Ucs/World] <Current>: – задать ключ

Ключи команды PLAN:

�� Current ucs – создает изображение текущей ПСК в плане на текущем 
видовом экране. Используется по умолчанию;

�� Ucs – обеспечивает переключение в план предварительно сохраненной ПСК 
и регенерирует изображение. AutoCAD запрашивает имя требуемой ПСК;

�� World – создает изображение в плане МСК.

Команда PLAN изменяет направление взгляда и отключает перспективу, но не 
меняет текущей ПСК. Все координаты, вводимые или отображаемые после запус-
ка этой команды, берутся относительно текущей ПСК.

Выполните упражнение Vpt2 из раздела 5.

Установка.ортогональных.
и.аксонометрических.видов
Ортогональный вид, помещаемый на видовой экран, базируется на системе ко-
ординат, заданной в системной переменной UCSBASE. По умолчанию это мировая 
система координат, однако пользователь вправе установить в качестве базовой 
любую из имеющихся в рисунке именованных ПСК. AutoCAD позволяет восста-
навливать на видовом экране соответствую-
щую ортогональную ПСК в тот момент, 
когда текущим становится ортогональный 
вид. Например, при установке вида спере-
ди AutoCAD может автоматически сделать 
текущей переднюю ортогональную ПСК. 
Такое согласованное переключение видов 
и систем координат очень удобно для реше-
ния множества конструкторских задач.

При установке ортогонального вида 
AutoCAD зуммирует его до границ.

Для установки ортогональных и аксоно-
метрических видов используются инстру-
менты падающего меню View → 3D Views (см. 
рис. 24.1).

В рабочем пространстве 3D Modeling ин-
струменты установки ортогональных и ак-
сонометрических видов находятся в группе 
View ленты Visualize (рис. 24.2).

Рис. 24.2. Инструменты установки 
ортогональных и аксонометрических 

видов на ленте Visualize
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Top – установка точки зрения сверху (план, горизонтальная проекция);

Bottom – установка точки зрения снизу;

Left – установка точки зрения слева (профильная проекция);

Right – установка точки зрения справа;

Front – установка точки зрения спереди (фронтальная проекция);

Back – установка точки зрения сзади;

SW Isometric – установка юго-западного изометрического вида;

SE Isometric – установка юго-восточного изометрического вида;

NE Isometric – установка северо-восточного изометрического вида;

NW Isometric – установка северо-западного изометрического вида;

View Manager… – сохранение и восстановление именованных видов в диалого-
вом окне View Manager (рис. 24.3), которое также можно открыть из падающего 
меню View → Named Views....

Рис. 24.3. Диалоговое окно установки видов

Выполните упражнение Vpt1 из раздела 5.

Установка ортогональных и аксонометрических видов
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Интерактивное.управление.точкой.
взгляда

Команда 3DORBit активизирует на текущем видовом экране режим 
интерактивного управления точкой взгляда при работе в трехмерном 
пространстве. Видом модели в это время можно управлять с помощью 
мыши. С орбиты могут рассматриваться как вся модель, так и ее от-
дельные объекты. Команда вызывается из падающего меню View → 
Orbit → Constrained Orbit (рис. 24.4). 

Рис. 24.4. Вызов команды 3DORBIT из падающего меню

Для того чтобы приступить к вращению вида, нужно нажать кнопку мыши 
и начать перемещать ее. При этом точка цели остается неподвижной, а положе-
ние камеры, то есть наблюдателя, перемещается относительно нее. Пока команда 
3DORBit активна, редактирование объектов невозможно.

Для установки орбитального вида необходимо выбрать один или несколько 
объектов, которые должны быть рассмотрены с орбиты. Если же предварительно 
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ничего не было выбрано, в рассмотрении будет участвовать вся модель. Тем не ме-
нее рекомендуется ограничивать круг вовлекаемых в операцию объектов, так как 
это ускоряет работу программы.

Для улучшения восприятия трехмерных орбитальных видов на них можно раз-
местить одно или несколько средств визуализации с помощью контекстного меню 
команды 3DORBit (рис. 24.5), для чего необходимо в процессе выполнения ко-
манды щелкнуть правой кнопкой мыши на области рисования:

Рис. 24.5. Контекстное меню команды 3DORBIT

�� Current Mode: – текущий режим.
�� Other Navigation Modes – другие режимы навигации:
•� Constrained Orbit 1 – зависимая орбита;
•� Free Orbit 2 – свободная орбита;
•� Continuous Orbit 3 – непрерывная орбита;
•� Adjust Distance 4 – регулировка расстояния;
•� Swivel 5 – шарнир;
•� Walk 6 – обход;
•� Fly 7 – облет;
•� Zoom 8 – зуммирование;
•� Pan 9 – панорамироваие.

�� Enable Orbit Auto Target – включение автоприцела орбиты.
�� Animation Settings… – загрузка диалогового окна параметров анимации 

Animation Settings (рис. 24.6):

Интерактивное управление точкой взгляда
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•� Visual style: – установка визуального стиля:
◊� As displayed – обычный;
◊� Rendered – тонирование;
◊� 3D Hidden – объекты на трехмерном виде представляются в каркасном 

виде. Линии, относящиеся к задним граням, не отображаются;
◊� 3D Wireframe – объекты на трехмерном виде представляются в виде 

каркаса – отрезков и кривых (как кромки граней и тел);
◊� Conceptual – грани многоугольников на трехмерном виде окрашива-

ются в заданный цвет;
◊� Realistic – грани подвергаются раскрашиванию, с просвечивающим 

сквозь них каркасом;
◊� Draft – черновой вариант;
◊� Low – низкое разрешение;
◊� Medium – среднее разрешение;
◊� High – высокое разрешение;
◊� Pressentation – презентационный вариант;

•� Frame rate (FPS): – установка частоты кадров в секунду;
•� Resolution: – установка разрешения;
•� Format: – определение формата.

Рис. 24.6. Диалоговое окно параметров анимации

�� Zoom Window – окно зуммирования.
�� Zoom Extents – зуммировать в границах.
�� Zoom Previous – предыдущее зуммирование.
�� Parallel – параллельная проекция, то есть никакие две параллельные линии 

на виде не сходятся. Формы объектов остаются неизменными и не искажа-
ются при приближении камеры.
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�� Perspective – перспективная проекция, то есть все параллельные линии на 
виде сходятся в одну точку. Чем ближе к наблюдателю расположен объект, 
тем крупнее его размер на экране. При достаточно большом приближении 
имеет место искажение форм. Однако этот тип проекции более естестве-
нен: именно так видит окружающий мир человеческий глаз.

�� Reset View – восстановить вид.
�� Preset Views – стандартные виды:
•� Top – сверху;
•� Bttom – снизу;
•� Front – спереди;
•� Back – сзади;
•� Left – слева;
•� Right – справа;
•� SW Isometric – юго-западный вид изометрии;
•� SE Isometric – юго-восточный вид изометрии;
•� NE Isometric – северо-восточный вид изометрии;
•� NW Isometric – северо-западный вид изометрии.

�� Named Views – именованные виды;
�� Visual Styles – визуальные стили:
•� 3D Hidden – объекты на трехмерном виде представляются в каркасном 

виде. Линии, относящиеся к задним граням, не отображаются;
•� 3D Wireframe – объекты на трехмерном виде представляются в виде кар-

каса – отрезков и кривых (как кромки граней и тел);
•� Conceptual – грани многоугольников на трехмерном виде окрашиваются 

в заданный цвет;
•� Realistic – грани подвергаются раскрашиванию, с просвечивающим 

сквозь них каркасом.
�� Visual Aids – средства визуализации:
•� Compass – установка компаса, при котором орбитальное кольцо допол-

няется тремя пространственными пунктирными окружностями, симво-
лизирующими проекции осей X, Y и Z на сферу;

•� Grid – строится вспомогательная сетка из линий, параллельных осям X и 
Y и перпендикулярных оси Z. Трехмерный уровень, на котором она рас-
положена, задается системной переменной ELEVATION. 

 Перед входом в режим трехмерной орбиты можно, воспользовавшись 
командой GRiD, задать параметры отображения сетки. Количество ос-
новных ее линий зависит от того, какой установлен шаг в системной 
переменной GRIDUNIT. Промежутки между основными линиями делят-
ся еще на десять частей с помощью дополнительных линий (на рисунке 
они выделены серым цветом).

 При изменении коэффициента экранного увеличения (зуммировании) 
на трехмерном орбитальном виде подбирается количество линий сет-

Интерактивное управление точкой взгляда
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ки так, чтобы они не сливались, но и не отстояли друг от друга слиш-
ком далеко. Если вид отдаляется от наблюдателя, линий становится 
меньше. Напротив, с приближением вида количество линий увеличи-
вается до тех пор, пока не начинает вновь соответствовать значению 
GRIDUNIT.

•� UCS Icon – включение и отключение пиктограммы ПСК. Если она была 
включена перед вызовом команды 3DORBit, на орбитальном виде сра-
зу же появляется цветная пиктограмма в виде тройки осей. Ось X име-
ет красный цвет, ось Y – зеленый, ось Z – синий или голубой. Режим 
отобра жения трехмерной пиктограммы ПСК устанавливается также 
системной переменной UCSICON.

Выполните упражнение Orb1 из раздела 5.

Свободная.орбита
Команда 3DFORBit активизирует управление интерактивным про-
смотром объектов в трехмерном режиме, используя неограниченную 
орбиту, обеспечивающую движение по кругу в любом направлении 
без привязки к плоскости. При этом точка зрения не ограничена 
плос костью XY или осью Z. Команда вызывается из падающего меню 
View → Orbit → Free Orbit (см. рис. 24.4).

Вид, на котором действует режим орбиты, помечается орбитальным кольцом. 
Геометрически оно представляет собой большой круг, разделенный на квадранты 
четырьмя малыми кругами. В процессе выполнения команды неподвижной оста-
ется точка, на которую направлен взгляд, то есть точка цели. Позиция наблюдате-
ля (точка камеры) перемещается относительно цели. Считается, что цель в данном 
случае совмещена с центром орбитального кольца.

Указатель мыши изменяет свое состояние в зависимости от того, на какой час-
ти орбитального кольца находится. Форма указателя помогает понять, как именно 
будет вращаться вид:

�� если указатель находится внутри орбитального кольца, он выглядит как 
маленькая сфера с двумя внешними окружностями-орбитами. Нажатие 
кнопки и движение мыши в этом случае вызывают свободное перемеще-
ние вида. Вид ведет себя так, как будто бы пользователь захватил мышью 
воображаемую сферу, окружающую объекты, и начал вращать ее вокруг 
точки цели. Указатель можно перемещать по горизонтали, по вертикали 
и по диагонали;

�� если указатель мыши находится вне орбитального кольца, он выглядит 
как маленькая сфера с внешней окружностью-стрелкой. Нажатие кноп-
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ки и перемещение указателя вокруг орбитального кольца вызывают вра-
щение вида относительно оси, проходящей через центр кольца перпен-
дикулярно экрану. Если указатель переходит через орбитальное кольцо, 
он приобретает форму сферы с двумя орбитами и начинает свободно 
перемещать вид, как было описано выше. После выхода указателя обрат-
но во внешнюю часть восстанавливается режим вращения вида вокруг 
центральной оси;

�� если указатель мыши находится на левом или правом малом круге ор-
битального кольца, он выглядит как маленькая сфера с горизонтальным 
эллипсом-стрелкой. Нажатие кнопки и перемещение указателя из этих 
точек вызывают вращение вида относительно вертикальной оси, проходя-
щей через центр кольца. Вертикальная линия на указателе символизирует 
направление этой условной оси Y;

�� если указатель мыши находится на верхнем или нижнем малом круге 
орбитального кольца, он выглядит как маленькая сфера с вертикальным 
эллипсом-стрелкой. Нажатие кнопки и перемещение указателя из этих 
точек вызывают вращение вида относительно горизонтальной оси, про-
ходящей через центр кольца. Горизонтальная линия на указателе симво-
лизирует направление этой условной оси X.

Динамическое.вращение.трехмерной.
модели

Команда 3DCORBit активизирует возможность постоянного враще-
ния вида по орбите и вызывается из падающего меню View → Orbit → 
Continuous Orbit (см. рис. 24.4).

Работая в этом режиме, пользователь нажимает кнопку мыши и задает направ-
ление, в котором должен вращаться вид после отпускания кнопки.

В процессе постоянного вращения по орбите остаются доступными команды 
контекстного меню, позволяющие задать тип проекции, режим раскрашивания, 
активные средства визуализации, восстановить вид, установить стандартный вид. 
Если выбрать из контекстного меню какой-либо из пунктов: Pan или Zoom, – вра-
щение останавливается.

Пока команда 3DCORBIT продолжает работу, никакие другие вводить в команд-
ной строке нельзя; также исключается редактирование объектов. Для завершения 
работы команды необходимо либо нажать клавишу Enter или Esc, либо выбрать 
пункт Enter из контекстного меню.

Выполните упражнение Orb2 из раздела 5.

Динамическое вращение трехмерной модели
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Регулировка.расстояния
Команда 3DDistANCE устанавливает режим интерактивного трех-
мерного просмотра, приближение к объектам и удаление от них. Ко-
манда вызывается из падающего меню View → Camera → Adjust Distance.

Изменение расстояния до объектов осуществляется при вертикальном переме-
щении курсора, при этом можно увеличивать и уменьшать изображение объектов 
и настраивать расстояние до них.

Курсор в команде 3DDistANCE приобретает форму горизонтальной линии с 
двумя стрелками, одна из которых указывает вверх, а другая – вниз. При нажатии 
кнопки и перемещении курсора вертикально вверх камера приближается к объек-
там и тем самым увеличивает их видимые размеры. При нажатии кнопки и пере-
мещении курсора вертикально вниз камера удаляется от объектов и тем самым 
уменьшает их видимые размеры.

Шарнир
Команда 3DswiVEL изменяет цель вида в направлении перетаскива-
ния мыши и вызывается из падающего меню View → Camera → Swivel.

Во время работы команды 3DswiVEL осуществляется имитация панорамиро-
вания камерой в направлении перетаскивания, при этом изменяется направление 
обзора и можно выполнять шарнирное перемещение камеры в плоскости XY или 
вдоль оси Z.

Обход.чертежа
Команда 3DwALK интерактивно меняет вид трехмерного чертежа, 
при этом кажется, что наблюдатель обходит модель. Команда вызыва-
ется из падающего меню View → Walk and Fly → Walk.

Обход всей модели выполняется в текущем видовом экране перемещением в 
плоскости XY с помощью клавиатуры, круговой осмотр и поворот – с помощью 
мыши. При этом доступны следующие соответствия:

�� Tab – показать тему;
�� Up arrow / W key – стрелка вверх или клавиша W перемещает камеру вперед, 

при этом кажется, что пользователь проходит или пролетает вперед;
�� Down arrow / S key – стрелка вниз или клавиша S перемещает камеру назад;
�� Left arrow / A key – стрелка влево или клавиша A перемещает камеру влево, 

и при этом кажется, что пользователь перемещается влево;
�� Right arrow / D key – стрелка вправо или клавиша D перемещает камеру впра-

во;
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�� Drag mouse – перетаскивание с помощью мыши задает цель для просмотра 
или поворота взгляда пользователя;

�� F key – клавиша F переключает режим облета на режим обхода, и наоборот;
�� Don't show me this again – больше не выводить это окно.

При этом открывается палитра ло-
катора положения POSITION LOCATOR 
(рис. 24.7), в которой отображается вид 
сверху на положение трехмерной модели 
при навигации обхода или облета, задан-
ное пользователем на чертеже.

�� Zoom In – увеличение изо-
бражения в палитре лока-
тора положения.

�� Zoom Out – уменьшение 
изображения в палитре 
локатора положения.

�� Zoom Extents – зуммирова-
ние изображения в грани-
цах палитры локатора по-
ложения.

На образце отображается текущее по-
ложение пользователя в модели. Здесь 
можно перетащить указатель положения, 
чтобы изменить свое местоположение. 
Также можно перетащить указатель цели, 
чтобы изменить направление вида.

�� Position indicator color – определе-
ние цвета указателя текущего положения пользователя.

�� Position indicator size – определение размера указателя текущего положения 
пользователя:
•� Small – малый;
•� Medium – средний;
•� Large – большой.

�� Position indicator blink – включение и отключение эффекта мерцания указа-
теля положения.

�� Target indicator – вывод на экран указателя, который показывает цель вида.
�� Target indicator color – определение цвета указателя цели.
�� Preview transparency – определение прозрачности в окне просмотра. При-

нимает значения от 0 до 95.
�� Preview visual style – определение визуального стиля образца для просмотра.

Рис. 24.7. Палитра локатора положения

Обход чертежа



Глава 24. Определение трехмерных видов590

Облет.чертежа
Команда 3DFLY интерактивно меняет вид трехмерного чертежа, при 
этом кажется, что наблюдатель пролетает сквозь модель. Команда вы-
зывается из падающего меню View → Walk and Fly → Fly.

Облет всей модели, в отличие от обхода, не ограничивается перемещением в 
плоскости XY, поэтому создается ощущение полета над площадью модели.

Работа с командой 3DFLY аналогична работе с командой 3DwALK.

Параметры.обхода.и.облета
Чтобы управлять установками параметров обхода и облета, следует 
использовать диалоговое окно Walk and Fly (рис. 24.8), которое загру-
жается из падающего меню View → Walk and Fly → Walk and Fly Settings….

Рис. 24.8. Диалоговое окно параметров обхода и облета

Здесь настраиваются следующие параметры:

�� В области Settings – определение параметров, относящихся к окну команд 
и Палитре локатора положения:
•� Display instruction balloon: – установка режимов показа окна команд:
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◊� When entering walk and fly modes – каждый раз при включении режимов 
обхода и облета выводится окно управления навигацией обхода и об-
лета Walk and Fly Navigation Mappings;

◊� Once per session – в каждом сеансе AutoCAD при первом входе поль-
зователя в режим обхода или облета на экран будет выводиться 
окно управления навигацией обхода и облета Walk and Fly Navigation 
Mappings;

◊� Never – запрет на вывод окна управления навигацией обхода и облета 
Walk and Fly Navigation Mappings;

•� Display Position Locator window – указывает, будет ли открываться Палит-
ра локатора положения при включении пользователем режима обхода.

�� В области Current drawing settings – определение параметров обхода и об-
лета для текущего чертежа:
•� Walk/fly step size: – определение величины каждого шага в единицах чер-

тежа. Значение хранится в системной переменной STEPSIZE;
•� Steps per second: – определение количества шагов в секунду. Значение 

хранится в системной переменной STEPSPERSEC.

Камера
Команда CAmERA устанавливает камеру и положение цели для соз-
дания и сохранения трехмерного вида объектов в перспективе и вы-
зывается щелчком на пиктограмме Create Camera в группе Camera лен-
ты Visualize рабочего пространства 3D Modeling.

Запросы команды CAmERA:
Current camera settings: Height=0 Lens Length=50 mm – текущие на-

стройки камеры
Specify camera location: – указать положение камеры
Specify target location: – указать положение цели
Enter an option [?/Name/LOcation/Height/Target/LEns/Clipping/View/

eXit]<eXit>: – указать один из ключей или нажать клавишу Enter для заверше-
ния команды

Ключи команды CAmERA:

�� ? – выводит на экран список определенных в настоящее время камер;
�� Name – присваивает камере имя;
�� LOcation – указывает положение камеры, из которой рассматривается 

трехмерная модель;
�� Height – изменяет высоту камеры;
�� Target – указывает рассматриваемый целевой объект камеры;
�� LEns – изменяет фокусное расстояние камеры. Чем больше фокусное рас-

стояние объектива, тем ближе поле зрения;

Камера
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�� Clipping – определяет переднюю и заднюю секущие плоскости и уста-
навливает их значения. Все объекты, расположенные между камерой и 
передней секущей плоскостью, а также за задней секущей плоскостью, не 
отображаются. При этом выдаются следующие запросы:
Current camera settings: Height=0 Lens Length=50 mm – текущие 
настройки камеры
Specify camera location: – указать положение камеры
Specify target location: – указать положение цели
Enter an option [?/Name/LOcation/Height/Target/LEns/Clipping/
View/eXit]<eXit>: C – переход в режим указания секущих плоско-
стей
Enable front clipping plane? [Yes/No] <No>: Y – включить ли 
переднюю секущую плоскость
Specify front clipping plane offset from target plane: – задать 
смещение передней секущей плоскости от целевой плоскости
Enable back clipping plane? [Yes/No] <No>: Y – включить ли зад-
нюю секущую поверхность
Specify back clipping plane offset from target plane: – задать 
смещение задней секущей плоскости от целевой плоскости
Enter an option [?/Name/LOcation/Height/Target/LEns/Clipping/
View/eXit]<eXit>: – указать один из ключей или нажать клавишу Enter 
для завершения команды

�� View – устанавливает текущий вид в соответствии с установками каме-
ры;

�� eXit – прерывает команду.

Камеру, установленную на чертеже, можно включать и выключать, использо-
вать ручки для изменения ее местоположения и цели или фокусного расстояния 
объектива.

Анимация.перемещений.при.обходе.
и.облете
Анимация перемещений обеспечивает предварительный просмотр любого пере-
мещения, включая обход и облет чертежа. Перед созданием анимации перемеще-
ния по траектории необходимо создать образец предварительного просмотра.

Команда ANiPAtH сохраняет анимацию вдоль траектории в трехмер-
ной модели, создавая анимационный файл. Вызывается из падающего 
меню View → Motion Path Animations…. При этом открывается диалого-
вое окно анимации траектории перемещения Motion Path Animation 
(рис. 24.9), которое позволяет настроить следующие параметры.
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Рис. 24.9. Диалоговое окно анимации траектории перемещения

�� В области Camera – настройка камеры:
•� Link camera to: – связывание камеры:

◊� Point – со статической точкой на чертеже;
◊� Path – с траекторией движения на чертеже;
◊� Select Point / Path – осуществление выбора точки местонахождения ка-

меры или траектории вдоль хода перемещения камеры в зависимости 
от того, выбрана точка или траектория.
В списке отображаются наименованные точки или траектории, с ко-
торыми можно связать камеру. Чтобы создать траекторию, необходи-
мо связать камеру с линией, дугой, эллиптической дугой, окружно-
стью, полилинией, трехмерной полилинией или сплайном.
При создании пользователем траектории движения камера создает-
ся автоматически. Если пользователь удаляет объект, созданный им 
в виде траектории движения, наименованная траектория движения 
также удаляется.

�� В области Taget – настройка цели:
•� Link taget to: – связывание цели:

◊� Point – если камера связана с траекторией, эта настройка связывает 
цель со статической точкой на чертеже;

◊� Path – связывание цели с траекторией перемещения на чертеже;
◊� Select Point / Path – осуществление выбора точки или траектории в ка-

честве цели, в зависимости от выбора точки или траектории.

Анимация перемещений при обходе и облете
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В списке отображаются наименованные точки или траектории, с ко-
торыми можно связать цель камеры. Чтобы создать траекторию, не-
обходимо связать цель с линией, дугой, эллиптической дугой, окруж-
ностью, полилинией, трехмерной полилинией или сплайном.

�� Animation settings – управление выводом анимационного файла:
•� Frame rate (FPS): – частота выполнения анимации, измеряемая в кадрах в 

секунду. Следует задать значение от 1 до 60;
•� Number of frames: – общее количество кадров в анимации. Вместе с час-

тотой кадров это значение определяет длительность анимации. Когда 
пользователь изменяет это число, значение продолжительности Duration 
пересчитывается автоматически;

•� Duration (seconds): – продолжительность анимации в секундах. Когда 
пользователь изменяет это число, значение количества кадров Number of 
frames пересчитывается автоматически;

•� Visual style: – список визуальных стилей и наборы параметров тонирова-
ния, которые можно применить к анимационному файлу;

•� Format: – определение формата файла для анимации: AVI, MPG, WMV (до-
ступен, только если установлена программа Microsoft® Windows Media® 
Player версии 9 или выше), MOV (доступен только при установке про-
граммы Apple QuickTime Player);

•� Resolution: – определение ширины и высоты окончательной анимации в 
экранных единицах отображения;

•� Corner deceleration – медленное перемещение камеры при повороте угла;
•� Reverse – изменение направления анимации на обратное.
•� When previewing show camera preview – загрузка диалогового окна пред-

варительного просмотра анимации Animation Preview.
�� Preview… – предварительный просмотр анимации в диалоговом окне пред-

варительного просмотра Animation Preview.
Движение камеры управляется привязкой камеры и ее цели к точке или тра-

ектории.
Для создания неподвижной камеры ее необходимо привязать к точке. Если ка-

мера привязана к траектории, то она будет перемещаться вдоль этой траектории. 
Неподвижность или перемещение цели определяется аналогично. Одновремен-
ная привязка к точке и камеры, и цели не допускается.

Одна и та же траектория используется в том случае, когда анимационный вид 
должен проходить по траектории камеры. В этом случае для параметра траекто-
рии цели устанавливается значение None.

Видовой.куб
Видовой куб – это постоянно присутствующий на экране инструмент навигации, 
отображающийся в одном из углов окна AutoCAD (рис. 24.10). Интерфейс ви-
дового куба активизируется при наведении на него курсора. Щелчком кнопкой 
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мыши и перетаскиванием можно установить новую 
точку зрения на модель. 

Контекстное меню видового куба содержит сле-
дующие параметры (рис. 24.11):

�� Home – восстановление исходного вида, со-
храненного в модели.

�� Parallel – переключение текущего вида на 
параллельную проекцию.

�� Perspective – переключение текущего вида 
на перспективную проекцию.

�� Perspective with Ortho Faces – переключение 
текущего вида на перспективную проек-
цию с ортогональными гранями.

�� Set Current View as Home – определение исходного вида модели на основе 
текущего вида.

�� VewCube Settings… – вызов одноименного диалогового окна регулировки 
отображения и поведения видового куба (рис. 24.12). 

�� Help – вызов интерактивной справочной системы.

В диалоговом окне VewCube Settings настраиваются следующие параметры:

�� В области Display определяется отображение видового куба:
•� On-sceen position: – место видово-

го экрана, в котором отобража-
ется куб (системная переменная 
NAVVCUBELOCATION): Top Right – 
вверху справа; Bottom Right – вни-
зу справа; Top Left – вверху слева; 
Bottom Left – внизу слева;

•� ViewCube size: – размер видово-
го куба (системная переменная 
NAVVCUBESIZE):
◊� Automatic – размер видового куба 

соответствует текущему размеру 
активного видового экрана, мас-
штабному коэффициенту актив-
ного листа или окну чертежа;

◊� Tiny – маленький куб; Small – не-
большой куб; Normal – обычный 
куб; Large – большой куб;

•� Inactive opacity: Low High – управ-
ление прозрачностью неактивно-
го куба (системная переменная 
NAVVCUBEOPACITY);

Рис. 24.10. Видовой куб

Рис. 24.11. Контекстное меню 
видового куба

Видовой куб
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Рис. 24.12. Диалоговое окно регулировки параметров видового куба

•� Show UCS menu – отображение раскрывающегося меню UCS под видо-
вым кубом.

�� В области When dragging on the VewCube – настройка при перетаскивании 
на видовой куб:
•� Snap to closest view – привязать к стандартному ближайшему виду. 

�� В области When clicking on the VewCube – настройка при щелчке на видовом 
кубе:
•� Zoom to extents after view change – принудительная подгонка модели до 

границ текущего видового экрана после изменения вида;
•� Use view transitions when switching views – плавный переход при переклю-

чении между видами;
•� Orient VewCube to current UCS – ориентация видового куба по текущей 

ПСК (системная переменная NAVVCUBEORIENT).
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�� Keep scene upright – сохранение вертикально-
го положения сцены.

�� Show compass below the VewCube – отображе-
ние компаса под видовым кубом.

�� Кнопка Restore Defaults – установка стан-
дартных параметров.

Видовой куб содержит 26 элементов, щелчком на 
которых можно изменить текущий вид модели. Эти 
двадцать шесть элементов разделены на три группы: 
грань, ребро и угол.

Шесть элементов, расположенных на гранях 
куба, соответствуют стандартным ортогональным 
видам модели: TOP – сверху, BOTTOM – снизу, FRONT – 
спереди, BACK – сзади, LEFT – слева и RIGHT– справа 
(рис. 24.13). 

Щелчок на одном из ребер приводит к измене-
нию вида модели на вид, повернутый наполовину, 
основываясь на двух сторонах модели (рис. 24.14).

Щелчок на одном из углов видового куба приво-
дит к изменению ориентации текущего вида модели 
на вид в три четверти, основанный на точке обзора, 
определяемой тремя сторонами модели (рис. 24.15). 

Контур видового куба показан сплошной лини-
ей, если определен один  из стандартных видов, в 
противном случае – контур показан штриховой ли-
нией.

Получить пользовательский вид можно, щелк-
нув на видовом кубе и перетащив его в необходимое 
положение.

Если видовой куб используется при одном ли 
нескольких выбранных объектах, то до окончания 
установки точки взгляда динамично отображаются 
только выбранные объекты.

Видовой куб поддерживает два режима проек-
ций – перспективную (параллельную) и ортого-
нальную, а также комбинацию двух этих режимов – 
перспективную с ортогональными гранями. 

При тонировании модели использование пер-
спективной проекции позволяет получить более 
реа листичный вид.

В случае установки ортогонального вида моде-
ли рядом с видовым кубом отображаются две по-

Рис. 24.13. Грань видового 
куба

Рис. 24.14. Ребро видового 
куба

Рис. 24.15. Угол видового 
куба

Видовой куб
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воротные стрелки, позволяющие повернуть текущий вид на 90 градусов по или 
против часовой стрелки вокруг центра вида, а также четыре прямоугольных тре-
угольника, позволяющих перейти к одному из смежных ортогональных видов 
(рис. 24.16).

Рис. 24.16. Поворотные стрелки видового куба
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В процессе проектирования различных объектов большая часть графических 
работ приходится на формирование каркасных, поверхностных или твердотель-
ных моделей. Как правило, по завершении работы над моделью, а иногда и в про-
цессе проектирования, требуется максимально правдоподобное изображение 
сконструи рованного объекта, то есть должны быть использованы реальные цве-
та, специ фическая текстура поверхности, естественная светотень, перспектива и 
другие эффекты. Это бывает необходимо, например, при предъявлении заказчику 
законченного проекта или при проверке правильности выполнения дизайн-про-
ектирования. Кроме того, визуализация моделей объектов, сформированных в 
AutoCAD, может быть вполне самоценной, в том числе при создании рекламы 
или анимационных клипов. Данный подход в последнее время получил широкое 
распространение благодаря простоте формирования в AutoCAD сложных трех-
мерных объектов. Подготовленные для визуализации трехмерные объекты могут 
быть импортированы вместе с наложенными на их грани цветом и текстурой в 
другие графические пакеты, например 3ds Max.

Решая вопрос о способе представления объекта, следует учитывать, како-
го качества нужно добиться и сколько времени на это потребуется. Например, 
для обычного технического отчета вполне подойдет изображение с подавлен-
ными скрытыми линиями. Для презентаций, дизайнерских проектов, рекламы 
необходимо применять тонирование и подсветку. Чем выше требования к реа-
листичности изображения, тем более сложный алгоритм применяется для его 
формирования: с освещением из одного или нескольких источников света, со 
светотенью, с трассировкой всех световых лучей для достижения абсолютной 
достоверности. 

Визуальные.стили
Стиль отображения – это набор параметров, который управляет отображением 
кромок и теней на видовом экране. Управление визуальными стилями осуществ-
ляется из падающего меню View → Visual Styles или инструментами, расположен-
ными в группе View ленты Home и в группе Visual Styles ленты Visualize рабочего 
пространства 3D Modeling (рис. 25.1, 25.2).

В AutoCAD поддерживаются следующие визуальные стили.

 или  2D Wireframe – двухмерный каркас. Объекты представляются в 
виде отрезков и кривых как кромки граней и тел. Видны растровые и OLE-
объекты, учитываются типы и веса линий (рис. 25.3).

 или  Wireframe – каркас. Объекты представляются в виде отрезков 
и кривых как кромки граней и тел (рис. 25.4).
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 или  Hidden – трехмерный каркас со скрытыми линиями. Объекты 
представляются в каркасном виде. При этом линии, относящиеся к задним 
граням, не отображаются (рис. 25.5).

Рис. 25.1. Инструменты управления визуальными стилями в падающем меню

Визуальные стили
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Рис. 25.2. Инструменты управления визуальными стилями  
в рабочем пространстве 3D Modeling

Рис. 25.3. Визуальный стиль – двухмерный каркас
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Рис. 25.4. Визуальный стиль – трехмерный каркас

Рис. 25.5. Визуальный стиль – трехмерный каркас со скрытыми линиями

Визуальные стили
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 или  Realistic – реалистичный. Раскрашиваются объекты и сгла-
живаются кромки между гранями многоугольника. Отображаются материалы 
объектов (рис. 25.6).

Рис. 25.6. Визуальный стиль – реалистичный

 или  Conceptual – концептуальный. Раскрашиваются объекты и 
сглаживаются кромки между гранями многоугольника. Для раскрашивания 
используется стиль грани по Гучу с переходом не от тени к свету, а между хо-
лодным и теплым цветовыми тонами. Этот эффект менее реалистичен, но он 
лучше отображает подробности модели (рис. 25.7).

Рис. 25.7. Визуальный стиль – концептуальный
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В стилях Realistic и Conceptual грань освещается двумя удаленными источника-
ми, которые перемещаются при изменении направления взгляда на модель.

 или  Shaded – тонированный. Объекты отображаются с использо-
ванием тонирования с плавными переходами (рис. 25.8).

Рис. 25.8. Визуальный стиль – тонированный

 или  Shaded with Edges – тонированный с кромками. Объекты 
отобра жаются с использованием тонирования с плавными переходами, с ви-
димыми кромками (рис. 25.9).

Рис. 25.9. Визуальный стиль – тонированный с кромками

Визуальные стили
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 или  Shades of Gray – оттенки серого. Объекты отображаются с ис-
пользованием тонирования оттенками одного цвета (серого) с плавными пе-
реходами (рис. 25.10).

Рис. 25.10. Визуальный стиль – оттенки серого

 или  Sketchy – эскизный. Объекты отображаются с эффектом ри-
сования от руки (рис. 25.11).

Рис. 25.11. Визуальный стиль – эскизный
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 или  X-Ray – просвечивание. Объекты отображаются частично 
прозрачными (рис. 25.12).

Рис. 25.12. Визуальный стиль – просвечивание

Настройка.стиля.отображения
Стиль отображения можно выбрать в любой момент и при необходимости изме-
нить его параметры или создать собственный стиль, изменяя настройки граней и 
кромок и используя затенение и фон.

Команда VisUALstYLEs загружает Диспетчер визуальных стилей 
Visual Styles Manager (рис. 25.13), предназначенный для создания и из-
менения визуальных стилей и применения их к видовому экрану. Ко-
манда вызывается из падающего меню View → Visual Styles → Visual Style 
Manager… или щелчком на стрелочке справа Visual Style Manager… в груп-
пе Visual Styles ленты Visualize рабочего пространства 3D Modeling.

Диспетчер визуальных стилей содержит поля и инструменты, адаптируемые в 
зависимости от установленного стиля:

�� область Available Visual Styles in Drawing – отображение образцов изображе-
ний визуальных стилей, имеющихся в чертеже. Выбранный стиль отобра-
жается с желтым окаймлением, и нижерасположенные панели содержат 
его параметры;

��  Create New Visual Style – создание нового визуального стиля сопровож-
дается открытием диалогового окна Create New Visual Style, в котором не-

Настройка стиля отображения
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обходимо ввести имя и дополни-
тельное описание создаваемого 
стиля. Новый образец изображе-
ния помещается в конец панели;

��  Apply Selected Visual Style to Cur-
rent Viewport – применение выбран-
ного визуального стиля к текуще-
му видовому экрану;

��  Export the Selected Visual Style to 
the Tool Palette – создается инстру-
мент выбранного визуального сти-
ля и экспортируется в инструмен-
тальную палитру;

��  Delete the Selected Visual Style – 
удаление выбранного визуального 
стиля.

Для визуального стиля двухмерный кар-
кас 2D Wireframe в Диспетчере визуальных 
стилей устанавливаются следующие пара-
метры (см. рис. 25.13).

�� 2D Wireframe options – параметры 
двухмерного каркаса:
•� Contour lines – установка коли-

чества линий контура;
•� Draw true silhouettes – создание 

истинного силуэта.
�� 2D Hide – Occluded ines – параметры скрытых линий:
•� Color – назначение цвета;
•� Linetype – назначение типа линий.

�� 2D Hide – Intersection Edges – параметры ребер пересечений:
•� Show – установка видимости;
•� Color – назначение цвета.

�� 2D Hide – Miscellaneous – другие параметры:
•� Halo gap % – установка коэффициента недовода.

�� Display resolution – параметры экранного разрешения:
•� Arc/circle smoothing – регулировка сглаживания дуг и окружностей;
•� Spline segments – определение количества сегментов сплайна;
•� Solid smoothness – настройка плавности тел.

Для визуального стиля каркас Wireframe в Диспетчере визуальных стилей уста-
навливаются следующие параметры (рис. 25.14).

Рис. 25.13. Диспетчер визуальных 
стилей для двухмерного каркаса
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�� Face Settings – определение па-
раметров внешнего вида граней 
в видовом экране:

•�  кнопка Opacity – измене-
ние значения прозрачности с 
положительного на отрица-
тельное и наоборот;

•� Face style – установка сти-
ля тонирования на гранях 
(системная переменная 
VSFACESTYLE):
◊� Realistic – реалистичный 

стиль с максимально воз-
можным приближением 
отображает то, как грань 
выглядит на самом деле;

◊� Gooch – стиль Гуч опреде-
ляет использование гам-
мы холодных и теплых 
оттенков вместо темных 
и светлых для улучшения  
отображения граней, кото-
рые могли бы быть затене-
ны и плохо видимы в реа-
листичном представлении;

◊� None – стиль не устанавли-
вается;

•� Lighting quality – установка ка-
чества освещения в зависимо-
сти от необходимости отобра-
жения цветов на гранях мо-
дели (системная переменная 
VSLIGHTINGQUALITY):
◊� Faceted – фасетное;
◊� Smooth – сглаживание;
◊� Smoothest – максимальное 

сглаживание;
•� Color – определяет отображение цветов на гранях (системная перемен-

ная VSFACECOLORMODE);
◊� Normal – не применяется к модификатору цвета грани;
◊� Monochrome – отображение модели в оттенках заданного пользовате-

лем цвета (системная переменная VSMONOCOLOR);

Рис. 25.14. Диспетчер визуальных  
стилей для каркаса

Настройка стиля отображения
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◊� Tint – изменяются оттенок и насыщенность цвета грани;
◊� Desaturate – цвет смягчается путем сокращения компоненты его на-

сыщенности на 30%;
•� Monochrome color / Tint Color – установка монохромного цвета или оттенка 

цвета. Данная настройка недоступна, если для цвета грани выбран ре-
жим Normal или Desaturate (системная переменная VSMONOCOLOR);

•� Opacity – управление непрозрачностью и прозрачностью граней в видо-
вом экране (системная переменная VSFACEOPACITY);

•� Material display – управление отображением материалов и текстуры на 
гранях (системная переменная VSMATERIALMODE):
◊� Materials and texture – отображение материалов и текстуры;
◊� Materials – отображение материалов;
◊� Off – отображение материалов и текстуры отключено.

�� Lighting – управление эффектами, связанными с освещением:

•�  кнопка Highlight intensity – изменение значения интенсивности под-
светки с положительного на отрицательное и наоборот;

•� Highlight intensity – регулировка интенсивности подсветок на гранях без 
материалов (системная переменная VSFACEHIGHLIGHT);

•� Shadow display – назначение отображения теней. Для повышения ка-
чества изображения следует отключить тени (системная переменная 
VSSHADOWS): 
◊� Mapped  Object shadow – полные тени;
◊� Ground shadow – только тени на земле;
◊� Off – без теней.

�� Environment Settings – регулировка параметров среды:
•� Backgrounds – назначение отображения фона в видовом экране (систем-

ная переменная VSBACKGROUNDS).
�� Edge Settings – регулировка параметров отображения ребер:
•� Show – установка режима отображения (системная переменная VSEDGES):

◊� Facet Edges – ребра граней;
◊� Isolines – изолинии;
◊� None – ничего;

•� Number of lines – установка количества строк (системная переменная 
ISOLINES);

•� Color – назначение цвета для ребер (системная переменная VSEDGECOLOR);
•� Always on top – поверх остальных окон (системная переменная 

VSISOONNTOP).
�� Occluded Edges – регулировка параметров перекрытых ребер: 
•� Show – отображение перекрытых ребер (системная переменная 

VSOCCLUDEDEDGES);
•� Color – установка цвета для перекрытых ребер (системная переменная 

VSOCCLUDEDCOLOR);
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•� Linetype – установка типа линий для перекрытых ребер (системная пере-
менная VSOCCLUDEDLTYPE).

�� Intersection Edges – регулировка параметров ребер пересечения:
•� Show – отображение ребер пересечения (системная переменная 

VSINTERSECTIONEDGES);
•� Color – установка цвета для ребер пересечения (системная переменная 

VSINTERSECTIONCOLOR);
•� Linetype – установка типа линий для ребер пересечения (системная пере-

менная VSINTERSECTIONLTYPE).
�� Sihouette Edges – регулировка параметров кромок силуэта:
•� Show – отображение ребер силуэта (системная переменная VSSILHEDGES);
•� Width – установка ширины, при которой отображаются ребра силуэта 

(системная переменная VSSILHWIDTH).
�� Edge Modifiers – назначение параметров ребер-модификаторов:

•�  кнопка Line Exstensions edges – включение и отключение эффекта 
выступания отрезков за их пересечения для создания эффекта рисова-
ния от руки;

•�  кнопка Jitter edges – включение и отключение эффекта мерцания 
для придания линиям вида эскизов;

•� Line Exstensions – длина отрезков, выступающих за их пересечения (си-
стемная переменная VSEDGELEX);

•� Jitter – степень мерцания ребер (системная переменная VSEDGEJITTER): 
High – высокое; Medium – среднее; Low – низкое; Off – отключено;

•� Crease angle – определение угла сгиба, при котором кромки внутри грани 
становятся невидимыми, для получения эффекта сглаживания (систем-
ная переменная VSEDGESMOOTH);

•� Halo gap % – назначение коэффициента недовода, который указывает раз-
мер зазора, отображаемого в области покрытия одного объекта другим. 
Данная настройка доступна, если выбраны визуальные стили Conceptual 
или 3D Hidden. Если значение коэффициента недовода больше 0, ребра 
силуэта не отображаются (системная переменная VSHALOGAP).

Отображением граней модели управляют эффекты затенения и цвета.
Стиль грани определяет затенение грани: реальный – означает создание реа-

листичного эффекта, Гуч – лучше отображает детали, смягчая контраст между 
освещенными и затененными областями. В освещенных областях используются 
теплые оттенки, а в темных областях – холодные.

Мягкое освещение сглаживает кромки между гранями многоугольника, что 
придает объектам реалистичный вид с гладкими переходами. При освещении гра-
ней объекты выглядят более плоскими и менее гладкими.

Размер источников подсветки объекта влияет на ощущение блеска. При ис-
пользовании меньших и более ярких источников подсветки объекты выглядят 
блестящими.

Настройка стиля отображения



Глава 25. Создание реалистичных изображений612

Цвет может отображаться, как обычно, либо можно изменить режим цвета гра-
ни. В монохромном режиме все грани отображаются одним и тем же цветом с оди-
наковым оттенком. В режиме цветовых оттенков используется один и тот же цвет 
для раскрашивания всех граней с изменением значений оттенка и интенсивности 
цвета. Режим разбавления смягчает цвета.

Стиль отображения определяет также отображение фонов и теней на видовом 
экране. В качестве фона на видовом экране можно применять цвет, градиентную 
заливку или изображение в любом из стилей трехмерного отображения. Чтобы 
использовать фон, необходимо вначале создать именованный вид с фоном и уста-
новить его в качестве текущего.

Для затеняемых объектов на видовом экране возможно отображение теней, от-
брасываемых объектами на землю или на другие объекты.

Кромки разных типов отображаются с использованием линий различного типа 
и цвета либо с мерцанием и выступом за кромки, что придает линиям такой вид, 
будто они нарисованы карандашом вручную.

Подготовка.моделей.для.тонирования
Тонированные изображения выглядят более реалистично, чем рисунки с при-
мененными визуальными стилями. Операция тонирования позволяет получить 
изображения, в некоторых случаях даже более качественные, чем выполненные 
красками, цветными карандашами или тушью.

Тонирование обычно представляет отдельную задачу при создании проекта и 
выполняется в несколько этапов.

1. Подготовка моделей объектов для тонирования – на этом этапе важно про-
контролировать способы формирования объектов и задать настройки точ-
ности отображения.

2. Определение освещения моделей – необходимо создать источники света и 
настроить их соответственно текущей задаче.

3. Определение материалов для поверхности объектов – следует задать или 
выбрать из библиотеки отражательные характеристики материалов и при-
своить их видимым поверхностям.

4. Тонирование – обычно эта операция повторяется многократно, с измене-
нием различных настроек и возвратом к предыдущим этапам, пока не будет 
достигнут желаемый результат.

Такое деление на этапы достаточно условно; в реальной работе перечисленные 
операции часто неотделимы друг от друга и необязательно выполняются в выше-
описанном порядке.

Важный этап процесса тонирования – подавление скрытых поверхностей, так 
как тонирование скрытых поверхностей и поверхностей заднего плана не имеет 
смысла. Чтобы можно было установить, передней или задней является грань, в 
AutoCAD используется нормаль к каждой из граней.
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Направление нормали определяется тем, как нарисована грань в правоориен-
тированной системе координат, принятой в AutoCAD. Если углы грани заданы в 
направлении против часовой стрелки, нормаль направлена наружу; если по часо-
вой стрелке – внутрь. Тонирование выполняется быстрее, если все нормали к гра-
ням обращены в одну сторону. Твердотельные объекты имеют заведомо правильно 
ориентированные сети и нормали, что очень удобно для задач тонирования.

Все грани следует рисовать одним и тем же методом: смешение способов ри-
сования может привести к непредсказуемым результатам. Во время тонирования 
AutoCAD вычисляет все нормали, направленные от точки зрения, и удаляет из 
сцены связанные с ними многоугольники. Этот процесс называется подавлением 
задних граней.

После того как задние грани подавлены, AutoCAD сравнивает относительные 
расстояния по оси Z. Если одна из граней перекрывает другую, AutoCAD подавля-
ет невидимую грань.

Особое внимание при создании модели следует уделить пересекающимся гра-
ням. Рекомендуется использовать логические операции объединения, пересече-
ния и вычитания. В этом случае кромки на тонированном изображении выглядят 
более точными и аккуратными.

При наличии в созданной модели копланарных, то есть лежащих в одной плос-
кости и перекрывающих друг друга, граней при визуализации также могут воз-
никнуть проблемы, особенно если этим граням присвоены разные материалы. 
В данном случае рекомендуется сместить объекты друг относительно друга.

Кроме того, при создании моделей следует избегать скрученных на 180°�и по-
этому самоперекрывающихся граней, поскольку возникает неопределенность на-
правления нормалей и результат визуализации такой модели может быть непред-
сказуем.

Большое значение при визуализации модели имеет плотность сети. Сглажива-
ние объекта выполняется системой визуализации автоматически. При визуализа-
ции существуют два типа сглаживания: интерполяция нормалей к граням поверх-
ности и учет числа граней, определяющих геометрию. Чем больше число граней, 
тем более гладкими получаются поверхности, но увеличивается время обработки. 

Интерполяцией нормалей к граням управлять нельзя, однако можно изменять 
точность отображения криволинейных объектов с помощью системной перемен-
ной FACETRES, которая регулирует плотность сети и гладкость тонированных и 
визуализированных тел с криволинейными поверхностями. 

Команды, предназначенные для формирования реалистичного тонирования, 
вызываются из падающего меню View → Render (рис. 25.15). В рабочем простран-
стве 3D Modeling команды тонирования расположены на ленте Visualize (рис. 25.16).

Команда RENDER осуществляет тонирование. Она вызывается из 
падающего меню View → Render → Render или щелчком на пиктограм-
ме Render to Size в группе Render ленты Visualize рабочего пространства 
3D Modeling.

Подготовка моделей для тонирования
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Рис. 25.15. Команды реалистичного тонирования в падающем меню

Рис. 25.16. Команды реалистичного тонирования на ленте Visualize

Выполните упражнение Ren1 из раздела 5.

Команда RPREF осуществляет подготовку параметров для тонирова-
ния. Она вызывается из падающего меню View → Render → Advanced 
Render Settings... или щелчком на стрелочке слева Render Preset Manager в 
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группе Render ленты Visualize рабочего пространства 3D Modeling. При этом за-
гружается палитра RENDER PRESETS MANAGER (рис. 25.17).

Рис. 25.17. Палитра настройки параметров тонирования

На этапе тонирования трехмерной модели важна техника построения моде-
ли объекта. Рекомендуется применять для этого однотипные методы. Не следует 
строить, например, модели зданий, одни стены которых представляют собой гра-
ни, другие – выдавленные отрезки, а третьи – каркасные сети.

К твердотельным моделям не рекомендуется добавлять двухмерные и трехмер-
ные грани, а также трехмерные поверхности. Не всегда приемлемо добавление 
двухмерных и трехмерных граней, если модель состоит из трехмерных поверхно-
стей. Впрочем, эти рекомендации даются только для упрощения процесса тониро-
вания: даже если модель сформирована из произвольно ориентированных поверх-
ностей, ее можно корректно тонировать (правда, тогда на это потребуется гораздо 
больше времени).

Время, необходимое для построения тонированного изображения, зависит от 
количества граней и вершин объектов. Любая криволинейная поверхность, ис-
пользуемая в процессе тонирования, предварительно разбивается на грани – тре-
угольные и четырехугольные участки плоскости с вершинами в углах граней. При 
минимизации количества граней процесс значительно упрощается: чем проще 
структура поверхности, тем меньше времени тратится на определение цвета каж-
дого пикселя грани.

Подготовка моделей для тонирования
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Управление точностью и разрешением отображения тонированных моделей 
осуществляется с помощью команды ViEwREs. Величина точности аппроксима-
ции, которая устанавливается этой командой, влияет на плавность линий, фор-
мирующих окружности, дуги и эллипсы. AutoCAD отображает такие фигуры на 
экране в виде множества коротких прямолинейных сегментов. Чем выше точность 
аппроксимации, тем плавнее дуги и окружности, но одновременно продолжитель-
нее процесс их регенерации. Если окружности на рисунке похожи на многоуголь-
ники, они и после тонирования останутся такими же. Для повышения произво-
дительности рекомендуется в ходе рисования устанавливать как можно меньшую 
точность аппроксимации, а перед тонированием увеличить ее для достижения 
требуемого качества.

Как уже говорилось ранее, плавность линий, образующих тонированные тела 
с криволинейными поверхностями, регулирует системная переменная FACETRES. 
Она связана с точностью аппроксимации, заданной в команде ViEwREs. Если 
значение системной переменной FACETRES равно 1, степень аппроксимации кри-
волинейных поверхностей тел равна степени аппроксимации окружностей, дуг и 
эллипсов. Если этой переменной присвоить значение 2, точность аппроксимации 
для тел будет вдвое выше, чем для окружностей, дуг и эллипсов, и т. д. По умолча-
нию FACETRES установлена в 0.5. Диапазон допустимых значений – от 0.01 до 10.

Настройка тонирования для различных режимов определяется качеством 
изображения, которое может предоставить используемый компьютер. Основные 
параметры, влияющие на качество отображения, – разрешение экрана дисплея и 
глубина цветности – зависят как от типа выбранного для компьютера монитора, 
так и от типа установленной видеокарты.

В палитре RENDER PRESETS MANAGER можно настроить следующие параметры.

 Кнопка Render – запуск процесса тонирования.

Render  in: – назначение выходного адреса для вывода тонированного изобра-
жения: Window – в отдельное окно Render; Viewport – на один из видовых экра-
нов; Region – части объекта на один из видовых экранов.

Render  Size: – текущее значение разрешения формата вывода для тонирован-
ного изображения.

Current Preset: – текущий набор параметров.

Preset Info – сведения о наборе параметров: Name: –название и Description: –опи-
сание.

�� Render Duation – длительность визуализации:
•� Until Satisfactory – до получения удовлетворительных результатов, пока 

пользователь не отменит операцию; 
•� Render By Level: – визуализация по уровню;
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•� Render By Time: – визуализация по времени;
�� Lights and Materials – источники света и материалы:
•� Render Accuracy: – качество визуализации: Low – низкое; Draft – черновое; 

High – высокое.

Освещение
Для получения реалистичного тонированного изображения в AutoCAD предо-
ставляется возможность создавать, перемещать и настраивать источники света. 
Задавая источники света, а также материалы поверхности объектов, можно до-
биваться всех необходимых эффектов, связанных с цветом, отражением и свето-
тенью.

Установка в рисунке источников света – простейший способ улучшить внеш-
ний вид тонированных моделей. Источник может освещать либо всю модель, либо 
выбранные объекты рисунка и их части.

Во время работы в окне просмотра в трехмерном раскрашенном виде освеще-
ние по умолчанию подается из двух точек, которые перемещаются вслед за движе-
нием модели. Все поверхности модели освещаются таким образом, чтобы визуаль-
но отличаться друг от друга. Можно по желанию установить интенсивность света 
или совсем отключить его, если необходимо показать солнечное освещение или 
освещение, созданное пользователем. Обычно задается низкая интенсивность, 
так как при высокой изображение может оказаться размытым. Сам по себе рассе-
янный свет не дает реалистичного изображения. Стыки между смежными гранями 
не видны, так как все грани освещаются одинаково. Данный тип освещения чаще 
всего используют как вспомогательное средство для подсветки поверхностей, на 
которые не попадает направленный свет.

Для моделирования более реалистичной сцены используется фотометрическое 
освещение, при создании которого характеристики распространения источников 
света и их цвета импортируются из файлов, предоставляемых производителями 
осветительных приборов. 

В AutoCAD имеются следующие виды источников света: точечные, прожекто-
ры, удаленные.

Инструменты создания и настройки источников света находятся в падающем 
меню View → Render → Light (рис. 25.18). Также команды создания источников све-
та расположены в группе Lights ленты Visualize рабочего пространства 3D Modeling 
(рис. 25.19).

Точечный.источник.света
Точечный источник света – испускает лучи во всех направлениях; интенсивность 
света от него уменьшается с расстоянием. Такие источники удобны для имитации 
света электрических ламп (рис. 25.20). Их широко используют для создания об-

Точечный источник света
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щих эффектов освещения, зачастую в комбинации с прожекторами. Кроме того, 
точечные источники подходят в качестве вспомогательных для подсветки отдель-
ных поверхностей как альтернатива рассеянному свету.

Рис. 25.18. Инструменты создания и настройки источников света в падающем меню

Рис. 25.19. Инструменты создания источников света  
в рабочем пространстве 3D Modeling
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Рис. 25.20. Пример использования точечного источника света

Формирование нового точечного источника света осуществляется 
командой POiNtLiGHt, вызываемой из падающего меню View → 
Render → Light → New Point Light или щелчком на пиктограмме New 
Point Light панели инструментов Lights или Render.

Для точечного источника света предусмотрены дополнительные свойства, 
при этом необходимо, чтобы системная переменная LIGHTINGUNITS имела значе-
ние 1 – американская система единиц или 2 – международная система единиц СИ. 

Запросы команды POiNtLiGHt:

Specify source location: – задать положение источника света
Enter an option to change [Name/Intensity factor/Status/Photometry/

shadoW/Attenuation/filterColor/eXit]<eXit>: – ввести название изменяемо-
го режима

Ключи команды POiNtLiGHt:

�� Name – имя источника света, в котором можно использовать буквы верхне-
го и нижнего регистра числа, пробелы, дефисы и символы подчеркивания. 
Длина имени не должна превышать 256 символов;

�� Intensity factor – установка интенсивности источника света, которая 
может изменяться от 0 до максимального значения, поддерживаемого в 
пользовательской системе;

�� Status – включение и выключение источника света;

Точечный источник света



Глава 25. Создание реалистичных изображений620

�� Photometry – измерение силы света видимых источников. При этом ко-
манда выдает следующие запросы:
Specify source location: – задать положение источника света
Enter an option to change [Name/Intensity 
factor/Status/Photometry/shadoW/Attenuation/filterColor/eXit] 
<eXit>: P – включение режима фотометрии
Enter a photometric option to change [Intensity/Color/eXit] <I>: – 
ввести изменяемый параметр фотометрии

•� Intensity – интенсивность в канделах. Кандела – единица силы све-
та, то есть воспринимаемая мощность, излучаемая источником света в 
определенном направлении (кд/ср – кандела на стерадиан). Команда 
выдает следующие запросы:
Enter intensity (Cd) or enter an option [Flux/Illuminance]: – 
ввести значение интенсивности в канделах
◊� Flux – значение воспринимаемой энергии через значение светового 

потока в люксах. Люкс – единица освещенности в системе СИ (лм/м2 –  
люмен на квадратный метр);

◊� Illuminance – интенсивность источника света на основе значения 
освещенности в фут-канделах. Фк – единица освещенности, приня-
тая в США (лм/фут2 – люмен на квадратный фут)

•� Color – задайте цветовую характеристику света, выражаемую через имя 
цвета или через температуру по шкале Кельвина;

•� eXit – выйти из режима фотометрии
�� shadoW – включение отбрасывания теней от источника света. При этом 

команда выдает следующие запросы:
Specify source location: – задать положение источника света
Enter an option to change [Name/Intensity factor/Status/
Photometry/shadoW/Attenuation/filterColor/eXit] <eXit>: W – вклю-
чение режима отбрасывания теней
Enter shadow settings [Off/Sharp/soFt] <Sharp>: – ввести парамет-
ры теней
•� Off – отключение отображения и вычисления теней для источника света;
•� Sharp – отображение теней с резким изображением кромок;
•� soFt – отображение теней с мягким изображением кромок с текстурой.

�� Attenuation – настройка затухания. При этом команда выдает следую-
щие запросы:
Specify source location: – задать положение источника света
Enter an option to change [Name/Intensity factor/Status/
Photometry/shadoW/Attenuation/filterColor/eXit] <eXit>: A – пере-
ход в режим настройки затухания
Enter an option to change [attenuation Type/Use limits/attenuation 
start Limit/attenuation End limit/eXit] <eXit>: – указать один из 
ключей
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•� attenuation Type – назначение типа затухания, то есть спада освеще-
ния. Чем дальше от источника располагается объект, тем темнее он вы-
глядит. None – затухание отсутствует, далекие и близкие к источнику 
света объекты освещаются одинаково; Inverse linear – линейная инвер-
сия, при которой затухание обратно пропорционально расстоянию от 
источника света до объекта; inverse Squared – квадратичная инверсия, 
при которой затухание обратно пропорционально квадрату расстояния 
от источника света до объекта;

•� Use limits – использование пределов затухания;
•� attenuation start Limit – начальный предел затухания. При этом 

указывается точка начала освещения в виде смещения от центра источ-
ника света;

•� attenuation End limit – конечный предел затухания. При этом ука-
зывается точка конца освещения в виде смещения от центра источника 
света. Далее этой точки свет не распространяется.

�� filterColor – назначение цвета источнику света. При этом команда вы-
дает следующие запросы:
Specify source location: – задать положение источника света
Enter an option to change [Name/Intensity factor/Status/Pho-
tometry/shadoW/Attenuation/filterColor/eXit] <eXit>: C – переход 
в режим настройки цвета освещения
Enter true color (R,G,B) or enter an option [Index color/Hsl/
colorBook]: – указать цвет из палитры в формате R, G, B – красный, зе-
леный, синий, или выбрать один из ключей:
•� Index color – указать цвет ACI, то есть цветовой индекс AutoCAD;
•� Hsl – указать оттенок, насыщенность и яркость цвета;
•� colorBook – указать цвет из альбома;

�� eXit – завершение команды.

Прожектор
Прожектор – испускает направленный конус света, интенсивность которого с рас-
стоянием уменьшается (рис. 25.21). Имеется возможность задавать направление 
света и размер конуса. В пучке света прожектора различают полный конус и яр-
кое пятно. Попадая на освещаемую поверхность, свет от прожектора дает в центре 
пятно максимальной освещенности, окруженное переходной областью, где интен-
сивность меньше. Прожекторы применяют для выборочной подсветки отдельных 
элементов и областей модели.

Создание нового прожектора осуществляется командой sPOtLiGHt, 
вызываемой из падающего меню View → Render → Light → New Spotlight 
или щелчком на пиктограмме New Spotlight на панели инструментов 
Lights или Render.

Прожектор
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Рис. 25.21. Пример использования прожектора

Запросы команды sPOtLiGHt:
Specify source location: – задать положение источника света
Specify target location: – задать положение цели
Enter an option to change [Name/Intensity factor/Status/Photometry/

Hotspot/Falloff/shadoW/Attenuation/filterColor/eXit] <eXit>: – ввести 
имя режима

Ключи команды sPOtLiGHt аналогичны ключам команды формирования 
точечного источника света POiNtLiGHt. Добавлены следующие ключи:

�� Hotspot – задание угла, определяющего конус наиболее яркого света. До-
пустимый диапазон – от 0 до 60°;

�� Falloff – назначение спада освещенности, то есть угла, определяющего 
полный конус света, называемый также угловым полем. Может прини-
мать значения от 0 до 160°, но при этом быть больше или равным углу 
яркого пятна.

Пространство между ярким пятном и полным световым конусом иногда назы-
вают областью спада освещенности. Чем больше разница между ярким пятном и 
полным световым конусом, тем мягче граничная кромка освещаемого пятна. Если 
эти величины равны, освещаемое пятно очерчивается резкой кромкой. Угловая 
величина яркого пятна не может превышать угол полного светового конуса; оба 
значения могут варьироваться в пределах от 0 до 160°. 
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Удаленный.источник.света
Удаленный источник света – испускает параллельные лучи только в одном на-
правлении (рис. 25.22). Лучи не имеют ни начала, ни конца и распространяются 
бесконечно с обеих сторон от источника. Интенсивность света не уменьшается с 
расстоянием: каждая поверхность освещена так же ярко, как и вблизи источника.

Рис. 25.22. Пример использования удаленного источника света

Положение удаленного источника света на рисунке несущественно – имеет 
значение только направление лучей. Все объекты на рисунке освещены, в том чис-
ле и находящиеся за источником. Удаленный свет распространяется так, как если 
бы он шел из точки, находящейся за пределами рисунка. Во избежание путаницы 
лучше всегда помещать источник удаленного света за пределами модели.

Удаленный источник света особенно удобен для равномерного освещения 
объектов или заднего плана сцены, а также для имитации солнечного света. По-
скольку удаленные источники для имитации Солнца применяются очень широко, 
особенно в архитектурных проектах, в фотореалистичных режимах тонирования 
предусмотрено специальное средство для расчета положения Солнца на основе 
времени суток и географических координат.

Создание нового удаленного источника света осуществляется коман-
дой DistANtLiGHt, вызываемой из падающего меню View → Render → 
Light → New Distant Light или щелчком на пиктограмме New Distant Light 
на панели инструментов Lights или Render.

Удаленный источник света
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Запросы команды DistANtLiGHt:
Specify light direction FROM <0,0,0> or [Vector]: – указать направле-

ние светового луча от точки 0,0,0 или задать вектор
Specify light direction TO <1,1,1>: – указать направление светового 

луча к точке 1,1,1
Enter an option to change [Name/Intensity factor/Status/Photometry/

shadoW/ filterColor/eXit] <eXit>: – ввести имя режима

Ключи команды DistANtLiGHt аналогичны ключам команды формирования 
точечного источника света POiNtLiGHt.

Свойства.солнца
Солнечный свет – это особый вариант 
удаленного освещения, который создает 
эффект естественного света. Угол сол-
нечного освещения определяется гео-
графическим местоположением, а также 
датой и временем, которые задаются для 
конкретной модели. Лучи солнечного 
света параллельны и имеют одинаковую 
интенсивность на всем протяжении.

В фотометрическом режиме поддер-
живается также имитация неба, что позво-
ляет создать эффект мягкого рассеянного 
света, формируемого в результате взаимо-
действия солнечных лучей с атмосферой.

Настройка солнечного осве-
щения осуществляется ко-

мандой sUNPROPERtiEs, вызывае-
мой из падающего меню View → 
Render → Light → Sun Properties или 
щелчком на стрелочке справа Sun 
Properties в группе Light Sun & Location 
ленты Visualize рабочего простран-
ства 3D Modeling. При этом загружает-
ся палитра свойств солнца SUN 
PROPERTIES (рис. 25.23).

В этой палитре настраиваются следую-
щие параметры.

�� General – определение основных 
свойств солнца: Рис. 25.23. Палитра свойств солнца



625

•� Status – включение и отключение солнца;
•� Intensity Factor – установка интенсивности или яркости солнца;
•� Color – управление цветом солнечного освещения;
•� Shadows – включение и отключение отображения и расчета теней от 

солнца.
�� Sky Properties – определение свойств неба:
•� Status – включение и отключение вычисления освещенности неба;
•� Intensity Factor – усиление эффекта верхнего света;
•� Haze – усиление эффекта дымки в атмосфере. Диапазон значений от 0 

до 15.
�� Horizon – определение внешнего вида и расположения горизонта:
•� Height – определение высоты горизонта. Диапазон значений от –10 

до +10;
•� Blur – степень размывания между нулевой плоскостью и небом. Диапа-

зон значений от 0 до 10;
•� Ground color – определение цвета земли.

�� Advanced – определение дополнительных художественных эффектов:
•� Night color – определение цвета ночного неба;
•� Aerial perspective – использование воздушной перспективы;
•� Visibility distance – определение расстояния, на котором происходит 10% 

ухудшение видимости из-за дымки.
�� Sun disk appearance – определение вида солнечного диска:
•� Disk scale – масштаб солнечного диска;
•� Glow intensity – интенсивность свечения солнца;
•� Disk intensity – интенсивность солнечного диска.

�� Sun Angle Calculator – определение параметров положения солнца:
•� Date – настройка текущего значения даты. Щелчком на кнопке с много-

точием, расположенной в правой части строки, загружается диалоговое 
окно Calendar, содержащее календарь;

•� Time – настройка текущего значения времени;
•� Daylight Savings – настройка летнего времени;
•� Azimuth – отображение азимута, угла солнца над горизонтом по часовой 

стрелке от направления на север;
•� Altitude – широта, угол солнца по вертикали над горизонтом;
•� Source Vector – отображение координат исходного вектора направления 

солнца.
�� Rendered Shadow Details – настройка свойств теней:
•� Type – настройка типа тени: Sharp – резкие, Soft – мягкие;
•� Samples – установка размера текстуры тени;
•� Softness – настройка смягчения отображения кромок теней.

�� Geographic Location – отображение текущих параметров географического 
положения:
•� City: – город;

Свойства солнца
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•� Time Zone: – часовой пояс;
•� Latitude: – широта;
•� Latitude Direction: – направление широты;
•� Longitude: – долгота;
•� Longitude Direction: – направление долготы.

Сеточный.свет
Для создания реалистичной сцены при визуализации рекомендуется использовать 
сеточный свет (световую сетку), который можно смоделировать с помощью фото-
метрических источников с параметрами, характерными для реальных источников 
света. При этом источник света располагается в центре фотометрической сетки.

Именно источники сеточного света позволяют получить анизотропное, то есть 
неравномерное, распределение освещенности, вычисленное на основе данных, ко-
торые предоставляют изготовители реальных источников света. 

Создание нового источника сеточного света осуществляется коман-
дой wEBLiGHt, вызываемой щелчком на пиктограмме Weblight в 
группе Lights ленты Visualize рабочего пространства 3D Modeling (см. 
рис. 25.19).

Запросы команды wEBLiGHt:
Specify source location <0,0,0>: – задать положение источника света
Specify target location <0,0,-10>: – задать положение цели
Enter an option to change [Name/Intensity factor/Status/Photometry/

weB/shadoW/filterColor/eXit] <eXit>: – ввести имя режима

Ключи команды wEBLiGHt аналогичны ключам команды формирования то-
чечного источника света POiNtLiGHt. Добавлен следующий ключ:

�� weB – задание интенсивности света в точках сферической сетки. При этом 
выдается запрос:
Enter a Web option to change [File/X/Y/Z/Exit] <Exit>: – ввести 
имя режима

�� File – имя сеточного файла с расширением IES, который следует исполь-
зовать для определения свойств сетки;

�� X,Y,Z – задание поворота сетки вокруг осей X, Y, Z.

Назначение.материалов
Чтобы сделать тонированные изображения более правдоподобными, необходимо 
придать поверхностям объектов оптические свойства различных материалов. Ма-
териалы могут быть как реальными, так и не существующими в природе. В первом 
случае подбирают характеристики таким образом, чтобы они соответствовали ка-
кому-либо металлу или пластмассе, стеклу и т. д.
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Библиотека стандартных материалов AutoCAD содержит большой набор ма-
териалов и текстур, для использования которых служит обозреватель материалов. 
Если имеющийся набор не удовлетворяет разработчика, он может, используя ре-
дактор материалов, сам создать материал, соответствующий его требованиям.

Материалы, определенные в AutoCAD, можно связывать с конкретными объ-
ектами, индексами цветов AutoCAD, блоками и слоями.

Важным элементом определения материала является цвет. Работа с цветом на 
компьютере отличается от привычной всем техники работы с красками или ка-
рандашами.

Цвета большинства предметов реального мира связаны с так называемыми 
пигментами. Например, когда солнечный свет попадает на лепесток розы, послед-
ний поглощает все цвета спектра, кроме красного, который отражается и тем са-
мым становится виден наблюдателю. Если предмет отражает все цвета спектра, 
поверхность его кажется белой, если не отражает ни одного – черной. Базовыми 
пигментами считаются красный, желтый и синий. Смешение двух базовых пиг-
ментов дает производные цвета: оранжевый (красный и желтый), зеленый (жел-
тый и синий), фиолетовый (красный и синий). Художник, смешивая краски на 
палитре, работает с пигментами.

Если объект представляет собой источник света, он испускает лучи, а не отра-
жает их. Цвета, которые мы видим на мониторе компьютера, являются цветами из-
лучения, а не пигментами. Из них базовыми считаются красный, зеленый и синий. 
По первым буквам английских слов, означающим эти цвета, компьютерная цвето-
вая модель получила название RGB: red – красный, green – зеленый, blue – синий. 
Производные цвета излучения – желтый (красный и зеленый), голубой (зеленый 
и синий), пурпурный (красный и синий). Совокупность всех цветов излучения 
дает белый цвет, полное отсутствие излучения – черный.

Кроме системы RGB, в компьютерах применяется система HLS, получив-
шая свое название по первым буквам слов hue – оттенок, lightness – яркость, 
saturation – насыщенность. В ней цвет выбирается из диапазона допустимых от-
тенков, а затем производится регулировка его яркости и насыщенности – уровня 
содержания черного.

Важная характеристика при определении материала – зависимость цвета по-
верхности от освещения. В реальной жизни те части объектов, которые располо-
жены под малыми углами к падающему на них световому лучу, кажутся более тем-
ными. Те же части, которые перпендикулярны световым лучам, представляются 
более яркими, иногда даже белыми (бликующими), независимо от цвета объектов 
и от источника света.

В AutoCAD предусмотрен гибкий подход к определению поверхности объектов, 
базирующийся на определенном наборе ее оптических характеристик. Задать ма-
териал поверхности тела в AutoCAD – значит определить следующие параметры:

�� основной цвет/текстуру поверхности;
�� цвет рассеянного освещения;

Назначение материалов
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�� отраженный цвет/текстуру бликов;
�� шероховатость поверхности материала;
�� прозрачность материала, которую можно задать текстурой прозрачности;
�� преломление прозрачного материала;
�� текстуру выдавливания поверхности, определяющую эффект рельефа.

Когда в AutoCAD говорится о текстуре, это означает, что может существовать 
растровый файл, цветовая карта которого используется полностью или частично 
с целью неравномерного распределения по поверхности цвета, прозрачности или 
рельефа.

Команда mAtBROwsEROPEN, загружающая обозреватель материа-
лов Materials Browser (рис. 25.24), вызывается из падающего меню 
View → Render → Materials Browser или щелчком на пиктограмме Materials 
Browser в группе Materials ленты Visualize рабочего пространства 
3D Modeling. 

Рис. 25.24. Обозреватель материалов



629

Обозреватель материалов Materials Browser применяется для операций с библио-
теками материалов, а также для поиска и сортировки материалов в библиотеках 
и на чертеже.

�� Document Materials: – описание материалов, применяющихся в открытом 
чертеже: Show All – показать все; Show Applied – показать используемые; 
Show Selected – показать выбранные; Show Unused – показать неиспользуе-
мые; Purge All Unused – удалить 
все неиспользуемые.

�� Autodesk Library – стандартная си-
стемная библиотека, содержащая 
материалы, разработанные ком-
панией Autodesk.

�� My Materials – библиотека материа-
лов, созданная пользователем. 

��  – доступ к операциям соз-
дания и редактирования библио-
тек материалов: Open Existing 
Library – открыть существующую 
библиотеку; Create New Library – 
создать библиотеку; Remove 
Library – удалить библиотеку; 
Create Category – создать катего-
рию; Delete Category – удалить ка-
тегорию; Rename – переимено-
вать.

��  Opens/Closes materials editor – 
загрузка диалогового окна редак-
тора материалов Materials Editor 
(рис. 25.25).

Команда mAtEDitOROPEN, позволяющая определять материалы, вы-
зывается из падающего меню View → Render → Materials Editor. Эта коман-
да загружает редактор материалов Materials Editor (см. рис. 25.25).

Вкладка Appearance содержит элементы управления, позволяющие редактиро-
вать свойства материала.

��  Scene – выбор формы образца для просмотра и качества тонирования: 
Sphere – шар; Cube – куб; Cylinder – цилиндр; Canvas – полотно; Plane – 
плос кость; Object – объект; Vase – ваза; Draped Fabric – драпировка, ткань; 
Glass Curtain Wall – навесная стена, стекло; Walls – стены; Pool of liquid – ре-
зервуар с жидкостью; Utility – кладовая; Torus – тор (рис. 25.26).

Рис. 25.25. Диалоговое окно 
определения материалов

Назначение материалов
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Содержимое редактора материалов зави-
сит от типа выбранного материала и шабло-
на. Для типового материала Global доступны 
следующие параметры (см. рис. 25.25).

�� Generic – настройка типовых пара-
метров:
•� Color – установка цвета;
•� Image – установка изображения 

(рис. 25.27):
•� Image – изображение;

◊� Checker – клетка;
◊� Gradient – градиент;
◊� Marble – мрамор;
◊� Noise – шум;
◊� Speckle – рябь;
◊� Tiles – мозаика;
◊� Waves – волны; 
◊� Wood – дерево;
◊� Edit Image… – загрузка адап-

тируемой палитры редакти-
рования изображения Texture 
Editor – Color;

◊� Remove Image – удалить изобра-
жение;

•� Image Fade – управление компо-
зицией базового цвета и диффуз-
ного изображения. Диффузный 
цвет – это цвет, отражаемый объ-
ектом при освещении;

•� Glossiness – отражающая способ-
ность поверхности материала, 
определяющая степень ее глянца 
или матовости. Загрузка адап-
тируемой палитры редактирова-
ния изображения Texture Editor – 
Glossiness;

•� Highlights – управление цветом 
бликов на материале.

�� Reflectivity – управление уровнем 
отражательной способности и ин-
тенсивности цвета блика на поверх-
ностях:

Рис. 25.26. Выбор формы образца 
материалов

Рис. 25.27. Выбор изображения 
материалов
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•� Direct – регулятор прямой. Загрузка адаптируемой палитры редактиро-
вания изображения Texture Editor – Direct;

•� Oblique – регулятор под углом. Загрузка адаптируемой палитры редак-
тирования изображения Texture Editor – Oblique.

�� Transparency – настройка параметров прозрачности материала:
•� Amount – регулятор количества света, проходящего через поверхность;
•� Image – установка изображения;
•� Image Fade – управление композицией изображения и величины про-

зрачности;
•� Translucency – регулятор полупрозрачности, то есть доли света в процен-

тах, поглощаемого и вновь излучаемого при прохождении через поверх-
ность;

•� Refraction – регулятор степени преломления светового луча при про-
хождении через поверхность: Air – воздух; Water – вода; Alcohol – спирт; 
Quartz – кварц; Glass – стекло; Diamond – алмаз; Custom – пользователь-
ский.

�� Cutouts – настройка вырезаемых участков управляет эффектами перфора-
ции материала. 

�� Self Illumination – настройка параметров самосвечения:
•� Filter Color – регулятор создания эффекта светофильтра вокруг светя-

щейся поверхности;
•� Luminance – регулятор имитации освещения материала фотометриче-

ским источником света: Dim Glow – тусклое свечение; LED Panel – све-
тодиодная панель; LED Screen – светодиодный экран; Cell Phone Screen – 
экран сотового телефона; CRT Television – телевизор с ЭЛТ; Lamp Shade 
Exterior – наружная сторона абажура; Lamp Shade Interior – внутренняя 
сторона абажура; Desk Lamp Lens – рассеиватель настольной лампы; Halo-
gen Lamp Lens – рассеиватель галогенной лампы; Frosted Bulb – матиро-
ванная лампа; Custom – пользовательский;

•� Color Temperature – регулятор цветовой температуры, определяющей 
цвет самосвечения: Candle – канделы; Incandescent Bulb – лампа накалива-
ния; Floodlight – прожектор заливающего света; Moonlight – лунный свет; 
Daylight Warm – естественный теплый свет; Daylight Cool – естественный 
холодный свет; Xenon Arc Lamp – ксеноновая дуговая лампа; TV Screen – 
экран телевизора; Custom – пользовательская.

�� Bump – настройка параметров выдавливания, позволяющих использова-
ние рельефного рисунка на поверхности материала.

Наложение.текстур
Применительно к тонированию наложение текстур означает проецирование дву-
мерной растровой картинки на поверхность трехмерного объекта для достижения 

Наложение текстур
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специальных эффектов. Форматы растровых изображений могут быть самыми 
разными – TGA (.tga), BMP (.bmp, .rle, .dib), PNG (.png), JPG (.jpg, .jpeg), TIFF 
(.tif), GIF (.gif), PCX (.pcx).

Наложение текстур производится по координатам UV. Эти буквы специаль-
но выбраны так, чтобы подчеркнуть независимость от координат XY объектов 
AutoCAD. Накладываемые текстуры масштабируются в соответствии с текущей 
системой единиц AutoCAD.

При тонировании растровые картинки можно использовать как:

�� цветовые текстуры, определяющие раскраску поверхности объекта, как 
если бы на нее была нанесена растровая картинка. Например, для имита-
ции покрытого плиткой пола на горизонтальную поверхность наклады-
вают текстуру, напоминающую по виду шахматную доску. Или растровая 
картинка с узором накладывается на изображение сиденья стула для ими-
тации обивки;

�� текстуры отражения, имитирующие предметы, как бы отражающиеся от 
гладкой поверхности объекта. Для моделирования сцены, отражающейся 
на поверхности блестящего объекта, используется текстура среды;

�� текстуры прозрачности, задающие прозрачные и непрозрачные участки 
на объекте, создавая эффект наличия отверстий и проемов. Степень про-
зрачности определяется яркостью элементов текстуры: чисто-белые ее 
области соответствуют непрозрачным участкам, чисто-черные – прозрач-
ным. Если текстура цветная, то для вычисления степени прозрачности 
программа берет в расчет эквивалент в оттенках серого. Например, если 
взять растровое изображение черного круга в середине белого прямо-
угольника и наложить его на объект в качестве текстуры прозрачности, то 
поверхность будет выглядеть так, как будто на объекте имеется круглое 
прозрачное отверстие;

�� текстуры выдавливания – имитирующие эффект небольшого выдавлива-
ния участков изображения над остальной поверхностью, то есть эффект 
выпуклости или барельефа. Любое изображение можно использовать как 
текстуру выдавливания. Более светлые участки картинки, наложенной как 
текстура выдавливания, выглядят как бы возвышающимися над поверхно-
стью объекта. Простейший пример – картинка с белыми буквами на черном 
фоне. Наложение ее на плоскость в качестве текстуры выдавливания дает 
эффект выпуклых букв на плоском фоне, хотя в действительности объект 
остается плоским. Если текстура цветная, для вычисления «высоты» эле-
ментов, кажущихся выпуклыми при выдавливании, программа оперирует 
эквивалентом в оттенках серого. Применение текстур выдавливания не 
ограничено картинками с текстами – любая регулярная растровая структу-
ра может быть использована для придания поверхности рельефного облика;

�� текстуры самосвечения – имитирующие свечение объекта. При этом бе-
лые области визуализируются с максимальным самосвечением, черные – 
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без самосвечения. На светящуюся область не влияют источники света, а 
также на нее не падают тени.

Наложение текстур осуществляется командой mAtERiALmAP. Соответствую-
щие инструменты расположены в падающем меню View → Render → Mapping и в груп-
пе Materials ленты Visualize рабочего пространства 3D Modeling (рис. 25.28, 25.29).

Рис. 25.28. Инструменты наложения текстур в падающем меню

После применения материала с текстурой можно выполнить настройку ориен-
тации текстуры на объектах или гранях. При наложении материала выполняется 
его вписывание в форму объекта.

Запросы команды mAtERiALmAP:
Select an option [Box/Planar/Spherical/Cylindrical/copY mapping 

to/Reset mapping]<Box>: – указать один из ключей
Select faces or objects: – выбрать грани или объекты
Select faces or objects: – нажать клавишу Enter для завершения выбора
Accept the mapping or [Move/Rotate/reseT/sWitch mapping mode]: – 

принять наложение или указать один из ключей

Наложение текстур



Глава 25. Создание реалистичных изображений634

Рис. 25.29. Инструменты наложения текстур в падающем меню

Ключи команды mAtERiALmAP:

�� Planar – плоское наложение, при котором изображение наклады-
вается на объект, как бы проецируясь на двухмерную поверхность, 
при этом оно масштабируется для вписывания в объект, но не ис-
кажается. Команда вызывается из падающего меню View → 
Render → Mapping → Planar Mapping или щелчком на пиктограмме 
Planar в группе Materials ленты Visualize;

�� Box – соответствие прямоугольников, при котором изображение 
накладывается на коробчатые тела и повторяется на всех сторо-
нах объекта. Команда вызывается из падающего меню View → 
Render → Mapping → Box Mapping или щелчком на пиктограмме Box 
в группе Materials ленты Visualize;

�� Cylindrical – цилиндрическое наложение, при котором изобра-
жение накладывается на цилиндрический объект; горизонталь-
ные края загибаются и соединяются, верх и низ не затрагивают-
ся. Высота изображения масштабируется вдоль оси цилиндра. 
Команда вызывается из падающего меню View → Render → 
Mapping → Cylindrical Mapping или щелчком на пиктограмме 
Cylindrical в группе Materials ленты Visualize;

�� Spherical – сферическое наложение, при котором изображение 
деформируется как по горизонтали, так и по вертикали. Верх на-
ложения стягивается в точку, располагающуюся в «северном по-
люсе» сферы, в то время как низ стягивается в «южный полюс». 
Команда вызывается из падающего меню View → Render → 
Mapping → Spherical Mapping или щелчком на пиктограмме Spherical 
в группе Materials ленты Visualize;
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�� copY mapping to – копирование наложения для применения к исходному 
объекту;

�� Reset mapping – восстановление для текстуры значений координат UV 
по умолчанию;

�� Move – перемещение текстуры с помощью ручек;
�� Rotate – поворот текстуры с помощью ручек;
�� reseT – сброс и восстановление 

для текстуры значений координат 
UV по умолчанию;

�� sWitch mapping mode – переклю-
чение режима наложения и отобра-
жение основной подсказки.

Адаптируемая палитра редактирования 
изображения Texture Editor предоставляет 
возможность создания сложных узоров с за-
данными свойствами текстуры (рис. 25.30). 
Палитра загружается при щелчке на об-
разце текстуры в редакторе материалов 
Materials Editor (см. рис. 25.25).

�� В области предварительного про-
смотра отображается образец тек-
стуры со всеми внесенными изме-
нениями. 

�� Параметры внешнего вида 
Apperance предусмотрены только 
для текстур на процедурной основе.

�� В области преобразований 
Transforms настраиваются следую-
щие параметры:
•� Link texture transforms – связыва-

ние параметров преобразования 
текстур;

•� Position – положение материала: 
Offset – смещение на образце; 
Rotation – угол поворота образца 
вокруг оси W в системе коорди-
нат UVW;

•� Scale – масштабирование образца 
с возможностью указания реаль-
ных физических единиц измере-
ния;

•� Repeat – повтор узора образца.
Рис. 25.30. Пример палитры 
редактирования изображения

Наложение текстур
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Фон
Для создания фона в текущем виде используют команду ViEw, вызы-
ваемую из падающего меню View → Vamed Views…. При этом загружает-
ся диалоговое окно View Manager (рис. 25.31), в котором необходимо 
щелкнуть мышью на кнопке New…. В появившемся диалоговом окне 
создания вида New View в области Background настраиваются параметры 
переопределения стандартного фона (рис. 25.32).

Рис. 25.31. Диалоговое окно управления видами

Диалоговое окно переопределения стандартного фона Background (рис. 25.33) 
имеет различный список настраиваемых параметров в зависимости от выбранного 
типа фона.

�� Type: – список типов фонов:
•� Solid – заливка, при которой выбирается одноцветный сплошной фон;
•� Gradient – градиентная заливка, при которой задается двух- или трех-

цветный переходный фон;
•� Image – использование для определения фона файла с изображением.

�� Preview – отображение выбранного цвета.
�� Solid options – настройка параметров заливки:
•� Color: – загрузка диалогового окна установки цвета.

При использовании градиентной заливки диалоговое окно Background позволя-
ет настроить следующие параметры фона (рис. 25.34).
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Рис. 25.32. Диалоговое окно создания вида

�� Gradient options:
•� Three color – назначение трехцветного градиента. Если этот параметр не 

установлен, то можно задать двухцветный градиент;
•� Top color: – загрузка диалогового окна установки верхнего цвета гради-

ента;
•� Middle color: – загрузка диалогового окна установки среднего цвета гра-

диента;
•� Bottom color: – загрузка диалогового окна установки нижнего цвета гра-

диента;
•� Rotation: – назначение угла поворота переходного фона.

При использовании параметра Image диалоговое окно Background позволяет ис-
пользовать в качестве фона изображение (рис. 25.35).

При использовании параметра Sun & Sky диалоговое окно Background позволяет 
регулировать параметры фона с изображением солнца и неба (рис. 25.36).

Фон
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�� General – назначение общих параметров: Status – положение; Intensity Fac-
tor – коэффициент интенсивности; Color – цвет; Shadows – с тенями.

�� Sky Properties – определение свойств неба: Status – состояние небесного 
фона и освещения; Intensity Factor – коэффициент интенсивности; Haze – 
дымка;
•� Horizont – горизонт: Height – высота; Blur – размывание; Ground color – 

цвет земли;
•� Advanced – дополнительные параметры: Night color – цвет ночи; Aerial 

perspective – воздушная перспектива; Visibility distance – расстояние ви-
димости;

•� Sun disk apperance – вид солнечного диска: Disk scale – масштаб диска; 
Glow intensity – интенсивность света; Disk intensity – интенсивность диска.

�� Sun Angle Calculator – указание положения солнца: Date – дата; Time – время; 
Daylight Saving – летнее время; Azimuth – азимут; Altitude – широта; Source 
Vector – исходный вектор.

�� Rendered Shadow Details – сведения о визуализированном изображении с 
тенями: Type – тип; Samples – примеры; Softness – смягчение.

Для отображения созданного фона необходимо установить именованный вид 
в качестве текущего на видовом экране и активизировать фон в текущем стиле 
отображения.

Рис. 25.33. Диалоговое окно 
определения фона с помощью 

заливки

Рис. 25.34. Диалоговое окно 
определения фона с помощью 

градиентной заливки
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Тонирование.среды
Тонирование среды производится в палитре RENDER ENVIRONMENT & 
EXPOSURE, вызываемой командой RENDERENViRONmENt (рис. 25.37). 
Команда загружается из падающего меню View → Render → Render 
Environment....

Тонирование среды позволяет определить визуальное представление расстоя-
ния между объектами и точкой наблюдения, настроить туман и затемнения уда-
ленных объектов с использованием белого, черного и других оттенков.

Рис. 25.35. Диалоговое окно определения 
фона с помощью изображения

Рис. 25.36. Диалоговое окно определения 
фона с изображением солнца и неба

Тонирование среды
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Рис. 25.37. Диалоговое окно тонирования среды
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При формировании чертежа на основе трехмерной твердотельной модели (напри-
мер, приведенной на рис. 26.1) следует придерживаться следующего порядка.

Рис. 26.1. Чертеж трехмерной твердотельной детали

1. Установить ПСК параллельно главному виду детали. Для этого необходимо 
воспользоваться командой UCs, вызвав ее из падающего меню Tools → New 
UCS → 3 Point.

2. Перейти из пространства модели в пространство листа щелчком на закладке 
Layout. См. упражнения Spa1 и Spa2 из раздела 5.

3. Удалить лишние видовые окна.

4. Настроить параметры листа с помощью диалогового окна Page Setup Manager. 
Выбрать формат листа А3.

5. Вставить в рисунок рамку формата А3 (при условии, что эта заготовка уже 
существует). Вставка осуществляется командой iNsERt. См. упражнение 
In1 из раздела 4.
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6. Создать наклонный текстовый стиль в диалоговом окне Text Style, вызывае-
мом из падающего меню Format → Text Style.... В области Font в раскрываю-
щемся списке Font Name: следует выбрать шрифт simplex.shx; в поле Oblique 
Angle: установить угол наклона к нормали 15; в поле Height: установить вы-
соту 0 (нуль). См. упражнение T7 из раздела 2.

7. Заполнить штамп. Рекомендуется увеличить изображение штампа с по-
мощью зуммирования. Затем использовать команду DtEXt. При заполне-
нии штампа удобно пименить ключ выравнивания по ширине Fit команды 
DtEXt. См. упражнение T4 из раздела 2.

8. Создать на чертеже видовые экраны с необходимыми проекциями 
(рис. 26.2), используя команду sOLViEw, вызываемую из падающего меню 
Draw → Modeling → Setup → View:

Рис. 26.2. Видовые экраны с проекциями детали

•� получить главный вид – фронтальную проекцию детали:
_SOLVIEW
Enter an option [Ucs/Ortho/Auxiliary/Section]: U – ПСК
Enter an option [Named/World/?/Current] <Current>: – нажать 
клавишу Enter
Enter view scale <1>: 0.5 – указать масштаб вида

Формирование чертежей с использованием трехмерного ...
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Specify view center: – указать центр вида
Specify view center <specify viewport>: – нажать клавишу Enter
Specify first corner of viewport: – указать первый угол видового 
экрана
Specify opposite corner of viewport: – указать противоположный 
угол видового экрана
Enter view name: Front – ввести имя формируемого фронтального вида

•� получить вид сверху – горизонтальную проекцию детали:
Enter an option [Ucs/Ortho/Auxiliary/Section]: O – орторежим
Specify side of viewport to project: – указать верхнюю границу 
видового экрана главного вида
Specify view center: – указать центр вида
Specify view center <specify viewport>: – нажать клавишу Enter
Specify first corner of viewport: – указать первый угол видового 
экрана
Specify opposite corner of viewport: – указать второй угол видо-
вого экрана
Enter view name: Gorizont – ввести имя формируемого горизонталь-
ного вида

•� получить вид слева – профильную проекцию детали:
Enter an option [Ucs/Ortho/Auxiliary/Section]: O – орторежим
Specify side of viewport to project: – указать левую границу ви-
дового экрана главного вида
Specify view center: – указать центр вида
Specify view center <specify viewport>: – нажать клавишу Enter
Specify first corner of viewport: – указать первый угол видового 
экрана
Specify opposite corner of viewport: – указать второй угол видо-
вого экрана
Enter view name: Profil – ввести имя формируемого вида

•� получить разрез детали:
Enter an option [Ucs/Ortho/Auxiliary/Section]: S – сечение
Specify first point of cutting plane: CEN – указать на профиль-
ной проекции первую точку режущей плоскости с объектной привязкой 
к центру верхнего основания цилиндра
Specify second point of cutting plane: CEN – указать на профиль-
ной проекции вторую точку режущей плоскости с объектной привязкой 
к центру нижнего основания цилиндра
Specify side to view from: – указать слева на профильной проекции 
точку направления взгляда
Enter view scale <0.5>: – нажать клавишу Enter
Specify view center: – указать центр вида
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Specify view center <specify viewport>: – нажать клавишу Enter
Specify first corner of viewport: – указать первый угол видового 
экрана
Specify opposite corner of viewport: – указать второй угол видо-
вого экрана
Enter view name: Section – ввести имя формируемого вида
Enter an option [Ucs/Ortho/Auxiliary/Section]: – для завершения 
работы команды нажать клавишу Enter

9. Всем слоям с невидимыми линиями (<имя вида>-HID) установить тип ли-
нии HIDDEN. Выполнить команду sOLDRAw, вызываемую из падающего 
меню Draw → Modeling → Setup → Drawing. В ответ на последовательность 
запросов Select objects: следует указать рамки всех видовых экранов.

10. Отключить слой VPORTS, в котором находятся рамки видовых экранов.
11. Находясь в пространстве листа, провести на проекциях детали осевые ли-

нии.
12. Проставить на проекциях детали размеры в слоях с именами <имя вида>-

DIM (рис. 26.3).
13. Оформить недостающие обозначения на чертеже и сохранить файл с рисун-

ком.

Рис. 26.3. Чертеж детали

Формирование чертежей с использованием трехмерного ...
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Перечень.команд

3D – построение трехмерных объектов в виде полигональных сетей распростра-
ненных геометрических форм – параллелепипедов, конусов, сфер, торов, клиньев 
и пирамид.
3DALiGN – выравнивание объектов относительно других объектов в двухмерном и 
трехмерном пространствах.
3DARRAY – построение трехмерных массивов.
3DCLiP – вызов диалогового окна Adjust Clipping Planes для просмотра сечений 
трехмерной модели с помощью двух динамических плоскостей, которые ограни-
чивают пространство чертежа по глубине отображаемой области.
3DCONFiG – настройка системы трехмерной графики в командной строке.
3DCORBit – установка режима интерактивного трехмерного просмотра с дина-
мическим вращением вида.
3DDistANCE – управление расстоянием от камеры до объекта при просмотре в 
трехмерном пространстве.
3DDwF – создание трехмерного DWF-файла пользовательской трехмерной моде-
ли и отображение ее в программе просмотра DWF.
3DEDitBAR  – изменение формы, масштабирование и изменение касания для 
NURBS-поверхностей. 
3DFACE – построение трехмерных граней, каждая из которых ограничена тремя 
или четырьмя кромками.
3DFLY – интерактивное изменение пользовательского вида трехмерных черте-
жей таким образом, что наблюдатель как бы пролетает сквозь модель.
3DFORBit – управление интерактивным просмотром объектов в трехмерном ре-
жиме, используя неограниченную орбиту.
3DmEsH – построение полигональных сетей произвольной формы.
3DmOVE – отображение инструмента ручки перемещения в трехмерном виде и 
перемещение объектов на указанное расстояние в заданном направлении.
3DORBit – интерактивный просмотр объектов в трехмерном пространстве с по-
мощью устройства указания.
3DORBitCtR – активация на текущем видовом экране трехмерного вида, вывод 
на экран орбитального кольца и предоставление возможности указать централь-
ную точку орбиты с помощью мыши.
3DOsNAP – задание режимов объектной привязки для трехмерных объектов.
3DPAN – динамическое панорамирование объекта при его просмотре в трехмер-
ном пространстве.
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3DPOLY – создание трехмерных полилиний из линейных сегментов.
3DPRiNt – отсылка трехмерной модели в службу трехмерной печати.
3DROtAtE – отображение на трехмерном виде ручки поворота и вращение объ-
ектов вокруг базовой точки.
3DsCALE – в трехмерном виде отображение гизмо 3D-масштабирования, способ-
ствующее изменению размеров трехмерных объектов.
3DsiN – импорт файлов из программы 3D Studio MAX.
3DswiVEL – имитация эффекта поворота камеры при просмотре модели в трех-
мерном пространстве.
3DwALK – интерактивное изменение вида трехмерного чертежа, при этом кажет-
ся, что наблюдатель обходит модель.
3DZOOm – динамическое зуммирование при просмотре модели в трехмерном 
пространстве.

A

ABOUt – вывод на экран информации об AutoCAD.
ACisiN – импорт ACIS-файлов, в которых содержится описание твердых тел.
ACisOUt – экспорт твердотельных объектов AutoCAD в файлы формата ACIS.
ACtBAsEPOiNt – вставка базовой точки в макрос операции.
ACtmANAGER – управление файлами макросов операций.
ACtRECORD – запуск рекордера операций.
ACtstOP – остановка рекордера операций и предоставление возможности сохра-
нения записанных операций в файле макроса операции.
ACtUsERiNPUt – пауза для обеспечения ввода пользователя в макрос операции.
ACtUsERmEssAGE  – вставка пользовательского сообщения в макрос опера-
ции.
ADCCLOsE – закрытие Центра управления AutoCAD DesignCenter.
ADCENtER – загрузка Центра управления AutoCAD DesignCenter, обеспечи-
вающего управление содержимым – блоками, внешними ссылками и образцами 
штриховки.
ADCNAViGAtE – перемещение в зоне структуры Центра управления AutoCAD 
DesignCenter на конкретный файл, папку или сетевой ресурс.
ADDsELECtED  – создание нового объекта на основе типа объекта и общих 
свойств выбранного объекта.
ADJUst – регулировка затенения, контраста и настроек монохромности выбран-
ного изображения или подложки (DWF, DWFx, PDF или DGN).
ALiGN – выравнивание объектов относительно других объектов в двухмерном и 
трехмерном пространствах.
AmECONVERt – конвертирование твердотельных моделей AME в объекты 
AutoCAD.
ANALYsisCURVAtURE – отображение цветового градиента на поверхности для 
оценки различных аспектов ее кривизны.
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ANALYsisDRAFt  – отображение цветового градиента на трехмерной модели 
для оценки наличия достаточного пространства между деталью и ее литейной 
формой.
ANALYsisOPtiONs – настройка параметров отображения для результатов ана-
лиза целостности, кривизны и уклона.
ANALYsisZEBRA – проецирование полос на трехмерную модель для анализа не-
прерывности поверхности.
ANiPAtH – сохранение анимации вдоль траектории в трехмерной модели.
ANNOREsEt – восстановление исходного расположения всех измененных мас-
штабируемых представлений выбранных аннотативных объектов.
ANNOUPDAtE – обновление существующих аннотативных объектов в соответ-
ствии с текущими свойствами их стилей.
APERtURE – изменение размера прицела и величины области влияния объект-
ной привязки.
APPLOAD – загрузка и выгрузка приложений; составление набора приложений 
для автозагрузки.
ARC – построение дуг.
ARCHiVE – упаковка файлов из текущей подшивки в архив.
AREA – вычисление площадей и периметров объектов или заданных областей.
ARRAY – создание прямоугольных и круговых массивов объектов.
ARX – загрузка, выгрузка и предоставление информации о приложениях 
ObjectARX.
AttACH  – вставка внешней ссылки, изображения или подложки (файлы DWF, 
DWFx, PDF или DGN) в текущий чертеж.
AttACHURL – добавление гиперссылок к объектам и зонам рисунка.
AttDEF – создание описаний атрибутов, то есть связанных с блоком информаци-
онных текстов. Описание атрибута задает его характеристики и определяет под-
сказки, выводимые при вставке блока, с которым связан атрибут.
AttDisP – глобальное управление видимостью атрибутов на рисунке.
AttEDit – изменение данных в атрибутах выбранного блока.
AttEXt – извлечение данных из атрибутов блоков текущего рисунка и экспорт во 
внешний файл формата TXT или DXX.
AttiPEDit – изменение текстового содержимого атрибута в блоке.
AttREDEF – переопределение блока и обновление связанных с ним атрибу-
тов.
AttsYNC – обновление всех вхождений блока после редактирования описаний 
его атрибутов.
AUDit – проверка рисунка и его целостности.
AUtOCONstRAiN – наложение геометрических зависимостей на набор выбран-
ных объектов на основе ориентации объектов относительно друг друга.
AUtOPUBLisH  – автоматическая публикация чертежей в файлы DWF, DWFx 
или PDF с сохранением в указанном местоположении.
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B

BACtiON – добавление операции в описание динамических блоков.
BACtiONBAR – отображение и скрытие панелей операций для набора объектов 
параметров.
BACtiONsEt – указание набора объектов, связанных с операцией в описании ди-
намического блока.
BACtiONtOOL – добавление операции в описание динамических блоков.
BAsE – указание базовой точки вставки для текущего рисунка.
BAssOCiAtE – связывание операции с параметром в описании динамического 
блока.
BAttmAN – редактирование свойств атрибутов в описаниях блоков.
BAttORDER – задание порядка атрибутов для блока.
BAUtHORPALEttE – открытие окна Палитры вариации блоков в редакторе бло-
ков.
BAUtHORPALEttECLOsE – закрытие окна Палитры вариации блоков в редак-
торе блоков.
BCLOsE – закрытие редактора блоков.
BCONstRUCtiON – преобразование геометрии во вспомогательную геометрию.
BCPARAmEtER  – применение параметров зависимостей к выбранным объектам 
или преобразование размерных зависимостей в параметрические.
BCYCLEORDER – изменение порядка циклического перебора ручек для вхожде-
ния динамического блока.
BEDit – открытие диалогового окна редактирования описания блока, а затем ре-
дактора блоков.
BEsEttiNGs – отображение диалогового окна настроек редактора блоков.
BGRiPsEt – создание, удаление или выполнение сброса ручек, связанных с па-
раметром.
BHAtCH – нанесение ассоциативной штриховки или градиентной заливки внутри 
замкнутого контура.
BLiPmODE – управление видимостью маркера на экране при рисовании.
BLOCK – создание описания блока из выбранных объектов.
BLOCKiCON – формирование изображений-образцов для блоков, представлен-
ных в Центре управления.
BLOOKUPtABLE – сохранение выбранных объектов в файле аппаратно-незави-
симого растрового формата BMP.
BmPOUt – сохранение выбранных объектов в файле аппаратно-независимого 
растрового формата BMP.
BOUNDARY – создание области или полилинии из замкнутого контура.
BOX – построение трехмерных твердотельных параллелепипедов (ящиков).
BPARAmEtER – добавление в описание динамического блока параметра с руч-
ками.
BREAK – разрыв выбранного объекта между двумя точками.
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BREP – удаление журнала из трехмерных элементарных и составных тел.
BROwsER – вызов веб-браузера, зарегистрированного в системном реестре.
BsAVE – сохранение текущего описания блока.
BsAVEAs – сохранение копии текущего описания блока под новым именем.
BtABLE – отображение диалогового окна для определения вариантов блока.
BtEstBLOCK – вызов окна тестирования в редакторе блоков для тестирования 
динамического блока.
BVHiDE – назначение невидимости объектов в текущем или во всех состояниях 
видимости в описании динамического блока.
BVsHOw – назначение видимости объектов в текущем или во всех состояниях 
видимости в описании динамического блока.
BVstAtE – создание, установка или удаление состояния видимости в динамиче-
ском блоке.

C

CAL – вычисление математических и геометрических выражений.
CAmERA – установка положения камеры и цели при настройке трехмерного вида.
CHAmFER – снятие фасок в местах пересечения объектов.
CHAmFEREDGE – построение скоса для ребер трехмерных тел и поверхностей.
CHANGE – управление свойствами объектов.
CHECKstANDARDs – проверка текущего рисунка на соответствие установлен-
ным стандартам оформления.
CHPROP – изменение цвета, слоя, типа линии, масштаба типа линии, веса (тол-
щины) линии, трехмерной высоты и стиля печати объекта.
CHsPACE – перенос объектов из пространства модели в пространство листа и 
наоборот.
CiRCLE – построение окружностей.
CLAssiCimAGE – загрузка диспетчера растровых изображений.
CLAssiCLAYER – загрузка диспетчера свойств слоев.
CLAssiCXREF – загрузка диспетчера внешних ссылок.
CLEANsCREENOFF – включение скрытых ранее панелей инструментов, окна ин-
струментальных палитр, палитры свойств и Центра управления.
CLEANsCREENON – скрытие всех элементов пользовательского интерфейса, 
кроме строки меню и строки состояния.
CLiP – обрезка выделенных объектов, таких как блоки, внешние ссылки, изобра-
жения и видовые экраны.
CLOsE – закрытие текущего рисунка.
CLOsEALL – закрытие всех открытых в данный момент рисунков.
COLOR – установка цвета для вновь создаваемых объектов.
COmmANDLiNE – отображение командной строки.
COmmANDLiNEHiDE – запрет на отображение командной строки.
COmPiLE – компиляция файлов форм и файлов шрифтов PostScript.
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CONE – построение трехмерного твердотельного конуса.
CONstRAiNtBAR  – отображение или скрытие геометрических зависимостей 
объекта.
CONstRAiNtsEttiNGs – управление отображением геометрических зависимо-
стей на панелях зависимостей.
CONVERt – преобразование двухмерных полилиний и ассоциативных штриховок, 
созданных в AutoCAD более ранних версий.
CONVERtCtB – преобразование таблиц цветозависимых стилей печати (СТВ) в 
таблицы именованных стилей печати (STB).
CONVERtOLDLiGHts – преобразование формата отображения источников света, 
созданных в предыдущих версиях, в формат новой версии программы AutoCAD.
CONVERtOLDmAtERiALs – преобразование формата отображения материалов, 
созданных в предыдущих версиях, в формат новой версии программы AutoCAD.
CONVERtPstYLEs – настройка рисунка на использование именованных или 
цветозависимых стилей печати.
CONVtOmEsH  – преобразование 3D-объектов, таких как полигональные сети, 
поверхности и твердые тела в меш-сети.
CONVtONURBs  – преобразование трехмерных тел и поверхностей в NURBS-
поверхности.
CONVtOsOLiD – преобразование полилинии и окружности, для которых задана 
высота, в трехмерные тела.
CONVtOsURFACE – преобразование объектов в поверхности.
COPY – создание копии объекта.
COPYBAsE – копирование объектов в буфер обмена с указанием базовой точки 
без их удаления из рисунка.
COPYCLiP – копирование объектов в буфер обмена без их удаления из рисунка.
COPYHist – копирование текста из окна командной строки в буфер обмена.
COPYLiNK – копирование текущего вида в буфер обмена для связывания с дру-
гими OLE-приложениями.
COPYtOLAYER – копирование одного или более объектов в другой слой.
CUi – управление настраиваемыми элементами интерфейса пользователя, такими 
как рабочее пространство, панель инструментов, меню, контекстное меню и со-
четание клавиш.
CUiEXPORt – экспорт пользовательских настроек из файла acad.cui в файл час-
тичной адаптации или в файл CUI предприятия.
CUiimPORt – импорт пользовательских настроек из файла CUI предприятия или 
частичного файла CUI в файл acad.cui.
CUiLOAD – загрузка файла CUI.
CUiUNLOAD – выгрузка файла CUI.
CUstOmiZE – адаптация панелей инструментов, кнопок, клавиш быстрого вы-
зова и инструментальных палитр.
CUtCLiP – занесение объектов в буфер обмена с их удалением из рисунка.
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CVADD – добавление управляющих вершин к NURBS-поверхностям и сплайнам.
CVHiDE  – отключение отображения управляющих вершин для всех NURBS-
поверхностей и кривых.
CVREBUiLD – воссоздание формы NURBS-поверхностей и кривых.
CVREmOVE – удаление управляющих вершин с NURBS-поверхностей и сплай-
нов.
CVsHOw – отображение управляющих вершин для заданных NURBS-поверхнос-
тей или кривых.
CYLiNDER – построение трехмерных твердотельных цилиндров.

D

DAtAEXtRACtiON – извлечение данных чертежа из внешнего источника с табли-
цей извлечения данных и объединение данных с внешним файлом.
DAtALiNK – загрузка диалогового окна связи с данными Data Link Manager.
DAtALiNKUPDAtE – обновление данных по организованной связи с внешними 
данными.
DBCONNECt – интерфейс AutoCAD для работы с таблицами внешних баз дан-
ных.
DBList – вывод на экран информации базы данных для всех объектов рисунка.
DCALiGNED – ограничение расстояние между двумя точками на разных объектах.
DCANGULAR – наложение зависимости на угол между сегментами линии или по-
лилинии, на угол, образованный сдвигом дуги или дугового сегмента полилинии, 
или на угол между тремя точками на объектах.
DCCONVERt – преобразование ассоциативных размеров в размерные зависимо-
сти.
DCDiAmEtER – наложение зависимости на диаметр окружности или дуги.
DCDisPLAY – отображение или скрытие динамических зависимостей, связанных 
с набором выбранных объектов.
DCFORm – указывает, является ли создаваемая размерная зависимость динами-
ческой или аннотативной.
DCHORiZONtAL – ограничение расстояния X между точками объекта или между 
двумя точками разных объектов.
DCLiNEAR  – создание зависимости горизонтальности, вертикальности или по-
ворота на основе местоположений исходных точек выносных линий и размерной 
линии.
DCRADiUs – наложение зависимости на радиус окружности или дуги.
DCVERtiCAL  – ограничение расстояния Y между точками объекта или между 
двумя точками разных объектов.
DDEDit – редактирование текстов (в том числе размерных), описаний атрибутов 
и допусков формы и расположения.
DDPtYPE – установка стиля отображения и величины точечных объектов.
DDVPOiNt – установка направления взгляда в трехмерном пространстве.
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DELAY – установка паузы при выполнении пакета команд.
DELCONstRAiNt – удаление всех геометрических и размерных зависимостей из 
набора объектов.
DEtACHURL – удаление гиперссылок из рисунка.
DGNADJUst – настройка слияния с фоном, контрастности и монохромного ре-
жима для подложки DGN.
DGNAttACH – вставка файла DGN в текущий чертеж в качестве подложки.
DGNCLiP – обрезка отображаемой области выбранной подложки DGN по задан-
ному контуру.
DGNEXPORt – создание одного или нескольких DGN-файлов из текущего чер-
тежа.
DGNimPORt – импорт данных из файла DGN в новый DWG-файл.
DGNLAYERs – управление отображением слоев в DGN-подложке.
DGNmAPPiNG – позволяет создавать и редактировать пользовательские парамет-
ры соответствия DGN.
Dim и Dim1 – переход в режим нанесения размеров.
DimALiGNED – нанесение параллельных линейных размеров.
DimANGULAR – нанесение угловых размеров.
DimARC – нанесение размера длины дуги.
DimBAsELiNE – нанесение новых линейных, угловых или ординатных размеров 
от базовой линии предыдущего или выбранного размера.
DimBREAK – разрыв или восстановление размерных или выносных линий, пере-
секающих другие объекты.
DimCENtER – нанесение маркеров центра или центровых линий на кругах и дугах.
DimCONstRAiNt – применение размерных зависимостей к выбранным объек-
там или точкам на объектах либо преобразование ассоциативных размеров в раз-
мерные зависимости.
DimCONtiNUE – нанесение цепи линейных, угловых или ординатных размеров 
от второй выносной линии предыдущего или выбранного размера.
DimDiAmEtER – нанесение диаметров окружностей, дуг и эллипсов.
DimDisAssOCiAtE – отмена ассоциативности выбранных размеров.
DimEDit – редактирование размеров.
DimiNsPECt – добавление или удаление рамки с контрольными данными для 
выбранного размера.
DimJOGGED – нанесение размеров с изломом для окружностей и дуг.
DimJOGLiNE – добавление или удаление линий с изломом к линейному или вы-
ровненному размеру.
DimLiNEAR – нанесение линейных размеров.
DimORDiNAtE – нанесение ординатных размеров.
DimOVERRiDE – переопределение установок размерных переменных без пере-
определения стиля.
DimRADiUs – нанесение радиусов окружностей, дуг и эллипсов.
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DimREAssOCiAtE – связывание выбранных размеров с геометрическими объ-
ектами.
DimREGEN – обновление расположения всех ассоциативных размеров.
DimsPACE – корректировка расстояния между линейными или угловыми раз-
мерами.
DimstYLE – создание и модификация размерных стилей.
DimtEDit – перемещение и поворот размерных текстов.
Dist – измерение расстояний и углов между точками.
DistANtLiGHt – создание удаленного источника света.
DiViDE – равномерное размещение объектов-точек или блоков вдоль или по пе-
риметру объектов.
DONUt – построение закрашенных кругов и колец.
DRAGmODE – управление отображением объектов при перетаскивании.
DRAwiNGRECOVERY – отображение списка имен файлов чертежей, подлежа-
щих восстановлению после сбоя системы.
DRAwiNGRECOVERYYHiD – вызов справочной системы.
DRAwORDER – изменение порядка вывода растровых изображений и других 
объектов на экран.
DsEttiNGs – настройка параметров шаговой привязки, сетки, полярного и объ-
ектного отслеживания.
DsViEwER – вызов диалогового окна Aerial View, обеспечивающего интерактивное 
управление экранным увеличением текущего видового экрана.
DtEXt – формирование текста.
DViEw – установка параллельных проекций и видов в перспективе.
DwFADJUst – настройка подложки DWF из командной строки.
DwFAttACH – вставка подложки DWF в текущий чертеж.
DwFCLiP – определение подобласти подложки DWF с помощью секущих конту-
ров.
DwFFORmAt – установка DFW или DWFx в качестве принимаемого по умол-
чанию формата для публикации чертежей в файлы DWF, DWFx и PDF или на 
плоттеры, для создания 3D DWF- или 3D DWFx-файла для 3D-модели и его от-
крытия в окне DWF Viewer, для сохранения объектов в чертеже в другом формате 
файла, для создания файла DWF и DWFx с возможностью устанавливать отдель-
ные переопределения параметров листа для каждого листа в подшивке.
DwFLAYERs – управление отображением слоев в DWF- или DWFx-подложке.
DwGPROPs – настройка и просмотр свойств текущего рисунка.
DXBiN – импорт двоичных файлов в специальной кодировке.

E

EAttEDit – редактирование атрибутов во вхождениях блоков.
EAttEXt – экспорт информации из атрибутов блоков во внешний файл.
EDGE – изменение видимости кромок трехмерных граней.
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EDGEsURF – построение трехмерных полигональных сетей (поверхностей Кунса).
EDitsHOt – редактирование сохраненного именованного вида с перемещением 
или без перемещения.
ELEV – установка уровня и трехмерной высоты выдавливания вновь создаваемых 
объектов.
ELLiPsE – построение эллипсов и эллиптических дуг.
ERAsE – удаление выбранных объектов из рисунка.
EtRANsmit – формирование комплектов, состоящих из файла рисунка и всех 
используемых в нем внешних файлов для передачи по Интернету.
EXPLODE – разбиение составного объекта (без изменения геометрии) на состав-
ляющие его объекты.
EXPORt – сохранение объектов в файлах различных форматов.
EXPORtDwF – создание файла DWF с возможностью устанавливать отдельные 
переопределения параметров листа для каждого листа в подшивке.
EXPORtDwFX – создание файла DWFx, в котором можно установить переопре-
деления параметров листа отдельно для каждого листа в подшивке.
EXPORtLAYOUt  – создание визуального представления текущего листа в про-
странстве модели нового чертежа.
EXPORtPDF – создание файла PDF, в котором можно установить переопределе-
ния параметров листа отдельно для каждого листа в подшивке.
EXPORtsEttiNGs – настройка параметров страницы и элементов чертежа при 
экспорте в DWF, DWFx или PDF файл.
EXPORttOAUtOCAD – создание версии AEC файла, который можно открыть в 
AutoCAD.
EXtEND – удлинение объектов до пересечения с другими объектами.
EXtERNALREFERENCEs – открытие палитры внешних ссылок.
EXtERNALREFERENCEsCLOsE – закрытие палитры внешних ссылок.
EXtRUDE – создание тел путем выдавливания двухмерных объектов.

F

FBXEXPORt – создание файла Autodesk® FBX, содержащего объекты, выбранные 
на текущем чертеже.
FBXimPORt – импорт файла Autodesk® FBX, содержащего объекты, источники 
света, камеры и материалы.
FiELD – создание многострочного текстового объекта, представляющего собой 
поле, которое автоматически обновляется при изменении некоторой величины.
FiLL – управление закрашиванием таких объектов, как штриховки, фигуры и ши-
рокие полилинии.
FiLLEt – скругление углов и сопряжение объектов.
FiLLEtEDGE – скругление и сопряжение ребер объектов-тел.
FiLtER – создание фильтров многократного использования для выбора объектов 
на основе их свойств.
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FiND – поиск, замена, выбор и показ текста на рисунке.
FLAtsHOt – создание двухмерного представления всех трехмерных объектов в те-
кущем виде.
FOG – создание эффекта тумана или воздушной перспективы для визуального 
представления объектов.
FREEsPOt – создание свободного прожектора, подобного прожектору без задан-
ной цели.
FREEwEB – создание свободной световой сетки, подобной световой сетке без за-
данной цели.

G

GCCOiNCiDENt – наложение зависимости на две точки относительно друг друга 
или на точку относительно кривой или ее продолжения.
GCCOLLiNEAR – размещение двух или нескольких сегментов линий вдоль одной 
линии.
GCCONCENtRiC – наложение зависимости на две дуги, две окружности или два 
эллипса по одинаковой центральной точке.
GCEQUAL – задание одинакового радиуса для выбранных дуг и окружностей или 
одинаковой длины для выбранных линий.
GCFiX – блокировка местоположения точек и кривых.
GCHORiZONtAL – линии или пары точек размещаются параллельно оси Х теку-
щей системы координат.
GCPARALLEL – задание отношения параллельности между выбранными линия-
ми.
GCPERPENDiCULAR  – размещение выбранных линий под углом 90 градусов 
друг к другу.
GCsmOOtH – наложение зависимости на сплайн для сохранения его смежности 
и G2-непрерывности по отношению к другому сплайну, отрезку, дуге или полили-
нии.
GCsYmmEtRiC  – симметричное расположение выбранных объектов относи-
тельно выбранной линии.
GCtANGENt – определяет сохранение точки касания двух кривых или их про-
должений.
GCVERtiCAL – линии или пары точек размещаются параллельно оси Y текущей 
системы координат.
GEOGRAPHiCLOCAtiON – задание широты и долготы расположения.
GEOmCONstRAiNt – применение или сохранение существующих геометриче-
ских отношений между объектами или точками на объектах.
GOtOURL – открытие файла или веб-страницы, на которые указывает гиперссыл-
ка в выбранном объекте.
GRADiENt – заполнение замкнутой области или выбранных объектов градиент-
ной заливкой.
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GRAPHiCsCONFiG – задание параметров, определяющих рабочие характеристи-
ки трехмерного отображения.
GRAPHsCR – переключение из текстового окна в графическую область.
GRiD – включение и отключение точечной сетки на текущем видовом экране.
GROUP – создание именованных наборов (групп) объектов и управление ими.

H

HAtCH – заполнение указанного контура неассоциативной штриховкой по вы-
бранному образцу.
HAtCHEDit – редактирование нанесенных штриховок или градиентной заливки.
HAtCHGENERAtEBOUNDARY  – создание неассоциированных полилиний во-
круг выбранного люка.
HAtCHsEtBOUNDARY – переопределение выбранной штриховки или заливки, 
соответствующей границы.
HAtCHsEtORiGiN – контроль исходного положения выбранной штриховки.
HAtCHtOBACK – установка порядка отображения в чертеже.
HELiX – создание двухмерной или трехмерной спирали.
HELP – вызов справочной системы.
HiDE – регенерация трехмерной модели с подавлением скрытых линий.
HiDEOBJECts – скрытие выбранных объектов.
HiDEPALEttEs – скрытие всех отображаемых палитр, включая окно команд.
HLsEttiNGs – настройка параметров отображения невидимых линий.
HYPERLiNK – создание гиперссылки для объекта или изменение существующей 
гиперссылки.
HYPERLiNKOPtiONs – управление отображением курсора и подсказок к гипер-
ссылкам.

i

iD – определение координат указанных точек.
imAGE – управление растровыми изображениями.
imAGEADJUst – регулировка яркости, контрастности и степени слияния с фо-
ном вставленных в рисунок растровых изображений.
imAGEAttACH – вставка нового растрового изображения в текущий рисунок.
imAGECLiP – создание контуров подрезки изображений.
imAGEFRAmE – управление видимостью границ контуров подрезки растрового 
изображения.
imAGEQUALitY – управление качеством вывода вставленных в рисунок растро-
вых изображений на экран.
imPORt – импорт в AutoCAD файлов различных форматов.
imPRiNt – клеймение грани трехмерного тела.
iNsERt – вставка в текущий рисунок именованного блока или другого рисунка.
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iNsERtOBJ – вставка связанного или внедренного объекта.
iNtERFERE – создание сложного трехмерного тела, занимающего общий объем 
двух или более тел.
iNtERsECt – создание составных тел или областей из пересечения двух или бо-
лее тел или областей с удалением непересекающихся участков объектов.
isOLAtEOBJECts – временное сокрытие отображения всех объектов, кроме вы-
бранных.
isOPLANE – выбор текущей изометрической плоскости.

J

JOGsECtiON – добавление сегмента с изломом к объекту-сечению.
JOiN – соединение объектов для формирования одного целого объекта.
JPGOUt – сохранение выбранных объектов в файле формата JPG.
JUstiFYtEXt – изменение размеров текстовых объектов без изменения их место-
положения.

L

LAYCUR – назначение слоя выбранных объектов текущим.
LAYDEL – удаление слоя выбранных объектов и всех объектов на слое.
LAYER – управление слоями и их свойствами.
LAYERCLOsE – закрытие Диспетчера свойств слоев.
LAYERP – отмена последних изменений состояния и свойств слоев.
LAYERPALEttE – загрузка Диспетчера свойств слоев.
LAYERPmODE – включение и отключение режима записи последовательности 
изменений свойств слоев.
LAYERstAtE  – сохранение, восстановление именованных состояний слоев и 
управление ими.
LAYFRZ – заморозка слоя выбранных объектов.
LAYisO – изоляция слоя выбранных объектов так, что все другие слои выключа-
ются.
LAYLCK – блокировка слоев выбранных объектов.
LAYmCH – объявление слоя выбранных объектов соответствующим слою назна-
чения.
LAYmCUR  – назначение слоя выбранного объекта текущим.
LAYmRG – объединение выбранных слоев в слое назначения.
LAYOFF – выключение слоя выбранного объекта.
LAYON – включение всех слоев.
LAYOUt – создание и модификация листов в рисунке.
LAYOUtwiZARD – вызов Мастера компоновки листа для настройки параметров 
компоновки и печати нового листа.
LAYtHw – размораживание всех слоев.
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LAYtRANs – изменение системы слоев рисунка в соответствии с установленными 
пользователем стандартами.
LAYULK – разблокирование слоя выбранного объекта.
LAYUNisO – включение слоев, которые были выключены последней командой 
LAYisO.
LAYVPi – изоляция слоя объекта в текущий видовой экран.
LAYwALK – загрузка диалогового окна обхода слоя LayerWalk.
LEADER – построение линии-выноски, соединяющей пояснительные надписи с 
поясняемыми элементами.
LENGtHEN – увеличение длин объектов и центральных углов дуг.
LiGHt – управление источниками света и световыми эффектами для фотореалис-
тичной визуализации.
LiGHtList – открытие списка источников света в модели для его добавления и 
изменения.
LiGHtListCLOsE – закрытие списка источников света в модели.
Limits – указание пределов границ рисунка и лимитов сетки, отображаемой в 
пространстве модели или на текущем листе рисунка.
LiNE – построение отрезков.
LiNEtYPE – создание, загрузка и установка типов линий.
List – получение информации о выбранных объектах из базы данных рисунка.
LiVEsECtiON – включение режима псевдоразреза для выбранного объекта-сече-
ния.
LOAD – загрузка файла с описанием форм, определенных пользователем, для 
вставки в рисунок командой sHAPE.
LOFt – создание трехмерного тела или поверхности путем сечений двумя или бо-
лее кривыми.
LOGFiLEOFF – закрытие файла журнала, открытого командой LOGFiLEON.
LOGFiLEON – включение записи содержимого текстового окна в файл.
LtsCALE – определение глобального масштаба типов линий.
LwEiGHt – установка текущего веса линий, параметров отображения линий в за-
висимости от их веса и единиц веса линий.

m

mARKUP – отображение сведениий о пометках с возможностью изменения их 
статуса.
mARKUPCLOsE – закрытие Диспетчера наборов пометок.
mAssPROP – вычисление масс-инерционных характеристик областей и тел.
mAtBROwsERCLOsE – закрытие окна обозревателя материалов Materials Rowser.
mAtBROwsEROPEN – открытие окна обозревателя материалов Materials Rowser.
mAtCHCELL – копирование свойств выбранной ячейки таблицы в другие ячейки.
mAtCHPROP – копирование свойств объекта в другие объекты.
mAtEDitORCLOsE – закрытие окна редактора материалов Materials Editor.
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mAtEDitOROPEN – открытие окна редактора материалов Materials Editor.
mAtERiALAssiGN  – использование текущего материала, который определен в 
системной переменной CMATERIAL.
mAtERiALAttACH – назначение материалов объектам по слоям.
mAtERiALmAP – отображение ручки блока наложения материалов для корректи-
ровки наложений на грань или на объект.
mAtERiALs – администрирование, применение и редактирование материалов.
mAtERiALsCLOsE – закрытие диалогового окна материалов.
mEAsURE – размещение объектов-точек или блоков на объекте с заданными ин-
тервалами.
mEAsUREGEOm – измерение расстояния, радиуса, угла, площади и объема вы-
бранных объектов или последовательности точек.
mENU – загрузка файла меню.
mENULOAD – загрузка фрагментов меню.
mENUUNLOAD – выгрузка фрагментов меню.
mEsH – создание трехмерного сетевого объекта примитива в форме ящика, кону-
са, цилиндра, пирамиды, шара, клина или тора.
mEsHCAP – создание грани сети, соединяющей открытые ребра.
mEsHCOLLAPsE – объединение вершин выбранных граней или ребер сети.
mEsHCREAsE – заострение кромок выбранных подобъектов сети.
mEsHEXtRUDE – расширение грани сети в трехмерное пространство.
mEsHmERGE – объединение смежных граней в одну грань.
mEsHOPtiONs  – отображение диалогового окна параметров тесселяции сети, 
которое предназначено для управления принятых по умолчанию настроек преоб-
разования существующих объектов в объекты-сети.
mEsHPRimitiVEOPtiONs – отображение диалогового окна параметров сетевых 
примитивов, в котором устанавливается тесселяция по умолчанию для объектов 
сетевых примитивов.
mEsHREFiNE – увеличение количества граней в выбранных объектах или гранях.
mEsHsmOOtH – преобразование таких трехмерных объектов, как многоуголь-
ная сеть, поверхность и тело, – в объекты-сети.
mEsHsmOOtHLEss – уменьшение степени сглаживания для объектов-сетей на 
одну ступень.
mEsHsmOOtHmORE – увеличение степени сглаживания для объектов-сетей на 
одну ступень.
mEsHsPiN – обращение ребра, прилегающего к двум треугольным граням сети.
mEsHsPLit – разделение грани сети на две грани.
mEsHUNCREAsE – удаление сгиба из граней, ребер или вершин выбранной сети.
miGRAtEmAtERiALs – поиск материалов из предыдущих версий на инструмен-
тальных палитрах и их преобразование к общему типу.
miNsERt – множественная вставка блоков с расположением их в узлах прямо-
угольного массива.
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miRROR – зеркальное отображение объекта.
miRROR3D – зеркальное отображение трехмерных объектов относительно задан-
ной плоскости.
mLEADER – создание объекта-мультивыноски.
mLEADERALiGN – выравнивание и разнесение в пространстве объектов-выносок.
mLEADERCOLLECt  – выстраивание выбранных мультивыносок, содержащих 
блоки, в строки или столбцы с отображением результата с помощью одной вы-
носки.
mLEADEREDit – добавление линий выноски к объекту мультивыноски или их 
удаление.
mLEADERstYLE – создание и модификация стилей мультивыносок.
mLEDit – редактирование мультилиний.
mLiNE – построение мультилиний.
mLstYLE – описание стилей мультилиний.
mODEL – переключение из пространства листа в видовой экран пространства мо-
дели.
mOVE – перемещение объектов на заданное расстояние в указанном направлении.
mREDO – отмена действия команды UNDO. Допускается многократное повторе-
ние этой операции.
msLiDE – создание файла слайда из текущего видового экрана пространства мо-
дели или текущего листа.
msPACE – установка текущим пространства модели в видовом экране.
mtEDit – редактирование многострочного текста.
mtEXt – создание многострочных текстовых надписей.
mULtiPLE – многократное повторение следующей команды.
mViEw – создание видовых экранов на листах и управление ими.
mVsEtUP – настройка параметров рисунка.

N

NAVBAR – единый интерфейс для доступа к инструментам навигации и ориента-
ции.
NAVsmOtiON  – отображение на экране области, в которой можно с помощью 
кинематографической камеры создавать и воспроизводить анимации для обзора 
проекта и презентаций. В этой области возможна навигация с применением за-
кладок.
NAVsmOtiONCLOsE – закрытие диалогового окна аниматора движения. 
NAVswHEEL – усовершенствованный набор инструментов навигации, к которым 
предусмотрен быстрый доступ с помощью курсора.
NAVVCUBE  – указывает текущее направление обзора. При перетаскивании ин-
струмента Видовой куб или щелчке на нем сцена поворачивается.
NEtLOAD – загрузка приложения .NET.
NEw – создание файла рисунка.
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NEwsHEEtsEt – создание новой подшивки.
NEwsHOt – создание именованного вида с движением, воспроизводимым при 
проигрывании в Аниматоре движения.
NEwViEw – создание именованного вида без перемещений.

O

OBJECtsCALE – добавление или удаление поддерживаемых масштабов для ан-
нотативных объектов.
OFFsEt – построение эквидистанты, то есть концентрических окружностей, па-
раллельных отрезков или кривых, подобных существующим.
OLELiNKs – обновление, изменение и разрыв имеющихся OLE-связей.
OLEsCALE – настройка размера, масштаба и других свойств выбранного OLE-
объекта.
OOPs – восстановление объектов, стертых командой ERAsE.
OPEN – открытие существующего файла рисунка.
OPENDwFmARKUP – открытие DWF-файла с электронными пометками.
OPENsHEEtsEt – открытие выбранной подшивки.
OPtiONs – настройка параметров рабочей среды AutoCAD.
ORtHO – включение режима рисования только параллельно осям координат.
OsNAP – установка текущих режимов объектной привязки.

P

PAGEsEtUP – указание устройства печати, формата бумаги и других параметров 
для листов.
PAN – перемещение изображения на текущем видовом экране.
PARAmEtERs – управление ассоциативными параметрами в чертеже.
PARAmEtERsCLOsE – закрытие палитры Диспетчера параметров.
PARtiALOAD – дополнительная загрузка геометрии в частично открытый рису-
нок.
PARtiALOPEN – частичное открытие рисунка путем его загрузки в текущий ри-
сунок геометрии с выбранного вида или слоя.
PAstEAsHYPERLiNK – вставка данных из буфера обмена в формате гиперссыл-
ки.
PAstEBLOCK – вставка скопированных ранее объектов в виде блока.
PAstECLiP – вставка в активный рисунок содержимого буфера обмена Windows.
PAstEORiG – вставка скопированного блока в новый рисунок с координатами, 
которые этот блок имел в исходном рисунке.
PAstEsPEC – вставка данных из буфера обмена Windows, при которой обеспечи-
вается управление их форматом.
PCiNwiZARD – вызов Мастера импорта параметров печати из PCP- и PC2-
файлов для закладки Model или текущего листа.
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PDFADJUst – настройка слияния с фоном, контрастности и монохромного режи-
ма для подложки PDF.
PDFAttACH – вставка файла PDF в текущий чертеж в качестве подложки.
PDFCLiP – обрезка отображаемой области выбранной подложки PDF по задан-
ному контуру.
PDFLAYERs – управление отображением слоев в подложке PDF.
PEDit – редактирование полилиний и трехмерных полигональных сетей.
PFACE – создание многогранной сети произвольной сложности.
PLAN – установка вида в плане (сверху) относительно заданной ПСК.
PLANEsURF – создание плоской поверхности.
PLiNE – построение двухмерных полилиний.
PLOt – вывод рисунка на плоттер, принтер или в файл.
PLOtstAmP – нанесение штемпеля в определенном углу каждого чертежа и 
запись соответствующей информации в файл журнала.
PLOtstYLE – установка стиля печати для новых или выбранных объектов.
PLOttERmANAGER – вызов диалогового окна Plotter Manager, с помощью которо-
го можно настроить новый плоттер или изменить его конфигурацию.
PNGOUt – сохранение выбранных объектов в файле формата PNG (Portable 
Network Graphics).
POiNt – создание объекта-точки.
POiNtCLOUD – создание и прикрепление файла индексированного облака точек 
с возможностью выбора различных вариантов.
POiNtCLOUDAttACH  – вставка файла индексированного облака точек (PCG 
или ISD) в текущий чертеж.
POiNtCLOUDiNDEX – создание индексированного облака точек (PCG или ISD) 
из файла сканирования.
POiNtLiGHt – создание точечного источника света.
POLYGON – построение равносторонних многоугольников в виде замкнутых по-
лилиний.
POLYsOLiD – создание трехмерного политела.
PREssPULL – сжатие или растягивание ограниченных областей.
PREViEw – предварительный просмотр рисунка на экране перед выводом на печать.
PROJECtGEOmEtRY – проецирование точек, отрезков или кривых на трехмер-
ное тело или поверхность с разных направлений.
PROPERtiEs – управление свойствами объектов.
PROPERtiEsCLOsE – закрытие палитры свойств объектов.
PsEtUPiN – импорт набора параметров листа из другого файла рисунка во вновь 
создаваемый лист.
PsPACE – переключение видовых экранов из пространства модели в простран-
ство листа.
PUBLisH – создание многолистовых наборов рисунков для вывода в многолистовой 
файл формата DWF (Design Web Format), на устройство печати или в файл чертежа.
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PUBLisHtOwEB – создание HTML-страниц с изображениями выбранных ри-
сунков.
PURGE – очистка рисунка от неиспользуемых именованных объектов (например, 
блоков, слоев и пр.).
PYRAmiD – создание трехмерного тела пирамиды.

Q

QCCLOsE – закрытие калькулятора QuickCalc.
QDim – быстрое нанесение размера.
QLEADER – быстрое построение выноски и пояснения для нее.
QNEw – создание нового рисунка с использованием шаблона по умолчанию.
QsAVE – быстрое сохранение текущего рисунка.
QsELECt – быстрое создание наборов объектов на основе определенного крите-
рия выбора.
QtEXt – управление показом на экране и выводом на плоттер текста и атрибутов.
QUiCKCALC – загрузка калькулятора QuickCalc.
QUiCKCUi – отображение редактора адаптации интерфейса пользователя в свер-
нутом состоянии.
QUit – завершение работы с AutoCAD.
QVDRAwiNG – отображение открытых чертежей и листов в чертеже как образцов 
для просмотра.
QVDRAwiNGCLOsE – закрытие образцов для просмотра открытых чертежей и 
листов в чертеже.
QVLAYOUt – отображение образцов для просмотра пространства модели и листов 
в чертеже.
QVLAYOUtCLOsE  – закрытие образцов для просмотра пространства модели и 
лис тов в чертеже.

R

RAY – построение лучей, то есть линий, бесконечных в одном направлении.
RECOVER – восстановление поврежденного рисунка.
RECOVERALL – восстановление поврежденного файла чертежа вместе со всеми 
прикрепленными внешними ссылками.
RECtANG – построение полилинии в виде прямоугольника.
REDEFiNE – восстановление внутренних команд AutoCAD, подавленных коман-
дой UNDEFiNE.
REDO – отмена действия последней команды UNDO или U.
REDRAw – перерисовка содержимого текущего видового экрана.
REDRAwALL – перерисовка содержимого всех видовых экранов.
REFCLOsE – сохранение или отказ от изменений, произведенных в ходе редакти-
рования блоков или внешних ссылок.
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REFEDit – выбор вхождения блока или ссылки для редактирования.
REFsEt – добавление и исключение объектов из рабочего набора при редактиро-
вания блоков и внешних ссылок.
REGEN – регенерация рисунка и перерисовка содержимого текущего видового 
экрана.
REGENALL – регенерация рисунка и перерисовка всех видовых экранов.
REGENAUtO – управление автоматической регенерацией рисунка.
REGiON – преобразование объектов, ограничивающих некоторую площадь, в об-
ласти.
REiNit – повторная инициализация портов ввода-вывода, дигитайзера, монитора 
и файла параметров программ.
RENAmE – изменение имен объектов.
RENDER – создание реалистичного тонированного изображения трехмерной кар-
касной или твердотельной модели.
RENDERCROP – задание конкретного участка в изображении для тонирования, 
то есть окна кадрирования.
RENDERENViRONmENt – управление туманом и затемнением объектов для ви-
зуального представления удаленных расстояний.
RENDEREXPOsURE  – предоставление настроек для регулировки глобального 
освещения в последнем выводе визуализации.
RENDERPREsEts – задание предварительных настроек и повторно используе-
мых параметров тонирования изображения.
RENDERwiN – отображение окна тонирования без вызова задачи тонирования.
REsEtBLOCK – сброс одного или нескольких вхождений динамических блоков 
на значения описаний блоков по умолчанию.
REsUmE – возобновление прерванного процесса выполнения пакета (макроса).
REVCLOUD – создание полилиний с дуговыми сегментами, используемых в 
качест ве «облаков» для пометок.
REVERsE – обращение порядка вершин выбранных линий, полилиний, сплайнов 
и спиралей; эта функция удобна при работе с типами линий, предусматривающи-
ми включенный текст, а также с полилиниями, начало и конец которых различа-
ются по ширине.
REVOLVE – создание тела путем вращения двухмерных объектов вокруг оси.
REVsURF – создание поверхности вращения вокруг выбранной оси.
RiBBON – открытие окна ленты.
RiBBONCLOsE – закрытие окна ленты.
ROtAtE – поворот объектов вокруг заданной точки.
ROtAtE3D – поворот объектов вокруг оси в трехмерном пространстве.
RPREF – настройка режимов тонирования трехмерной модели.
RPREFCLOsE – закрытие палитры параметров тонирования.
RsCRiPt – повторное выполнение пакетного файла.
RULEsURF – создание трехмерной поверхности, натянутой на две кривые.
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s

sAVE – сохранение рисунка под текущим или заданным именем.
sAVEAs – сохранение рисунков, которым еще не было присвоено имя, или пере-
именование текущего рисунка.
sAVEimG – сохранение тонированных изображений в файлах.
sCALE – масштабирование объектов – пропорциональное изменение размеров 
объектов в направлениях X, Y и Z.
sCALEListEDit – управление списком доступных значений масштаба для видо-
вых экранов, листа и печати.
sCALEtEXt – изменение точки выравнивания для выбранных текстовых объек-
тов без изменения их положения.
sCRiPt – выполнение последовательности команд из пакетного (командного) 
файла (макроса).
sECtiON – создание областей (сечений) в результате пересечения плоскостей и 
тел.
sECtiONPLANE – создание объекта-сечения, который представляет собой секу-
щую плоскость, проходящую через трехмерный объект.
sECtiONPLANEJOG – добавление сегмента с изломом к объекту-сечению.
sECtiONPLANEsEttiNGs – установка параметров отображения для выбранной 
секущей плоскости.
sECtiONPLANEtOBLOCK – сохранение выбранных секущих плоскостей в качест-
ве двухмерных или трехмерных блоков.
sECURitYOPtiONs – управление настройками режимов безопасности.
sEEK – открытие веб-браузера и отображение домашней страницы Autodesk.
sELECt – занесение выбранных объектов в текущий набор.
sELECtsimiLAR – поиск всех объектов в текущем чертеже, которые соответству-
ют свойствам выбранных объектов и добавление их в набор.
sEtBYLAYER – изменение переопределения свойств выбранных объектов на зна-
чение ByLayer.
sEtiDROPHANDLER – выбор типа содержимого, вставляемого в текущее при-
ложение Autodesk из точек загрузки.
sEtUV – наложение текстур на поверхности трехмерных объектов.
sEtVAR – получение списка системных переменных, изменение их значений.
sHADEmODE – управление способом раскрашивания твердотельных объектов 
на текущем видовом экране.
sHAPE – вставка формы.
sHAREwitHsEEK  – отображение содержимого текущего чертежа на панелях 
DesignCenter при выборе вкладок Folders или Open Drawings.
sHEEtsEt – открытие Диспетчера подшивок.
sHEEtsEtHiDE – закрытие Диспетчера подшивок.
sHELL – доступ к командам операционной системы.
sHOwPALEttEs – восстановление отображения скрытых палитр.



667Перечень команд

siGVALiDAtE – вывод информации о цифровой подписи для файла.
sKEtCH – выполнение контурных эскизов «от руки».
sLiCE – формирование разреза трехмерного объекта.
sNAP – ограничение перемещения указателя мыши определенными интервалами 
в режиме шаговой привязки.
sOLDRAw – построение профилей и сечений на видовых экранах, созданных ко-
мандой sOLViEw.
sOLiD – создание закрашенных или контурных многоугольников.
sOLiDEDit – редактирование граней и ребер трехмерных тел.
sOLPROF – создание профилей трехмерных тел.
sOLViEw – создание плавающих видовых экранов, использующих ортогональ-
ную проекцию для размещения многовидовых рисунков и сечений твердотельных 
объектов и ACIS-тел.
sPACEtRANs – преобразование расстояний между единицами пространства мо-
дели и пространства листа.
sPELL – орфографическая проверка надписей в рисунке.
sPHERE – построение трехмерного твердотельного шара.
sPLiNE – создание неоднородных рациональных B-сплайнов (NURBS).
sPLiNEDit – редактирование сплайнов или сглаженных сплайнами полилиний.
sPOtLiGHt – создание прожектора.
stANDARDs – управление подключением файлов стандартов к рисункам 
AutoCAD.
stAtUs – вывод на экран статистической информации о рисунке, режимах и гра-
ницах.
stLOUt – сохранение тел в двоичном или ASCII-файле.
stREtCH – растягивание объектов путем перемещения одной из его частей без 
разрыва объектов.
stYLE – создание и изменение текстовых стилей, а также установка текущего тек-
стового стиля.
stYLEsmANAGER – вызов Диспетчера стилей печати Plot Style Manager.
sUBtRACt – создание составной области или тела путем булевой операции вы-
читания.
sUNPROPERtiEs – вызов диалогового окна определения свойств солнца.
sUNPROPERtiEsCLOsE – закрытие диалогового окна определения свойств 
солнца.
sURFBLEND – создание поверхности непрерывного перехода между двумя сущес-
твующими поверхностями.
sURFEXtEND – удлинение поверхности на заданное расстояние.
sURFFiLLEt – создание поверхности сопряжения между двумя другими поверх-
ностями.
sURFNEtwORK  – создание поверхности в пространстве между несколькими 
кривыми в направлениях осей U и V с использованием подобъектов-кромок по-
верхности и ребер тела.
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sURFOFFsEt – создание параллельной поверхности на заданном расстоянии от 
исходной поверхности.
sURFPAtCH  – создание поверхности, служащей ограничителем, по кромке по-
верхности, формирующей замкнутый контур.
sURFsCULPt – обрезка и объединение поверхностей, ограничивающих непро-
ницаемую область, с созданием тела.
sURFtRim – обрезка частей поверхности по линии пересечения с другой поверх-
ностью или геометрией другого типа.
sURFUNtRim  – восстановление областей поверхности, удаленных командой 
SURFTRIM.
swEEP – создание трехмерного тела или поверхности посредством сдвига дву-
мерной кривой вдоль траектории.
sYswiNDOws – упорядочение значков окон открытых рисунков.

t

tABLE – создание в рисунке незаполненного объекта-таблицы.
tABLEDit – редактирование текста в ячейке таблицы.
tABLEEXPORt – экспорт данных из таблицы в файл формата CSV.
tABLEstYLE – описание нового стиля таблиц.
tABLEt – настройка и калибровка планшета.
tABsURF – создание поверхности сдвига по определяющей кривой и вектору на-
правления.
tARGEtPOiNt – создание целевого точечного источника света.
tAsKBAR – управление отображением чертежей на панели задач Windows.
tEXt – создание однострочных текстовых надписей.
tEXtEDit  – редактирование размерной зависимости, размера или текстового 
объекта.
tEXtsCR – открытие текстового окна AutoCAD.
tEXttOFRONt – перемещение текста и размеров на передний план относительно 
всех остальных объектов рисунка.
tHiCKEN – создание трехмерного тела посредством утолщения поверхности.
tiFOUt – сохранение выбранных объектов в файле формата TIF.
timE – получение сведений о дате, времени и общей продолжительности работы 
над созданием и изменением рисунка.
tiNsERt – вставка блока в ячейку таблицы.
tOLERANCE – нанесение условных обозначений допусков формы и расположе-
ния поверхностей на чертеже.
tOOLBAR – включение, отключение и адаптация панелей инструментов.
tOOLPALEttEs – открытие окна инструментальных палитр.
tOOLPALEttEsCLOsE – закрытие окна инструментальных палитр.
tORUs – построение трехмерного твердотельного тора.
tPNAViGAtE – отображение заданной палитры инструментов или группы палитр.
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tRACE – построение линейных закрашенных сегментов заданной ширины.
tRANsPARENCY – управление прозрачностью фоновых пикселей растровых 
изображений.
tRAYsEttiNGs – управление показом значков и уведомлений в строке состоя-
ния.
tREEstAt – получение информации о пространственных индексах рисунка.
tRim – обрезка объекта по кромке, заданной другими объектами.

U

U – отмена действия последней выполненной команды.
UCs – управление пользовательскими системами координат.
UCsiCON – управление видимостью и расположением пиктограммы ПСК.
UCsmAN – управление пользовательскими системами координат, открытие диа-
логового окна UCS.
ULAYERs – управление отображением слоев в подложке DWF, DWFx, PDF или 
DGN.
UNDEFiNE – подавление внутренней команды AutoCAD одноименной командой, 
определенной в приложении.
UNDO – последовательная отмена команд текущего сеанса.
UNiON – создание составной области или тела путем булевой операции объеди-
нения.
UNisOLAtEOBJECts – отображение объектов, ранее скрытых с помощью команд 
isOLAtEOBJECts или HiDEOBJECts.
UNits – управление форматом и точностью представления линейных и угловых 
единиц измерения.
UPDAtEFiELD – обновление полей в выбранных объектах рисунка вручную.
UPDAtEtHUmBsNOw – обрезка объекта по кромке, формируемой другими объ-
ектами.

V

VBAiDE – вызов редактора Visual Basic.
VBALOAD – глобальная загрузка проекта VBA в текущий сеанс AutoCAD.
VBAmAN – загрузка, выгрузка, сохранение, создание, внедрение и извлечение 
проектов VBA.
VBARUN – запуск VBA-макроса.
VBAstmt – выполнение команды VBA-приложения в командной строке 
AutoCAD.
VBAUNLOAD – глобальная выгрузка проекта VBA.
ViEw – сохранение и восстановление именованных видов.
ViEwGO – восстановление именованного вида.
ViEwPLAY – воспроизведение анимации, связанной с именованным видом.
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ViEwPLOtDEtAiLs – отображение информации о выполненных задачах печати/
публикации.
ViEwREs – указание точности аппроксимации объектов на текущем видовом 
экране.
VisUALstYLEs – создание и изменение визуальных стилей и применение 
визуаль ного стиля к видовому экрану.
VisUALstYLEsCLOsE – закрытие Диспетчера визуальных стилей.
VLisP – вызов интегрированной среды разработки приложений Visual LISP.
VPCLiP – подрезка объектов на видовых экранах.
VPLAYER – управление видимостью слоев для отдельных видовых экранов.
VPmAX – развертывание текущего видового экрана листа для редактирования.
VPmiN – сворачивание текущего видового экрана листа до прежнего состояния.
VPOiNt – установка в пространстве направления взгляда на трехмерный объект.
VPORts – деление области рисования на несколько неперекрывающихся или 
плавающих видовых экранов.
VsCURRENt – задание визуального стиля в текущем видовом экране.
VsLiDE – просмотр файла-слайда на текущем видовом экране.
VssAVE – сохранение визуального стиля.
VtOPtiONs – отображение изменения в виде плавного перехода.

w

wALKFLYsEttiNGs – настройка параметров обхода и облета.
wBLOCK – запись набора объектов или блока в отдельный файл.
wEBLiGHt – создание источника сеточного света.
wEDGE – построение трехмерного клиновидного тела с наклонной гранью, при-
ближающейся к оси X.
wHOHAs – выдача информации о том, кем открыт указанный файл рисунка.
wiPEOUt – скрытие существующих объектов рисунка за маскирующим объектом 
цвета фона.
wmFiN – импорт графической информации в формате метафайла Windows.
wmFOPts – настройка параметров команды wmFiN.
wmFOUt – экспорт объектов в файл формата WMF (Windows metafile).
wORKsPACE – создание, измение и сохрание рабочего пространства, а также на-
значение его текущим.
wssAVE – сохранение рабочего пространства.
wssEttiNGs – задание параметров рабочих пространств.

X

XAttACH – вставка внешних ссылок в текущий рисунок.
XBiND – внедрение именованных объектов, определенных во внешней ссылке, в 
текущий рисунок.
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XCLiP – присвоение контура подрезки внешней ссылке или блоку и установка 
передней и задней плоскостей обрезки.
XEDGEs – создание геометрии каркаса посредством извлечения ребер из трех-
мерного тела или поверхности.
XLiNE – построение бесконечных прямых линий.
XOPEN – открытие выбранной внешней ссылки в новом окне.
XPLODE – разбиение составного объекта на составляющие объекты.
XREF – управление внешними ссылками.

Z

ZOOm – увеличение или уменьшение видимого размера объектов на текущем ви-
довом экране.



Приложение.2...
Перечень.системных.
переменных
Системные переменные управляют работой функций AutoCAD и различными 
аспектами поведения рабочей среды программы. От установки системных пере-
менных зависит характер работы большинства команд. Системные переменные: 
задают различные режимы рисования, размеры объектов, лимиты рисунка; хранят 
информацию о текущем рисунке и конфигурации AutoCAD, числовых или тек-
стовых данных; служат для включения или отключения параметров. Обычно зна-
чения системных переменных изменяют в полях диалоговых окон соответствую-
щих команд, но можно менять и непосредственно в командной строке, что в ряде 
случаев выполняется быстрее.

Просматривать и изменять значения системных переменных можно в прозрач-
ном режиме, но при этом новые значения могут не вступить в действие до завер-
шения приостановленной команды.

Ниже приведен перечень системных переменных AutoCAD.

3D

3DDwFPREC – управление точностью публикации 3D DWF. Диапазон значений 
переменной от 1 до 6.
3DCONVERsiONmODE – служит для преобразования определений материалов 
и источников света в текущую версию программы. 
3DOsmODE – задание параметров 3D-объектной привязки.
3DsELECtiONmODE – управление приоритетом выбора визуально перекрываю-
щихся объектов при использовании 3D-визуальных стилей. 

A

ACADLsPAsDOC – запись в реестр целого числа, управляющего режимом загруз-
ки файла acad.lsp во все документы. Значения переменной:

0 – только при открытии первого рисунка в сеансе AutoCAD (начальное зна-
чение);

1 – с каждым открываемым рисунком
ACADPREFiX – предназначенная только для чтения строковая переменная, обо-
значающая имя каталога, задаваемое переменной среды AutoCAD, с добавлением 
разделителей (если путей несколько).
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ACADVER – предназначенная только для чтения строковая переменная, обозна-
чающая номер версии AutoCAD. Не совпадает с переменной $ACADVER заголовка 
DXF-файла, в которой содержится номер уровня базы данных рисунка.
ACisOUtVER – управление версией ACIS SAT-файлов, создаваемых командой 
ACisOUt, поддерживающей значения от 15 до 18, 20, 21, 30, 40, 50, 60 и 70. На-
чальное значение 70.
ACtPAtH – задание дополнительных путей поиска макросов операций для вос-
произведения. 
ACtRECORDERstAtE – задание текущего состояния рекордера операций. 
ACtRECPAtH – задание пути для сохранения новых макросов операций. 
ACtUi – управление поведением панели рекордера операций при записи и вос-
произведении макросов. 
ADCstAtE – предназначенная только для чтения целая переменная, обозначаю-
щая состояние активности Центра управления. Позволяет разработчикам прило-
жений определять статус доступа к файлу рисунка с помощью функций AutoLISP. 
Значения переменной:

0 – Центр управления отключен;
1 – Центр управления включен.

AFLAGs – битовый код флагов атрибута для команды AttDEF. Значения переменной:
0 – ни один из флагов не задан (начальное значение);
1 – скрытый;
2 – постоянный;
4 – контролируемый;
8 – установленный;
16 – зафиксировать положение в блоке.

При установке нескольких режимов одновременно значения переменных 
суммируются.
ANGBAsE – вещественная переменная, записываемая в рисунок, обозначающая 
направление угла 0 градусов в текущей ПСК. Начальное значение 0.0000.
ANGDiR – целая переменная, записываемая в рисунок, задающая положительное 
направление отсчета углов относительно нулевого направления текущей ПСК. 
Значения переменной:

0 – против часовой стрелки (начальное значение);
1 – по часовой стрелке.

ANNOALLVisiBLE – скрытие или отображение аннотативных объектов, не под-
держивающих масштаба текущей аннотации. 
ANNOAUtOsCALE – обновление аннотативных объектов в соответствии с мас-
штабом аннотации при изменении масштаба аннотаций. 
ANNOtAtiVEDwG – включение/выключение возможности вставки чертежа в 
другой чертеж в качестве аннотативного блока. 
APBOX – целая переменная, записываемая в реестр, включающая и отключающая 
отображение прицела автопривязки. Значения переменной:
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0 – прицел автопривязки отключен (начальное значение);
1 – прицел автопривязки включен.

APERtURE – целая переменная, записываемая в реестр, задающая размер при-
цела объектной привязки в пикселах. Значения переменной от 1 до 50. Начальное 
значение 10.
APPLYGLOBALOPACitiEs – применение параметров прозрачности ко всем палит-
рам. 
APstAtE – целая переменная, сохраняющая значение, которое указывает, что от-
крыта Палитра вариаций блоков в редакторе блоков. Значения переменной:

0 – закрыть (начальное значение);
1 – открыть.

AREA – вещественная переменная, предназначенная только для чтения, хранящая 
последнее значение площади, вычисленное командой AREA.
AttDiA – целая переменная, записываемая в реестр, управляющая интерфейсом 
команды iNsERt при задании значений атрибутов. Значения переменной:

0 – выводятся запросы в командной строке (начальное значение);
1 – используется диалоговое окно.

AttiPE – управляет отображением контекстного редактора, предназначенного 
для создания многострочных атрибутов. 
AttmODE – целая переменная, записываемая в рисунок, управляющая состояни-
ем видимости атрибутов в рисунке. Значения переменной:

0 – все атрибуты невидимы;
1 – сохраняется текущее состояние видимости каждого из атрибутов. Види-

мые атрибуты отображаются, скрытые – нет (начальное значение);
2 – все атрибуты видны.

AttmULti – управляет возможностью создания многострочных атрибутов. 
AttREQ – целая переменная, записываемая в реестр, управляющая режимом ис-
пользования значений атрибутов по умолчанию в команде iNsERt. Значения 
переменной:

0 – для всех атрибутов принимаются значения по умолчанию;
1 – для каждого атрибута выдается запрос значения или диалоговое окно, в 

зависимости от режима, установленного в переменной ATTDIA (начальное 
значение).

AUDitCtL – целая переменная, записываемая в реестр, управляющая созданием 
файла протокола проверки (ADT) при выполнении команды AUDit. Значения 
переменной:

0 – файл не создается (начальное значение);
1 – файл создается.

AUNits – целая переменная, записываемая в рисунок, определяющая единицы 
измерения углов. Значения переменной:

0 – десятичные градусы (начальное значение);
1 – градусы/минуты/секунды;
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2 – грады;
3 – радианы;
4 – топографические единицы.

AUPREC – целая переменная, записываемая в рисунок, определяющая коли-
чество десятичных знаков в значениях углов. Начальное значение 0.
AUtODwFPUBLisH  – управление автоматическим созданием файлов DWF 
(Design Web Format) при сохранении и закрытии файлов чертежей (DWG).
AUtOmAtiCPUB – управление автоматическим созданием электронных файлов 
(DWF/PDF) при сохранении или закрытии файлов чертежа (DWG). 
AUtOsNAP – целая переменная, записываемая в реестр, управляющая маркером, 
всплывающей подсказкой и магнитом автопривязки, а также включением и от-
ключением полярного и объектного отслеживаний, всплывающими при их ис-
пользовании подсказками. Значения переменной:

0 – все подавляется;
1 – включение маркера автопривязки;
2 – включение подсказок автопривязки;
4 – включение магнита автопривязки;
8 – включение полярного отслеживания;
16 – включение объектного отслеживания;
32 – включение подсказок полярного и объектного отслеживаний.

При установке нескольких режимов одновременно значения переменных сум-
мируются. Начальное значение 63.

B

BACKGROUNDPLOt – целая переменная, записываемая в реестр, управляющая ре-
жимом фонового вывода в операциях печати и публикации. Значения переменной:

0 – передний план;
1 – фон;
2 – передний план (начальное значение);
3 – фон.

BACKZ – вещественная переменная, записываемая в рисунок, обозначающая сме-
щение задней секущей плоскости от плоскости цели для текущего видового экра-
на в условных единицах.
BACtiONBARmODE – указывает, отображаются ли в редакторе блоков панели 
операций и объекты операций из предыдущих версий. 
BACtiONCOLOR – строковая переменная, записываемая в реестр, устанавливаю-
щая цвет текста для операций, выполняемых в редакторе блоков. Значения вы-
бираются из стандартного списка: BYLAYER, BYBLOCK и целые числа от 1 до 255. 
Начальное значение переменной 7.
BCONstAtUsmODE  – включение и выключение статуса отображения зависи-
мостей и управление тонированием объектов на основе назначенного им уровня 
зависимостей. 
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BDEPENDENCYHiGHLiGHt – целая переменная, записываемая в реестр, управ-
ляющая наличием выделенных взаимосвязей в зависимых объектах, когда пара-
метр, действие или сетка выбраны в редакторе блоков. Значения переменной:

0 – указывает, что зависимые объекты не выделены;
1 – указывает, что зависимые объекты выделены (начальное значение).

BGRiPOBJCOLOR – строковая переменная, записываемая в реестр, 
устанавливаю щая цвет ручек в редакторе блоков. Значения выбираются из стан-
дартного списка: BYLAYER, BYBLOCK и целые числа от 1 до 255. Начальное значе-
ние переменной 141.
BGRiPOBJsiZE – целая переменная, записываемая в реестр, устанавливающая 
отображаемый размер настраиваемых ручек в редакторе блоков относительно 
экранной системы. Допустимые значения содержат целые числа от 1 до 255. На-
чальное значение переменной 8.
BiNDtYPE – незаписываемая целая переменная, управляющая обработкой имен 
зависимых символов при внедрении внешних ссылок и при редактировании 
вхождений. Значения переменной:

0 – традиционный способ (xref1|one преобразуется в xref$0$one) (началь-
ное значение);

1 – способ, аналогичный вставке блоков (xref1|one преобразуется в one).
BLiPmODE – целая переменная, записываемая в реестр, управляющая видимо-
стью маркеров рисования. Значения переменной:

0 – маркеры отключены (начальное значение);
1 – маркеры включены.

BLOCKEDitLOCK – целая переменная, записываемая в реестр, запрещающая от-
крытие редактора блоков и редактирование определений динамических блоков. 
Значения переменной:

0 – указывает на то, что редактор блока можно открыть (начальное значение);
1 – указывает на то, что редактор блока нельзя открыть.

BLOCKEDitOR – незаписываемая целая переменная, отражающая состояние ре-
дактора блока: открыт или не открыт. Значения переменной:

0 – означает, что редактор блока не открыт (начальное значение);
1 – означает, что редактор блока открыт.

BLOCKtEstwiNDOw – указывает на то, является ли окно тестирования блока 
текущим. 
BPARAmEtERCOLOR – строковая переменная, записываемая в реестр, задающая 
цвет параметров в редакторе блоков. Значения выбираются из стандартного списка: 
BYLAYER, BYBLOCK и целые числа от 1 до 255. Начальное значение переменной 7.
BPARAmEtERFONt – строковая переменная, записываемая в реестр, задающая 
шрифт, используемый для параметров и операций в редакторе блоков. Начальное 
значение переменной Simplex.shx.
BPARAmEtERsiZE – целая переменная, записываемая в реестр, устанавливаю-
щая размер текста и функций параметра в редакторе блоков относительно экран-
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ной системы . Допустимые значения содержат целые числа от 1 до 255. Начальное 
значение переменной 12.
BPtEXtHORiZONtAL  – принудительное горизонтальное расположение текста, 
отображаемого для параметров операций и параметров зависимостей в редакторе 
блоков. 
BtmARKDisPLAY – целая переменная, записываемая в реестр, управляющая 
отобра жением меток наборов значений для вхождений динамического блока. Зна-
чения переменной:

0 – указывает, что метки наборов значений не отображаются;
1 – указывает, что метки наборов значений отображаются (начальное значе-

ние).
BVmODE – незаписываемая целая переменная, управляющая способом отобра-
жения объектов, которые становятся невидимыми для текущего состояния види-
мости, в редакторе блока. Значения переменной:

0 – указывает, что скрытые объекты невидимы (начальное значение);
1 – указывает, что скрытые объекты видимы, но отображаются серым цветом.

C

CALCiNPUt – целая переменная, записываемая в реестр, управляющая вычисле-
нием математических выражений и глобальных констант в полях для ввода тек-
стовых или числовых данных. Значения переменной:

0 – выражения не вычисляются;
1 – выражения вычисляются после нажатия клавиш Alt+Enter (начальное зна-

чение).
CAmERADisPLAY – целая переменная, записываемая в рисунок, включающая 

или выключающая отображение объектов камеры. Значения переменной:
0 – символьные обозначения камеры не выводятся на экран (начальное зна-

чение);
1 – символьные обозначения камеры выводятся на экран.

CAmERAHEiGHt – целая переменная, записываемая в рисунок, задающая зна-
чение высоты по умолчанию для новых объектов камеры. Высота выражается в 
текущих единицах чертежа. Начальное значение переменной 0.
CANNOsCALE – задание имени текущего масштаба аннотации для текущего про-
странства. 
CANNOsCALEVALUE – отображение значения текущего масштаба аннотации. 
CAPtUREtHUmBNAiLs  – указывает, следует ли создавать эскизы для инстру-
мента перемотки и когда их создавать. 
CBARtRANsPARENCY – управление прозрачностью панелей зависимостей. 
CCONstRAiNtFORm – управление применением аннотационных или динами-
ческих зависимостей к объектам. 
CDAtE – незаписываемая вещественная переменная, обозначающая текущую 
дату и время суток.
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CECOLOR – строковая переменная, записываемая в рисунок, устанавливающая 
цвета вновь создаваемых объектов. Значения выбираются из стандартного списка: 
BYLAYER, BYBLOCK и целые числа от 1 до 255. Значения цветов полноцветного 
режима вводятся как уровни RGB-составляющих (целые числа от 1 до 255), раз-
деленные запятыми. Значение цвета имеет следующий формат RGB:000,000,000. 
Начальное значение переменной BYLAYER.
CELtsCALE – вещественная переменная, записываемая в рисунок, задающая те-
кущий масштаб типа линии объекта. Начальное значение переменной 1.0000.
CELtYPE – строковая переменная, записываемая в рисунок, устанавливающая те-
кущий тип линии для новых объектов. Начальное значение BYLAYER.
CELwEiGHt – целая переменная, записываемая в рисунок, устанавливающая зна-
чения текущего веса (толщины) линий для новых объектов. Значения переменной:

-1 – установка веса линий BYLAYER (начальное значение);
-2 – установка веса линий BYBLOCK;
-3 – установка веса линий NORMAL, контролируется системной переменной 

LWDEFAULT.
Другие допустимые значения: 0, 5, 9, 13, 15, 18, 20, 25, 30, 35, 40, 50, 53, 60, 70, 

80, 90, 100, 106, 120, 140, 158, 200 и 211. Значения соответствуют сотым долям 
миллиметра.
CENtERmt – целая переменная, записываемая в пользовательские настройки, 
управляющая растягиванием центрированного по горизонтали многострочного 
текста с помощью ручек. Значение переменной не применяется для растягивания 
многострочного текста с помощью линейки в текстовом редакторе, используемом 
в месте редактирования. Значения переменной:

0 – при перемещении угловой ручки центрированного многострочного текста 
центральная ручка перемещается в том же направлении, а ручка на проти-
воположной стороне остается на месте (начальное значение);

1 – при перемещении угловой ручки центрированного многострочного текста 
центральная ручка остается на месте, и оба набора боковых ручек переме-
щаются в направлении растягивания.

CEtRANsPARENCY – задание уровня прозрачности для новых объектов. 
CHAmFERA – вещественная переменная, записываемая в рисунок, задающая пер-
вую длину фаски команды CHAmFER при создании по двум длинам. Начальное 
значение 0.0000.
CHAmFERB – вещественная переменная, записываемая в рисунок, задающая вто-
рую длину фаски команды CHAmFER при создании по двум длинам. Начальное 
значение 0.0000.
CHAmFERC – вещественная переменная, записываемая в рисунок, задающая 
длину фаски команды CHAmFER при создании по двум длинам. Начальное зна-
чение 0.0000.
CHAmFERD – вещественная переменная, записываемая в рисунок, задающая угол 
фаски команды CHAmFER при создании по длине и углу. Начальное значение 
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0.0000.
CHAmmODE – незаписываемая целая переменная, определяющая метод созда-
ния фасок в AutoCAD. Значения переменной:

0 – по двум длинам (начальное значение);
1 – по одной длине и углу.

CiRCLERAD – незаписываемая вещественная переменная, определяющая радиус, 
предлагаемый по умолчанию при выполнении команды CiRCLE. При перемен-
ной, равной 0, значение по умолчанию отсутствует. Начальное значение 0.0000.
CLAssiCKEYs – задание способа функционирования сочетаний клавиш быстро-
го вызова: по правилам AutoCAD, независимым от Windows, или по правилам 
Windows. 
CLAYER – строковая переменная, записываемая в рисунок, устанавливающая имя 
текущего слоя. Начальное значение 0.
CLEANsCREENstAtE – незаписываемая целая переменная, сохраняющая значе-
ние, которое указывает на включение состояния очистки экрана. Значения пере-
менной:

0 – отключено (начальное значение);
1 – включено.

CListAtE – незаписываемая целая переменная, сохраняющая значение, которое ука-
зывает состояние окна команды: скрыто или отображается. Значения переменной:

0 – скрытие;
1 – отображение (начальное значение).

CmAtERiAL – строковая переменная, записываемая в рисунок, устанавливающая 
материал для новых объектов. Начальное значение BYLAYER.
CmDACtiVE – целая переменная, предназначенная только для чтения, определяю-
щая битовый код, указывающий, активны ли в данный момент обычная команда, 
прозрачная команда, пакет команд и (или) диалоговое окно. Значения перемен-
ной:

1 – активна обычная команда;
2 – активны обычная команда и прозрачная команда;
4 – активен пакет команд;
8 – активно диалоговое окно;
16 – активно DDE;
32 – активен AutoLISP (работает только для команд ObjectARX);
64 – активна команда ObjectARX.

При установке нескольких режимов одновременно значения переменных 
суммируются.
CmDDiA – целая переменная, записываемая в реестр, управляющая отображени-
ем текстового редактора, используемого в месте редактирования при простановке 
линий-выносок. Значения переменной:

0 – отключен;
1 – включен (начальное значение).
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CmDECHO – незаписываемая целая переменная, управляющая отображением 
подсказок и ввода при выполнении функции AutoLISP command. Значения пере-
менной:

0 – подсказки и вводимые значения не отображаются;
1 – подсказки и вводимые значения отображаются (начальное значение).

CmDiNPUtHistORYmAX – целая переменная, записываемая в реестр, устанав-
ливающая максимальное число предыдущих значений ввода, которые хранятся 
в команде для запроса. Управление отображением последних введенных пользо-
вателем команд осуществляется системной переменной INPUTHISTORYMODE. На-
чальное значение 20.
CmDNAmEs – строковая переменная, предназначенная только для чтения, выво-
дит английское имя действующей или прозрачной команды.
CmLEADERstYLE – задание имени текущего стиля мультивыноски. 
CmLJUst – целая переменная, записываемая в рисунок, определяющая тип рас-
положения мультилинии. Значения переменной:

0 – по верху (начальное значение);
1 – по середине;
2 – по низу.

CmLsCALE – вещественная переменная, записываемая в рисунок, управляющая 
шириной мультилинии. Начальное значение 1.0000 (британские единицы) или 
20.0000 (метрические единицы).
CmLstYLE – строковая переменная, записываемая в рисунок, задающая текущее 
имя стиля мультилинии. Начальное значение STANDARD.
COmPAss – незаписываемая целая переменная, управляющая показом трехмер-
ного компаса на текущем видовом экране. Значения переменной:

0 – компас отключен (начальное значение);
1 – компас включен.

CONstRAiNtBARDisPLAY  – управление отображением панелей зависимостей 
после применения зависимостей и при выборе чертежей с геометрическими за-
висимостями. 
CONstRAiNtBARmODE – управление отображением геометрических зависимо-
стей на панелях зависимостей. 
CONstRAiNtiNFER – определяет, налагаются ли подразумеваемые геометриче-
ские зависимости при рисовании и редактировании геометрических объектов. 
CONstRAiNtNAmEFORmAt – управление форматом текста в размерных зави-
симостях. 
CONstRAiNtRELAX – указывает на то, активизированы или сняты зависимости 
во время редактирования объекта. 
CONstRAiNtsOLVEmODE – управление поведением зависимостей при их при-
менении или редактировании. 
COORDs – целая переменная, записываемая в реестр, управляющая режимом 
отображения координат в строке состояния. Значения переменной:
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0 – координаты обновляются при указании точек;
1 – отслеживаются текущие абсолютные координаты курсора (начальное зна-

чение);
2 – отображаются динамически обновляемые абсолютные координаты; при 

запросах ввода расстояний и углов отображаются расстояние и угол, взя-
тые относительно последней указанной точки.

COPYmODE – управляет автоматическим повтором команды COPY. 
CPLOtstYLE – строковая переменная, записываемая в рисунок, определяющая 
текущий стиль печати для вновь создаваемых объектов. Значения переменной:

BYLAYER;
BYBLOCK;
NORMAL;
USERDEFINED.

CPROFiLE – строковая переменная, записываемая в реестр, предназначенная 
только для чтения, определяющая имя текущего профиля. Начальное значение 
Unnamed Profile.
CROssiNGAREACOLOR – целая переменная, записываемая в реестр, управляю-
щая цветом области выбора в процессе выбора секущей рамки. Допустимый диа-
пазон значений от 1 до 255. При этом должна быть активизирована системная 
переменная SELECTIONAREA. Начальное значение переменной 3 (зеленый).
CsHADOw – целая переменная, записываемая в рисунок, задающая свойство 
отображения теней для трехмерного объекта. Для обеспечения видимости следу-
ет включить отображение теней в стиле отображения, применяемом к видовому 
экрану. Значения переменной:

0 – отображает отбрасываемую и принимаемую тень (начальное значение);
1 – отображает отбрасываемую тень;
2 – отображает принимаемую тень;
3 – игнорирует тени.

CtAB – строковая переменная, записываемая в рисунок, определяющая имя теку-
щей вкладки в рисунке (модель или один из листов).
CtABLEstYLE – строковая переменная, записываемая в рисунок, определяющая 
имя текущего стиля таблиц. Начальное значение STANDARD.
CULLiNGOBJ – управление возможностью выделения или выбора 3D-подобъек-
тов, скрытых на виде. 
CULLiNGOBJsELECtiON  – управление возможностью выделения или выбора 
3D-объектов, скрытых на виде. 
CURsORsiZE – целая переменная, записываемая в реестр, определяющая размер 
перекрестья в процентном отношении к размеру экрана. Допустимые значения 
находятся в интервале от 1 до 100. При значении 100 экран полностью перекры-
вается курсором. Начальное значение 5.
CVPORt – целая переменная, записываемая в рисунок, задающая номер-иденти-
фикатор текущего видового экрана. Начальное значение 2.



Приложение 2682

D

DAtALiNKNOtiFY – управление уведомлением об обновленных или отсутствую-
щих связях с данными. 
DAtE – незаписываемая вещественная переменная, предназначенная только для 
чтения текущей даты и времени суток.
DBCstAtE – целая переменная, записываемая в рисунок, предназначенная толь-
ко для чтения индикатора активности Диспетчера связи с базами данных. Значе-
ния переменной:

0 – диспетчер подключения к БД не отображается (начальное значение);
1 – диспетчер подключения к БД отображается.

DBLCLKEDit – целая переменная, записываемая в реестр, определяющая дейст-
вие по редактированию, выполняемое при двойном нажатии левой кнопки мыши 
в области чертежа. Значения переменной:

0 – сигнал неактивен;
1 – сигнал активен (начальное значение).

DBmOD – незаписываемая целая переменная, предназначенная только для чте-
ния, хранящая битовый код, определяющий состояние изменений в рисунке. Код 
является суммой следующих значений:

1 – изменена база данных объектов;
4 – изменена переменная базы данных;
8 – изменено окно;
16 – изменен вид;
32 – изменено поле.

При сохранении чертежа AutoCAD сбрасывает значение переменной в 0.
DCtCUst – строковая переменная, записываемая в реестр, определяющая путь и 
имя файла текущего вспомогательного орфографического словаря для проверки 
правописания.
DCtmAiN – строковая переменная, записываемая в реестр, определяющая имя 
файла текущего основного орфографического словаря. Значения переменных:

enu – английский (американский вариант);
ena – английский (австралийский вариант);
ens – английский (британский вариант, ise);
enz – английский (британский вариант, ize);
ca – каталонский;
cs– чешский;
da – датский;
nl – нидерландский (основной);
nls – нидерландский (вторичный);
fi – финский;
fr – французский (с недиакритическими прописными);
fra – французский (с диакритическими прописными);
de – немецкий (с эсцетом);
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ded – немецкий (без эсцета);
it – итальянский;
no – норвежский (Bokmal);
non – норвежский (Nynorsk);
pt – португальский (Португалия);
ptb – португальский (Бразилия);
ru – русский (без символа е);
rui – русский (с символом е);
es – испанский (с недиакритическими прописными);
esa – испанский (с диакритическими прописными);
sv – шведский.

DEFAULtGiZmO  – установка гизмо 3D-переноса, 3D-поворота или 3D-масшта-
бирования в качестве принимаемого по умолчанию, когда выполняется выбор 
под объектов.
DEFAULtLiGHtiNG – целая переменная, записываемая в рисунок, управляющая 
освещением по умолчанию в текущем видовом экране. Освещение по умолчанию 
обеспечивается набором удаленных источников света, которые светят в направле-
нии вида. Значения переменной:

0 – освещение по умолчанию автоматически отключается, если включаются 
точечные источники света, прожекторы, удаленное освещение или сол-
нечный свет;

1 – включено (начальное значение).
DEFAULtLiGHtiNGtYPE – целая переменная, записываемая в рисунок, указываю-
щая тип освещения по умолчанию. В программе AutoCAD 2006 и более ранних 
версиях использовался один удаленный источник света в качестве освещения по 
умолчанию. В новом освещении по умолчанию используются два удаленных ис-
точника света, что позволяет обеспечить лучшее освещение модели, а также ре-
гулировать рассеянный свет. Установка этой системной переменной зависит от 
видового экрана. Значения переменной:

0 – старый тип освещения по умолчанию;
1 – новый тип освещения по умолчанию (начальное значение).

DEFLPLstYLE – строковая переменная, записываемая в реестр, определяющая 
текущий стиль печати для слоя 0.
DEFPLstYLE – строковая переменная, записываемая в реестр, определяющая те-
кущий стиль печати для новых объектов. Начальное значение ByLayer.
DELOBJ – целая переменная, записываемая в реестр, управляющая сохранением 
или удалением геометрических объектов, использованных для создания трехмер-
ных объектов Значения переменной:

0 – исходные объекты остаются в рисунке;
1 – исходные объекты удаляются(начальное значение);
2 – исходные объекты остаются в рисунке;
-1 – исходные объекты остаются в рисунке;
-2 – исходные объекты остаются в рисунке.
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DEmANDLOAD – целая переменная, записываемая в реестр, управляющая пове-
дением AutoCAD при обнаружении в рисунке объектов, созданных во внешних 
приложениях. Значения переменной:

0 – отключение подгрузки;
1 – режим подгрузки стороннего приложения при открытии рисунка, который 

содержит объекты, созданные в этом приложении. Это значение не вы-
зывает подгрузку приложения при вызове одной из определенных в нем 
команд;

2 – режим подгрузки стороннего приложения при вызове одной из определен-
ных в нем команд. Это значение не вызывает подгрузку приложения при 
открытии рисунка, в котором содержатся принадлежащие приложению 
объекты;

3 – режим подгрузки стороннего приложения при открытии рисунка, который 
содержит объекты, созданные в этом приложении, или при вызове одной 
из определенных в нем команд (начальное значение).

DGNFRAmE – определение отображения или печати контуров подложки DGN в 
текущем чертеже. 
DGNimPORtmAX – устанавливает максимальное число элементов, преобразуе-
мых при импорте файла DGN. 
DGNmAPPiNGPAtH – задание папки для файла dgnsetups.ini, в котором хранятся 
параметры соответствия DGN. 
DGNOsNAP – определяет активность привязки объекта к геометрии в подложках 
DGN, прикрепленных к чертежу. 
DiAstAt – незаписываемая целая переменная, предназначенная только для чте-
ния, определяющая способ выхода из последнего диалогового окна. Значения 
переменной:

0 – кнопкой Cancel;
1 – кнопкой OK.

DiGitiZER – определение дигитайзеров, подключенных к системе. 
DimADEC – целая переменная, записываемая в рисунок, управляющая точностью 
угловых размеров. Значение по умолчанию 0. Значения переменной:

-1 – число десятичных знаков в угловых размерах равно значению системной 
переменной DIMDEC;

0-8 – число десятичных знаков в угловых размерах равно значению систем-
ной переменной DIMADEC.

DimALt – переключаюшаяся переменная, записываемая в рисунок, управляющая 
альтернативными единицами в размерах. Значения переменной:

OFF – альтернативные единицы отключены (начальное значение);
ON – включены.

DimALtD – целая переменная, записываемая в рисунок, управляющая точностью 
представления (задание числа знаков после запятой) альтернативных единиц в 
размерах. Начальное значение 2.
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DimALtF – вещественная переменная, записываемая в рисунок, управляющая ко-
эффициентом пересчета для альтернативных единиц в размерах. Начальное зна-
чение 25.4000.
DimALtRND – вещественная переменная, записываемая в рисунок, определяю-
щая округление альтернативных единиц измерения. Начальное значение 0.00.
DimALttD – целая переменная, записываемая в рисунок, определяющая коли-
чество десятичных знаков в значениях допусков для альтернативных размерных 
единиц. Начальное значение 2.
DimALttZ – целая переменная, записываемая в рисунок, управляющая подавле-
нием нулей в допусках создаваемых размеров. Значения переменной:

0 – нулевые значения удаляются и для футов, и для дюймов (начальное зна-
чение);

1 – нулевые значения не удаляются ни для футов, ни для дюймов;
2 – нулевые значения удаляются только для дюймов;
3 – нулевые значения удаляются только для футов;
4 – в десятичных размерах удаляются ведущие нули (например, 0.2000 ста-

новится .2000);
8 – в десятичных размерах удаляются замыкающие нули (например, 4.2000 

становится 4.2).
При установке нескольких режимов одновременно значения переменных 

суммируются.
DimALtU – целая переменная, записываемая в рисунок, определяющая формат 
единиц для всех видов альтернативных размеров, за исключением угловых. При 
значениях переменной:

1 – научные;
2 – десятичные (начальное значение);
3 – технические;
4 – архитектурные (с горизонтальной чертой);
5 – дробные (с горизонтальной чертой);
6 – архитектурные;
7 – дробные;
8 – установленные в Windows.

DimALtZ – целая переменная, записываемая в рисунок, управляющая подавлени-
ем нулей в альтернативных размерных единицах создаваемых размеров. Значения 
переменной:

0 – нулевые значения удаляются и для футов, и для дюймов (начальное зна-
чение);

1 – нулевые значения не удаляются ни для футов, ни для дюймов;
2 – нулевые значения удаляются только для дюймов;
3 – нулевые значения удаляются только для футов;
4 – в десятичных размерах удаляются ведущие нули (например, 0.2000 ста-

новится .2000);
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8 – в десятичных размерах удаляются замыкающие нули (например, 4.2000 
становится 4.2);

12 – в десятичных размерах удаляются и ведущие, и замыкающие нули (на-
пример, 0.2000 становится .2).

При установке нескольких режимов одновременно значения переменных 
суммируются.
DimANNO – указывает, является ли текущий размерный стиль аннотативным. 
DimAPOst – строковая переменная, записываемая в рисунок, определяющая 
строку, которая присоединяется в конец любых размеров в альтернативных еди-
ницах измерения, за исключением угловых.
DimARCsYm – целая переменная, записываемая в рисунок, управляющая отобра-
жением символа дуги в размере длины дуги. Значения переменной:

0 – помещает символы длины дуги перед текстом размера (начальное значе-
ние);

1 – помещает символы длины дуги над текстом размера;
2 – запрещает отображение символов длины дуги.

DimAssOC – целая переменная, записываемая в рисунок, управляющая ассоциа-
тивностью размерных объектов. Значения переменной:

0 – наносятся расчлененные размеры. Связь между элементами размера от-
сутствует. Составляющие размер отрезки, дуги, стрелки и текст строятся 
как отдельные объекты;

1 – наносятся неассоциативные размеры. Все составляющие размер элемен-
ты представляют собой единый объект. При перемещении определяющей 
точки размера его значение автоматически пересчитывается.

2 – наносятся ассоциативные размеры. Все составляющие размер элементы 
представляют собой единый объект. Кроме того, одна или несколько опре-
деляющих точек размера связаны с точками прикрепления на геометриче-
ских объектах. При перемещении точки прикрепления местоположение 
размера, его ориентация и значение автоматически обновляются (началь-
ное значение).

DimAsZ – вещественная переменная, записываемая в рисунок, управляющая вели-
чинами стрелок на концах размерной линии и выноски. Начальное значение: 0.1800.
DimAtFit – целая переменная, записываемая в рисунок, управляющая размеще-
нием размерного текста и стрелок, если для того и другого одновременно недоста-
точно места между выносными линиями. Значения переменной:

0 – и текст, и стрелки размещаются за пределами выносных линий;
1 – вначале премещаются стрелки, затем текст;
2 – вначале перемещается текст, затем стрелки;
3 – размещение выполняется автоматически и оптимально (начальное значе-

ние).
DimAUNit – целая переменная, записываемая в рисунок, определяющая формат 
единиц измерения для угловых размеров. Значения переменной:
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0 – десятичные градусы (начальное значение);
1 – градусы/минуты/секунды;
2 – грады;
3 – радианы.

DimAZiN – целая переменная, записываемая в рисунок, определяющая режим по-
давления нулей в размерном числе угловых размеров. Значения переменной:

0 – отображаются все ведущие и замыкающие нули (начальное значение);
1 – в десятичных размерах удаляются ведущие нули (например, 0.2000 ста-

новится .2000);
2 – в десятичных размерах удаляются замыкающие нули (например, 4.2000 

становится 4.2);
3 – в десятичных размерах удаляются и ведущие, и замыкающие нули (напри-

мер, 0.2000 становится .2).
DimBLK – строковая переменная, записываемая в рисунок, определяющая блок, 
используемый для стрелок на концах размерных линий и выносок. Значения пе-
ременной:

DOT – точка;
DOTSMALL – малая точка;
DOTBLANK – контурная точка;
ORIGIN – указатель начала;
ORIGIN2 – указатель начала 2;
OPEN – разомкнутая;
OPEN90 – прямой угол;
OPEN30 – разомкнутая 30;
CLOSED – замкнутая;
SMALL – контурная малая точка;
NONE – нет;
OBLIQUE – засечка;
BOXFILLED – заполненный прямоугольник;
BOXBLANK – прямоугольник;
CLOSEDBLANK – пустая замкнутая;
DATUMFILLED – заполненный треугольник;
DATUMBLANK – треугольник;
INTEGRAL – интеграл;
ARCHTICK – двойная засечка.

DimBLK1 – строковая переменная, записываемая в рисунок, определяющая стрел-
кау на первом конце размерной линии (при включенной переменной DIMSAH).
DimBLK2 – строковая переменная, записываемая в рисунок, определяющая стрел-
кау на втором конце размерной линии (при включенной переменной DIMSAH).
DimCEN – вещественная переменная, записываемая в рисунок, управляю-
щая нанесением маркеров центра и центровых линий кругов и дуг в командах 
DimCENtER, DimDiAmEtER и DimRADiUs. Начальное значение 0.0900. Зна-
чения переменной:



Приложение 2688

0 – не строятся ни маркеры центра, ни осевые линии;
<0 – строятся осевые линии;
>0 – строятся маркеры центра.

DimCLRD – целая переменная, записываемая в рисунок, определяющая цвет раз-
мерных линий, стрелок и выносных линий. Начальное значение 0.
DimCLRE – целая переменная, записываемая в рисунок, определяющая цвет вы-
носных линий размеров. Начальное значение 0.
DimCLRt – целая переменная, записываемая в рисунок, определяющая цвет раз-
мерного текста. Начальное значение 0.
DimCONstRAiNtiCON – отображение значка блокировки размерных зависимо-
стей рядом с текстом. 
DimDEC – целая переменная, записываемая в рисунок, определяющая коли-
чество десятичных знаков для основных размерных единиц. Начальное значе-
ние 4.
DimDLE – вещественная переменная, записываемая в рисунок, определяющая ве-
личину, на которую размерная линия будет выступать за выносную линию при 
использовании засечек в качестве стрелок. Начальное значение 0.0000.
DimDLi – вещественная переменная, записываемая в рисунок, управляющая рас-
стоянием между соседними размерными линиями в базовых размерах. Начальное 
значение 0.3800.
DimDsEP – вещественная переменная, записываемая в рисунок, определяющая 
верхнее предельное отклонение или наибольший предельный размер (при вклю-
ченных переменных DIMTOL или DIMLIM). Начальное значение 0.0000.
DimEXE – вещественная переменная, записываемая в рисунок, определяющая 
расстояние, на которое выносная линия должна выступать за размерную линию. 
Начальное значение 0.1800.
DimEXO – вещественная переменная, записываемая в рисунок, определяющая 
величину смещения выносных линий относительно заданных начальных точек. 
Начальное значение 0.0625.
DimFRAC – целая переменная, записываемая в рисунок, определяющая формат 
дробей в случаях, когда DIMLUNIT имеет значение 4 (архитектурные) или 5 (дроб-
ные). Значения переменной:

0 – горизонтальная черта (начальное значение);
1 – диагональная черта;
2 – на одном уровне.

DimFXL – вещественная переменная, записываемая в рисунок, устанавливающая 
общую длину выносных линий от размерной линии до исходной точки размера. 
Длина устанавливается в единицах чертежа. Начальное значение 1.0000.
DimFXLON – переключающаяся переменная, записываемая в рисунок, управляю-
щая установкой фиксированной длины выносных линий. Если значением этой 
переменной является ON, то длина выносных линий устанавливается равной дли-
не, заданной в переменной DIMFXL.
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DimGAP – вещественная переменная, записываемая в рисунок, определяющая 
расстояние, оставляемое пустым при нанесении размерного текста в разрыве раз-
мерной линии. Начальное значение 0.0900.
DimJOGANG – вещественная переменная, записываемая в рисунок, определяю-
щая угол поперечного сегмента размерной линии в ломаной линии размера радиу-
са. Ломаные линии размеров радиуса строятся в случаях, когда центр расположен 
за пределами страницы. Начальное значение 45 (90 в метрических размерах).
DimJUst – целая переменная, записываемая в рисунок, управляющая положени-
ем размерного текста по горизонтали. Значения переменной:

0 – вдоль размерной линии, центрированной между выносными (начальное 
значение);

1 – у первой выносной линии;
2 – у второй выносной линии;
3 – вдоль первой выносной линии;
4 – вдоль второй выносной линии.

DimLDRBLK – строковая переменная, записываемая в рисунок, определяющая 
тип стрелки на конце линии-выноски. Полный список стрелок приведен в описа-
нии переменной DIMBLK.
DimLFAC – вещественная переменная, записываемая в рисунок, определяющая ко-
эффициент масштабирования для линейных размеров. Начальное значение 1.0000.
DimLim – переключающаяся переменная, записываемая в рисунок, управляющая 
генерацией размерного текста в формате Limits. Значения переменной:

OFF – размерный текст не генерируется в формате Limits (начальное значе-
ние);

ON – размерный текст генерируется в формате Limits.
DimLtEX1 – строковая переменная, записываемая в рисунок, устанавливающая 
тип первой выносной линии. Значением переменной могут быть BYLAYER, BYBLOCK 
или имя типа линии.
DimLtEX2 – строковая переменная, записываемая в рисунок, устанавливающая 
тип второй выносной линии. Значением переменной могут быть BYLAYER, BYBLOCK 
или имя типа линии.
DimLtYPE – строковая переменная, записываемая в рисунок, устанавливающая 
тип размерной линии. Значением переменной могут быть BYLAYER, BYBLOCK или 
имя типа линии.
DimLUNit – целая переменная, записываемая в рисунок, управляющая форматом 
единиц для всех видов размеров, кроме угловых. Значения переменной:

1 – научные;
2 – десятичные (начальное значение);
3 – инженерные;
4 – архитектурные (с горизонтальной чертой);
5 – дробные (с горизонтальной чертой);
6 – установленные в Windows.
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DimLwD – значение из стандартного списка, записываемое в рисунок, определяю-
щее вес (толщину) размерных линий. Значения переменной:

-3 – обычный (значение LWDEFAULT)
-2 – BYLAYER (начальное значение);
-1 – BYBLOCK;

либо целые числа, представляющие количество сотых долей миллиметра.
DimLwE – значение из стандартного списка, записываемое в рисунок, определяю-
щее вес (толщину) выносных линий. Значения переменной:

-3 – обычный (значение LWDEFAULT)
-2 – BYLAYER (начальное значение);
-1 – BYBLOCK;

либо целые числа, представляющие количество сотых долей миллиметра.
DimPOst – строковая переменная, записываемая в рисунок, определяющая 
строку, которая присоединяется в начало или конец (или в начало и конец) раз-
меров.
DimRND – вещественная переменная, записываемая в рисунок, определяющая 
точность округления всех линейных размеров. Начальное значение 0.0000.
DimsAH – переключаемая переменная, записываемая в рисунок, управляющая 
использованием блоков нестандартных окончаний размерных линий. Значения 
переменной:

OFF – используются блоки стрелок, заданные в переменной DIMBLK (началь-
ное значение);

ON – используются блоки стрелок, заданные в переменных DIMBLK1 и DIMBLK2.
DimsCALE – вещественная переменная, записываемая в рисунок, определяющая 
глобальный коэффициент масштабирования, применяемый ко всем размерным 
блокам, которые выражают протяженность объектов, расстояния и смещения, а 
также выноскам. Начальное значение 1.0000. Значения переменной:

0.0 – приемлемое значение по умолчанию вычисляется путем масштабиро-
вания между текущими видовыми экранами пространства модели и про-
странством листа. Если пространство листа не используется, коэффици-
ент равен 1.0;

>0 – вычисляется коэффициент масштабирования, который направляет раз-
меры текста, размеры стрелок и другие масштабируемые величины на пе-
чать с их номинальными значениями.

DimsD1 – переключаемая переменная, записываемая в рисунок, во включенном 
состоянии подавляющая первую размерную линию. Начальное значение OFF.
DimsD2 – переключаемая переменная, записываемая в рисунок, во включенном 
состоянии подавляющая вторую размерную линию. Начальное значение OFF.
DimsE1 – переключаемая переменная, записываемая в рисунок, во включенном 
состоянии подавляющая первую выносную линию. Начальное значение OFF.
DimsE2 – переключаемая переменная, записываемая в рисунок, во включенном 
состоянии подавляющая вторую выносную линию. Начальное значение OFF.
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DimsOXD – переключаемая переменная, записываемая в рисунок, во включен-
ном состоянии подавляющая отображение стрелок при отсутствии достаточного 
пространства между выносными линиями. Значения переменной:

OFF – стрелки не подавляются (начальное значение);
ON – стрелки подавляются;

DimstYLE – строковая переменная, записываемая в рисунок, предназначенная 
только для чтения, хранящая имя текущего размерного стиля. Начальное значе-
ние STANDARD.
DimtAD – целая переменная, записываемая в рисунок, управляющая вертикаль-
ным расположением текста относительно размерной линии. Значения переменной:

0 – текст располагается по центру между двумя выносными линиями;
1 – текст располагается над размерной линией;
2 – текст размещается рядом с размерной линией со стороны, наиболее уда-

ленной от определяющих точек;
3 – текст размещается согласно требованиям промышленных стандартов Япо-

нии (Japanese Industrial Standarts, JIS).
DimtDEC – целая переменная, записываемая в рисунок, определяющая коли-
чество десятичных знаков для значений допусков в основных единицах. Началь-
ное значение 4.
DimtFAC – вещественная переменная, записываемая в рисунок, определяющая 
коэффициент масштабирования для расчета высоты текста дробных частей раз-
меров и допусков относительно высоты размерного текста, заданной в перемен-
ной DIMTXT. Начальное значение 1.0000.
DimtFiLL – целая переменная, записываемая в рисунок, управляющая фоном 
размерного текста. Значения переменной:

0 – фон отсутствует (начальное значение);
1 – цвет фона чертежа;
2 – фон, заданный переменной DIMTFILLCLR.

DimtFiLLCLR – целая переменная, записываемая в рисунок, устанавливающая 
цветом фона текста в размерах. Номера цветов отображаются в диалоговом окне 
выбора цвета. Начальное значение 0.
DimtiH – переключаемая переменная, записываемая в рисунок, управляющая 
ориентацией размерного текста для всех типов размеров, кроме ординатных, если 
текст вписывается между выносными линиями. Значения переменной:

OFF – текст размещается вдоль размерной линии;
ON – текст размещается горизонтально (начальное значение).

DimtiX – переключаемая переменная, записываемая в рисунок, управляющая раз-
мещением размерного текста между выносными линиями. Значения переменной:

OFF – в линейных и угловых размерах текст создается между выносными ли-
ниями при наличии места (начальное значение);

ON – размерный текст всегда наносится между выносными линиями, даже 
если обычно он размещается вне их.
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Dimtm – вещественная переменная, записываемая в рисунок, определяющая 
нижнее предельное отклонение или наименьший предельный размер, если DIMTOL 
или DIMLIM включены. Если значения переменных DIMTM и DIMTP различны, верх-
нее отклонение размещается над нижним. Начальное значение 0.0000.
DimtmOVE – целая переменная, записываемая в рисунок, определяющая прави-
ла перемещения размерного текста. Значения переменной:

0 – размерный текст перемещается вместе с размерной линией (начальное 
значение);

1 – к перемещенному размерному тексту строится выноска;
2 – размерный текст перемещается свободно.

DimtOFL – переключаемая переменная, записываемая в рисунок, управляющая 
построением размерной линии между выносными линиями, даже если текст раз-
мещается вне линий. Значения переменной:

OFF – размерная линия не рисуется между образмеренными точками, если раз-
мерные стрелки размещаются вне этих точек (начальное значение);

ON – размерная линия рисуется между образмеренными точками, даже если 
размерные стрелки размещаются вне этих точек.

DimtOH – переключаемая переменная, записываемая в рисунок, управляющая 
положением размерного текста за выносными линиями. Значения переменной:

OFF – текст размещается вдоль размерной линии (начальное значение);
ON – текст размещается горизонтально.

DimtOL – переключаемая переменная, записываемая в рисунок, управляющая 
добавлением предельного отклонения в конец размерного текста. Начальное зна-
чение OFF.
DimtOLJ – целая переменная, записываемая в рисунок, управляющая выравни-
ванием вертикального отклонения относительно размерного текста номинала. 
Значения переменной:

0 – по низу;
1 – по середине (начальное значение);
2 – по верху.

DimtP – вещественная переменная, записываемая в рисунок, определяющая 
верхнее предельное отклонение или наибольший предельный размер, если DIMTOL 
или DIMLIM включены. Начальное значение 0.0000.
DimtsZ – вещественная переменная, записываемая в рисунок, определяющая 
размер засечки, которая наносится вместо стрелки в линейных размерах, радиусах 
и диаметрах. Начальное значение 0.0000. Значения переменной:

0 – рисуются стрелки;
>0 – вместо стрелок рисуются засечки. Величина засечки определяется произ-

ведением значений DIMTSZ и DIMSCALE.
DimtVP – вещественная переменная, записываемая в рисунок, регулирующая 
вертикальное положение размерного текста над или под размерной линией. При 
значении, меньшем 0.7, размерная линия разрывается. Начальное значение 
0.0000.



693Перечень системных переменных

DimtXstY – строковая переменная, записываемая в рисунок, определяющая тек-
стовый стиль для размера. Начальное значение  STANDARD.
DimtXt – вещественная переменная, записываемая в рисунок, определяющая 
высоту размерного текста, если он не имеет фиксированную высоту. Начальное 
значение 0.1800.
DimtXtDiRECtiON – указывает направление чтения размерного текста. 
DimtZiN – целая переменная, записываемая в рисунок, управляющая удалением 
нулей в допусках линейных размеров. Значения переменной:

0 – нулевые значения подавляются и для футов, и для дюймов (начальное 
значение);

1 – нулевые значения не подавляются ни для футов, ни для дюймов;
2 – нулевые значения подавляются только для дюймов;
3 – нулевые значения подавляются только для футов;
4 – в десятичных размерах подавляются ведущие нули (например, 0.2000 ста-

новится .2000);
8 – в десятичных размерах подавляются замыкающие нули (например, 4.2000 

становится 4.2);
12 – в десятичных размерах подавляются и ведущие, и замыкающие нули (на-

пример, 0.2000 становится .2).
При установке нескольких режимов одновременно значения переменных 

суммируются.
DimUPt – переключающаяся переменная, записываемая в рисунок, управляю-
щая действием курсора при пользовательском расположении текста. Значения 
переменной:

OFF – курсор задает только положение размерной линии (начальное значе-
ние);

ON – курсор задает и положение текста, и положение размерной линии.
DimZiN – целая переменная, записываемая в рисунок, управляющая удалением 
нулей в размерном тексте основных единиц измерения. Значения переменной:

0 – нулевые значения удаляются и для футов, и для дюймов (начальное зна-
чение);

1 – нулевые значения не удаляются ни для футов, ни для дюймов;
2 – нулевые значения удаляются только для дюймов;
3 – нулевые значения удаляются только для футов;
4 – в десятичных размерах удаляются ведущие нули (например, 0.2000 ста-

новится .2000);
8 – в десятичных размерах удаляются замыкающие нули (например, 4.2000 

становится 4.2);
12 – в десятичных размерах удаляются и ведущие, и замыкающие нули (на-

пример, 0.2000 становится .2).
При установке нескольких режимов одновременно значения переменных 

суммируются.
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DisPsiLH – целая переменная, записываемая в рисунок, управляющая показом 
кромок силуэта твердотельных объектов в каркасном представлении. Значения 
переменных:

0 – линия силуэта не отображается (начальное значение);
1 – линия силуэта отображается.

DistANCE – незаписываемая вещественная переменная, предназначенная только 
для чтения, хранящая последнее значение расстояния, вычисленное командой DIST.
DiVmEsHBOXHEiGHt – устанавливает количество делений для высоты сети-
ящика по оси Z. 
DiVmEsHBOXLENGtH – устанавливает количество делений для длины сети-
ящика по оси X. 
DiVmEsHBOXwiDtH – устанавливает количество делений для ширины сети-
ящика по оси Y. 
DiVmEsHCONEAXis – устанавливает количество делений по периметру основа-
ния сети-конуса. 
DiVmEsHCONEBAsE – устанавливает количество делений между периметром и 
центральной точкой основания сети-конуса. 
DiVmEsHCONEHEiGHt – устанавливает количество делений между основанием 
и точкой или вершиной сети-конуса. 
DiVmEsHCYLAXis – устанавливает количество делений по периметру основания 
сети-цилиндра. 
DiVmEsHCYLBAsE – устанавливает количество радиальных делений от центра 
основания сети-цилиндра до его периметра. 
DiVmEsHCYLHEiGHt – устанавливает количество делений между основанием и 
вершиной сети-цилиндра. 
DiVmEsHPYRBAsE – устанавливает количество радиальных делений между 
центром основания сети-пирамиды и его периметром. 
DiVmEsHPYRHEiGHt – устанавливает количество делений между основанием и 
вершиной сети-пирамиды. 
DiVmEsHPYRLENGtH – устанавливает количество делений для каждого из раз-
меров основания сети-пирамиды. 
DiVmEsHsPHEREAXis – устанавливает количество радиальных делений вокруг 
конечной точки оси сети-шара. 
DiVmEsHsPHEREHEiGHt – устанавливает количество делений между двумя 
конечными точками оси сети-шара. 
DiVmEsHtORUsPAtH – устанавливает количество делений на траектории, об-
разованной сдвигом профиля сети-тора. 
DiVmEsHtORUssECtiON – устанавливает количество делений в профиле, в ре-
зультате сдвига которого образуется траектория сети-тора. 
DiVmEsHwEDGEBAsE – устанавливает количество делений между средней точ-
кой периметра треугольного размера сети-клина. 
DiVmEsHwEDGEHEiGHt – устанавливает количество делений для высоты сети-
клина по оси Z. 
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DiVmEsHwEDGELENGtH – устанавливает количество делений для длины сети-
клина по оси X. 
DiVmEsHwEDGEsLOPE – устанавливает количество делений уклона, образуе-
мого соединением вершины клина с кромкой его основания. 
DiVmEsHwEDGEwiDtH – устанавливает количество делений для ширины сети-
клина по оси Y. 
DONUtiD – незаписываемая вещественная переменная, хранящая текущее зна-
чение внутреннего диаметра кольца по умолчанию. Начальное значение 0.5000.
DONUtOD – незаписываемая вещественная переменная, хранящая текущее зна-
чение внешнего диаметра кольца по умолчанию. Значение должно быть ненуле-
вым. Начальное значение 1.0000.
DRAGmODE – целая переменная, записываемая в реестр, управляющая отобра-
жением объектов при перетаскивании. Значения переменной:

0 – объекты не отображаются;
1 – объекты отображаются при вводе ключа Drag (следить) в командной стро-

ке (после выбора объекта);
2 – контуры перетаскиваемых объектов отображаются всегда (начальное зна-

чение).
DRAGP1 – целая переменная, записываемая в реестр, управляющая частотой ре-
генерации объекта при отслеживании. Начальное значение 10.
DRAGP2 – целая переменная, записываемая в реестр, управляющая частотой ре-
генерации объекта при быстром отслеживании. Начальное значение 25.
DRAGVs – строковая переменная, записываемая в чертеж, устанавливающая ви-
зуальный стиль при создании трехмерный твердотельных примитивов и выдав-
ленных тел и поверхностей.
DRAwORDERCtL – целая переменная, записываемая в рисунок, управляющая 
работой функции, устанавливающей порядок следования объектов. Значения 
переменной:

0 – отключение стандартного отображения объектов с порядком следования: 
после редактирования объектов они видимы всегда, независимо от их по-
рядка следования, до завершения регенерации рисунка или до повторного 
открытия рисунка. Также отключает наследование порядка следования: 
новым объектам, созданным из объектов с порядком следования, не назна-
чается порядок следования первоначально выбранного первым объекта;

1 – включение стандартного отображения объектов с порядком следования: 
после редактирования объектов они отображаются автоматически в соот-
ветствии с правильным порядком следования;

2 – включение наследования порядка следования: новым объектам, создан-
ным из объектов с порядком следования, назначается порядок следования 
первоначально выбранного первым объекта;

3 – все возможности функции порядка следования. Включение правильного 
отображения объектов с порядком следования, а также наследования по-
рядка следования (начальное значение).
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DRstAtE – незаписываемая целая переменная, определяющая, активно ли диа-
логовое окно восстановления чертежа. Значения переменной:

0 – диалоговое окно восстановления чертежа не активно;
1 – диалоговое окно восстановления чертежа активно.

DtEXtED – целая переменная, записываемая в реестр, задающая интерфейс поль-
зователя, выводимый на экран для редактирования однострочного текста. Значе-
ния переменной:

0 – выводит на экран текстовый редактор, используемый в месте редактиро-
вания;

1 – выводит на экран текстовую подсказку создания текста и позволяет 
указать любое место на чертеже для создания нового текстового блока. 
А также выводит на экран диалоговое окно правки текста для его изме-
нения;

2 – диалоговое окно восстановления чертежа активно (начальное значение).
DwFFRAmE – целая переменная, записываемая в рисунок, определяющая види-
мость контура подложки DWF. Значения переменной:

0 – контур подложки DWF не видим и не печатается;
1 – контур подложки DWF отображается и может быть напечатан;
2 – контур подложки DWF отображается, но не печатается (начальное значе-

ние).
DwFOsNAP – целая переменная, записываемая в реестр, определяющая актив-
ность привязки объекта для геометрии в подложках DWF, прикрепленных к чер-
тежу. Значения переменной:

0 – привязка объекта запрещена для геометрии во всех вложениях подложки 
DWF чертежа;

1 – привязка объекта разрешена для геометрии во всех вложениях подложки 
DWF чертежа (начальное значение).

DwGCHECK – целая переменная, записываемая в реестр, управляющая провер-
кой рисунков на корректность при их открытии. Значения переменной:

0 – если в рисунке, который предстоит открыть, содержатся ошибки, перед от-
крытием выводится предупреждение об этом (начальное значение);

1 – если в рисунке, который предстоит открыть, содержатся ошибки, или он 
был сохранен в другом приложении (не в AutoCAD или AutoCAD LT), 
перед открытием выводится предупреждение об этом;

2 – если в рисунке, который предстоит открыть, содержатся ошибки, выво-
дится предупреждение об этом в командной строке;

3 – если в рисунке, который предстоит открыть, содержатся ошибки, выводит-
ся предупреждение об этом в командной строке. Если в открываемом ри-
сунке содержатся ошибки или он был сохранен в приложении, отличном 
от AutoCAD или AutoCAD LT, выводится предупреждение.

DwGCODEPAGE – строковая переменная, записываемая в рисунок, предназна-
ченная только для чтения, хранящая то же значение, что и SYSCODEPAGE (для це-
лей совместимости).
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DwGNAmE – незаписываемая строковая переменная, предназначенная только 
для чтения, хранящая имя рисунка, введенного пользователем. Начальное значе-
ние Drawing.dwg.
DwGPREFiX – незаписываемая строковая переменная, предназначенная только 
для чтения, хранящая путь к рисунку (диск и папка).
DwGtitLED – незаписываемая целая переменная, предназначенная только для 
чтения, указывающая, присвоено ли текущему рисунку имя. Значения перемен-
ной:

0 – имя не присвоено;
1 – имя присвоено.

DXEVAL – задает условия сравнения таблиц извлечения данных с источником 
данных и, если данные устарели, отображает уведомление о необходимости об-
новления. 
DYNCONstRAiNtmODE – отображение скрытых размерных зависимостей при 
выборе объектов с наложенными зависимостями.
DYNDiGRiP – битовый код, записываемый в реестр, управляющий отображением 
динамических размеров во время растягивания ручками. Системной переменной 
DYNDIVIS необходимо присвоить значение 2, которое отображает все динамиче-
ские размеры. Значения переменной:

0 – нет;
1 – результирующий размер;
2 – размер изменения длины;
4 – размер абсолютного угла;
8 – размер изменения угла;
16 – размер радиуса дуги.

Начальное значение переменной 31.
DYNDiVis – целая переменная, записываемая в пользовательские настройки, 
управляющая отображением количества динамических размеров во время растя-
гивания ручками. Значения переменной:

0 – только первый динамический размер в циклической последовательности;
1 – только первые два размера в циклической последовательности (начальное 

значение);
2 – все динамические размеры, определяемые системной переменной 

DYNDIGRIP.
DYNmODE – целая переменная, записываемая в пользовательские настройки, 
включающая и отключающая функции динамического ввода. Когда все функции 
включены, контекст управляет отображением. Значения переменной:

0 – все функции динамического ввода, в том числе динамические подсказки, 
отключены;

1 – ввод указателя включен;
2 – размерный ввод включен;
3 – ввод указателя и размерный ввод включены (начальное значение).
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DYNPiCOORDs – переключаемая переменная, записываемая в пользовательские 
настройки, контролирующая, используются ли для ввода с помощью мыши абсо-
лютные или относительные координаты. Значения переменной:

0 – относительные (начальное значение);
1 – абсолютные.

DYNPiFORmAt – переключаемая переменная, записываемая в пользовательские 
настройки, контролирующая, используется ли для ввода с помощью мыши фор-
мат полярных или декартовых координат. Этот параметр применяется только для 
второй или следующей точки. Значения переменной:

0 – полярные (начальное значение);
1 – декартовы.

DYNPiVis – целая переменная, записываемая в пользовательские настройки, 
управляющая отображением ввода с помощью мыши. Значения переменной:

0 – только при вводе в запросе точки;
1 – автоматически в запросе точки (начальное значение);
2 – всегда.

DYNPROmPt – целая переменная, записываемая в пользовательские настройки, 
управляющая отображением подсказок динамического ввода. Значения переменной:

0 – отключено;
1 – включено (начальное значение).

DYNtOOLtiPs – переключаемая переменная, записываемая в пользовательские 
настройки, управляющая выбором подсказок, на которые влияют параметры 
внешнего вида подсказок. Значения переменной:

0 – только поля значений динамического ввода;
1 – все подсказки на чертеже (начальное значение).

E

EDGEmODE – целая переменная, записываемая в реестр, управляющая режимом 
определения режущих и граничных кромок для команд tRim и EXtEND. Значе-
ния переменной:

0 – выбранная кромка используется в своих текущих границах (начальное 
значение);

1 – объект удлиняется или обрезается до точки пересечения с воображаемым 
продолжением режущего или граничного объекта.

ELEVAtiON – вещественная переменная, записываемая в рисунок отдельно по 
видовым экранам, определяющая действующее значение уровня (относительно 
текущей ПСК) текущего видового экрана в текущем пространстве. Начальное 
значение 0.0000.
ENtERPRisEmENU – строковая переменная, записываемая в реестр, сохраняю-
щая, включая путь, имя файла MNU, если оно определено.
ERRNO – отображает номер соответствующего кода ошибки, когда вызов функ-
ции AutoLISP приводит к ошибке, выявленной AutoCAD. 
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ERRNO – незаписываемая целая переменная, предназначенная только для чте-
ния, содержащая номер ошибки, сформированный AutoCAD при обнаружении 
некорректного завершения AutoLISP-функции. Начальное значение 0.
ERstAtE – незаписываемая целая переменная, определяющая активность палит-
ры внешних ссылок. Значения переменной:

0 – не активна;
1 – активна.

EXPERt – незаписываемая целая переменная, управляющая отображением за-
просов командной строки. Значения переменной:

0 – все запросы отображаются обычным образом (начальное значение);
1 – подавляются запросы о регенерации и выключении текущего слоя;
2 – подавляются в дополнение к вышеперечисленным запросы о переопреде-

лении блока и записи рисунка поверх другого с тем же именем;
3 – подавляются в дополнение к вышеперечисленным запросы о повторной 

загрузке или записи в файл определения типа линии поверх другого с тем 
же именем;

4 – подавляются в дополнение к вышеперечисленным запросы о переопреде-
лении с используемыми именами ПСК и видовых экранов;

5 – подавляются в дополнение к вышеперечисленным запросы о переопреде-
лении с используемыми именами размерных стилей.

EXPORtEPLOtFORmAt – установка принимаемого по умолчанию типа файла, 
выводимого в электронном виде: PDF, DWF или DWFx. 
EXPORtmODELsPACE – определение части чертежа, подлежащей экспорту из 
пространства модели в файл DWF, DWFx или PDF.
EXPORtPAPERsPACE – определение части чертежа, подлежащей экспорту из 
пространства листа в файл DWF, DWFx или PDF. 
EXPORtPAGEsEtUP – определение того, должен ли экспорт в файл DWF, DWFx 
или PDF производиться с текущими настройками листа. 
EXPLmODE – незаписываемая целая переменная, управляющая обработкой 
блоков с разными масштабами вставки в команде EXPLODE. Значения перемен-
ной:

0 – блоки не расчленяются;
1 – блоки расчленяются (начальное значение);

EXtmAX – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, определяющая координаты верхней правой границы рабочей области 
рисунка.
EXtmiN – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, определяющая координаты левой нижней границы рабочей области 
рисунка.
EXtNAmEs – целая переменная, записываемая в рисунок, определяющая формат 
имен элементов символьных таблиц (типов линий, слоев и др.). Значения пере-
менной:
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0 – использует параметры AutoCAD Release 14, которые ограничивают длину 
имен до 31 символа. В них могут входить буквы от A до Z, цифры от 0 до 9 и не-
которые специальные символы – знак доллара $, подчеркивание _ и дефис -;

1 – по соглашениям AutoCAD 2000 и более поздних версий. Имена могут со-
держать до 255 символов. В них могут входить буквы от A до Z, цифры 
от 0 до 9, пробелы и специальные символы, не используемые Microsoft® 
Windows® и AutoCAD в других целях (начальное значение).

F

FACEtERDEVNORmAL – установка максимального угла между нормалью к по-
верхности и смежными гранями сети. 
FACEtERDEVsURFACE – установка степени сохранения первоначальной формы 
тела или поверхности в преобразованном объекте-сети. 
FACEtERGRiDRAtiO – установка максимального соотношения размеров для де-
лений сети, создаваемых для преобразуемых в сеть тел и поверхностей. 
FACEtERmAXEDGELENGtH – установка максимальной длины кромок для объ-
ектов-сетей, создаваемых в результате преобразования из тел и поверхностей. 
FACEtERmAXGRiD – установка максимального количества линий сетки U и V 
для преобразуемых в сеть тел и поверхностей. 
FACEtERmEsHtYPE – установка типа создаваемой сетки. 
FACEtERmiNUGRiD – установка минимального количества линий сетки U для 
преобразуемых в сеть тел и поверхностей. 
FACEtERmiNVGRiD – установка минимального количества линий сетки V для 
преобразуемых в сеть тел и поверхностей. 
FACEtERPRimitiVEmODE – указание источника вывода настроек сглаживания 
для преобразуемых в сеть объектов: выводятся они из диалогового окна парамет-
ров тесселяции сети или из диалогового окна параметров сетевых примитивов. 
FACEtERsmOOtHLEV – установка степени сглаживания, принимаемого по 
умолчанию для объектов, преобразуемых в сеть. 
FACEtRAtiO – незаписываемая целая переменная, управляющая плотностью се-
тевого представления цилиндрических и конических тел. Значение 1 увеличивает 
плотность сетки и улучшает качество тонирования. Значения переменной:

0 – создание для цилиндрических и конических тел сетки размером N на 1 
(начальное значение);

1 – создание для цилиндрических и конических тел сетки размером N на M.
FACEtREs – вещественная переменная, записываемая в рисунок, регулирующая 
гладкости раскрашенных и тонированных твердотельных трехмерных объектов, а 
также объектов с подавленными скрытыми линиями: диапазон допустимых зна-
чений переменной от 0.01 до 10.0. Начальное значение 0.5.
FiELDDisPLAY – вещественная переменная, записываемая в рисунок, управляю-
щая отображением полей на сером фоне. На печать фон не выводится. Значения 
переменной:
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0 – поля отображаются без фона;
1 – поля отображаются на сером фоне (начальное значение).

FiELDEVAL – целая переменная, записываемая в рисунок, управляющая режимом 
обновления полей. Начальное значение 31. Значение задается битовым кодом, ко-
торый является суммой следующих значений:

0 – не обновляются;
1 – обновляются при открытии;
2 – обновляются при сохранении;
4 – обновляются при печати;
8 – обновляются при вызове команды EtRANsmit;
16 – обновляются при регенерации.

FiLEDiA – целая переменная, записываемая в реестр, управляющая использова-
нием диалоговых окон навигации к файлу. Значения переменной:

0 – диалоговые окна не отображаются. Тем не менее возможность прину-
дительного вызова окна сохраняется; для этого нужно ввести тильду ~ 
в ответ на запрос в командной строке. То же справедливо для функций 
AutoLISP и ADS;

1 – диалоговые окна отображаются. Однако, если активен пакетный файл 
или программа AutoLISP/ObjectARXTM, AutoCAD выводит запрос в ко-
мандной строке (начальное значение).

FiLLEtRAD – вещественная переменная, записываемая в рисунок, управляющая 
значеним текущего радиуса сопряжения. Начальное значение 0.0000.
FiLLEtRAD3D – хранение текущего значения радиуса сопряжения для трехмер-
ных объектов.
FiLLmODE – целая переменная, записываемая в рисунок, управляющая закрас-
кой штриховок (заливок), фигур и полилиний ненулевой ширины. Значения пе-
ременной:

0 – объекты не закрашиваются;
1 – объекты закрашиваются (начальное значение).

FONtALt – строковая переменная, записываемая в реестр, установливающая аль-
тернативный шрифт, используемый в случае, если не найден указанный шрифт. 
Начальное значение simplex.shx.
FONtmAP – строковая переменная, записываемая в реестр, представляющая 
файл, описывающий подстановку шрифтов. Хранит имя текущей таблицы соот-
ветствия шрифтов.
FRAmE – включение и выключение отображения рамок для всех внешних ссы-
лок, изображений и подложек DWF, DWFx, PDF и DGN. 
FRONtZ – вещественная переменная, записываемая в рисунок, определяющая 
смещение передней секущей плоскости для текущего видового экрана в единицах 
рисунка.
FULLOPEN – незаписываемая целая переменная, предназначенная только для 
чтения, содержащая индикатор частичного открытия текущего рисунка. Значе-
ния переменной:
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0 – рисунок открыт частично;
1 – рисунок открыт полностью.

FULLPLOtPAtH – целая переменная, записываемая в реестр, определяющая, от-
правлен ли весь файл чертежа в буфер печати. Значения переменной:

0 – отправляет только имя файла чертежа;
1 – отправляет весь файл чертежа (начальное значение).

G

GEOLAtLONGFORmAt – управление форматом значений широты и долго-
ты в диалоговом окне географического положения Geographic Location и в строке 
состоя ния координат в географическом режиме. 
GEOmARKERVisiBiLitY – управление отображением географических маркеров. 
GFANG – задание угла градиентной заливки. 
GFCLR1 – задание цвета для одноцветной градиентной заливки или первого цве-
та для двухцветной градиентной заливки. 
GFCLR2 – задание второго цвета для двухцветной градиентной заливки. 
GFCLRLUm – управление уровнем тона или оттенка в одноцветной градиентной 
заливке. 
GFCLRstAtE – задание количества цветов градиентной заливки: один или два. 
GFNAmE – задание узора градиентной заливки. 
GFsHiFt – указывает, выровнен ли узор градиентной заливки по центру или сме-
щен влево и вверх. 
GLOBALOPACitY – управление уровнем прозрачности всех палитр. 
GRiDDisPLAY – битовый код, записываемый в рисунок, управляющий режимом 
работы дисплея и лимитами отображения сетки. Начальное значение 3. Параметр 
хранится в виде битового кода, использующего сумму следующих значений:

0 – ограничивает отображение сетки зоной, заданной командой Limits;
1 – не ограничивает отображение сетки зоной, заданной командой Limits;
2 – включает отображение адаптивной сетки, которая ограничивает плотность 

сетки при уменьшении масштаба изображения;
4 – если задано отображение адаптивной сетки, то при увеличении масштаба 

изображения генерируются дополнительные более плотно расположен-
ные линии сетки пропорционально интервалам основных линий сетки;

8 – изменяет плоскость сетки в соответствии с плоскостью XY динамической 
ПСК.

GRiDmAJOR – целая переменная, записываемая в рисунок, управляющая часто-
той основных линий сетки по сравнению с второстепенными линиями. Допусти-
мый диапазон значений от 1 до 100. Начальное значение 5.
GRiDmODE – целая переменная, записываемая в рисунок, управляющая включе-
нием и отключением видимости экранной сетки. Значения переменной:

0 – отображение сетки отключено (начальное значение);
1 – отображение сетки включено.
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GRiDstYLE – определяет стиль отображаемых ручек для пространства двухмер-
ной модели, редактора блоков, двухмерного параллельного проецирования, трех-
мерного перспективного проецирования и вкладок листов. 
GRiDUNit – двухмерная точка, записываемая в рисунок, определяющая размер 
ячейки сетки на текущем видовом экране по X и Y. Начальное значение: 0.5000, 
0.5000 (британские единицы) или 10,10 (метрические единицы).
GRiPBLOCK – целая переменная, записываемая в реестр, управляющая ручками 
внутри блоков. Значения переменной:

0 – устанавливается только одна ручка (в точке вставки блока) (начальное 
значение);

1 – ручки устанавливаются на всех объектах в блоке.
GRiPCOLOR – целая переменная, записываемая в реестр, определяющая цвет не-
выбранных ручек. Допустимый диапазон значений от 1 до 255. Начальное значе-
ние 160.
GRiPCONtOUR – определяет цвет контура ручки.
GRiPDYNCOLOR – целая переменная, записываемая в реестр, управляющая цве-
том специальных ручек для динамических блоков. Допустимый диапазон значе-
ний от 1 до 255. Начальное значение 140.
GRiPHOt – целая переменная, записываемая в реестр, определяющая цвет выбран-
ных ручек. Допустимый диапазон значений от 1 до 255. Начальное значение 1.
GRiPHOVER – целая переменная, записываемая в реестр, определяющая цвет за-
полнения невыбранных ручек при прохождении курсора над ними. Допустимый 
диапазон значений от 1 до 255. Начальное значение 3.
GRiPmULtiFUNCtiONAL – указывает способы доступа к многофункциональным 
ручкам.
GRiPOBJLimit – целая переменная, записываемая в реестр, определяющая режим 
подавления ручек в случае, если исходный набор содержит больше объектов, чем 
задано. Допустимый диапазон значений от 1 до 32767. Начальное значение 100.
GRiPs – целая переменная, записываемая в реестр, управляющая показом ру-
чек при растягивании, перемещении, повороте, масштабировании и зеркальном 
отобра жении объектов. Значения переменной:

0 – ручки отключены;
1 – ручки включены (начальное значение).

GRiPsiZE – целая переменная, записываемая в реестр, определяющая размер 
квад рата, изображающего ручку (в пикселах). Допустимый диапазон значений 
переменной от 1 до 255. Начальное значение 5.
GRiPsUBOBJmODE – определяет, активизируются ли автоматически ручки при 
выборе подчиненных объектов.
GRiPtiPs – целая переменная, записываемая в реестр, определяющая Режим 
отобра жения подсказок к ручкам, когда курсор останавливается на снабженных 
подсказками ручках из сторонних объектов. Значения переменной:

0 – отображение подсказок для ручек отключено;
1 – отображение подсказок для ручек включено (начальное значение).
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GtAUtO – целая переменная, записываемая в реестр, управляющая автоматиче-
ским отображением инструментов ручки при выборе объектов перед запуском 
команды в видовом экране, которому задан трехмерный стиль отображения. Зна-
чения переменной:

0 – инструменты ручки не отображаются автоматически при выборе объектов 
перед выполнением команды;

1 – инструменты ручки отображаются автоматически после создания набора 
объектов перед выполнением команды (начальное значение).

GtDEFAULt – целая переменная, записываемая в реестр, управляющая автома-
тическим выполнением команд трехмерного поворота и переноса. Значения пере-
менной:

0 – команды 3DmOVE и 3DROtAtE не выполняются автоматически при вы-
полнении команд mOVE и ROtAtE в трехмерном виде (начальное значе-
ние);

1 – команды 3DmOVE и 3DROtAtE выполняются автоматически при выпол-
нении команд mOVE и ROtAtE в трехмерном виде.

GtLOCAtiON – целая переменная, записываемая в реестр, управляющая перво-
начальным расположением инструментов ручки, если выбор объектов произво-
дится до выполнения команд 3DmOVE или 3DROtAtE.

H

HALOGAP – целая переменная, записываемая в рисунок, управляющая отобра-
жением зазора в области покрытия одного объекта другим. Значение задается в 
процентах от одной единицы и не зависит от экранного увеличения. Начальное 
значение 0.
HANDLEs – целая переменная, записываемая в рисунок, предназначенная только 
для чтения, управляющая процессом присвоения меток объектам. Как функция 
отключения не доступна в данной версии программы, переменная служит только 
для совместимости с пакетными файлами, написанными для прежних версий про-
граммы. Начальное значение Off.
HELPPREFiX – задание пути к файлу справочной системы.
HiDEPRECisiON – незаписываемая целая переменная, управляющая точностью 
скрытия невидимых линий и раскрашивания. Значения переменной:

0 – одинарная точность; требуется меньший объем памяти (начальное значе-
ние);

1 – двойная точность; требуется больший объем памяти.
HiDEtEXt – переключающаяся переменная, записываемая в рисунок, управля-
ющая режимом обработки в команде HiDE текстовых объектов. Значения пере-
менной:

OFF – текстовые объекты не скрываются и не скрывают другие объекты;
ON – текстовые объекты скрываются, но не скрывают другие объекты (на-

чальное значение).



705Перечень системных переменных

HiGHLiGHt – незаписываемая целая переменная, управляющая подсветкой объ-
ектов при выборе. Не влияет на объекты, имеющие ручки. Значения переменной:

0 – отключение подсветки выбранных объектов;
1 – включение подсветки выбранных объектов (начальное значение).

HPANG – незаписываемая вещественная переменная, определяющая угол накло-
на образца штриховки. Начальное значение 0.
HPANNOtAtiVE – признак наличия аннотативных связей у нового образца штри-
ховки. 
HPAssOC – целая переменная, записываемая в реестр, управляющая ассоциатив-
ностью образцов штриховки и градиентных заливок. Значения переменной:

0 – штриховки и градиентные заливки не связаны с контурами;
1 – штриховки и градиентные заливки связаны с контурами и обновляются 

при изменении контуров (начальное значение).
HPBACKGROUNDCOLOR – управление цветом фона для образцов штриховки. 
HPBOUND – незаписываемая целая переменная, управляющая типом объекта, 
создаваемого командами BHAtCH и BOUNDARY. Значения переменной:

0 – создаются области;
1 – создаются полилинии (начальное значение).

HPBOUNDREtAiN – определяет, создаются ли объекты-контуры для новой штри-
ховки и заливки. 
HPCOLOR – задание цвета по умолчанию для новой штриховки. 
HPDLGmODE – управление отображением диалоговых окон штриховки и гради-
ента Hatch and Gradient и редактирования штриховки. 
HPDOUBLE – незаписываемая целая переменная, определяющая режим для соз-
данных пользователем штриховок крест-накрест. Штрихование крест-накрест 
подразумевает нанесение второй штриховки, повернутой относительно первой на 
90 градусов. Значения переменной:

0 – обычное штрихование (начальное значение);
1 – штрихование крест-накрест.

HPDRAwORDER – незаписываемая целая переменная, управляющая порядком 
вывода штриховок и заливок на экран. Значения переменной:

0 – для порядка следования не назначается штриховка или заливка;
1 – штриховка или заливка помещается на задний план всех остальных объ-

ектов;
3 – штриховка или заливка помещается за контуром (начальное значение);
4 – штриховка или заливка помещается перед контуром.

HPGAPtOL – вещественная переменная, записываемая в реестр, управляющая 
режимом игнорирования мелких зазоров в контурах, окружающих почти замкну-
тые области. Начальное значение 0.
HPiNHERit – целая переменная, записываемая в рисунок, определяющая исход-
ную точку полученной штриховки с помощью копирования свойств команд соз-
дания штриховки. Значения переменной:
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0 – исходная точка штриховки заимствована из переменной HPORIGIN (на-
чальное значение);

1 – исходная точка штриховки заимствована из объекта исходной штриховки.
HPisLANDDEtECtiON – определяет способ работы с островками внутри конту-
ра штриховки. 
HPisLANDDEtECtiONmODE – признак выявления внутренних замкнутых кон-
туров, называемых островками. 
HPLAYER – задание слоя по умолчанию для новой штриховки и заливки. 
HPmAXLiNEs – установка максимального количества линий штриховки, отобра-
жаемых при выполнении операции штриховки. 
HPNAmE – незаписываемая строковая переменная, содержащая имя образца 
штриховки по умолчанию длиной до 34 символов (без пробелов). Начальное зна-
чение ANSI31.
HPOBJwARNiNG – целая переменная, записываемая в реестр, устанавливающая 
количество объектов контура штриховки, которые можно выбрать до отображе-
ния предупреждения. Максимальное значение может изменяться, но оно значи-
тельно больше 100000000 (ста миллионов). Начальное значение 10000.
HPORiGiN – двухмерная точка, записываемая в рисунок, отображающая исходную 
точку штриховки для новых объектов штриховки относительно текущей системы 
координат пользователя. Начальное значение 0,0.
HPORiGiNmODE – целая переменная, записываемая в реестр, определяющая ис-
ходную точку штриховки. Значения переменной:

0 – исходные точки штриховки установлены с помощью переменной HPORIGIN 
(начальное значение);

1 – исходные точки установлены с помощью левого нижнего угла прямоуголь-
ных границ контура штриховки;

2 – исходные точки установлены с помощью правого нижнего угла прямо-
угольных границ контура штриховки;

3 – исходные точки установлены с помощью правого верхнего угла прямо-
угольных границ контура штриховки;

4 – исходные точки установлены с помощью левого верхнего угла прямо-
угольных границ контура штриховки;

5 – исходные точки установлены с помощью центра прямоугольных границ 
контура штриховки.

HPQUiCKPREViEw – признак отображения образца для просмотра при задании 
внутренних точек области штриховки. 
HPsCALE – незаписываемая вещественная переменная, содержащая коэффициент 
масштабирования образца штриховки по умолчанию. Начальное значение 1.0000.
HPsEPARAtE – целая переменная, записываемая в реестр, определяющая коли-
чество создаваемых заштрихованных объектов с помощью команды штриховки, 
если выделено несколько замкнутых контуров. Значения переменной:

0 – создан один заштрихованный объект (начальное значение);
1 – создано несколько заштрихованных объектов.
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HPsPACE – незаписываемая вещественная переменная, содержащая расстояние 
между штриховыми линиями по умолчанию для созданных пользователем штри-
ховок. Начальное значение 1.0000.
HPtRANsPARENCY – задание значения прозрачности для новой штриховки и 
заливки. 
HYPERLiNKBAsE – строковая переменная, записываемая в рисунок путь, ис-
пользуемый для всех относительных гиперссылок в рисунке. Значение не задано, 
используется тот же путь, что и у рисунка.

i

imAGEFRAmE – управляет видимостью рамок изображения и выводом их на пе-
чать. 
imAGEHLt – целая переменная, записываемая в реестр, управляющая режимом 
подсветки растровых изображений при выборе. Значения переменной:

0 – подсвечиваются только границы растрового изображения (начальное зна-
чение);

1 – подсвечивается все растровое изображение.
imPLiEDFACE – целая переменная, записываемая в реестр, управляющая обна-
ружением предполагаемых граней. Значение этой переменной должно быть уста-
новлено равным 1, если необходимо выбирать и изменять предполагаемые грани. 
Значения переменной:

0 – предполагаемые грани не обнаруживаются;
1 – предполагаемые грани обнаруживаются (начальное значение).

iNDEXCtL – целая переменная, записываемая в рисунок, управляющая создани-
ем слоевых и пространственных индексов и сохранением их в файле рисунка. Зна-
чения переменной:

0 – индексы не создаются (начальное значение);
1 – создаются индексы слоев;
2 – создаются индексы пространства;
3 – создаются индексы слоев и пространства.

iNEtLOCAtiON – строковая переменная, записываемая в реестр, содержащая на-
чальный адрес Интернета, используемый в команде BROwsER и в диалоговом 
окне Browse the Web. Начальное значение http://www.autodesk.com.
iNPUtHistORYmODE – битовый код, записываемый в реестр, управляющий со-
держанием и положением отображения последних введенных пользователем ко-
манд. Начальное значение 15. Параметр хранится в виде битового кода, использую-
щего сумму следующих значений:

0 – последние введенные команды не отображаются;
1 – последние введенные команды отображаются в командной строке или в 

динамической подсказке, доступ к которой можно получить с помощью 
клавиш ↑ и ↓;
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2 – последняя введенная текущая команда отображается в контекстном меню;
4 – все последние введенные команды в текущем сеансе отображаются в кон-

текстном меню;
8 – маркеры для последнего ввода местоположений точки отображаются в 

чертеже.
iNsBAsE – трехмерная точка, записываемая в рисунок, соответствующая базовой 
точке вставки, устанавливаемой командой BAsE. Начальное значение 0.0000, 
0.0000, 0.0000.
iNsNAmE – незаписываемая строковая переменная, содержащая имя блока по 
умолчанию для команды iNsERt.
iNsUNits – целая переменная, записываемая в рисунок, управляющая значени-
ем (в единицах рисунка) для автоматического масштабирования объектов, встав-
ляемых в рисунок путем перетаскивания из Центра управления. Значения пере-
менной:

0 – не заданы;
1 – дюймы (начальное значение);
2 – футы;
3 – мили;
4 – миллиметры;
5 – сантиметры;
6 – метры;
7 – километры;
8 – микродюймы;
9 – милы;
10 – ярды;
11 – ангстремы;
12 – нанометры;
13 – микроны;
14 – дециметры;
15 – декаметры;
16 – гектометры;
17 – гигаметры;
18 – астрономические единицы;
19 – световые годы;
20 – парсеки.

iNsUNitsDEFsOURCE – целая переменная, записываемая в реестр, соответствую-
щая единицам измерения исходного рисунка. Значения переменной:

0 – не заданы;
1 – дюймы (начальное значение);
2 – футы;
3 – мили;
4 – миллиметры;
5 – сантиметры;
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6 – метры;
7 – километры;
8 – микродюймы;
9 – милы;
10 – ярды;
11 – ангстремы;
12 – нанометры;
13 – микроны;
14 – дециметры;
15 – декаметры;
16 – гектометры;
17 – гигаметры;
18 – астрономические единицы;
19 – световые годы;
20 – парсеки.

iNsUNitsDEFtARGEt – целая переменная, записываемая в реестр, соответствую-
щая единицам измерения в целевом рисунке при вставке блоков с помощью Цент-
ра управления AutoCAD DesignCenter. Значения переменной:

0 – не заданы;
1 – дюймы (начальное значение);
2 – футы;
3 – мили;
4 – миллиметры;
5 – сантиметры;
6 – метры;
7 – километры;
8 – микродюймы;
9 – милы;
10 – ярды;
11 – ангстремы;
12 – нанометры;
13 – микроны;
14 – дециметры;
15 – декаметры;
16 – гектометры;
17 – гигаметры;
18 – астрономические единицы;
19 – световые годы;
20 – парсеки.

iNtELLiGENtUPDAtE – целая переменная, записываемая в реестр, управляющая 
скоростью обновления графики. Начальное значение 20 кадров в секунду. Пере-
менная работает с помощью подавления обновления графики, пока не исчезнет 
счетчик времени. Последующие обновления его сбрасывают.
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iNtERFERECOLOR – целая переменная, записываемая в рисунок, устанавливаю-
щая цвет объектов взаимодействия. Действительными значениями являются BY-
LAYER и целые числа от 0 до 255. Начальное значение 1.
iNtERFEREOBJVs – строковая переменная, записываемая в рисунок, управляю-
щая стилем отображения объектов взаимодействия.
iNtERFEREVPVs – строковая переменная, записываемая в рисунок, задающая 
стиль отображения видового экрана во время проверки пространственных взаи-
модействий.
iNtERsECtiONCOLOR – целая переменная, записываемая в рисунок, управляю-
щая цветом полилиний пересечения. Начальное значение 257.
iNtERsECtiONDisPLAY – переключающаяся переменная, записываемая в ри-
сунок, управляющая отображением полилиний пересечения. Значения перемен-
ной:

OFF – отображение полилиний пересечения отключено (начальное значение);
ON – отображение полилиний пересечения включено.

isAVEBAK – целая переменная, записываемая в реестр, управляющая повыше-
нием скорости последовательных сохранений, особенно для больших рисунков. 
Управляет созданием резервной копии BAK. Значения переменной:

0 – файл BAK не создается (даже при полном сохранении);
1 – файл BAK создается (начальное значение).

isAVEPERCENt – целая переменная, записываемая в реестр, соответствующая 
количеству неиспользуемого дискового пространства, допустимого в файле ри-
сунка. Диапазон значений переменной от 0 до 100. Начальное значение 50.
isOLiNEs – целая переменная, записываемая в рисунок, задающая число изоли-
ний на поверхности трехмерного объекта в каркасном представлении. Диапазон 
значений переменной от 0 до 2047. Начальное значение 4.

L

LARGEOBJECtsUPPORt – управление поддержкой больших предельных раз-
меров объектов при открытии и сохранении чертежей. 
LAstANGLE – незаписываемая вещественная переменная, предназначенная толь-
ко для чтения, соответствующая конечному углу последней введенной дуги в плос-
кости XY текущей ПСК в текущем пространстве. Начальное значение 0.
LAstPOiNt – незаписываемая трехмерная последняя введенная точка, выражен-
ная в координатах ПСК в текущем пространстве. Начальное значение 0.0000, 
0.0000, 0.0000.
LAstPROmPt – незаписываемая строковая переменная, предназначенная только 
для чтения, содержащая последний текст, выведенный в командной строке. Эта 
строка абсолютно идентична последней командной строке и включает любой вве-
денный пользователем текст.
LAtitUDE – вещественная переменная, записываемая в рисунок, задающая ши-
роту модели чертежа в формате десятичных чисел. Значением по умолчанию яв-
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ляется широта Сан-Франциско, Калифорния. Диапазон допустимых значений от 
-90 до +90. Положительные значения представляют северные широты. На значе-
ние не влияют установки системных переменных AUNITS и AUPREC.
LAYERDLGmODE – установка режима для Диспетчера свойств слоев при исполь-
зовании команды LAYER. 
LAYEREVAL – определяет необходимость построения списка слоев при добавле-
нии новых слоев к чертежу или к вставленным внешним ссылкам. 
LAYEREVALCtL – управление фильтрацией общего списка новых несогласован-
ных слоев в Диспетчере свойств слоев. Этот список используется при создании 
нового слоя. 
LAYERFiLtERALERt – целая переменная, записываемая в реестр, удаляющая из-
быточные фильтры слоев для повышения производительности. Значения пере-
менной:

0 – оключено;
1 – когда диспетчер свойств открыт, можно удалить все фильтры слоев, со-

общение не отобразится;
2 – если открыт диспетчер слоев, выводится сообщение, в котором будет ука-

зана ошибка, рекомендовано и предложено удалить все фильтры (началь-
ное значение);

3 – когда открыт чертеж, отобразится сообщение об ошибке, и будет предло-
жено открыть диалоговое окно, в котором можно выбрать фильтры для 
удаления.

LAYERmANAGERstAtE – указание состояния окна Диспетчера свойств слоев 
(открыто или закрыто). 
LAYERNOtiFY – определение условий вывода предупреждения при обнаружении 
несогласованных новых слоев. 
LAYOUtREGENCtL – целая переменная, записываемая в реестр, управляющая 
режимом обновления списка отображения на вкладке модели и вкладках листов. 
Значения переменной:

0 – рисунок регенерируется при каждом переходе с одной вкладки на другую;
1 – для вкладки модели и последнего активного листа список отображения 

сохраняется в памяти. При переключении между этими двумя вкладками 
регенерации не происходит. При переходе на какой-либо другой лист его 
содержимое регенерируется;

2 – рисунок регенерируется только при первом заходе на каждую из вкладок. 
Далее AutoCAD сохраняет для них списки отображения, поэтому после-
дующих регенераций уже не требуется (начальное значение).

LEGACYCtrlPiCK – целая переменная, записываемая в реестр, задающая клавиши 
циклического повторения выбора и определяющая действия при нажатии клави-
ши Ctrl и левой кнопки мыши. Значения переменной:

0 – нажатие клавиши Ctrl и левой кнопки мыши используется для выбора под-
объектов (граней, контуров и вершин) на трехмерных твердотельных объ-
ектах (начальное значение);
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1 – нажатие клавиши Ctrl и левой кнопки мыши используется для цикличе-
ского просмотра перекрывающихся объектов. Запрещает использование 
нажатия клавиши Ctrl и левой кнопки мыши для выбора подобъектов на 
трехмерных твердотельных объектах.

LENsLENGtH – вещественная переменная, записываемая в рисунок, предназна-
ченная только для чтения, соответствующая фокусному расстоянию (в мм) при 
построении перспективного вида на текущем видовом экране. Начальное значе-
ние 50.0000.
LiGHtGLYPHDisPLAY – целая переменная, записываемая в рисунок, управляю-
щая отображением обозначений источников света. Если эта системная перемен-
ная отключена, обозначения источников света на чертеже не отображаются. Зна-
чения переменной:

0 – отключено;
1 – включено (начальное значение).

LiGHtiNGUNits – управление использованием обычных или фотометрических 
источников света и задание единиц освещения для чертежа. 
LiGHtListstAtE – незаписываемая целая переменная, указывающая, открыто ли 
окно источников света в модели. Значения переменной:

0 – закрыто (начальное значение);
1 – открыть.

LiGHtsiNBLOCKs – управление использованием источников света, содержа-
щихся в блоках, при визуализации.
LimCHECK – целая переменная, записываемая в рисунок, управляющая допусти-
мостью создания объектов за пределами лимитов рисунка. Значения переменной:

0 – разрешено (начальное значение);
1 – запрещено.

LimmAX – двухмерная точка, записываемая в рисунок, хранящая значение правого 
верхнего угла лимитов рисунка, выраженного в мировых координатах. Начальное 
значение 12.0000, 9.0000.
LimmiN – двухмерная точка, записываемая в рисунок, хранящая значение левого 
нижнего угла лимитов рисунка, выраженного в мировых координатах. Начальное 
значение 0.0000, 0.0000.
LiNEARBRiGHtNEss – управление уровнем яркости видового экрана при ис-
пользовании стандартного освещения. 
LiNEARCONtRAst – управление уровнем контрастности видового экрана при 
использовании стандартного освещения. 
LisPiNit – целая переменная, записываемая в реестр, управляющая сохранени-
ем в памяти функций и переменных, описанных в загруженных программах на 
AutoLISP, при открытии нового рисунка (в однодокументном интерфейсе). Зна-
чения переменной:

0 – функции и переменные AutoLISP сохраняются в памяти при переходе к 
следующему рисунку;
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1 – функции и переменные AutoLISP действуют только для текущего рисунка 
(начальное значение).

LOCALE – незаписываемая строковая переменная, предназначенная только для 
чтения, содержащая языковой код ISO рабочего языка текущей версии программы. 
Этот код отображается в виде трехбуквенной аббревиатуры, возвращаемой функ-
цией Windows GetLocaleInfo с помощью константы LOCALE_SABBREVLANGNAME.
LOCALROOtPREFiX – строковая переменная, записываемая в реестр, указываю-
щая полный путь к корневой папке структуры локальных файлов, доступных для 
адаптации.
LOCKUi – битовый код, записываемый в реестр, блокирующий положение и раз-
мер панелей инструментов и плавающих окон, таких как DesignCenter и палитра 
свойств. Закрепленные панели инструментов и окна могут открываться и за-
крываться, а элементы могут быть добавлены или удалены. Чтобы временно их 
разблокировать, следует удерживать нажатой клавишу Ctrl. Значок блокировки в 
строке состояния указывает, заблокированы ли панели инструментов и окна. Для 
отображения заблокированных параметров следует нажать правую кнопку мыши 
на значке блокировки. Параметр хранится в виде битового кода, использующего 
сумму следующих значений:

0 – панели инструментов и окна не заблокированы (начальное значение);
1 – закрепленные панели инструментов заблокированы;
2 – заблокированы закрепленные или имеющие якорь окна;
4 – плавающие панели инструментов заблокированы;
8 – плавающие окна заблокированы.

LOFtANG1 – вещественная переменная, записываемая в рисунок, устанавли-
вающая черновой угол сквозь первое поперечное сечение в операции сечения. 
Нулевое направление измеряется наружу от кривой на плоскости кривой. Поло-
жительное направление измеряется в сторону следующего поперечного сечения. 
Действительными являются значения, большие или равные 0, но меньшие 360. 
Начальное значение 90.
LOFtANG2 – вещественная переменная, записываемая в рисунок, устанавливаю-
щая черновой угол сквозь последнее поперечное сечение в операции сечения. 
Нулевое направление измеряется наружу от кривой на плоскости кривой. Поло-
жительное направление измеряется в сторону предыдущего поперечного сечения. 
Действительными являются значения, большие или равные 0, но меньшие 360. 
Начальное значение 90.
LOFtmAG1 – целая переменная, записываемая в рисунок, устанавливающая ве-
личину чернового угла сквозь первое поперечное сечение в операции сечения. 
Контролирует, насколько быстро поверхность начинает изгибаться в направле-
нии следующего поперечного сечения. Действительными являются целые значе-
ния от 1 до 10. Начальное значение 1.
LOFtmAG2 – целая переменная, записываемая в рисунок, устанавливающая ве-
личину чернового угла сквозь последнее поперечное сечение в операции сечения. 
Контролирует, насколько быстро поверхность начинает изгибаться в направлении 
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следующего поперечного сечения. Действительными являются целые значения от 
1 до 10. Начальное значение 1.
LOFtNORmALs – целая переменная, записываемая в рисунок, управляющая 
нормалями развернутого объекта в точках их прохода сквозь поперечные сечения. 
Этот параметр игнорируется при задании траектории или направляющих. Дан-
ные параметры также можно задать в диалоговом окне настройки сечений. Значе-
ния переменной:

0 – линейчатый;
1 – сглаженный (начальное значение);
2 – первая нормаль;
3 – последняя нормаль;
4 – конечная нормаль;
5 – все нормали;
6 – использовать черновой угол и величину.

LOFtPARAm – битовый код, записываемый в рисунок, управляющий очертанием 
развернутых тел и поверхностей. Начальное значение 7. Значения переменной:

1 – без поворота (минимизирует поворот между поперечными сечениями);
2 – спрямить направление (спрямляет направление от начала до конца каждой 

кривой поперечного сечения);
4 – упростить (генерирует простые сплошные тела и поверхности, такие как 

цилиндр или плоскость, вместо сплайновых тел и поверхностей);
8 – закрыть (закрывает поверхность или тело между первым и последним по-

перечными сечениями).
LOGEXPBRiGHtNEss – управление уровнем яркости видового экрана при ис-
пользовании фотометрического освещения.
LOGEXPCONtRAst – управление уровнем контрастности видового экрана при 
использовании фотометрического освещения.
LOGEXPDAYLiGHt – управление внешним дневным светом при использовании 
фотометрического освещения. 
LOGEXPmiDtONEs – управление уровнем полутонов видового экрана при ис-
пользовании фотометрического освещения. 
LOGEXPPHYsiCALsCALE – управляет относительной яркостью самосветящихся 
материалов в фотометрической среде. 
LOGFiLEmODE – целая переменная, записываемая в реестр, указывающая, требует-
ся ли запись содержимого текстового окна в файл журнала. Значения переменной:

0 – журнал не ведется (начальное значение);
1 – журнал ведется.

LOGFiLENAmE – строковая переменная, записываемая в рисунок, предназначенная 
только для чтения, содержащая адрес и имя файла журнала для текущего рисунка.
LOGFiLEPAtH – строковая переменная, записываемая в реестр, содержащая адре-
са файлов журналов всех рисунков сеанса.
LOGiNNAmE – незаписываемая строковая переменная, предназначенная только 
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для чтения, содержащая имя пользователя, указанное при настройке или введен-
ное при запуске AutoCAD. Максимальная длина имени – 30 символов.
LONGitUDE  – вещественная переменная, записываемая в рисунок, задающая 
долготу модели чертежа в формате десятичных чисел. Значением по умолчанию 
является долгота Сан-Франциско, Калифорния. Диапазон допустимых значений 
от -180 до +180. Положительные значения представляют западную долготу. На 
значение не влияют установки системных переменных AUNITS и AUPREC.
LtsCALE – вещественная переменная, записываемая в рисунок, задающая гло-
бальный коэффициент масштабирования типов линий. Начальное значение 
1.0000.
LUNits – целая переменная, записываемая в рисунок, определяющая формат ли-
нейных единиц. Значения переменной:

1 – научные;
2 – десятичные (начальное значение);
3 – инженерные;
4 – архитектурные;
5 – дробные.

LUPREC – целая переменная, записываемая в рисунок, определяющая коли-
чество десятичных знаков в отображаемых значениях расстояний, а также в 
предлагаемых для редактирования значениях, исходная точность которых мень-
ше заданной в LUPREC. Начальное значение 4.
LwDEFAULt – значение из стандартного списка, записываемое в реестр, устанав-
ливающее численное значение, соответствующее весу линий Default. Допусти-
мые значения: 0, 5, 9, 13, 15, 18, 20, 25, 30, 35, 40, 50, 53, 60, 70, 80, 90, 100, 106, 120, 
140, 158, 200 и 211. Начальное значение 25.
LwDisPLAY – целая переменная, записываемая в рисунок, управляющая учетом 
весов линий при отображении объектов на экране. Для каждой вкладки рисунка 
сохраняется отдельное значение переменной. Значения переменной:

0 – объекты отображаются без учета весов линий (начальное значение);
1 – объекты отображаются с учетом весов линий.

LwUNits – целая переменная, записываемая в реестр, устанавливающая едини-
цы измерения веса (толщины) линий. Значения переменной:

0 – дюймы;
1 – миллиметры (начальное значение).

m

mAtBROwsERstAtE – управление состоянием окна Обозреватель материалов. 
mAtEDitORstAtE – указывает, открыто или закрыто окно Редактора материа-
лов. 
mAtERiALsPAtH – задание пути к библиотекам материалов. 
mAtstAtE – незаписываемая целая переменная, указывающая состояние окна 
определения материалов. Значения переменной:
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0 – закрыто (начальное значение);
1 – открыто.

mAXACtVP – целая переменная, записываемая в рисунок, устанавливающая мак-
симальное число видовых экранов, которые могут быть активны одновременно. 
Начальное значение 64.
mAXsORt – целая переменная, записываемая в реестр, устанавливающая макси-
мальное число имен символов или имен файлов, которое можно отсортировать с 
помощью команд вывода списков. Начальное значение 1000.
mBUttONPAN – целая переменная, записываемая в реестр, управляющая дей-
ствиями третьей кнопки или колесика на устройстве указания. Значения пере-
менной:

0 – действия, предписанные в файле меню MNU;
1 – панорамирование путем нажатия третьей кнопки (колесика) и последую-

щего перемещения мыши (начальное значение).
mEAsUREiNit – целая переменная, записываемая в реестр, задающая начальные 
единицы (британские или метрические) при создании нового рисунка. Значения 
переменной:

0 – британские единицы; AutoCAD использует файлы образцов штриховки и 
типов линий, заданные в элементах реестра ANSIHatch и ANSILinetype;

1 – метрические единицы; AutoCAD использует файлы образцов штриховки 
и типов линий, заданные в элементах реестра ISOHatch и ISOLinetype.

mEAsUREmENt – целая переменная, записываемая в рисунок, задающая едини-
цы (британские или метрические) для текущего рисунка. Значения переменной:

0 – британские единицы; AutoCAD использует файлы образцов штриховки 
и типов линий, заданные в элементах реестра ANSIHatch и ANSILinetype 
(начальное значение);

1 – метрические единицы; AutoCAD использует файлы образцов штриховки 
и типов линий, заданные в элементах реестра ISOHatch и ISOLinetype.

mENUBAR – управляет отображением строки меню.
mENUCtL – целая переменная, записываемая в реестр, управляющая переключе-
нием страниц экранного меню при вводе команды с клавиатуры. Значения пере-
менной:

0 – страницы не переключаются;
1 – страницы переключаются (начальное значение). 

mENUECHO – незаписываемая целая переменная, содержащая битовый код 
управления эхо-выводом и запросами меню. Начальное значение 0. Код является 
суммой следующих значений:

1 – подавление эхо-вывода пунктов меню (переключатель в меню – ^P);
2 – подавление системных запросов во время выполнения команд из меню;
4 – подавление переключателя ^P эхо-вывода пунктов меню;
8 – отображение всех выводимых и вводимых строк (режим отладки для 

DIESEL-макросов).
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mENUNAmE – строковая переменная, записываемая в реестр, предназначенная 
только для чтения, содержащая адрес и имя файла меню.
mEsHtYPE – управление типом сети, создаваемой с помощью команд REVsURF, 
tABsURF, RULEsURF и EDGEsURF. 
miRRHAtCH – управление способом отображения образцов штриховки с по-
мощью команды miRROR. 
miRRtEXt – целая переменная, записываемая в рисунок, управляющая обработ-
кой текстов в команде miRROR. Значения переменной:

0 – текст сохраняет свое направление (начальное значение);
1 – текст отображается зеркально.

mLEADERsCALE – задание общего масштабного коэффициента для объектов-
мультивыносок. 
mODEmACRO – незаписываемая строковая переменная, позволяет выводить в 
статусной строке текстовые строки, например имя текущего рисунка, время и дату 
или специальные режимы.
msLtsCALE – масштабирование типов линий, отображаемых на вкладке модели, 
представление с учетом масштаба (масштабируемое представление).
msmstAtE – незаписываемая целая переменная, сохраняющая значение, указы-
вающее состояние Диспетчера наборов пометок. Значения переменной:

0 – закрыт (начальное значение);
1 – открыт.

msOLEsCALE – вещественная переменная, записываемая в рисунок, управляю-
щая размерами текстовых OLE-объектов, вставляемых в пространство модели.
mtEXtCOLUmN – задание параметров столбцов по умолчанию для объекта мно-
гострочного текста. 
mtEXtED – строковая переменная, записываемая в реестр, определяющая имя 
текстового редактора, используемого для работы с многострочными текстовыми 
объектами.
mtEXtFiXED – целая переменная, записываемая в реестр, управляющая внеш-
ним видом Редактора многострочного текста. Значения переменной:

0 – редактор многострочного текста и текст, расположенный внутри него, 
отобра жаются в соответствии с размером и расположением многостроч-
ного текстового объекта внутри рисунка. Слишком большой или малень-
кий текст отображается, соответственно, с максимальным или минималь-
ным размером окна (начальное значение);

1 – редактор многострочного текста и текст, расположенный внутри него, 
отобра жаются в соответствии со стандартами расположения, размера и 
высоты текста.

mtEXttOOLBAR – управление отображением панели инструментов форматиро-
вания текста. 
mtJiGstRiNG – строковая переменная, записываемая в реестр, определяет содержи-
мое образца текста, который выводится около курсора при вызове команды mtEXt.
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mYDOCUmENtsPREFiX – строковая переменная, записываемая в реестр, пред-
назначенная только для чтения, содержащая полный путь к папке документов те-
кущего пользователя.

N

NAVBARDisPLAY – управление отображением панели навигации на всех видо-
вых экранах. 
NAVswHEELmODE – задание текущего режима штурвала. 
NAVswHEELOPACitYBiG – управление прозрачностью больших штурвалов. 
NAVswHEELOPACitYmiNi – управление прозрачностью мини-штурвалов. 
NAVswHEELsiZEBiG – задание размера больших штурвалов. 
NAVswHEELsiZEmiNi – задание размера мини-штурвалов. 
NAVVCUBEDisPLAY – управление отображением инструмента Видовой куб на 
текущем видовом экране при применении текущего визуального стиля. 
NAVVCUBELOCAtiON – определяет угол видового экрана, в котором отображает-
ся инструмент Видовой куб. 
NAVVCUBEOPACitY – управление прозрачностью неактивного инструмента Ви-
довой куб. 
NAVVCUBEORiENt – определяет, как ориентирован Видовой куб: в соответствии 
с текущей ПСК или в соответствии с МСК. 
NAVVCUBEsiZE – задание размера инструмента Видовой куб. 
NOmUtt – незаписываемая короткая целая переменная, управляющая полным 
подавлением запросов сообщений в командной строке. Значения переменной:

0 – нормальный режим подсказок (начальное значение);
1 – полное подавление подсказок.

NORtHDiRECtiON – вещественная переменная, записываемая в рисунок, задаю-
щая угол смещения от севера. Установки системных переменных AUNITS и AUPREC 
влияют на это значение.

O

OBJECtisOLAtiONmODE – определяет, остаются ли скрытые объекты скрыты-
ми в следующем сеансе рисования. 
OBsCUREDCOLOR – целая переменная, записываемая в рисунок, определяющая 
цвет невидимых линий. Начальное значение 257.
OBsCUREDLtYPE – целая переменная, записываемая в рисунок, определяющая 
тип линий заднего плана. Значения переменной:

0 – Откл (начальное значение);
1 – сплошная;
2 – штриховая;
3 – пунктирная;
4 – штриховая (короткие штрихи);
5 – штриховая (средние штрихи);
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6 – штриховая (длинные штрихи);
7 – штриховая увеличенного масштаба (короткие штрихи);
8 – штриховая увеличенного масштаба (средние штрихи);
9 – штриховая увеличенного масштаба (длинные штрихи);
10 – штриховая большого масштаба;
11 – разреженная пунктирная.

OFFsEtDist – незаписываемая вещественная переменная, определяющая теку-
щее расстояние смещения, используемое командой OFFsEt. Начальное значение 
1.0000. Значения переменной:

<0 – подобный объект проходит через заданную точку;
>0 – используется текущее расстояние смещения.

OFFsEtGAPtYPE – целая переменная, записываемая в реестр, управляющая за-
зорами между сегментами, возникающими при построении подобных полилиний. 
Значения переменной:

0 – зазоры заполняются путем растягивания сегментов полилиний (начальное 
значение);

1 – зазоры заполняются сопрягающими дуговыми сегментами (радиусом, рав-
ным расстоянию смещения);

2 – зазоры заполняются соединяющими линейными сегментами.
OLEFRAmE – целая переменная, записываемая в рисунок, управляющая режимом 
отображения и печати рамок на всех OLE-объектах рисунка. Значения переменной:

0 – рамка не отображается и не печатается;
1 – рамка отображается и печатается;
2 – рамка отображается, но не печатается (начальное значение).

OLEHiDE – управление показом OLE-объектов в AutoCAD на экране и при печа-
ти. Значения переменной:

0 – объекты показываются на экране (начальное значение);
1 – отображаются только в пространстве листа;
2 – отображаются в пространстве модели;
3 – вообще не отображаются.

OLEQUALitY – целая переменная, записываемая в реестр, управляющая ка-
чеством печати OLE-объектов от штрихового рисунка до реалистического изо-
бражения высокого качества. Значения переменной:

0 – монохромное;
1 – пониженное;
2 – высокое;
3 – автоматический выбор (начальное значение).

OLEstARtUP – целая переменная, записываемая в рисунок, управляющая за-
грузкой приложения, в котором был создан внедренный OLE-объект, для его пе-
чати. Значения переменной:

0 – исходное приложение не загружается (начальное значение);
1 – исходное приложение загружается при выполнении функции печати.
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Если задано открытие исходного приложения, качество вычерчивания может 
быть улучшено.
OPENPARtiAL – управление возможностью работать с файлом чертежа до его 
полного открытия. 
OPmstAtE – незаписываемая целая переменная, сохраняющая значение, которое 
указывает состояние Палитры свойств. Значения переменной:

0 – закрыта (начальное значение);
1 – открыта;
2 – автоскрытие: открыта, однако если курсор выходит за пределы палитры, 

отображается только строка заголовка.
ORtHOmODE – целая переменная, записываемая в рисунок, управляющая режи-
мом ввода во время операций, требующих точности (F8). Значения переменной:

0 – ортогональный режим отключен (начальное значение);
1 – ортогональный режим включен.

OsmODE – целая переменная, записываемая в реестр, содержащая битовый код теку-
щих режимов объектной привязки. Начальное значение 4133. Значения переменной:

0 – NONE;
1 – ENDpoint;
2 – MIDpoint;
4 – CENter;
8 – NODe;
16 – QUAdrant;
32 – INTersection;
64 – INSertion;
128 – PERpendicular;
256 – TANgent;
512 – NEArest;
1024 – QUIck;
2048 – APParent Intersection;
4096 – EXTension;
8192 – PARallel.

При установке нескольких режимов одновременно значения переменных сум-
мируются.
OsNAPCOORD – целая переменная, записываемая в реестр, управляющая 
приори тетом ввода координат с клавиатуры над текущими режимами привязки:

0 – текущие режимы объектной привязки подавляют ввод координат с кла-
виатуры;

1 – вводимые с клавиатуры координаты подавляют текущие режимы объект-
ной привязки;

2 – вводимые с клавиатуры координаты подавляют режимы привязки (за ис-
ключением случаев выполнения командных файлов) (начальное значе-
ние).
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OsNAPNODELEGACY – управляет возможностью использования узловой объ-
ектной привязки к многострочным текстовым объектам. 
OsNAPHAtCH – устаревшая целая переменная, записываемая в реестр, исполь-
зуется для управления объектной привязкой. Значения переменной:

0 – объекты штриховки игнорируются при объектной привязке (начальное 
значение);

1 – при объектной привязке объекты штриховки воспринимаются как другие 
объекты.

OsNAPZ – незаписываемая целая переменная, управляющая автоматической 
проекцией объектной привязки на плоскость, параллельную плоскости XY теку-
щей ПСК, на текущем уровне. Значения переменной:

0 – при привязке используется значение координаты Z указанной точки (на-
чальное значение);

1 – при привязке значение координаты Z указанной точки заменяется значе-
нием уровня ELEV, установленным для текущей ПСК.

OsOPtiONs – битовый код, записываемый в реестр, автоматически подавляющий 
объектную привязку на объектах штриховки и геометрию с отрицательными значе-
ниями Z при использовании динамической ПСК. Начальное значение 3. Параметр 
хранится в виде битового кода, использующего сумму следующих значений:

0 – объектная привязка работает на объектах штриховки и в геометрии с от-
рицательными значениями Z при использовании динамической ПСК;

1 – объекты штриховки игнорируются при объектной привязке;
2 – объектная привязка игнорирует геометрию с отрицательными значениями 

Z при использовании динамической ПСК.

P

PALEttEOPAQUE – целая переменная, записываемая в реестр, управляющая 
свойством прозрачности окон. Значения переменной:

0 – режим прозрачности включен пользователем (начальное значение);
1 – режим прозрачности отключен пользователем;
2 – режим прозрачности недоступен, хотя и включен пользователем;
3 – режим прозрачности недоступен и отключен пользователем.

PAPERUPDAtE – целая переменная, записываемая в реестр, управляющая вы-
водом диалогового окна-предупреждения при попытке вывести на печать лист, 
формат которого не совпадает с форматом, заданным по умолчанию в файле пара-
метров плоттера. Значения переменной:

0 – если плоттер не поддерживает данного формата листа, выводится пред-
упреждение (начальное значение);

1 – листу принудительно назначается формат, заданный в файле параметров 
плоттера.

PARAmEtERCOPYmODE – управление способом обработки зависимостей и 
пользовательских ссылочных параметров при копировании объектов с зависимо-
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стями с одного чертежа на другой, из пространства модели на листы и в обратном 
направлении, а также в определения блоков. 
PARAmEtERsstAtUs – признак отображения или скрытия Диспетчера парамет-
ров. 
PDFFRAmE – определяет видимость контура подложки PDF. 
PDFOsNAP – определяет активность привязки объекта для геометрии в подлож-
ках PDF, прикрепленных к чертежу. 
PDmODE – целая переменная, записываемая в рисунок, устанавливающая режим 
отображения точек. Начальное значение 0.
PDsiZE – вещественная переменная, записываемая в рисунок, устанавливающая 
размер символа отображения объекта-точки. Начальное значение 0.0000. Значе-
ния переменной:

0 – символ размером 5% от высоты области рисования;
>0 – абсолютное значение размера;
<0 – значение в процентах от размера видового экрана.

PEDitACCEPt – целая переменная, записываемая в реестр, управляющая подав-
лением сообщения команды PEDit о том, что выбранный объект не является по-
лилинией. Значения переменной:

0 – запрос выводится (начальное значение);
1 – запрос не выводится.

PELLiPsE – целая переменная, записываемая в рисунок, управляющая режимом 
формирования эллипса. Значения переменной:

0 – создание реальных эллипсов (начальное значение);
1 – аппроксимация эллипсов полилиниями.

PERimEtER – незаписываемая вещественная переменная, предназначенная толь-
ко для чтения, хранящая последнее значение периметра, вычисленное командами 
AREA, List и DBList.
PERsPECtiVE – целая переменная, записываемая в рисунок, указывающая, 
отобра жает текущий видовой экран рабочий вид в перспективе или нет. Значение 
переменной сбрасывается в 0, если файл чертежа или DXF-файл сохраняется в 
формате, предшествующем формату новой версии AutoCAD. Эта системная пере-
менная действительна только в пространстве модели. Значения переменной:

0 – вид в перспективе отключен;
1 – вид в перспективе включен.

PERsPECtiVECLiP – определение местоположения секущей плоскости базовой 
точки визуализации. 
PFACEVmAX – незаписываемая целая переменная, предназначенная только для 
чтения, устанавливающая максимальное число вершин одной грани. Начальное 
значение 4.
PiCKADD – целая переменная, записываемая в реестр, управляющая добавочным 
выбором объектов. Значения переменной:

0 – отключение PICKADD. Последние выбранные индивидуально или с по-
мощью рамки объекты становятся новым набором. Объекты, которые на-
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ходились в наборе до этого, исключаются из него. Добавить объекты в на-
бор можно, выбирая их при нажатой клавише Shift;

1 – включение PICKADD. Последние выбранные индивидуально или с помощью 
рамки объекты добавляются в текущий набор. Исключить объекты из на-
бора можно, выбирая их при нажатой клавише Shift (начальное значение).

PiCKAUtO – целая переменная, записываемая в реестр, управляющая автома-
тическим созданием рамки выбора в ответ на запрос Select objects. Значения 
переменной:

0 – не используется;
1 – автоматическое создание рамки выбора (начальное значение).

PiCKBOX – целая переменная, записываемая в реестр, определяющая размер при-
цела выбора объектов в пикселах. Начальное значение 3.
PiCKDRAG – целая переменная, записываемая в реестр, определяющая способ 
создания рамки выбора. Значения переменной:

0 – рамка создается указанием двух диагональных точек. При этом нет необ-
ходимости удерживать в нажатом состоянии кнопку выбора устройства 
указания (начальное значение);

1 – рамка создается путем перемещения мыши от одного угла к другому при 
нажатой кнопке. Точка, где была нажата кнопка, становится одним углом 
рамки; точка, где она была отпущена, – вторым.

PiCKFiRst – целая переменная, записываемая в реестр, управляющая способом 
выбора объектов, при котором можно сначала создать набор выбора, а затем ввес-
ти команду редактирования или получения сведений. Значения переменной:

0 – предварительный выбор не допускается;
1 – предварительный выбор допускается (начальное значение).

PiCKstYLE – целая переменная, записываемая в реестр, управляющая выбором 
групп и ассоциативной штриховки. Значения переменной:

0 – нет выбора групп или ассоциативной штриховки;
1 – допускается групповой выбор (начальное значение);
2 – выбор ассоциативной штриховки;
3 – выбор групп и ассоциативной штриховки.

PLAtFORm – незаписываемая строковая переменная, предназначенная только 
для чтения, определяющая имя платформы, на которой работает AutoCAD.
PLiNECONVERtmODE – задание способа вписывания, используемого при пре-
образовании сплайнов в полилинии. 
PLiNEGEN – целая переменная, записываемая в рисунок, управляющая генераци-
ей типа линии в вершинах двухмерных полилиний. Значения переменной:

0 – генерация линии заданного типа начинается заново (со штриха) в каждой 
вершине полилинии (начальное значение);

1 – генерация линии заданного типа не прерывается в вершинах полилинии.
PLiNEtYPE – целая переменная, записываемая в реестр, устанавливающая режим 
использования оптимизированных двухмерных полилиний в AutoCAD. Значения 
переменной:
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0 – не оптимизируются, при создании используются неоптимизированные по-
лилинии;

1 – не оптимизируются, при создании используются оптимизированные по-
лилинии (начальное значение);

2 – полилинии в рисунках R14 или более старых рисунках преобразуются при 
открытии, при создании используются оптимизированные полилинии.

PLiNEwiD – вещественная переменная, записываемая в рисунок, определяющая 
ширину полилинии по умолчанию. Начальное значение 0.0000.
PLOtOFFsEt – целая переменная, записываемая в реестр, управляющая спосо-
бом отсчета смещения чертежа – относительно печатаемой области или кромок 
листа бумаги. Значения переменной:

0 – задание отсчета смещения чертежа относительно печатаемой области (на-
чальное значение);

1 – задание отсчета смещения чертежа относительно кромок листа бумаги.
PLOtROtmODE – целая переменная, записываемая в реестр, управляющая ори-
ентацией чертежа. Значения переменной:

0 – поворот печатаемой области осуществляется так, что метка, обозначающая 
левый нижний угол чертежа (при просмотре контура), совпадает с ниж-
ним левым (0), верхним левым (90), верхним правым (180) или нижним 
правым (270) углом листа. Смещения начала чертежа по X и Y отсчитыва-
ются от левого нижнего угла бумаги;

1 – нижний левый угол печатаемой области совмещается с нижним левым 
углом листа;

2 – аналогично значению 0, но смещения начала чертежа по X и Y отсчитыва-
ются от повернутой точки начала (начальное значение).

PLOttRANsPARENCYOVERRiDE – определяет, учитывается ли прозрачность 
объектов при печати. 
PLQUiEt – целая переменная, записываемая в реестр, управляющая выводом не-
обязательных диалоговых окон и сообщений о некритических ошибках при пакет-
ной печати и выполнении командных файлов. Значения переменной:

0 – выводятся сообщения (начальное значение);
1 – ошибки регистрируются в журнале.

POiNtCLOUDAUtOUPDAtE – определяет, восстанавливается ли облако точек 
автоматически после операций с ним, а также после панорамирования, изменения 
масштаба изображения или движения по орбите. 
POiNtCLOUDDENsitY – определяет количество точек, одновременно отображае-
мых во всех облаках точек на виде чертежа. 
POiNtCLOUDLOCK – определяет, можно ли выполнять операции с вставленным 
облаком точек, перемещать и поворачивать его. 
POiNtCLOUDRtDENsitY – улучшает рабочие характеристики за счет снижения 
количества точек, отображаемых на виде чертежа при изменении масштаба изо-
бражения, панорамировании или движении по орбите в реальном времени. 
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POLARADDANG – строковая переменная, записываемая в реестр, сохраняющая 
полярные углы, определенные пользователем.
POLARANG – вещественная переменная, записываемая в реестр, сохраненяющая 
шаг полярных углов, определенных пользователем. Допустимые значения: 5; 10; 
15; 18; 22.5; 30; 45; 90. Начальное значение 90.
POLARDist – вещественная переменная, записываемая в реестр, сохраненяющая 
шаг привязки, определенный пользователем в случае, когда системная перемен-
ная SNAPSTYL установлена в 1 (полярная привязка). Начальное значение 0.0000.
POLARmODE – целая переменная, записываемая в реестр, управляющая поляр-
ным и объектным отслеживаниями: использование абсолютных или относитель-
ных полярных углов; использование дополнительных углов; нажатие клавиши 
Shift при работе с опорными точками. Начальное значение 0. Значения переменной:

Полярная трассировка:
0 – от текущей системы координат (абсолютная);
1 – от выбранных объектов (относительная).

Объектная трассировка:
0 – ортогональная;
2 – полярная;

Использование дополнительных углов полярной трассировки:
0 – не используется;
4 – используется.

Получение точек объектного отслеживания:
0 – автоматически;
8 – используется Shift.

POLYsiDEs – незаписываемая целая переменная, определяющая число сторон 
многоугольника, предлагаемое по умолчанию командой POLYGON (МН-УГОЛ). 
Начальное значение 4.
POPUPs – незаписываемая целая переменная, предназначенная только для чте-
ния, определяющая статус текущего драйвера монитора. Значения переменной:

0 – не позволяет работать с графическим интерфейсом;
1 – позволяет работать с графическим интерфейсом.

PREViEwEFFECt – целая переменная, записываемая в реестр, указывающая ви-
зуальный эффект, используемый для предварительного просмотра набора объек-
тов. Значения переменной:

0 – пунктирные линии (отображение по умолчанию для выбранных объек-
тов);

1 – утолщенные линии;
2 – пунктирные и утолщенные линии (начальное значение).

PREViEwFACEEFFECt – указывает визуальный эффект, применяемый при пред-
варительном просмотре выбранных подчиненных объектов-граней. 
PREViEwFiLtER – битовый код, записываемый в реестр, исключающий указан-
ные типы объектов из области предварительного выбора. Начальное значение 7.
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Параметр хранится в виде битового кода, использующего сумму следующих зна-
чений:

0 – не исключает никаких объектов;
1 – исключает объекты на заблокированных слоях;
2 – исключает объекты внешних ссылок;
4 – исключает таблицы;
8 – исключает объекты многострочного текста;
16 – исключает заштрихованные объекты;
32 – исключает объекты в группах.

PREViEwtYPE – управление видом, используемым для миниатюры чертежа. 
PRODUCt – незаписываемая текстовая переменная, предназначенная только для 
чтения, содержащая название программного продукта.
PROGRAm – незаписываемая строковая переменная, предназначенная только 
для чтения, сохраняющая имя файла программы.
PROJECtNAmE – строковая переменная, записываемая в рисунок, присваиваю-
щая имя проекта текущему рисунку. Позволяет сохранять информацию о путях 
доступа к источникам ссылок.
PROJmODE – целая переменная, записываемая в реестр, определяющая режим 
проецирования для операций обрезки и удлинения. Значения переменной:

0 – реальный трехмерный режим (без проецирования);
1 – используются проекции на план текущей системы координат (начальное 

значение);
2 – используются проекции на плоскость текущего вида.

PROXYGRAPHiCs – целая переменная, записываемая в рисунок, управляющая 
сохранением объектов-заместителей в рисунке. Значения переменной:

0 – не сохраняется;
1 – сохраняется (начальное значение).

PROXYNOtiCE – целая переменная, записываемая в реестр, выводящая сообще-
ния при открытии рисунка, который содержит объекты, созданные другим при-
ложением, если это приложение не загружено. Значения переменной:

0 – не выводится;
1 – выводится (начальное значение).

PROXYsHOw – целая переменная, записываемая в реестр, управляющая показом 
объектов-заместителей в рисунке. Значения переменной:

0 – не видны;
1 – видны (начальное значение);
2 – видны габаритные прямоугольники и параллелепипеды.

PROXYwEBsEARCH – целая переменная, записываемая в реестр, задающая ре-
жим поиска адаптеров объектов. Значения переменной:

0 – наличие новых адаптеров объектов не проверяется;
1 – наличие новых адаптеров объектов проверяется лишь при установленной 

связи с Интернетом (начальное значение).
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PsLtsCALE – целая переменная, записываемая в реестр, управляющая масшта-
бированием типов линий в пространстве листа. Значения переменной:

0 – без специального масштабирования;
1 – зависит от масштаба видового экрана (начальное значение).

PsOLHEiGHt – вещественная переменная, записываемая в рисунок, управляю-
щая значением высоты по умолчанию для развернутого твердотельного объекта. 
Начальное значение 4 (британские единицы), 80 (метрические).
PsOLwiDtH – вещественная переменная, записываемая в рисунок, управляющая 
значением ширины по умолчанию для развернутого твердотельного объекта. На-
чальное значение 0.25 (британские единицы), 5 (метрические).
PstYLEmODE – целая переменная, предназначенная только для чтения, опреде-
ляющая тип стилей печати (цветозависимые или именованные) в текущем рисун-
ке. Переменная только читается. Значения переменной:

0 – именованные;
1 – цветозависимые (начальное значение).

PstYLEPOLiCY – целая переменная, записываемая в реестр, управляющая ассо-
циированностью цвета объекта с его стилем печати. Значения переменной:

0 – ассоциативность между цветом и стилем печати не создается;
1 – стиль печати объекта ассоциируется с его цветом (начальное значение).

PsVPsCALE – вещественная переменная, записываемая в рисунок, управляющая 
масштабом для вновь создаваемых видовых экранов. Начальное значение 0.
PUBLisHALLsHEEts – целая переменная, записываемая в реестр, управляющая 
заполнением списка диалогового окна публикации. Значения переменной:

0 – в список публикации автоматически загружается только содержимое теку-
щих документов (пространства листа и/или модели);

1 – содержимое всех открытых документов AutoCAD автоматически загружа-
ется в список публикации (начальное значение).

PUBLisHCOLLAtE – публикация листов в рамках одного задания требует наличия 
драйвера печати, поддерживающего многолистовую печать, или соответствую щей 
опции печати.
PUBLisHHAtCH – управление обработкой образцов штриховки, опубликованных 
в формате DWF или DWFx, как отдельным объектом при открытии в Autodesk 
Impression. 
PUCsBAsE – строковая переменная, записываемая в рисунок, сохраняющая имя 
ПСК, на которой базируются начало и ориентация ортогональных систем коорди-
нат (только для пространства листа).

Q

QCstAtE – незаписываемая целая переменная, определяющая активность каль-
кулятора QuickCalc. Значения переменной:

0 – не активен;
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1 – активен.
QPLOCAtiON – управление местоположением палитры быстрых свойств. 
QPmODE – управление состоянием палитры быстрых свойств (включена или от-
ключена). 
QtEXtmODE – целая переменная, записываемая в рисунок, управляющая режи-
мом быстрого отображения текста. Значения переменной:

0 – текст отображается полностью (начальное значение);
1 – изображается габаритная рамка.

QVDRAwiNGPiN – управление состоянием отображения по умолчанию изобра-
жений-образцов чертежей. 
QVLAYOUtPiN – управляет состоянием отображения по умолчанию изображе-
ний-образцов пространства модели и листов в чертеже. 

R

RAstERDPi – целая переменная, записываемая в реестр, управляющая форматом 
листа и масштабом чертежа при переключении устройств вывода с размерных на 
безразмерные и наоборот. Начальное значение 300.
RAstERPERCENt – задает максимальный процент виртуальной памяти, доста-
точной для печати растрового изображения. 
RAstERPREViEw – целая переменная, записываемая в реестр, управляющая со-
хранением вместе с рисунком BMP для предварительного просмотра. Значения 
переменной:

0 – образец для просмотра не создается;
1 – образец для просмотра создается (начальное значение).

RAstERtHREsHOLD – задает предельный размер растрового изображения в ме-
габайтах.
REBUiLD2DCV – количество управляющих вершин при повторном построении 
сплайна. 
REBUiLD2DDEGREE – глобальное значение порядка при повторном построении 
сплайна. 
REBUiLD2DOPtiON – управление удалением исходной кривой при повторном 
построении сплайна. 
REBUiLDDEGREEU – порядок в направлении оси U при повторном построении 
NURBS-поверхности. 
REBUiLDDEGREEV – порядок в направлении оси V при повторном построении 
NURBS-поверхности. 
REBUiLDOPtiONs – управление параметрами удаления и обрезки при повтор-
ном построении NURBS-поверхности. 
REBUiLDU – количество линий сетки в направлении оси U при повторном по-
строении NURBS-поверхности. 
REBUiLDV – количество линий сетки в направлении оси V при повторном построе-
нии NURBS-поверхности. 
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RECOVERAUtO – управление отображением уведомлений о восстановлении пе-
ред открытием поврежденного файла чертежа или после его открытия. 
RECOVERYmODE – целая переменная, записываемая в реестр, управляющая  
записью информации о восстановлении чертежа после системного сбоя. Значения 
переменной:

0 – информация о восстановлении не записывается, диалоговое окно восста-
новления чертежа после системного сбоя автоматически не открывается, 
из системного реестра информация о восстановлении удаляется;

1 – информация о восстановлении записывается, но после системного сбоя 
диалоговое окно восстановления чертежа автоматически не открывается;

2 – информация о восстановлении записывается, в начале следующего сеанса 
работы после системного сбоя диалоговое окно восстановления чертежа 
открывается автоматически (начальное значение).

REFEDitNAmE – незаписываемая строковая переменная, предназначенная толь-
ко для чтения, хранящая имя файла редактируемой ссылки.
REGENmODE – целая переменная, записываемая в рисунок, управляющая авто-
матической регенерацией рисунка. Значения переменной:

0 – не применяется;
1 – применяется (начальное значение).

RE-iNit – незаписываемая целая переменная, осуществляющая повторную ини-
циализацию портов ввода-вывода, монитора, дигитайзера, плоттера и файла acad.
pgp. Начальное значение 0. Значения переменной:

1 – повторная инициализация порта ввода/вывода дигитайзера;
4 – повторная инициализация дигитайзера;
16 – повторная инициализация файла PGP.

REmEmBERFOLDERs – целая переменная, записываемая в реестр, управляющая 
путем по умолчанию в полях Папка стандартных диалоговых окон выбора файлов. 
Значения переменной:

0 – поддержание совместимости с AutoCAD 2000 и более ранними версиями. 
При вызове AutoCAD двойным щелчком на значке AutoCAD путь, ука-
занный в поле Рабочий каталог этого ярлыка, предлагается по умолчанию и 
в диалоговых окнах выбора файлов;

1 – в диалоговых окнах выбора файлов предлагается последний использован-
ный путь. Значение из поля Рабочий каталог ярлыка AutoCAD (начальное 
значение).

RENDERPREFsstAtE – незаписываемая целая переменная, сохраняющая значе-
ние, указывающее, открыта палитра параметров тонирования или нет. Значения 
переменной:

0 – закрыта (начальное значение);
1 – открыта.

RENDERUsERLiGHts – управление переопределением параметров освещения 
видового экрана при визуализации. 
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REPORtERROR – целая переменная, записываемая в реестр, управляющая ре-
жимом отправки сообщения об ошибке в Autodesk при аварийном завершении 
AutoCAD. Значения переменной:

0 – окно отчета об ошибках не выводится, сведения не пересылаются в 
Autodesk;

1 – окно отчета об ошибках выводится, сведения могут быть отправлены в 
Autodesk (начальное значение).

RiBBONCONtEXtsELECt – управление отображением контекстных вкладок 
ленты при однократном или двойном щелчке мышью на объекте. 
RiBBONCONtEXtsELLim – ограничение количества объектов, которые можно 
изменить одновременно с помощью элементов управления на ленте или с по-
мощью контекстной вкладки. 
RiBBONDOCKEDHEiGHt – управление высотой горизонтально закрепленной 
ленты. Можно указать, что эта высота соответствует высоте текущей вкладки или 
что лента имеет заранее заданную высоту. 
RiBBONsELECtmODE – управление состоянием предварительно выбранных 
объектов. Определяет, останутся ли эти объекты выбранными после активизации 
контекстной вкладки ленты и выполнения команды. 
RiBBONstAtE – указание на открытое или закрытое состояние палитры ленты. 
ROAmABLEROOtPREFiX – строковая переменная, записываемая в реестр, пред-
назначенная только для чтения, сообщающая полный путь к корневой папке 
структуры перемещаемых файлов, доступных для адаптации.
ROLLOVEROPACitY – определяет прозрачность палитры при наведении на нее 
курсора. 
ROLLOVERtiPs – управление отображением подсказок ролловеров в приложе-
нии. 
RtDisPLAY – целая переменная, записываемая в реестр, управляющая показом 
растровых изображений при панорамировании и зуммировании в реальном вре-
мени (команды ZOOm и PAN). Значения переменной:

0 – видны изображения;
1 – видны только границы (начальное значение).

s

sAVEFiDELitY – управление сохранением чертежа с визуальной точностью. 
sAVEFiLE – строковая переменная, записываемая в реестр, предназначенная 
только для чтения, сообщающая имя файла автоматического сохранения.
sAVEFiLEPAtH – строковая переменная, записываемая в реестр, сообщающая 
адрес папки, в которой осуществляется автоматическое сохранение файлов сеан-
са AutoCAD.
sAVENAmE – незаписываемая строковая переменная, предназначенная только 
для чтения, сообщающая имя файла, под которым сохранен текущий рисунок 
(вместе с адресом).
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sAVEtimE – целая переменная, записываемая в реестр, задающая интервал вре-
мени автоматического сохранения рисунка в минутах. Начальное значение 10. 
Значения переменной:

0 – автоматическое сохранение отключено;
>0 – чертеж автоматически сохраняется с заданным интервалом.

sCREENBOXEs – незаписываемая целая переменная, предназначенная только 
для чтения, сообщающая количество боксов в зоне экранного меню графического 
экрана. Переменная равна 0, если экранное меню отключено при настройке.
sCREENmENU – отображение или скрытие экранных меню. 
sCREENmODE – незаписываемая целая переменная, предназначенная только 
для чтения, сообщающая битовый код, указывающий состояние графического/
текстового экрана AutoCAD. Начальное значение 3. Значения переменной:

0 – отображается текстовый экран;
1 – отображается графический экран;
2 – отображабтся и текстовый, и графический экран.

sCREENsiZE – незаписываемая двухмерная точка, предназначенная только для 
чтения, сообщающая размер текущего видового экрана в пикселах (X и Y).
sDi – целая переменная, записываемая в реестр, управляющая типом интерфейса 
AutoCAD (одно- или многодокументный). Значения переменной:

0 – включение многодокументного интерфейса (начальное значение);
1 – отключение многодокументного интерфейса;
2 – только чтение. Многодокументный интерфейс недоступен, так как загру-

жено приложение, не поддерживающее такого интерфейса. Значение 2 не 
сохраняется;

3 – только чтение. Многодокументный интерфейс недоступен, так как поль-
зователь присвоил SDI значение 1, а в AutoCAD было загружено прило-
жение, не поддерживающее наличия нескольких рисунков; причем при-
своение значения переменной было выполнено раньше, чем загрузка. Зна-
чение 3 не сохраняется.

sELECtiONANNODisPLAY – управление временным отключением доступности 
масштабируемых представлений при выборе объекта аннотативный. 
sELECtiONAREA – целая переменная, записываемая в реестр, управляющая 
отобра жением эффектов для областей выбора. Значения переменной:

0 – отключено;
1 – включено (начальное значение).

sELECtiONAREAOPACitY – целая переменная, записываемая в реестр, управляю-
щая прозрачностью области выбора в процессе выбора рамки и секущей рамки. 
Допустимый диапазон значений от 0 до 100. Чем меньше значение настройки, тем 
прозрачнее область. При значении, равном 100 единицам, область становится не-
прозрачной. Системная переменная SELECTIONAREA должна быть активизирована.
sELECtiONCYCLiNG – включение и отключение циклического перебора при вы-
боре. 
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sELECtiONPREViEw – битовый код, записываемый в реестр, управляющий 
отобра жением предварительного просмотра выбора. Объекты выделяются при 
наведении на них прицела. В этом случае предварительный выбор означает, что 
объект был бы выбран при щелчке на нем. Начальное значение 3. Параметр хра-
нится в виде битового кода, использующего сумму следующих значений:

0 – отключено;
1 – включено, если ни одна команда не активна;
2 – включено в ответ на запрос выбора объекта.

sELECtsimiLARmODE – управление набором сопоставляемых свойств 
однотипных объектов, позволяющим выбрать объект с помощью команды 
sELECtsimiLAR. 
sEtBYLAYERmODE – управление свойствами, выбираемыми командой BYLAYER. 
sHADEDGE – целая переменная, записываемая в рисунок, управляющая показом 
ребер и граней при тонировании. Значения переменной:

0 – грани тонируются без выделения ребер;
1 – грани тонируются с выделением ребер цветом фона;
2 – грани не заполняются, а ребра рисуются цветом объекта;
3 – грани тонируются цветом объекта, а ребра – цветом фона (начальное зна-

чение).
sHADEDiF – целая переменная, записываемая в рисунок, управляющая отноше-
нием рассеянной освещенности к освещенности диффузного отражения. Началь-
ное значение 70.
sHADOwPLANELOCAtiON – целая переменная, записываемая в рисунок, управ-
ляющая расположением скрытой опущенной нулевой плоскости, используемой 
для отображения теней. Значение представляет собой положение на текущей 
оси Z. Опущенная нулевая плоскость является скрытой, однако она отбрасывает 
и принимает тени. На объекты, расположенные ниже опущенной нулевой плоско-
сти, падает тень от этой плоскости. Опущенная нулевая плоскость используется, 
если системной переменной VSSHADOWS установлено значение отображения пол-
ных теней или теней на земле.
sHORtCUtmENU – целая переменная, записываемая в реестр, управляющая 
доступностью контекстных меню (стандартного, режимов редактирования и ко-
манд) в рабочей области рисования. Начальное значение 11. Значения перемен-
ной:

0 – все контекстные меню отключены (режим совместимости с R14);
1 – доступно стандартное контекстное меню;
2 – доступно контекстное меню режима редактирования;
4 – доступно контекстное меню режима команд;
8 – контекстное меню режима команд доступно при наличии ключей в ко-

мандной строке;
16 – контекстное меню доступно, если правая кнопка устройства указания 

удерживается нажатой в течение некоторого времени.
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При установке нескольких режимов одновременно значения переменных сум-
мируются.
sHOwHist – целая переменная, записываемая в рисунок, управляющая свой-
ством показа журнала для тел на чертеже. Значения переменной:

0 – отменяет показ журнала для всех тел, при этом невозможно просмотреть 
исходные объекты, которые были использованы для создания твердотель-
ного объекта;

1 – не переопределяет отдельные установки свойства показа журнала для тел 
(начальное значение);

2 – отображает журнал для всех тел, переопределяя отдельные установки 
свойства показа журнала для тел. Можно просмотреть исходные объекты, 
которые были использованы для создания твердотельного объекта.

sHOwLAYERUsAGE – целая переменная, записываемая в реестр, отображающая 
значки в Диспетчере свойств слоев, чтобы показать, используются ли слои. Зна-
чения переменной:

0 – отключено (начальное значение);
1 – включено.

sHOwmOtiONPiN – управление состоянием по умолчанию миниатюр сним-
ков. 
sHOwPALEttEstAtE – признак отображения или скрытия палитр, в том числе 
ленты и окна команд. 
sHPNAmE – незаписываемая строковая переменная, хранящая имя формы по 
умолчанию.
siGwARN – целая переменная, записываемая в реестр, управляющая выводом 
предупреждения при открытии файла с присоединенной цифровой подписью. 
Значения переменной:

0 – если подпись в файле действительна, предупреждение не выдается;
1 – если подпись в файле действительна, предупреждение выдается (началь-

ное значение).
sKEtCHiNC – вещественная переменная, записываемая в рисунок, определяю-
щая шаг приращения в команде sKEtCH. Начальное значение 0.1000.
sKPOLY – целая переменная, записываемая в рисунок, определяющая режим ге-
нерации отрезков или полилиний в команде sKEtCH. Значения переменной:

0 – генерируются отрезки;
1 – генерируются полилинии.

sKtOLERANCE – определение точности сглаживания сплайном эскиза, постро-
енного вручную. 
sKYstAtUs – определяет, вычисляется ли освещенность неба во время визуали-
зации. 
smOOtHmEsHCONVERt – устанавливает, будут ли объекты-сети, преобразуе-
мые в 3D-тела или поверхности, сглаженными или многогранными, а также будет 
ли выполняться объединение граней. 
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smOOtHmEsHGRiD – устанавливает максимальную степень сглаживания, при 
которой на 3D-объектах-сетях будет отображаться многогранная сеть-подложка. 
smOOtHmEsHmAXFACE – установка максимального количества граней, разре-
шенного для объектов-сетей. 
smOOtHmEsHmAXLEV – установка максимальной степени сглаживания для 
объектов-сетей. 
sNAPANG – вещественная переменная, записываемая в рисунок, хранящая зна-
чение угла поворота сетки шаговой привязки в текущей ПСК для текущего видо-
вого экрана. Начальное значение 0.
sNAPBAsE – двухмерная точка, записываемая в рисунок, хранящая координаты 
начальной точки сетки шаговой привязки для текущего видового экрана в теку-
щей ПСК. Начальное значение 0.0000, 0.0000.
sNAPisOPAiR – целая переменная, записываемая в рисунок, определяющая ак-
тивную плоскость изометрии для текущего видового экрана. Значения перемен-
ной:

0 – левая (начальное значение);
1 – верхняя;
2 – правая.

sNAPmODE – целая переменная, записываемая в рисунок, включающая и отклю-
чающая режим шаговой привязки. Значения переменной:

0 – режим шаговой привязки отключен (начальное значение);
1 – режим шаговой привязки включен на текущем видовом экране.

sNAPstYL – целая переменная, записываемая в рисунок, определяющая стиль 
привязки для текущего видового экрана. Значения переменной:

0 – стандартный ортогональный (начальное значение);
1 – изометрический.

sNAPtYPE – целая переменная, записываемая в реестр, определяющая стиль ша-
говой привязки на текущем видовом экране. Значения переменной:

0 – привязка к узлам прямоугольной сетки (начальное значение);
1 – полярная привязка. Курсор перемещается по дискретным значениям углов. 

Используется в сочетании с объектным и полярным отслеживанием.
sNAPUNit – двухмерная точка, записываемая в рисунок, хранящая шаг привязки 
на текущем видовом экране. Начальное значение 0.5000, 0.5000.
sOLiDCHECK – незаписываемая целая переменная, определяющая режим про-
верки корректности структуры тел в текущем сеансе AutoCAD. При значении 1 
(по умолчанию) переменная установлена. Значения переменной:

0 – проверка тел отключена;
1 – проверка тел включена (начальное значение).

sOLiDHist – целая переменная, записываемая в рисунок, управляющая установ-
кой значения по умолчанию для свойства журнала для новых и существующих 
объектов. Если установлено значение 1, для составных тел сохраняется журнал 
исходных объектов, входящих в составное тело. Значения переменной:
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0 – журнал не сохраняется;
1 – тела сохраняют журнал своих исходных объектов (начальное значение).

sORtENts – управляет сортировкой объектов в соответствии с порядком про-
рисовки для некоторых операций. 
sPLDEGREE – сохранение последнего значения порядка сплайнов и определение 
используемого по умолчанию значения порядка для команды sPLiNE при зада-
нии управляющих вершин. 
sPLFRAmE – целая переменная, записываемая в рисунок, управляющая отобра-
жением сплайнов и сглаженных сплайнами полилиний. Значения переменной:

0 – управляющая ломаная сплайнов и сглаженных полилиний не выводится 
(начальное значение);

1 – выводится управляющая ломаная сплайнов и сглаженных полилиний.
sPLiNEsEGs – целая переменная, записываемая в рисунок, число прямых сег-
ментов, которыми аппроксимируются участки сплайна. Чем больше число сег-
ментов в кривой, тем более точно будут отображены контуры объекта. Допусти-
мые значения находятся в интервале от -32768 до 32767. Начальное значение 8.
sPLiNEtYPE – целая переменная, записываемая в рисунок, определяющая тип 
сглаживающей кривой в ключе Spline команды PEDit. Значения переменной:

5 – квадратичный В-сплайн;
6 – кубический В-сплайн (начальное значение).

sPLKNOts – сохранение последней настройки узловой параметризации для 
сплайнов и определение используемой по умолчанию настройки узлов для коман-
ды SPLINE при задании определяющих точек. 
sPLmEtHOD – сохранение последнего режима построения сплайна и определе-
ние используемого по умолчанию режима команды sPLiNE. 
ssFOUND – незаписываемая строковая переменная, предназначенная только для 
чтения, сообщающая имя файла и путь, полученные при успешном поиске подшивки.
ssLOCAtE – целая переменная, записываемая в пользовательские настройки, 
управляющая режимом автоматического поиска и открытия подшивки, связан-
ной с открываемым рисунком. Значения переменной:

0 – подшивка не открывается вместе с рисунком;
1 – подшивка открывается вместе с рисунком (начальное значение).

ssmAUtOOPEN – целая переменная, записываемая в пользовательские настрой-
ки, управляющая автоматическим выводом Диспетчера подшивок при открытии 
рисунка, связанного с подшивкой, в AutoCAD. Значения переменной:

0 – Диспетчер подшивок автоматически не открывается;
1 – Диспетчер подшивок автоматически открывается (начальное значение).

ssmPOLLtimE – целая переменная, записываемая в реестр, управляющая вре-
менным интервалом автоматического обновления данных о состоянии в подшив-
ке. Допустимый диапазон значений от 20 до 600. Начальное значение 60.
ssmsHEEtstAtUs – целая переменная, записываемая в реестр, управляющая 
способом обновления данных о состоянии в подшивке. Значения переменной:
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0 – не обновлять данные о состоянии в подшивке автоматически;
1 – обновлять данные о состоянии при загрузке или выгрузке подшивки;
2 – обновлять данные о состоянии при загрузке или обновлении подшив-

ки, или регулярно через интервал времени, установленный переменной 
SSMPOLLTIME (начальное значение).

ssmstAtE – незаписываемая целая переменная, предназначенная только для 
чтения, содержащая индикатор активности окна Диспетчера подшивок. Значения 
переменной:

0 – Диспетчер подшивок не активен;
1 – Диспетчер подшивок активен.

stANDARDsViOLAtiON – целая переменная, записываемая в реестр, определяю-
щая режим оповещения пользователя о нарушениях стандартов в текущем рисун-
ке при создании или изменении нестандартного объекта. Значения переменной:

0 – режим оповещения отключен;
1 – при нарушении стандартов в рисунке выводится предупреждение;
2 – при открытии связанного с файлом стандартов файла, а также при соз-

дании и редактировании нестандартных объектов в строке состояния 
отобра жается значок стандарта (начальное значение).

stARtUP – целая переменная, записываемая в реестр, управляющая выводом 
диалогового окна при создании нового рисунка. Значения переменной:

0 – вывод диалогового окна выбора шаблона, или использование файла шаб-
лона рисунка по умолчанию (начальное значение);

1 – вывод диалоговых окон начала работы и создания нового рисунка.
stAtUsBAR – управление отображением строки состояния приложения и чер-
тежа. 
stEPsiZE – вещественная переменная, записываемая в рисунок, задающая раз-
мер каждого шага в единицах чертежа при работе в режиме обхода или облета. 
Можно ввести любое вещественное число от 1E-6 до 1E+6. Начальное значение 
6.0000.
stEPsPERsEC – вещественная переменная, записываемая в рисунок, задающая 
число шагов, выполняемых в секунду, при работе в режиме обхода или облета. 
Можно ввести любое вещественное число от 1 до 30. Начальное значение 2.
sUBOBJsELECtiONmODE – фильтрация выделения граней, кромок, вершин 
или подобъектов тела с историей при наведении на них курсора. 
sUNPROPERtiEsstAtE – незаписываемая целая переменная, указывающая, от-
крыто окно Свойств солнца или нет. Значения переменной:

0 – закрыто (начальное значение);
1 – открыто.

sUNstAtUs – целая переменная, записываемая в рисунок, управляющая излуче-
нием солнечного света на текущем видовом экране. Значения переменной:

0 – отключено;
1 – включено (начальное значение).
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sURFACEAssOCiAtiVitY – признак сохранения взаимосвязи поверхностей с 
объектами, на основе которых они созданы. 
sURFACEAssOCiAtiVitYDRAG – установка режима предварительного просмот-
ра при перетаскивании ассоциативных поверхностей с целью повышения произ-
водительности работы. 
sURFACEAUtOtRim – управление автоматической обрезкой поверхностей при 
проецировании на них геометрии. 
sURFACEmODELiNGmODE – управление типом создаваемых поверхностей 
(процедурные поверхности или NURBS-поверхности). 
sURFtAB1 – целая переменная, записываемая в рисунок, управляющая плот-
ностью сети, аппроксимирующей поверхность, в направлении M для команд 
RULEsURF, tABsURF, REVsURF и EDGEsURF. Начальное значение 6.
sURFtAB2 – целая переменная, записываемая в рисунок, управляющая плот-
ностью сети, аппроксимирующей поверхность, в направлении N для команд 
RULEsURF, tABsURF, REVsURF и EDGEsURF. Начальное значение 6.
sURFU – целая переменная, записываемая в рисунок, управляющая плотностью 
поверхности в направлении M для ключа Fit команды PEDit. Начальное значе-
ние 6.
sURFtYPE – целая переменная, записываемая в рисунок, управляющая типом 
поверхности сглаживания, которая используется командой PEDit (ключ Spline). 
Значения переменной:

5 – квадратичный В-сплайн;
6 – кубический В-сплайн (начальное значение);
8 – поверхность Безье.

sURFV – целая переменная, записываемая в рисунок, управляющая плотностью 
поверхности в направлении N для ключа Fit команды PEDit. Начальное значе-
ние 6.
sYsCODEPAGE – незаписываемая строковая переменная, предназначенная толь-
ко для чтения, содержащая системную кодовую страницу, которая определяется 
операционной системой. Способы изменения кодовой страницы описаны в доку-
ментации по операционной системе.

t

tABLEiNDiCAtOR – целая переменная, записываемая в пользовательские на-
стройки, управляющая отображением номеров рядов и букв столбцов при откры-
тии текстового редактора, используемого в месте редактирования, для изменения 
ячейки таблицы. Значения переменной:

0 – отключено;
1 – включено (начальное значение).

tABLEtOOLBAR – управление отображением панели таблицы Table toolbar. 
tABmODE – незаписываемая целая переменная, управляющая использованием 
режима Tablet. Значения переменной:
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0 – планшет отключен (начальное значение);
1 – планшет включен.

tARGEt – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, хранящая положение цели в координатах ПСК на текущем видовом 
экране при настройке перспективного изображения.
tBCUstOmiZE – переключаемая переменная, записываемая в реестр, определяю-
щая индикатор доступности панелей инструментов для адаптации. Значения пе-
ременной:

0 – отключение команд CUstOmiZE и tOOLBAR, а также возможности адап-
тации из контекстного меню панели;

1 – включение возможности адаптации панелей (начальное значение).
tDCREAtE – вещественная переменная, записываемая в рисунок, предназначен-
ная только для чтения, содержащая дату и время (местное) создания текущего 
рисунка.
tDiNDwG – вещественная переменная, записываемая в рисунок, предназначен-
ная только для чтения, содержащая общее время редактирования.
tDUCREAtE – вещественная переменная, записываемая в рисунок, предназна-
ченная только для чтения, содержащая дату и время (всемирное) создания теку-
щего рисунка.
tDUPDAtE – вещественная переменная, записываемая в рисунок, предназначен-
ная только для чтения, содержащая дату и время (местное) последнего сохране-
ния рисунка.
tDUsRtimER – вещественная переменная, записываемая в рисунок, предназна-
ченная только для чтения, содержащая таймер пользователя.
tDUUPDAtE – вещественная переменная, записываемая в рисунок, предназна-
ченная только для чтения, содержащая дату и время (всемирное) последнего со-
хранения рисунка.
tEmPOVERRiDEs – целая переменная, записываемая в реестр, включающая и 
отключающая клавиши временной отмены. Значения переменной:

0 – отключено;
1 – включено (начальное значение).

tEmPPREFiX – незаписываемая строковая переменная, предназначенная только 
для чтения, содержащая имя папки для хранения временных файлов.
tEXtED – задает интерфейс пользователя, выводимый на экран для редактирова-
ния однострочного текста. 
tEXtEVAL – незаписываемая целая переменная, управляющая методом обработ-
ки текстовых строк. Значения переменной:

0 – ответы на запросы ввода текстовых строк и значений атрибутов восприни-
маются буквально (начальное значение);

1 – текстовые строки с символами ( или ! считаются выражениями языка 
AutoLISP.
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tEXtFiLL – целая переменная, записываемая в реестр, управляющая заполнением 
текста, выполненного шрифтами TrueType, при печати и тонировании. Значения 
переменной:

0 – текст выводится в контурном виде;
1 – текст выводится в заполненном виде (начальное значение).

tEXtOUtPUtFiLEFORmAt – служит для хранения параметров Unicode для пе-
чати и текстовых файлов журналов. 
tEXtQLtY – незаписываемая целая переменная, управляющая качеством начер-
тания шрифтов TrueType при выводе текстов на печать и тонировании. Значение 0 
полностью отключает улучшение качества шрифтов, а значение 100 соответству-
ет максимальному улучшению качества за счет потери производительности. На-
чальное значение 50.
tEXtsiZE – вещественная переменная, записываемая в рисунок, управляющая 
высотой по умолчанию для нового текста в текущем начертании.
tEXtstYLE – строковая переменная, записываемая в рисунок, хранящая имя те-
кущего текстового стиля. Начальное значение STANDARD.
tHiCKNEss – вещественная переменная, записываемая в рисунок, управляющая 
значением текущей трехмерной высоты. Начальное значение 0.0000.
tHUmBsiZE – задание максимального размера в пикселах при создании миниатюр.
tiLEmODE – целая переменная, записываемая в рисунок, устанавливающая теку-
щую вкладку в рисунке (модель или последний из листов). Значения переменной:

0 – последний использовавшийся лист;
1 – модель (начальное значение).

timEZONE – значение из стандартного списка, записываемое в рисунок, уста-
навливающее часовой пояс в чертеже. Значения в таблице выражены в часах и 
минутах от всемирного времени. Заданное географическое положение также уста-
навливает часовой пояс. Если часовой пояс задан неправильно, можно исправить 
его в диалоговом окне географического положенияили задать системную пере-
менную TIMEZONE. Начальное значение -8000. Значения переменной:

-12000 – международная западная линия даты;
-11000 – остров Мидуэй, Самоа;
-10000 – Гаваи;
-9000 – Аляска;
-8000 – тихоокеанское поясное время (США и Канада), Тихуана;
-7000 – Аризона;
-7000 – Чихуахуа, Ла-Пас, Мацатлан;
-7000 – горный часовой пояс (США и Канада);
-6000 – центральная Америка;
-6000 – центральноамериканское время (США и Канада);
-6000 – Гвадалахара, Мехико, Монтеррей;
-6000 – Саскачеван;
-5000 – Богота, Лима, Киото;
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-5000 – восточное поясное время (США и Канада);
-5000 – Индиана (восток);
-4000 – атлантическое время (Канада);
-4000 – Каракас, Ла-Пас;
-4000 – Сантьяго;
-3000 – Ньюфаундленд;
-3000 – Бразилия;
-3000 – Буэнос-Айрес, Джорджтаун;
-3000 – Гренландия;
-2000 – центрально-атлантическое время;
-1000 – Азорские острова;
-1000 – острова Зеленого Мыса;
0000 – Касабланка, Монровия;
0000 – Дублин, Эдинбург, Лиссабон;
+1000 – Амстердам, Берлин, Берн, Рим, Стокгольм;
+1000 – Белград, Братислава, Будапешт, Любляна;
+1000 – Брюссель, Мадрид, Копенгаген, Париж;
+1000 – Сараево, Скопье, Варшава, Загреб;
+1000 – Западная Центральная Африка;
+2000 – Афины, Бейрут, Стамбул, Минск;
+2000 – Бухарест;
+2000 – Каир;
+2000 – Хараре, Претория;
+2000 – Хельсинки, Киев, София, Таллинн, Вильнюс;
+2000 – Иерусалим;
+3000 – Багдад;
+3000 – Кувейт, Эр-Рияд;
+3000 – Москва, Санкт-Петербург, Волгоград;
+3000 – Найроби;
+3300 – Тегеран;
+4000 – Абу Даби, Мускат;
+4000 – Баку, Тбилиси, Ереван;
+4300 – Кабул;
+5000 – Екатеринбург;
+5000 – Исламабад, Карачи, Ташкент;
+5300 – Сенай, Калькутта, Мумбаи, Нью-Дели;
+5450 – Катманду;
+6000 – Алматы, Новосибирск;
+6000 – Астана, Дака;
+6000 – Шри Джаяварденепура;
+6300 – Рангун;
+7000 – Бангкок, Ханой, Джакарта;
+7000 – Красноярск;
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+8000 – Пекин, Чонвинг, Гонконг, Урумчи;
+8000 – Иркутск, Улан-Батор;
+8000 – Куала-Лампур, Сингапур;
+8000 – Перт;
+8000 – Тайпей;
+9000 – Осака, Саппоро, Токио;
+9000 – Сеул;
+9000 – Якутск;
+9300 – Аделаида;
+9300 – Дарвин;
+10000 – Брисбен;
+10000 – Канберра, Мельбурн, Сидней;
+10000 – остров Гуам, Порт-Морсби;
+10000 – Хобарт;
+10000 – Владивосток;
+11000 – Магадан, Соломоновы Острова, Новая Каледония;
+12000 – Окленд, Веллингтон;
+12000 – Фиджи, Камчатка, Маршалловы острова;
+13000 – Нукуалофа.

tOOLtiPmERGE – переключаемая переменная, записываемая в пользователь-
ские настройки, объединяющая подсказки на чертеже в одну подсказку. Значения 
переменной:

0 – отключены (начальное значение);
1 – включены.

tOOLtiPs – целая переменная, записываемая в реестр, управляющая выводом 
всплывающих подсказок. Значения переменной:

0 – подсказки отключены;
1 – подсказки используются (начальное значение).

tPstAtE – незаписываемая целая переменная, предназначенная только для чте-
ния, определяющая состояние активности окна инструментальных палитр. Зна-
чения переменной:

0 – окно инструментальных палитр не активно;
1 – окно инструментальных палитр активно.

tRACEwiD – вещественная переменная, записываемая в рисунок, определяющая 
ширину полосы по умолчанию. Начальное значение 0.0500.
tRACKPAtH – целая переменная, записываемая в реестр, управляющая отобра-
жением трассирующих линий полярного и объектного отслеживаний. Значения 
переменной:

0 – трассы прекрывают экран (начальное значение);
1 – трассы соединяют опорные точки с курсором;
2 – линии полярной трассировки не отображаются;
3 – трассы не отображаются.
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tRANsPARENCYDisPLAY – определяет, учитывается ли прозрачность объектов 
при отображении. 
tRAYiCONs – целая переменная, записываемая в реестр, управляющая отображе-
нием лотка в строке состояния. Значения переменной:

0 – лоток не отображается;
1 – лоток отображается (начальное значение).

tRAYNOtiFY – целая переменная, записываемая в реестр, управляющая отображе-
нием служебных уведомлений на лотке в строке состояния. Значения переменной:

0 – уведомления не отображаются;
1 – уведомления отображаются (начальное значение).

tRAYtimEOUt – целая переменная, записываемая в реестр, управляющая дли-
тельностью показа служебных уведомлений (в секундах). Допустимые значе-
ния – от 0 до 10. Начальное значение 5.
tREEDEPtH – целая переменная, записываемая в рисунок, определяющая мак-
симальное количество ветвлений древовидного пространственного индекса. На-
чальное значение 3020. Значения переменной:

0 – запрещается использование пространственного индекса;
>0 – разрешается использование пространственного индекса;
<0 – разрешается использование пространственного индекса в двухмерном ре-

жиме.
tREEmAX – целая переменная, записываемая в реестр, управляющая снижением 
требований к памяти при регенерации рисунка путем ограничения максимально-
го количества узлов в пространственном индексе рисунка (дереве октантов).
tRimmODE – целая переменная, записываемая в реестр, управляющая обрезкой 
выбранных кромок фасок и сопряжений. Значения переменной:

0 – кромки сохраняются;
1 – кромки обрезаются до конечных точек фасок/сопряжений (начальное зна-

чение).
tsPACEFAC – незаписываемая вещественная переменная, управляющая стилем 
межстрочного интервала в многострочном тексте. Допустимые значения – от 0.25 
до 4.0. Начальное значение 1.0.
tsPACEtYPE – целая переменная, записываемая в реестр, управляющая стилем 
межстрочного интервала в многострочном тексте. Значения переменной:

1 – стиль At Least;
2 – стиль Exactly (начальное значение).

tstACKALiGN – целая переменная, записываемая в рисунок, выравнивающая 
«двухэтажный» текст (типа обыкновенной дроби) по вертикали. Значения пере-
менной:

1 – по низу (bottom) (начальное значение);
2 – по середине (center);
3 – по верху (top).

tstACKsiZE – целая переменная, записываемая в рисунок, управляющая отно-
шением высоты дробной части «двухэтажного» текста к высоте выделенного тек-
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ста (в процентах). Допустимые значения от 1 до 127. Начальное значение 70.

U

UCsAXisANG – целая переменная, записываемая в реестр, устанавливающая зна-
чения угла (в градусах) по умолчанию при повороте ПСК вокруг одной из ее осей 
с помощью параметров X, Y или Z команды UCs. Допустимые значения: 5; 10; 15; 
18; 22.5; 30; 45; 90; 180. Начальное значение 90.
UCsBAsE – строковая переменная, записываемая в рисунок, содержащая имя 
ПСК, на которой базируются ортогональные системы координат.
UCsDEtECt – целая переменная, записываемая в рисунок, управляющая актив-
ностью сбора данных динамической ПСК. Значения переменной:

0 – не активна;
1 – активна (начальное значение).

UCsFOLLOw – целая переменная, записываемая в рисунок, устанавливающая 
вид в плане при переходе от одной ПСК к другой. Значения переменной:

0 – ПСК не влияет на установленный вид (начальное значение);
1 – смена ПСК вызывает установку вида в плане на текущем видовом экране.

UCsiCON – целая переменная, записываемая в рисунок отдельно по видовым 
экранам, включающая видимость пиктограммы ПСК на текущем видовом экране. 
Значения переменной:

0 – пиктограмма не отображается;
1 – пиктограмма отображается;
2 – если отображается, пиктограмма помещается в начало координат текущей 

системы;
3 – пиктогрграмма отображается и помещается в начало координат текущей 

ПСК (начальное значение).
UCsNAmE – строковая переменная, записываемая в рисунок отдельно по видо-
вым экранам, предназначенная только для чтения, хранящая имя текущей систе-
мы координат для текущего видового экрана в текущем пространстве.
UCsORG – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, хранящая координаты начала текущей системы координат для теку-
щего видового экрана в текущем пространстве.
UCsORtHO – целая переменная, записываемая в реестр, определяющая режим 
восстановления ортогональной ПСК в момент установки соответствующего орто-
гонального вида. Значения переменной:

0 – не изменяет текущую систему координат;
1 – ориентирует систему координат по ортогональному виду (начальное зна-

чение).
UCsViEw – целая переменная, записываемая в реестр, управляющая режимом со-
хранения текущей ПСК вместе с именованным видом. Значения переменной:

0 – не сохраняется;
1 – сохраняется (начальное значение).

UCsVP – целая переменная, записываемая в рисунок отдельно по видовым экра-
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нам, управляющая режимом следования ПСК на видовых экранах за системой ко-
ординат, установленной на текущем видовом экране. Значения переменной:

0 – на всех видовых экранах устанавливается ПСК, совпадающая с системой 
координат текущего видового экрана;

1 – на каждом видовом экране устанавливается отдельная, хранящаяся вместе 
с ним ПСК (начальное значение).

UCsXDiR – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, хранящая направления оси Х текущей ПСК на текущем видовом экра-
не в текущем пространстве (модели или листа).
UCsYDiR – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, хранящая направления оси Y текущей ПСК на текущем видовом экра-
не в текущем пространстве (модели или листа).
UNDOCtL – незаписываемая целая переменная, предназначенная только для чте-
ния, хранящая битовый код, указывающий состояние ключей AUTO и Control ко-
манды UNDO. Начальное значение 21. Параметр хранится в виде битового кода, 
использующего сумму следующих значений:

0 – возможность отмены команд отключена;
1 – возможность отмены команд включена;
2 – может быть отменена только одна команда;
4 – режим Auto включен;
8 – активна группа команд.

UNDOmARKs – незаписываемая целая переменная, предназначенная только для 
чтения, хранящая количество меток, заданных в команде UNDO c ключом Mark 
для управления отменой. Начальное значение 0.
UNitmODE – целая переменная, записываемая в рисунок, управляющая отобра-
жением чисел с дробной частью, в футах и дюймах и в топографических единицах. 
Значения переменной:

0 – дробные единицы, футы, дюймы и топографические единицы отображают-
ся в соответствии с установками (начальное значение);

1 – формат дробных единиц, футов, дюймов и топографических единиц опре-
деляется в процессе ввода.

UOsNAP – определяет, активна ли объектная привязка к геометрии во вставлен-
ных в чертеж подложках DWF, DWFx, PDF и DGN. 
UPDAtEtHUmBNAiL – битовый код, записываемый в рисунок, управляющий 
обновлением образцов в Диспетчере подшивок. Начальное значение 15. Пара-
метр хранится в виде битового кода, который является суммой следующих зна-
чений:

0 – не обновляет образцы для листов, видов на листах и видов пространства 
модели;

1 – обновляет образцы для видов на листах;
2 – обновляет образцы для видов модели;
4 – обновляет образцы для листов;
8 – обновляет образцы при создании, изменении и восстановлении листов или 
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видов;
16 – обновляет образцы при сохранении рисунка.

UsERi1–5 – целые переменные USERI1, USERI2, USERI3, USERI4 и USERI5, запи-
сываемые в рисунок, используемые для хранения целых чисел. Начальное значе-
ние 0.
UsERR1–5 – вещественные переменные USERR1, USERR2, USERR3, USERR4 и 
USERR5, записываемые в рисунок, используемые для хранения вещественных чи-
сел. Начальное значение 0.0000.
UsERs1–5 – незаписываемые строковые переменные USERS1, USERS2, USERS3, 
USERS4 и USERS5, используемые для хранения текстовых данных.

V

ViEwCtR – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, содержащая центр текущего видового экрана в координатах ПСК.
ViEwDiR – трехмерный вектор, записываемый в рисунок, предназначенный толь-
ко для чтения, содержащий направление взгляда на текущем видовом экране в 
координатах ПСК.
ViEwmODE – целая переменная, записываемая в рисунок, предназначенная 
только для чтения, определяющая битовый код режима вида на текущем видовом 
экране. Параметр хранится в виде битового кода, использующего сумму следую-
щих значений:

0 – все отключено (начальное значение);
1 – включен вид в перспективе;
2 – включена передняя секущая плоскость;
4 – включена задняя секущая плоскость;
8 – включен режим установки вида в плане при смене системы координат;
16 – передняя секущая плоскость не совмещена с точкой наблюдения.

При установке нескольких режимов одновременно значения переменных 
суммируются.
ViEwsiZE – вещественная переменная, записываемая в рисунок, предназначен-
ная только для чтения, хранящая значения высоты изображения на текущем ви-
довом экране в условных единицах.
ViEwtwist – вещественная переменная, записываемая в рисунок, предназначен-
ная только для чтения, хранящая угол поворота вида на текущем видовом экране. 
Начальное значение 0.
VisREtAiN – целая переменная, записываемая в рисунок, управляющая ви-
димостью, цветом, типом линии, толщиной линии и стилями печати (если 
PSTYLEPOLICY равна 0) зависимых от внешних ссылок слоев, а также сохранением 
адресов доступа для вложенных ссылок. Значения переменной:

0 – внешние ссылки принимают значения параметров слоя текущего рисунка;
1 – установки слоя будут подавлены установками рисунка внешней ссылки 

(начальное значение).
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VPLAYEROVERRiDEs  – указывает на наличие слоев с переопределениями 
свойств видовых экранов для текущего видового экрана листа. 
VPLAYEROVERRiDEsmODE – управление отображением и печатью переопреде-
лений свойств слоев для видовых экранов листа. 
VPmAXimiZEDstAtE – незаписываемая целая переменная, предназначенная 
только для чтения, содержащая индикатор развернутого состояния видового 
экрана. Значения переменной:

0 – не развернут (начальное значение);
1 – развернут.

VPROtAtEAssOC – определяет, будет ли вид поворачиваться в видовом экране 
при повороте видового экрана. 
VsACURVAtUREHiGH – значение, при котором поверхность отображается зеле-
ным цветом в результате анализа кривизны. 
VsACURVAtURELOw – значение, при котором поверхность отображается синим 
цветом в результате анализа кривизны. 
VsACURVAtUREtYPE – управление типом анализа кривизны, используемого в 
определенной ситуации. 
VsADRAFtANGLEHiGH – значение, при котором модель отображается зеленым 
цветом в результате анализа уклона. 
VsADRAFtANGLELOw – значение, при котором модель отображается синим цве-
том в результате анализа уклона. 
VsAZEBRACOLOR1 – первый цвет полос, отображаемых в результате анализа 
Зеб ра.
VsAZEBRACOLOR2 – второй (контрастирующий) цвет полос, отображаемых в 
результате анализа Зебра. 
VsAZEBRADiRECtiON – управление направлением, под которым отображаются 
полосы анализа Зебра (по горизонтали, по вертикали или под углом). 
VsAZEBRAsiZE – управление шириной полос, отображаемых в результате ана-
лиза Зебра. 
VsAZEBRAtYPE – тип отображения результатов анализа целостности. 
VsBACKGROUNDs – целая переменная, записываемая в рисунок, управляющая 
отображением фонов в стиле отображения, применяемом к текущему видовому 
экрану. Значения переменной:

0 – отключено;
1 – включено (начальное значение).

VsEDGECOLOR – строковая переменная, записываемая в рисунок, устанавли-
вающая цвет граней в стиле отображения текущего видового экрана. Начальное 
значение равно 7 (ACI черный).
VsEDGEJittER – строковая переменная, записываемая в рисунок, управляю-
щая степенью проявления линий сквозь карандашную зарисовку. Если установке 
предшествует знак минус, эффект мерцания отключается. Значения переменной:

1 – низкий;
2 – средний (начальное значение);
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3 – высокий.
VsEDGEOVERHANG – целая переменная, записываемая в рисунок. Отрезки 
продлеваются за их пересечения для создания эффекта рисования от руки. Диа-
пазон значений от 1 до 100 пикселов. Если значению предшествует знак минус, 
эффект продления отрезков отключается.
VsEDGEs – целая переменная, записываемая в рисунок, управляющая типом гра-
ней, отображаемых в видовом экране. Значения переменной:

0 – грани не отображаются;
1 – изолинии отображаются (начальное значение);
2 – ребра граней отображаются.

VsEDGEsmOOtH – целая переменная, записываемая в рисунок, задающая угол, 
под которым отображаются загнутые грани. Диапазон значений от 0 до 180. На-
чальное значение 1.
VsFACECOLORmODE – целая переменная, записываемая в рисунок, управляю-
щая вычислением цвета граней. Значения переменной:

0 – нормальный: атрибут цвета грани не применяется (начальное значе-
ние);

1 – монохромный: отображает все грани цветом, заданным системной пере-
менной VSMONOCOLOR;

2 – тонированный: использует для оттенения всех граней цвет, заданный си-
стемной переменной VSMONOCOLOR, изменяя значения оттенка и насыщен-
ности цвета;

3 – разбавить: смягчает цвет, уменьшая компонент насыщенности на 30%.
VsFACEHiGHLiGHt – вещественная переменная, записываемая в рисунок, управ-
ляющая отображением бликующей подсветки на гранях, не заполненных материа-
лом, в текущем видовом экране. Диапазон значений от -100 до 100. Чем больше 
число, тем больше подсветка. Объекты с прикрепленными материалами игнори-
руют установку этой переменной, если включена переменная VSMATERIALMODE. 
Начальное значение -30.
VsFACEOPACitY – вещественная переменная, записываемая в рисунок, управ-
ляющая прозрачностью граней в текущем видовом экране. Диапазон значений от 
-100 до 100. Если значение равно 100, грань полностью непрозрачная. Если зна-
чение равно 0, грань полностью прозрачная. При отрицательных значениях уро-
вень прозрачности устанавливается, но отключается влияние этого значения на 
изобра жение на чертеже. Начальное значение -60.
VsFACEstYLE – целая переменная, записываемая в рисунок, управляющая отобра-
жением граней в текущем видовом экране. Значения переменной:

0 – стиль не применяется;
1 – реалистичное: максимально возможное приближение отображения к тому, 

как грань выглядит на самом деле (начальное значение);
2 – Гуч: используется гамма холодных и теплых цветов вместо темных и свет-

лых для улучшения отображения граней, которые могли бы быть затене-
ны и плохо видны в реалистичном представлении.
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VsHALOGAP – целая переменная, записываемая в рисунок, устанавливающая ко-
эффициент недовода в стиле отображения, применяемом к текущему видовому 
экрану. Диапазон значений от 0 до 100. Начальное значение 0.
VsHiDEPRECisiON – незаписываемая целая переменная, управляющая точно-
стью отображения скрытых и раскрашенных объектов в стиле отображения, при-
меняемом к текущему видовому экрану. Начальное значение 0.
VsiNtERsECtiONCOLOR – целая переменная, записываемая в рисунок, указываю-
щая цвет полилиний пересечения в стиле отображения, применяемом к текущему 
видовому экрану. Начальным значением является 7, специальное значение, при ко-
тором цвет (белый или черный) меняется на обратный на основе цвета фона.
VsiNtERsECtiONEDGEs – переключаемая переменная, записываемая в рису-
нок, управляющая отображением ребер пересечения в стиле отображения, при-
меняемом к текущему видовому экрану. Значения переменной:

0 – отключено (начальное значение);
1 – включено.

VsiNtERsECtiONLtYPE – целая переменная, записываемая в рисунок, устанав-
ливающая тип линии для линий пересечения в визуальном стиле, применяемом в 
текущем видовом экране. Значения переменной:

0 – отключено;
1 – заливка (начальное значение);
2 – штриховая;
3 – пунктирная;
4 – штриховая (короткий штрих);
5 – штриховая (средний штрих);
6 – штриховая (длинный штрих);
7 – двойная (короткий штрих);
8 – двойная (средний штрих);
9 – двойная (длинный штрих);
10 – штриховая (увел. штрих);
11 – редкопунктирная.

VsisOONtOP – целая переменная, записываемая в рисунок, отображающая изо-
линии сверху раскрашенных объектов в стиле отображения, применяемом к теку-
щему видовому экрану. Значения переменной:

0 – отключено (начальное значение);
1 – включено.

VsLiGHtiNGQUALitY – целая переменная, записываемая в рисунок, устанавли-
вающая качество освещения в текущем видовом экране. Значения переменной:

0 – отображаются грани;
1 – отображается сглаженным (начальное значение).

VsmAtERiALmODE – целая переменная, записываемая в рисунок, управляющая 
отображением материалов в текущем видовом экране. Значения переменной:

0 – материалы не отображаются (начальное значение);
1 – материалы отображаются, текстуры не отображаются;
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2 – отображаются материалы и текстуры.
VsmAX – трехмерная точка, записываемая в рисунок, предназначенная только 
для чтения, хранящая правый верхний угол текущего видового экрана, выражен-
ный в координатах ПСК.
VsmiN – трехмерная точка, записываемая в рисунок, предназначенная только для 
чтения, хранящая левый нижний угол текущего видового экрана, выраженный в 
координатах ПСК.
VsmONOCOLOR – строковая переменная, записываемая в рисунок, устанавливаю-
щая цвет монохромного и тонированного отображения граней в стиле отображе-
ния, применяемом в текущем видовом экране. Начальное значение 255,255,255.
VsOBsCUREDCOLOR – строковая переменная, записываемая в рисунок, задаю-
щая цвет линий заднего плана в стиле отображения, применяемом в текущем ви-
довом экране. Начальное значение ByBlock.
VsOBsCUREDEDGEs – целая переменная, записываемая в рисунок, управляю-
щая отображением скрытых граней заднего плана. Значения переменной:

0 – отключено;
1 – включено (начальное значение).

VsOBsCUREDLtYPE – целая переменная, записываемая в рисунок, задающая 
тип линии для линий заднего плана в стиле отображения, применяемом в теку-
щем видовом экране. Значения переменной:

0 – отключено;
1 – заливка (начальное значение);
2 – штриховая;
3 – пунктирная;
4 – штриховая (короткий штрих);
5 – штриховая (средний штрих);
6 – штриховая (длинный штрих);
7 – двойная (короткий штрих);
8 – двойная (средний штрих);
9 – двойная (длинный штрих);
10 – штриховая (увел. штрих);
11 – редкопунктирная.

VsOCCLUDEDCOLOR – задание цвета скрытых линий в визуальном стиле, при-
меняемом к текущему видовому экрану. 
VsOCCLUDEDEDGEs – признак отображения кромок заднего плана. 
VsOCCLUDEDLtYPE – задание типа линий для скрытых линий в визуальном 
стиле, применяемом к текущему видовому экрану. 
VssHADOws – целая переменная, записываемая в рисунок, управляющая отобра-
жением теней в стиле отображения. Значения переменной:

0 – тени не отображаются (начальное значение);
1 – отображаются только тени на земле;
2 – отображаются все тени.
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VssiLHEDGEs – целая переменная, записываемая в рисунок, управляющая 
отобра жением контуров силуэта твердотельных объектов в визуальном стиле, 
применяемом в текущем видовом экране. Значения переменной:

0 – отключено (начальное значение);
1 – включено.

VssiLHwiDtH – целая переменная, записываемая в рисунок, управляющая ши-
риной контуров силуэта в текущем видовом экране. Диапазон значений от 1 до 25. 
Начальное значение 5.
VsstAtE – незаписываемая целая переменная, сохраняющая значение, которое 
указывает, открыто окно визуальных стилей или нет. Начальное значение 0.
VtDURAtiON  – целая переменная, записываемая в реестр, задающая длитель-
ность плавного перехода видов в миллисекундах. Допустимый диапазон значений 
от 0 до 5000. Начальное значение 750.
VtENABLE – целая переменная, записываемая в реестр, управляющая использо-
ванием плавной смены вида. Плавную смену вида можно включить или отклю-
чить для панорамирования, масштабирования, изменений угла вида или для сце-
нариев. Значения переменной:

0 – отключено для панорамирования/масштабирования, поворота и сценариев;
1 – включено для панорамирования/масштабирования, отключено для пово-

рота и сценариев;
2 – отключено для панорамирования/масштабирования и сценариев, включе-

но для поворота;
3 – включено для панорамирования/масштабирования и поворота, отключено 

для сценариев (начальное значение);
4 – отключено для панорамирования/масштабирования и поворота, включено 

для сценариев;
5 – включено для панорамирования/масштабирования и сценариев, отключе-

но для поворота
6 – отключено для панорамирования/масштабирования, включено для пово-

рота и сценариев;
7 – включено для панорамирования/масштабирования, поворота и сценариев.

VtFPs – целая переменная, записываемая в реестр, задающая минимальную ско-
рость плавного перехода видов в кадрах в секунду. Если отображение плавных 
переходов не поддерживает эту скорость, используется мгновенный переход. Диа-
пазон допустимых значений от 1 до 30. Начальное значение 7.

w

wHiPARC – целая переменная, записываемая в реестр, управляющая гладкостью 
окружностей и дуг на экране. Значения переменной:

0 – окружности и дуги аппроксимируются линейными векторами (начальное 
значение);

1 – окружности и дуги отображаются гладкими кривыми линиями.
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wHiPtHREAD – целая переменная, записываемая в реестр, управляющая исполь-
зованием дополнительного процессора (то есть многопоточной обработкой дан-
ных) для ускорения операций зуммирования и панорамирования, которые вызы-
вают перерисовку или регенерацию рисунка. Значения переменной:

0 – многопоточной обработки нет. Регенерация и перерисовка рассчитывают-
ся одним процессором. Параметр обеспечивает совместимость с однопро-
цессорной обработкой из предыдущих версий;

1 – многопоточная обработка только при регенерации. На многопроцессор-
ных компьютерах расчет регенерации распараллеливается между двумя 
процессорами (начальное значение);

2 – многопоточная обработка только при перерисовке. На многопроцессор-
ных компьютерах расчет перерисовки распараллеливается между двумя 
процессорами;

3 – многопоточная обработка и при регенерации, и при перерисовке. На мно-
гопроцессорных компьютерах расчет регенерации и перерисовки распа-
раллеливается между двумя процессорами.

wiNDOwAREACOLOR – целая переменная, записываемая в реестр, управляю-
щая цветом прозрачной области выбора в процессе выбора рамки. Начальное 
значение 5 (синий). Допустимый диапазон значений от 1 до 255. Переменная 
SELECTIONAREA должна быть активизирована.
wmFBKGND – незаписываемая целая переменная, управляющая прозрачностью 
фона метафайлов, выводимых командой wmFOUt, а также форматом объектов 
метафайлов, помещаемых в буфер обмена или перетаскиваемых в другие прило-
жения. Значения переменной:

0 – фон прозрачен (начальное значение);
1 – цвет фона объектов совпадает с текущим цветом фона экрана.

wmFFOREGND – незаписываемая целая переменная, управляющая цветом ли-
ний объектов AutoCAD в других приложениях. Значения переменной:

0 – обмен цветов фона и линий, если требуется гарантия, что цвет линий будет 
темнее цвета фона (начальное значение);

1 – обмен цветов фона и линий, если требуется гарантия, что цвет линий будет 
светлее цвета фона.

wORLDUCs – незаписываемая целая переменная, предназначенная только для 
чтения, содержащая индикатор совпадения текущей ПСК с Мировой системой 
координат. Значения переменной:

0 – не совпадает;
1 – совпадает (начальное значение).

wORLDViEw – целая переменная, записываемая в рисунок, управляющая интер-
претацией координат, вводимых в командах 3DORBit, DViEw и VPOiNt – относи-
тельно Мировой системой координат (по умолчанию), относительно текущей ПСК 
или ПСК, заданной в системной переменной UCSBASE. Значения переменной:

0 – система координат не изменяется;
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1 – на время действия команд выполняется совмещение с Мировой системой 
координат (начальное значение).

wRitEstAt – незаписываемая целая переменная, предназначенная только для 
чтения, указывающая, может ли быть перезаписан текущий файл рисунка или 
он открыт только для чтения. Позволяет разработчикам приложений определять 
статус доступа к файлу рисунка с помощью функций AutoLISP. Значения пере-
менной:

0 – запись запрещена, чертеж открыт в режиме для чтения;
1 – запись разрешена (начальное значение).

wsAUtOsAVE – сохранение изменений рабочего пространства при переходе в 
другое рабочее пространство. 
wsCURRENt – незаписываемая строковая переменная, возвращающая имя теку-
щего рабочего пространства в интерфейс командной строки и устанавливающая 
это пространство текущим.

X

XCLiPFRAmE – целая переменная, записываемая в рисунок, управляющая види-
мостью контуров подрезки внешних ссылок и блоков. Значения переменной:

0 – контуры подрезки невидимы (начальное значение);
1 – контуры подрезки видимы.

XDwGFADECtL – управление затенением всех объектов внешних ссылок DWG. 
XEDit – целая переменная, записываемая в рисунок, определяющая, может ли 
текущий рисунок участвовать в операции редактирования вхождений, будучи 
вставленным в другой рисунок как внешняя ссылка. Значения переменной:

0 – редактирование не разрешено;
1 – редактирование разрешено (начальное значение).

XFADECtL – целая переменная, записываемая в рисунок, управляющая сниже-
нием интенсивности отображения объектов, не входящих в рабочий набор, при 
редактировании блоков и внешних ссылок командой. Переменной присваиваются 
значения от 0 до 90%. Начальное значение 50. Чем больше значение переменной, 
тем менее ярко выглядят объекты, не входящие в рабочий набор.
XLOADCtL – целая переменная, записываемая в реестр, управляющая переклю-
чением режима подгрузки внешних ссылок; управление загрузкой оригинального 
рисунка или его копии. Значения переменной:

0 – подгрузка отключена, открывается весь рисунок;
1 – подгрузка включена, открывается файл ссылки;
2 – подгрузка включена, открывается копия файла ссылки (начальное значе-

ние).
XLOADPAtH – строковая переменная, записываемая в реестр, определяющая 
адрес для хранения временных копий файлов подгруженных внешних ссылок.
XREFCtL – целая переменная, записываемая в реестр, управляющая созданием 
файлов журналов внешних ссылок. Значения переменной:



753Перечень системных переменных

0 – не создаются (начальное значение);
1 – создаются.

XREFNOtiFY – целая переменная, записываемая в реестр, управляющая уве-
домлениями об обновлениях и потерянных внешних ссылках. Значения пере-
менной:

0 – уведомления о внешних ссылках отключены;
1 – уведомления о внешних ссылках включены. О том, что в текущем рисунке 

имеются внешние ссылки, свидетельствует значок в правом нижнем углу 
окна приложения (на лотке в строке состояния). Предупреждение о по-
терянных внешних ссылках выводится в виде значка ! желтого цвета при 
открытии рисунка;

2 – уведомления о внешних ссылках включены. Отображение значка внеш-
них ссылок, как и для значения 1. При изменении файла внешней ссыл-
ки из лотка всплывает уведомление. Периодичность проверки наличия 
обновлений во внешних ссылках управляется системной переменной 
XNOTIFYTIME (начальное значение).

XREFtYPE – целая переменная, записываемая в реестр, управляющая стандарт-
ным способом вставки внешних ссылок (вставка или наложение). Значения пере-
менной:

0 – вставка по умолчанию (начальное значение);
1 – наложение по умолчанию.

Z

ZOOmFACtOR – целая переменная, записываемая в реестр, управляющая быст-
ротой перемещения курсора на экране при одном и том же расстоянии, пройден-
ном мышью. Принимает значения от 3 до 100. Большему значению соответствует 
большая чувствительность. Начальное значение 60.
ZOOmwHEEL – целая переменная, записываемая в реестр, переключающая на-
правление операций прозрачного масштабирования при прокрутке колесика 
мыши. Значения переменной:

0 – при движении колесика вперед масштаб увеличивается, при движении на-
зад – уменьшается (начальное значение);

1 – при движении колесика вперед масштаб уменьшается, при движении на-
зад – увеличивается.
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